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Disclaimer 

Information in this document is subject to change without notice and does not represent a 
commitment on the part of Software Bisque.  The software and/or databases described in this 
document are furnished under a license agreement or nondisclosure agreement.  They may be 
used or copied only in accordance with the terms of the agreement (www.bisque.com/eula).  It 
is against the law to copy the software on any medium except as specifically allowed in the license 
or nondisclosure agreement.  The purchaser may make one copy of the software for backup 
purposes.  No part of this manual and/or databases may be reproduced or transmitted in any 
form or by any means, electronic or mechanical, including (but not limited to) photocopying, 
recording, or information storage and retrieval systems, for any purpose other than the 
purchaser’s personal use, without the express written permission of Software Bisque. 

 

© 1984-2018 Software Bisque, Incorporated.  All rights reserved worldwide. 
 
Charts created with TheSkyX are for personal use only.  They may not be published in any form 
without express written permission of Software Bisque, Inc., or accompanied by a suitable 
copyright notice. 
 
TheSkyX includes routines from Astronomical Algorithms Software, © 1991 by Jeffrey Sax, and 
option to the book Astronomical Algorithms by Jean Meeus copyright © 1991 by Willmann-Bell.  
ISBN 0-943376-35-2.  Non-exclusive use has been specifically granted, in writing, by Willmann-
Bell, for use in TheSkyX.  Serial Number U11A445.  Photographs in the AAO folder of TheSkyX’s 
media are copyright Anglo-Australian Observatory (AAT images) and/or ROE/AATB (UK Schmidt 
Telescope images) and are reproduced with permission.  Photographs from the Anglo Australian 
Observatory telescopes are by David Malin. 
 
TheSky, TheSkyX™, TheSkyX Serious Astronomer Edition™, TheSkyX Professional Edition™, Camera 
Add On™, TPoint Add On™, Dome Add On™, Paramount ME™, Paramount ME II™, Paramount 
MX™, Paramount MX+™, Paramount MYT™, and Paramount Taurus™ are trademarks of Software 
Bisque, Incorporated.  
 
The photograph of the Milky Way is licensed from Digital Sky LLC.  Selected “in-place” photos are 
copyright Robert Gendler and are reproduced with permission.  Winter Star Party panorama 
photographs courtesy Art Mullis.   
 
Software Bisque acknowledges the usage of the HyperLeda database (http://leda.univ-lyon1.fr). 
 
TheSkyX makes use of data and/or services provided by the International Astronomical Union's 
Minor Planet Center (https://minorplanetcenter.net/). 
 
Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries.  Windows® is a trademark of Microsoft Corporation.  All other product names are 
trademarks of their respective owners and are used solely for identification. 
 
Portions of this document by Andre Bormanis and Woodrow W. Grizzle III. 
 

http://www.bisque.com/eula
http://leda.univ-lyon1.fr/
https://minorplanetcenter.net/
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Welcome to TheSkyX 

Many of you have never seen the sky.  Not really.  If you live in a city or suburb, a pale blue or 
grey dome looms overhead while the Sun is up, and a darkish brown curtain hangs down at night, 
with maybe a few sparks of light poking through here and there if the clouds haven’t gathered 
and the glare from buildings and cars and billboards isn’t overwhelming.  The Sun and the Moon 
are unmistakable of course, but the spattering of stars you glimpse are probably strangers to you.  
Some of them might even be planets – for most people, it’s hard to tell the difference. 
 
All of this is about to change.  You have in your hands an extraordinary tool for revealing not just 
new worlds, but the entire universe.  The night sky is an incredible wonderland of diverse and 
spectacular objects and phenomena.  Some of these breathtaking sights are created by tiny 
particles that ply the fringes of our atmosphere.  Others are immense, ancient structures, 
incomprehensibly far away. 
 
TheSkyX Professional Edition or TheSkyX Serious Astronomer Edition will bring these amazing 
marvels and more to your desktop.  It will help you learn the fundamentals of astronomy, the 
most ancient science, and teach you how to recognize just about everything in the real sky.  
Whether you’re looking up from the streets of a light-polluted city, or taking in the view from a 
remote, pitch-black mountaintop, or controlling your distant observatory from Internet, TheSkyX 
will help you understand what you see and find what you’re looking for. 
 
You’ll also enjoy experiences that are only possible through the magic of simulation and virtual-
reality programming.  Faster-than-light flights through the solar system, out-of-this-world views 
of the Earth and Moon, and the orbital tracks of hundreds of satellites are just some of the 
animations built into TheSkyX.  Trips through space and time that were once possible only in the 
imagination will be vividly brought to life on your computer screen. 
 
TheSkyX has something to offer everyone, from the absolute beginner to the most 
knowledgeable amateur astronomer.  This User Guide will help you navigate the basic features 
and tools our unique program has to offer. 
 
The sky is waiting for you.  Let’s get started! 

Getting Started 

TheSkyX Professional Edition and Serious Astronomer Edition (hereafter referred to simply as 
TheSkyX) are available for either Mac or Windows operating systems.  Operating system specific 
versions are sold separately, so please make sure you have the right product for your computer 
before proceeding. 
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Throughout this document, TheSkyX Professional Edition-specific features are accompanied by 
the Professional Edition graphic below. 
 

 

Hardware Acceleration 

TheSkyX uses the latest operating system-specific hardware acceleration technology so that you 
can enjoy smooth Sky Chart zooming, panning, scrolling. 
 

• TheSkyX for Mac uses OpenGL to speed chart rendering.  OpenGL is built in to the Mac 
operating system, so no additional software or drivers are required. 

• TheSkyX for Windows uses Direct3D to optimize graphic output.  Direct3D is built in to the 
Windows operating system, so no additional software or drivers are required.   

Running TheSkyX without Hardware Acceleration 

TheSkyX can optionally be run without hardware acceleration.  When TheSkyX is launched for the 
first time, it determines if a suitable hardware acceleration technology is available (OpenGL on 
Mac, or Direct3D on Windows), then configures the graphics rendering mode accordingly.   
 
To manually configure TheSkyX to run without hardware acceleration, click the Preferences 
command from the Edit menu (Windows) or the Apple menu (Mac) to show the Preferences 
window.  Select the No Hardware Acceleration option from the Graphics Rendering Mode list 
and then click Close.  TheSkyX must be restarted for this setting to take effect. 
 
The following features are not available when the No Hardware Acceleration option is selected: 
 

• 3D Solar System (page 182) 

• 3D Stars (page 166) 

• Milky Way photo (page 198) 

• Object symbol transparencies (page 236) 

• Photographic panorama horizons (page 259) 

• Planets rendered using 2D ellipses instead of 3D-like photographs 

• Satellites From Above Earth (page 195) 

• Solar and Lunar Eclipse Viewer (page 184)  

• Virtual Mount (page 372) 

Minimum System Requirements 

Please review the minimum system requirements before installing TheSkyX on your computer. 
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Mac 

TheSkyX Serious Astronomer Edition for Mac can run on any Mac desktop or laptop computer 
with OS X 10.7 or later with a 2 GHz or faster Core Duo processor.  You also need at least 512 MB 
RAM, 64 MB video RAM, and 1.3 GB of free disk space, a mouse or other pointing device and a 
DVD ROM drive. 
 

 
 
TheSkyX Professional Edition for Mac has the identical minimum requirements, except that a total 
of 2.5 GB of free disk space is required. 

Windows 

TheSkyX for Windows can run on any desktop or laptop computer running Windows 10, Windows 
8.1, Windows 8, Windows 7, 32- or 64-bit Editions, with a 1.5 GHz or faster Intel Pentium 4, 
Pentium M, Pentium D, or AMD K-8 (Athlon) or better processor.  You also need at least 512 MB 
RAM, 64 MB video RAM, and 1.3 GB of free disk space, a mouse or other pointing device and a 
DVD ROM drive. 

Microsoft Windows N and KN Editions Note 

Microsoft Windows N and KN operating systems do not include the Windows multimedia player, 
so TheSkyX will not run “out of the box”.  Install the Windows Media Feature Pack to allow 
TheSkyX to run on these scaled down Windows operating systems. 
 
Windows Vista and Windows XP are not supported by TheSkyX version 10.5 and later. 
 

 
 
TheSkyX Professional Edition for Windows has the same minimum requirements, except that a 
total of 2.5 GB of free disk space is required. 

Installing TheSkyX 

TheSkyX is normally distributed either on DVD-ROM or by downloading the full installer from the 
Software Bisque web site.  (TheSkyX Pro installers are also distributed on a thumb drive that is 
included with Paramount robotic telescope systems.) 
 
If you have purchased TheSkyX from the Software Bisque Store and want more information about 
how to download the full installer, see “How Do I Download My Software?” on this page:  
 
http://www.bisque.com/sc/pages/Download-Links-and-Serial-Number.aspx#Download  

http://www.bisque.com/sc/pages/Download-Links-and-Serial-Number.aspx#Download
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Mac 

Like all Mac software, TheSkyX is easy to install.   
 

• If you received TheSkyX on disk, insert the DVD in the DVD-ROM drive.  TheSkyX DVD icon 
appears on your desktop once the media is recognized.  Double click it to view the 
contents of the disk.  To copy TheSkyX to your computer, first double-click TheSkyX 
volume to open it, then drag and drop TheSkyX application icon to the Applications folder. 

• If you downloaded the full installer from the Software Bisque web site, double-click the 
TheSkyX [Serious or Pro] for Mac Full Installer disk image to view its contents (Mac OS X 
may perform this step automatically).  To copy TheSkyX to your computer, drag and drop 
TheSkyX application icon to the Applications folder. 

• If you received TheSkyX on a thumb drive as part of the Paramount Software Suite that is 
included with the purchase of a Paramount mount, follow the installation instructions in 
the Paramount Quick Start Guide that is included inside the Paramount shipping box. 

 
To start TheSkyX, click Go > Applications from Finder (U), then double-click on TheSkyX 
[Serious Astronomer Edition] or [Professional Edition] application icon. 
 
To make sure you are running the latest release, click Help > Check for Updates and follow the 
instructions. 

Windows 10 or Windows 8 

To install TheSkyX under Windows 10 or Windows 8 from the DVD-ROM: 
 

1. Insert the DVD-ROM in the DVD-ROM drive.  
2. From the Start window, right-click on a non-tiled region, then click the All Apps icon 

in the lower right corner of the window (Figure 1). 
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Figure 1: Windows 8 Start screen showing the All Apps icon in the lower right corner. 

3. On the Apps window, click the Computer icon under the Windows System column on 
the right side of the screen. 

4. On the Computer window, double-click TheSkyX DVD icon to view its contents. 
5. Double-click the setup application icon to begin the installation.  If you are signed into 

an account that does not have administrative privileges, you will need to enter an 
administrator’s password to complete the installation. 

6. Follow each step of the Setup Wizard to complete the installation. 

Windows 7 

To install TheSkyX under Windows 7 from the DVD-ROM: 
1. Insert the DVD in the DVD-ROM drive.  
2. Click Start > Computer. 
3. On the Computer window, select the removable storage device that holds TheSkyX 

media, and then click the AutoPlay button (it’s located in the tool bar near the top of 
this window). 
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Figure 2: TheSkyX’s AutoPlay window. 

 
4. Click the Install button to begin the installation process. 
5. Follow the on-screen instructions to complete the installation.   

Starting TheSkyX on Windows 

Windows 10 or Windows 8 

 

Figure 3: TheSkyX's application icon. 

To start TheSkyX on Windows 10 or 8, click TheSkyX’s icon pictured above on the Start window.  
(Click the Windows accelerator key to show the Start window). 
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Windows 7 

To run TheSkyX on earlier Windows operating systems, click Start > All Programs > Software 
Bisque > TheSkyX [Edition Name] > TheSkyX [Edition Name]. 
 
To make sure you are running the latest release, click Help > Check for Updates and follow the 
instructions. 

TheSkyX Default Installation Folder 

TheSkyX Professional Edition and TheSkyX Serious Astronomer Edition are installed to operating 
system specific folders. 

Mac 

TheSkyX is copied to the computer’s Applications folder on Mac OS X.  From Finder, choose the 
Applications command from the Go menu to view all the applications that are installed on your 
computer (A).   

Windows 

TheSkyX’s default installation location varies slightly between 32- and 64-bit Editions of Windows. 

Windows 10, Windows 8, and Windows 7 32-bit Application Support Files Folder Example 

 
The default folder for TheSkyX Professional Edition’s application support files on Windows 7 32-
bit Editions is: 
 
C:\Program Files\Software Bisque\TheSkyX Professional Edition 

 
The default folder for TheSkyX Serious Astronomer Edition’s application support files on Windows 
7: 
 
C:\Program Files\Software Bisque\TheSkyX Serious Astronomer 

Edition 

 
For 32-bit Editions of Windows, you can determine the computer’s Program Files folder from a 
Command Prompt by typing the bold letters below: 
 
C:\echo %PROGRAMFILES% <Enter Key> 

 
The default folder is:  C:\Program Files 

Windows 10, Windows 8, and Windows 7 64-bit Application Support Files Folder Example 

 
The default folder for TheSkyX Professional Edition’s application support files on Windows 7 and 
Windows Vista 64-bit Editions is: 
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C:\Program Files (x86) \Software Bisque\TheSkyX Professional 

Edition 

 
The default folder for TheSkyX Serious Astronomer Edition’s application support files on Windows 
8, Windows 7: 
 
C:\Program Files (x86)\Software Bisque\TheSkyX Serious 

Astronomer Edition 

 
Note that under 64-bit Editions of Windows, 32-bit applications are installed to the Program Files 
(x86) folder instead of the Program Files folder. 
 
On 64-bit Editions of Windows, you can determine the computer’s Program Files folder for 32-
bit applications from a Command Prompt by typing the bold letters below: 
 
C:\echo %PROGRAMFILES(x86)% <Enter Key> 

 
The default folder is: C:\Program Files (x86) 

Removing TheSkyX 

If you wish to remove or uninstall TheSkyX from your computer, please follow the procedure 
outlined below. 

Macintosh 

1. From Finder, click Go > Applications to open the Applications folder.  
2. Drop TheSkyX Professional Edition or TheSkyX Serious Astronomer Edition application 

to the trash.  Note that you must empty the trash before re-installing.  TheSkyX’s 
settings are saved to the Application Support folder.  See “Application Support Files” 
on page 26 for details how to remove them. 

Windows 

1. Log on as an administrator.  
2. Click Start > Control Panel > Uninstall a Program. 
3. Select TheSkyX Professional Edition or TheSkyX Serious Astronomer Edition from the 

list of installed programs, and click the Uninstall button.  
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Activating TheSkyX 

 

Figure 4: The Serial Number and License Agreement introduction page. 

The first time TheSkyX is launched, you must enter your name and your serial number, then 
accept to the Software License Agreement.  Click Continue from the introduction page (Figure 4) 
to get started.   
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Figure 5: Activate TheSkyX to run on this computer by entering your name and a valid serial number. 

Enter your name and TheSkyX serial number included with your purchase, then click the Continue 
button (Figure 5).   If you cannot locate your serial number for any reason, please carefully read 
the, “Where is My Serial Number?” text immediately below the Serial Number text box.  The 
Continue button will remain dimmed or inactive until a valid serial number has been entered.   
 
Remember, the name and the serial number entered here are used to activate TheSkyX to run on 
this computer, only.  Activation does not automatically register your serial number with Software 
Bisque.  See “Registering Your Serial Number” on page 23 for details how to register your serial 
number if necessary. 
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Figure 6: Software License Agreement. 

The final activation step is to accept the terms of the Software Bisque Software License 
Agreement by clicking the I accept the terms of the license agreement option (Figure 6), then 
click the Done button.  TheSkyX will now launch. 

Registering Your Serial Number 

If you purchased TheSkyX from the Software Bisque store, your serial number is registered 
automatically, and included with your web order information.  To view your registered serial 
number from your Software Bisque account, go to www.bisque.com, then click Sign In on the 
upper right side of the page to sign in.  Once signed in, click your sign in name in the upper right 
of the page to view your account profile.  From there, click the Subscriptions link on the left side 
of the page (below your account’s avatar). 
 
If you did not purchase the product directly from Software Bisque, your serial number is located 
on the outside of the media case.  We urge you to register your software at 

http://www.bisque.com/eula
http://www.bisque.com/eula
http://www.bisque.com/
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www.bisque.com/register.  After you register your serial number, you will be able to download 
the full product installer and latest update. 
 
If you received TheSkyX with the purchase of a Paramount mount, use your Paramount Software 
Suite serial number to activate TheSkyX and the Add On.  See the Paramount Quick Start Guide 
included with the mount for details. 
 
We also recommend that you keep a printed copy of your serial number for your permanent 
records.  Your registered serial number serves as one form of proof of purchase for future 
updates, and you’ll need it if you must reinstall TheSkyX. 
 

Software Subscription 

When you purchase a software product from Software Bisque, you also receive a one (1) year 
software subscription to all major and minor updates.  You can optionally renew the subscription 
each year afterward.  Details can be found at www.bisque.com/subscription. 

Small Computer Screens 

When TheSkyX is opened on a Netbook computer or a laptop with a small screen, it automatically 
configures settings to maximize screen real estate.   
 

 

Figure 7: TheSkyX’s window optimized for a 1024 x 600 Netbook computer. 

The following reminder message is displayed. 

http://www.bisque.com/register
http://www.bisque.com/subscription
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Figure 8: The Small Screen Settings Reminder window. 

Turn on the Do Not Show this Window Again checkbox to prevent this window from appearing 
in the future. 
 
Follow the instructions on the Small Screen Settings Reminder window to restore TheSkyX’s chart 
settings.  

Minimizing CPU Usage 

By default, TheSkyX continuously computes and displays the positions of astronomical objects 
(stars, satellites, asteroids, comets, and so on) at a rate of 30 times per second (30 Hz).  You may 
wish to minimize computational load on the computer’s CPU when using an older model 
computer with a slower processor, or when running a battery powered laptop by using the Sleep 
command (page 216) to temporarily suspend TheSkyX’s computations, or set the Target Frame 
Rate on the Advanced Preferences window (225) to a value of 5 or less. 
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Application Support Files 

When TheSkyX is launched for the first time, a user account-specific folder, called TheSkyX’s 
Application Support Files Folder, is created to save settings.  Examples of TheSkyX’s settings 
include: 
 

• The serial number(s) you entered for TheSkyX and optional Add Ons 

• Location, date and time settings 

• Sky Chart preferences 

• Positions of windows and dialogs 

• Tool bar positions and configuration 

• Field of view indicator databases 

• Custom field of view indicators 

• Custom panoramic horizon photos and custom drawn horizons 

• Configuration of the telescope and other equipment 

• Tour files 

• TPoint Add On settings, pointing samples and models 

• Any other TheSkyX-related files that you create and save in this folder or its sub folders 
 
Each time TheSkyX is started, the settings from the previous session are automatically restored. 
 
The Application Support Files Folder is named either TheSkyX Professional Edition or TheSkyX 
Serious Astronomer Edition, depending on the Edition that was installed.  The exact location of 
this folder depends on the operating system, as described below. 

Mac Application Support Files Folder 

TheSkyX’s application support files are in the Library/Application Support/Software Bisque folder 
in your account’s home directory.   

Notes 

 

• By default, Mac OS X versions 10.7 and later do not show the Library folder in the Finder 
menu.  To reveal and open the Library folder, from Finder, press and hold the Option key, 
then choose the Library command in the Go menu (toggling the Option key shows and hides 
the Library command).   

• TheSkyX’s settings will remain until you send them to the trash.  If you ever remove TheSkyX 
from your Mac (page 20), you will also want to delete these files and folders so that there’s 
no trace of TheSkyX on the computer. 

Windows Application Support Files Folder 

TheSkyX’s settings are in the Software Bisque folder of the Documents (Windows 8, and Windows 
7).  
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Windows 10, Windows 8 and Windows 7 

To navigate to the Documents folder, click the Start graphic and then click the Documents 
command in the Start menu.   
 
Windows Explorer opens the Documents folder.  Double-click the folder named Software Bisque, 
then either TheSkyX Professional Edition or TheSkyX Serious Astronomer Edition folder to view 
TheSkyX’s application support files and folders. 
 
TheSkyX’s settings will remain in your Documents folder until you delete them.  TheSkyX’s 
uninstaller (page 20) will not delete files or folders from your Documents folder.   

Restoring Default Settings 

TheSkyX has a broad-ranging set of features with literally hundreds of options.  If you wish to 
restore every setting and every option to the “factory defaults,” do the following: 
 

1. Exit TheSkyX. 
2. Rename TheSkyX’s Application Support Files folder.  Renaming this folder, rather than 

deleting it, creates a backup of existing settings files, just in case you want to restore a 
setting from a file later.  See “Application Support Files Directory Structure and Files” on 
page 27 for a list of, and explanation for, each folder and file, and how it is used by 
TheSkyX. 

3. Launch TheSkyX.  You’ll need to enter your serial number, just like the first time TheSkyX 
was launched. 

 
Restoring the default settings is essentially the same as uninstalling TheSkyX, deleting the 
Application Support Files folder and then reinstalling.  Remember, there’s almost never a 
compelling reason to uninstall TheSkyX, unless you want to permanently remove it from the 
computer.   

Backing Up or Copying Settings 

To backup all your TheSkyX settings, copy the entire application support files folder, including 
files and sub-folders to your backup drive.  You can also “replicate” TheSkyX’s settings on multiple 
accounts or on another computer by copying the application support files folder and all the sub-
folders to the appropriate folder on the second machine.  (See “Mac Application Support Files 
Folder” on page 26 or Windows Application Support Files Folder on page 26 for details about the 
location of these files and folders). 

Application Support Files Directory Structure and Files 

The table below describes each file and folder in TheSkyX’s application support files folder 
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Folder Name Files Description 

TheSkyX Professional 
Edition or  
TheSkyX Serious 
Astronomer Edition 
 

 This root folder stores all the files and 
folders for TheSkyX’s settings. 
 

 AppSettings.ini This text file stores TheSkyX’s 
application-wide settings, including 
the product’s serial number. 
 

ImagingSystem.ini This text file stores the configuration 
settings related to telescopes, 
cameras, focusers, filter wheels, and 
domes. 
 

LastDocument.ini This text file stores the name and 
location of the last Chart Settings file 
that was opened. 
 

Locations.txt This text file stores the database of 
locations that are displayed in the List 
of Locations tab of the Location 
window (page 36). 
 

LogFileOpen.txt This text file is a log of every file that 
TheSkyX opens or accesses when it is 
run.  It can be a useful diagnostic tool 
for troubleshooting. 
 

LogVerifyFileResources.txt This text file is a log of TheSkyX-
related resources that are opened.  It 
can be a useful diagnostic tool for 
“debugging” purposes. 
 

OutputSplash.txt This text file logs critical initialization 
points that can help diagnose startup 
problems. 
 

SDBState.inf This binary file saves stores which Sky 
Database is presently turned on. 
 

TheSkyXInstallPath.txt This text file stores the location or full 
path of TheSkyX on the computer.  It 
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Folder Name Files Description 

is used by TheSkyX’s Daily Build 
installer. 
 

WindowPositions.ini This text file stores the size, position 
and orientation of TheSkyX’s main 
window, toolbar windows and other 
windows. 
 

Asteroids  This folder is the default location for 
saving asteroid orbital element text 
files that are downloaded from the 
web. 
 

Astrometry  This folder is the default location for 
saving photo-specific files related to 
astrometric solutions. 
 

Autocalibration  This folder is the default location for 
saving files related automated 
pointing calibration runs. 
 

Comets  This folder is the default location for 
saving comet orbital element text files 
that are downloaded from the web. 
 

Database Queries  This folder is the default location for 
saving supplied and custom database 
query files.  These files end with the 
extension .dbq. 
 

Documents  This folder is the default location for 
saving Chart Settings.  These files end 
with the extension .skyx. 
 

Exported Data  This folder is the default location for 
saving exported Sky Charts. 
   

Field of View Indicators  This folder stores files related to Field 
of View Indicators. 
 

Detector geometry.txt This text file contains the database of 
cameras (or “detectors”) that is 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 30 

Folder Name Files Description 

displayed in the Detectors branch of 
the Equipment Database tree list on 
the Equipment tab of the Field of 
View Indicators window (page 120). 
 

Eyepieces.txt This text file contains the database of 
eyepieces that is displayed in the 
Eyepieces branch of the Equipment 
Database tree list on the Equipment 
tab of the Field of View Indicators 
window (page 120). 
 

My equipment.txt This text file contains a list of the 
equipment added to the My 
Equipment list on the Field of View 
Indicators window (page 120). 
 

Telescopes.txt This text file contains the database of 
telescopes that is displayed in the 
Telescopes branch of the Equipment 
Database tree list on the Equipment 
tab of the Field of View Indicators 
window (page 120). 
 

Horizons  This folder stores custom panoramic 
horizon photographs and other 
Horizon & Atmosphere (page 259) 
related files. 
 

Movies  This folder is the default location to 
save movies generated in the Create 
Tour window. 
 

Observer Log  This folder holds XML-based 
observing logs generated by the Add 
or Edit Observation button (page 82). 
 

Observing Lists  This folder stores custom observing 
lists that are generated from the 
Manage Observing List command. 
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Folder Name Files Description 

Orchestrate  This folder stores Orchestrate-related 
files. 
 

Pocket Edition Files  This folder stores TheSky Pocket 
Edition-related files (this feature is 
not currently supported). 
 

Satellites  This folder is the default location for 
saving satellite data (TLEs) 
downloaded from the web (page 
190). 
 

SDBs  This folder is the default location for 
custom Sky Databases. 
 

Source Extraction  This folder holds the Source 
Extraction configuration files. 
 

Star Chart GIFs  This folder is the default location for 
saving exported Sky Charts in GIF 
format. 
 

SVG  This folder is the default location for 
saving scalable vector graphics (.svg) 
files that can be applied to Chart 
Elements. 
 

Tours  This folder is the default location for 
saving custom tours that are 
generated by the Create Tour 
command (page 90). 
 

TPoint  This folder is the default location for 
saving TPoint data.  These files end 
with the extension .tptx.   
 
Click the TPoint Add On User Guide 
command from the Help menu for 
details about using TPoint improve 
the telescope’s pointing. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 32 

About This Documentation 

We’ll discuss customizing TheSkyX for your geographic location in a moment… 
 
The purpose of the User Guide is to familiarize you with the basic organization and structure of 
our program, and to introduce those of you who are new to the subject of astronomy to some of 
its most important terms and concepts.  We also hope the Guide will stimulate you to become 
more interested in astronomy and space science, and excited to start learning about the 
extraordinary universe we live in. 
 
We urge you join the Software Bisque support community at www.bisque.com/support.  If you 
have questions, our support staff and other knowledgeable astronomers will try to help.   

Having a Look Around 

The star chart display is the heart and soul of TheSkyX.  We call it the Sky Chart, to distinguish it 
from the real thing.  To the left of the Sky Chart you’ll find a series of stacked windows with 
vertical tabs to access the most commonly used commands and options.  You can show or hide 
stacked windows from the Display menu. 
 

 

Figure 9: TheSkyX’s default screen showing the Sky Chart, with stacked tool windows on the left and toolbars on the top. 

 

http://www.bisque.com/support
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Figure 10: The Orientation, Move and Date and Time toolbars (click and drag the checkered “gripper” on the left side of 
each toolbar to move it). 

When TheSkyX is first launched, it attempts to automatically set your location using the web; the 
date and time are read from your computer’s clock.   
 
You’ll also notice that if you are using TheSkyX during daytime, the sky it displays is blue (just like 
the actual sky).  In a moment, we’ll describe how to change that to a night view even during the 
day.   
 
To help you get started and more easily identify commands, the toolbar buttons are configured 
with large icons and text description.   
 
The software authors understand that showing both a graphic and text consumes valuable real 
estate on notebooks, smaller computer screens, or when operating TheSkyX from a remote 
computer.  To reduce the size of the toolbar buttons, click the Preferences command from the 
Tools menu (TheSkyX menu on the Mac), then click the Toolbars icon.  In the Appearance pop-
up, select Icon Only; in the Size pop-up, select Small and then click Close.  See “Customizing 
Toolbars” on page 202 for more information. 
 
Right now, let’s make sure that the program is set to display the Sky Chart from your location. 

Entering Your Location 

Home is where you hang your hat, and where most of you probably view the sky.  The first time 
TheSkyX is launched, your computer’s IP address is used to place your location on Earth, typically 
within a few miles, which is close enough for most astronomy work. 
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If you know the precise longitude of your location, you can enter it, or choose the name of the 
city you live in, or the one closest to you, from the list in the Location window. 
 

1. Highlight the Input item in the main menu.   
2. Select the first command, Location. 

 

 

Figure 11: Location window, List of Locations tab. 

A window appears displaying options for setting your location.  From the List of Locations tab, if 
you live in the U.S., double-click on United States.  A list of the major cities within your country 
appears.  You can choose your city, or the one closest to where you live, by double-clicking on it.   
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The Location on Earth used by TheSkyX (My Location) 

The My Location table shows your location on Earth as defined by its longitude, latitude, time 
zone, elevation and Daylight-Saving Option.  

Location Description (Description) 

The location Description is for reference purposes only.  Double-click the description to change 
it. 

Time Zone Offset (Time Zone) 

The time zone of a location on Earth is defined as the difference between Coordinated Universal 
Time (UTC) and local time, in hours.  For most locations, this equals your longitude divided by 15 
degrees.  In some regions, the value used for time zone can differ by plus or minus one hour.   
 
If you are unsure of your time zone, try searching the web for the time zone of a nearby city.  For 
example, a Google search for “time zone Golden Colorado” shows the following information: 
 

 

Figure 12: Results of a Google search for Golden, Colorado’s time zone. 

If you live in Golden, Colorado, USA, enter minus seven (–7) hours for the time zone. 
 

 

The value for time zone is independent of Daylight Saving Time, so the number 
entered above should not be changed when Daylight Saving Time is in effect. 
 
The Daylight-Saving Option (DSO), described below, determines whether 
TheSkyX’s time will be changed when Daylight Savings Time starts and ends for 
a given region. 

Daylight Saving Option (DSO) 

TheSkyX can be configured to automatically “spring forward” when Daylight Saving Time begins, 
then “fall back” when it ends.  Select the Daylight-Saving Option that applies for your region.  
 
See “Appendix C: Daylight Saving Time” on page 649 to see the starting and ending dates for each 
option.  The Not Observed option means that Daylight Saving Time is not observed for the 
location, so TheSkyX’s time does not change during the year, for example, if you live in Tucson, 
Arizona, USA. 
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Location Database (List of Locations) 

TheSkyX includes a large database of pre-defined locations that can be used to get you “close 
enough” to your home location.  
 
When a location is highlighted in the list, the Selected Location table shows the details for this 
location. 
 
Select a location from the list, then click the Set as My Location button, or double-click on the 
location name to use it as your location.  
 
Click the Remove button to remove the selected location. 
 
Your location settings are saved when you click the Close button, and will be used the next time 
TheSkyX is started. 

Custom Location 

Alternatively, you can enter your latitude and longitude or U.S. zip code from the Custom tab. 
 
Before entering your time zone, please carefully read “Time Zone Offset (Time Zone)” on page 
35 and “Daylight Saving Option (DSO)” on page 35 for details about how TheSkyX uses these two 
settings.   
 
A very common error is to manually change the Time Zone value by one hour when Daylight 
Saving Time is observed.  TheSkyX does this automatically.  If your local time is off by one hour, 
make sure the Time Zone is correct for your location, using the time zone definition above. 
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Figure 13: The Custom location tab (Location command, Input menu). 

Location from Zip Code (From Zip Code button) 

U.S. residents can enter a zip code to retrieve their approximate location from the web.  If your 
computer is protected by a firewall, you may need to configure the firewall settings to allow 
TheSkyX to retrieve this information from the web. 

Location from Computer’s Internet Protocol (From IP button) 

If your computer is connected to the Internet, you can obtain reasonably accurate location data 
using your computer’s IP address.  If your computer is protected by a firewall, you may need to 
configure the firewall settings to allow TheSkyX to retrieve this information from the web. 
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Adding Custom Locations to TheSkyX’s Location List (Add to Location Database button) 

After manually entering your location details, click this button to permanently save them in 
TheSkyX’s Locations List. 

Using Google™ Maps (To Google Map button) 

Compare your coordinates to a Google map to make sure they’re accurate.  Or, use the Google 
map to refine your location.  Clicking the To Google Map button launches a browser and shows 
this location on a Google Map. 
 
To refine the coordinates, adjust the map accordingly, right-click (+left-click on the Mac) on the 
map, or click the Satellite button to show the satellite photo of your observatory, for example, 
then click the Directions To command to show the precise latitude and longitude, in decimal 
format, of this point in the Driving Directions.  
 
Highlight the latitude (the first coordinate that is shown), then select the Copy command from 
the Edit menu.  From TheSkyX, right-click (+left-click on the Mac) and select the Paste 
command.  Repeat this procedure for longitude.  
 
When you’re done, click the To Google Map button again to make sure the values you entered 
are correct.  The coordinates of pointer on the map that appears should match your observing 
site. 
 

 
 

Double-check your location before proceeding!  Longitude, latitude and, most 
commonly, time zone errors result in sky charts that do not match what you see in 
the nighttime (or daytime) sky, and the telescope may not point accurately. 
 
To verify your location is correct, click the To Google Map button to show a map for 
the specified longitude and latitude coordinates.  This will show a map directly 
above the location. 
 

 

 

Location changes are prohibited while TheSkyX is connected to a telescope. 

 

Earth Map 

Yet another way to find home is to use the Location window’s Earth Map tab. 
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Figure 14: The Earth Map tab (Input > Location window). 

The default view shows a map of the entire Earth with a red stick pin at the current location.  Use 
the Zoom slider to change the magnification, and the scroll bars, or left drag on the map, to center 
the desired region.  Turn on the Show Locations checkbox to overlay TheSkyX’s List of Locations 
on the map, indicated by a small red dot.  The location descriptions will also appear at higher 
magnifications.  The Show Boundaries option shows you the approximate country and U.S. state 
boundaries.  Double-click on the map to choose the location beneath the mouse cursor. 
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The Basics 

What follows is an introductory section, which describes the basic functions of TheSkyX, and will 
help you to quickly get started exploring the marvels of the sky.  Included in this section are 
instructions for zoom, scroll, and pan controls, as well as display options, returning to home 
position, and moving/adjusting the toolbars and “dock-able” windows.  

Zoom Control 

There are several ways to zoom in and out in the Sky Chart.  You can use the zoom in/zoom out 
buttons on the toolbar, the zoom box, or by using Orientation menu controls. 

Zoom Buttons 

To zoom in on objects in the Sky Chart, simply click the zoom in button in the toolbar.  This will 
reduce your field of view, and increase the angular size of the scene (called the field of view or 
field width). 
 
To zoom out, simply click the toolbar’s zoom out button.  This will increase the Sky Chart’s field 
of view, giving you a wider field of view. 

Zoom Menu Controls 

Alternatively, you can zoom in or out using menu commands.  Under the Orientation menu, you 
will find controls to zoom in and out. 

Sky Chart Zoom Tool 

On the left side of the Sky Chart window, you will find a red zoom tool.  This tool makes it easy 
to zoom in and out with a simple click and drag.  Just click the zoom tool’s slider bar, and by 
dragging it up or down, you will zoom either in (up) or out (down).  Or, click the +/– symbols to 
zoom out or in. 
 
To show or hide the zoom tool, click the Zoom Tool command from the Tools menu. 
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Figure 15: The Zoom Tool on the Sky Chart. 

Zooming with Scroll Wheel Mouse 

If you are using a mouse with a scroll wheel feature, you can zoom in or out by simply rolling the 
wheel forward for zoom in, and backward for zooming out.  This feature is great for quick, 
convenient zooming. 

Zoom Box 

Using the zoom box is another easy way to zoom in on objects in TheSkyX.  Choose a portion of 
the Sky Chart into which you would like to zoom.  Hold down the SHIFT key (the cursor changes to 
the pointing finger) while clicking in one corner of the chosen portion, and drag the mouse to the 
opposite corner.  Release the mouse button, and the box’s caption says, “Click inside to zoom, 
outside to cancel.”   
 
Notice that the box’s diagonal dimensions appear above it in degrees, minutes and seconds of 
arc.  Click anywhere inside the box to zoom in, filling the Sky Chart’s field of view with the 
dimensions of the zoom box. 
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Figure 16: A zoom box on the Sky Chart (SHIFT+drag). 

Returning to Naked-Eye View 

Regardless of how you zoom, you can always return to the naked-eye field of view by either 
zooming out manually, or by selecting Orientation > Zoom To > Naked Eye 100°. 

Scrolling and Panning Control 

Scrolling or panning the Sky Chart’s “camera” will allow you to look at the universe in any desired 
direction, giving you that perfect view. 

Toolbar Controls 

The toolbar features four easy to use buttons for camera scrolling and panning.  By locating and 
clicking any of the four blue arrow buttons (Move Up, Move Down, Move Left, Move Right), you 
can move to camera to look up, down, left, or right.  Also, to look specifically in the four cardinal 
directions or at the zenith (straight up), locate and click the “look” buttons (Look North, for 
example).  Clicking any of these buttons will orient the Sky Chart in the corresponding direction. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 43 

 

 

Figure 17: The cardinal directions, up, and panning buttons. 

Clicking and Dragging 

Alternatively, you can adjust the field of view by left-clicking your mouse anywhere in the Sky 
Chart and dragging the view.    

Chart Navigation 

The navigate command lets you explore the digital sky through a celestial sphere map (showing 
the constellations and their boundaries), by entering specific coordinates, or by selecting a 
specific position angle. 

Using the Navigate Command 

To access the Navigate command, select Orientation > Navigate.  Three tabs at the top of the 
window indicate the navigator choices: Celestial Sphere, Sky Chart Center, and Rotation.  
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Celestial Sphere Tab 

 

Figure 18: The Celestial Sphere tab on the Navigate window. 

The Celestial Sphere tool shows a view of the entire sky with constellation boundaries.  The 
RA/Dec of the mouse pointer, and constellation name are updated in the status text.  Click the 
mouse on the graphic to center the Sky Chart on this constellation. 
 
If the chart looks too small at first, simply click and drag the window’s lower right corner to resize 
it.  After you close the window or quit the application, TheSkyX will remember the window size 
and position each time you open it. 
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By default, TheSkyX attempts to pin the local horizon near the bottom of the screen.  If the 
“clicked on” position happens to be below the horizon, the Sky Chart moves to the closest visible 
point.  Turn on the Allow Sky Chart to be Scrolled Below the Horizon option on the Horizon tab 
on the Display > Horizon & Atmosphere Options window to allow regions below the local horizon 
to be accessible. 
 
To move a region of the sky to the center of the window, click and drag the map.  Because it 
represents a sphere, the map is a continuous loop. 
 
You can remove the horizon picture from the Sky Chart altogether by deselecting the Show 
Horizon checkbox.  Click Close on the Navigate window to return to the Sky Chart.  You will notice 
that you can now scroll below the horizon either manually or with the Celestial Sphere navigator. 
 
When finished with the Navigate window, click Close to return to the Sky Chart. 
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Enter Coordinates Tab 

 

Figure 19: The Enter Coordinates tab on the Navigate window. 

Select the Enter Coordinates tab to enter specific coordinates in either equatorial (RA/Dec) or 
horizon coordinate (Az/Alt) systems. 
 
To enter coordinates, click on the desired field and directly enter the values into it.  For 
convenience, you can simply enter three numbers separated by spaces.  For example, enter 10, 
30, 29 into the RA field to specify right ascension of 10h 30m 29s. 
 
Because equatorial coordinate systems are based upon the orientation of Earth’s axis, their 
accuracy diminishes over time due to, among other factors, precession.  For that reason, many 
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publications reference equatorial coordinates at a specific point in time known as an equinox.  If 
you are using RA/Dec coordinates, it is important to choose the correct equinox (either 2000.0 
or 1950.0).  The 1950.0 equinox setting can be useful, as many older publications list equatorial 
coordinates per the 1950.0 equinox. 
 
Click Center on RA/Dec (for equatorial coordinates) or Center on Az/Alt (for horizon coordinates) 
to center the Sky Chart on the selected coordinates. 
 
When connected to a telescope, click Slew To RA/Dec to slew the telescope to these equatorial 
coordinates, or click Slew to Az/Alt to slew the telescope to these horizon coordinates. 
 
Click the Get Sky Chart Center Coordinates button to display the current coordinates of the Sky 
Chart’s center in the above coordinate fields. 
 
For your reference, example input for each of the coordinate systems appears in the Coordinate 
Input Examples near the bottom of the window.   
 
Click Close to return to the Sky Chart. 
 
See “Slewing to a Specific Coordinate” on page 381 for details about slewing a telescope using 
the Navigate commands. 
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Rotation Tab 

 

Figure 20: The Rotation tab on the Navigate window. 

The Sky Chart can be rotated to any angle, called the position angle, and it helps to match the 
Sky Chart to the actual sky and to paper charts you may use while observing or planning an 
observation session. 
 
Click the Rotation tab to view and adjust the Sky Chart’s position angle.  You will immediately see 
a graduated circle with a brown indicator showing the Sky Chart’s current position angle.  Click 
and drag this indicator to adjust the position angle to whatever you wish in real-time. 
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Near the bottom of the window, you will see the Sky Chart’s Current Position Angle.  You can 
also enter a New Position Angle into the field at the bottom of the window (to hundredths of a 
degree of accuracy).  Use the up and down arrows here for an easy way to adjust the position 
angle in whole-degree increments.  For example, if you enter 42.78°, clicking the up arrow once 
will increase the value to 43.78°. 
 
Once you have entered a position angle, click Set to update the Sky Chart. 
 
Click Close to return to the Sky Chart. 
 
The horizon is hidden automatically when you adjust the position angle.  Changing the position 
angle is equivalent to changing the direction of “down” in relation to the horizon, so the horizon 
as a reference becomes irrelevant.  TheSkyX removes it to avoid confusion. 

Mirror Image 

 
Refractors and catadioptric telescopes used with star diagonals produce mirror images of the sky 
because they have an odd number of image reflections.  Selecting Display > Show Mirror Image 
flips the Sky Chart to “reflect” the view through a refractor or catadioptric telescope with star 
diagonal. 
 

 

• The mirror image icon appears in the upper left corner of the Sky Chart when 
Show Mirror Image is turned on. 
 

• When your optical system produces mirrored photos, and one of these photos 
is used to perform a successful Image Link (page 312), Show Mirror Image is 
turned on automatically. 

Right Clicking the Sky Chart 

Commonly used commands can be accessed by right-clicking the mouse on the Sky Chart. 
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Figure 21: Right-click on the Sky Chart to access the pop-up menu above. 

Hide <Object Type> 

Right-clicking the Sky Chart when the mouse cursor is placed on a star or other object shows a 
pop-up menu where the first command is to Hide <Object Type Here>; clicking this command 
turns off objects of this type.  In Figure 21, for example, the mouse cursor was placed over a star, 
so the command reads Hide Star. 

Lock On <Solar System Object> 

Right-clicking on a solar system object shows the Lock On command (page 69) that pins the object 
to the center of the Sky Chart.  

Edit <Object Type> 

Choosing the second command in the right-click pop-up menu shows the Edit Preferences 
window that allows the attributes for this element to be changed.  See “Editing Chart Element 
Attributes” on page 236 for more information. 

Center on Cursor 

Click this command to center the Sky Chart on the right-click mouse position. 
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Frame 

Click this command to center the object on the Sky Chart and adjust the chart’s field of view to 
approximately match the object’s angular size. 

Find 

Click this command to show the Find window (page 70). 

Navigate 

Click this command to command to show the Navigate window (page 43). 

Look Pop-Up Menu 

The commands in the Look pop-up menu orient the Sky Chart to look north, south, east, west or 
directly overhead (page 150). 

Zoom Pop-Up Menu 

The commands in the Zoom pop-up menu can be used to change the Sky Chart’s field of view to 
any one of several preset values (page 40). 

Slew 

Click this command to slew the telescope to the celestial coordinates of the right-click mouse 
position on the Sky Chart (page 381). 

Abort  

Click this command to halt the telescope’s motion during a slew. 

Close This Menu 

Click this command to hide the Sky Chart’s right-click pop-up menu. 

Display Chart Elements 

In addition to the huge database of celestial objects in TheSkyX, several other useful elements, 
such as coordinate system lines, constellation boundaries, and other reference lines, are all 
available to you.  Each can be toggled on or off with ease.   

Chart Element Buttons 

On the toolbar, you will find a few buttons assigned to control chart elements (Constellation 
Figures, the Ecliptic, etc.).  To toggle a given chart element on or off, simply click the appropriate 
button.  For instance, if you want to turn on the constellation figures, locate and click the Show 
Constellation Figures button on the toolbar: the constellation figures appear in the Sky Chart.  
Also, note that the button is now a darker gray than the rest of the toolbar.  This change indicates 
that the constellation figures are turned on.  To hide them, click the button again.  The button 
color will lighten, and the constellation figures will fade from view.  There are several other chart 
element buttons on the toolbar.  Try them all to get a feel for how they work. 
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Chart Elements Window 

A complete list of chart elements is available by selecting Chart Elements from the sidebar of the 
stacked tool windows, which is located on the left side of the screen when you first open 
TheSkyX. 
 

 

 

Figure 22: The Chart Elements window (Display menu). 

If Chart Elements does not appear in your stacked tool window, or if you removed it, you can 
always access it again by selecting Chart Elements from the Display menu. 
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Locating a Chart Element by Name (Locate by Name) 

If you know the name of the Chart Element you’re after, there’s a quick way to find it in the list.  
For example, suppose you want to turn on the line that represents the galactic equator.  Typing 
the letter “g” into the Locate by Name text input shows a list of all the elements that begin with 
this letter in the pop-up menu.  Selecting Galactic Equator expands the Reference Lines and 
Photos node to reveal this option.  Press the TAB key to place the “focus” on this checkbox.   
 
From here, you can turn the checkbox on or off, or, click the Edit Attributes button to configure 
this element’s upper and lower magnitude limits, angular size limits and other display properties, 
such as the font size, line styles, fill colors and symbol.  See “Customizing Chart Elements” on 
page 236 for more information. 

Customizable Interface 

One of the great features of TheSkyX is its customizable interface.  All toolbars and “dock able” 
windows are movable and adjustable, giving you great flexibility in using TheSkyX to best suit 
your needs. 

Positioning Toolbars 

When you first open TheSkyX, you will notice rows of toolbars on the top of the screen, a stacked 
tool window on the left, and the Sky Chart on the right.   
 
When looking at the toolbars, notice that at the far left of each, you will see a textured area (or 
“gripper bar”).   
 

 

Figure 23: The textured region on the left side of toolbar windows can be used to position the toolbar. 

Clicking and dragging on this area will allow you to move that toolbar to almost any new desired 
location on the screen.  As you drag the toolbar, you will notice that portions of the screen move 
to allow you to drop the toolbar into position.  If you drop a toolbar in one of these positions, it 
will “snap” into place.  (You may also drop the toolbar over the Sky Chart in any location, without 
snapping.)  Feel free to experiment with this feature to get a feel for how the toolbars can be 
moved, as you can always move the toolbar back to its default position later.  Be sure to look 
over each toolbar, and you will see that they are divided into sections, each of which can be 
moved.  Note that the textured section denotes the beginning of a new toolbar section. 
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Moving Dockable Windows 

To the lower left of the screen, you will find a set of tool windows that are stacked together.  A 
sidebar allows you to choose which window you want to see.  All the windows stacked together 
on the left side of the screen can be moved and/or made into a new stack.  Notice that when you 
select a stacked window on the sidebar, its name also appears at the top of the window along 
with a window resize button and a close window button.  By clicking the window resize button, 
you release that window from the stack.  Now you are free to move the window to any location 
that you like by clicking and dragging it.   
 
Alternately, you can dock the window on the left or right side of the window by dragging it and 
releasing it in any area that readjusts as the window is drug over.  For instance, try clicking Labels 
in the stacked tool window.  Now click the window resize button in the top right of that window.  
The window will now undock from the stack.  Click and drag the window to the far-right side of 
the screen.  You will notice that the Sky Chart will move slightly to the left, and a dark gray area 
will appear, indicating that you may “dock” this window here.  Release the mouse button, and 
you have docked the window.  If you would like to move another window, simply repeat the 
previous steps. 
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Figure 24: The stacked tool windows, include the Tours, Find, Date and Time, Photos, Labels and Telescope, Observing 
List and other hardware-specific windows. 
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Stacking and “Dockable” Windows 

Windows can be stacked by dropping a window on top of docked windows.  When the docked 
window turns a dark gray, drop the window you are moving to stack them.   

Closing and Reopening a Docked Window 

If you wish to remove a window from view completely, simply select it from the stacked tool 
window sidebar, and click the close window button.   
 
If you want to view a window again, simply select it from the Display menu. 
 
The following windows can be stacked on the left or right side of the main window, or, by 
dragging the window’s title (caption), positioned anywhere on your computer’s monitor. 
 

• Chart Elements 

• Chart Status 

• Date and Time 

• Find 

• Labels 

• Observing List 

• Photos 

• Telescope 

• Tours  

• Telescope-specific command windows 

Full Screen 

 
The Sky Chart can fill the entire screen.  To enter Full Screen Mode, click the Full Screen command 
from the Display menu.   
 

 
Press the Escape (ESC) key on the computer’s keyboard to exit Full Screen Mode. 
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Heading Home 

The universe is a big place, and when you are ready to go home, it is nice to know that TheSkyX 
can get you there in only two clicks (that’s one clicks faster than it takes with a pair of famous red 
shoes).  When you are ready to return to your default space and time, simply click Look South, 
followed by Computer Clock, both in the toolbar.  This action will adjust the Sky Chart’s view to 
the south, and at the current time designated by your computer’s internal clock.  Welcome back! 

Restoring Default Sky Chart Settings 

Or, select the New command from the File menu whenever you want to restore TheSkyX’s chart 
settings to their default values.   
 
This will show the daytime sky (Show Daylight command, Display menu), set the date and time 
to the computer’s clock and (turn on the Computer Clock button on the Date and Time window, 
Input menu), shows the default objects labels, object types, reference lines, object magnitude 
and size limits; just like when TheSkyX was first launched. 

Saving & Retrieving Your Sky Chart 

Your Sky Chart settings can be saved and opened at any time by creating special TheSkyX files 
with the extension .skyx. 

Saving Your Sky Chart 

You can save your current Sky Chart, along with all its settings, at any time by selecting the Save 
command from the File menu.  This saves the Sky Chart (as a. skyx settings file), which is a handy 
way to save data you wish to quickly recall later, such as when you journey to your favorite hilltop. 
 
Choosing the Save As command from the File menu allows you to save the settings without 
overwriting the current settings file. 

Opening an Existing File 

To open an existing Sky Chart, select the Open command from the File menu.  You will then be 
able to search your hard disk for existing .skyx files. 

Help Options 

As you continue to use TheSkyX and read through this User Guide, keep in mind that we have 
included the complete User Guides for both TheSkyX and the TPoint Add On, as well as an XML-
based help, and all are accessible from TheSkyX’s Help menu.  Even the most seasoned observer 
sometimes needs a little help, and with all the features packed into TheSkyX, it is handy to always 
have a reference guide at your fingertips. 
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Help Search 

You can easily search through TheSkyX’s many commands by entering search terms into the Help 
menu’s search field.  For more detailed help, continue reading for more help options. 

TheSkyX Help - Assistant 

TheSkyX includes a powerful, html-based help guide called Assistant, which is designed to help 
you to get the most out of TheSkyX, no matter how you plan to use it.  Whether you use TheSkyX 
to plan for meteor showers, or you want to use the most advanced telescope controls, TheSkyX 
Assistant is there for you, regardless of your user experience. 

TheSkyX User Guide 

This user guide is available, in its entirety, can be viewed, or searched by selecting Help > TheSkyX 
User Guide to access it. 

TPoint Add On User Guide 

TPoint software is an advanced telescope pointing analysis system that allows you to analyze and 
model the errors inherent to a telescope system to dramatically improve pointing performance.  
TheSkyX offers the optional TPoint Add On that integrates telescope modeling and pointing 
corrections, polar alignment assistance, automated pointing calibration (Professional Edition 
only) and TPoint-assisted tracking corrections via ProTrack™ on Paramount model mounts.   
 
Both TheSkyX Serious Astronomer Edition and TheSkyX Professional Edition come with a trial 
version of the TPoint Add On, which can be activated the first time you use the add on, after 
which time, you must purchase a license separately.  TPoint can be accessed from the Tools 
menu. 
 
Like many aspects of an imaging system, there is a significant learning curve with TPoint.  
Fortunately, TheSkyX makes using TPoint smooth, and you should be able to complete a pointing 
calibration run on the first night and start analyzing your system right away.  The TPoint Add On 
User Guide in PDF format can be viewed by clicking Help > TPoint Add On User Guide. 
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Finding and Identifying Celestial Objects 

 
TheSkyX’s astronomical databases can quickly locate any one of up to a billion objects, either by 
clicking on the object on the Sky Chart (called “identifying a target”) or with the Find command 
from the Edit menu.  

Identifying Target Objects 

The Sky Chart is linked to TheSkyX’s astronomical databases.  Click the left mouse button on any 
celestial object to identify it, and display the Object Information Report on the Find window (the 
Find window will be displayed automatically if it is hidden).  The Object Information Report 
provides a wealth of information about the object. 
 
You can also search for objects by name or catalog number using with the Find command on the 
Edit menu (see “Finding Objects” on page 70 for more information).   
 
A red bull’s eye appears on the Sky Chart at the mouse click position (Figure 26) and identifies 
this object as the target object, or target.  Tool bar buttons that act on, or apply to, the target 
include a red or green target graphic. 

Object Information Report Contents 

• the object’s common name and/or its catalog designation  

• the graphical symbol used to represent this object on the Sky Chart 

• cross references to other catalogs (in the Name 2–Name 10 fields) 

• the object’s type (planet, variable star, irregular galaxy, and so on) 

• the constellation in which the object lies 

• the object’s magnitude 

• a star’s Bayer (Greek-letter) brightness designation 

• the plain English Dreyer description for the object 

• the object’s distance from Earth, in light years and AU (where available) 

• catalog-specific information (such as min/max magnitude of variable stars, spectral class, 
parallax, proper motion, position error, distance from the Solar System) 
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• the object’s topocentric equatorial (RA-Dec) coordinates, for both the date specified in 
the Date and Time window (page 139) and Equinox 2000.0  

• the object’s current horizon (Az-Alt) coordinates  

• the object’s rise time, transit time and set time for the site location and the object’s 
angular dimensions 

• the angular separation from the last object identified 

• the object’s position angle (the angle between the line connecting the object and the last-
identified object, and the line connecting the last identified object and the North or South 
Celestial Pole) 

• Other catalog and object-specific information 
 
“Appendix J: Object Properties” on 667 includes a comprehensive list of objects properties. 
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Figure 25: The Object Information Report appears on the Details pane of the Find window (Edit menu). 
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The target is highlighted with a red bull’s eye on the Sky Chart (Figure 26).  Press the ESCAPE key 
to hide the bull’s eye. 

 

Figure 26: The Sky Chart displays a bull’s eye centered on the current target.   

The object you clicked on (or located using the Find command), and up to ten “nearby” objects 
(or objects with names that closely match this object), are listed in the Related Search Results 
box.  This eliminates any need to click exactly on the object, and makes it easy to study groups of 
objects without having to click on each one.  If you click in an area without any nearby objects, 
the Mouse Click Position is the only entry.  
 

 

Figure 27: The text color indicates the object's visibility (green means the object is currently above horizon; black text 
means it is below horizon). 

The object’s symbol (a yellow star in Figure 25) is displayed next to the object’s name.  When the 
object’s name is displayed with green-colored text, the object is presently above the horizon.  
Black-colored text means the object is currently below the horizon. 

Identifying Galaxies, Nebulas, and Open Clusters 

At wide fields of view, galaxies, nebulas and open clusters are displayed as their standard 
symbols.  At higher magnifications, the symbols are replaced with circles or ellipses that 
represent the shape and dimensions of the object.  Within these extended objects, there is no 
marked point on which to click.  If the object is displayed as a circle, you can click anywhere within 
the circle.  For objects displayed as ellipses, click within the circular region defined by the ellipse’s 
minor axis, as shown in the drawing below.  
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Figure 28: Click inside the shaded circle to identify this extended object (galaxy). 

The Andromeda galaxy (M31) is one example of an extended object.  You need to click on a point 
towards the center of M31 – without too many nearby stars – to identify it.  Click on the central 
region of stars to identify them.  
 

 

Figure 29: The target object-specific buttons on the Find window. 

Centering Objects on the Sky Chart (Center button) 

The Center button repositions the Sky Chart with the identified object at the center. 

Framing Objects (Frame button) 

The Frame button repositions the Sky Chart with the identified object at the center and adjusts 
the field of view to show extended objects. 
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The default field of view for point sources (or cataloged objects that do not have size information) 
is 10 arcminutes.  To use a different framed field width, change the Default Frame Size when 
Object Size is Unknown value on the Non-Stellar Object Options window from the Display menu. 

Show Photographs, HR Diagrams and Notes (Show Photo+ button) 

If the identified object has a photograph (not all objects have photographs), the Show Photo+ 
button shows it in the Photo Viewer window (Figure 30). 
 

 

Figure 30: Photo Viewer window showing a photo of Jupiter. 
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If the identified object is a star that has spectral class information, a Hertzsprung-Russell (HR) 
diagram is displayed instead.  The yellow crosshairs show star’s color relative to other stars. 
 

 

Figure 31: HR Diagram for a Hipparcos-Tycho star 68686. 

Show only the Hipparcos Stars on the Current Sky Chart 

Choose this option to graph only the Hipparcos stars that are on the current Sky Chart. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 66 

Show the Brightest 15,000 Hipparcos Stars 

Choose this option to show the brightest stars from the Hipparcos catalog on the current Sky 
Chart. 

Observing and Other Notes about Objects (Notes tab) 

TheSkyX includes interesting and educational notes on the constellations, many Messier, IC and 
NGC objects as well as hundreds of stars. 
 

 

Figure 32: Notes for the star named Heze. 
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• Constellation notes based on the book Star Tales by Ian Ridpath 

• Star notes from Jim Kaler (professor emeritus of astronomy, University of Illinois)   

• Visual observing notes of selected objects by Steve Gottlieb 

• Visual observing notes of selected objects by Tomm Lorenzin 
 
These notes are copyrighted and distributed with permission. 

Slew the Telescope (Slew button) 

When a telescope connection is established, click the Slew button to command the telescope to 
slew to this object. 

Aborting Telescope Slews (Abort button) 

If you change your mind after clicking the Slew To button, click the Abort button to terminate 
the slew.  This button is available only while the telescope is slewing. 

Copy Object Information Report to Clipboard (Copy Text button) 

To copy all the information in the Object Information Report to the Clipboard, click the Copy 
button.  Or, right-click (+click on the Mac) on the report and click the Copy Text command in 
the pop-up menu. 
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Figure 33: Right-clicking over the Object Information Report to show a context pop-up menu. 

To copy the contents of a single field, move the mouse cursor over it, right-click the mouse 
(+click on the Mac) and then click the Copy ‘<Field Name>’, where ‘<Field Name>’ is the name 
of the information field beneath the mouse cursor. 
 
Other pop-up menu commands allow copying just the equatorial coordinates (2000.0 or current), 
or toggling the number formatting between sexagesimal and decimal format. 

Adding Objects to an Observing List (Add to List button) 

TheSkyX can create an observing list of the objects.  To add this object to the Observing List, click 
the Add to List button.  See “Observing Lists” on page 288. 
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Locking on a Solar System Object (Lock On button) 

If the target object is a planet, moon or other solar system object, click the Lock On button to pin 
this object to the center of the Sky Chart.  Locking on to a solar system object can reveal 
interesting phenomena.  For example, the motion of Jupiter’s moons can be observed by locking 
on Jupiter, then performing a time skip, and can be reveal when a Jovian moon’s shadow is visible 
on Jupiter’s surface (shadow transit, page 179) or when a moon passes behind the planet 
(occultation, page 179).  The procedure described below can also be used to track the motion of 
other solar system objects. 

To Observe the Motion of Jupiter’s Moons 

1. Choose the Find command from the Edit menu. 
2. Type Jupiter. in the Search For text box, then click the Find button.  Note that placing a 

period immediately after any name in the Search For text box and then clicking the Find 
button automatically frames the object on the Sky Chart.  If the period is omitted in the 
search for text, click the Frame button to frame the Jupiter now. 

3. Click the Lock On button to pin Jupiter to the center of the Sky Chart.   
4. Choose the Celestial Sphere command from the Orientation menu to orient the Sky Chart 

so that the celestial pole is toward the top of the window and Jupiter’s pole always points 
up on the screen. 

5. From the Date & Time window, choose a time skip increment of 1000x (or other time skip 
increment), then click the Go Forward button to watch the motion of Jupiter’s moons 
over time.   

 
Figure 34 shows a “triple shadow transit” that occurred on June 3, 2014.   
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 70 

 

Figure 34: Sky Chart showing a triple Jovian moon shadow transit. 

As a reminder, the text Locked on <Solar System Object> appears in the lower right corner of the 
Sky Chart.  Left-click and drag the screen to break the lock.  
 
Objects outside the solar system cannot be locked on. 
 
As a reminder, the text Locked on <Solar System Object> appears in the lower right corner of the 
Sky Chart.  Left-click and drag the screen to break the lock.  
 
Objects outside the solar system cannot be locked on. 

Finding Objects 

You don’t have to locate an object in the Sky Chart to get information about it.  The Find 
command in the Edit menu can locate every object in TheSkyX’s databases.  
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You can also access it by pressing F, or by clicking the Find button in the Edit toolbar.  Selecting 
the Find command displays the Find window, which provides several ways to locate any object. 

Finding by Name 

One way to find an object is to enter its name (Aldebaran, Bear Paw) in the Search For text input.  
You can enter the names of comets, minor planets, and auxiliary objects that appear in any active 
Sky Database.  
 
For example, to find the Orion Nebula, type Orion Nebula and click the Find button.  The Object 
Information report shows details about the Orion Nebula.  If the Orion Nebula is within the 
current field of view, it’s marked with a bull’s eye.  
 
You can also search for a star by manually entering its Bayer (Greek-letter) magnitude 
designation, followed by the constellation’s three-letter abbreviation.  For example, to find the 
third-brightest star in Orion, type Gamma Ori.  Clicking the Find button locates that star, Bellatrix. 
 
Great Nebula in Orion   
Gamma Ori  

If you are not sure of the correct spelling… 

Star names are Greek, Arabic, or Latin.  You don’t have to know the correct spelling.  The Find 
command shows you matching names. 
 

 

Figure 35: A list of matching names appears as you type. 
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For example, if you enter ‘Or” the Search For text input shows objects that start with these 
letters. 

The Milky Way and the Magellan Clouds 

The Milky Way (our galaxy) is displayed as a photograph or draw as a polygon that can cover a 
significant portion of the Sky Chart.  Keeping track of its boundaries in all cases would consume 
too many resources.  It was therefore decided not to identify the Milky Way when you click inside 
it.  At narrow fields of view, the Milky Way’s boundaries are not usually visible, and the polygon 
forms a solid background color.  This is potentially confusing (“Is that the Milky Way or a 
nebula?”), so the Milky Way is not displayed at fields of view below 20°. 
 
The Magellanic Clouds (the two smaller galaxies “attending” our galaxy) are large, complex 
objects.  The Small Magellanic Cloud is shown as a filled ellipse and is easy to spot in the Sky Chart 
– it’s located at a right ascension of about 1h, not far from the south celestial pole.  Type the text 
‘Small Magellanic Cloud’ in the Search For text input and then click the Find button to locate it. 
 
By default, the Large Magellanic Cloud is not shown as a specific object.  To display the region in 
which it’s located, search for Large Magellanic Cloud.  To have TheSkyX draw a polygon that 
represents this region, select the Large Magellanic Cloud Sky Database in the Database Manager 
window from the Input menu. 

Entering Catalog Numbers with the Mouse 

Because it can be difficult to type keyboard keys in the dark, TheSkyX includes a method for 
entering catalog numbers with the mouse.  
 
On the Advanced Find tab, click the numbers (and the decimal point) on the right to enter 
numerical keys.  Clicking Space enters a space.  Clicking Back deletes the last (rightmost) 
character in the edit box, regardless of the current location of the text cursor.  

Advanced Searches 

Finding by Object Type 

Objects are categorized by type in the Find by Name or Catalog Number list on the Advanced 
tab of the Find window.  
 
A simple way to find any object is to first determine its type (is the object a star, galaxy, cluster 
or other?).  Next, determine what catalog you want to search and then select the name of the 
object from the catalog list.  The table below lists each category in the Find tree list. 
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Object Type  Catalog/Cross Reference Description 

Asterisms  Lists the names of many common 
asterisms. 
 
 

Constellations   Lists the names of the 88 constellations. 
 

Non-stellar 
Objects 

  Lists databases of non-stellar objects. 
 

Caldwell Caldwell Catalog objects. 
 

Common Names Names of common non-stellar objects. 
 

Herschel Herschel 400 catalog. 

IC Index Catalog. 

Lorenzin Tomm Lorenzin Catalog. 

Messier Messier Catalog. 

NGC New General Catalogue. 

PGC Principal Catalog of Galaxies. 

PGC cross reference Cross references to the Principal Catalog 
of Galaxies. 

PLN Planetary Nebulae. 

SAC* Saguaro Astronomy Club Deep Space 
Object catalog. 

Sky Databases 
(SDBs) 

Optional (non-core) databases  These optional Sky Databases (SDBs) can 
be turned on from the Database Manager 
command in the Input menu. 
 

Solar System   Objects within our solar system. 
 

Meteor Shower Radiants 
 

Locations of meteor showers. 

Moon Earth’s Moon. 
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Object Type  Catalog/Cross Reference Description 

Planets (alphabetical) Earth  
Jupiter 
Mars 
Mercury 
Neptune 
Saturn 
Uranus 
Venus 
 

Satellites Man-made satellites that have been 
imported from the Satellites window on 
the Input menu. 
 

Small Solar System Bodies Objects that are classified as Small Solar 
System Bodies by the IAU. 

 

Asteroids (Large Database): Names of 
asteroids that have been imported from 
the Large Database tab on the Small Solar 
System Bodies windows (Input menu). 
 

Asteroids (Small Database): Names of 
asteroids that have been imported from 
the Small Database tab on the Small Solar 
System Bodies windows (Input menu). 
 

 Comets: Names of comets selected in the 
Comet tab on the Small Solar System 
Objects window (Input menu). 
 

Dwarf Planets Pluto 
 

Sun The Sun. 
 

Stellar 
Objects  

  Lists databases of stars. 
 

Bayer Bayer catalog designations. 

Common name Common star names. 

DM Bonner Durchmusterung number. 

Flamsteed Flamsteed designations. 

GCVS General Catalog of Variable Stars. 
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Object Type  Catalog/Cross Reference Description 

GSC Guide Star Catalog. 

HD Henry Draper Number. 

NSV Catalog of Variable Stars. 

SAO Smithsonian Astrophysical Observatory. 

Struve Struve Catalog stars. 

WDS Washington Double Star catalog. 

SAC Cross References 

The Saguaro Astronomy Club Database contains cross references to the astronomical catalogs in 
the table below. 
 

Catalog Name SAC Cross Reference 

Third Cambridge Catalog of Radio Wave Sources 
 

3C  

George Abell (planetary nebulae and galaxy clusters) 
  

Abell 

Aitken Double Star catalog 
 

ADS 

Arp-Madore (globular clusters) 
  

AM 

(open clusters) 
 

Antalova 

Apriamasvili (planetary nebulae) 
 

Ap 

Halton Arp (interacting galaxies) 
 

Arp 

Barkhatova (open clusters) 
  

Bark 

Barnard (dark nebulae) 
 

B 

(open clusters)  
 

Basel 

Bonner Durchmusterung (stars)  
 

BD 

Berkeley (open clusters) 
  

Berk 

Bernes (dark nebulae)  
 

Be 

Biurakan (open clusters) 
  

Biur 

(open clusters)  Blanco 

http://www.saguaroastro.org/content/db/SAC_DeepSky_Ver80.zip
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Catalog Name SAC Cross Reference 

 

(open clusters) 
 

Bochum 

Cederblad (bright nebulae) 
 

Ced 

Catalog of Galaxies and Clusters of Galaxies 
 

CGCG 

Collinder (open clusters)  
 

Cr 

(open clusters) 
  

Czernik  

David Dunlap Observatory (dwarf galaxies) 
 

DDO 

Dolidze (open clusters) 
  

Do 

Dolidze-Dzimselejsvili (open clusters) 
  

DoDz 

Dunlap (Southern objects of all types) 
  

Dun 

European Southern Observatory (Southern objects) 
 

ESO  

Feinstein (open clusters) 
 

Fein  

(open clusters)  
 

Frolov  

(bright nebulae)  
 

Gum  

William Herschel (globular clusters) 
  

H  

(open clusters) 
 

Haffner  

(open clusters) 
  

Harvard  

Havermeyer and Moffat (open clusters) 
  

Hav-Moffat  

Henize (planetary nebulae) 
  

He  

(open clusters)  
 

Hogg  

Holmberg (galaxies)  
 

Ho  

Haute Provence (globular clusters)  HP  
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Catalog Name SAC Cross Reference 

 

Humason (planetary nebulae)  
 

Hu  

1st and 2nd Index Catalogs to the NGC (All types of objects 
except dark nebulae) 
  

IC  

Iskudarian (open clusters)  
 

Isk  

Jonckheere (planetary nebulae)  
 

J  

Kohoutek (planetary nebulae)  
 

K  

Father Lucian Kemble (asterisms)  
 

Kemble  

(open clusters) 
  

King  

Krasnogorskaja (planetary nebulae) 
  

Kr  

Lacaille (globular clusters) 
  

Lac  

(open clusters) 
  

Loden 

Lynds (bright nebula)  
  

LBN 

Lynds (dark nebulae) 
  

LDN 

Northern Proper Motion, 1st part, Galaxies 
 

NPM1G 

(open clusters) 
 

Lynga  

Messier (all types of objects except dark nebula) 
  

M 

Morphological Catalog of Galaxies 
 

MCG  

Merrill (planetary nebulae) 
 

Me  

Markarian (open clusters and galaxies) 
  

Mrk  

Melotte (open clusters) 
  

Mel  

Minkowski (planetary nebulae) 
 

M1 thru M4  
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Catalog Name SAC Cross Reference 

New galaxies in the Revised Shapley-Ames Catalog 
 

New  

New General Catalogue of Nebulae & Clusters of Stars.  (All 
types of objects except dark nebulae) 
 

NGC  

Palomar (globular clusters) 
 

Pal  

Peimbert and Costero (planetary nebulae) 
  

PC  

(open clusters)  
 

Pismis  

Perek & Kohoutek (planetary nebulae) 
  

PK  

Rodgers, Campbell, & Whiteoak (bright nebulae) 
  

RCW  

(open clusters) 
  

Roslund  

Ruprecht (open clusters)  
 

Ru  

Sandqvist (dark nebulae) 
  

Sa 

(open clusters) 
  

Sher 

Sharpless (bright nebulae) 
 

Sh  

Sandqvist & Lindroos (dark nebulae) 
  

SL  

Shapley & Lindsay (clusters in LMC) 
  

SL  

Stephenson (open clusters) 
  

Steph  

(open clusters) 
 

Stock  

Terzan (globular clusters) 
  

Ter  

(open clusters) 
  

Tombaugh  

Tonantzintla (globular clusters) 
 

Ton  

Trumpler (open clusters)  
 

Tr  

Catalog of selected Non-UGC galaxies UA  
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Catalog Name SAC Cross Reference 

 

Uppsala General Catalog (galaxies) 
  

UGC 

United Kingdom Schmidt (globular clusters) 
  

UKS  

(open clusters) 
 

Upgren 

Vorontsov-Velyaminov (interacting galaxies)  
 

VV 

van den Bergh (open clusters, bright nebulae) 
  

vdB  

van den Bergh & Herbst (bright nebulae) 
  

vdBH 

van den Bergh-Hagen (open clusters) 
  

vdB-Ha 

Vyssotsky (planetary nebulae) 
 

Vy  

(open clusters) 
 

Waterloo  

Double Star (Messier 40) 
  

Winnecke 

Zwicky (galaxies) 
 

ZWG 

 
To locate objects in the SAC, in the Search For text input on the Find window, enter SAC <Cross 
Reference> <Catalog Number> and then click the Find button.  For example, entering the text 
SAC Cr 33 locates this open cluster in the Collinder catalog. 

Finding by Catalog Designation 

Another way to find an object is to enter its catalog designation.  Leading zeroes are not required; 
the search routine automatically adds them.  Typing just the catalog abbreviation (with no 
number) lists the first 10 items in the catalog. 
 
The Tycho catalog’s designers indexed it with the corresponding GSC numbers.  We have 
therefore not included it as a searchable catalog.  

Searching Catalogs by Cross Reference  

Objects can be located using catalog designations that are cross referenced to the source catalog.  
The table below lists the available cross-reference catalogs and their prefixes, along with the 
number of galaxies in the catalog (Count) and an example of the correct format to use when 
search for an object in this catalog.   
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See Catalog Cross References in Appendix A: Databases and Cross References on page 632 for a 
list of these catalogs. 

More Find Examples 

The following tables show a variety of useful search queries for the Locate By Name text box. 
 

Star Name  Type of Query  

Polaris  Common star name  

SAO 308  Smithsonian Astrophysical Observatory star 

GSC 4628:237  Guide Star Catalog number 

HIP 11767  Hipparcos identifier  

PPM 431  Positions and Proper Motions (PPM) number  

HD 8890  Henry Draper number  

B+88 8  Bonner Durchmusterung catalog  

C-34 12784  Cordoba Durchmusterung catalog 

P-42 7856  Cape Durchmusterung catalog 

  

Flamsteed/Bayer (use 
constellation abbreviation)  

Result 

ALPHA UMI  (Alpha Ursae Minoris)  

25 PSI 1 ORI  25 Psi 1 Orionis  

  

Non-stellar Objects Result 

Great Nebula in Andromeda Common non-stellar object name 

M31 M31 Messier Object 

NGC 224 NGC 224 in the New General Catalog 

IC 434 IC 434 in the Index Catalog  

PGC 18508 Principal Galaxies Catalog 

GCVS GK ORI General Catalog of Variable Stars 

NSV New Suspected Variable Catalog 

PLN 194+2.1 Planetary Nebula 

 

Solar System Objects  Result 

Saturn  Finds Saturn  

Wild 4  Finds the comet named "Wild 4"  

Ceres  Finds small database asteroid named "1 Ceres"  

MPL 835 OLIVIA  "MPL" prefix finds that asteroid (or minor planet) 
named "835 Olivia" from the large asteroid database.   

  

Uranometria Star Charts  Result 
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URA 36  Centers on Uranometria star chart number 36  

URA 36+  Centers on Uranometria star chart number 36 and sets 
Uranometria-like chart attributes.   

 

Satellites/Spacecraft Result  

SAT COSMOS 100  Searches for the satellite named "Cosmos 100"  

 

Miscellaneous Objects  Result  

Zenith Moves to 90 degrees altitude  
 

AAVSO A  Sets field width to AAVSO type A (accepts a-g)  
 

RA decimal hours, Dec 
decimal degrees 
 

Enter any RA, Dec coordinate pair, separated by a 
comma and in decimal format and click the Find 
button to locate this position on the Sky Chart and 
display information about it in the Object Information 
window. 
 
For example, enter 12.3, 13.4 to locate this 
coordinate on the Sky Chart. 
 

RA hours RA minutes RA 
seconds, Dec degrees Dec 
minutes Dec seconds 
 

Enter any RA, Dec (2000.0) coordinate pair, separated 
by a comma, in sexagesimal format, and click the Find 
button to locate this position on the Sky Chart display 
information about it in the Object Information 
window. 
 
For example, enter 10h 26m 36.2s, 40d 20m 22.8s to 
locate this coordinate on the Sky Chart.  See Finding 
by Equatorial Coordinate below for more information. 
 

Z2.5  Zooms to a 2.5-degree field of view  
 

Z2.5m  Zooms to a 2.5-minute field of view  
 

Z200s  Zooms to 200 arcsecond field of view  
 

SCALE 2.5  Adjusts the sky chart so that the scale is 2.5 
arcseconds/pixel 
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Finding by Equatorial Coordinate 

The Sky Chart can be centered on a RA, Dec coordinate (2000.0) using either decimal or 
sexagesimal format.   

Decimal format 

Enter any RA, Dec coordinate pair, separated by a comma and in decimal format and click the 
Find button to locate this position on the Sky Chart and display information about it in the Object 
Information window. 

 
For example, enter 12.38893, 13.43345 and then click the Find button to locate this coordinate 
on the Sky Chart. 

Sexagesimal format 

Enter any RA, Dec coordinate pair, separated by a comma, in sexagesimal format: 
 
UUh VVm WWs, XXd YYm ZZs 
 
Each component is described in the table below. 
 

Designation Description 

UU  
 

A number between 0-23 specifying the hours of RA. 

h 
 

The lower-case letter “h” specifying the preceding number is RA hours. 

VV  
 

A number between 0-59 specifying the minutes of RA. 

m 

 
The lower-case letter “m” specifying the preceding number is RA minutes. 

WW 

 
A number between 0-59.99999 specifying the seconds of RA. 

s The lower-case letter “s” specifying the preceding number is RA seconds, 
 

, A comma character (“,”) separates the RA coordinate from the Dec 
coordinate. 
 

XX  
 

A number between 0-89 specifying the degrees of declination. 

d  The lower-case letter “d” specifying the preceding number represents 
degrees of declination. 
 

YY A number between 0-59 specifying the minutes of declination. 
 

m  The lower-case letter “m” specifying the preceding number represents 
arcminutes of declination. 
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ZZ A number between 0-59.99 specifying the seconds of declination. 
 

s The second lower-case letter “s” specifies the preceding number represents 
arcseconds of declination. 
 

 
Sexagesimal format example: 
 
10h 12m 32.22s, -80d 12m 44.3s 

Logging Observations 

Click the Log tab on the Find window to view the observing log and notes for this object.  
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Figure 36: The Log tab on the Find window showing an observation notes for a star. 
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Click the Add or Edit Observations button to show the Observer Log window that allows you to 
add notes, a seeing scale, rating and other information for the current object, and view a table 
of your observations. 
 

 
Note: The object observed graphic (above) appears on the Log tab for objects that have a 
recorded observation. 
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Figure 37: Observer Log window. 

Observations are stored in XML format in the Observer Log folder located in the Application 
Support folder (page 26).  See “Add Observing Notes (Add to Observer Log)” on page 296 for more 
information about Observer Logs. 
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Labeling Objects 

  

 

Figure 38: Common star, Bayer and Flamsteed designation labels near the Pleiades Nebula (M45). 
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The first time TheSkyX runs, the common names for the planets are shown.  To show the names 
of other objects, select the Labels command from the Display menu to turn on the Labels window 
or click the Labels tab to make it visible. 
 

 

Figure 39: The Labels window (Display menu > Labels command). 
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The Labels window allows you to show or hide the names of the following common objects. 
 

• Asterisms 

• Asteroids (Name, Magnitude and Number)  

• Comets 

• Common Star Names 

• Bayer Designation 

• Flamsteed Designation 

• Common Non-stellar Object Names 

• Constellations 

• Cardinal Directions 

• Messier Objects 

• Meteor Shower Radiants 

• Planets, Dwarf Planets, Moons and the Sun 

• Spacecraft or Artificial Satellites (Name, Range and Latitude/Longitude Position) 

• Detailed and customizable catalog specific labels 
 
Turn on the checkbox next to the desired common label to show it.  Turn off the checkbox to hide 
the label. 
 

Detailed Labels 

 
The astronomical catalogs used by TheSkyX also contain catalog-specific information that might 
be useful to show on the sky chart.  Detailed Labels can also be shown for star and non-stellar 
catalogs and custom Sky Databases (SDBs). 
 
For example, if you’re working with double stars, you can show a detailed label that contains the 
magnitude and angular separation between star systems in Washington Catalog of Double stars 
by expanding WDS in Stellar Objects section under Detailed Labels.   
 
Or, if you’re researching galaxies in the New General Catalogue (NGC), you might want to show 
a detailed label that includes blue magnitude and equatorial coordinates (Detailed Labels > Non-
stellar Objects > NGC Identifier group). 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 90 

 
Detailed labels are shown on the Sky Chart at 60° fields of view and smaller. 

Showing Labels (Show Labels) 

This checkbox shows or hides the check marked labels.  

Finding a Specific Label (Locate a Label by Name) 

Use this text input to quickly locate (and turn on or off) a common name or detailed label in the 
labels tree.  For example, to turn on Messier labels, type “m”; the labels that begin with this letter 
appear in the pop-up menu.  Select Messier Objects to expand the labels list and show the 
Messier Objects checkbox.  Pressing the TAB key highlights the checkbox 

Turning Labels Off (Turn Off All Labels) 

Press this button to turn off the Show Labels checkbox and turn off every checkbox in the labels 
list. 

Label Density (Maximum Number of Labels on Sky Chart) 

Adjust this slider to change the number of labels that will appear on the Sky Chart at one time.   
 
Label Size (Label Scale Factor) 
The default size of all chart element labels can be scaled from 80 percent to 200 percent.  This 
option is especially useful for making fonts larger on high-resolution or “High DPI” displays. 

Anti-aliased Labels (Enable Smooth Moving Labels)  

When this checkbox is turned on, the font used to display labels is “anti-aliased” so that the 
motion of the label, particularly during time skip animations, is smooth.  When this option is 
turned off, you might notice an otherwise slight “jerky motion” of fonts during animations. 

Tours 
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Before we investigate the various menu and “button” commands arranged across the top of the 
screen, let’s explore some of the tours that have been created to demonstrate some common 
yet fascinating things you can see in the sky. 
 
Notice the series of tabs running vertically on the right side of the main.  Select the tab labeled 
Tours.  If this window is not visible, click the Tours command from the Display menu to show it.  
A list of available tours is displayed: 
 

• Analemma 

• Angular size of Mars 

• Coordinates – Equatorial 

• Coordinates – Horizon 

• Mercury evening visibility 

• Mercury morning visibility 

• Moon cycle – size and phase 

• Motion of Barnard’s Star 

• 24-Hour Motion of Saturn’s Moons 

• Rotation and Phase of Mercury 2008 

• Rotation and Phase of Venus 2008 

• Saturn from Earth Over 10 Years 

• Venus and Mercury Paths 

• What Was That? (Iridium Flare Example)  

• Winter Constellations 
 
Go ahead and take one of the tours.  Highlight one that sounds interesting, then click the Start 
button.  Or, click the Run All button to watch them consecutively. 

Creating Tours 

 
 
TheSkyX Professional Edition provides a powerful interface that can be used create tours that 
simulate astronomical events, highlight interesting objects, or demonstrate astronomical 
concepts.   
 
A tour is based on a timeline that can be as long or as short as you want.  Any number of 
waypoints can be added to the timeline at which you can “show something” (for example, turn 
on the constellation lines) or “do something” (for example, perform a 100-year time skip 
simulation) by executing a macro command.  One, or any number macro commands can be 
executed at each waypoint, providing a virtually unlimited set of tools to create educational 
demonstrations.  Tours can be saved later in QuickTime movie format. 
 
To get started, let’s look at one of the supplied tours.  
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1. Highlight the Winter Constellations tour on the Tours window.  Click the Tours command 

from the Display menu to show this window if necessary.  This displays the Tour Information 
tab. 

 

 

Figure 40: The Tour Information tab on the Create Tour window. 

2. Enter the title of the tour in the Title on Sky Chart text input.  This text will appear at the top 
of the Sky Chart while the tour is running. 

3. Enter a Tour Description as plain text or HTML.  This description appears on the Tours window 
when the tour name is highlighted. 
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4. To play a sound at the beginning of the tour, click the Choose button and select the file.  Turn 
on the Loop Continuously checkbox to play the tour repeatedly. 

5. Drag the tour time pointer to 0 seconds or click the Rewind button to go to the beginning of 
the tour.  The Macro Commands at Waypoint text input now shows the four macros that will 
be run when the tour begins. See “Appendix D: Macro Commands” on page 653 for a 
complete list of available macro commands. 

6. Drag the time pointer under each red arrow to reveal the macro commands for that waypoint.   
7. Click the Rewind button, then the Start button to watch the entire tour. 

Options Pop-up Menu 

New Tour 

Select this command to reset the tour parameters to default settings. 

Open Tour 

Select this command to choose a tour file name to open.   

Save Tour/Save Tour As 

Saves the current tour to the Tours folder in the “Application Support Files” folder (page 26).  
Save As lets you use enter a different name for the tour file. 

Copy Tour 

Copies the tour to the Clipboard as text. 

Paste Tour 

Pastes a tour-formatted text file from the Clipboard. 
 
The next step is to define the timing of the tour on the Timeline tab. 
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Figure 41: The Timeline tab. 

The green line on the timeline graphic shows the length of the tour, in seconds.  A red arrow on 
the top of the timeline represents the position of a waypoint.  Dragging the gray, upward pointing 
tour time pointer (positioned at 0 seconds in Figure 41) lets you advance to a specific time in the 
tour.   
 
The Winter Constellations tour is 30 seconds long.  Click the + button to expand the timeline, or 
the – button to shorten it.  This tour also includes ten different waypoints (indicated by a red 
pointer on the top of the timeline).  Each waypoint represents a point of transition in the tour.   
 
Defining a new waypoint is easy, just drag the tour time pointer to the desired time and then 
click the Add Waypoint button.  When the tour time pointer is positioned beneath a waypoint, 
the button text Reset Waypoint appears instead.  
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Macro Explanation 

SetConstlLine( “*”, 0 ); 
 

Show or hide constellation lines. 
 
Argument 1 is either constellation’s abbreviation in quotation 
marks (“Ori”), or an asterisk in quotes “*” to indicate all 
constellation lines. 
Argument 2 defines how to show the constellation lines.  A 1 
means to turn on the constellation(s), a 0 turns them off. 
 

SetConstlBoundary( “*”, 
0 ); 

Show or hide constellation boundary lines. 
 
Argument 1 is either constellation’s abbreviation in quotation 
marks (“Ori”), or an asterisk in quotes “*” to indicate all 
constellation boundary lines. 
Argument 2 defines how to show the constellation lines.  A 1 
means to turn on the constellation boundary lines on, a 0 turns 
them off. 
 

SetConstlLabel( “*”, 0 ); Show or hide constellation labels. 
 
Argument 1 is either constellation’s abbreviation in quotation 
marks (“Ori”), or an asterisk in quotes “*” to indicate all 
constellation lines. 
Argument 2 defines how to show the constellation labels.  A 1 
means to turn on the constellation label(s) on, a 0 turns them off. 
 

SetConstlDrawing( “*”, 0 
); 
 

Show or hide constellation drawings. 
 
Argument 1 is either constellation’s abbreviation in quotation 
marks (“Ori”), or an asterisk in quotes “*” to indicate all 
constellation lines. 
Argument 2 defines how to show the constellation labels.  A 1 
means to turn on the constellation drawing(s) on, a 0 turns them 
off. 
 

 

Adjust Timeline Pop-up Menu 

Use the commands in the Adjust Timeline pop-up menu to add or remove time from the tour. 

• Scale Time to Pointer adjusts the length of the tour based on the current position of the time 
slider. 

• Remove Before Pointer resets the start of the tour to the current position of the time slider 
and removes all waypoints before this position. 
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• Remove After Pointer resets the end of the tour to the current position of the time slider and 
removes all waypoints after this position. 

• Mirror creates a mirror image of the timeline and waypoints. 

Clear Button 

Click this button to remove all text from the Macro Commands at Waypoint text input. 

Record 

When the Record checkbox is turned on, the macro commands necessary to perform an action 
are displayed as you perform them.  For example, clicking Display > Horizon & Atmosphere 
Options and turning off the Show Horizon checkbox shows: 
 
SetVisible(“Horizon”, 0); 

 
Note that you can access any of TheSkyX’s celestial object types in macro arguments by name.  
For example, instead of “Horizon” as argument 1, you can turn the meridian line on or off by 
using the text “Meridian” as the first argument instead.  See “Customizing Chart Elements” on 
page 236 and the Chart Elements window for the complete list of permitted object type names. 

New Tour 

Click this button to start a new tour.  

Start/Pause/Resume  

The text on this button changes depending on current position of the tour time pointer.  When 
the pointer is at 0 seconds and the tour is not playing, click Start to begin playing the tour.  When 
the tour is playing, click Pause to stop it.  Click Resume to play the tour from the current position 
of the tour time pointer. 

Rewind 

Resets the tour time pointer to the beginning of the tour. 

Create Movies 

Once your tour is complete, you can create a QuickTime™ movie from the Create Movie tab.  
Windows users will have to install QuickTime (available free from Apple’s web site) to use this 
feature. 
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Figure 42: The Create Movie tab on the Create Tour window. 

Movie File Name 

Displays the file name of the movie that will be created.  Click the Save As button to specify a 
different file name. 

Save As Button 

Click this button to enter the name of the movie. 

Options 

The resolution and frame rate of the movie is configurable to your audience. 

Movie Size (Pixels) 

Select the resolution of movie from the Movie Size list.   

• 320x240 (iPod Classic) 

• 640x480 (Desktop) 

• 480x272 (PSP) Sony PlayStation Portable™ format 
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• 480x320 (iPhone/iPod Touch) 

• 800x600 

Frames per Second 

Select the number of frames, or frequency to capture the Sky Chart when creating the movie.  
The higher the frames per second, the better the quality at the expense of a larger movie file. 

High Quality  

Turn this radio button on to configure high quality QuickTime movie settings. 

Create Movie 

Click this button to create the movie.  The length of time it takes create the movie depends on 
the length of the tour, the resolution and frame rate settings, as well as the speed of your 
computer. 

Photos of the Deep Sky 

Since the middle of the 19th century astronomers have been taking pictures of the sky.  In recent 
years, digital imaging sensors have replaced film to capture even more remarkable views of the 
Moon and planets, as well as star clusters, nebulas, and galaxies.  Relatively modest amateur 
telescopes, equipped with digital cameras, can capture images that rival the best photographs 
taken by professional observatories just a couple of decades ago. 
 
TheSkyX has a veritable art gallery’s worth of fantastic space images you can look at any time.  
Browsing these images will give you a taste of the extraordinarily diverse number of objects that 
populate the night sky. 

Viewing Astronomical Photos 

In the stacked windows, you’ll see a tab called Photos.  Select it.  (Select the Photos command 
from the Display menu to show this window if necessary.) 
 
In the window that opens, you’ll see two items, Photo Groups, and NGC/IC Digitized Sky Survey 
Photos.  NGC/IC stands for New General Catalogue/Index Catalog.  These are two of the most 
popular catalogs astronomers use to keep track of the huge number of celestial objects they’ve 
been studying over the centuries.   
 
As you scroll through the list of objects, a small picture of each will be displayed below the list.  
Click the Show in Photo Viewer option to view them in a separate window. 
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Placing Photos 

 
 
TheSkyX Professional Edition’s Place Photo command lets you create and manage individual or 
groups of photographs and provides tools to precisely position each photograph on the Sky Chart.  
In short, there’s everything you need to show off your “in-place” photos. 
 

 

Figure 43: Sky Chart showing in-place photo of the Great Nebula in Orion (M42). 

The Bevis constellation drawings are one example of one Photo Overlay Group that is included 
with TheSkyX.  The Deep Sky Overlays is another. 
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Creating a Photo Group 

To create a photo group from your collection, start by copying all the photos to a single folder on 
your computer.  Note that TheSkyX can show GIF, JPG, TIFF and PNG file formats.  The PNG format 
works well since it can have a transparency layer and is compressed. 
 
We’ll use the Messier Overlay photos as a “collection” to demonstrate how to create a photo 
group.  On the Mac, TheSkyX’s resources are stored inside the application bundle, so these photos 
are not readily accessible or visible from Finder.  If you are familiar with accessing files in an 
application bundle, you’ll find the files in this example in the folder named: 
 
TheSkyX Professional Edition.app/Contents/Resources/Common/Photos/SDBs/Messier Overlays  
 
If you’d like to follow along, you can make a copy of these files in a folder on your desktop.  On 
Windows, these files are located, by default, in the following folder: 
 
C:\Program Files\Software Bisque\TheSkyX <Edition Name Here>\ 

Resources/Common/Photos/SDBs/Messier Overlays 

 
Where <Edition Name Here> is either TheSkyX Serious Astronomer Edition or TheSkyX 
Professional Edition. 
 
1. To avoid confusion, first turn off the existing Messier Overlays Photo Group by clicking the 

Database Manager command from the Input menu, and turning off the checkbox next to 
Messier Overlays in the Photo Databases node under Sky Databases, then click Close. 

2. Select the Place Photo command from the Input menu to show the Place Photo window. 
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Figure 44: Photo Group tab on the Place Photo window (Input menu). 

3. On the Photo Group tab, click the Choose Folder button and navigate to the folder that holds 
your collection of photos then click the Choose button. 

4. Your photos appear in the Photo List.  The name of the photo group text file, which stores 
the photo group information, is listed in the Editing Photo Overlay File text input box. 

5. To overlay and place a single photo in the list on the Sky Chart, highlight its name.  A preview 
of the photo appears on the Photo Group tab.   

6. Click the Place Photo tab.  The selected photo is centered on the Sky Chart.  From here, you 
need to adjust the Sky Chart’s center coordinates, field width and rotation to align the photo. 
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Figure 45: The Edit Photo Placement tab on the Place Photo window. 

7. The Edit Photo Placement tab has tools to move left, right, up, down, zoom in, out and rotate 
the Sky Chart so that the photo can be aligned with the Sky Chart.  Click the Edit Photo 
Placement button to begin this process.  The Show Digitized Sky Survey Photos checkbox 
allows you to show these photos as another frame of reference to help align your photo.  
Once you are satisfied with the position of the photo, click the Save Placement Changes 
button to save it.  Click the Cancel Edit button to abort the process and not save changes.  

8. Repeat steps 5-7 for each photo in the Photo List. 

Placement Information 

Click on the Placement Information tab to show the equinox 2000.0 RA/Dec coordinates of the 
photo, as well as the photo’s Scale, in arcseconds/pixel and Position Angle, in degrees. 
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Managing Photo Databases 

Click the Database Manager command on the Input menu to show the Database Manger 
window.  Next, expand the Photo Databases branch of the Sky Databases node in the Databases 
tree to show the available photo overlays. 
 

 

 

Figure 46: The list of the photo databases in the Database Manager’s Databases list. 

Viewing Photos from the Digitized Sky Survey 
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TheSkyX Professional Edition can overlay photos from the Digitized Sky Survey (DSS) on the Sky 
Chart (see Figure 138) or retrieve the equivalent FITS image for any position on the celestial 
sphere and for any field of view up to 2° x 2°.  This “all-sky photographic reference” can be 
extremely useful when searching for new objects such as supernovas or asteroids. 

Overlaying Digitized Sky Survey Photos on the Sky Chart 

1. Adjust the Sky Chart to the desired position and field of view.  For example, frame the spiral 
galaxy M81 by selecting the Find command from the Edit menu, entering M81 in the Search 
For text input, and then clicking the Frame button.  You should now see the color photo of 
M81 on the Sky Chart.   

2. For convenience, select the Celestial Sphere command from the Orientation menu.  This 
command fixes the equatorial center of the Sky Chart to the center of the window with the 
north celestial pole “up” on the screen.   

3. Select the Digitized Sky Survey command from the Tools menu. 
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Figure 47: Setup tab of the Digitized Sky Survey window. 

4. From the Setup tab, select the Web option (internet connection required).  If you own the 
TheSkyX Pro Database Add On (page 637), select the Disc Drive, Folder or Volume option, 
click the Choose button to specify the location of the Digitized Sky Survey data, then select 
the Palomar Sky Survey (10x) option. 

5. Click the Create Photo tab. 
6. Click the Fill Sky Chart button.  The photo is retrieved from the selected source. 
7. Click the Show Photo in Front of Chart Elements option to show the photo on top of 

everything else on the Sky Chart. 
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Creating a FITS File of a Digitized Sky Survey Photo 

1. Follow steps 1-5 above. 
2. Click the Create button.  The FITS file is retrieved from the selected source and displayed in 

the FITS Viewer window. 
 

 

Figure 48: M52 in the FITS Viewer window. 

Viewing FITS Photos 
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TheSkyX Professional Edition uses the High-Energy Astrophysics Science Archive Research 
Center’s (HEASARC) CFITSIO software library to manage FITS files.  It is the “standard” library that 
handles the all complexities of different FITS file formats so that your FITS (provided it adheres 
to the FITS standard) will be opened and displayed correctly. 

Opening a FITS Photo 

1. Click the Open FITS command from the Tools menu. 
2. Navigate to the location of the FITS file, select it and then click Open.   
3. The FITS photo is now displayed on the FITS Viewer window. 

FITS Viewer Window 

The FITS Viewer window contains basic image manipulation commands and shows a table with 
the FITS header information.   

Photo Pop-Up Menu 

The following commands are available from the Photo pop-up menu. 

Open 

Opens a FITS and displays it on the FITS Viewer window.  Note that the FITS file must use the 
extension FIT or FTS to be recognized as a FITS on the Mac. 

Save 

Saves the FITS file using its current file name. 

Save As 

Saves the FITS file using the file name you specify. 

Print 

Prints the FITS file to the default printer. 
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File Information  

This command shows the File Information tab with the FITS header information.  Search the web 
for the Flexible Image Transport System specification for details about FITS headers and 
keywords. 

 

Figure 49: The FITS header data on the File Information tab of the FITS Viewer window. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 109 

Zoom In/Zoom Out 

These commands can be used to change the scale of the displayed photo by zooming in or out. 

Actual Pixels 

This command shows the photo with no scaling. 

Clear  

Click this command to close the FITS image. 

To Image Link 

Select this command to copy the displayed photo to the Image Link window.  See “Image Link 
and Automated Astrometry” on page 312 for details. 

Close  

Click this command to close the FITS Viewer window. 

Fits Viewer Toolbar 

The toolbar buttons located at the top of the FITS Viewer window give access to commonly used 
commands to manipulate photos. 

 

Histogram Control Button 

Click this button to show the histogram control at the bottom of the FITS Viewer window.  The 
histogram control is used to adjust the photo’s contrast.  
 

 

This feature takes advantage of multi-core processors, making real-time contrast 
adjustments possible, even on large photos. 
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Figure 50: The histogram control is displayed by clicking the Histogram button. 

The Histogram Control 

The histogram control can adjust the photo’s contrast graphically or manually.   
 
The upper portion of the histogram control shows a red triangle with a red vertical line, and green 
triangle with a green vertical line.  Red represents the position on the histogram below which all 
data are displayed using the color black.  Green represents the position on the histogram above 
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which all data is displayed using the color white.  Values between the minimum and maximum 
positions are scaled using different shades of gray. 
 

• Click and drag the green-blue triangles to adjust the white and black points.   

• Click the mouse on the left side of the histogram to change the black point; right side clicks 
adjust the white point. 

 
To manually adjust contrast, enter the minimum and maximum values in the text boxes below 
the histogram, then click Apply. 

Minimum 

Enter the value below which the photo’s data is scaled to the color black. 

Maximum 

Enter the value above which the photo’s data is scaled to the color white. 

Apply  

Adjust the photo’s contrast based on the Minimum and Maximum values. 

Histogram Control Toolbar 

The six toolbar buttons near the bottom of the Histogram control can be used to adjust contrast.  
Each is described in the table below. 
 

Button Description 

 

Reset the histogram’s minimum and maximum values 
to zero and the maximum data value for this photo, 
respectively.   
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Button Description 

 

Scale the histogram so that minimum and maximum 
contrast values approximately match or “bound” the 
photo’s data. 

 

Scale the histogram for low contrast. 

 

Scale the histogram for medium contrast. 

 

Scale the histogram for high contrast. 
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Button Description 

 

Scale the histogram to best show photos of planets. 

Method  

The Method pop-up menu on the lower left corner of the Histogram Control provides several 
different algorithms that can be used to set the photo’s contrast.   

SBIG 

Use SBIG’s algorithm to scale the photo. 

Bjorn 

This is a proprietary algorithm (named after the author) that can be very effective in setting 
appropriate contrast values for a variety of photos. 
 
The Bjorn method’s Background settings include:  
 

• None 

• Weak 

• Medium 

• Strong 

• Very Strong 
 
The “stronger” the background setting, the higher the black point on the histogram.  A Very 
Strong background shows the least faint detail in the photo. 
 
The Bjorn method Highlights options include: 
 

• None  

• Weak 

• Medium 

• Strong 

• Very Strong 

• Adaptive (for general purpose use) 
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• Planetary (best for planets) 
 
The lower the highlight setting, the higher the white point value and the more “data” that is 
included when scaling the histogram.  Lower highlights can reveal details in the brightest portions 
of the photo.   

Linear 

This method scales the data in the histogram linearly. 

Custom 

Use this option with the Minimum and Maximum inputs to scale the photo. 
 
*If the contrast algorithm used to scale a photo’s histogram results in an all-white or all-black 
photo, try using a different contrast method.  

Arrow Button 

 
When the Arrow button is clicked, the X and Y position of the mouse cursor, and the brightness 
value of this picture element (pixel) is displayed in the lower left of the photo window. 
 
Clicking and dragging changes the position of the zoomed photo. 

Zoom In Button 

 
Click this button to zoom in and magnify the photo. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 115 

Zoom Out Button 

 
Click this button to zoom out, making the photo appear smaller in the window. 

Subframe Button 

 
Click this button to enable the subframe tool that can be used to draw a rectangular region, or 
subframe on the photo.   
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Figure 51: A subframe drawn on the photo of M81. 

The control can be used to define the region around a guide star during autoguiding (page 476) 
or to define a region of interest (ROI) on a photo so that subsequent photos are acquired for this 
region, only. 

 Text Tool 

 
Click this button to enable the text tool that can be used to add text to a photo.  Click on the 
photo to place the text input box, then enter the desired text.  The text box can be clicked and 
positioned anywhere on the photo. 
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Figure 52: Custom text can be added to photos. 

 

Cursor Information 

 
Click this button to display the pixel position and right ascension and declination coordinates of 
the pixel directly under the mouse cursor, based on the photo’s World Coordinate System (WCS) 
information.   
 

• WCS data is added to the FITS header after a successful Image Link (page 312). 

• If the photo does not contain WCS, only the pixel position is shown. 
 
The equatorial coordinates of a centroid around the region under the mouse cursor is also 
displayed.  Notice the slight difference between the Cursor coordinates and the Centroid Under 
Cursor in Figure 53. 
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Figure 53: The Cursor Information button shows WCS coordinates for the cursor position. 

Crosshairs 

Turn on this checkbox to overlay a graphical crosshair on the photo. 

Your Sky Tonight 

This section is intended to help you explore the night sky from your location on any date, at any 
time.  You’ll be able to answer the question: “When I head outside tonight at, say, 9 p.m., what 
am I going to be able to see?”  You’ll also learn how to plan for special events, like meteor showers 
and lunar eclipses. 
 
For a given location, what you can see in the sky on any given night depends on the date and 
time.  The stars that are visible at 9 p.m. on a December night are very different from the ones 
you would see at 9 p.m. in June, for example.  And the Moon and planets follow their own unique 
celestial paths – their positions, and their brightness, vary from month to month and year to year. 
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Observing Lists 

TheSkyX includes a command that will display a select list of objects that will be visible in your 
night sky on the current date.  You can set the parameters of this list to choose the kinds of 
objects you’re most interested in seeing. 
 
To generate a What’s Up Observing List: 
 

1. Go to the Tools menu. 
2. Select the Manage Observing List command. 
3. Click the What’s Up Setup tab. 
4. Select the Viewing Time for the list. 
5. Select the Optical Aid that you will be using. 
6. Click the What’s Up? button. 
7. Click the Close button. 

 
Clicking the What’s Up? button creates and shows the list of objects that are visible from your 
location in tonight’s sky on the Observing List window.  When you highlight an item, observing 
notes are displayed.   
 
Some of these objects, and the data displayed with them, may be unfamiliar to you.  We’ll be 
describing most of the information in the What’s Up? command in more detail on page 288. 

Field of View Indicators 

 
 
A Field of View Indicator (FOVI) is a chart element that represents the field of view that is 
rendered by an eyepiece, CCD sensor, camera body and optical tube, or a Telrad™ finder, 
binoculars or other optical system.   
 
As you zoom in or out in the Sky Chart, the FOVIs shrink or grow in proportion to the field of view.  
The utility to this feature is endless, particularly helpful during observing sessions and with 
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telescope control.  Easy, quick identification of celestial objects can be made when you view the 
Sky Chart as if you were looking through the eyepiece, so there is no guesswork required. 

Choosing Your Telescopes, Eyepieces and Cameras 

Select the Field of View Indicators command from the Display menu to open the Field of View 
Indicators window.   
 

 

 

Figure 54: The Equipment tab of the Field of View Indicators window. 

To the left, you will see the equipment database list, including selections for Telescopes, 
Eyepieces, and Detectors.  To select a telescope, expand the Telescopes portion of the tree.  You 
will see a large selection of telescope makers.  Expanding a telescope maker’s menu will produce 
a list of telescope models by that manufacturer.  Choose your telescope from the list.  Once you 
have selected your telescope, click the green arrow button found in the middle of the window.  
You will then see the telescope listed on the My Equipment list to the right of the window. 
 
Now, choose your eyepiece and/or detector from the appropriate menu from the left side 
Equipment Database.   
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Update Equipment Button 

If your model camera, eyepiece, lens or telescope is not listed, click this button to download the 
most recent equipment databases available from the Software Bisque web site, then check the 
appropriate Equipment Database to see if your hardware has been added since you installed 
your software.   
 
If your equipment still does not appear, post a question on the Software Bisque community 
forums with the exact make and model of your equipment, and we’ll try to update our databases.   
 
Once you have chosen your telescope, eyepieces, and detectors, click the Create my FOVIs 
button.  You will then be taken to the My FOVIs tab, where each FOVI will appear in a list with a 
checkbox to turn each FOVI on or off.   
 

 

Figure 55: The My FOVIs tab. 

Selecting a FOVI and clicking the Edit button will show the Add/Edit Equipment window where 
you can edit each element and aspect of the telescope and eyepiece or detector combination 
(page 124). 
 
Clicking the Quick Add button also opens the Add/Edit Equipment window, in which you can add 
a FOVI with characteristics of your choosing.  Just input the desired Shape, Reference Frame, and 
Width and Height in arcminutes, and you’ve added a brand new FOVI of custom dimension. 
 
Clicking Remove will remove a FOVI from the list.  Clicking Center will center the FOVI on the 
screen. 
 
Checking the Preview checkbox will reveal a preview of each selected FOVI in the Sky Chart.  
When the Preview checkbox is turned on, the currently selected FOVI is centered on the Sky 
Chart.  This lets you quickly determine which optical system is best for your needs.   
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Note that if you turn on both the Preview checkbox and the checkbox next to a FOVI, 
two identical FOVIs will appear on the Sky Chart (the “preview” FOVI and the actual 
FOVI).  To avoid confusion, make sure to turn off the Preview checkbox before closing 
this window. 

 

 

Remember that FOVIs represent the view through your telescope, and will not 
appear on the Sky Chart if the chart’s field of view is set to 100° (naked eye) and 
wider.  To see the FOVIs, zoom to a field of view of less than 100°. 

 
The My FOVI tab shows the following information for each field of view indicator. 

Description 

The FOVI description is the combination of the telescope and the eyepiece or detector 
description.  To change a description, highlight the FOVI in the list and click the Edit button. 

Size  

The size column shows the angular dimensions of the FOVI, in arcminutes.   

Scale/Magnification 

For telescope and camera FOVIs, the scale or image scale, in arcseconds per pixel is displayed.  
The optical system’s magnification is displayed when the FOVI consists of a telescope and 
eyepiece. 

Type 

The Type column shows either Eyepiece for eyepiece plus telescope combinations, or CCD for a 
camera plus telescope FOVI. 

Reference Frame 

This column shows the frame of reference to use when displaying the FOVI.  See “FOVI Frame of 
Reference (Reference Frame List)” on page 126 for details about reference frame options. 

Link to Rotator 

This column allows you to establish a link between a field of view indicator and your rotator 
hardware. When linked to an active rotator, the position angle of the FOVI as it appears on the 
star chart will be adjusted to match the current position of the rotator.   
 
Conversely, the rotator hardware to may be commanded to move to a new position by dragging 
a linked field of view indicator. 

Showing Telrad Finders 

Telrad™ finder FOVIs are shown at all fields of view (but may not be completely visible at small 
fields) and can be added to the Sky Chart using the My Chart Elements command on the Input 
menu. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 123 

To add one or more Telrad Finder FOVIs to the Sky Chart: 

1. Click Input > My Chart Elements.  
2. On the Manage tab, click the Add Telrad button.  
3. Under Command+Click (Mac) or Ctrl+Click (Windows), select Cursor Position in the Snap To 

pop-up menu.  
4. Position the mouse cursor over the Sky Chart, press and hold the  key on the Mac or the 

CTRL key on Windows, then click the left mouse button.  A new Telrad finder is drawn at the 
current cursor position.  

 

 

Figure 56: A Sky Chart showing multiple Telrad finders. 

To position a Telrad finder at a specific coordinate: 

1. From the Manage tab on the My Chart Elements window, highlight the Telrad you want 
to move in the My Chart Element list by clicking on it or click on the center of the Telrad 
Finder on the Sky Chart.  A selected Telrad finder appears as My Chart Element # in the 
Object Information Report on the Find window. 

2. Click the Edit button (or double-click on the element) to show the Add/Edit Chart Element 
window. 

3. To enter equatorial coordinates, click the Equatorial radio button then enter the right 
ascension (RA) in hours, minutes and seconds and declination (Dec) in degrees, minutes 
and seconds.  

 
To enter horizon coordinates, click the Horizon radio button then enter the azimuth (Azm) in 
hours, minutes and seconds and altitude (Alt) in degrees, minutes and seconds. 
 
To Drag and Move a Telrad Finder: 
 

1. From the Manage tab on the My Chart Elements window, select the Telrad you want to 
move in the My Chart Element list, or click on the center of the Telrad Finder on the Sky 
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Chart.  A selected Telrad finder appears as My Chart Element # in the Object Information 
Report on the Find window. 

2. Click and drag the small red rectangle in the center of the Telrad finder to move it. 
3. Release the mouse when the Telrad is positioned where you want it. 

Adding or Editing Field of View Indicator Properties 

Clicking the Edit button or the Plus Sign button on the My FOVIs tab (Field of View Indicators 
window) shows the Add/Edit Equipment window.  This window lets you define up to twenty 
different FOVI elements.  
 

 

 

Figure 57: The Add/Edit Equipment window (clicking the Edit button). 

Field of View Indicator Description (Description) 

Enter a description for your detector, such as Super CCD with 10 Detectors. 

Element Number List 

Up to twenty separate FOVI elements can be defined for each FOVI.  For example, if your camera 
has a built-in autoguider, then the FOVI will have two different elements, one for the imaging 
detector and one for the autoguider. 
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Element Description (Description) 

Enter a text description for the element, such as “ST-237 guider mounted to my guide scope”. 

Shape 

Specify the shape of the element. An element can be:  

• Circular (or elliptical) 

• Rectangular 

• Marker (a small cross that is offset from the main FOVI) 

• Off-Axis Guider (a rectangle that represents the position of an off-axis guider). 

OAG PA 

When a FOVI element’s Shape is defined as Off-Axis Guider, enter the position angle of the off-
axis guider, in degrees.  

Position Angle 

Enter the position angle, measured counterclockwise from north, of the FOVI element. This is the 
native position angle of the FOVI before any offsets due to a linked rotator are applied, so this 
value may be changed freely without effecting the position or orientation of linked hardware.   
 
This field is automatically populated with the correct angle for FOVIs generated from a successful 
Image Link (page 312), allowing users to accurately predict the position and orientation of their 
imaging system's actual field of view.  For FOVIs linked to rotators, it is recommended that this 
field be set to 0 degrees, and the position angle of the FOVI instead synchronized to the imaging 
system's actual field of view using the rotator offset (page 603). 
 
To rotate a FOVI on the Sky Chart 
 
Clicking on the FOVI line reveals two small red “handles” to indicate it is selected. 

• Click and drag the center handle to unpin it from the center of the window and pin it 
to a specific RA/Dec position on the Sky Chart. 

• Click and drag the outer handle to rotate the FOVI about its center. 

• The FOVI’s current position angle is also displayed. 
 

Hint:  When accurate FOVI position angles are required, the FOVI’s position angle can be adjusted 
by one-tenth of one-degree increments by clicking and dragging the mouse cursor away from the 
center of the FOVI.  When the cursor is positioned further from the center of the FOVI, small 
changes in the mouse position results in small changes to the FOVI’s position angle. 
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Figure 58: Click and drag on the small red square to change the FOVI’s position angle. 

FOVI Frame of Reference (Reference Frame List) 

Select the frame of reference for the detector or detector/telescope combination. 

• Sky Chart: The FOVI is pinned to the center of the Sky Chart. 

• Equatorial: The FOVI is displayed specific equatorial coordinate. 

• Telescope Crosshairs: When connected to a telescope, and the field of view 35º and 
smaller, the FOVI is displayed with the telescope crosshairs symbol in the center of the 
FOVI.  At wider fields of view, only the telescope cross hair appears (two concentric yellow 
circles). 

 

 

Figure 59: Sky Chart showing a Telescope Crosshairs FOVI at fields of view 35° and smaller.  
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• Telescope Mask: Use this option to simulate the view through a telescope.  Regions 
outside the FOVI are “masked” and therefore not visible. 

 

 

Figure 60: A Sky Chart showing a telescope mask FOVI. 

Size, X/Y 

Enter the physical size of the camera’s detector, in mm. 

Offset, X/Y 

Enter the offset of the element from the Element Number 1, in mm. 

Pixels, X/Y 

For CCD cameras, enter the number of pixels in each axis. This value is used to compute the scale 
of images acquired with the camera, in arcseconds/pixel. 

East/West offset 

Specify the number of arcminutes to shift the center of the FOVI to the East or West.  A number 
greater than zero shifts the FOVI West, a negative number shifts it East. 

North/South Offset 

Specify the number of arcminutes to shift the center of the FOVI to the North or South.  A number 
greater than zero shifts the FOVI South, a negative number shifts it North. 
 
Clicking the Plus Sign button shows slightly different options. 
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Figure 61: The Add/Edit Equipment window (clicking the plus sign button). 

Enter the FOVI’s Description, Shape and Reference Frame (described above) and the Width and 
Height, in arcminutes.  

FOVIs and the Sky Chart 

FOVIs that are displayed on the Sky Chart are configurable and customizable.  
 
They can be:  
 

• Clicked and dragged to any part of the screen 

• Copied and “pinned” to a specific equatorial (RA/Dec) coordinate 

• Rotated to any angle 

• Used as the telescope cross hairs 

• Used to create a telescope mask 

• Used to control a camera rotator 

How to Position a FOVI on the Sky Chart 

Select the FOVI on the Sky Chart by clicking on it, or click on the center marker (if the FOVI has a 
visible center marker).  Two small reddish squares, and the position angle, appear when the FOVI 
is selected.  The center square can be dragged to move the FOVI; drag the outer square to change 
the position angle. 
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Figure 62: Clicking on a FOVI shows the position angle, and rectangles to position and orient it.  

How to Use a FOVI as the Telescope Cross Hair 

1. Click the Field of View Indicators command from the Display menu. 
2. Click on the My FOVIs tab. 
3. Highlight the FOVI that you want use as the telescope cross hair. 
4. Click the Edit button. 
5. On the Add/Edit Equipment window, select Telescope from the Reference Frame list. 
6. Click OK. 

 
When the Sky Chart’s field of view is small enough to resolve the FOVI, and the telescope is 
connected, the telescope’s cross hair will include the FOVI, too. 

Object Paths 

Sometimes the best way to say something is with a picture.  This is certainly true with a complex 
concept like planetary motion.  Tracing out motion paths of solar system objects is the perfect 
way to demonstrate their motion and to plan for upcoming observation sessions.  TheSkyX allows 
you to do so with ease and flexibility. 
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Figure 63: An object path showing the Sun's analemma. 

Generating an Object Path 

Selecting the Object Paths command from the Tools menu will bring up the Object Paths window.  
In it, you will see a list of solar system objects, along with various drop-down menus and buttons 
that control the various object path functions.  On the left, you will see a list of solar system 
objects: the eight classical planets, plus Pluto, the Sun, Moon, comets, and asteroids.  On the 
right, you will see information pertaining to the path that TheSkyX is currently set to create, 
including the number of items selected, the chosen time increment, the count of time 
increments, and the path style. 
 
To get our feet wet, let’s try out the object path tool on an observer’s favorite, the planet Mars. 
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Note: This process works the same way with any object.  If Mars is not in your sky right now, you 
can always choose another object, or adjust your Sky Chart to the next time Mars is visible. 
 

1. Choose Object Paths from the Tools menu. 
2. From the Select Solar System Object list, select Mars. 
3. Looking over to the right side of the window, you will now see that Items Selected now 

says 1. 
4. By default, TheSkyX sets the time increment to 1 day, which is changeable by using the 

pop-up menu.  Let’s leave it at 1 day for now.   
5. The Count is set at 30 by default, which means that the system will calculate a path for 30 

of the chosen time increments.  In this case it is 30 days. 
6. The Path Style may be changed from a connected line to a dotted line, each with various 

point styles.  Experimenting with this feature will allow you to best decide which option 
is right for you. 

7. Then, click the Create Path button, and a new path appears in the Sky Chart, revealing 
the path taken by Mars starting with the current system time and ending in the next 30 
days. 

 
In this example, the generated path shows the position of Mars in the sky each day at the same 
time.  So, if the clock is set at 12:00 a.m. when you generate the path, it will show the position of 
Mars each day at 12:00 a.m. 
 
Clicking the Show button in the Object Paths window will zoom in and center the path in the Sky 
Chart. 
 
What if you would like to see the path that an object takes through the sky during a single day?  
TheSkyX makes that easy, as well.  Using Mars as our example again, following these easy steps 
will lead you to success. 
 

1. Select Object Paths from the Tools menu. 
2. Choose Mars from the Select Solar System Objects list. 
3. Ensuring that the Create Paths button is highlighted on the right, change the time 

increment to 1 hour. 
4. Change the frequency to 24 by either typing it into the field or by using the field’s arrow 

buttons. 
5. Select the path style that is best for you. 
6. Click Create Path. 

 
You will now see a path on the Sky Chart reflecting Mars’ motion through the sky over the next 
24 hours. 
 
Remember, clicking the Show button in the Object Paths window will zoom in and center the 
path in the Sky Chart. 
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Once you get the hang of the example path, try out several different paths, changing the variables 
to achieve different effects. 

Updating Object Paths 

Should you wish to update object paths based upon new time and date settings, simply click the 
Update All button. 

Clearing Object Path Data 

If you would like to clear paths from the Sky Chart, click Clear All Paths. 

Create Paths Options 

TheSkyX allows you to create object paths with a great amount of flexibility.  The following is a 
detailed explanation of each option under the Create Paths menu. 

Items selected 

This area denotes how many objects are selected for which paths will be drawn.  You may select 
as many objects as you wish from the list on the left. 

Time increment 

Here, you can select the desired increment of time for the object path.  This input behaves 
similarly to Date and Time Control (page 140), where virtually any time increment can be 
specified using a <number>+<keyword> sequence.  The time keywords include:  
 

• year = 365.2425 days 

• week = 7 days 

• day = 1 Earth day 

• hour = 1 hour of time 

• minute = 60 seconds of time 

• second = 1 second of time 
 
Each keyword must be preceded by a number as shown in the examples below.  Plural or singular 
keywords are acceptable. 
 
5 hours 3 minutes 25.2 second 
15 days 
6 years 
7 weeks  

Count 

Using this function lets you choose how many time increments you want to include in the object 
path.  Selecting 1 hour as the time increment and 24 as the count generates a path that is 24 
hours in length, or about one Earth day. 
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Path style 

Using the drop-down menu, the path style can be changed so that is drawn as a smooth 
connected line, a dotted line with points at each position, a dotted line with a graphical 
representation of the object at each position, or a continuous line with either dots or graphic 
objects at each position. 

Interactive Object Paths 

If you would like to create a path “interactively” using TheSkyX’s Date and Time control as the 
object moves, turn on the Interactive checkbox.  When in the Interactive mode, paths will be 
created for the selected solar system objects as the time is changed using Date and Time 
controls.  
 
When the Interactive checkbox is on, a Stop command is issued to the date time controls so that 
you can choose the desired skip increment.  Use the Step Forward or Go Forward (or Backward) 
controls to see the paths as they are generated.  
 
Click the Remove Interactive Paths button to remove all paths from the Sky Chart.   Note that 
paths can be up to 500 “time increments” long.  Once they reach this maximum length, the object 
will continue moving but the path will no longer be recorded.   

Path Labels 

TheSkyX affixes labels to paths so that you can reference an object’s position at any given time 
along the path.   
 
To change labels for one or more object paths, first select the object(s) on left of the Object Paths 
window. If more than one path is selected, the first selected will be the template for the other 
paths (other paths will inherit the position, frequency and label type of the first selected).  
 
When creating paths interactively, make sure to set the desired labeling options before changing 
time using the Date and Time controls. 
 
To see the label data, or to adjust how labels are generated, click the Path Labels button near 
the top right side of the Object Paths window.  You will see several options, such as the position 
of the label, label frequency, and options for the label data (day, month, date, etc.).  Let’s change 
the label parameters in our Mars example to show us the date and time of several points along 
Mars’ path. 
 

1. Click the Path Labels button in the Object Paths window. 
2. The label position is set at top, and the frequency at 6, by default, so let’s just leave those 

as they are for now. 
3. In the Label Options drop-down menu, select Date and time. 
4. Click the Update button. 
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You will now notice that the path labels in the Sky Chart now show the date and time of six points 
along the generated path.  If you want to change the label details again, simply follow the 
previous steps, substituting the new parameters under the Path Labels section. 

Label List 

In the Path Labels section, you will notice a label list under the label parameters.  TheSkyX allows 
you to view and change any label along your generated path.  Scrolling in this list will reveal the 
label and the date and time of each incremental point along the generated path.  (In our example 
above, we generated a 30-day long path, so the label list contains data for 30 days.)  You can 
change any label to anything you like by double clicking on a label cell and entering text.  Clicking 
Update will update your path and show the new labels. 

Path Labels Options 

TheSkyX affixes labels to object paths based upon default parameters or those selected by the 
user.  Understanding these will help you to get the most out of TheSkyX’s object paths function. 

Position 

A label’s position can be changed here.  You can elect Top, Bottom, Left, or Right. 

Frequency 

This function adjusts the frequency at which labels appear on the object path.  The frequency can 
be changed by directly entering a number into the field, or by using its arrow buttons. 

Label option 

Here, you can change the data content of labels.  Labels can display date, time, date and time, 
day and month, or day only.  Additionally, labels can be turned off completely by selecting None. 

Label list 

This list shows all labels on a given object path and lists the labels as well as the date and time of 
each point along the path. 
 
You can change the content of any label by double-clicking in a label’s cell and entering text. 
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The Calendar 

 
Mankind has been using calendars of one kind or another to mark the passage of time for 
thousands of years.  TheSkyX’s Calendar charts the phases of the Moon, sunrise and sunset, and 
viewing opportunities for a special kind of satellite event called an Iridium flare, monthly.  You 
can display and print a calendar for a single month or the entire year. 
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Figure 64: The Calendar window (Calendar command, Tools menu). 

Copy Calendar to Clipboard (Copy button) 

The current month’s calendar can be exported by copying it to the Clipboard using the Copy 
button, and then pasted into other applications that accept graphics (in Portable Network 
Graphics or PNG format). 
 
Please include the Software Bisque copyright if you publish a calendar on the web or in a monthly 
astronomy bulletin. 
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Create a Calendar as a PDF (Create PDF button) 

Calendars created as Portable Document Format (PDF) documents can be emailed and viewed, 
or printed using free software on Windows, or freely with the Preview application on the Mac. 
 
PDF calendars, by default, are saved to the directory named: 
 

Software Bisque/TheSkyX <Edition Name Here>/Exported Data  

 
In your home folder (the one with the house icon in Finder on the Mac or the current user’s My 
Documents folder on Windows). 

Print Calendars (Print button) 

Clicking the Print button sends the calendar to your printer.  Make sure that your printer is turned 
on and ready to go before doing so. 

Show Sun or Moon Rise and Set Times (Sunrise/set, Moonrise/set checkboxes) 

Turn on the Sunrise/set or Moonrise/set checkbox to show the local sunrise (moonrise) and 
sunset (moonset) times for each day on the calendar.  

Show Times of Iridium Flares (Iridium Flares checkbox) 

To show the predicted times for flares in the calendar, TheSkyX must first generate an Iridium 
flare report.  To do so, click the Iridium Flares command on the Tools menu, specify the desired 
search parameters, then click the Find Flares button to generate a report of upcoming flares.  
 
After an Iridium flare report is generated, turning on the Iridium Flares checkbox on the Calendar 
window shows the magnitude, time, direction and altitude of each flare in the Iridium flare 
report. 

Show Yearly Moon Phase Calendar (Show Full Year checkbox) 

Turn on the Show Full Year checkbox to view the phases of the Moon for the current year. 
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Figure 65: Phases of the Moon for one year. 

Future and Past Calendars (Previous/Next Month/Year buttons) 

When the Show Full Year checkbox is off, click the Next or Previous Month button to view a 
future or past month’s calendar. 
 
If you select the Date & Time tab, a small calendar for the current month will be displayed.  Here’s 
a very interesting feature: if you click on any date in the calendar, the Sky Chart automatically 
shifts to show you what the sky will look like on that date, for the current time.  Notice also that 
the four major phases of the Moon are displayed in the calendar. 
 
For a more detailed calendar, go to the Tools item in the Main Menu.  Scroll down to Calendar 
and select it.  A larger, printable calendar is displayed.  Note that you can select various kinds of 
information to be included in the calendar by checking the appropriate boxes on the right-hand 
side of the window. 

Exploring the Sky Chart 

In this section, we’ll focus on how to adjust and navigate the Sky Chart.  The best way to learn 
our program is simply to use it.  Feel free to play around with the various buttons and menu 
commands you see in the tool bars.  TheSkyX won’t break, and it won’t bite you. 
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Changing the Date and Time   

 
The clock built into your computer is constantly tracking the date and time.  TheSkyX reads this 
and displays whatever is above your horizon right now, but it can also show you the sky for 
different times of day or night.   
 
By default, TheSkyX starts up using the computer’s clock to show time advancing at 1× (real time) 
with the Go Forward button pressed (meaning time is advancing how you’d expect). 
 
From the Input menu, select the Date and Time command to show the Date and Time window 
(Figure 66).   
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Figure 66: The Date and Time window (Date and Time command, Input menu). 

Entering the Date and Time (Date & Time Control) 

Use TheSkyX’s Date & Time control that is located near the top of the Date and Time window to 
enter any date, after January 1, 4,712 BC and before December 31, 10,000 AD. 
 

 

Figure 67: The Date & Time control on the Date and Time window and on the Date & Time Toolbar (Display > Date & 
Time Toolbar). 

Do to so, click the mouse on the date or time element you wish to change, then type the desired 
value for: 
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• hours 

• minutes 

• seconds 

• AM/PM  

• month  

• date 

• year 
 
To set a specific month, click the month text to highlight it, then press the key for the first letter 
in the month. For example, press “D” for December.  Pressing the “J” key repeatedly toggles the 
months January, June and July.  If your mouse has a scroll wheel, use it to move up and down 
through the months.  Or, use the up/down arrow keys on the keyboard. 
 
To toggle between AM/PM, highlight the text, use the scroll the mouse wheel or up/down arrow 
keys on the keyboard. 
 
The current month can also be selected using the calendar on the Date and Time window. 

Formatting the Date and Time 

The format of the date and time can be changed to suit your preferences.  Double-click on the 
Date & Time control to show the date and time formatting options.  See “Have it Your Way with 
Preferences” on page 201. 

Calendar Control  

TheSkyX’s Calendar control on the Date and Time window provides two mouse-click access to 
any date for the current year.  If necessary, click the Date and Time command from the Display 
menu to turn this window on; click the Date & Time tab on the stacked windows to bring it to 
the front. 
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Figure 68: The Calendar control on the Date and Time window (Date and Time command, Display menu). 

The top of the calendar control shows the year.  Click the forward/backward arrows to 
advance/retreat one year at a time. 
 
The edges of the calendar show the months of the year.  Click any tab to bring it forward. 
 
Black numbers for dates indicate the days in the current month, light gray numbers are shown 
for the prior or next month.  The current day is highlighted light red.  Click on any day to highlight 
it; the Sky Chart is adjusted accordingly.  Click the month name tab to reveal the calendar for that 
month. 

Time Controls  

Buttons for controlling the flow of time are available by clicking the Date and Time command on 
the Display menu and on the Date and Time Toolbar. 
 

 

Figure 69: Time Controls on the Date and Time window (Display menu) and the Date and Time Toolbar (from left to right: 
Computer Clock, Time Editor control, Go Backward, Step Backward, Stop, Step Forward, Go Forward, Time Skip 

Increment). 

Use the Computer’s Clock (Computer clock) 

When the Computer Clock button is clicked, TheSkyX gets the date and time from the computer’s 
clock.  It also resets the time skip increment to 1× (real time) and sets the Go Forward time skip 
option. 

Verifying TheSkyX’s Time 

 
 
Accuracy is of the utmost importance in your observations.  Select the Verify TheSkyX’s Time 
command from the Tools menu to check TheSkyX’s time against the U.S. Naval Observatory’s 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 143 

Master Clock.  You can also click the corresponding toolbar button if you have the Orientation 
Toolbar activated (check TheSkyX > Preferences > Toolbars). 
 
Note:  This tool is valid for U.S. locations only, and requires an internet connection. 

Move Backward in Time (Go backward) 

 
 
Even though time marches on, TheSkyX can make time go backward by clicking the Go Backward 
button.  This can be handy to replay an astronomical event and is sort of like having your own 
DVD player on history. 

Step Backward in Time (Step backward) 

 
Unlike the Go Backward button, the Step Backward button can be used to incrementally retreat 
time by the Time Skip Increment amount.   Use this to find the first contact of an eclipse, or 
determine the precise time when a minor planet occults a star, for example. 
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Stop Time (Stop) 

 
 
Use the Stop button to halt the motion of stars and other objects from your earth-based 
perspective. 

Step Forward in Time (Step forward) 

 
Use the Step Forward button to incrementally advance time by the Time Skip Increment amount. 

Go Forward in Time (Go forward)  

 
Use the Go Forward button to advance time. When the Time Skip Increment is set to 1× (real 
time), TheSkyX is showing you how the real sky looks at any instant. 
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Advancing or Retreating Time (Increment Time By) 

 

 

Figure 70: Increment Time control. 

Use the Increment Time By control to specify the rate or interval to advance or retreat time.   
 
The default time interval options include: 
 

• 1× (real time): Time advances or retreats based on the computer’s clock. 

• 10×, 100×, 1000×: Time changes by a factor of 10, 100 or 1000 times the normal rate. 
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• 1 second  

• 1 minute 

• 1 hour 

• 1 day 

• 1 lunar month 

• 1 year 

• Sunrise: The time skip interval is the length of time between sunrises for each day. 

• Sunset: The time skip interval is the length of time between sunrises for each day. 

• Start Twilight: The time skip interval is the length of time between morning astronomical 
twilight for successive days. 

• End Twilight: The time skip interval is the length of time between evening astronomical 
twilight for successive days. 

• Custom: Click the Custom command to show the Custom Time Flow Increments and 
Rates window. 

 

 

Figure 71: Define custom rates and time skip increments using the Custom Time Flow Increments and Rates window. 

User-Defined Rates and Time Skip Increments (My rates and increments) 

This list shows the rates and increments that you’ve defined by clicking the Add button to the 
right. 
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Define a Numerical Increment or Rate (Number) 

Enter any decimal number for the rate or increment you wish to define.  For example, 2.56 days, 
or 500x. 

Define the Flow Rate or Time Skip Increment Unit (Unit) 

Specify the unit for the rate or time skip increment. The lower case “×” unit means “a rate that is 
N times greater than actual time. Only whole numbers (integer) values are permitted for time 
skip rates. 

Add Rates and Increments (Add) 

Once you’ve entered a number and a rate, click Add to add it to the My Rates and Increments 
list. 
 
Custom rates are saved automatically, and restored when TheSkyX is opened. 

Remove Rates and Increments (Remove) 

Select one or all the rates and increments, then click the Remove button to remove them from 
the list. 

Quickly Change Time (Change Time) 

The Change Time slider on the Date and Time window allows you to quickly advance or retreat 
time at the current rate. 
 
This control is useful for reviewing lunar eclipses, occultations and Iridium flares. 
 
Now that you’re familiar with the time controls, below the calendar there is an item called Set 
Specific Time.  Click it. 
 
You’ll see a list of different “times”—not in hour and minute format, but in terms of astronomical 
events. The list of common events includes:  
 

• Now: TheSkyX uses the computer’s clock to show time 

• Sunrise:  The time of day when the rising Sun reaches the “refracted horizon” – the 
line on the refracted sky that corresponds to the observer’s horizontal.  

 
Hint: Refraction caused by the earth’s atmosphere bends light, so, at sea level, the Sun’s upper 
limb is visible about 3 minutes before it is above the local horizon.   
 

• Noon: The time of day when the Sun is centered on the meridian. This is not 
necessarily 12:00 p.m. 

• Sunset:  The time when the Sun appears just below the “refracted horizon”.  

• Midnight:  12:00:00 a.m. local time. 

• Morning (Begin Astronomical Twilight):  The time when astronomical twilight begins. 
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• Evening (End Astronomical Twilight):  The time when astronomical twilight ends. 

• New Moon:  The date and time in the current month when the Moon’s phase is zero 
percent. 

• First Quarter: The date and time in the current month when the waxing Moon’s phase 
is approximately 50 percent. 

• Last Quarter: The date and time in the current month when the waning Moon’s phase 
is approximately 50 percent. 

• Full Moon: The date and time in the current month when the Moon’s phase is 
approximately 100 percent. 

• Moonrise: The time of day when the rising Moon intersects the refracted horizon. 

• Moonset: The time of day when the setting Moon is below the refracted horizon. 

• Vernal Equinox:  The date and time for the current year when spring begins in the 
northern hemisphere. 

• Summer Solstice:  The date and time for the current year when summer begins in the 
northern hemisphere. 

• Autumnal Equinox:  The date and time for the current year when autumn begins in 
the northern hemisphere. 

• Winter Solstice:  The date and time for the current year when winter begins in the 
northern hemisphere. 

 
The last item in the list allows you to enter the Julian Date of an event. 
 
The Moon’s phase events search the current month.  For example, if TheSkyX’s month is set to 
any date in July 1592, the New Moon is July 24, even if the date is later than July 24. 
   
When you select any of these options, the Sky Chart shows you what the sky will look at that time 
for the current date.  Try several of the options and watch how the chart changes. 
 
You can make time speed up and even go backwards.  In the Tools menu, choose the item called 
Time Skip.  Try one of the various options.  The Sky Chart will continue moving backward or 
forward in time until you select Stop, or the Use Computer’s Clock option. 
 
Finally, you can also enter a specific date and time by selecting the Input item from the Main 
Menu and choosing Date and Time (note there is also a shortcut key for this displayed, within 
the menu – TheSkyX will always display shortcut keys in the menu whenever they are available). 

Prohibit All Time Changes and Force ‘Use Computer Clock’ 

Setting the date and time in TheSkyX is normally free flowing; you can simulate the night sky from 
one hundred years ago just as easily as tonight’s sky with a few keystrokes or mouse clicks.   
 
Setting the incorrect date and time when controlling a telescope can result in personal injury or 
damage your equipment.   
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When this checkbox is turned on, changes to TheSkyX’s time settings are not allowed so that Sky 
Chart always uses the computer’s clock to establish the date and time.  It is turned on 
automatically when controlling a telescope, and turned off automatically when a telescope 
connection is terminated, or TheSkyX is closed.  To avoid confusion, the state of this checkbox is 
not saved or restored. 

Reports 

TheSkyX makes generating calendar reports of Sun and Moon activity, equinoxes and solstices, 
planet ephemerides and meteor showers a snap.  Set the Sky Chart to any year you choose, and 
select Tools > Reports to see a wealth of astronomical data specific to the given year. 

Equinox/Solstice Report 

This report displays the date and exact time of each equinox and solstice for the Sky Chart’s 
current year.  To see a different year’s values, simply change the Sky Chart’s year in the Date and 
Time tab or toolbar. 

Meteor Radiant Report 

Keep on top of meteor shower activity with this handy report.  With the Meteor Radiant Report, 
you can instantly see the Month/Day, RA, Dec, and Hourly Rate of each meteor shower for the 
Sky Chart’s current year.  Just as with the other reports, you can obtain values for a different year 
by changing the date in the Date and Time tab or toolbar. 

Planet Report 

This is a “catch all” report that lists a variety of solar, planetary and lunar ephemerides and other 
useful information such as Earth distance, longitude of each visible planet’s central meridian, 
Moon-specific information and more.  You can obtain values by changing the date in the Date 
and Time tab or toolbar. 

Sun & Moon Report 

This report lists times for moonrise, moonset, sunrise, sunset, and the beginning and ending of 
(astronomical) twilight for each day of the Sky Chart’s current month and year.  To see values for 
a different month or year, simply change the date in the Date and Time tab or toolbar. 

Sky Database Reports (All SDBs) 

This report shows the name, search prefix, object count, object type and the associated text file 
for every Sky Database. 

Copying Reports 

Any of these reports can be copied to the clipboard for pasting into another application by simply 
clicking the Copy button at the lower left side of the Reports window. 
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The Look Commands 

Our eyes can see only a small portion of the sky at a time.  TheSkyX can show you the entire sky 
at once, but it’s often more useful to focus the display on one part of the sky at a time, to match 
what you can see in the real night sky with your unaided eyes. 
 
Changing the direction of your view is accomplished with the Look commands.  These can be 
found in the Orientation menu, but they are also available to you as buttons in the Orientation 
tool bar.   
 
By default, the Sky Chart is displayed looking south.  Click the East button in the Orientation tool 
bar.  Note that the star field has changed; the compass direction displayed at the bottom of the 
screen indicates E, for east.  Experiment with the other compass direction buttons. 
 
In addition to the compass direction buttons, a set of arrow buttons can be used to shift your 
viewing direction incrementally.  Click the right arrow button.  Notice how the view shifts slightly 
to the left (how far the Sky Chart shifts depends on your field of view, discussed below), just as if 
you were outside, looking at the real sky, and turning your head to the right.  The left, right, up 
and down buttons function similarly (if your computer’s monitor is small, or the screen resolution 
is low, the entire toolbar may not fit on the screen, so you may need to click the >> symbol to 
display the up and down buttons), mimicking the movement of your head in the indicated 
directions. 
 
You can also press and hold the CONTROL key then drag the mouse to adjust the position of the 
Sky Chart. 

Orientation Options 

A variety of options exist for orienting the Sky Chart.  You may choose from a terrestrial sphere, 
or celestial sphere orientation, or a free rotation mode. 

Terrestrial Sphere 

Choose the Terrestrial Sphere command from the Orientation menu to orient the Sky Chart as if 
from a vantage point on Earth’s surface and according to terrestrial (azimuth and altitude) 
coordinates.   
In this orientation, the simulated planets, stars and other objects move across the sky from east 
to west, just like the actual night sky.  Detecting motion of the actual celestial objects using the 
unaided eye takes patience.  While the stars may appear stationary at first glance, careful 
observation reveals the effects of earth’s persistent on-axis rotation.   
 
A magnified view of the night sky through a telescope with no clock drive quickly reveals the 
apparent motion as stars drift out of the field.  The same is true for the simulated Sky Charts.  
When the Terrestrial Sphere option is selected, narrower fields of view, the apparent motion of 
the stars becomes obvious.   
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If you’re working at smaller fields of view, and wish to “stop the world from turning” use the 
Celestial Sphere option. 

Celestial Sphere 

To view the Sky Chart from the origin (center) of the celestial sphere, select the Celestial Sphere 
command from the Orientation menu.  Objects are shown based on their equatorial positions 
and do not move as time advances. 

Free Rotation 

Choosing the Free Rotation command from the Orientation menu allows you to freely rotate the 
Sky Chart in any direction without being constrained to any coordinate system or convention. 
 
Note:  Each of these options is also available as a button on the Orientation Toolbar (page 209). 

Rotating the Sky Chart 

While in Free Rotation mode, you can rotate the Sky Chart freely, in any direction, with 
commands from the Orientation menu, or by using the Rotate Tool found in the Tools menu. 

Rotating Clockwise and Counterclockwise 

  
 
First, select Free Rotation from either the Orientation menu or from the Orientation Toolbar.  
Then, select either Rotate Clockwise or Rotate Counterclockwise from the Orientation menu.  

You can also use the keyboard shortcut Alt++ (that is, press and hold down the Alt key while 

pressing the plus key; the Mac keyboard labels this key with the word Option, too) to rotate 
clockwise.  Similarly, Alt+– rotates the Sky Chart counterclockwise. 

Rotate Tool 

You can also rotate the Sky Chart to any position angle you choose by using the Rotate Tool.  Click 
Tools > Rotate Tool to display it.  A brownish-red position angle indicator appears on the Sky 
Chart with a label indicating the current position angle. 
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Figure 72: The Rotate Tool (Rotate Tool command, Tool menu). 

 
To use the Rotate Tool, first center the Sky Chart at the rotation position.  To change the position 
angle, click and drag the square at the end of the position angle indicator.  Notice that the 
position angle readout changes as you drag the indicator. 
 
You can also set a position angle using the Rotation settings under the Orientation > Navigate 
command.  See the Navigate Command section for more details. 
 
Position angle in TheSkyX is measured from the celestial pole, through east. 

Angular Separation & Position Angle 

 
Determining the angular separation and position angle of two objects is a snap with TheSkyX. 

Angular Separation & Position Angle Tool 

Select Tools > Angular Separation & Position Angle to bring up the tool.  You will notice that a 
pale green indicator with two square endpoints and a square center point appears in the Sky 
Chart.  To determine the angular separation and relative position angle between two objects, 
simply click and drag the endpoints so that they overlap the objects for which you wish to 
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determine angular separation and position angle values.  You can hold down the Control key 
(Windows) or Command key (Mac) to snap the endpoints to the nearest object for greater 
accuracy.  It’s that simple!  The desired values will appear in the label below the indicator.  
Determining angular separation and position angles has never been so simple or as elegant as it 
is in TheSkyX. 
 
Once you are finished with this tool, deselect it by returning the Tools > Angular Separation & 
Position Angle command. 
 
Note:  The Angular Separation & Position Angle tool works in terrestrial or celestial sphere mode 
and in free rotation mode.  You can also click and drag the Sky Chart to adjust the view at any 
time. 

Field of View 

You probably know that a circle can be divided into 360 degrees.  Imagine a pie cut into six equal 
slices.  The angle between the edges of a given slice is 360/6 = 60 degrees.  Astronomers measure 
angles in degrees, and fractions of a degree: each degree is divided into sixty minutes, and each 
minute is divided into sixty seconds. 
 
When you look up, you can see only a portion of the entire sky.  Imagine for a moment that the 
sky is an immense spherical bowl above your head.  You’re seeing an area of the sky that spans 
an angle. 
 
Assuming you have normal peripheral vision, that angle is about sixty degrees – one slice of our 
imaginary pie in the sky.  Another way of saying this is your field of view is sixty degrees wide.  
Some people can see a little more, some a little less, but sixty degrees is about average for adults. 
 
When you look at the sky with binoculars or a telescope, what you see is magnified – in effect, 
you bring the sky closer, making it easier to see detail and faint objects.  The downside of 
magnification is that it always reduces your field of view, sometimes to just a fraction of a degree.  
The greater the magnification, the smaller the field of view. 
 
TheSkyX allows you to set the field of view to any angle, from 235 degrees to a fraction of a 
degree.  This is very useful when you’re trying to understand how much of a constellation or star 
field might be visible in a pair of binoculars or a small telescope. 

Setting the Field of View 

A simple way to change the field of view is to use the Zoom In and Zoom Out buttons.  The current 
field of view is displayed next to these buttons.  Click on that pop-up menu.  A list of preset fields 
of view is displayed.  Some of these correspond to the field of view of a typical pair of binoculars 
or amateur telescope.   
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The Wide Field option shows you the sky from horizon to horizon, 180 degrees.  The Naked Eye 
option gives you a 100-degree field of view – a bit wider field than what you can see with your 
eyes, but we wouldn’t want you to miss anything. 
 
You can also define a zoom box to zoom in to an area of the Sky Chart.  Place your cursor on one 
corner of the area you want to zoom in on.  While pressing the shift key, click and hold while you 
move your cursor to the opposite corner, then click anywhere inside the zoom box to enlarge it 
(you can click outside the zoom box to cancel this operation). 

Stellar Cartography 

Just as you would use a map to find your way around a city, state, or country, celestial maps or 
star charts are designed to help you find your way around the sky. 
 
Use your mouse or track pad to move the arrow around the Sky Chart.  You’ll notice that when 
the tip of the arrow touches an object, an information box describing that object is automatically 
displayed.  The kind of information displayed depends in part on the nature of the object, but 
one thing that is always displayed is the location of the object.  This is indicated by two different 
sets of coordinates. 

Cosmic Coordinates 

Maps of the Earth identify the location of landmarks with two numbers: latitude and longitude.  
Latitude is measured in degrees north or south of the equator, and longitude is measured in 
degrees east or west of the Prime Meridian. 
 
A similar system is used for objects in the sky.  The celestial equator divides the sky into two 
hemispheres, north and south.  The celestial equivalent of longitude is called right ascension 
(TheSkyX uses the abbreviation RA)  and the equivalent of latitude is called declination (Dec).  
Right ascension is measured in hours, minutes, and seconds, from 0 to 24.  This may seem odd at 
first, but there’s a very good reason for this peculiar convention: the Earth is rotating.  It turns 
around once on its axis in 24 hours, but from our terrestrial perspective, it looks like the sky is 
rotating around the Earth every 24 hours.  Right ascension is measured eastward from the 
constellation Aries, the Ram.  Specifically, 0 hours RA, the First Point of Aries, is the position in 
the sky where the Sun crosses the celestial equator on the first day of spring. 
 
Declination is measured in degrees north or south of the celestial equator.  The celestial equator 
is 0 degrees declination.  The north celestial pole is located at 90 degrees declination (Polaris, the 
North Star, has a declination very close to 90 degrees).  The south celestial pole is at minus 90 
degrees declination.  You can also translate right ascension into degrees: a complete circle has 
360 degrees; dividing 360 by 24 gives 15, so every hour of right ascension is equal to 15 degrees.   
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Imagine a line running across the sky from due north to due south, splitting the sky in two.  This 
line is called the meridian.  Better yet, turn on the Meridian checkbox under the Reference Lines 
& Photos group on the Chart Elements window (page 254) to view it on the Sky Chart.  When a 
celestial object crosses the meridian, it is also at its highest altitude in the sky.  This is called the 
transit time.  The best time to observe a celestial object with a telescope is when it’s crossing the 
meridian. 
 
This brings us to another way of identifying the location of an object in the sky: altitude and 
azimuth.  Altitude is simply the number of degrees the object is above the horizon, from 0 (on 
the horizon) to 90 (directly overhead).  Be careful not to confuse altitude with declination – they 
are not the same thing.   
 
Azimuth indicates the compass direction of an object.  Specifically, it is the number of degrees 
east of north that you need to turn to see the object.  Due east, for example, is 90 degrees 
azimuth.   
 
The problem with using altitude and azimuth for astronomical objects of course is that these 
numbers are constantly changing as the Earth rotates.  TheSkyX, however, can calculate these 
numbers instantaneously, making it easier to know what direction to look when you’re outside 
in the dark, trying to find an object at a specific time. 

Understanding Projections 

Ever since we discovered that the Earth isn’t flat, but spherical, cartographers have been looking 
for ways to represent a curved surface on a flat surface.  
 
A sphere cannot be projected onto a plane without introducing distortion. In the most commonly 
used projection – called the Mercator projection – objects get larger the farther they are from 
the equator. This causes Greenland to look nearly as large as the entire United States on a world 
map. Navigators adopted the Mercator projection because a straight line on a Mercator 
projection, called a rhumb line, represents a constant compass bearing from true north.  
 
Other projections have their own combinations of strengths and weaknesses. All projections are 
compromises – the “best” projection is the one whose advantages outweigh its disadvantages 
for an application.  
 
By default, TheSkyX uses the stereographic projection for fields of view greater than 60°.  A 
stereographic projection is said to be “conformal.”  Although (as with all flat maps) the overall 
projection is distorted, all lines of declination and right ascension intersect at right angles, as they 
do on the celestial sphere.  
 
The advantage of stereographic projection is that, over small areas of the display, object shapes 
are only slightly distorted.  Constellations remain easy to identify.  Compare this with the polar 
projection of a planisphere.  There is almost no distortion near the poles, but constellations near 
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the horizon are badly stretched out of shape.  (A planisphere is one of those rotating star charts 
that approximate what’s visible in the sky at a given date and time.)  
 
When the Sky Chart is set to a field of view of 60° or less, the projection automatically switches 
to an orthographic projection, which displays the sky more as it would appear on the surface of 
a sphere. (This is the only projection used at 60° fields of view and smaller.)  

Projections  

By default, TheSkyX uses a stereographic projection for 60° fields of view and greater. The 
Projections command from the Display menu changes the projection. In the Projections window, 
click the radio button of the projection you want.  
 

 

Figure 73: The Projections window. 

The selected projection is applied to the Sky Chart immediately.  It takes effect only when the 
field of view is greater than 60°—no change occurs if the current field of view is 60° or less. 
 

• Stereographic: The default for fields of view equal to and greater than 60°. It keeps lines 
of right ascension and declination at right angles and minimizes local distortion. 
Conformal. 235° maximum field of view. 
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• Orthographic: Displays the sky more as it would appear on the surface of a sphere. It’s the 
default (indeed, it’s the only available projection) for angles of view 60° and less. 
Conformal. 180° maximum field of view.  

• Mercator: Shows the celestial sphere like a conventional map. It allows wider fields of 
view, including a 360° view that shows the entire celestial sphere. Conformal. 360° 
maximum field of view.  

• Gnomonic: This is the “pinhole camera projection.”  It displays meteor paths as straight 
lines, as seen when viewing a meteor shower. Non-conformal. 150° maximum field of 
view.  

• Azimuthal Equal-Distance: The distance between objects having an angular separation on 
the celestial sphere is the same at any part of the Sky Chart. Non-conformal. 300° 
maximum field of view.  

• Azimuthal Equal-Area: The areas of any sections of the celestial sphere subtending a solid 
angle are the same at any part of the Sky Chart. Non-conformal. 235° maximum field of 
view. 

Stars and Constellations 

There are some 6,000 stars visible to the naked eye.  Most of these stars can only be seen from 
locations far from the bright lights of a city or town.  If you really want to see the stars, you either 
must go to Hollywood or get out of Dodge. 

Star Names 

Some of the brighter stars have proper names, but most don’t – there are just too many to give 
each one a name.  Instead, astronomers have devised a system that assigns names to naked-eye 
stars based on their brightness and the name of the constellation they belong to.  Following a 
centuries-long tradition, the brightest star in a constellation is designated by the first letter of the 
Greek alphabet, Alpha, followed by the genitive form of the Latin name of its constellation.  For 
example, the brightest star in the constellation Orion is called Alpha Orionis.  It also has a proper 
name: Rigel.  (We’ll talk more about constellations later.  Right now, we’re going to focus on 
individual stars.)  When the letters run out, stars are identified by various alphanumeric 
designations. 
 
A funny thing about Rigel: even though it’s the brightest star in Orion, its designation is Beta 
Orionis.  Astronomers originally thought that Betelgeuse, another star in Orion, was a little bit 
brighter, but improvements in photometers in the 20th century revealed that Rigel is the brighter 
star (it’s possible that Betelgeuse might have been brighter in the past, when astronomers first 
began to designate stars with Greek letters). 

Bright Stars and Dim Stars 

Long before the invention of the telescope, astronomers also came up with a numerical system 
for classifying stars by their brightness.  They decided that the brightest stars would be called 
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First Magnitude.  Those half as bright as First would be called Second Magnitude, then Third 
Magnitude, and so on down to Sixth Magnitude, which denotes the dimmest stars visible to the 
naked eye. 
 
We use a modified form of this system today.  The brightest star in the nighttime sky is called 
Sirius.  It’s in the constellation Canis Major, the Big Dog, and it’s sometimes called the Dog Star.  
Its magnitude is minus 1.4, which we write as –1.4.  This may seem a little confusing, but it isn’t 
that hard to understand.  A couple of centuries ago, astronomers decided to make the magnitude 
scale more precise.  They knew the Sun and Moon and some of the planets are brighter than the 
brightest stars, so these were given negative magnitudes.  They also realized that a First 
Magnitude star is a bit more than twice as bright as a Second.  To keep Sixth Magnitude as the 
faintest star visible to the naked eye, astronomers recalibrated the magnitude system to follow 
a logarithmic scale.  Each stellar magnitude is about 2.5 times brighter than the next lower 
magnitude so that the difference of five magnitudes is a brightness factor of (exactly) 100. 
 
With a telescope, you can see stars much dimmer than Sixth Magnitude.  TheSkyX database 
includes stars down to about 14th Magnitude. 
 
On a clear, moonless night, people who live in cities or suburbs can rarely see stars dimmer than 
Third Magnitude.  If you’re just starting to learn the names of the brighter stars and 
constellations, you should set the magnitude filter in TheSkyX to Second or Third magnitude.  That 
way, when you go out at night to compare what you see on your computer to what you can see 
in the real sky, you won’t be confused by a screen display that shows more stars than you can 
see from your location. 

Setting the Magnitude Limit 

This command tells TheSkyX to only display stars, galaxies, clusters, or any other object type, or 
combination of object types, that has magnitude information, that are brighter or fainter than a 
selected magnitude.  Controls for editing the magnitude limits are found on the Chart Elements 
window on the Display menu.   
 
The following example demonstrates how to change the magnitude limits for all celestial objects. 
 

1. Make sure the Chart Elements window is visible. If it’s not, select the Chart Elements 
command from the Display menu to show it.   

2. Highlight the Celestial Objects text by clicking on it.  This selects the 40 chart elements in 
the Chart Elements node. 

3. Click the Edit Attributes button. 
4. Near the bottom of the Chart Elements window you’ll see a tab labeled Magnitude Limits.  

You can enter a value between 30.0 and –6.0, or change the magnitude using the sliders. 
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Figure 74: Magnitude Limits tab on the Chart Elements window. 

The attributes of chart elements (including lower and upper magnitude, angular size, font 
properties and colors) can be changed individually or as a group based on the items that are 
selected in the Chart Elements list. 

Number of Selected Chart Elements (Selected) 

This text shows the name of the selected chart element or the number of selected chart elements 
in the Chart Element list. 

Show Only Brighter Stars (Hide fainter than) 

Specify the magnitude of the faintest objects to be displayed on the Sky Chart.  For example, if 
you live in a light polluted city and want to approximate the stars you can see on typical night’s 
sky, enter magnitude 1 or 2.  
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Show Only Fainter Stars (Hide brighter than) 

The Hide Brighter Than controls provide additional filtering, displaying objects only within a 
specified brightness range.  Larger magnitude values represent dimmer objects. The brightest 
objects have negative magnitudes. 
 
As you move the slider the number of stars on the Sky Chart changes to reflect the changing 
magnitude limits. 

Other Chart Elements 

Like land maps, star charts can be overlaid with a variety of lines and markings intended to 
highlight specific celestial features and help you find objects at specific coordinates. 
 
The Chart Elements menu lets you display or hide various reference lines and symbols, but you 
should be aware that even though the cosmos mostly consists of empty space, a star chart can 
get very crowded very quickly.  The celestial equator and lines of right ascension and declination 
can be added to the Sky Chart, for example.  Experiment with this feature by clicking on the box 
next to a listed chart element to see how it affects the display. 

A Star to Guide You 

For people living in the northern hemisphere, probably the most noteworthy star is Polaris, the 
North Star.  It always stays in the same part of the sky, every night, 365 days a year.  The reason 
for this is simple: Polaris happens to be located almost directly above our North Pole.  As the 
Earth rotates on its axis, other stars rise and set, but because Polaris is right above the pole, it 
always seems to stay in the same place.   
 
How high Polaris is above your horizon is a direct way to find your latitude.  If Polaris is 40 degrees 
above the local horizon, for example, you must be somewhere on the 40th latitude line.  
Philadelphia and Denver are both very close this latitude, as are Naples, Italy and Beijing, China.  
The stars you can see on any given date and (local) time are essentially the same for these cities, 
and any other place along this line of latitude.   
 
More than anything else, latitude determines what you can see in the sky.  The North Star is not 
visible from the Southern Hemisphere, as are most of the stars and constellations near it.  And 
there are all sorts of stars and constellations visible from the Southern Hemisphere that we never 
get to see in the North (the Moon and planets are visible from both hemispheres).  TheSkyX can 
show you what the sky would look like from any place in either hemisphere. 

Double Stars 

A little more than half of all stars travel in pairs, orbiting each other in space.  The American 
astronomer Henrietta Leavitt once quipped that three stars out of every two are double.  Most 
of them appear as single stars to the naked eye.  You need good binoculars or a small telescope 
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to resolve them as double stars (there are also triple stars and groups consisting of four or even 
more stars). 
 
Some double stars are true binaries, meaning they are gravitationally bound to each other and 
orbit a common point in space.  Others only appear to be double because they happen to lie 
along the same line of sight from Earth, but are in fact many light years apart and not tied to each 
other by gravity. 
 
One of the best-known double stars in the sky is called Mizar.  It’s located in the handle of the 
Big Dipper. 

Finding Mizar 

Mizar is visible only from the Northern Hemisphere, and is easiest to find in the evening sky in 
Spring. 
 
Select the Find tab from the vertical tabs on the left side of TheSkyX’s window. 
 
Type Mizar into the Search For text input, then click the Find button.  A double red “bull’s eye” 
will encircle the star in the Sky Chart.  
 
The Big Dipper is one of the northern sky’s most recognizable asterisms (this term is described 
below).  Being able to find it will help you find other nearby constellations, such as Cassiopeia.  
Once you’ve mastered these constellations, others will be easier to learn. 
 
Another good thing about being able to find the Big Dipper: it will make it easy for you to find 
Polaris, and therefore true north.  The two stars at the end of the cup of the dipper point to 
Polaris.  Imagine a line connecting these two stars.  Extend it in the direction the cup is pouring, 
about five times the distance between the two stars.  The star you see at the end of that line is 
Polaris.  
 

Variable Stars 

Fortunately for us, and everything else that lives on Earth, the Sun radiates energy at a very nearly 
constant rate.  But there are some stars that change in brightness dramatically over the course 
of a few months, and in some cases, just a few days or even hours.  These are called variable 
stars, and TheSkyX distinguishes them with a small red “v” to the lower left of the star.   
 
The most notorious variable star is called Algol, a name derived from an Arabic word that means 
demon.  Located in the constellation Perseus, its rhythmic dips in magnitude can easily be 
observed with the naked eye.  Every 2.867 days, over the course of just a few hours, Algol falls 
from second magnitude (2.1) to third (3.4) and back.  During these periodic dimmings, you can 
gauge its changing brightness by comparing it to other nearby stars.  The evening sky in Autumn 
is the easiest time to find this fascinating object (it is only visible from the Northern Hemisphere).  
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It may have been considered demonic in ancient times, but today we know this innocent star has 
a companion that orbits it every 2.867 days.  Algol dims when that companion passes in front of 
it from our perspective.  Such stars make up a special class called eclipsing binaries. 

Classifying Stars 

Stars differ not only in their brightness, but also in their size, surface temperature, and chemical 
composition.  The one thing they have in common is that they are all spherical – although some 
spin so fast they tend to bulge in the middle! 
 
All stars are basically immense balls of intensely hot gas that generate heat and light through a 
process called nuclear fusion.  The temperature and density in the core of a star are so great that 
lighter atoms smash into each with enough force to fuse into heavier atoms.  In our own Sun, for 
example, atoms of hydrogen fuse to produce atoms of helium (this process involves several 
intermediate steps).  The fusion process releases energy in the form of electromagnetic radiation 
– light. 
 
By spreading starlight into a spectrum, astronomers can learn the temperature and chemical 
makeup of stars.  After studying thousands of stars, it became clear that stars fall into various 
categories, or classes.  Some are massive and bright, and have relatively short, tumultuous lives.  
Others are small and dim, and can shine steadily for tens of billions of years. 
 
A letter and number system is used to define stars in terms of their most important physical 
characteristics, and these designations are displayed when you point to a star in the Sky Chart.  A 
more complete discussion of spectral classes and the physics of stars can be found in any 
introductory astronomy text. 

Giants and Dwarfs 

When you see a bright star in the sky, there are two possibilities: the star is close by and relatively 
average in size, or it is far away and gigantic. 
 
Rigel is the brightest star in the constellation Orion.  It is nearly 800 light years away, but is the 
seventh brightest star in the sky.  It is a whopper, with a diameter of about 100 million kilometers.  
The Sun, by comparison, is about 1.4 million kilometers across. 
 
Astronomers distinguish between apparent magnitude and absolute magnitude.  Apparent 
magnitude is how bright a star looks in the sky.  Absolute magnitude refers to how bright a star 
would appear if it were located exactly 10 parsecs (32.6 light years) away.  The apparent 
magnitude of Rigel is about 0.2, but its absolute magnitude is nearly –7.0. 
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More about Constellations 

The desire to find order in nature, even where none exists, seems to be built into the human 
brain.  When you look up at the sky on a dark, clear night, the sheer number of stars can be 
overwhelming.  Our distant ancestors must have been in awe of those countless lights randomly 
scattered across the sky like diamonds. 
 
Because of our instinctive need to find order, cultures across the globe have organized stars into 
distinctive patterns called constellations.  These patterns are purely a product of the human 
imagination.  Nature had nothing to do with creating them. 
 
The constellations we recognize today have mostly come down to us from the ancient Greeks.  
Many of them represent mythological figures.  Orion, for example, one of the most prominent 
constellations visible in northern wintertime, represents a heroic hunter who first appeared in 
one of the great epics of classical Greek literature, The Odyssey.  Orion is accompanied by two 
hunting dogs that are also immortalized in constellations: Canis Major and Canis Minor, the big 
and little dogs, respectively. 
 
When you look at Orion, it isn’t hard to imagine the figure of a hunter with a raised arm wielding 
a club.  You can see one classic representation of this figure by going to the Display menu and 
selecting Constellations & Asterisms Options.  You can display line drawings, mythical figures, 
and constellation boundaries by checking the appropriate boxes.  You can also use the slider 
labeled Transparency to adjust how bright these renderings appear. 
 
For many other constellations, the connection between its array of stars and what it is supposed 
to represent is difficult to see, to say the least.  They’re a little more like abstract art, intended to 
represent the idea of a thing rather than the thing itself. 
 
Drawing lines between the stars of a given constellation provides a simple “stick figure” view of 
that constellation.  When astronomers think about constellations at all, this is how they usually 
think of them.  The more fanciful mythological drawings of constellations became popular in the 
early 17th century, especially in the gorgeous star charts engraved by the great German celestial 
cartographer Johann Bayer (Bayer is also credited with creating the system that designates stars 
with Greek letters and the genitive name of their constellations, as described previously). 
 
When the constellations we recognize today were originally created, many stars were left over – 
that is, not all stars fit into the established patterns.  To avoid confusion, astronomers designated 
boundary lines between the constellations.  Not unlike borders between countries, any star that 
falls within the borders of a given constellation is said to belong to it, whether it was included in 
the original depiction of that constellation or not. 
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Asterisms 

There are familiar patterns of stars that don’t quite qualify as constellations.  Astronomers call 
these patterns asterisms.  The Big Dipper and the Pleiades (the Seven Sisters) are probably the 
two most familiar examples.  In Japan, the Pleiades are called Subaru.  You’ve probably seen them 
driving around your neighborhood. 

Some Tips on Using Star Charts 

Learning how to connect what you see on a star chart to what you see in the real sky takes some 
time.  We’re going to show you a step-by-step process that will make it easier for you to find 
common stars and constellations.  With a little patience and practice, you’ll soon become an 
expert. 
 
First, when you go outside and look at the sky, you need to know what direction you’re facing.  
You need to know how to find true north.  City streets often lie along north/south and east/west 
lines, but this isn’t always the case.  If you aren’t sure which way is north at your viewing location, 
use a magnetic compass to find it. 
 
When hundreds of stars are displayed on your chart, finding individual stars and constellations 
can be very challenging.  But if you limit the number of stars in the chart to just a dozen or so of 
the brightest stars, you’ll have a much easier time learning the sky. 

Printing a Sky Chart 

Printing a sky chart to take with you when you go outside is also very helpful.  TheSkyX can print 
any chart it displays.  You can print an “all sky” chart, or select a part of the sky you’re interested 
in learning.   
 
Choose the File command from the main menu.  Near the bottom of the menu, you’ll see two 
items: Print and Print Setup (if you have more than one printer connected to your computer, 
Print Setup can be used to select the printer you’d like to use).  Select the Print command. 
 
The Print Chart tab of the Export Chart window is displayed on the screen.  In addition to printing 
charts, TheSkyX allows you export charts as Portable Document Format (PDF), Scalable Vector 
Graphic (SVG) and Postscript files.   

To Export a Sky Chart in PDF, SVG or Postscript Format 

1. Select the desired option from the Format list. 
2. Click the Export button.  
3. On the Export Chart window, enter the file name to save the chart in this format. 
4. Click Save. 
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Click the Create Bitmap tab (or, from the main menu, click the Export command from the File 
menu) to view the options for saving Sky Charts as bitmaps or pixmaps.  Click the Copy Sky Chart 
button to copy the current chart to the Clipboard.  Click the Save As button to save the chart as 
a Portable Networks Graphics (PNG) file. 
 
Turn on the Create Custom Size checkbox to specify the Resolution, in dots per inch (DPI), Width 
and Height, in inches, of the bitmap.   
 
If you want to create high-resolution star charts for publication, individual “layers” of the chart 
can be exported by turning on the desired checkboxes in the Chart Layers tab. 

 
 
Clicking the Print button on the Print Chart tab sends the chart to the currently selected printer.  
TheSkyX uses the current Map Like display settings (page 251) and prints stars in black, leaving 
the sky white.  The size of the star is proportional to its magnitude.  Non-stellar objects are also 
printed using the symbols that appear in the Map Like Sky Charts. 
 
You can choose the orientation of the printout and other printing parameters by clicking the Page 
Setup button.  When you’re ready to print, simply click the Print button. 
 
The best time to start learning the sky is a clear, cloudless night, when there is no Moon or at 
most a crescent Moon.  Moonlight can interfere as much as city lights when it comes to seeing 
the stars, and if the Moon is close to Full, you probably won’t be able to find any but the very 
brightest stars and planets.  You also want to be in an open space, a place where there are no tall 
buildings, trees, or annoying artificial lights to interfere with your viewing.  Make sure that you 
have a clear view to the north. 
 
When you get to your observing site, give your eyes at least a few minutes to adapt to the 
darkness.  You’ll need a flashlight to read the chart of course, but you should use one that has a 
red filter.  These can be bought at most stores that sell telescopes, or you can simply tape a piece 
of transparent red film over a standard flashlight.  Using only red light will help preserve your 
night vision.  If you take your computer outside with you, the Display > Show Night Vision Mode 
command will help preserve it, too. 
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An Interstellar Perspective 

Our Sun is but one of billions of stars in the Milky Way galaxy.  For centuries, astronomers have 
been charting the positions of other stars in our galaxy, and have accurately determined the 
distances to many thousands of them.  This information allows us to step outside our solar 
system, in effect, and see what the Sun and other stars in our part of the galaxy would look like 
from dozens of light years away. 
 
The constellations are only figments of our imagination.  A constellation’s stars may seem to be 
close together, but are usually very far apart and often have no mutual relationship at all.  (Except 
for being part of the same galaxy, the Milky Way.)  The sky looks flat because there are no 
reference points to help us perceive the distance to the stars with just our eyes.  Since the human 
mind is pretty good at creating order from random patterns, seeing pictures in the sky is no 
surprise.  TheSkyX has a 3D stars tool that can help you to understand the spatial relationship 
between stars that we see at night.   

Viewing the 3D Star Map 

 
Selecting 3D Stars command from the Tools menu brings up the 3D Stars window.  Immediately 
upon opening the window, the viewer will pan across a 3D rendering of the heavens, with the 
position of our Sun marked in the center.  Click and drag on the star field to get a feel for the 
nature of the 3D space. 
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Figure 75: The 3D Stars window. 

3D Star Map Controls 

On the left, you will see the controls that operate the 3D Stars tool.  On the top, you will see a 
slider that allows you to view visible stars from those relatively nearby to those quite distant.   
 
The bottom slider, labeled Viewing Distance from the Sun, ranges from 1 to 2,000 light years.  A 
light year is a fundamental “cosmic yardstick” used to describe the distance to the stars.  One 
light year is equal to the distance that light travels in one year.  Since light travels at approximately 
300,000 kilometers per second in a vacuum, then a little math tells us that a light year is equal to 
about 9.5 trillion kilometers: that’s far!  Another interesting fact about light years is that the 
number of light years distant an object is tells us how long it takes light to arrive here from that 
object.  So, if an object is 2,000 light years away, that means it took the light we see from that 
object 2,000 years to reach us.  Also, it means that we see that object, not as it exists today, but 
as it existed 2,000 years ago.  The further we look out into space, the further we see back in time. 
 
Using the Filter Stars by Distance from the Sun slider will allow you to see the general stellar 
structure of our galaxy by displaying stars up to 2,000 light years away from our home solar 
system.  Using this can help you to get a feel for the relative distance of many stars, including 
well-known favorites, such as Betelgeuse and Rigel in the constellation Orion.  Notice that the 
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number of stars that disappear grows as you move the slider to the left, meaning that most of 
the stars we see at night are quite close to us, relatively speaking. 

Viewing a Single Constellation 

If you would like to focus on a single constellation, you can do that, as well.  Using the Show 
constellation pop-up menu, select a constellation; you can choose from any of the 88 official 
astronomical constellations.  Let’s use the functions of the 3D Stars tool to explore the region 
around a famous constellation, Orion, the Hunter. 
 

1. Choose the 3D Stars command from the Tools menu. 
2. Select Orion from the Show constellation drop-down menu.  You will now see the 

constellation of Orion, the Hunter in the viewer, surrounded by the constellation 
boundary box.  These boxes are used by astronomers to describe regions of the sky found 
near the 88 constellations. 

3. Check Show common star names to show the names of the more “famous” stars, the A-
listers, if you will.  In Orion, the stars of his shoulders, knees, and belt are labeled, as well 
as the brightest star of his head. 

4. Use the Filter Stars by Distance from the Sun slider to hide or reveal stars based upon 
their distance from the Sun.  Move the slider to the left, and take note of when each star 
in Orion disappears. 

5. Now, using the Viewing Distance from the Sun slider, adjust the distance back and forth 
and observe the effect on the constellation’s appearance. 

6. Try sliding the same slider about one-quarter of the way to the right.  Then, click and drag 
on the constellation.  You will see an exploded view of Orion’s stars through 3D space.  
This gives you a great view of the relative distance of each of Orion’s stars.  Experiment 
with various viewing distances to get a feel for how it works. 

7. Use the Filter Stars by Distance from the Sun slider to see an excellent demonstration of 
each star’s distance, as they appear and disappear, based upon their distance. 

 
Experimenting with the sliders and with different constellations will serve to give you a good 
grasp on relative stellar distances.  The next time you look up at Orion, think about space in 3D 
and the vast distances over which that light travelled to get to your eyes. 

Closer to Home: Atmospheric Phenomena 

As we mentioned earlier, some of the most interesting things we can see in the sky are happening 
right above our heads, in the upper atmosphere.   

Meteors and Fireballs 

You’ve probably seen a so-called shooting star (maybe you’ve even wished on one).  A shooting 
star isn’t really a star at all, but a grain of space dust.  When one of these particles hits our 
atmosphere, it’s traveling at tens of thousands of kilometers an hour.  Friction makes it glow 
white hot, turning it into a meteor.  It may seem surprising that a speck of dust at the edge of 
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space could create a streak of light visible from the ground, but even the brightest meteor is 
rarely bigger than a pea. 
 
The flying dust grains that cause meteors mostly come from the tails of comets.  Several tons of 
this material fall to Earth every single day.  If you get away from the lights of the city and watch 
the sky on a moonless night for an hour or two, you’ll see at least a few meteors – maybe quite 
a few.  They’re falling everywhere, all the time. 
 
Occasionally something much larger than a speck of dust falls to Earth and creates a spectacular 
fireball.  Fireballs can blaze across the sky with such intensity that they literally light up the 
landscape.  They can range in size from a few centimeters to several meters.  Bits and pieces of 
them sometimes survive the fiery descent through our atmosphere and crash into the ground.  
These fragments are called meteorites.   
 
Meteorites are chunks of asteroids and they fall into three main categories, based on chemical 
composition.  Iron meteorites are the most commonly found because they are very distinctive, 
consisting of ninety percent iron with a bit of nickel mixed in.  They are extremely dense, and 
have magnetic properties.  
  
Stony meteorites look more like common rocks.  They are the most common form of meteorite 
but aren’t found as often as iron meteorites for two reasons: they look like ordinary, everyday 
Earth rocks, and they can’t be located using a metal detector. 
 
The third class is the stony irons, which, as the name suggests, are a mixture of the iron and stony 
types. 
 
A few people around the world make a good living hunting and selling meteorites.  A decent-
sized specimen can be worth thousands of dollars to a museum or a private collector.  A really 
big meteorite with an unusual composition can be worth millions.  Something to think about next 
time you see a fireball… 

Meteor Showers 

The dust trails left by comets that have visited the inner solar system follow predictable orbits 
around the Sun.  Several times a year Earth passes near one of these cosmic debris trains, 
resulting in a meteor shower.  Halley’s Comet, which has a 76-year orbit, is responsible for two 
annual meteor showers, the Eta Aquarids in early May, and the Orionid shower in mid-October. 
 
Have you ever looked at a set of railroad tracks and noticed, as they stretch into the distance, 
how they seem to converge to a single point?  A similar effect can be seen during a meteor 
shower.  The debris “train” of the shower’s parent comet follows the tracks of an imaginary 
railroad.  If you pay attention to the direction most of the meteors in a shower seem to be coming 
from, they all converge back to the same point in the sky – the “vanishing point” of the tracks of 
the debris train.  This is called the radiant.  TheSkyX plots the radiant for all annual meteor 
showers and estimates the date and time they are expected to peak. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 170 

 
To display meteor shower radiants, select the Chart Elements tab from Display menu.  Within the 
list of elements, there is an item called Reference Objects.  Click it, and a new list of items is 
displayed.  Check the box next to Meteor Shower Radiants. 
 
The radiants for all meteor showers will now be displayed on the Sky Chart.  If you move the 
cursor to the center of any radiant, details on that shower, including when it is expected to peak, 
will be displayed.  

The Northern (and Southern) Lights 

The Northern Lights, or aurora borealis, can be as stunning as any fireworks display.  They appear 
as curtains of colorful, shifting light, suspended high up in the night sky.  Unfortunately, they are 
generally only visible from high latitudes, and when they might occur is notoriously hard to 
predict. 
 
Auroral displays are caused by charged particles from the solar wind striking the Earth’s upper 
atmosphere.  Our planet’s magnetic field guides these particles toward the poles, which is why 
auroras are only visible from high northern and southern latitudes (the auroral light show is called 
the aurora australis in the southern hemisphere). 

Our Celestial Backyard: The Solar System 

Our Sun is one of countless stars in the universe.  The planets that circle the Sun are its family, 
figuratively speaking, and it would be hard to deny that Earth is its favorite child.  The planet we 
call home is located at just the right distance to be neither too cold nor too hot for liquid water 
and life to flourish on its surface.  But the rest of the Sun’s family – the solar system – is full of 
diverse and fascinating characters.  Some of them may once have harbored some form of 
primitive life.  These bodies are much, much closer than even the next nearest star, and so 
astronomers like to say they inhabit our celestial backyard. 
 
Finding a planet in TheSkyX is simple.  Simply go to the Edit menu and choose Find.  Type the 
name of the planet in the Search For box.  Information about the planet will be displayed.  You 
can center the planet in the Sky Chart by clicking the Center button near the bottom of the screen.  
Note that this same procedure applies to every object in TheSkyX’s database.  If you’re unsure of 
an object’s name or catalog number, click the Advanced button to view a comprehensive list of 
searchable objects. 

The Moon 

The most familiar object in the night sky is undoubtedly the Moon.  It’s been Earth’s constant 
companion for more than four billion years.  Scientists believe that the Moon was formed shortly 
after the birth of the solar system, when a molten planet about the size of Mars smashed into 
the Earth.  That planet is no longer around, but much of the fallout from its impact settled into 
orbit around us and aggregated into the Moon. 
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The Moon is tidally locked to the Earth.  Our gravitational pull, over millions of years, slowly put 
the brakes on the rotation of our satellite.  Today the Moon makes one complete rotation for 
every single orbit it makes around the Earth.  Because of this, the same side of the Moon always 
faces the Earth.  We had no way of seeing the far side of the Moon until spacecraft were sent 
there in the late 1950’s.  Some people mistakenly call the far side of the Moon the dark side of 
the Moon.  With all due respect to Pink Floyd, the Moon has no “dark” side.  Over the course of 
a lunar day (about 29.5 Earth days) the far side of the Moon gets just as much sunlight as the side 
facing us. 
 
As the Moon orbits the Earth, it goes through its familiar phases, from New to Full and back again.  
TheSkyX can tell you the phase of the Moon on any date, at any time.  It is automatically displayed 
on the star chart in its current phase and proper location whenever it is above the horizon.  The 
orbit of the Moon is not a perfect circle, but an ellipse, meaning it has an oval shape (in fact, all 
orbits, from artificial satellites to planets to stars circling the centers of galaxies, are ellipses).  
TheSkyX will tell you the current distance between the Earth and Moon. 
 
The Moon is one of the most interesting things to look at in binoculars or a telescope.  Even a 
little magnification will reveal the larger lunar craters, and help you see the mare, the so-called 
lunar “seas,” which are really cooled lava basins.  The Moon has no atmosphere, so liquid water 
cannot exist there.  Our single natural satellite is dry as a bone, but there is some evidence that 
small amounts of water ice might reside in the permanently shadowed craters near the Moon’s 
poles. 

Moon Photo Viewer 

 
 
TheSkyX includes a detailed map of the Moon based on photographs taken by a spacecraft called 
Clementine.  Clementine was launched into space on a converted intercontinental ballistic missile 
– a Cold War sword was turned into a lunar plowshare that yielded a rich scientific harvest, giving 
scientists important new information on the morphology (shape) and mineralogy of the Moon. 
 
To access the Clementine Moon map, go to the Tools menu and choose Moon Photo Viewer.  
Your lunar journey begins with a photo showing the region near the feature Tranquillitatis, better 
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known as the Sea of Tranquility.  As you move the mouse cursor over the photo, different features 
are highlighted in red, and the Moon’s longitude and latitude are shown to the left.  (To highlight 
larger features, place the cursor near its center.) 
 

 

Figure 76: Moon Photo Viewer window. 

You can use the Sky Chart’s Moon with the Moon Photo Viewer to locate a feature in a photo on 
the Earth-based view of the Moon.  Or, you can click on the Sky Chart’s Moon to show the photo 
of that region. 
 
Do to so, first position the Moon Photo Viewer window so that the Sky Chart is also visible on 
your screen.   
 
Lock On and Frame the Sky Chart’s Moon: 
 

1. Clicking the Find command from the Edit menu. 
2. On the Find window, type Moon and then click the Lock On button. 
3. On the Find window, click the Frame button. 
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Figure 77: The Sky Chart Moon showing the position of the current Clementine photo (red rectangle) and the Moon grid 
lines. 

The Moon is now fixed to the center of the Sky Chart.  Make sure that the Highlight Region on 
Sky Chart’s Moon checkbox is turned on (page 174).  You can now click on the Sky Chart Moon 
to show the photo of that region on the Moon Viewer window.  Or, you can change the Moon 
Viewer Photo by clicking the Left/Right/Above/Below buttons and the Sky Chart’s Moon will 
highlight this region in red. 

Label Moon Features 

Many interesting lunar features can be labeled on the Clementine photos, including: 
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• Craters 

• Sub-craters 

• Mare (lunar “seas”)   

• Landing Sites 

• Catena (crater chains)   

• Rima (rilles)   

• Lacus (lakes)   

• Mons (mountains)   

• Dorsum wrinkle ridges   

• Promontor promontories   

• Vallis (valleys)   
 
Turn on the Show Moon Features checkbox to display the selected features.  The Turn All On and 
Turn All Off buttons can be used to show or hide all features. 

Feature Information & Mouse Coordinates 

Placing the mouse cursor over the photo reveals additional information, including the precise 
lunar latitude and longitude and details about the feature.  When the Show Crater Outlines 
checkbox is turned on, the crater beneath the mouse cursor is also highlighted in red. 

Show Adjacent Photo 

Press the Left/Right/Above/Below buttons to navigate the Moon’s surface. 
 
As you scroll around, you might notice black rectangular regions on some photos.  These show 
areas where no photographic data was acquired during the survey. 

Options 

The Moon Viewer window offers the following display options.  

Show Crater Outlines 

Turn on the Show Crater Outlines to display yellow circles around the craters on the photos.   

Show Grid on the Sky Chart’s Moon 

Turn on Show Grid on the Sky Chart’s Moon to show lines of latitude and longitude on the Sky 
Chart’s Moon.  

Highlight Region on Sky Chart’s Moon 

Turn on this checkbox to show the location of the current photo on the Sky Chart’s Moon.  You 
can also click anywhere on the Sky Chart Moon to show the Clementine photo for that area. 

Show High-Resolution Photos 
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Turn on this checkbox to show 100-meter resolution Clementine photos in TheSkyX Professional 
Edition.   
 
Setting the Moon’s Font  
The font used to label Moon features on the Clementine photos is the same font used to label 
the Sky Chart’s Moon.  If you wish to change this font, edit the Moon’s font attributes from the 
Chart Elements window (page 236) . 
 

 

Figure 78: TheSkyX’s Moon shows simulated shadows based on the Moon’s topography and the current phase. 

 
TheSkyX incorporates elevation data from lunar space missions to create a realistic view of the 
Moon’s surface.  (Hardware Acceleration is required for this feature to work; see “Hardware 
Acceleration” on page Error! Bookmark not defined.14 for details.) 

The Classical Planets 

Not counting Earth, five planets are visible to the naked eye.  It has been known since ancient 
times that the planets slowly change position relative to the stars, which appear to be fixed, never 
moving with respect to each other from year to year.  In fact, the word planet derives from an 
ancient Greek term that means “wanderer.” 
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All planets in our solar system orbit the Sun (you probably know that the Sun is a star, not a 
planet).  Their orbits lie more or less in the same plane, so as they circle the Sun, their paths are 
restricted to a narrow band in our sky, which is called the ecliptic.  The constellations that lie in 
this plane received special attention from ancient astronomers.  Collectively they are known as 
the Zodiac constellations. 
 
The farther a planet is from the Sun, the longer it takes to complete a single orbit.  Planets farther 
from the Sun therefore move more slowly through the Zodiac.   
 
TheSkyX can locate any planet wherever it happens to be on a given night.  Below we describe 
some general features of the planets, starting from the closest in, then moving out to the edge 
of the solar system. 

Mercury 

Mercury is the closest planet to the Sun.  It takes only 88 days to travel around the Sun once.  
This is another way of saying that a year on Mercury is 88 days long. 
 
Because Mercury is so close to the Sun, it can be spotted only shortly after sunset and shortly 
before sunrise, when it is near the “edge” of its orbit from our perspective.  It is hard to see much 
surface detail on Mercury in even the most powerful telescope, but the Mariner 10 spacecraft 
made three “fly-bys” of Mercury in 1974 and 1975.  Pictures from that spacecraft revealed 
Mercury strongly resembles our Moon, with a heavily cratered surface.  It is comparable to our 
Moon in size, but much denser.  Being so close to the Sun, the surface of Mercury is very hot, as 
you would expect.  The average daytime temperature there is above 400º C. 

Venus 

Commonly known as both the morning and the evening “star,” Venus is the brightest natural 
object in the sky after the Sun and Moon.  Its beautiful radiance has dazzled mankind throughout 
history.  Venus is so bright that, from a very dark location, it can cast shadows. 
 
When astronomers first eyed Venus through telescopes, they discovered that the planet is 
perpetually enveloped in clouds.  They never part, keeping the surface of the planet forever 
shielded from direct view.  This fact led to a great deal of fevered speculation about what might 
be hidden beneath those relentless clouds.  Could Venus harbor steamy, tropical rainforests, 
inhabited by alien dinosaurs or even more exotic forms of life?   
 
Much to the disappointment of science fiction writers, astronomers discovered in the early 
1960’s that the surface temperature of this deceptively serene-looking planet is hot enough to 
melt lead.  Venus is a hellish, uninhabitable desert.  The reason for this is a runaway greenhouse 
effect.  The Venusian atmosphere is almost entirely carbon dioxide (CO2), a gas notorious for its 
effectiveness at trapping heat.  The fact that high concentrations of CO2 have raised the surface 
temperature of Venus so far above what we would otherwise expect is one reason some worry 
about rising CO2 levels on our planet.  If Venus had the same mix of nitrogen and oxygen in its 
atmosphere as we have in ours, it would almost certainly be a lovely place to spend your vacation. 
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When Galileo began to systematically observe Venus with his telescopes, he discovered it goes 
through phases like the Moon.  This helped convince him that the Sun, not the Earth, is the center 
of motion in the solar system.  Venus, like Mercury, is an “inner” planet, meaning that they lie 
closer to the Sun than we do.  This is why these planets are visible only in the early evening or 
pre-dawn skies – from our location in the solar system, they never appear to travel very far from 
the Sun. 

Earth 

Earth is the third planet from the Sun.  Scientists sometimes refer to Earth as the Water Planet 
because more than 70 percent of our surface is covered by liquid water, and water is essential 
for life.  Our world is the only planet in the solar system that can support life as we know it. 
 
A day is defined as the amount of time it takes for Earth to make one complete rotation on its 
axis.  A year is defined as the time it takes Earth to make one complete orbit of the Sun.  The 
length of a day and year are different on other planets because they rotate at different rates and 
have different orbits. 
 
The axis about which our planet turns is tilted relative to the plane of our orbit.  This is why we 
have seasons.  In the summer, our northern hemisphere is tilted toward the Sun, so the days are 
longer, and sunlight strikes the Earth more directly, making the northern hemisphere warmer 
(the opposite is true in the southern hemisphere) than it is in winter.  In the wintertime, our 
northern hemisphere is tilted away from the Sun.  The days are thus shorter and colder (again, 
the opposite is true in the southern hemisphere).   
 
A solstice occurs when our axis is tilted directly toward or away from the Sun.  The winter solstice 
is the shortest day of the year, and the summer solstice is the longest (depending on your 
latitude, this may or may not correspond to the times of earliest sunrise and latest sunset – the 
explanation is a little more complicated than what we’re prepared to discuss here).   
 
An equinox occurs when the center of the Sun is directly above the Earth’s equator.  There are 
two of these each year, one in spring (the vernal equinox) and one in fall (the autumnal equinox).  
Equinox is derived from Latin and means “equal night.”  During an equinox, night and day are 
both just about 12 hours long. 
 
Like all planets, the orbit of the Earth is not perfectly circular, but slightly elliptical.  The Earth is 
about a million kilometers closer to the Sun in December than June. 

Mars 

The next planet out from the Sun is Mars.  It is about half the size of our planet and takes a little 
more than two years to go around the Sun once.  Mars is very similar to Earth in two important 
ways.  Its day is just over 24 hours long, and its axis of spin is tilted about 23 degrees, almost the 
same tilt as Earth.  This means that Mars has seasons, just like we do.  But they last twice as long, 
since a Mars’ year is about twice as long as one of ours (687 Earth days, to be more precise). 
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Like Venus, the atmosphere of Mars is almost entirely CO2.  Unfortunately, it is an extremely thin 
atmosphere, about 1/100th the pressure of our atmosphere at the equivalent of Martian sea 
level.  During the day, the surface temperature of Mars near the equator can rise above freezing, 
but that same night it will drop well below –100º C.  A little more greenhouse effect on Mars 
would be a welcome thing.  As it is, the air on Mars is too thin to support liquid water on its 
surface, another blow to all those science fiction writers who imagined alien beings and ancient 
civilizations on Mars. 
 
Still, Mars is the only other planet in our solar system whose surface is directly accessible to 
astronauts.  Even though liquid water can’t exist on Mars today, there is lots of geological 
evidence to suggest that in the distant past, the atmosphere of Mars was much thicker, and water 
flowed there freely.  This gives scientists hope that Mars may have once harbored simple forms 
of life.  If life did thrive there in the distant past, it may still survive today, perhaps in small “oases” 
deep underground, where organisms would be protected from the harsh conditions on the 
surface. 
 
The best time to look at Mars in a telescope is during an opposition.  About every 26 months, 
Mars and Earth line up on the same side of the Sun.  This is when Mars is at its brightest and 
closest, and therefore appears at its best in a telescope.  TheSkyX can calculate the dates of future 
oppositions and even tell you how large, in arcseconds, the disk of Mars will appear in an Earth-
bound telescope. 
 
As Mars approaches opposition, it briefly exhibits retrograde motion.  This is a fancy way of saying 
that Mars looks like it turns around and moves backward in the sky for several days.  This is simply 
a trick of perspective.  As our two planets orbit the Sun, Earth catches up to and passes Mars.  
When we pass, Mars appears to move backward with respect to the far more distant stars. 
 
Looking at Mars through a telescope, the first thing an observer usually notices on the disk of the 
planet are the albedo features.  These are bright and dark markings that mostly correspond to 
variations in the coarseness of Martian surface dust.  They were first systematically charted and 
named by the Italian astronomer Giovanni Schiaparelli in the 19th century.  He mistakenly 
believed that the dark features were seas and lakes, and he used the Latin terms mare and lacus 
accordingly.  Today we know there is no surface water on Mars, but like Earth, the Red Planet 
does have polar caps.  Unlike our polar ice, they are made not just of frozen water but carbon 
dioxide or “dry ice” as well.  During an opposition, you can usually glimpse either the northern or 
southern cap in a small telescope.   
 
There is a huge difference between seeing Mars in a telescope and looking at images of Mars 
taken by orbiting spacecraft.  Beginning with the Mariner 4 fly-by in 1965, American, Russian, and 
European spacecraft have revealed Mars to be a world of geological wonders.  Huge craters, 
towering volcanoes, and immense systems of canyons mark and etch its surface. 
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Mars is orbited by two small moons, named Phobos and Deimos (ancient Greek words for fear 
and terror, respectively).  They are much smaller than our Moon, irregularly shaped, and difficult 
to see in most amateur telescopes.  Some scientists believe these moons are wayward asteroids. 

The Asteroid Belt 

A ring of interplanetary debris circles the Sun between the orbits of Mars and Jupiter.  These 
rocky fragments are thought to be remnants from the original disk of material that formed the 
planets.  The gravity of Jupiter prevented these bodies from aggregating into a planet in their 
own right.  There are literally millions of asteroids, but collectively their mass is only about 1/10 
the mass of our Moon. 
 
Ceres is the largest asteroid, and the first to be discovered back on New Year’s Day in 1801.  
TheSkyX does not include asteroids in its main database, but you can add information on 
asteroids through the Input > Small Solar System Bodies menu. 

Jupiter 

Jupiter is the king of the planets.  Ten times wider than Earth, it has more mass than all the other 
planets in our solar system combined.  Nearly a billion kilometers from the Sun, it takes twelve 
years to complete a single orbit.   
 
Jupiter has a family of dozens of moons of various sizes and shapes, forming, in effect, a “mini” 
solar system.  At last count, astronomers have charted over 60 moons orbiting this giant world.  
Many of these bodies are small as a typical asteroid (some of them might even be asteroids that 
were captured by Jupiter, caught like flies in its gravitational web). 
 
Jupiter is attended by four large moons comparable in size to our own Moon.  Because they were 
discovered by Galileo when he first turned his telescope on Jupiter in 1609, we call them the 
Galilean satellites. 
 
TheSkyX includes telescope and spacecraft images of Jupiter, and can plot the orbits of its 
Galilean satellites.  This is a particularly useful feature if you have a telescope.  The moons shift 
position night to night as they orbit Jupiter, and you can track these motions with a modest 
telescope, or even a good pair of binoculars.  Also, when a Galilean moon passes in front of 
Jupiter, it casts a shadow on the disk of the planet that can be observed in small telescopes.  
These shadow transits are fascinating to observe, and TheSkyX graphically shows when they will 
occur.  It also provides timings for another interesting phenomenon involving Jupiter’s moons, 
an occultation.  These occur when one of the moons enters the giant planet’s shadow and passes 
behind it.  Interesting Historical Note: by timing the occultations of the Jovian moon Io, the 
astronomer Ole Romer was able to make a rough estimate of the speed of light way back in 1676. 

Saturn 

Author’s comment: I’ll never forget the first time I saw Saturn through a telescope.  I was 11 years 
old.  The telescope was small enough to fit in a lunchbox, but it was made by an extraordinary 
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man named Max Bray, and was more than a match for Saturn.  In the eyepiece, I saw a small 
white disk nestled inside a perfect set of white rings.  It took my breath away.  Everyone I know 
who has ever seen Saturn in a telescope remembers it.  The most fun I’ve ever had in over three 
decades of being involved in astronomy is showing someone Saturn in a telescope for the first 
time.  The planet is best known of course for its extraordinary rings.   
 
Saturn takes nearly 30 years to complete one orbit around the Sun.  During this period, our view 
of the rings is slowly changing.  Sometimes they are spread relatively wide and are easy to see, 
but about every 15 years they line up edge-on to our view.  These “ring plane crossings” last a 
few days or so, and during this time all that can be seen of the rings is a dark, thin line crossing 
the disk of the planet. 
 
Like Jupiter, Saturn is attended by numerous moons of various shapes and sizes.  Titan, the 
largest, has a mostly–nitrogen atmosphere about one-and-a-half times thicker than the Earth’s. 

Going Farther 

Saturn is the farthest planet that was known to man in ancient times.  The invention of the 
telescope revealed innumerable new worlds never before seen by human eyes, including 
previously unknown planets in our own solar system. 

Uranus 

The seventh planet out from the Sun, Uranus is the first planet discovered by telescope.  The 
astronomer William Herschel is credited with recognizing it as a planet over two hundred years 
ago, in 1781 (other astronomers had seen it, but mistook it for a star – Herschel initially thought 
it was a comet).  Like Jupiter and Saturn, it is a giant, much larger than Earth, and its atmosphere 
is mostly made of hydrogen and helium.  But there are also significant amounts of water, 
ammonia, and methane ice in this frigid world, and so astronomers refer to it as an Ice Giant. 
 
At a distance of almost 3 billion kilometers, Uranus takes 84 years to make a complete trip around 
the Sun.  Its axis of rotation is tilted 98 degrees to the plane of its orbit, as if the planet had been 
flipped on its side.  Like all the giant planets, Uranus has an extensive family of moons, at least 
27.  They are named after characters taken from the works of Shakespeare and Alexander Pope.  
The largest, Titania, is about half the size of Earth’s Moon. 
 
On a dark, moonless night, Uranus is just barely visible to the naked eye – if you have very sharp 
vision and know exactly where to look.  TheSkyX, of course, can tell you where to find it.  Uranus 
is relatively easy to find in a good pair of binoculars. 

Neptune 

The next planet out, Neptune, is similar in size and composition to Uranus.  It is also considered 
an Ice Giant.  The existence of Neptune was predicted by mathematical analysis of the orbit of 
Uranus.  Deviations in the predicted orbit of Uranus led astronomers to believe that some other 
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large body farther out in the solar system periodically tugs at Uranus.  This theory was confirmed 
when Neptune was discovered close to its predicted position.   
 
In a telescope, Neptune appears cool blue in color.  It was first spotted by none other than Galileo, 
when it happened to be near Jupiter in the sky, but Galileo assumed that this faint blue object 
was a star, not a planet, and so he is not credited with its discovery. 
 
It takes Neptune over 184 years to make a single orbit of the Sun.  Discovered in 1846, it has yet 
to make a single orbit since it was first recognized as a planet.  It lies some 4.5 billion kilometers 
from the Sun, and is attended by 13 diverse moons.  The largest, Triton, is 2700 kilometers in 
diameter, just a little smaller than our own Moon.  Triton orbits Neptune in a retrograde orbit, 
which means that it travels backwards relative to the direction of rotation of Neptune itself.  This 
suggests that Triton did not form with Neptune, but came into being somewhere farther out in 
the solar system and was later captured by Neptune’s gravity. 

Pluto and the Ice Dwarfs 

We all used to be taught that there are nine planets in the solar system.  That is no longer the 
case.  Pluto has been demoted.  Today it is not considered a full-fledged planet, but an ice dwarf, 
one of perhaps hundreds of such objects that inhabit the outer reaches of the solar system. 
 
Many people, including a lot of astronomers, are unhappy that Pluto has lost its status as a planet.  
Controversy is still raging over the decision to reclassify it.  If you’re wondering who gets to decide 
whether Pluto is a planet, the authority rests on a group called the International Astronomical 
Union  (IAU).  Founded in 1919, the IAU has some 10,000 members, all professional astronomers.  
Its main purpose is to promote and protect the science of astronomy internationally, but it also 
has sole authority for classifying and naming astronomical objects.  Despite some groups that 
claim otherwise, you cannot have a star named after yourself or a loved one without going 
through the IAU. 
 
During their August 2006 meeting, the IAU membership voted on a new, more rigorous definition 
of a planet that had been developed by one of its working groups.  This new and improved 
classification scheme included the category “dwarf planets”  to cover objects in our solar system 
that had recently been discovered beyond the orbit of Pluto.  Unfortunately for Pluto fans, it 
perfectly fits the new category, hence the demotion. 

Land of the Comets: The Kuiper Belt and the Oort Cloud 

One of the most beautiful things you’ll ever see in the sky is a bright comet.  Comets are refugees 
from the outer fringes of the solar system.  Mixtures of ice and dust, the astronomer Fred 
Whipple famously described comets as “dirty snowballs.” 
 
Astronomers believe that most comets spend their lives in either the Kuiper Belt or the Oort 
Cloud.  Named for the astronomers who first theorized their existence, these regions of space, 
far beyond the orbit of Pluto, are thought to be repositories of matter left over from the 
formation of the solar system. 
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A gravitational nudge from a nearby star or a passing cloud of interstellar dust can send an object 
from this region careening into the inner solar system.  When a comet gets close to the Sun, its 
ice begins to sublimate.  The escaping gas and dust form the coma and tail that give comets their 
distinctive appearance. 
 
Most comets are unexpected strangers to our part of the solar system, but some have settled 
into predictable, short-term orbits.  Halley’s Comet is probably the most famous example.  
TheSkyX charts the orbits of several periodic comets.  Most of them can only be seen on rare 
occasions with a telescope, but you never know when a new comet will be discovered and grace 
our sky in spectacular fashion, as comets Hyakutake and Hale-Bopp did in the late 1990’s. 
 
You can also enter the orbital elements of newly discovered comets into TheSkyX database using 
the Input > Small Solar System Bodies command.  The position of the comet from night to night 
can then be displayed in the Sky Chart.  Orbital elements can be downloaded from Harvard 
University’s Center for Astrophysics website. 

A 3D View of the Solar System 

Planetary motion is complex.  It took humans thousands of years to figure it all out.  Fortunately 
for us, computers make the tough math a breeze, and they allow us to create useful simulations 
of the motions of solar system objects. 

Modeling Planetary Motion 

The planets move in predictable orbits about the Sun, and with the easy-to-use Solar System 
Tool, you can model their positions and motions with ease. 

 

The Planets 

For a 3D solar system simulation including the eight classical planets, plus Pluto, select Solar 
System from the Tools menu.  A window then opens showing the solar system simulator.  On the 
right, you see the simulation.  You can click and drag on the simulated solar system to change the 
orientation and view it from varying angles.  Time can also be moved forward or backward using 

http://www.minorplanetcenter.org/
http://www.minorplanetcenter.org/
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the Time Skip item in the Tools menu, or the corresponding toolbar buttons.  Alternately, you 
can adjust the time using the Date and Time item in the Input menu. 
 
On the left are the menus and controls that affect what you see in the simulator.  There is a slider 
that lets you control the viewing distance from 1 to 50 A.U., or astronomical units.  An 
astronomical unit is a basic unit of distance used to describe the distance between objects within 
the solar system.  One A.U. equals the average distance from the Earth to the Sun, about 150 
million kilometers.  Try out the distance slider to get a feel for how it works. 
 
There are also checkboxes used to toggle on or off the ecliptic grid, orbit depths, and the 
background stars. 

Small Solar System Bodies: Comets 

Small solar system bodies include comets and asteroids.  TheSkyX can display the orbits of these 
objects in the solar system simulator.  By default, there are none available to show, so you will 
have to download some from the internet.  Let’s start by downloading some comet data  
 

1. With the Solar System window open, select Input > Small Solar System Bodies.  A new 
window appears with three tabs at the top, Comets, Asteroids (Small Database), and 
Asteroids (Large Database).  Select the Comets tab. 

2. A window opens labeled Comets Available for Display.  Here, you will see the total 
number of comets available for display, as well as a list of their names with checkboxes.  
It is with these checkboxes that you can toggle comets on or off in the Sky Chart or in the 
solar system simulator. 

3. You have three options for importing comet data into TheSkyX.  You can import them 
from an existing file, or you may download comet data directly in TheSkyX using internet 
databases.  You may download individual comet data by name, or you can download all 
the data for all observable comets at once.  For our example, let’s download all observable 
comets at once.  To do this, simply click Observable. 

4. The data will then download, and the observable comets will now appear in the list above, 
on the Sky Chart, and in the solar system simulator. 

 
Note: Be sure that your computer is connected to an active internet connection before 
attempting to download comet data. 

Small Solar System Bodies: Asteroids 

The process is very similar when downloading asteroid data from the Asteroids (Small Database) 
tab.  There, you can choose to import asteroid data from an existing file, by orbital characteristic, 
such as distant, critical, or unusual, or you may import by asteroid name. 
 
Should you decide to import asteroids from the Asteroids (Large Database) tab, you will have to 
visit one of the websites provided and download a file with the desired data.  You can then select 
the file with the Choose button to reveal the asteroids in the Sky Chart and solar system 
simulator.  Additionally, the checkboxes you see under the Asteroids (Large Database) tab toggle 
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important display options such as computing asteroid positions at startup and 24-hour object 
paths for imported asteroids. 

Eclipses 

 
One of the most spectacular phenomena in nature is a total eclipse of the Sun.  If you’ve seen 
one, you’ll never forget it, and chances are you’ll want to see as many as you can in your life.  
TheSkyX can predict eclipses literally thousands of years in the future.  It can tell you where the 
eclipse will be visible and how long it will last, so naturally it’s a great tool for planning a trip to 
see one of these extraordinary events. 
 
There are three kinds of solar eclipses: total, annular and partial.  In a total eclipse, the Moon 
passes in front of and completely covers the disk of the Sun, making it possible to see the Sun’s 
corona, its extended atmosphere, and eruptions of surface plasma called prominences.  This is 
truly a unique coincidence: the Sun is 400 times bigger than the Moon, but the Moon is 400 times 
closer to the Earth, so in our sky, they have almost the same angular diameter, about half a 
degree.  No other moon in our solar system can treat its home planet to a total eclipse. 
 
Like a total eclipse, an annular eclipse occurs when the Moon goes right in front of the Sun.  Due 
to differences in orbital positions, the angular size of the Moon is a bit smaller than the Sun.  At 
the peak of an annular eclipse, a ring or “annulus” of light appears around the Moon.   
 
In a partial eclipse, the Moon covers a portion of the Sun, so the corona and prominences aren’t 
visible.  Still, a partial eclipse can be fascinating to observe – if you use an appropriate filter to 
protect your eyes.   
 
The Solar and Lunar Eclipse Finder lists hybrid eclipses that include both total and partial eclipses 
during the event.  For example, the eclipse in April 2023 near Australia begins as an annular 
eclipse, becomes a total eclipse, and then reverts to an annular eclipse. This type of eclipse is 
designated as Hybrid A-T-A. 
 
NEVER LOOK DIRECTLY AT THE SUN WITHOUT A SAFE FILTER!  You can instantly and 
permanently damage your eyesight by looking at the Sun without proper protection. 
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Lunar eclipses occur when the Moon passes into the shadow of the Earth.  If the Moon orbited 
the Earth in the same plane as the Earth orbits the Sun, a lunar eclipse would happen every 
month, when the Moon is in its Full phase.  But because the orbit of the Moon is tipped about 
five degrees relative to the orbit of the Earth around the Sun, lunar eclipses only happen about 
once every eighteen months when the orbits are aligned. 
 
You might imagine that when the Moon passes into our shadow it completely disappears, but it 
doesn’t.  Dust in our atmosphere scatters a little bit of sunlight into our planet’s shadow.  Because 
dust mostly scatters red light, the Moon typically takes on a dim red or copper glow during the 
total phase of a lunar eclipse.  How dark the Moon becomes depends mostly on how much dust 
happens to be in the air at the time of the eclipse.  One of the fun things about viewing a lunar 
eclipse is that you never know exactly what shade of red or how dark the Moon will appear. 

Viewing Eclipses 

Selecting Solar and Lunar Eclipse Viewer command from the Tools menu bar brings up the Solar 
and Lunar Eclipse Viewer Window.   
 

 

Figure 79: The Solar and Lunar Eclipse Viewer window. 

In it, you will see a list of upcoming eclipses, a box displaying local circumstances for a selected 
eclipse, the eclipse viewer, and several checkboxes and sliders used to control the viewer. 

Solar Eclipse Viewing 

While using protective eyewear is certainly not necessary when viewing a solar eclipse in 
TheSkyX, the importance of using proper protection when observing the actual Sun at any time 
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can never be overstated.  Experienced observers should consider the following guidelines when 
observing a total eclipse: 
 

1. get a proper eclipse viewing filter – do NOT improvise – and use it right up until the sky 
darkens rapidly, 

2. enjoy the total phase naked eye as nature intended,  
3. use the filter again as soon as the corona has been outshone by the diamond ring. 

 
In the eclipse viewer, solar eclipse paths are viewed on a three-dimensional Earth globe, showing 
the eclipse shadow’s path, rise and set curves, and umbral and penumbral limits. 
 
To view a solar eclipse, scroll down the list near the top of the window and select a solar eclipse.  
Immediately, you will notice that the eclipse viewer will update to show the pertinent data on 
the Earth globe.  A small green circle indicates your home position, as entered in the location 
section of TheSkyX.  Additionally, you will notice a black circle along with colored lines 
representing important data about the selected eclipse.  The following is a brief description of 
these markings. 
 
The Black Circle marks the umbral (darker) eclipse shadow as projected onto Earth.  This is the 
region where eclipse totality is possible. 
 
The Yellow Line represents the line of central eclipse.  It shows the eclipse’s center line path over 
the globe.  Yellow Ovals at the beginning and end points of the yellow line represent the umbral 
rise and set curves 
 
The Grey Line represents the limits of the umbral shadow. 
 
The Red Lines show both the rise and set curves and the shadow limits of the penumbra (lighter 
shadow). 
 
The White Line marks the penumbral shadow on the Earth globe. 
 
These markers can be toggled on or off by using the checkboxes under Solar Eclipse Display 
Options on the lower left of the window. 
 
Once you have selected an eclipse from the list, you will notice that the Local Circumstances box 
now displays the local information regarding the eclipse, such as its local visibility, magnitude, 
start and end times, and moment of greatest eclipse.  Once an eclipse is selected, the Sky Chart 
automatically updates to display the eclipse from your selected location. 
 
Using the slider immediately below the Solar Eclipse Display Options, you can view the path of 
the eclipse in progress, ranging between its start and end points.  Simply slide it to the left to 
move toward the start point, and sliding it to the right will move toward the eclipse’s end point. 
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Note:  Another way to move time is to click Go Forward in the toolbar.  Selecting an eclipse 
automatically stops time in TheSkyX, but by restarting it, you can watch the eclipse progress in 
the viewer in real time, or at any speed you choose. 
 
Below the eclipse start/end slider is the slider marked Solar Eclipse Viewing Distance.  With the 
slider all the way to the left, the eclipse viewer is set to view the globe from a perspective of one 
Earth radius away.  Slide the slider to the right, and you will gradually increase the viewing 
distance up to 50 Earth radii.  If you have a scroll-wheel mouse, you can adjust the viewing 
distance by moving the cursor over the viewer and rolling the scroll wheel up (for closer distance) 
or down (for farther distance).  Clicking and dragging the mouse will rotate the globe, adjusting 
the angle at which the eclipse path is viewed. 
 
Note:  In case your view of the globe is cut off, this window is resizable by clicking and dragging 
on the lower right corner. 

Lunar Eclipse Viewing 

Also included in the eclipse list are lunar eclipses.  These are shown from the perspective of 
Earth’s surface in the Sky Chart.   
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Figure 80: Lunar eclipse showing the umbra and penumbra. 

 
By selecting a lunar eclipse from the list, the Sky Chart will automatically update to show the 
chosen eclipse.  Note that the Moon and penumbra and umbra of Earth’s shadow appear with 
labels.   
 
Looking at the Local Circumstances box will show the start date and time for the selected eclipse, 
as well as the maximum shadow coverage in lunar diameters.  As with solar eclipses, time is 
stopped when an eclipse is selected, but can be started again whenever you wish to view the 
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eclipse in motion.  Using this tool, you can take note of shadow contact times when preparing for 
the exciting spectacle that is a lunar eclipse. 

Spacecraft 

 
Before 1957, nothing made by human hands existed above our atmosphere.  But in that year, the 
Soviet Union launched the world’s first artificial satellite, Sputnik.  Since then, thousands of 
satellites have been launched into Earth orbit. 
 
TheSkyX downloads orbital elements or two-line elements (TLEs)  from the web to keep track of 
thousands of satellites and other orbital debris.  Using these numbers, TheSkyX can calculate 
where satellites will appear in the sky for any location on Earth.   
 
To manage which satellites are shown, click the Satellites command in the Input menu.   
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Figure 81: The Satellites window (click the Satellites command from the Input menu). 

Satellite TLE data can be imported from the web or from a text file that contains the properly 
formatted data.  TheSkyX uses orbital element information from Space Command Center’s TLEs 
to predict and display satellites’ positions.  Two-line element data must be updated frequently 
and are available for most satellites on the web.   
  
Gravitational forces, among other things, constantly perturb the orbit of a satellite around earth, 
so its position is not precisely predictable over long periods of time.  TheSkyX automatically 
updates selected TLEs for each time it is launched. 

Download Satellite TLEs from the Web (Import From Web button) 

Current satellite TLE data are retrieved from Dr. T.S. Kelso’s Celestrak web site. 
 
Clicking the Import from Web button shows the Import Satellites from Celestrak window. 
 

http://www.celestrak.com/
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Figure 82: The Import Satellites from Celestrak window. 

Turn on the desired categories, then click the Download button to retrieve them from the web.  
Importing all the satellites will most likely sap your computer’s processor, so choose wisely. 
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Import from File 

TLE data residing in a text file, rather on the web, can be imported and displayed by clicking the 
Import From File button.  The text file must contain TLE data only.  For example, the TLE data for 
the GOES 2 satellite looks like this:  

   

GOES 2  
10061U 77048A 98127.50441330 .00000045 00000-0 10000-3 0 97472 10061 13.1659 29.4732 
0005723 183.8196 16.8163 1.00281760 21356  

Status  

The Status section shows the total number of satellites that were successfully loaded, the average 
age of the TLE data (the “newer” the better) and the number of TLEs that have been rejected 
because they are older than 45 days.   
 
Use the Advanced tab on the Find window to locate a satellite. 

Show Satellites  

When this option is turned on, satellite positions are computed and displayed on the Sky Chart.   

Show Satellite Paths 

Turn on this checkbox to draw a line on the Sky Chart that represents the upcoming path that the 
satellite will follow.   

Length of Satellite Paths (Length input) 

Enter the length of time, in minutes, of the satellites’ paths. 

Fun Example: Observing the International Space Station (ISS) 

Watching the International Space Station fly overhead is a truly exciting event.  TheSkyX can be 
used to predict when the ISS will travel overhead, and show you its path. 
 
To find the best passes for the ISS, do the following. 
 

1. Click the Satellites command on the Input menu.  
2. Click the Import From The Web button. 
3. Turn on the International Space Station radio button. 
4. Click the Download button. 
5. Click the Satellites From Above Earth button on the Satellites window (lower left corner 

of the window). 
6. Select ISS (ZARYA) from the list of satellites, then click the Find Best Passes button. 

 
A list of the times when this satellite is visible above the horizon is displayed.  Double-click the 
items in the list to show the pass from an above-Earth perspective.  Turn on the Update Chart 
radio button to show the path on the Sky Chart. 
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Iridium Flares 

 
Beginning in 1998, a network of sixty-six communication satellites called Iridium was launched 
into orbit.  At any given time, at least one of them is above the horizon for any location on Earth 
(not counting the territory around the north and south poles).  Sometimes, as an Iridium satellite 
moves across the sky, sunlight bounces off its antennas and solar panels, creating a brief but 
brilliant Iridium flare.  TheSkyX can calculate when the next flare will be visible from your location 
(they only happen in early evening or shortly before dawn).  Click the Tools > Iridium Flares 
command to find the next flare that you can observe from your backyard. 
 
Choose the Iridium Flares command from the Tools menu. 
 

 

Figure 83: The Iridium Flares tab on the Satellites window (Satellites command, Tools menu). 
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Specifying the Type of Flare to Find (Search For pop-up menu) 

Flares can be located based on what time of day they occur.   
 

• Daytime Flares occur between sunrise and sunset 

• Nighttime Flares occur between sunset and sunrise 

• Dawn/Dusk Flares occur during the morning and evening hours 
 
Choose the All Flares item to search for flares that occur any time, day or night.   

Length of Time to Search (During the next) 

Enter the number of days from now to search for flare events.  Flare prediction involves some 
heavy-duty computing, so you may want to limit the length of the search to less than a week so 
on slower computers. 

Minimum Height Above the Horizon (Above altitude)  

Mountains, trees or nearby buildings can hide flares that occur at lower altitudes.  Enter the 
lowest altitude that a flare can be seen from where you will be observing. 

Limiting Magnitude of Flare (Brighter than) 

Enter the magnitude of the faintest flare you want to find.  Faint nighttime flares are easy to spot; 
but if you’re looking for a daytime or evening flare, make sure to enter magnitude minus 2 or 
brighter (the lower the magnitude, the brighter the flare). 

Show Iridium Flare Paths 

Turn on this option to show a line on the Sky Chart that shows where the flare occurs and how 
long the flare lasts. 

Set Time to Now (Computer clock) 

This button resets TheSkyX’s date and time to the computer’s clock.   

Begin Searching for Flares (Find flares) 

Click this button to begin the search for flares.  Even a very fast computer requires a minute or 
more to locate all the flares for the next month. 

Iridium Flare Report 

The right side of the window shows a report containing the following information for each flare. 

• Local time when the flare begins. 

• Coordinated Universal Time when the flare begins. 

• Maximum magnitude of the flare. 

• The altitude and azimuth position at maximum magnitude. 

• The angle, in radians, between observer’s line of sight and Sun, subtended at the 
satellite. 
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• The name of the Iridium satellite. 

• The mirror number on the satellite that is causing the flare and its angle. 

• The Julian date of the flare. 
 
Click a column header to sort the column’s contents from smallest to biggest (that is, an 
ascending sort).  Clicking a particular header more than once will invert the sort.  For example, 
clicking the Magnitude header once sorts the flares from brightest to faintest.  Clicking it twice 
sorts from faintest to brightest (a descending sort). 

Simulating the Flare (Watch flare) 

Now the fun begins.  Clicking the Watch Flare button orients the Sky Chart so that the selected 
flare is visible near the center of the window.  If no flare is selected, the first flare in the report 
will be simulated.  A green laser pointer momentarily appears, showing you exactly where to look 
to view the start of flare.  They’re really easy to miss in the actual sky. 
 
The excitement builds as the satellite’s mirror begins to reflect the Sun’s light and grow brighter 
for the next few seconds.   
 
Now that you’ve seen a simulated flare, your goal is to go outside and actually observe the real 
thing.  Take your friends or family along; after viewing the flare, they’ll think you are an 
astronomy wizard. 

Satellites from Above Earth 

 
Often people who have not studied or practiced astronomy are amazed that many satellites are 
visible to the naked eye.  Most times, satellites are observed by chance when someone looks up 
and catches a glimpse of something moving among the stars.  TheSkyX has a useful tool that aids 
with satellite observation and can tell you not only when and where to look, but also the name 
and purpose of many satellites in the sky. 
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Figure 84: The Satellites Above Earth tab (Tools > Satellites From Above Earth). 

Review: Viewing Satellites and their Orbits 

To observe satellites, select the Satellites from Above Earth command from the Input menu.  If 
this is your first time using the satellites tool, there will not be any satellites listed, and you will 
have to download some satellite Two-Line Elements (TLE’s) before any satellite data can be 
shown.  You can think of a TLE as a big set of numbers that describes a satellite’s orbit. 
 
To obtain TLE data, click the Satellites button, or select Satellites from the Input menu.  The 
Satellites window appears.  From here, you can choose to import satellite data from the web or 
an existing file.  Later, you can also choose to clear all satellite data by clicking Remove All. 
 
Note:  Ensure that TheSkyX’s date is set to within 45 days of the current date to avoid date 
rejection when downloading satellite for import. 
 
Let’s start by downloading some satellite TLEs from the web.  To do this, simply click Import From 
Web… on the Satellites window.  You can then choose the satellite category or categories you 
wish to download from the internet database, Celestrak.  After you have selected the desired 
satellite categories, click Download. 
 
Return to the Satellites From Above Earth window, and you will see the satellites plotted as 
points around the Earth globe.  Also, note that the satellites are also viewable in the Sky Chart. 
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On the Satellites From Above Earth window, a list featuring your newly downloaded satellites 
appears on the left.  By selecting a satellite(s) from this list and by clicking Show Selected Orbits.  
The satellite orbits will appear in the viewer.  Sliding the Viewing Distance slider will change the 
view from a distance of 1 Earth radius up to 50 Earth radii.  If your mouse is equipped with a scroll 
wheel, you can use it to adjust the viewing distance, too.  If need be, the lower right corner of 
the window can be dragged to resize it. 
 
By clicking Update Chart, the Sky Chart is updated to show the recent satellite data from a 
ground-based perspective.  Now you will be able to amaze your friends and neighbors with your 
uncanny ability to “predict” satellite appearances in the heavens! 

Astronomical Conjunctions 

When two or more planets appear near one another – within a few degrees or less –the objects 
are said to be in conjunction.  But don’t be fooled.  Although the objects appear close by from 
our earth-bound perspective, the two objects are still hundreds or thousands of astronomical 
units apart.  There’s no need to worry about a collision. 
 

 

Figure 85: Screen capture when a conjunction is found. 

Finding out when two or three planets will be in conjunction is easy with TheSkyX’s Conjunction 
Finder.  It can locate conjunctions between any two or three planets and/or the Sun and Moon, 
as viewed from Earth.  
 
Select the Conjunction Finder command from the Tools menu and then mark two or three objects 
in the Objects list.  Earth is listed for reference only; it cannot be selected as part of the search. 
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Click the Start button to begin the search.  TheSkyX uses the value entered in the Within (degrees) 
number input to determine how close the objects must fall before a conjunction is reported.  
Once a conjunction is found, the Sky Chart is updated to show it. 

Beyond the Backyard: Our Home Galaxy 

Our Sun is but one member of a huge assemblage of hundreds of billions of stars that comprise 
our home galaxy, the Milky Way.  Our galaxy is also peppered with vast, colorful clouds of gas 
and dust, called nebulae, and other exotic objects. 
 
The invention of the telescope revealed that there is much more in the night sky than stars and 
planets.  In the 18th century, the French astronomer Charles Messier began to catalog some of 
these mysterious objects to make sure he didn’t mistake them for new comets.  The Messier 
Catalog is still in use today.  It includes star clusters, and various kinds of nebulas and galaxies.  
These so-called “deep sky” objects are favorite viewing targets of amateur astronomers. 
  
There are literally millions of objects in the sky that astronomers want to keep track of.  Various 
catalogs have been developed for this purpose.  TheSkyX includes several of them in order to 
chart these objects on the Sky Chart. 

The Milky Way 

The ancient Greeks believed that the Milky Way was exactly that: spilled milk.  History failed to 
record whether anyone cried over it.  It wasn’t until Galileo invented the astronomical telescope 
that the true nature of the Milky Way was revealed: millions of stars too distant to be resolved 
by the naked eye.  We now know that the stars of our particular galaxy form an immense 
pinwheel shape, with several spiral arms extending out from its center.  When you look at the 
Milky Way, you’re looking at a section of one of these spiral arms (galaxies come in a variety of 
shapes and sizes, from spherical to irregular – more on this later). 
 
An unfortunate fact of modern life is that the Milky Way is too faint to be seen from within cities 
and most of their suburbs.  You need to be far from city lights and any other source of light 
pollution to appreciate how extraordinarily beautiful it is.  TheSkyX can display the Milky Way at 
various levels of brightness, simulating what you might see from the outskirts of a small town or 
an isolated mountain peak.  Astronomers have come up with the very cool-sounding term 
isophote to describe regions of equal brightness in the Milky Way. 
 
In the Display menu, the item Milky Way Options allows you to choose to display the Milky Way 
graphically, with isophotes corresponding to two levels of brightness, or as a wide-angle 
photograph of the Milky Way superimposed in the proper position on the Sky Chart.  As with 
constellation figures, you can adjust the transparency of the Milky Way to simulate how much (if 
any) of it you can see from your location. 
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Figure 86: The Milky Way Options window (Click the Milky Way Options command from the Display menu). 

Turn Milky Way On/Off (Show Milky Way) 

Show or hide the Milky Way photograph or isophote drawings by turning this checkbox on or off. 

Displaying the Milky Way (Milky Way Type) 

Choose how to show the Milky Way on the Sky Chart.   

Milky Way Photograph  

Options in this group allow you to configure how the Milky Way Photograph appears on the Sky 
Chart. 

Name of Milky Way Photograph (Name) 

A color and black and white Milky Way photos are supplied with TheSkyX.  Double-click on the 
name, or highlight it and click the Apply button to show in on the Sky Chart. 
 
Note that the Milky Way photo shown in the Photo-Like display mode only.   

Position on Galactic Equator 

The position of the Milky Way photograph with respect to the galactic equator can be configured.  
Changes to these settings are applied to the Sky Chart immediately. 
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Degrees Above Galactic Equator (Above) 

Use this slider to adjust how far above the galactic equator (in degrees) the top of the photo will 
appear. 

Degrees Below Galactic Equator (Below) 

Use this slider to adjust how far below the galactic equator (in degrees) the bottom of the photo 
will appear. 

Longitudinal Position (Longitude) 

Use this slider to adjust where the left edge of the photograph appears on the galactic equator.   

Transparency of the Photograph (Transparency) 

Use the slider to change the transparency of the Milky Way photograph.   
 
The Milky Way Photo will not appear on the Sky Chart when the Graphics Rendering Mode is set 
to No Hardware Acceleration (page 14).   

Beyond Our Galaxy 

About a hundred years ago astronomers believed that our galaxy, the Milky Way, contained 
pretty much everything in the universe.  But as telescopes became larger and more powerful, it 
became clear that there are other galaxies beyond the Milky Way – lots of them, in fact.  
According to the latest estimates, there are some fifty to one hundred billion galaxies in our 
universe comparable in size to the Milky Way. 
 
Our galaxy is also surrounded by a halo of some hundred and fifty-star clusters.  These clusters 
contain hundreds of thousands to millions of stars arranged in relatively compact, spherical 
shapes.  These globular clusters are made up mostly of ancient stars, some of them over ten 
billion years old. 
 
Just as some planets have moons, the Milky Way and many other galaxies are orbited by smaller 
“satellite” galaxies.  The Milky Way has at least two.  They were originally described by Persian 
astronomers, but today we call them the Magellanic Clouds in honor of Ferdinand Magellan, a 
16th century European explorer who observed and charted them on one of his epic voyages into 
the Southern Hemisphere.  Our galactic companions are most easily seen from that hemisphere, 
although at certain times of year they can be glimpsed from very low Northern latitudes.  They 
are beautiful objects, and to the naked eye look like small shreds of the Milky Way.  Even though 
they lie only 20 degrees apart in the sky, they are separated by 75,000 light years in space.  With 
a telescope, you can resolve some of their stars, and also see nebulae and star clusters that reside 
within them. 
 
The Milky Way is just one of billions of galaxies that populate the Universe.  Besides the 
Magellanic Clouds, only one of these other galaxies is visible to the naked eye.  It’s called the 
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Andromeda Galaxy because it lies within the boundaries of that constellation.  Every other galaxy 
requires a good pair of binoculars or a telescope to see. 
 
TheSkyX’s database includes thousands of galaxies within reach of amateur telescopes.  They can 
be displayed in the Non-stellar Objects section of the Chart Elements window. 
 
Galaxies of various shapes and sizes exist right out to the edge of observable space.  We live in a 
truly extraordinary universe.  We hope the TheSkyX will enrich and expand your appreciation of 
it. 

Have it Your Way with Preferences 

Select the Preferences command from TheSkyX menu (Mac) or click the Preferences command 
from the Edit menu (Windows) to reveal a host of options that allow you to configure the 
appearance and contents of the toolbars, what information appears on the status and report 
windows, as well as advanced options. 
 
The Preferences window shows four buttons along the top.  Click one to view the options 
associated with it. 

Toolbars 

 
The standard set of toolbars and the toolbars you create are listed on the left side of the window.  
When the check mark next to the toolbar name is on, the toolbar is visible on the main window.  
Toolbars can also be turned on and off by right-clicking (+click on the Mac) the mouse over the 
toolbar, and then selecting the desired command from the pop-up menu. 
 
Click the Customize button to configure the commands or actions that appear on each toolbar, 
or add new toolbars with the commands you want.   
 
Use the Toolbar Button Options to configure the size and appearance of the buttons on the 
toolbars. 
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Customizing Toolbars 

The default toolbars access the most commonly used commands.  You can change the buttons 
or commands that appear on these toolbars to add or remove buttons, or create custom toolbars 
with any set of commands that meet your work flow. 
 
To edit the actions on a toolbar: 
 

1. Highlight the toolbar you wish to edit from the Toolbars list, or click the New button and 
enter the name of a new toolbar. 

2. Highlight the desired action in the Actions list then click the green right-pointing arrow to 
add this action to the Current Toolbar Actions list. 

 
Once selected in the Current Toolbar Actions list, the action can be positioned on the toolbar by 
pressing the up/down arrows or removed by clicking the left arrow. 
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Figure 87: Customize Toolbars window.  Click the Preferences command from TheSkyX menu (Mac), or the Preferences 
command from the Edit menu (Windows), then click the Customize button. 

List of All Actions in TheSkyX (Actions List) 

Menu commands, windows and button actions are listed in the Actions list on the left side of the 
window.  Each action can be added to (or removed from) a standard or custom toolbar.  The 
<SEPARATOR> action places a vertical line between actions on the toolbar. 
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List of Defined Toolbars (Toolbars) 

The currently available toolbars are listed on the top right of the window.  The names of the 
standard toolbars are shown in green text and cannot be removed or renamed.  Custom toolbar 
names appear in black text. 

Actions in the Toolbar (Current Toolbar Actions List) 

The list of actions that will appear on the toolbar are shown on the bottom right of the window.  
Selecting an action allows it to be moved up or down by clicking the up/down arrow, or removed 
by clicking the left arrow.  See “Toolbar Actions” on page 204 for a description of each action. 
 
The right arrow adds the selected action to the toolbar. 

Resetting Standard Toolbars (Restore All Button) 

Click this button to restore all the toolbars with their default buttons.  

Toolbar Actions 

The Actions column of the Customize Toolbars window lists each toolbar and the toolbar’s 
default buttons.  Scroll down the list to view other actions that can be added to toolbars.   
 

Display Toolbar 
  

 

Figure 88: The default Display toolbar. 

 Action  Description 
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 Solar System Shows the Solar System window (page 
182). 

 3D Stars Shows the 3D Stars window (page 
182). 
 

 Field of View Indicators Shows the Field of View Indicators 
window (page 119). 
 

 Map Like 
 

Show the Sky Chart with a white 
background that simulates a printed 
star chart. 
 

 Photo Like 
 

Show the Sky Chart with a black 
background to simulate what a photo 
of the sky looks like. 
 

 Satellites From Above Earth 
 

Shows spacecraft orbiting the Earth 
(page 189). 
 

 Show Constellation Boundaries 
 

Turn constellation boundary lines on 
or off. 
 

 Show Daylight Turn this option on to simulate the 
morning, daytime and evening sky.   
 
When Show Daylight is turned off, the 
sky appears black to reveal stars and 
other objects, even during the day. 
 

 

When the Show Daylight 
command is turned on, the 
stars and other objects are 
filtered by magnitude so 
that they’re not visible, 
even at smaller fields of 
view.  
 
So that the simulated stars 
and other objects are 
visible during daylight 
hours, be sure to turn off 
the Show Daylight 
command.  Otherwise, you 
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might scratch your head 
thing, “What happened to 
all the objects on the Sky 
Chart?”  Blame the sun! 
 

 

 Show Ecliptic Turn on or off a line that shows the 
path of the Sun. 
 

 Show Equatorial Grid Turn on or off lines that show a grid of 
right ascension and declination 
coordinates. 
 

 Show Horizon Grid Turn on or off lines that show a grid of 
azimuth and altitude coordinates 
 

 Show Mirror Image Show the Sky Chart as it appears in a 
telescope with an odd number of 
mirrors (page 49). 
 

 Show Night Vision Mode Changes TheSkyX’s window to red to 
preserve dark adaptation (page 344) 
 

 Solar System Show or hide solar system objects. 
 

 Star Options Show the Star Options window to 
configure the appearance of stars on 
the Sky Chart (page 250). 
 

 Toggle Labels Turn the labels of objects on the Sky 
Chart on or off. 
 

Edit Toolbar 
  

 

Figure 89: The default Edit toolbar. 

 Copy Copy the current Sky Chart to the 
Clipboard as a picture. 
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 Find Locate objects in TheSkyX’s databases 
by name, catalog number or from a list 
of objects (page 59). 
 

 Paste Photo Overlays a photo from the Clipboard 
on the Sky Chart. 
 

Field of View Toolbar 
  

 

Figure 90: The default Field of View toolbar. 

 Field of View Chooser Choose the Sky Chart’s field of view 
from this list of predefined or custom 
field widths. 
 

 Zoom In Increase magnification by decreasing 
the Sky Chart’s field width.  Click and 
hold this button to zoom in 
continuously. 
 

 Zoom Out Decrease magnification by increasing 
the Sky Chart’s field width.  Click and 
hold this button to zoom out 
continuously. 
 
 

File Toolbar 
  

 

Figure 91: The default File toolbar. 

 Open Open or load a Sky Chart Settings file. 
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 Save Save the current Sky Chart Settings. 
 

Imaging System Toolbar 
  

 

Figure 92: The default Imaging System toolbar. 

 Autoguider Show the Autoguider pane (page 469). 
 

 Camera Show the Camera pane (page 455). 
 

 Dome 
 

Show the Dome pane (page 611). 

 Filter Wheel  
 

Show the Filter Wheel pane (page 
596). 

 Focuser 
 

Show the Focuser pane (page 561). 

 Rotator 
 

Show the Rotator pane (page 603). 

 Telescope 
 

Show the Telescope pane (page 342). 

 Video 
 

Show the Video pane (page 436). 

 Video (guider) 
 

Show the Autoguider pane (page 469). 

Look Toolbar 
  

 

Figure 93: The default Look toolbar. 

 Look East Look east at a 100-degree field of 
view. 
 

 Look North Look north at a 100-degree field of 
view. 
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 Look South Look south at a 100-degree field of 
view. 
 

 Look West Look west at a 100-degree field of 
view. 
 

 Look Up  Look straight up, at the zenith. 
 

Objects Toolbar 
  

 

Figure 94: The default Objects toolbar. 

 Show Clusters Show or hide star clusters. 
 

 Show Double Stars Show or hide double stars. 
 

 Show Galaxies Show or hide galaxies. 
 

 Show Nebulas Show or hide nebulas. 
 

 Show Stars Show or hide stars. 
 

 Show Variable Stars Show or hide variable stars. 
 

Orientation Toolbar 
  

 

Figure 95: The default Orientation toolbar. 

 Celestial Sphere Display the Sky Chart using an 
equatorial coordinate-based 
projection with the direction to the 
celestial pole toward the top of the 
window (page 151). 
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 Free Rotation In this projection, the Sky Chart can be 
rotated to any position angle (page 
151).   
 
This option is helpful when aligning 
photos with the simulated chart. 
 

 Rotate Tool Turn on the Rotate Tool to set the Sky 
Chart’s position angle (page 151). 
 

 Terrestrial Sphere Display the Sky Chart using a horizon-
based projection with the local zenith 
located at the top of the window (page 
150). 
 
 

Small Screen Toolbar 
 
  

 

Figure 96: The default Small Screen toolbar. 

 Abort Stops the current telescope slew (page 
393). 
 

 Connect Establishes communication between 
TheSkyX and the telescope’s controller 
(page 365).  
 

 Look East Orient the Sky Chart looking East at a 
100-degree field of view. 
 

 Look North Orient the Sky Chart looking East at a 
100-degree field of view. 
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 Look South Orient the Sky Chart looking East at a 
100-degree field of view. 
 

 Look West Orient the Sky Chart looking East at a 
100-degree field of view. 
 

 Move Down Orient the Sky Chart looking East at a 
100-degree field of view. 
 

 Move Left Adjusts the Sky Chart’s field of view to 
simulate looking to the right (page 42). 
 

 Move Right  Adjusts the Sky Chart’s field of view to 
simulate looking to the left (page 42). 
 

 Move Up Adjusts the Sky Chart’s field of view to 
simulate looking upward (page 42). 
 

 Telescope Setup Shows the Telescope Setup window 
(page 359). 
 

 Time Control Shows the date and time for the 
current Sky Chart (page 142). 
 

Telescope Toolbar 
  

 

Figure 97: The default Telescope toolbar. 

 Find Home Slews the telescope to its home 
position. 
 

 Park  Slews the telescope to the park 
position. 
 

 Slew Slews the telescope to the target 
object. 
 

Time Toolbar 
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Figure 98: The default Time toolbar. 

 Computer Clock Get the date and time from the 
computer’s clock (page 142). 
 

 Go Backward Decrement time continuously at the 
current rate or skip increment (page 
142). 
 

 Go Forward Increment time continuously at the 
current rate or skip increment (page 
144). 
 

 Set Time Flow Choose the rate or increment of time 
to advance or retreat (page 145). 
 

 Step Backward Decrement time one skip increment 
each time this button is clicked (page 
143). 
 

 Step Forward Increment time one skip increment 
each time this button is clicked (page 
144). 
 

 Stop Freeze time (page 144). 
 

 Time Controls Shows the date and time for the 
current Sky Chart (page 142). 
 

All Other Commands 

 Add Pointing Sample Adds a TPoint pointing calibration 
sample (page 395).  
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See the TPoint Add On User Guide for 
details about modeling telescopes. 
 

 Add or Edit Observation Creates or edits the observer log for 
the target object (page 296). 
 

 Add to List Add the target object to the Observing 
List.   
 
You can also press and hold the SHIFT 
key while clicking an object on the Sky 
Chart to add it to the Observing List 
(page 291). 
 

 Angular Separation & Position 
Angle 

Show the Angular Separation and 
Position Angle tool (page 152). 
 

 Binocular 50 Change the Sky Chart’s field of view to 

50. 
 

 Calibrate Photo Show the Camera Add On Calibrate 
Photo window. 
 

 Center Center the target object on the Sky 
Chart. 
 

 Center Cross Hairs Center the telescope cross hair on the 
Sky Chart (page 393). 
 

 Check for Updates Check to see if a newer version is 
available. 
 

 Clear Park Position Forgets the current telescope park 
position (page 375). 
 

 Connect Telescope Establishes a connection with the 
currently selected telescope (page 
365). 
 

 Copy Text Copies the selected text to the 
Clipboard. 
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 Cut Cuts or removes the selected text and 
places it on the Clipboard. 
 

 Disconnect Telescope Terminates the connection with the 
currently selected telescope (page 
365). 
 

 Exit/Quit Quits TheSkyX. 
 

 Finder 10 Change the Sky Chart’s field of view to 

10. 
 

 Frame Frame the current target object (page 
63). 
 

 Full Screen Show the Sky Chart using the entire 
desktop (page 56).   
 
Press the ESC key to exit Full Screen 
mode. 
 

 Highlight Center Constellation Highlights the constellation that is 
located near the center of the Sky 
Chart (page 254). 
 

 Lock On Pins a solar system target object to the 
center of the Sky Chart (page 69). 
 

 Maximum Zooms to the maximum field of view 
for the current projection. 
 

 Minimum 30" Change the Sky Chart’s field of view to 
30 arcseconds. 
 

 Move Down Adjusts the Sky Chart’s field of view to 
simulate looking downward (page 42). 
 

 Move Left Adjusts the Sky Chart’s field of view to 
simulate looking to the right (page 42). 
 

 Move Right Adjusts the Sky Chart’s field of view to 
simulate looking to the left (page 42). 
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 Move Up Adjusts the Sky Chart’s field of view to 
simulate looking upward (page 42). 
 

 Naked Eye 100 Change the Sky Chart’s field of view to 

100. 
 

 New Restores the chart settings to default 
values (page 57). 
 

 Next Show the next photo of the object 
(page 64). 
 

 Night Vision Setup Configure screen to preserve dark 
adaptation (page 344). 

 Overlay DSS Photo Show a Digitized Sky Survey Photo on 
the Sky Chart (page 103). 
 

 Point to Target Show a green laser pointer directed at 
the current target object. 
 

 Previous Show the next photo of the object 
(page 64). 
 

 Print Info Print information about the target 
object. 
 

 Push Scope To Show on-screen graphics that help find 
objects when using a hand-controlled 
or push to telescope (page 357). 
 

 Remove DSS Photos Hide and remove Digitized Sky Survey 
Photos from the Sky Chart (page 103). 
 

 Remove Satellites Remove satellite two-line elements 
from Sky Chart and from auto-
download list (page 248). 
 

 Reset Chart to Defaults Restore the chart settings to default 
values (page 57). 
 

 Rotate Clockwise Rotate the Sky Chart counterclockwise. 
 

 Rotate Counterclockwise Rotate the Sky Chart clockwise. 
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 Save As Save the chart settings with a specific 
file name. 
 

 Set Park Position Save the current position of the 
telescope as the park position (page 
375). 
 

 Set Track Rates Set the telescope’s tracking rates to 
match the target object (page 394). 
 

 Show Milky Way Show the Milky Way Galaxy on the Sky 
Chart. 
 

 Show Photo+ Show a photo or H-R diagram for the 
target object (page 64). 
 

 Show in Constellation Adjusts the field of view to the 
approximate size of the constellation 
surrounding the target object and 
points the green laser pointer at the 
object. 
 

 Sleep Minimizes CPU usage by halting all 
real-time computations. 
 

 Slew Prior Slew the telescope to the last target 
object, if one is available (page 382). 
 

 Star Brightness Down Decrease star brightness. 
 

 Star Brightness Up Increase star brightness. 
 

 Star Contrast Down Decrease the contrast between 
brighter and fainter stars. 
 

 Star Contrast Up Increase the contrast between brighter 
and fainter stars. 
 

 Suspend Connection Temporarily stop sending command 
to, and receiving commands from, the 
mount or telescope. 
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 Sync Synchronize the telescope’s position 
using the coordinates of the target star 
(page 366). 
 

 TPoint Add On User Guide View the TPoint Add On User Guide in 
PDF format. 
 

 Telescope 1 Change the Sky Chart’s field of view to 

1.  
 

 TheSkyX Help View documentation (page 32). 
 

 TheSkyX User Guide View the TheSkyX Professional and 
Serious Astronomer Edition User Guide 
in PDF format. 
 

 Toggle Linked Photo Show or hide the Image Link photo 
(page 312). 
 

 Track Satellite If the target object is a spacecraft, 
show the Satellite tracking window 
(page 388). 
 

 Turn Sidereal Tracking On Set the mount’s tracking rate to the 
sidereal rate. 
 

 Turn Tracking Off Set the mount’s tracking rate to zero. 
 

 Unpark Unpark the mount at the start of the 
observing session. 
 

 View From Lock on the target planet, comet or 
asteroid in the 3D Solar System View 
(page 182). 
 

 What’s Up? Show a report of interesting objects 
that are visible tonight (page 119). 
 

 Wide Field 180 Change the Sky Chart’s field of view to 

180. 
 

 Zoom In Decrease the Sky Chart’s field of view. 
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 Zoom Out Decrease the Sky Chart’s field of view. 
 

 Zoom Tool Show the Zoom Tool on the Sky Chart 
(page 40). 

Other Windows 

 About TheSkyX Show TheSkyX’s About window to 
reveal the software version, Edition 
and copyright information. 
 

 Auto Pointing Calibration Show the TPoint Add On Auto Pointing 
Calibration window.  See the TPoint 
Add On User Guide for details. 
 

 
Bisque TCS Show the Bisque TCS window.  See the 

Paramount MX User Guide for details. 
 

 Calendar Show the Calendar window showing 
the phase of the moon, rise and set 
times of the sun and moon and other 
events. 
 

 Calibration Show the TPoint Add On Calibration 
window for collecting pointing 
samples.  See the TPoint Add On User 
Guide for details. 
 

 Chart Elements Show the Chart Elements window 
(page 49). 
 

 Conjunction Finder Find astronomical conjunctions (page 
197). 
 

 Constellation & Asterism Options Show options for displaying 
constellations and asterisms. 
 

 Create Sky Database Create an auxiliary database from any 
ASCII text data. 
 

 
Create Tour  Create an astronomical tour (page 91). 

 

 Database Manager Manage TheSkyX’s databases (page 
268). 

 Date and Time  
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 Digital Setting Circles  

 Digitized Sky Survey  

 Edit Chart Elements  

 Export Chart  

 Horizon & Atmosphere Options  

 
Image Link Overlay FITS photos to match 

cataloged stars and determine the 
astrometric solution (page 312.) 

 Imaging System Setup Configure your imaging hardware. 

 Iridium Flares  

 Labels  

 Location  

 Manage Observing List  

 Milky Way Options  

 Moon Photo Viewer  

 Mosaic Grid  

 My Chart Elements  

 Navigate  

 Non-Stellar Object Options  

 Object Paths  

 Observing List  

 
Open FITS  

 
Place Photo  

 Preferences  

 Print Setup  

 Print  

 Projections  

 Reference Lines & Photos  

 Reports  

 Run Java Script  

 SGT Align  

 Satellites  

 Show DSS FITS Photo  

 Slide Show  

 Small Solar System Bodies  

 Solar and Lunar Eclipse Viewer  

 Star Search  

 Star Synchronization  

 TCP Server  

 TPoint Add On  

 Telescope Limits  
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 Telescope Window  

 
Tours  

 Track Satellite Window  

 Verify TheSkyX Time  

My Chart Elements 

 Add Area of Interest  

 Add Arrow  

 Add Chart Scale  

 Add Ellipse  

 Add Graphic  

 Add Label  

 Add Lines  

 Add Object  

 Add Object Label  

 Add Polygons  

 Add Telrad™  

Status Windows 

TheSkyX offers three different status windows that can be configured to show information about 
the current time, telescope position, and other report attributes.   

Chart Status 

 
The Chart Status window (Display > Chart Status) provides helpful information about the sky 
chart.  By default, the current location, date and time are shown, but up to 21 chart status 
attributes be added.   
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Figure 99: Chart Status window (Display > Chart Status). 

To change the contents of the Chart Status report, select the Preferences command from TheSkyX 
menu on the Mac (Edit > Preferences on Windows) then click the Status Windows icon.  In the 
Status Window list, select Sky Chart Status.   
 
Highlight the items in the Attribute List that interest you, then click the right-arrow button. 
 
Note that double-clicking the left side of the Sky Chart Status report shows the Sky Chart Status 
report options on the Preferences window.  Double-clicking the right side of the report shows 
the attribute-specific window.  For example, double-clicking on the Location text reveals the 
Location window. 

Digital Setting Circles and Status Bar 

The contents of the report that appears on the Digital Settings Circles window (page 397) and the 
Status Bar window can be configured identically as the Chart Status window.  Just make sure to 
select the appropriate option on the Status Window list. 
 

 

Figure 100: A Status Bar can be shown at the bottom of Sky Chart. 
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Report Setup 

 
 
The object-specific properties (for example, an object’s magnitude, or the spectral class of stars 
or the Moon’s ecliptic longitude), that appear in the Object Information Report and Tool Tips 
Report is configurable to your needs.  
 

• The Object Information Report appears on the Edit > Find window.  

• The Tool Tips Report is the small window that appears when you place the mouse over 
an object on the Sky Chart. 

 

 

Figure 101: Tool tip on the Sky Chart. 
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Date & Time Control 

The format of the date and time displayed in the Date & Time control (page 140) can be 
configured to meet your requirements.   
 

 

Figure 102: Date & Time Control options on the Preferences window. 

To open the Date & Time Control window select the Preferences command from TheSkyX menu 
(or Edit > Preferences in Windows) then click the Date & Time Control icon.   
 
In concept, formatting the date and time is simple.  On the Date & Time Format text box, just 
type the format of the date and time that you want, or select one of the predefined formats from 
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the drop-down list.  However, please take a moment to carefully read the text on this window.  
It should be self-explanatory, but this seemingly simple option is extremely flexible, and it might 
take you a few tries to get the format just the way you want it. 

Date & Time Format Configuration  

The allowable date and time format abbreviations in the Date and Time format text are shown 
in the table below. 
 

Abbreviation Explanation 

AP Shows AM or PM in capital letters.  Omitting the AP from the format 
will the time using a 24-hour time, or “military time” instead of the 
standard time format. 
 

Ap Shows am or pm in lower case letters.  Omitting the Ap abbreviation 
from the format will the time using a 24-hour time, or “military time” 
instead of the standard time format. 
 

d A single lower-case d shows the day as a number from 1 to 31. 
 

dd The lower-case letter ‘d’, repeated twice, shows the day as number 
with a leading zero (01 to 31). 
 

ddd The lower-case letter ‘d’, three times in succession, indicates the 
abbreviated name of the day should be displayed.  For example, dd 
shows the text Fri. 
 

dddd The lower-case letter ‘d’, four times in succession, indicates the 
complete name of the current day should be displayed.  For example, 
entering dddd shows the day of the week, such as Friday. 
 

h A single lower-case ‘h’ shows the hour without a leading zero.  For 
example, 1 a.m. is shown as 1. 
 

hh The lower-case letter ‘h’, repeated twice, shows the hour with a leading 
zero when appropriate.  For example, 1 a.m. is shown as 01. 
 

M A single upper-case letter ‘M’ shows the month as a number between 
1 and 12.   
 

m A single lower-case letter ‘m’ shows the minutes without a leading zero 
when appropriate.  For example, 5 minutes after the hour is shown as 
5. 
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Abbreviation Explanation 

mm The lower-case letter ‘m’, repeated twice, shows the minutes with a 
leading zero.  For example, 5 minutes after the hour is shown as 05. 
 

MM The upper-case letter ‘M’, repeated twice, indicate the abbreviated 
name of the current month should be displayed.  For example, MM 
shows Jan for January. 
 

MMM The upper-case letter ‘M’, three times in succession, shows the 
abbreviated localized month name (for example, 'Jan' to 'Dec' for 
English). 
 

MMMM The upper-case letter ‘M’, four times in succession, shows the 
complete name of the current month should be displayed.  For 
example, MMMM shows January. 
 

s A single lower-case letter ‘s’ shows the seconds without a leading zero 
when appropriate.  For example, 5 seconds after the minute is shown 
as 5. 
 

ss The lower-case ‘s’, repeated twice, shows the seconds with a leading 
zero.  For example, 5 seconds after the minute is shown as 05. 
 

yy The lower-case letter ‘y’, repeated twice, shows the decade and year.  
For example, yy shows 15. 
 

yyyy The lower-case letter ‘y’, repeated twice, shows the year using four 
digits.  For example, yyyy shows 2018. 

Advanced Preferences 
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Click the Advanced icon to show the application-wide options that normally do not need to be 
modified.  We recommend leaving the options alone unless you are an advanced user, or you’ve 
contacted technical support and have been instructed to alter one or more settings. 
 
The exceptions to this rule are: 
 

• Turning on/off the chart scroll bars 

• Showing the target frame rate (the frequency at which the Sky Chart is updated) 

• Turning on/off the status bar 

• Setting the Target Frame Rate (to conserve power on battery operated computers) 

• Turning on/off the zoom tool 

• Playing the startup sound 

• Showing the splash screen at startup 
 
The table below describes the advanced preferences. 
 

Option Description 

Registration 
 

Name Shows the user’s name that was entered when TheSkyX was first 
launched.  This name is not, necessarily, your Software Bisque 
account sign in name.  
 

TheSkyX Serial Number Shows the serial number that was entered when TheSkyX was first 
launched. 
 
The serial number is stored in the appsettings.ini text file located in 
the “Application Support Files” folder (page 26).  
 

TPoint Add On Serial 
Number 

Shows the serial number that was entered for the TPoint Add On. 
 
The serial number is stored in the appsettings.ini text file located in 
the “Application Support Files” folder (page 26).  
 

Dome Add On Serial 
Number 

Shows the serial number that was entered for the Dome Add On. 
 
The serial number is stored in the appsettings.ini text file located in 
the “Application Support Files” folder (page 26).  
 

Edition Lists the current Edition of TheSkyX that is installed.  
 

Sky Chart 
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Option Description 

Graphics Rendering Mode 
(Restart Required) 

Select the graphics rendering mode used by TheSkyX.  See “Hardware 
Acceleration” on page Error! Bookmark not defined. and “Running 
TheSkyX without  Acceleration” on page 14 for a complete discussion 
on this setting. 
 
Automatic determines whether or not hardware acceleration is 
available and sets the rendering mode accordingly. 
Hardware Acceleration forces TheSkyX to use hardware acceleration. 
No Hardware Acceleration forces TheSkyX to use non-hardware 
accelerated graphics. 
 
The default setting is Automatic.  
 
TheSkyX must be restarted for changes to this option to take effect. 
 

FOV Mask Transparency Set the transparency (a value between 0 and 255) for a field of view 
indicator’s “masked” region (page 122).  
 
The default value is 0.00. 
Maximum value = 255.0. 
Minimum value = 0.0. 
 
 

Automatically Save Chart 
Settings Upon Exit 

Turn this checkbox on so that TheSkyX’s settings are automatically 
saved each time the application is closed.  
 
The default setting is True. 
 

Prompt to Save Modified 
Chart Settings 

Turn this checkbox on to be prompted to save changes when TheSkyX 
is closed.  
 
The default setting is False. 
 

Auto Update Satellite TLEs 
Older Than (Hours) 

Enter the number of hours that must pass before satellite TLEs are 
considered “out of date.”  TLEs older than this value are automatically 
updated from the web when TheSkyX is launched.  
 
The default value is 20 hours. 
Maximum value = 1200. 
Minimum value = 1.0. 
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Option Description 

Zoom In/Out Percentage Enter the relative amount of change to the field of view of the Sky 
Chart when zooming in or out, as a percentage of the current field of 
view.  
 
The default value is 3.00. 
Maximum value = 100.0. 
Minimum value = 0.0. 
 

Move 
Left/Right/Up/Down 
Percentage 

Enter the relative amount of change in the position of the center of 
the screen while scrolling left, right, up, as a percentage of the 
current field of view.  
 
The default value is 2.50. 
Maximum value = 100.0. 
Minimum value = 0.0. 
 

Fade Transition Time Enter the length of time, in seconds, to transition or fade between 
Sky Charts when the position of the chart is changing.  
 
The default value is 0.35 seconds. 
Maximum value = 3.0. 
Minimum value = 0.0. 
 

Show Frame Rate Show the frequency, in frames per second, at which the Sky Chart is 
updated.  This value appears on the bottom left of the Sky Chart.  
 
Default value is False. 
 

Target Frame Rate Specify the “steady state” frame rate frequency at which to update 
the Sky Chart.  The higher the frame rate, the more CPU and GPU 
processor cycles required to display the Sky Chart.  
 
The default value is 30 frames per second. 
Maximum value = 200. 
Minimum value = 0. 
 

Show Chart Scroll Bars Show or hide scroll bars on the Sky Chart.  
 
The default setting is False. 
 

Show Status Bar Show or hide a small window on the bottom of the Sky Chart that 
provides Sky Chart status.  
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Option Description 

 
The default setting is False. 
 

Show Zoom Tool Show or hide the Sky Chart Zoom Tool (page 40) on the upper left 
side of the Sky Chart to adjust the chart’s field of view.  
 
The default setting is True. 
 

Copy Sample Files to 
Application Support Folder 

Turn this checkbox on to copy all user-configurable files to the 
“Application Support Files” folder (page 26) when the application is 
launched.  
 
The default value is True. 
 

Play Startup Sound Play TheSkyX’s introduction “jingle” each time the application 
launched.  
 
The default setting is True. 
 

Show Startup Splash 
Screen 

Shows an introduction graphic and status messages while TheSkyX is 
being initialized.  
 
The default setting is True. 
 

Bad Pointing Sample 
Criterion (Degrees) 

When a calibration point is added during a TPoint Add On pointing 
calibration run, the Bad Pointing Sample Criterion specifies the 
maximum angular separation allowed between the telescope’s 
position and the actual coordinates of the calibration point.  If the 
angular separation between the equatorial coordinates (RA/Dec) of 
the calibration point and the telescope’s position exceeds this value, 
an error message is displayed, and the point is not added to the 
calibration data.  
 
The default value is 0.50 degrees. 
Maximum value = 50.0. 
Minimum value = 0.0. 
 

Sleep on Minimize 
(Windows Only) 

Turn this checkbox on so that TheSkyX will not perform any 
operations might affect the CPU usage, including screen updates, 
downloads, etc.  
 

• This option applies to the Windows operating system only.   
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Option Description 

• The default setting is True. 
 

Legacy, External Pulse 
Focuser Control Small Size 

This deprecated setting is used for pulse focuser control during 
CCDSoft @Focus automated focusing.  
 
The default value is 50. 
Maximum value = 0. 
Minimum value = 5000. 
 

Legacy, External Pulse 
Focuser Control Large Size 

This deprecated setting is used for pulse focuser control during 
CCDSoft @Focus automated focusing.  
 
The default value is 1000. 
Maximum value = 0. 
Minimum value = 5000. 
 

Maximum Objects in 
Observing List (Restart 
Required) 

For a given database query, enter the maximum number of objects 
that can appear in the Observing List at one time.  
 
The default value is 2000 objects. 
Upper limit = 20,000. 
Lower limit = 100. 
 
TheSkyX must be restarted for changes to this option to take effect. 
 

Log ccdsoftCamera and 
sky6RASCOMTele 
Methods 

Turn this checkbox on to create a log file named LogISN.txt (where 
“N” is the current imaging system, starting at 0) of the ccdsoftCamera 
and sky6RASCOMTele methods that have been called via TheSkyX’s 
automation model (page 657).  
 

Black Box Recorder 
(Windows OS Only; 
Restart Required) 
 

TheSkyX can optionally record, and optionally transmit Windows 
crash log reports to Software Bisque.  This information in crash log 
reports can help find the cause of the crash more quickly and 
enabling this feature will not affect the software’s performance.   
 

• The default setting is Off 

• Choose the Save to Disk option to save crash log reports in the 
folder named Black Box Recorder Data of the Application Support 
Files folder (page 26).  Please attach this report in an email to 
ForumsAdmin@bisque.com  

• Choose the Send to Software Bisque to automatically upload 
crash log reports to a Software Bisque server when crashes occur. 

mailto:ForumsAdmin@bisque.com
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Option Description 

• This option applies to the Windows operating system only. 

• TheSkyX Professional Edition must be restarted before this option 
takes effect. 

 

TCP Responses Close 
Socket 

Always close the TCP socket when TheSkyX receives a response. 

Accurate Polar Alignment 
Auto Finishes In-Progress 
Pointing Runs 
 

If a TPoint session has not been finished, performing an Accurate Polar 
Alignment (see the TPoint Add On User Guide for details) finishes the 
TPoint session which prevents additional pointing calibration samples. 
 
The default value is False. 
 

Enable Dark Theme 
 

When this checkbox is turned on and TheSkyX is restarted, windows 
and other elements use a dark gray background color as opposed to a 
light-gray color. 
 
The default value is True. 
 

Minor Planet Center URLs  
 

Observable Comets The web address (or URL) for retrieving the list of observable comets 
from the Minor Planet Center.  
 
Default URL: 
http://www.minorplanetcenter.net/iau/Ephemerides/Comets/Soft06
Cmt.txt  
 

Comets and Asteroids By 
Name 

The web address (or URL) for retrieving the list of comets and 
asteroids by name from the Minor Planet Center.  
 
Default URL: 
http://scully.cfa.harvard.edu/cgi-bin/mpeph2.cgi  
 

Distant Asteroids  The web address (or URL) for retrieving the list of distant asteroids 
from the Minor Planet Center.  
 
Default URL: 
http://www.minorplanetcenter.net/iau/Ephemerides/Distant/Soft06
Distant.txt  
 

Critical Asteroids The web address (or URL) for retrieving the list of critical asteroids 
from the Minor Planet Center.  

http://www.minorplanetcenter.net/iau/Ephemerides/Comets/Soft06Cmt.txt
http://www.minorplanetcenter.net/iau/Ephemerides/Comets/Soft06Cmt.txt
http://scully.cfa.harvard.edu/cgi-bin/mpeph2.cgi
http://www.minorplanetcenter.net/iau/Ephemerides/Distant/Soft06Distant.txt
http://www.minorplanetcenter.net/iau/Ephemerides/Distant/Soft06Distant.txt
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Option Description 

 
Default URL: 
http://www.minorplanetcenter.net/iau/Ephemerides/CritList/Soft06
CritList.txt 
 

Unusual Asteroids The web address (or URL) for retrieving the list of unusual asteroids 
from the Minor Planet Center.  
 
Default URL: 
http://www.minorplanetcenter.net/iau/Ephemerides/Unusual/Soft0
6Unusual.txt 
 

Bright Asteroids at 
Opposition 

The web address (or URL) for retrieving the list of bright asteroids at 
opposition from the Minor Planet Center.  
 
Default URL: 
http://www.minorplanetcenter.net/iau/Ephemerides/Bright/2011/So
ft06Bright.txt 
 

Theater Screens (TheSkyX Theater Edition only)  
 

Screen Number for 
Theater Controls 

Enter the screen number of the multiple screen display that shows 
the Theater Edition control center. 
 
The default value is 0. 
 

Screen Number for 
Theater Graphical Chart 
 

Enter the screen number of the multiple screen display that shows 
the Theater Edition’s Sky Chart. 
 
The default value is 1. 
 

Satellite Tracking 
 

Maximum Declination 
(Degrees) 

Enter the highest permissible declination to track a satellite.  Tracking 
is stopped automatically when the declination of the satellite exceeds 
this value.  
 
The default value is 85 degrees. 
Maximum value = 0. 
Minimum value = 90. 
 

http://www.minorplanetcenter.net/iau/Ephemerides/CritList/Soft06CritList.txt
http://www.minorplanetcenter.net/iau/Ephemerides/CritList/Soft06CritList.txt
http://www.minorplanetcenter.net/iau/Ephemerides/Unusual/Soft06Unusual.txt
http://www.minorplanetcenter.net/iau/Ephemerides/Unusual/Soft06Unusual.txt
http://www.minorplanetcenter.net/iau/Ephemerides/Bright/2011/Soft06Bright.txt
http://www.minorplanetcenter.net/iau/Ephemerides/Bright/2011/Soft06Bright.txt
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Option Description 

Lost Track Factor (of Track 
Box) 
 

This value represents the maximum allowable average tracking error 
(as a percentage of the size of the current tracking box size) for the 
“state”" of the mount to be considered “tracking”.  When the average 
tracking error exceeds this value, tracking is automatically stopped.  
 
The default value is 9. 
Maximum value = 0. 
Minimum value = 10. 
 

Minimum Altitude 
(Degrees) 

Enter the lowest permissible altitude to track a satellite.  Tracking will 
not begin until the altitude of the satellite reaches this value, 
likewise, tracking is stopped when the altitude of the satellite falls 
below this value.  
 
The default value is 5 degrees. 
Minimum value = 0. 
Maximum value = 89. 
 
 

Track Box Size 
(Arcminutes) 
 

Sets the size of the satellite track box, in arcminutes (page 392).  

Offset Bump Size 
(Arcseconds) 

Displays the amount of adjustment or “bump size”, in arcseconds, to 
move the telescope when the bump up, down, left, right buttons are 
clicked.  This option is available in the Advanced Satellite Tracking 
Add On only.  
 

Camera (Camera Add On Only) 
 

Record Autoguider Graph 
History (Minutes) 
 

Enter the number of minutes of historical autoguiding data to graph. 

Advanced Camera User 
Interface (Restart 
Required) 

Turn this checkbox on and restart TheSkyX Professional Edition to 
allow autoguiding with the imaging camera, and imaging with the 
autoguiding camera in the Camera Add On.  This checkbox is turned 
off by default.  
 

Separate Interface for 
Autoguider’s Devices 
(Restart Required) 

Turn this checkbox on and restart TheSkyX Professional Edition if the 
imaging system’s autoguider uses a different focuser, filter wheel, or 
rotator than the imaging detector so that each device can be 
operated independent of the imager’s hardware.  
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Option Description 

Camera Warm Up/Cool 
Down Time Out (mins) 

Enter the number of minutes to allow the camera to cool to the 
temperature set point, or warm up, before issuing a communication 
time out error. 

Camera Connect 
Automatically Connects 
the Filter Wheel 
 

When this checkbox is turned on, connecting to the camera 
automatically connects to the selected filter wheel. 

Camera Connect 
Automatically Connects 
the Focuser 
 

When this checkbox is turned on, connecting to the camera 
automatically connects to the selected focuser. 

Camera Connect 
Automatically Connects 
the Rotator 
 

When this checkbox is turned on, connecting to the camera 
automatically connects to the selected rotator. 

Camera Disconnect 
Automatically Disconnects 
the Filter Wheel 
 

When this checkbox is turned on, disconnecting from the camera 
automatically disconnect the selected filter wheel. 

Camera Disconnect 
Automatically Disconnects 
the Focuser 
 

When this checkbox is turned on, disconnecting from the camera 
automatically disconnect the selected focuser. 

Camera Disconnect 
Automatically Disconnects 
the Rotator 
 

When this checkbox is turned on, disconnecting from the camera 
automatically disconnect the selected rotator. 

Mirror Cover Open/Close 
Timeout (secs) 
 

Enter the number of seconds to wait for the mirror covers to open or 
close before issuing a communication time out error. 

TCP Responses Close 
Socket 
 

Turn this checkbox on to force the Camera Add On to close open 
sockets when a TCP response is received by the client. 

All Sky Image Link Crop Settings  

 
 

Large photos generally have a large number of stars (light sources) and require more CPU cycles to 
process, which slows the All Sky Image Link process.  Rather than use the entire photo for an Image 
Link, cropping and using the central portion can significantly decrease All Sky Image Link solution 
times.  Once an All Sky Image Link is located for the cropped region, the original photo can be 
restored and displayed on the Sky Chart.   
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Option Description 

The options below let you specify the height and width of the photo that will trigger this “behind 
the scenes” All Sky Image Link optimization process.   
 

 

Photos are cropped when the Blind All Sky Image Link option is selected (page 334).  
All other options use the photo’s full frame. 

  
 

When the Height or Width 
of the Photo is Greater 
than (Pixels) 

Photographs that have a height or width greater than this value will 
be automatically cropped (by the amount specified immediately 
below) when performing All Sky Image Links.   
 

Use a Portion of the Photo 
by Cropping Dimensions 
(Percentage) 

Enter the size of the cropped photo, as a percentage of the original 
size, to use for the All Sky Image Link.   
 
For example, for a 2400 x 2400-pixel photo, entering 25 means that 
the height and width of the photo used as the source for the All Sky 
Image Link will be 600 x 600 pixels, and is cropped from the center of 
the original photo. 
 

 

Figure 103: The cropped region is 16 times smaller than the original 
photo. 
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Customizing Chart Elements 

There are over ninety different chart elements that can be displayed in the TheSkyX.  The universe 
is made up of vast emptiness, punctuated by an infinite variety of objects with an infinite variety 
of form.  From stars, nebulae, and galaxies, to ecliptic lines, coordinate grids, and reference lines, 
they are all here.  What follows is an introduction to each chart element.  To toggle any chart 
element on or off in the Sky Chart, simply check the box next to its name in the window. 

Editing Chart Element Attributes 

 
Before we continue to discuss chart elements, it would be prudent to say a word about their 
customizability.  The attributes of most Chart Elements are configurable, giving you the ultimate 
flexibility in customizing the Sky Chart.   
 
Items such as the color, transparency and graphic used to display an object, the font style for 
chart labels, the thickness, color and type of reference lines are all editable.   
 
Simply double-click on any object in the Chart Elements tab, and the Edit Chart Element 
Attributes window opens.  Here, you can change fonts, line attributes, object fill color, and 
symbol options.  Also, for objects that have them, you can adjust the magnitude limits, and 
angular size limits by selecting the appropriate tab in the same window.  Experimentation is 
perhaps the best teacher when exploring the customizable item attributes for chart elements. 
 

 

Not every attribute of every chart element is editable, as many are not applicable.  
Controls to select these attributes are disabled. 
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Figure 104: Properties tab on the Edit Chart Element Attributes for the Galactic Equator. 

In Figure 104, the Properties tab for the Galactic Equator chart element is shown.  Notice that 
the Fill Color and Symbol buttons are grayed because the galactic equator chart element is a line 
and therefore does not have an associated fill color or symbol. 
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Figure 105: Properties tab on the Edit Chart Element Attributes when more than one element is highlighted. 

The Edit Chart Elements window can be used to set the magnitude limits, angular size limits and 
properties of multiple object types, too.  For example, on the Chart Elements window, highlight 
the Galaxies text under the Non-Stellar Objects node of the Celestial Objects group and then 
click the Edit Attributes button. 
 
The Selected Chart Element text shows that seven different chart elements (that is, all the 
different classifications of galaxies) have been selected.  Any attribute changes will now be 
applied to each object type.   
 
As another example, you could limit magnitude of every object on the Sky Chart to only those 
between magnitude 8 and 10 by selecting the Celestial Objects group, then setting the Hide 
Fainter Than number input to 10 and the Hide Brighter Than to 8.  
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Editing Attributes by Right Clicking 

The attributes of a chart element can also be edited by right-clicking the mouse (+click on the 
Mac) over the element on the Sky Chart, and then clicking the Edit <Chart Element> Attributes 
where <Chart Element> is the element beneath the cursor. 
 

 

 

Figure 106: Right-clicking on a constellation line shows a context pop-up menu. 

Celestial Objects 

Here, you will find all the real objects of the universe that are included in TheSkyX’s database. 

Non-stellar Objects 

Celestial objects other than individual stars and the objects of our solar system, such as galaxies, 
nebulae, and star clusters, can be found under the heading Non-Stellar Objects. 

Galaxies 

Galaxies, sometimes called “island universes,” are the largest building blocks of the observable 
universe.  Galaxies are classified according to their shape.  You can choose among galaxy types 
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that you wish to display in the Sky Chart.  You can choose to show Type C, elliptical, lenticular, 
spiral, and irregular galaxies, as well as galaxy clusters.  Under Non-Stellar Objects > Galaxies, 
the list of checkboxes will allow you to toggle on or off galaxies based upon their type.  Notice 
that there are several different graphical points indicating galaxy type; these allow for quick 
identification in the Sky Chart. 

Nebulas 

 
There are many kinds of clouds of gas and dust in the sky, such a cloud is known as a nebula.  
Each of the different kinds of nebulae can be selected for display in the Sky Chart. 

Bright Nebula 

Bright nebulae are nebulae that emit or reflect light visible to the naked eye and appear as 
glowing clouds in the night sky.  In some bright nebulae, called emission nebulae, the radiation 
from nearby stars ionizes the gas in these nebulae, and causes it to glow.  A well-known emission 
nebula is the Orion Nebula in the sword of Orion, the Hunter.  In still others, the light from stars 
bounces off dust particles in the nebula, thereby illuminating it; these nebulae as known as 
reflection nebulae.  A famous reflection nebula is that around the Pleiades. 

Dark Nebula 

Not all nebulae emit light.  Sometimes they are dark and are only visible by being amongst or in 
front of regions of ionized gas (bright nebulae).  A famous dark nebula is the Horsehead Nebula, 
also known as Barnard 33, in the constellation of Orion, the Hunter.  A dark nebula is a region of 
cold, dense dust and gas.  They are so dense as to block the light from background stars or from 
a nearby emission nebula.  Star formation occurs within the dark nebulae, but such formation 
has not yet reached a level great enough for nebular ionization to occur.  The Great Rift of the 
Milky Way is a dark nebula that is visible to the naked eye from a dark sky site. 

Planetary Nebula 

Planetary nebulae are special kinds of nebulae occurring near a dying star or white dwarf.  When 
stars about the eight times the mass of our Sun or smaller begin to decline, they swell and 
contract, throwing off the outer layers in the process, and eventually leaving a white dwarf at the 
center.  The white dwarf’s radiation causes the cloud of gas to glow.  These objects are called 
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planetary nebulae because they looked like planets in the telescopes of astronomers during the 
18th and 19th centuries.  They do not have anything to do with the planets of our solar system, 
though.  They are all quite far away.  An interesting fact is that our Sun will end up as a planetary 
nebula in some 5 billion years from now. 

Star Clusters 

 
Visible in the sky are several clusters of stars.  These are stars which formed together in the same 
region of space at about the same time.  Star Clusters come in two varieties, open and globular. 

Open Clusters 

An open star cluster is a group of a few hundred stars up to a few thousand stars.  These stars all 
formed from the same nebula, or cloud of gas and dust.  These stars still interact with each other 
gravitationally, albeit loosely.  Some open clusters, such as the Pleiades, in Taurus, the Bull, are 
still surrounded by remnants of the cloud from which the component stars formed.  Others, such 
as the Hyades, also in Taurus, do not reveal distinct nebulosity. 

Globular Clusters 

Globular clusters are ancient, high density clusters of stars existing beyond the plane of the Milky 
Way or other galaxies.  They are so-called because they look like globes in the sky.  Some people 
have described them as looking, in telescopes, very much like salt spilled onto a black table cloth.  
These clusters orbit the galactic core in the region beyond the disk, known as the halo.  Globulars 
are composed of old stars, and are remarkably free of gas and dust, presumably because that 
material was long ago turned into stars.  Some globulars are visible to the naked eye, such as 
Omega Centauri and M13 in Hercules, though M13 requires very dark skies and good vision. 

Cluster + Nebulosity 

Some clusters contain nebulosity, either reflection nebulae caused by light from the component 
stars bouncing off of dust and gas surrounding them, or emission nebulae, which glow due to 
ionization of the cloud by the component stars’ radiation.  Use this item to toggle such clusters 
on or off. 
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Other Sources 

Quasar 

Quasars, quasi-stellar radio sources, are among the oldest known objects in the universe.  They 
are all very far away, lying hundreds of millions or even billions of light years away from Earth.  
The first quasars were discovered in the late 1950’s by radio astronomers.  For years, the debate 
raged as to their nature.  Today, it is believed that they are supermassive black holes.  
Tremendous energy emits from such a black hole region rising from the tremendous turmoil of 
the material orbiting and flowing into the black hole, in what is known as the accretion disk.  It is 
possible that such objects are the precursors to modern galaxies, and would therefore account 
for the presence of the supermassive black holes found at many galactic cores. 

X-ray Source 

Many high-energy objects in the universe emit x-rays, such as stars, nebulae, and galaxies.  
Unusually strong x-ray emissions indicate a very high energy situation, such as a black hole’s 
accretion disk.  In fact, it was by observing strong x-ray sources, such as Cygnus X-1, that black 
holes were eventually brought from the realm of the theoretical to that of the real.  Other 
powerful x-ray sources include quasars, certain double stars, such as those with a neutron star 
or white dwarf component, and some galaxy clusters. 

Radio Source 

Some objects emit large quantities of radio waves, these are known as radio sources.  Pulsars 
(short for pulsating star) are perhaps the most well-known examples of astronomical radio 
sources.  Pulsars are rapidly rotating neutron stars with a beam of radio radiation that sweeps by 
Earth like the beam from a lighthouse.  The result is a pulsing radio signal detectable in radio 
telescopes.  The first pulsar was discovered by Jocelyn Bell and Antony Hewish in 1967. 
 
Radio astronomy is a complete subfield of astronomy that has its roots in the 1930s, when the 
radio emissions of the Milky Way were first discovered.  Radio astronomy really took off after 
World War II.  In the 1950s, Cambridge’s Ryle and Hewish created important radio maps of the 
sky.  Other milestones occurred in the 1960s with the research of Frank Drake at Green Bank, 
West Virginia, and the ground-breaking discovery of the cosmic microwave background by 
Penzias and Wilson in New Jersey. 

NGC Probable Star 

These are objects that are listed in the New General Catalogue (NGC) as being probable stellar 
objects.  Probable objects are those predicted mathematically or through a combination of 
mathematics and observations. 

Other NGC 

NGC stands for New General Catalogue, a catalog of astronomical objects most notable for its 
size and the fact that it includes all types of deep-sky objects.  It was first compiled in the 1880s 
on commission of the Royal Astronomical Society by J.L.E. Dreyer, using William and John 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 243 

Herschel’s observations.  Since then, it has continued to grow in size and has been thoroughly 
revised twice. 
 
Turn the Other NGC checkbox on or off to toggle those objects belonging to the NGC and not 
specifically to any other object group. 

Mixed Deep Sky 

To toggle those objects that do not fall into any other category of non-stellar object, choose the 
Mixed Deep Sky checkbox. TheSkyX classifies objects in the famous Messier catalog as a mixed-
deep sky. 

Solar System Objects 

 
The many objects of our solar system are discreetly displayable in TheSkyX.  Choosing which to 
show in the Sky Chart is as simple as clicking a checkbox. 

Moon, Sun, Planets 

Here, you will be able to toggle the Moon and the eight classical planets, (including Earth), a host 
of small solar system bodies (comets, asteroids), satellites, and the Sun.  You will notice that each 
of the naked eye planets, plus the Moon and Sun, each has a unique graphic point style to 
instantly distinguish them in the sky chart. 
 
Here, you can select from any of the solar system objects.  By clicking the tree arrow next to Solar 
System Objects, you will see that you can choose among the Moon, the eight classical planets, 
small solar system objects (you’ll find Pluto here), satellites, and the Sun. 
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Small Solar System Bodies 

 
Under Small Solar System Bodies, you will find a button with the same label.  Clicking this button 
(or, clicking the Small Solar System Bodies command from the Input menu) will open a window 
allowing you to import small solar system bodies, such as comets and asteroids, into TheSkyX by 
using either an existing file, or by downloading orbital data from the internet.  

Comets 

Getting comet data imported into TheSkyX, follow these four, simple steps. 
 

1. With the Solar System window open, click Input > Small Solar System Bodies.  A new 
window appears with three tabs at the top, Comets, Asteroids (Small Database), and 
Asteroids (Large Database).  Select the Comets tab. 

2. A window opens labeled Comets Available for Display.  Here, you will see the total 
number of comets available for display, as well as a list of their names with check-boxes.  
It is with these check-boxes that you can toggle comets on or off in the Sky Chart or in the 
solar system simulator. 

3. You have three options for importing comet data into TheSkyX.  You can import them 
from an existing file, or you may download comet data directly in TheSkyX using internet 
databases.  You may download individual comet data by name, or you can download all 
the data for all observable comets at once.  For our example, let’s download all observable 
comets at once.  To do this, simply click Observable. 

4. The data will then download, and the observable comets will now appear in the list above, 
on the Sky Chart, and in the solar system simulator. 

 
Note: Be sure that your computer is connected to an active internet connection when attempting 
to download comet data. 

Asteroids 

The process is very similar as comet data when downloading asteroid data from the Asteroids 
(Small Database) tab.  There, you can choose to import asteroid data from an existing file, by 
orbital characteristic, such as distant, critical, or unusual, or you may import by asteroid name. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 245 

Should you decide to import asteroids from the Asteroids (Large Database) tab, you will have to 
visit one of the websites provided and download a file with the desired data.  You can then select 
the file with the Choose button to reveal the asteroids in the Sky Chart and solar system 
simulator.  Additionally, the check-boxes you see under the Asteroids (Large Database) tab 
toggle important display options such as computing asteroid positions at start-up and 24-hour 
object paths for imported asteroids. 

Small Database vs. Large Database Asteroids 

There are lots of asteroids out there; to date, about 750,000, and counting.   
 
The sheer number of them presents problems for charting programs.  If you want to show them 
all, there’s no easy way to continually update their positions without really slowing down the 
computer.  And, if you want to show the path of one asteroid, “wading through” them all to find 
the one you want can be difficult. 
 
For optimal functionality, TheSkyX breaks asteroids into separate databases, Small and Large. 

Small Database Asteroids  

• Limited to 1000 total on Sky Chart. 

• Can be imported by name, orbital characteristic, a text file or by entering the individual 
orbital elements. 

• Can create Object Paths (page 129) for any or all of them. 

• Sky Chart coordinates are updated continually. 

Large Database Asteroids 

• A virtually unlimited number can be shown on the Sky Chart. 

• Can be imported from standard IAU text files. 

• Cannot create Object Paths (page 129). 

• Can show the 24-hour path vector. 
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Figure 107: The Asteroids (Large Database) pane on the Small Solar System Bodies window. 

Large Database Asteroid Controls 

The Minor Planet Center and the Lowell Observatory each maintain comprehensive asteroid 
databases, and both can be imported directly into TheSkyX.  Web-based links to these web sites 
are located at the bottom of the Asteroids (Large Databases) pane, click on the desired asteroid 
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database, either mpcord.dat or astorb.dat to download it to your computer, then let TheSkyX 
where to find this file. 

Choose Button  

Click the Choose button to display the Open Large Database Asteroid window, then navigate to 
the folder that holds the asteroid database.  From there, select the database file name, and click 
the Open button. 

File Name 

The name of the selected asteroid database is displayed in this text box. 

Load Large Database Asteroids Each Time TheSkyX is Started 

When this checkbox is on, large database asteroids are automatically loaded each time TheSkyX 
is started.  There are over 730,000 known asteroids; importing them all can take a minute or so. 

Show 24-Hour Path of each Asteroid 

When this checkbox is on, each asteroid on the Sky Chart shows an arrow that indicates the 
direction, and length of the asteroid's path for the next 24 hours. 

Show Brighter Asteroids at Wide Fields of View 

By default, large database asteroids are shown on the Sky Chart when the field of view is 60 
degrees or less.  When this checkbox is on, the brighter (lower magnitude) asteroids are shown 
at fields of view greater than 60 degrees. 
 
When you click on an asteroid to identify it, its elements are numerically integrated to update 
them to the current equinox. The coordinates in the Object Information report are computed to 
an accuracy of ±1 arcsecond.  

Asteroid Paths 

The position and 24-hour path of any asteroid, over any time period, and for any number of 
selected small database asteroids, or for all asteroids. 

To View a 24-hour path for all Large Database Asteroids 

1. Click the Small Solar System Bodies command on the Input menu. 
2. Click the Asteroids (Large Database) tab. 
3. Turn on the Draw a line for each asteroid showing its path for the next 24 hours 

checkbox. 

To Create the 24-hour path for a Small Database Asteroid 

1. Click Input > Small Solar System Bodies. 
2. Click the Asteroids (Small Database) tab. 
3. Load the desired asteroids and click Close. 
4. Click Tools > Object Paths. 
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5. Select the asteroids in the Asteroids list. 
6. On the Create Paths tab, enter 1 hour (or any other increment). 
7. On the Count text box, enter 24 hours or any other number of increments. 
8. Click the Create Path button. 

 
A path for the selected asteroids for the select time increment is drawn on the Sky Chart. 

Satellites 

 
Artificial satellites can be viewed on the Sky Chart as they appear from your backyard, or from a 
position above Earth. 
 
From the Chart Elements window, click the Satellites button, or select the Satellites command 
from the Input menu,  to open the Satellites window.  In this window, you can import satellite or 
Iridium flare data from an existing file or from the internet.  Checkboxes allow you to toggle the 
satellites and orbital paths in the Sky Chart.  The Brightness slider allows you to control the 
brightness of satellites, making them easier to spot against a starry background. 

Viewing Satellites and their Orbits 

To observe satellite orbits, select Tools > Satellites from Above Earth.  If this is your first time 
using the satellites tool, there will not be any satellites listed, and you will have to download 
some satellite two-line elements (TLEs) before any satellite data can be shown.  You can think of 
a TLE as a set of numbers that describes a satellite’s orbit. 
 
To obtain TLE data, click the Satellites button, or select Satellites from the Input menu.  The 
Satellites window appears.  From here, you can choose to import satellite data from the web or 
an existing file.  Later, you can also choose to clear all satellite data by clicking Remove All. 
 
Note:  Ensure that TheSkyX’s date is set to within 45 days of the current date to avoid date 
rejection when downloading satellite for import. 
 
Let’s start by downloading some satellite TLEs from the web.  To do this, click the Import From 
Web… button.  You can then choose the satellite category or categories you wish to download 
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from the internet database, Celestrak.  After you have selected the desired satellite categories, 
click Download. 
 
Return to the Satellites From Above Earth window, and you will see the satellites plotted as 
points around the Earth globe.  Also, note that the satellites are also viewable in the Sky Chart. 
 
On the Satellites From Above Earth window, a list featuring your newly downloaded satellites 
appears on the left.  By selecting a satellite(s) from this list and by clicking Show Selected Orbits.  
The satellite orbits will appear in the viewer.  Sliding the Viewing Distance slider will change the 
view from a distance of 1 Earth radius up to 50 Earth radii.  If your mouse is equipped with a scroll 
wheel, you can use it to adjust the viewing distance, too.  If need be, the lower right corner of 
the window can be dragged to resize it. 
 
By clicking Update Chart, the Sky Chart is updated to show the recent satellite data from a 
ground-based perspective.  Now you will be able to amaze your friends and neighbors with your 
uncanny ability to “predict” satellite appearances in the heavens! 

Viewing Iridium Flares 

Some satellites become incredibly bright for short periods of time.  This phenomenon is due to 
the fact that their orbit brings them into precise alignment as to reflect a large quantity of sunlight 
down to Earth in a precise location.  This is most commonly observed with the Iridium 
communication satellites, and is therefore referred to as an Iridium Flare. 
 
TheSkyX can predict and display Iridium Flares using the satellite function.   
 

1. Select Input > Satellites, or, if the Satellites from Above Earth window is open, click the 
Satellites button. 

2. Choose the Iridium Flares tab. 
3. You can search for all flares, or limit your search to just daytime, nighttime, or dawn/dusk 

flares.  For this example, choose All flares. 
4. Leave the next few menus at their default settings. 
5. Click Find Flares, and TheSkyX will connect to an internet database to retrieve Iridium 

Flare data.  Be sure that your computer is connected to the internet for this. 
6. Once the upcoming flares appear in the list, click the Watch Flare button, and the flare 

will appear in the Sky Chart, along with a pointer directing you to the flare’s position. 
 
Now you know just where to look when it’s time for the next Iridium Flare. 
 
The Satellites window also features a button labeled Satellites From Above Earth, clicking this 
button opens the tool of the same name.  For more on using viewing satellites, please see the 
section Satellites From Above Earth. 
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Stellar Objects 

From the Chart Elements window, under the Stellar Objects heading, you will see the stellar 
objects displayable by TheSkyX; stars, double stars, suspected variables, supernovae, and variable 
stars.  Any of these are selectable via the checkboxes.   

Stars 

Immense luminous spheres occurring in the night sky, stars make up the better part of the mass 
of the universe observable to the naked eye.  They generate their light from nuclear reactions in 
their cores.  These nuclear reactions fuse hydrogen and helium to form elements up to atomic 
number 26: iron.  Stars occur in a variety of sizes and colors.  The color of a star is due to its 
temperature; red stars are relatively much cooler blue stars.  Our Sun is a middle-sized star.  The 
sizes of star points in the Sky Chart does not reflect actual size, but is an expression of relative 
apparent brightness, with larger points representing stars of greater apparent brightness. 

Star Options 

 
You will also see a button labeled Star Options.  Clicking this button opens a useful window that 
contains controls allowing you to adjust the Appearance of stars as well as options for their 
Proper Motion.  Tabs at the top of this window allow you to select between the two. 
 
Clicking the Appearance Tab brings up several sliders.  The Fainter/Brighter slider adjusts the 
apparent brightness of the stars in the Sky Chart. The Contrast slider adjusts the contrast of the 
Sky Chart image.  Less contrast can be useful those learning to identify constellations.  The More 
Fuzzy/More Solid slider lets you change the star points from fuzzy, nebulous orbs, to solid balls, 
and many points in between.  You can adjust the number of stars appearing in the Sky Chart by 
using the Less/More Stars slider.  Additionally, the halos seen around the star points can be 
controlled by the No/Bright Halos slider. 

Star Color 

Star color can be adjusted here in terms of the saturation of the spectral color of stars.  Also, the 
stars may be colored according to the selected ‘Star’ attribute color via a checkbox. 
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If you would like the stars to appear red in Night Vision Mode, check the checkbox labeled Red 
in Night Vision Mode. 

Map Like vs. Photo Like Display 

You may also choose between a Map Like chart, where the Sky Chart appears like a traditional 
printed chart, or a Photo Like chart, where the Sky Chart appears as photo-realistic view of the 
sky, by choosing the radio button at the bottom of the window. 

Proper Motion 

TheSkyX continually calculates stars’ proper motion, that is their actual motion in the heavens, 
not just the rising and setting, called apparent motion.  To access the proper motion options from 
the Star Options window, click the Proper Motion tab.  From here, you can turn off proper motion 
at any time by un-checking Compute Proper Motion.  You can also choose to Show Proper Motion 
Vectors by checking the box labeled as such.  Using the field labeled Proper motion vector length, 
you can enter a value between 0 and 99 years. 

Suspected Variable 

Many stars in the heavens are not steady in their energy output.  Such stars are known as variable 
stars.  There are many different types of variable star.  (Please see Variable Stars for more 
information.)  Choose Suspected Variable to toggle on or off those stars which appear, based 
upon best observations, to exhibit variable star tendencies, but are not yet confirmed. 

Supernova 

Perhaps the most energetic single event in the cosmos, the supernova is a relentless stellar 
explosion, whose effects are felt across vast expanses of space and time.  There are a few 
different types of supernovae, all with the same effect: an exploded star.  These events release 
incredible amounts of energy, much more than the Sun will release over its entire lifetime!  In 
addition to an enormous emission of light, there is also a shock wave emanating from the star.  
Material in this shock wave reaches incredible speed, and matter is slammed together hard 
enough for it to fuse into heavier elements and to emit light.  It is this fusion that is thought by 
some scientists to produce all elements heavier than iron in the Universe. 
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Variable Star 

 
A variable star is a star whose energy output is not constant, but varies in a regular pattern.  Some 
variable stars are useful in determining cosmic distances.  There are many different types of 
variables, but two main types of variable star, eclipsing binaries and Cepheids, make up most 
variables in the night sky. 
 
An eclipsing binary is a binary star with two component stars of unequal brightness.  When the 
brighter one is in “front” as viewed from Earth, the star appears to be brighter, and it appears 
dimmer when the dimmer one is in “front.”  A notable eclipsing binary is Algol in the constellation 
of Perseus.   
 
A Cepheid variable is a star whose energy output varies because the star swells and shrinks at 
regular intervals.  It is believed that these stars do this because of their internal structure and 
rotation causing a harmonic resonance.  The prototype Cepheid variable is δ (delta) Cephei.  
Cepheids are useful because they can be used to determine distances.  Their variation periods 
are directly related to their brightness.  Using this information, an observed Cepheid’s apparent 
brightness can be compared with its brightness as determined by observing its period to calculate 
its distance.  An historic use of this principle was when Edwin Hubble proved that the spiral 
nebulae were distant, separate galaxies in 1922 by observing Cepheid variables within them. 

Non-Stellar Objects 

Just as with stars, TheSkyX offers several options for displaying non-stellar objects.  Select Display 
> Non-Stellar object options to bring up the Non-Stellar Object Options window.  You can also 
access this window from the Chart Elements tab, under Non-Stellar Objects. 
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Non-Stellar Object Options 

 
Many of these options are designed to reduce computer resources while rendering the Sky Chart.  
Others are designed to reduce the number of non-stellar objects rendered to help you to hone 
in on just the objects you wish to observe. 

Non-Stellar Object Density 

The top two sliders are used to adjust the non-stellar object density in fields of view greater than 
60° (top slider) and less than 60° (bottom slider).  Simply click and drag the slider to the left or 
right for less or greater object density. 
 
You can also choose to plot objects whose entries overlap in various catalogs, such as NGC, IC, 
and PGC.  Turn on the Plot overlapping catalog entries checkbox to use the option. 
 
TheSkyX plots small galaxies as either filled ellipses or as a galaxy symbol.  If you prefer a symbol, 

select the Plot small galaxies as a “galaxy symbol…” checkbox.  For more on galaxy symbols, 
see the Galaxies section in the Chart Elements tab. 

Non-Stellar Object Drawings 

The style and appearance of non-stellar object drawings can be set with the drop-down and slider 
here.  Choose either Filled or Hollow from the drop-down menu to set the non-stellar object 
drawing style.  The slider below the drop-down menu morphs the drawings between More fuzzy 
and More solid appearance. 

In Place Photos 

TheSkyX can show NGC, IC, and PGC non-stellar objects as in place photos from the Digitized Sky 
Survey.  It can also clip the photos to the catalogued shape of the object, if you so choose.  Select 
the appropriate checkboxes in this section to turn on these options. 
 
You can also set the Default frame size when object size is unknown with this section’s value 
field.  The default setting is 10.00 arc-minutes, but you can change that value to suit your needs 
by using the up/down arrows or by directly entering a value in the field. 
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Solar System Options 

If you want the Sun and Moon to appear as transparent ellipses, select the first checkbox in this 
section. 
 
You can also choose to Show Earth’s shadow by selecting this checkbox. 
 
To exaggerate the angular size of the Sun and Moon in fields of view 90° and wider, set the 
desired value in the bottom-most field in the Non-Stellar Object Options window.  You can choose 
values between 1.0 and 10.0 times. 
 
When you are satisfied with the non-stellar object options settings, click Close to return to the 
Sky Chart. 

Reference Lines and Photos 

The Sky Chart can optionally show reference lines that reveal celestial coordinates, the meridian, 
ecliptic, galactic equator and others to help you find your way.  

Constellation and Asterism Options 

 
Click the Constellation & Asterism Options button (or the Constellation & Asterism Options 
command from the Display menu) to configure items such as asterisms, constellation drawings, 
constellation boundaries, constellation figures and constellation labels. 
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Figure 108: The Constellation & Asterism Options window. 

 
Each of the above items can be toggled, and there are several options available to you by clicking 
Constellation & Asterism Options.  Doing so opens a window of the same name.  Two tabs, 
labeled Constellations and Asterisms appear at the top.  Under the Constellations tab, note that 
there are sections each for constellation figures, boundaries, and drawings, with many 
customizable options for each. 

Asterisms 

Click the Asterisms tab, and you will see a list of available asterisms, along with a checkbox 
enabling asterism labels to be shown in the Sky Chart.  To show an asterism, locate it in the list 
and ensure that it is checked.  The chosen asterism will then appear in the Sky Chart. 
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Also, you can choose all asterisms at once by clicking the Show All button, or no asterisms by 
clicking the Show None button. 
 
Highlighting an asterism from the list and clicking the Center button is a handy way to locate and 
learn asterisms; they will be centered in the Sky Chart once the button is clicked.  TheSkyX 
probably contains more asterisms than you have come across before, so spend some time and 
have some fun discovering new ones. 

Constellation Drawings 

To display beautiful constellation drawings from Johannes Bayer’s Uranometria, check the box 
labeled Show Constellation Drawings.  Additionally, if you would like to see only the drawings 
for constellations currently at the center of the screen, click the Only show constellations that 
are near the center of the screen.   
 
Below that is a list of the 88 constellations with checkboxes, along with buttons for selecting All, 
None, the Zodiac constellations, and those constellations at the Center of the screen.  You can 
select exactly which constellations appear by utilizing the corresponding checkbox (check 
Andromeda to display the Andromeda drawing).   
 
Click the button with the color above the Transparency slider to change the color of the 
constellation drawing overlay.  You can pick from a list of colors, or you can choose your own 
color from the color wheel by clicking the color square in the lower right (the one with the three 
black dots).  The transparency of the constellation drawing overlay is controlled by the 
Transparency slider: move it to the right for increased transparency, and left for increased 
opacity. 

Constellation Boundaries 

 
Astronomers use the constellations to map out the sky.  But, instead of using just the drawings 
themselves, astronomers have laid out the entire sky in 88 sections, each attributed to a 
constellation found within that section.  To view these sections, or constellation boundaries, 
check Show Constellation Boundaries.  If you would like to highlight the central constellation 
region in the Sky Chart, simply click Highlight constellation boundary at center of Sky Chart. 
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Constellation Figures 

 
Click the Show Constellation Figures checkbox: dot-to-dot figures appear in the Sky Chart.  Today, 
there are a number of conventions for drawing the constellation figures, such as those from 
Astronomy and Sky & Telescope magazines, as well as those from H.A. Rey, and TheSkyX’s own.  
Choosing between the many styles is as easy as using the pop-up menu. 
 
You can also choose to label the constellations, and you can customize that label among many 
options.  This is especially useful, as there is much confusion about constellation pronunciation, 
especially the genitive forms, such as Cephei or Aurigae.  Checking the box labeled Label with: 
brings up the labels, and the pop-up menu lets you pick from a number of label options, including 
pronunciation for the constellation name and the genitive forms (used for describing objects that 
“belong” to a constellation, such as the star Epsilon Eridani). 

Ecliptic 

 
The ecliptic  is the apparent path of the Sun through the sky throughout the year.  This path also 
represents the general plane of the solar system, and it is because of this that the Moon and the 
planets can be found on or very near this line in the sky.  That is a handy fact, as it greatly limits 
the possible areas for planets to appear, therefore making them more easily found. 
 
To turn the ecliptic line on in TheSkyX, click the Ecliptic checkbox in the Chart Elements window.  
Likewise, the ecliptic can be turned off by clicking the Ecliptic checkbox again.  The ecliptic, like 
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most chart elements, is customizable by double-clicking on Ecliptic in the chart elements window, 
or by right-clicking on the ecliptic in the Sky Chart. 

Equatorial Grid 

 
An equatorial grid can be plotted onto the Sky Chart by turning on the Equatorial Grid checkbox.  
This spherical grid is based upon Earth’s equator projected into space, or the celestial equator.  
The grid also displays coordinates of right ascension and declination overlaid onto the Sky Chart. 
 
The grid’s attributes are fully customizable (see “Customizing Chart Elements” on page 236). 

Horizon Grid 

 
A grid that is based on the local theoretical horizon can be shown by turning on Horizon Grid 
checkbox.  This grid displays coordinates of azimuth and altitude overlaid onto the Sky Chart. 
 
The grid’s attributes are fully customizable (see “Customizing Chart Elements” on page 236). 

Horizon  

Turning on the Show Horizon checkbox displays a photograph or shaded region that represents 
the local horizon.    The default local horizon is drawn as a featureless line at 0° altitude.  You can 
redefine the line so it represents the horizon at your viewing site (see “Horizon and Atmosphere” 
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on page 259). Adding natural objects and obstructions to the horizon gives a better idea of what 
is and isn’t visible, and the approximate times at which objects rise or set. 

Horizon and Atmosphere Options 

 
To best approximate your observing site, TheSkyX allows you to show custom horizons and 
simulate atmospheric conditions including showing clouds, the Sun and Moon’s glow and 
displaying simulated meteor showers. 
 

 

Figure 109: The Horizon tab on the Horizon and Atmosphere Options window. 
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Horizon and Atmosphere Options 

Under this section, you can choose to display the horizon as a panoramic photograph or a custom 
drawn horizon, as well as show clouds, meteor radiants and other options.  
 
In the Horizon & Atmosphere Options window, you will notice four tabs at the top: Horizon, Sky 
Gradient, Clouds, and Miscellaneous.   
 
Under the Horizon tab, you can toggle the horizon and change it to one of several available virtual 
observing spots by choosing from the list at the left. 
 
Using the sliders on the right, under Horizon Photo Position, you can fine-tune the positioning of 
the horizon photos to best simulate each observing location.  You can also adjust the 
transparency of the horizon photo. 
 
If you would like to be able to scroll the sky chart below the horizon, click the Allow Sky Chart to 
be scrolled below the local horizon checkbox.   

Custom Drawn Horizons 

Near the center of the Horizon & Atmosphere window is a pop-up menu labeled Horizon Type.  
This is set to Photograph by default, but by changing it to Custom Drawn, you can use the mouse 
to draw a horizon outline that is based on your observing location.  
 
Left to right on the gray-blue-black shaded graphic represents the azimuth of your location.  Due 

north, or zero degrees azimuth is on the left, azimuth increases to the right through east (90), 

south (180), west (270) and then back to north.  The vertical axis represents the altitude of the 
local horizon, starting at zero degrees or horizontal on the bottom, increasing up to 90 degrees, 
or “straight up” at the top of the graphic.  Note that the default size of the Horizon & Atmosphere 
Options window shows the sky up to 60 degrees altitude or so.  If you need to draw portions of 
your local horizon higher than this, just make the window larger so that the graphic shows the 
entire region above the horizon. 
 
Click and drag in the blue shaded region along the correct coordinates to draw the custom 
horizon mask.   
 
Click the Apply button to update the Sky Chart’s horizon.  This also saves the custom horizon to 
the Application Support Files folder as an ASCII text file named Custom Horizon.hrz.  This 
text file has the following format: 
 
360 

    5.88 

    5.75 

    5.62 

    5.17 

    4.40 

    4.14 
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    3.88 

    3.43 

    3.05 

    2.47 

    . 

    . 

    . 

    4.72 

    4.40 

    4.14 

    4.34 

    4.59 

    5.56 

 

The number 360 appears in the first line, and represents the number of entries in the horizon 
text file, one line for each degree of azimuth.  Each subsequent line contains four spaces, 
followed by a number that is the altitude of the horizon line at that azimuth.  In the example 
above, the first line represents 5.88 degrees altitude at 1 degree of azimuth (through east), 5.75 
degrees altitude at 2 degrees azimuth, and so on to the end of the file. 
 

 

Figure 110: The Custom Drawn horizon options window. 
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Turning on the Show Refracted Horizon checkbox will draw a line on the refracted sky that 
corresponds to the observer’s horizontal.  Near the horizon, the atmosphere refracts (bends) the 
light so much that objects below the “physical” horizon are visible. 
 
Clicking the Create From Current Horizon Photo button generates a horizon mask based upon 
the photo selected when the Photograph horizon type is selected.  Once you are satisfied with 
your custom drawn horizon mask, click Apply. 
 
Click the Edit Attributes button to configure: 
 

• the custom horizon fill color 

• the transparency (Windows) or opacity (Mac) of the horizon fill color 

• the style and color of the line that is drawn on the horizon’s boundary 

• the font used to show the N, S, E, W and related directions text 
 
See “Customizing Chart Elements” on page 236 for more information about changing the 
attributes of chart elements. 

Creating and Using Your Own Panoramic Horizon 

If you own a digital camera and popular image processing software, you can create your own 
horizon panorama by stitching together a sequence of photos that spans 360 degrees.  Once this 
photo is created, copy it to the Horizons Application Support folder (see “Application Support 
Files” on page 26 for more information).  It will automatically appear under the My Panoramic 
Horizon Photos node in the Photos tree. 

Collecting the Photos 

If you wish to create a panoramic horizon, the following hardware and software is recommended: 
  

• A digital camera 

• A tripod  

• Panorama or “stitching” software that supports the PNG file format (PhotoShop 
Elements™, PhotoShop CS4™ or The Panorama Factory™, or Microsoft’s Image Composite 
Editor, for example). 

• Image processing software to make the “sky” portion of the photo transparent 
(PhotoShop Elements™ or PhotoShop CS4™, for example). 

Photo Taking Tips 

• Early morning, late evening, or an overcast day works best for even light distribution. 

• Use the widest field settings for your camera or telephoto lens. Don’t zoom or magnify 
the photo. 

• If you use a tripod, make sure it is level so that the “ends” of the panorama match.  
Modern stitching software can account for errors here. 
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• For best results, expert photographers recommend using up to a fifty to eighty percent 
overlap for adjacent photos. 

 

 

Figure 111: Panorama before transparency is added. 

 

Figure 112: Panorama after the transparent sky layer is added. 

Tips for Creating Panorama Photos 

• Both the width and the height of the panorama must be a multiple of 512 pixels.  If the 
width is not a multiple of 512 pixels, a portion of the photograph may be truncated or 
missing when it is displayed on the Sky Chart.  The supplied panoramic photos are 4096 x 
512 pixels or 8192 x 512 pixels, for example.  

• The photo must be 4 channel RGB (8 bits per channel) format. 

• Use your favorite stitching software to combine the individual images. Search the web for 
a list of software that can perform this operation.  The Panorama Factory software works 
well. 

• After stitching the adjacent photos together, the panorama must have a transparent 
region that identifies the “sky”.  Use your favorite image processing software to create an 
“alpha channel” or “transparency” layer to define a mask of the transparent regions, and 
then save this as a PNG photo. Your image processing software should have detailed 
information about how to accomplish this. 

• Larger images consume more computer and video RAM.  Generally, the smaller the 
panorama, the better. 

• Consider opening one of the horizon photos that come with TheSkyX in your image 
processing software to use as a “template” for creating your own panorama.   

  
There are many web sites dedicated to creating photographic panoramas.  Search for 
“panorama” and “panorama tools” or “image stitching”. 

Selecting the Panorama Photo 

When you have completed and saved the final panorama, copy it to the Horizons folder.  The 
location of this folder depends on your operating system. 

http://www.panoramafactory.com/
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Mac 

On the Mac, custom horizon photos should be saved in the Horizons folder that is in the TheSkyX’s 
Application Support Files folder (page 26): 
 
~/Library/Application Support/Software Bisque/TheSkyX <Edition 

Name Here>/Horizons 

 
The ‘~’ represents the location of your home directory (technically, /Users/<username> or the 
$HOME folder).  Look for the little icon of a house under Places in Finder’s Sidebar to find it. 

Windows 

On Windows, custom horizon photos should be copied to the Horizons folder located in 
TheSkyX’s Documents folder: 
 
< Documents>\Software Bisque\TheSkyX <Edition Name Here>\Horizons 

 
Where <root>\Users\<username> for Windows 7 and Windows 8; <Edition Name Here> is either 
TheSkyX Professional Edition or TheSkyX Serious Astronomer Edition.  
 
The horizon photo tree on the Horizon tab of the Horizon & Atmosphere Options window detects 
that a new photo is available and updates the list.  Select its name, to update the Sky Chart.  You’ll 
need to adjust the Horizon Photo Position settings to get things “just right” for your panorama. 

Sky Gradient 

TheSkyX even lets you adjust the color of the sky.  While this is best used to match sky conditions 
at your real-life observing location, you can always use it for fun, too.  Click the Sky Gradient tab 
to see how.  
 
Hint: Sky Gradients only apply when the Show Daylight command (page 57) is turned on.   
 
On the left, you will see a list of different sky color gradients corresponding to different times of 
day and sky conditions. 
 
On the right, you will see the controls for editing the sky color gradient.  Under Edit Sky Gradient, 
you will see the name of the selected sky gradient, the selected cloud tint (if any), a color preview 
of the selected sky gradient, as well as various buttons used to adjust the sky gradient. 
 
Let’s make a change to the default daytime sky gradient to represent a pale-sky day. 
 

1. Click the Show Daylight command from the Display menu to turn on daylight simulation. 
2. Click the Horizon & Atmosphere Options command on the Display menu. 
3. After the new window opens, click on the Sky Gradient tab. 
4. In the drop-down menu, Sky Gradient Type, choose Selected Sky Gradient. 
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5. Select a sky gradient form the list to edit, this time let’s choose Daytime.  This gradient 
simulates the color of the sky during sunlight hours.  If you would like, you may change 
the Description by editing the text in the field to the right. 

6. Now, on the right you will see the daytime sky color gradient in a sample box.  On the far 
right, you will also see little gray triangles that correspond to start points for the gradient 
colors.  Double-click the top-most triangle. 

7. The color wheel opens, allowing you to select a new color.  Choose any color you like from 
the wheel and click OK.  Do this for the remaining triangles until you are satisfied with the 
sky color gradient in the sample box.  If you would like to remove a gradient point, click 
Remove Point.  You can also click Paste Photo to import a sky photograph. 

8. Once you have the sky gradient set to your liking, you can fine-tune it with the 
Darker/Lighter slider, located below the sample box. 

9. To save your new gradient, click Save Gradients.  This action will save all changes made 
to gradients during the current session.  To return to default settings, you can always click 
Defaults, even after saving changes. 

10. Once you have saved and selected your new sky color gradient, it appears in the Sky Chart. 

Clouds 

Select the Clouds tab in the Horizon & Atmosphere window to bring up options for cloud images, 
position, and transparency.  Handily, these options will update live in the Sky Chart as you choose 
them. 

Cloud images 

On the top left, notice the checkbox marked Show Clouds.  Selecting this option will turn the 
clouds on or off completely. 
 
Choose a cloud image from those listed in the box to the left labeled Cloud Photo Name.  Click 
the Apply button or double-click on the cloud photo you want to use to apply it to the Sky Chart.  
You can also see a preview of your cloud choice to the right of the window. 

Cloud Transparency 

Maybe you have hazy, thin clouds at your observing site and you would like TheSkyX to model 
similar clouds in the Sky Chart.  Simply click and drag the Transparency slider to achieve the level 
of transparency you desire.  The exact transparency percentage appears to the right of the slider. 

Cloud Photo Position 

You have complete control over the position and orientation of cloud images in TheSkyX.  Choose 
a top and bottom limit for your cloud image by using the sliders to the right.  You can also spin 
the cloud image around your point of view by using the Right/Left slider.  Note that your 
selections for each slider are marked in degrees or either altitude (Top/Bottom) or azimuth 
(Right/Left). 
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Miscellaneous 

Options for the Sun’s halo, the Moon’s halo, and meteors appear under the Miscellaneous Tab 
in the Horizon & Atmosphere window. 

Sun’s Halo 

Turn on this checkbox to show the simulated Sun’s halo on the Sky Chart.  You can also stipulate 
an angular size (in degrees) for the solar halo.  The Sun’s halo is The default size is 10.00°. 

Moon’s Halo 

This checkbox controls the simulated halo that appears around the Moon at night.  Turn it on to 
have the Moon’s halo appear on the Sky Chart under the following conditions:  
 

• In the evening, after astronomical twilight’s end, through morning, when astronomical 
twilight begins.  (The angular size of the Moon’s glow increases slowly as twilight 
approaches, and is displayed at the maximum size afterward.) 

• The Moon is less than five degrees below the horizon, or astronomical twilight is in effect, 
whichever is earlier. 

• The Sky Chart’s field of view is greater than 10 degrees.   
 
The halo’s default angular size is 50.00°, but you can change it to whatever you wish using the 
Size box (0.00°-99.99°). 

Meteors 

Several options exist for displaying sporadic meteors and meteor showers. 
 
Checking the Show Meteor Shower Radiants checkbox will show the radiant points for upcoming 
meteor showers in the Sky Chart.  You can select how far into the future you want TheSkyX to 
look in plotting upcoming meteor shower radiants by entering a value in the Show only those 
during the next: field.  The default value is one week (7 days), but you can change it to whatever 
you wish.  This feature is particularly useful when planning to observe a meteor shower. 
 
You can also choose to show random, or sporadic, meteors in the Sky Chart by selecting the Show 
meteors (randomly) checkbox, and then choosing an hourly rate.  These sporadic meteors will 
not be based on actual forecasts, but are a great way to add extra realism to the Sky Chart.  In 
the real sky, you can expect to see anywhere from five to 15 sporadic meteors per hour. 
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Milky Way Options 

 
The Milky Way may be toggled by clicking the Milky Way checkbox in the Chart Elements 
window.  There are a number of options for Milky Way display available by clicking the Milky 
Way Options button. 
 
Once you have clicked the Milky Way Options button, the corresponding window will open.  With 
the central drop-down menu, you may choose either Photograph or Isophotes as your Milky Way 
type.  Choosing Photograph will display a photo-realistic depiction of the Milky Way in the Sky 
Chart.  Alternately, choosing Isophotes will give you a view reflecting areas of equal brightness. 

Celestial Pole Arrow 

If you would like to have a handy guide orienting you toward the celestial pole, turn on the 
Celestial North Arrow checkbox in the Chart Elements window.  A red indicator will appear in the 
upper left-hand corner of the Sky Chart, pointing North and East to help you stay oriented. 

Reference Objects 

There are a number of markers for various reference objects available in TheSkyX.  Many are self-
explanatory, but here is a short description of those with a more technical aspect.  Remember 
that each chart element is editable by double-clicking on its name in the list. 

Area of Interest, Arrow, Chart Scale 

See the “My Chart Elements” on page 283 for an explanation of these object types. 

Dome Slit 

The graphic that is displayed when TheSkyX is coupled to, and positioning an astronomical dome. 

Meteor Shower Radiants 

This marks the radiant point (or point of apparent origin) of a meteor shower. 
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Mosaic Grid 

This is the grid produced when setting up to take a photo mosaic of a region in the sky.  This grid 
represents each component frame of the mosaic.  

Reference Line 

A user-drawn line of reference. 

Reference Point 

A user-generated reference point. 

Telescope Limit 

This is a reference line that marks the slewing limit of the telescope currently set up in TheSkyX. 

Target Object 

This object marks the set target of your telescope or the object otherwise currently selected in 
the Sky Chart. 

Telrad 

If you have a telescope setup, the field of view of your Telrad™ viewfinder will appear on the Sky 
Chart with this option turned on. 

Telescope Cross Hairs 

With a telescope set up, these cross hairs show where it points in the Sky Chart. 

Pointing Sample 

A position on the celestial sphere that has been used by TPoint to calibrate the telescope and 
improve the telescope’s pointing. 

Tour Title 

When viewing a tour, this object toggles the title of the tour on or off in the Sky Chart. 

Zoom Box 

This option is a place holder so that the zoom box attributes can be edited (see “Editing Chart 
Element Attributes” on page 236).  To show or hide a zoom box, press and hold down the SHIFT 
key while dragging the mouse (see “Zoom Box” on page 41). 

Managing Databases 

TheSkyX includes a host of standard astronomical databases (see “Appendix A: Databases and 
Cross References” for a complete list).  TheSkyX can also be used to create custom databases 
from text-based data (see “Custom Databases”).  The Database Manager on the Input menu 
provides a means to turn on and off these databases, depending on your needs. 
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Using the Database Manager 

 
To access the database manager, choose the Database Manager command from the Input 
menu.  On the Database Manager window, you will see an expandable tree list of databases to 
the left; to the right are tabs for General information, database Items, Advanced options, and 
Replaced Objects. 
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Figure 113: The Database Manager window (General tab). 

To show objects in a database on the Sky Chart, turn on the checkbox next to its name in the 
Databases list. 

General Tab 

Selecting this tab (see Figure 113) will let you view the general information about the selected 
database.  When a core database is selected in the Databases list, a description and the location 
of the database files are displayed.  When a Sky Databases is selected, information such as the 
source text file, object types contained within the database, and the file path are listed. 
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Items Tab 

 

Figure 114: The Items tab on the Database Manager window. 

The table lists all the objects in the database, by row, and the fields in the database, by column.  
Clicking the Center Item button will center the highlighted object in the Sky Chart.  Alternately, 
you can automatically center a selected item by turning on the Automatically Center Highlighted 
Object on Sky Char checkbox. 
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Advanced Tab 

 

Figure 115: The Advanced tab on the Database Manager window. 

Here, you can remove, then reload the Sky Databases (SDBs) by clicking the Reload SDBs button.  
You can also convert existing TheSky6 SDBs to TheSkyX-compatible SDBX format by clicking the 
Convert button.   
 
1. Copy your TheSky6 Sky Database (.sdb) and text (.txt) files into TheSkyX’s SDBs folder (see 

“Application Support Files” on page 26 for details about these files). 
2. Click the Convert button, select the folder that holds your existing SDBs and associated text 

data (only). 
3. Click the Open button to begin the conversion process. 
 
The converted Sky Databases will appear on the Database Manager window’s list of Databases 
under My Sky Databases.  
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Optimized UCAC3/UCAC4 Catalogs 

TheSkyX Professional Edition can show stars from the native UCAC3 and/or the native UCAC4 star 
catalogs.  Before it can do so, you must first create a TheSkyX Pro-specific database file as 
described below. 
 

 

Important notes:  
 

• TheSkyX Pro Database Add On already includes the optimized UCAC3 and UCAC4 
plot files and these files need not be generated separately as describe below.  If 
you own the Database Add On, see “Accessing TheSkyX Pro Database Add On 
Catalogs” on page 640 for more information. 

• Clicking a UCAC star from the Sky Chart retrieves extended information about 
that star directly from the text-based UCAC database.  The optimized plot file is 
used to quickly display the position and magnitude of UCAC objects when 
panning and scrolling the Sky Chart. 
 

Choose  

Click this button to specify the location of the native UCAC3 or UCAC4 databases.   

Create 

Click this button to create an optimized TheSkyX-specific UCAC3 or UCAC4 database file: 
 

• UCAC3.plot for the native UCAC3 database.   

• UCAC4.plot for the native UCAC4 database.   
Optimized “plot” files are used by TheSkyX Pro to efficiently display objects and retrieve 
information from text-based databases.  Make sure that the UCAC3 or UCAC4 folder has “write 
access” so that the UCAC3.plot or UCAC4.plot file, respectively, can be saved in this folder.   
 
Creating the optimized plot files from the native databases takes several hours.  To configure 
TheSkyX Pro to use this optimized database, select either UCAC3 or UCAC4 in the Stellar 
Databases section of the Databases list, then click the Choose Folder button and choose the 
folder that holds the appropriate file. 

Show Only the Highlighted SDB 

When this check mark is turned on, and a Sky Database (SDB) is highlighted in the Databases 
list, the only the highlighted database is displayed on the Sky Chart (whether the checkbox next 
to the database is turned on or whether other Sky Databases are turned on).  This option allows 
you to individually display Sky Databases on the Sky Chart using the up/down arrows on the 
keyboard.  This can be helpful when trying to locate an SDB, or to troubleshoot whether or not 
your custom SDBs were compiled and are being displayed properly. 
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Replaced Objects Tab 

To view replaced objects, click this tab.  Clicking Refresh will update the list. 

Custom Databases 

Creating your own database of celestial objects can be a useful thing to do if you choose to 
carefully document your observations.  TheSkyX lets you do this with a great amount of freedom.  
Let’s take an overview look at the Create Sky Database command. 

Creating a Sky Database 

 
To see the Create Sky Database window, select the Create Sky Database command from the 
Input menu.  A tabbed window then opens, with options for defining fields, behaviors, advanced 
operations, and compilation operation. 

Define Fields Tab 

From the Define Fields tab, you can select values for a number of items.  If you wish to open a 
file containing field data, simply click Choose Source Text File.  If you would like to open it in 
Unicode, be sure to select the Open text file in Unicode checkbox. 
 
To enter value ranges for field items, highlight a field in the window to the left.  You will see its 
current column start and end points, if any.  To enter values, you may either enter them in the 
Starting column and Ending column fields below, or you can click on the starting point on the 
graph and drag to the desired ending point.  When dragging, the selected values appear to the 
right of the Set Columns button.  You can always change the values by clicking and dragging again.  
Once you have entered the desired values, click the Set Columns button.  The column will then 
be set on the graph, and a label featuring its description appears in blue. 
 
Clicking Clear All will clear all data from the graph. 
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Behavior Tab 

This tab includes options that define control the how the database interacts with the Sky Chart. 
 

 

Figure 116: Behavior tab on the Create Sky Database window (Create Sky Database command, Input menu). 

Sky Database Identifier (Identifier) 

Enter text that uniquely defines the database you are creating.  

Search Prefix 

Enter the text prefix that can be used to locate objects in the SDB when finding objects (page 59).   

Default Object Type 

Select the type of object (star, open cluster, etc.) that is in the source text file from this list.   
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Minimum Field of View 

Enter a number for the smallest (narrowest) field of view on the Sky Chart to show the objects in 
this database.   

Maximum Field of View 

Enter a number for the largest (widest) field of view on the Sky Chart to show the objects in this 
database. 

Coordinate Frame 

Select the coordinate system of the objects in the source text file. 

• Equatorial: Coordinates are in right ascension and declination format.  Make sure to 
specify the correct equinox for equatorial coordinates. 

• Horizon:  Coordinates are in azimuth and altitude format. 

• Topocentric: Coordinates are relative to the current location on the surface of Earth. 

Equinox 

Enter the equinox of the coordinates in the source text file. 

Plot Order 

When displaying databases, you may want a specific object to should appear “on top of” other 
objects.  The Plot Order allows you to select when, relative to objects in the core database, this 
database will be drawn on the sky chart. 
 

• Early: Show objects in the Sky Database before stars.  Stars will overlay objects in the 
database. 

• Middle: Show objects in the Sky Database after stars.  Objects in the database will overlay 
stars. 

• Late: Show objects in the Sky Database on top of all other objects. 

Cross Reference Type 

Select how objects in the source text file are cross referenced with objects in the core databases. 

• None:  Objects in the text file do not contain cross references to objects other databases. 

• Database: Objects in the text file contain cross references to objects in TheSkyX’s core 
databases, or other SDBs. 

• Pure: Objects in the text file reference existing object names or catalog numbers. 

• Common Name: Objects in the text file reference existing common object names. 

SDB Description  

Enter a text description for the Sky Database.  The SDB Description text editor accepts text that 
is formatted with hypertext markup language (HTML), so that, for example, links to external web 
sites can be included with the header.   
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 277 

Please note that the SDB Description text input is a simple text editor, not a web browser.  This 
means, for example, when HTML is pasted into the SDB Description text box, a link to an external 
web page may be formatted as a hyperlink (that is, underlined in blue), but clicking on the 
underlined text will not show the external link in a web browser.  
 
Once the SDB is compiled (see “Compile Tab” on page 278), the web links in the description can 
be accessed from the Description on General tab of the Database Manager (see “Managing 
Databases” on page 268). 
 

 

Figure 117: The General tab of the Database Manager window (page 268) showing web accessible hyperlinks in the Sky 
Database Description field. 

Additionally, there are options that control plotting, searching, and how object information is 
shown in the database and/or Sky Chart. 

Advanced Tab 

Under Advanced, you will find operators to translate text to object type, multipliers for various 
measurements and coordinates, folder options, and Unicode control. 
 
To the left is the Translate Text to Object Type section.  Simply type text into the fields, and select 
the desired object type from the drop-down menu. 
 
Multipliers for right ascension, declination, magnitude, major and minor axes, and position angle 
may be entered into the fields to the upper right. 
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Under Folder Operations, you can choose to compile a new folder from existing text files, or you 
may choose to convert a folder of TheSky6 database files for use in TheSkyX. 
 
Additionally, you can convert a text file to Unicode and select from a list of codecs to use in the 
To Unicode section to the lower right. 

Compile Tab 

This is where you can finally compile your database, once all the criteria are set.  Clicking the 
Compile button compiles the database, revealing the corresponding text file in the field with a 
star chart above.  You can add a header by checking the Add header to text file box. 
 
Once you are finished, click the Close button. 

Defining Search Fields in Sky Databases 

Most text-based celestial object databases include catalog numbers or other identifiers to 
uniquely identify each object.   
 
TheSkyX can use these identifiers to generate a “searchable” Sky Database (SDB) .  Objects in 
these databases can be located by typing the SDB Search Identifier, followed by the object’s 
unique identifier in the Search For text box on the Find window. 
 
Searchable Sky Databases and the objects they contain, are also listed in the Advanced tab of the 
Find window.   
 
The following procedure describes how to configure the Sky Database parameters so that once 
the SDB is created, the objects in the database can be located using the Find command on the 
Edit menu. 
 

1. Select the Create Sky Database command from the Input menu. 
2. On the Define Fields tab, click the Choose button near the top to the window. 
3. Select the file that contains the space separated text-based celestial object database and 

click Open.  The contents of the text file appear on the right side of the Define Fields tab. 
4. Specify the beginning and ending columns that hold the RA Hours, RA Minutes, RA 

Seconds, Dec Sign, Dec Degrees, Dec Minutes and Magnitude.  These are the minimum 
required fields for an SDB.   

 
For example, suppose in columns 66-74 contain right ascension in decimal format.  To define RA 
Hours, select this text on the left side of the window, then enter 66 in the Starting Column text 
input and 74 in the Ending Column text input and then click the Set Columns button.  The text 
file shows RA Hours in blue above these columns. (You can also drag the mouse to highlight the 
desired columns in the text file on the right.)   
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Repeat this process for each required field. 
 

1. On the Behavior tab, click  
2. Turn on the Allow Searching for Objects in Database checkbox on the Behavior tab of the 

Create Sky Database window. 

Search Prefix  

Some astronomical databases do not require a prefix to search for objects that are present in a 
database.  For example, if the database contains common names of objects like “Polaris” or 
“Andromeda Galaxy”, a catalog prefix is not required. 
 
Other catalogs identify each item by a single, unique number.   For example, the NGC catalog has 
7,840 items and they are numbered from 1 to 7,840.  For this catalog, a prefix and a number are 
required to uniquely identify and locate each object in the catalog (for example, NGC 555).  
 
In the example below, the ARP catalog of galaxies requires a Search Prefix because the search 
field contains only numbers from 1 to 338.  Entering just the number “338” would not provide 
enough information to uniquely identify ARP 338.  

Search Prefix Hints 

• For convenience when searching, limit prefixes to about 3-5 characters.  

• Do not use existing prefixes such as NGC, IC, PGC or SAO.  

• If a Search Prefix is defined in an SDB, then the prefix is required when searching for 
objects in that SDB.  For example, if the Search Prefix is defined as ARP-PG then the only 
way to locate objects in the Arp Peculiar Galaxies SDB is to enter ARP-PG 338.  
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Figure 118: The Behavior tab on the Sky Database window (Sky Database command from the Input menu). 

Just like other fields on the Define Fields window, the Label/Search field is specified by dragging 
over the columns (in this example, columns 1 through 3) then clicking the Set columns button. 
Alternatively, you can drag the columns then double-click on the Label/Search field.  
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Figure 119: The Define Fields tab on the Sky Database window (Sky Database command from the Input menu). 

In the Advanced tab of the Find window, when the database is expanded the Search Prefix will 
be added to the search field.  
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Figure 120: The Advanced tab on the Find window (choose the Find command on the Edit menu). 
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My Chart Elements 

 
TheSkyX allows you to add your own chart elements to the Sky Chart.  In so doing, TheSkyX gives 
you the best of convenience from both electronic and paper star charts. 
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Adding Chart Elements 

 

Figure 121: The My Chart Elements window (Input menu). 

 
The easiest method to add a chart element to the Sky Chart: 
 

1. Select the My Chart Elements command from the Input menu. The My Chart 
Elements window opens.  At the top left is a checkbox, Show My Chart Elements.  
Once you have added your own elements, turning this option on will reveal them on 
the Sky Chart.  Notice that there are two tabs in this window, Manage and 
Import/Export. 

2. On the Manage tab, select which element to add by clicking one of the buttons on 
the left side of the window: 

• Add Object – Adds an object to the Sky Chart.  The object can be of any type 
(star, cluster, galaxy, etc.) or one of your own object types (My Object Type). 
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• Add Label – Adds a text label to the Sky Chart.  The Enter Label window will 
appear so that you can specify the label’s text. 

• Add Object Label – Adds a custom label to an existing object.   

• Add Arrow – Add a reference arrow to the Sky Chart to highlight a particular 
object or region. 

• Add Ellipse – Adds an ellipse to the Sky Chart. 

• Add Area of Interest – Adds a shaded rectangular region to the Sky Chart for 
emphasis. 

• Add Chart Scale – Adds a small graphic that shows the angular scale for the 
chart. 

• Add Telrad – Adds a Telrad™ Finder to the Sky Chart. 

• Add Graphic – Adds a photograph or Scalable Vector Graphic to the Sky Chart. 
3. Position the mouse cursor over the Sky Chart, then CTRL+left-click (Windows) or 

+left-click (Mac) to add the Chart Element at that position. 
 
Or, click the Add and Edit button on the My Chart Elements window.  This opens a new window 
where you can input the necessary information about the element. 
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Figure 122: Add/Edit Chart Element window. 

 
Near the top of the Add/Edit Chart Element window, you will see the coordinates section.  You 
can choose between Equatorial or Horizon (azimuth-altitude) coordinates.  Also, you can choose 
to precess the coordinates from one equinox to the current one to update old data.  To do this, 
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simply input equinox dates in the fields To and From, and then click Precess.  The new coordinates 
will then appear in the coordinate fields above. 
 
Note:  This function works forward or backward.  If you would like to precess current coordinates 
to a past time, you can do that too. 
 
Once you have your coordinates entered, it is time to choose the object type.  Using the pop-up 
menu, choose the object type for your new chart element.  Remember that each of these objects 
can be toggled from various places in the Chart Elements window. 
 
You can then enter Label text, and a Snap to/cross reference point in the appropriate fields. 
 
The next four fields control the actual appearance of your object in the Sky Chart.  Magnitude, 
just like the magnitude of a star, controls the apparent brightness of the object in the Sky Chart 
(remember that the bigger the number, the dimmer the object).  Position Angle controls the 
angular offset in degrees of your new object and the reference object, relative to the north 
celestial pole.  Imagining your object as an ellipse, input the major and minor axis measurements 
in arc minutes.  Remember that circles are special types of ellipses whose major and minor axes 
are equal. 
 
Near the bottom of the window are the DRAW commands.  You can choose the type of draw 
command you wish to use from the drop-down menu.  You can then enter a command argument 
into the field below, or use the arrows to choose an appropriate argument value. 
 
Once you click OK, you will be brought back to the My Chart Elements window, and your new 
custom chart element appears in the object list to the right. 
 
You can always edit the element data by clicking Edit. 
 
To center the object in the Sky Chart, click Center. 
 
Clicking Remove All will remove all My Chart Elements. 
 
To change the CTRL+left click (Windows) or +left-click (Mac) behavior, use the drop-down menu 
to the lower left.  You can choose to snap to the Cursor Position, Nearest Star, or the Nearest 
Non-Stellar Object. 
 
When you are finished managing My Chart Elements, click Close. 

Export/Import My Chart Elements 

Choose the Export/Import tab at the top of the My Chart Elements window.  Here, you will be 
able to export your created chart elements, or you can import other chart elements from a text 
file. 
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Exporting Chart Elements 

Follow these easy steps to export your chart elements in Sky Database (SDB) format. 
 

1. To export a chart element, choose Export/Import tab at the top of the My Chart Elements 
window.  The top portion of the window now shows export options. 

2. Choose an appropriate identifier and enter it into the first field. 
3. Then, from the Default Object Type drop-down menu, choose the desired object type.  

You can choose from any of the object types used in TheSkyX. 
4. Choose the desired maximum and minimum values for the FOV (Field of View). 
5. Coordinate Frame lets you choose between equatorial or horizon (Azm/Alt) coordinate 

systems. 
6. Choose the appropriate equinox, plot order, and cross reference type. 
7. Before exporting, be sure to take note of the checkboxes to the top right of the export 

section.  These boxes let you toggle options for plotting objects and their labels, make 
these objects searchable, and to enable click identify for them. 

8. Once you are ready, click the Export to File… button to export your data to a Sky Database 
file.  Simply choose the file’s destination, and click Save. 

 
Note:  You can also save these data to the clipboard for later pasting. 

Importing My Chart Elements 

You can import any chart element(s) from a text file by using the bottom portion of the My Chart 
Elements window, Export/Import tab.  Simply click the From File button to import an existing 
file.  If you have chart element data copied to the clipboard, you can paste those data into 
TheSkyX by clicking the button labeled From Clipboard.  Additionally, you can change the working 
directory by clicking the Choose button. 

Observing Lists  

 
The Manage Observing List command in the Tools menu can be used to perform advanced 
searches or database queries to generate observing lists.  The Advanced Query tab offers much 
more detail regarding your query of celestial objects than the simplified options on the What’s 
Up Setup tab. 
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The normal procedure for creating an observing list is to define the type of objects you’re after, 
and specify the astronomical databases to search (in the Object Types & Databases tab).  Next, 
you can create custom filters based the attributes of the object types in the Filters tab.  The 
Constellations tab allows you to refine the location further. 
 
Once you’ve defined the parameters for your query, clicking the Run Advanced Query button 
generates an observing list on the Observing List window (Display menu). 

Advanced Query Setup 

 
Defining an advanced query is as simple as clicking the Advanced Query tab to the left of the 
What’s Up Setup tab.  You will notice that the query setup area changes to a multi-tabbed 
window that lets you Open/Save Query, choose Object Types & Databases, set Filters, and select 
Constellations and Other criteria for your query.  The following is a brief discussion of each tab 
and the information contained there. 
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Figure 123: Advanced Query pane on the Manage Observing List window (Manage Observing List command, Tools 
menu). 

Run Advanced Query 

Click this button to begin searching for objects based on the specified query attributes. 

Clear Observing List 

Click the Clear Observing List button to remove all objects from the current observing list. 
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Report Setup 

Click the Report Setup button to define the object parameters that appear in an observing list.  
For example, the list might contain only object names, or it can include as many additional 
properties as desired. 

Append Objects to the Observing List 

Turn on this checkbox to generate an observing list from multiple queries.  The results of each 
successive query are added to the end of the current observing list. 

Append Objects to the Observing List by SHIFT+Clicking Objects on the Sky Chart 

When this checkbox is turned on, objects can be added to the observing list by holding down the 
Shift key and then clicking objects on the Sky Chart.   

Open/Save Query Tab 

Here, you will see advanced (or Saved) queries available to you.  You can open queries by double-
clicking on the query name in the Saved Queries list (the Current Query shows the name of the 
currently loaded query settings file), save current query settings by clicking the Save As button, 
or create new ones by clicking one of the options in the Create New Query For pop-up menu.   
 

 

Figure 124: The Create New Query For pop-up menu. 

To Create a New Query 

Click the Create New Query pop-up menu. 
Select from one of the pre-defined queries to setup a query for that object type.  Or click the Let 
Me Define Query Parameters command to clear any existing query settings and start from 
scratch. 

Query Attributes 

The Query Attributes report shows the selected object types, databases filters that will be used 
for the current query. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 292 

Saved Queries 

The Saved Queries list shows supplied queries (files that have the database query or .dbq file 
extension) and the queries that you have generated and saved.  To open a query, double-click its 
name in the list, or click the Open button and then select it from the Open Database Query 
window.  

Saving Queries (Save As) 

Click the Save As button to name a query. 

Object Types & Databases Tab 

Here is where you select which types of objects you wish to include in your query, along with 
from which databases you would like to search. 
 
It’s best not to mix object types in your query.  For example, it’s not a good idea to create a single 
query for asteroids and spiral galaxies.  These object types are distinct and need separate queries. 

Filters Tab 

Under this tab, you can select from a thoroughly customizable list of filter options to narrow your 
query parameters.  All current filters can be edited or removed at any time by using the 
corresponding buttons found in the Current Filters section. 

Constellations Tab 

This tab allows you to specify a specific constellation, or group of constellations, to search. 

Other Tab 

This tab includes miscellaneous options that allow you to provide a text description of the query, 
choose among search criteria related to the Sky Chart, set queries to run automatically at given 
times, and to determine imaging availability of objects sorted by the query. 

Observing List Example 

Let’s go through the steps involved in running an advanced query.  Suppose you want to create 
an observing list that contains all the double stars from the Washington Catalog of Double Stars 
that have a spectral type of G5 in Orion.   
 
TheSkyX makes generating an observing list from this complex query relative simple. 
 

1. Select the Manage Observing List command in the Tools menu. 
2. Click the Advanced Query tab.   
3. On the Advanced Query tab, click the Create New Query For pop-up menu. 
4. Select the Double Stars command.  Double stars from the WDS (Washington Catalog of 

Double Stars) database are automatically selected for you in the Object Types & 
Databases tab. 
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5. Click the Filters tab to define a filter that limits our search to just the G5 double stars.  In 
the Attributes list, expand Double Stars, then select Spectral Type and click the Create 
Attribute Filter button. 

 

 

Figure 125: The Create Attribute Filter window. 

6. On the Create Attribute Filter window, select the Equal To command from the Match 
Objects That pop-up menu. 

7. Type the text G5 into the This Value text input and click OK. 
8. On the Constellations tab, click the None button, then turn on the check mark next to 

Orion. 
9. On the Open/Save Query tab, click the Save As button, and specify the name of this query 

as G5 Double Stars in Orion.  It’s always a good idea to save your work. 
10. Click the Run Advanced Query button to run the query and create the observing list on 

the Observing List window (Display menu). 
 
The Observing List window now shows forty-three G5 double stars in Orion.   
 
When you highlight an object in the Observing List, the green laser pointer will direct you to it in 
the Sky Chart.   
 
The Show on Sky Chart pop-up menu affects how the object is shown in the Sky Chart.  You can 
choose among Wide-field view, Constellation view, Small-field view, or Do not show at all. 
 

• Click the Center button to center the object in the Sky Chart’s field of view. 

• Click the Copy Text to copy the object text to the clipboard. 

• Print Information lets you print out the data from the list about the object. 
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• If you would like to slew a connected telescope to the object, simply click Slew to make it 
so. 

Observing List Window 

 
The Observing List window lets you create, edit, and manage objects your observing lists. 
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Figure 126: The Observing List window (Observing List command from the Display menu). 
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Observing lists can be created from TheSkyX in several different ways: 
 

• Manually add items: For each object in the list, double-click <Add> on the spreadsheet 
control, enter the name of the object and the press the Return key (Enter key on 
Windows). 

• What’s Up?:  Click the What’s Up? button located on the top left of the window to 
generate a list of objects (page 103). 

• Manually type or paste a list of object names from the Clipboard:  Click the Manage 
Observing List button on the top of the Observing List window, then click the Add Objects 
tab.  From here, you can type the list of object names, or paste a list of names that have 
been copied to the Clipboard by clicking the Paste Object Names button.  When the list 
is complete, click the Add Objects to Observing List button to update the Observing List 
spreadsheet. 

• Create an advanced query:  Click the Manage Observing List button on the top center of 
the window to define simple or extremely complex database queries that produce exactly 
the observing list you need.  See “Observing Lists” on page 288 for details. 

Labeling Observing List Objects (Label objects in observing list) 

Turn this option on to display a text label next to each object in the observing list. 

Draw a Line Between Observing List Objects (Draw a line connecting list objects) 

Drawing a line that connects each object in the list helps visualize the path the telescope must 
take to view each object in the list. 

Centering Objects in the List (Center) 

Highlight an object in the list, then click the Center button to center this object in the Sky Chart.  
The chart’s field of view stays the same. 

Copying Object Information to the Clipboard (Copy Text) 

Highlight an object in the list, then click the Copy Text button copy the object’s information to 
the Clipboard.  This text report can be pasted into any text editor. 

Print Information  

Click this button to print the Object Information Report for selected observing list object on the 
default printer. 

Slew the Telescope (Slew) 

Slew the telescope to the selected object. 

Add Observing Notes (Add to Observer Log) 

Use  the Observing Log window to keep a track of the objects you have observed.  You can even 
rate the object and seeing conditions, as well as add personalized notes.   
 
Select the observed object in the list, then click the Add Observer Log button to show the Edit 
Observation tab of the Observer Log window. 
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Figure 127: The Edit Observation tab on the Observing Log window (click the Add Observer Log button on the Observing 
List window to view this window). 

Name of the Observer (Observer) 

Type your name, or the list of observers’ names, here.   

Rate the Current Seeing Conditions (Seeing)  

Atmospheric turbulence, moisture, light pollution, and many other factors influent local 
astronomical seeing conditions.  Seeing conditions are typically rated on a scale from 1-5, the 
higher the rating, the better the seeing. 

Rate the Current Object (Rating)  

Like rating seeing, the subjective quality or appearance of the object that you’re observing can 
also be rated.  Again, a higher the number indicates a better rating. 

Enter Personal Comments (My notes) 

Critique the observed object by typing your notes here. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 298 

Updating the Observations Table (Update My Observations) 

Click this button to add notes, ratings, and object information to the table on the My 
Observations tab. 
 

 

Figure 128: The My Observations tab on the Observer Log window (click the Add Observer Log button on the Observing 
List window to view this window). 

The My Observations table shows the list of objects that you have observed.  The Observing List 
table shows an icon next to objects to indicate they have been observed.  

 

Figure 129: This graphic is displayed next to observing list objects after adding or editing an observation. 
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Figure 130: Objects that have been observed include the observation check mark icon next to them in the Observing List. 

To permanently remove an observation from the list, select it and press the DELETE key. 

Manage Observing List Window Orientation 

The orientation and position of the controls in the Observing List stacked window changes based 
on the window’s aspect ratio (that is, the ratio of the height to the width of the window).   
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This allows the Observing List window to float in a vertical orientation or be docked to the left or 
right side of the main window.  The window can also float in a horizontal orientation or be docked 
to the bottom of the main window.   
 
You can choose which orientation works best for your workflow and hardware (screen size, 
aspect ratio, resolution, number of screens, etc.). 
 
By default, the Observing List window is docked to the left side of TheSkyX’s main window in the 
vertical orientation.  To undock it, first make sure it’s the topmost stacked window by clicking on 
the Observing List tab on the left side of the window.  (Click the Observing List command from 
the Display menu to turn it on if necessary.)   
 
Once visible, click and drag the topmost portion (the caption) of the Observing List window and 
move it off the stacked windows. 
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Figure 131: Click and drag the mouse on the Observing List window to move it. 

The window can now be positioned where you want, even on a second monitor (if you’re lucky 
enough to have two!). 

Horizontal Orientation 

The controls on the Observing List window automatically switch between the vertical and 
horizontal orientation as the window is sized.  
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When the window is taller than it is wide, the controls appear in a vertical orientation.  When the 
window is wider than it is tall, and the window is wide enough to fit the controls in a horizontal 
orientation, the controls are automatically repositioned.  
 
To make the Observing List controls appear a horizontal orientation, click the lower right corner 
of the Observing List window (or the size control in the lower right corner on the Mac) and drag 
the window wider (while not making it taller).  Once the window is wide enough to fit the controls 
horizontally, they’re repositioned automatically. 
 
When the Observing List window is in the horizontal orientation, it can also be “docked” to the 
bottom of the main window (see Figure 132).  To dock it to the bottom of the main window, click 
and drag the caption to the center of the bottom of the main window.  When the top of the 
caption is near the bottom of the main window, positions of the Sky Chart and stacked windows 
are adjusted to make room for the Observing List window.  At this point, release the mouse to 
dock the window. 

Observing List Orientation Notes 

The Observing List window cannot be docked to the bottom of the window when the Observing 
List controls are in the vertical orientation. 
 
The main window will not allow the Observing List window to be docked at the bottom if there’s 
not enough room for it to fit.  So, maximize the main window before attempting to dock the 
horizontal Observing List window.   
 
The Chart Status Window can be closed or undocked to make room, if necessary. 
If all attempts at “bottom docking” fail, then close all other stacked windows.  If the window 
refuses to dock, it means there is insufficient screen real estate for this control to be placed at 
the bottom of the window. 
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Figure 132: The Observing List controls in a horizontal orientation and docked to the bottom of the main window. 

This configuration allows you to access items in the observing list while viewing the Sky Chart and 
still have access to the controls in the other stacked windows. 

Creating Sky Chart Mosaics 

 

 
The Mosaic Grid command on the Tools menu can be used to divide a rectangular area of the sky 
into smaller rectangular regions (called tiles), each of which has the dimensions of a selected 
field-of-view indicator (FOVI) or any other custom size.  Once the mosaic is created, you can slew 
the telescope to the center of any rectangle simply by clicking on it.   
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Figure 133: Sample mosaic grid on the Sky Chart. 

1. Select the Mosaic Grid command from the Tools menu to show the Mosaic Grid window. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 305 

 

Figure 134: The Mosaic Grid window. 

Mosaic Tile Geometry 

Use the options on the Geometry tab to define the Width and Height, in arcminutes, of each 
mosaic tile and each tile’s rotation, or Position Angle, in degrees, measured counterclockwise 
from North.  You can optionally select a field of view indicator in the My FOVIs list. 
 
Next, enter the number of Rows and Columns, the Overlap of the primary mosaic grid and the 
grid’s position on the celestial sphere, equatorial coordinates.  
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Turn on the Follow Moon checkbox so that TheSkyX will slew to the current position of the Moon, 
instead of a fixed equatorial coordinate.  
 
Turn on the Show Mosaic Grid checkbox to show the mosaic grid then click the Create and Show 
Mosaic Grid button to center and frame the mosaic on the Sky Chart. 
 
2. Click the Advanced tab.  The Advanced pane can be used to create a duplicate of the primary 

mosaic grid on the Sky Chart that is at a specific X and Y offset from the primary grid. 
 

 

Figure 135: Advanced tab on the Mosaic Grid window. 
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Enter the horizontal (x-axis) and vertical (y-axis) offset for the new mosaic. The offset unit is 
defined as the “width of the primary mosaic.” A value of 1 in the “X offset” will place the 
replicated mosaic’s upper left corner next to the primary mosaic’s upper right corner. (The offset 
is always relative to the upper left corner of the primary mosaic.)  
 
An offset of 0, 0 is allowed and will place another mosaic on top of the primary mosaic. The 
mosaics centers are numbered starting at one through the total number of mosaic regions. 
Mosaics are ordered alphabetically.  
 
Click the “Add” button to create the new mosaic and add the offset to the mosaic replication list. 
 
3. Specify the numbering convention for the mosaic centers.  

• -X, +Y: Mosaic center numbers are incremented right to left by row, starting in the 
upper left corner of the mosaic.  

• +Y, +X: Mosaic center numbers are incremented top to bottom by column, starting in 
the upper left corner of the mosaic. 

• +X, +Y: Mosaic center numbers are incremented left to right by row, starting in the 
upper right corner of the mosaic. 

• –Y, –X: Mosaic center numbers are incremented bottom to top by column, starting in 
the lower left corner of the mosaic. 

To Clipboard Button 

Click the button to copy the equatorial coordinates of the centers of selected mosaic to the 
Clipboard. These coordinates can be used to generate a script that slews your telescope to each 
position. 

 

Sample mosaic grid data: 
 
  1  A   0   9.32121655 -29.04969590 

  2  A   1   9.32119169 -28.89969638 

  3  A   2   9.32116702 -28.74969737 

  4  A   3   9.32114254 -28.59969785 

  5  A   4   9.30977751 -29.04991248 

  6  A   5   9.30976922 -28.89991265 

  7  A   6   9.30976100 -28.74991333 

  8  A   7   9.30975284 -28.59991349 

  9  A   8   9.29833849 -29.04991248 

 10  A   9   9.29834678 -28.89991265 

 11  A  10   9.29835500 -28.74991333 

 12  A  11   9.29836316 -28.59991349 

 13  A  12   9.28689945 -29.04969590 

 14  A  13   9.28692431 -28.89969638 

 15  A  14   9.28694898 -28.74969737 

 16  A  15   9.28697346 -28.59969785 
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Reset Slewed 

Once you have slewed your telescope to a given frame, parentheses are placed around the 
number in the center of the block, indicating that this frame has been imaged. If you wish to start 
the mosaic process over, click this button to clear all the parentheses. 

All Sky Mosaic Grid 

TheSky Professional Edition can create a mosaic grid that covers the entire celestial sphere (or, 
optionally just the northern half of the celestial sphere).  The grid can aid in producing an all sky 
photograph or performing an all sky survey. 
 

 

The maximum number of frames in an all sky mosaic grid is limited to about 15,000 
frames.  This means each frame must cover about four square degrees or more, 
depending on the overlap.   

 

For each frame generated, the camera position angle is assumed to be north up, or north down. 
The grid computations do not consider camera rotation angles outside these two orientations. 
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Figure 136: The All Sky Grid pane. 

Overlap  

Enter the percentage of overlap for each tile in the mosaic grid. 

Width (RA) 

Enter the angular width, in degrees, of each tile. 
 
Near the celestial equator, the distance around the celestial sphere is nearly 360 degrees, so the 
number of frames will be near 360 divided by the Width (RA) value.  As the declination increases, 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 310 

or decreases, the number of frames around the particular declination decreases.  Each 
declination band starts at RA 0.0, unless a different value is entered in the Starting RA text box. 
 
Once a grid is computed, it will be displayed on screen, and the text on the Create Grid button 
changes to Clear Grid. 

Height (Dec) 

The celestial sphere is divided into declination “bands” based on the Height (Dec) input value and 
the overlap percentage. For example, a Height of 5 degrees with a 10% overlap will yield 
declination bands that are spaced at 4.5-degree intervals.  

Starting RA 

Enter the right ascension, in decimal hours, to start the all sky grid. 

Create Grid 

Click this button to create a mosaic grid that covers the northern hemisphere using the FOVI from 
the Geometry pane. 

Include Southern Hemisphere 

Turn on this checkbox to create the grid for the entire celestial sphere. 

Copy Grid 

Click this button to copy the grid centers to the Clipboard in XML.  This format can be used to 
quickly generate a Sky Database of the grid, or imported into a spreadsheet application. 
 
<?xml version="1.0"?> 

<!DOCTYPE TheSkyDatabase> 

<TheSkyDatabaseHeader version="1.00"> 

 <identifier>Mosaic</identifier> 

 <sdbDescription>Locations of Mosaic centers</sdbDescription> 

 <specialSDB>0</specialSDB> 

 <plotObjects>1</plotObjects> 

 <plotLabels>1</plotLabels> 

 <plotOrder>0</plotOrder> 

 <searchable>1</searchable> 

 <clickIdentify>1</clickIdentify> 

 <epoch>        2000.0</epoch> 

 <referenceFrame>0</referenceFrame> 

 <crossReferenceType>0</crossReferenceType> 

 <defaultMaxFOV>      360.0000</defaultMaxFOV> 

 <defaultObjectType index="62" description="Mosaic 

point"></defaultObjectType> 

 <raHours colBeg="12" colEnd="23"></raHours> 

 <decDegrees colBeg="25" colEnd="36"></decDegrees> 

 <majorAxis colBeg="38" colEnd="43"></majorAxis> 

 <minorAxis colBeg="45" colEnd="50"></minorAxis> 

 <positionAngle colBeg="52" colEnd="57"></positionAngle> 

 <labelOrSearch colBeg="1" colEnd="10"></labelOrSearch> 

 <sampleColumnHeader> 

;dentifier     RA          Dec;--------- ------------ ------------

</sampleColumnHeader> 
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</TheSkyDatabaseHeader> 

Identifier     RA          Dec        Wid     Ht     PA 

---------- ------------ ------------ ------ ------ ------ 

Mp0         11.68432400   0.00000000 226.83 151.25   0.00 

Mp1         11.92194776   0.00000000 226.83 151.25   0.00 

Mp2         12.15957152   0.00000000 226.83 151.25   0.00 

Mp3         12.39719529   0.00000000 226.83 151.25   0.00 

Mp4         12.63481905   0.00000000 226.83 151.25   0.00 

Mp5         12.87244281   0.00000000 226.83 151.25   0.00 

Mp6         13.11006657   0.00000000 226.83 151.25   0.00 

Mp7         13.34769034   0.00000000 226.83 151.25   0.00 

Add SDB Header 

When the Copy Grid button is clicked, and this checkbox is turned on, the grid center positions 
are copied to the Clipboard in an XML format so that the grid can be compiled and displayed as 
a Sky Database (page 274). 

Using the Mosaic Grid 

Once a link with the telescope is established, click anywhere within one of the mosaic tiles, and 
the telescope will automatically slew to its equatorial center. 
 
If you are viewing or photographing the Moon, turning on the Follow Moon checkbox. The 
telescope’s tracking rate will automatically be set to the lunar rate. (The previous rate is restored 
when the mosaic is removed.) 
 
Although each tile is numbered sequentially, you can slew to them in any order. (If TheSkyX’s 
window is not maximized, or the field of view is too small, the numbers might not be displayed 
to avoid screen clutter.)  A selected frame’s border changes color from magenta to red, to 
indicate that is has been “visited.”  To reset each tile to its original color, click the Reset Slewed 
button.  
 
If you are using the Mosaic Grid feature to take pictures, the CCD or DSLR camera must be aligned 
with the mosaic frames. You must therefore either position the camera to align it with the Sky 
Chart, or orient the Sky Chart to the camera. TheSkyX can help you. Use Image Link to align one 
of your photographs with the Sky Chart, the “Image Link Information” gives the orientation of 
the image as an angular offset from North. You can then adjust the camera mount or the Sky 
Chart’s orientation accordingly.  
 
The Mosaic feature works best with equatorial telescopes. Azm/Alt telescopes suffer from field 
rotation, which causes the field of view to gradually rotate. The severity of this effect varies with 
the altitude coordinates of the area being photographed, and the length of time needed to 
complete the photography. A field-rotation corrector might be needed.  
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Image Link and Automated Astrometry 

 

 
TheSkyX Professional Edition’s Image Link™ and automated astrometry feature make it possible 
to overlay Flexible Image Transport System (FITS) photos on the Sky Chart.   
 
Image Link creates an “inventory” of stars and other light sources on the photo, then compares 
patterns of stars in the photo against known star catalogs to determine the photo’s astrometric 
solution (sometimes referred to as a “plate solve”).  Once a match is found, the photo can exactly 
overlay the Sky Chart – stars and galaxies in the photo match the corresponding objects on the 
Sky Chart.  
 
Image Link can be used with photos from the Digitized Sky Survey for areas of the sky of up to 
about 2° square, or on your photos up to about ten-degree fields of view. 
 
Your photos become part of the interactive Sky Chart.  Objects in the photo can be viewed, 
labeled and identified, just as if they were part of the Sky Chart. 
 
The astrometric solution can be used to precisely locate the position of variable stars, optical 
components of gamma ray bursts, supernovae, comets and asteroids.  It can also be used to 
automate calibration runs using the TPoint Add On. 

Photo Requirements 

An astrometric solution can be determined for photos with the following attributes. 
 

• A photo that adheres to the Flexible Image Transport System (FITS) standard.   

• A minimum of eight distinct stars in the photo.  

• A field of view of ten degrees or smaller.  For photos with relatively narrow fields of view 
(10-20 arcminutes), Software Bisque recommends using one of the larger star catalogs 
from TheSkyX Professional Edition Database Add On (page 637). 
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• The approximate equatorial coordinates of the photo must be known or otherwise 
available.   

o FITS photos acquired with the Camera Add On are saved with the telescope’s right 
ascension and declination and the Sky Chart is adjusted to this position when the 
photo is opened from the Image Link window.  

o The Sky Chart must be manually oriented to match the approximate position and 
field of view of the photo if the FITS header does not include the OBJCTRA and 
OBJCTDEC keywords.  Note that these keywords are automatically added to the 
FITS header when TheSkyX is connected to a telescope and the Camera Add On 
acquires the photo. 

• The approximate image scale of the photo, in arcseconds per pixel, must be known or 
computed.   

 

 

Don’t know your image scale? 
 

• The Field of View Indicator Report (page 119) shows the theoretical 
image scale for your optical setup (camera plus telescope).  While the 
theoretical image scale may exactly match the actual field of view, it is 
usually close enough for Image Link to find the astrometric solution, and 
determine the actual image scale. 

• All Sky Image Link’s Blind search option (page 334) determines the image 
scale empirically.   

• All Sky Image Link’s Search A Range of Image Scales option searches for 
solutions between a specified lower and upper image scale. 

 
The photo’s actual image scale is displayed in the Status window after a 
successful Image Link or All Sky Image Link.   

 

• Square pixels.  Determining an astrometric solution from a photo taken with cameras that 
have rectangular-shaped pixels may fail.  If your camera’s pixels are not square, make sure 
to resize the photo so that the pixels are square. 

  
Let’s use a FITS photo from the Digitized Sky Survey to demonstrate how Image Link and 
automated astrometry work together.   
 

1. On the Find tab, enter M81 and then click the Frame button.  This sets the field of view 
to about 40 arcminutes and frames M81 on the Sky Chart. 

2. Select the Digitized Sky Survey command from the Tools menu. 
3. On the Setup tab, turn on the Web option to retrieve Digitized Sky Survey photos from 

the web. 
4. On the Create Photo tab, click the Create button in the Show in FITS Viewer section.  The 

photo is downloaded from the web and displayed in the FITS Viewer window. 
5. On the FITS Viewer window, click the To Image Link command in the Photo pop-up menu.  

The photo is now displayed in the Image Link window. You’ll normally open your FITS 
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photos that are acquired from a CCD or digital camera by clicking the Open FITS button 
on the Image Link window. 

6. Click the Find Astrometric Solution button.   
 
The Astrometric Solution tab on the Image Link window shows the equatorial coordinates of the 
photo, the scale, position angle and the list of stars used in the solution.  
 

 

Figure 137: The Astrometric Solution tab of the Image Link window. 

The photo of M81 also appears on the Sky Chart at the appropriate location.  Turn on the Show 
Photo In Front of Chart Elements option to show the photo “on top of” the other chart elements. 
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Figure 138: M81 “linked” to the Sky Chart. 

The default Image Link settings can be used to perform astrometric solutions on photos acquired 
from a wide range of optical systems.  If an Image Link fails, check the following settings on the 
Setup tab of the Image Link window. 

Search Tab 

Image Link’s Search tab is used to open one or more FITS photos, configure the image scale, 
initiate the Image Link or astrometric solution, show the progress of the Image Link and define 
how the photo is displayed on the Sky Chart. 

Open FITS 

Click this button to display the Open FITS widow and select a FITS photo to Image Link.  Multiple 
photos can be selected and are Image Linked in succession.  The results of each photo’s Image 
Link are displayed in the Status text box. 
 

 

When opening a FITS photo, if the FITS header contains the photo’s equatorial 
coordinates (specifically, the OBJCTRA and OBJCTDEC keywords), or World 
Coordinate System (WCS) information, the center of the Sky Chart is automatically 
adjusted to match these coordinates.  The Sky Chart’s field of view is also changed 
to approximately match the photo’s field of view (based on the value of the image 
scale). 
 

• When TheSkyX is used to control the telescope, the FITS header in photos 
acquired with the Camera Add On use the current position of the telescope 
for the OBJCTRA and OBJCTDEC keywords. 

• If the position of the Sky Chart does not change when a FITS is opened, the 
photo’s coordinates cannot be determined from the FITS header.  In this 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 316 

case, you’ll need to manually center the Sky Chart on the approximate right 
ascension and declination of the photo to find the astrometric solution. 

 

Find Astrometric Solution 

After opening a FITS photo, and configuring the Image Scale, click this button to start searching 
for the astrometric solution. 

Abort 

The text on the Find Astrometric Solution button changes to Abort while Image Link is searching 
for the astrometric solution.  Click it to end the search.  

Unknown Scale 

When the Unknown Scale option is turned on, TheSkyX must know the approximate image scale 
of the photo.  Image Link will fail otherwise.  Make sure that the Image Scale (Best Guess) value 
is “close to” the actual scale (plus or minus two arcseconds per pixel).   
 
Image Link uses the Image Scale (Best Guess) as a starting point to find the astrometric solution 
of the photo.  If a solution is not found using this value, larger and smaller image scale values 
(based on the Scale Tolerance on the Setup tab) are used.   
 
Use the Unknown Scale option if you do not know the image scale of your optical system.  After 
the astrometric solution is found, turn on the Know Scale option and click the Set button to use 
the image scale that was computed from the astrometric solution. 

Known Scale 

When the Known Scale option is turned on, enter the actual image scale of the photo to plus or 
minus 0.5 arcseconds per pixel.  In contrast to the Unknown Scale option, the Known Scale does 
not perform an iterative search, so Image Link will always fail when the wrong Known Scale is 
used. 

Image Link Status 

The Status text box provides diagnostic feedback of the search for the astrometric solution.  
When an astrometric solution is found, the following information is displayed in the Astrometric 
Solution Results: 
 

• The equinox 2000.0 right ascension and declination of the photo’s center. 

• Image scale, in arcseconds per pixel. 

• Height and width, in pixels. 

• Angular size. 

• Position angle, measured counterclockwise from north. 

• Shows the total root mean square of the residual errors in the astrometric solution, and 
the RMS error in each axis. 

• The number of cataloged stars used in the solution. 

• The full-width, half maximum (FWHM) of the stars in the x- and y-axis. 
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For example, the solution for M81 displays the following results: 
 
******** ASTROMETRIC SOLUTION RESULTS ******** 

Center RA (2000.0): 09h 55m 22.8s 

Center Dec (2000.0): +69° 02' 49.7" 

Scale: 1.70 arcseconds/pixel 

Size (pixels): 963 x 670 

Angular Size: 0° 27' 17" x 0° 18' 59" 

Position Angle: 353° 59' from North 

RMS: 0.93 (X: 0.71 Y: 0.59) 

Number of Stars Used in Solution: 91 (98%) 

FWHM: 2.74 pixels, 4.65 arcseconds 

*********************************************** 

 

Image Link Succeeded. 

Verbose 

Turn this checkbox on to show extra information about the status of the search. 

Photo Overlay Options 

When Image Link finds the astrometric solution, the Sky Chart is adjusted to exactly match the 
field of view and the orientation of the photo (even mirrored, if necessary).  How the photo 
appears on the Sky Chart is configurable using the Photo Overlay Options. 

Show Photo 

Turn on this checkbox to show the Image Link photo on the Sky Chart.   

Percentage of Sky Chart 

This value defines the relative angular size of the photo compared to the Sky Chart’s field of view 
after a successful Image Link.  For example, a value of 75% means the Sky Chart's field of view is 
adjusted so that the resulting Image Link photo overlay occupies 75 percent of the Sky Chart. 

Show Photo In Front of Chart Elements 

Turn this option on to place the Image Link photo “on top of” the objects and symbols on the Sky 
Chart.  This hides the simulated stars and other elements on the chart. 

Show Photo behind Chart Elements 

Turn this option on to place the Image Link photo “behind” objects and symbols on the Sky Chart.  
This option reveals stars and other elements on the chart on the photo. 

Break Link 

When a photo’s astrometric solution is found, the photo is pinned or “image linked” to the Sky 
Chart so the photo becomes part of the chart.  Click this button to break the Image Link so that 
the photo is displayed in the center of the window and does not move when the position or field 
of view of the Sky Chart is changed. 

  



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 318 

Close FITS 

Click this button to break the Image Link and remove the FITS photo from the Image Link window. 

Image Link Setup Tab 

The Image Link options on this tab should be used to configure Image Link settings. 

Search Radius 

This value defines how far “away” from the Sky Chart’s current coordinates Image Link will search 
for a matching star field and is based on the photo’s field of view. 
 
When the FITS header includes World-Coordinate System information, or the telescope’s 
coordinates when the photo was acquired, the Sky Chart is automatically centered at these 
coordinates when the photo is opened in the Search tab.  Provided these coordinates are 
accurate, Image Link should not need to search the nearby region more than 2 fields of view to 
locate a match. 
 
If the telescope’s coordinates do not match the photo’s actual position (due to inherent pointing 
errors, for example), then Image Link can be configured to search a region up to 8 field of view 
from the current Sky Chart position to find a match. 
 
When the photo’s coordinates are not known, if possible, be sure to manually center the Sky 
Chart as close to the photo’s actual position on the celestial sphere as possible before attempting 
an Image Link.    If the photo contains an unidentifiable star field, use All Sky Image Link (page 
332) instead of Image Link. 

Scale Tolerance 

Image Link needs to know the image scale, in arcseconds per pixel, of the imaging system that 
produced the photo.  If you’re unsure of the exact image scale, enter a higher value for the scale 
tolerance.  Doing so allows Image Link to locate matches by varying the Image Scale entered on 
the Search tab. 
 
If you have no idea about the photo’s image scale, use image scale helper options below, or All 
Sky Image Link (page 332) to determine it for you. 

Type of Animation 

The Sky Chart can be configured to animate a successful image link.   
 

• None produces no animation. 

• Overshoot zooms and rotates the Sky Chart slightly past the image link position before 
matching the Sky Chart to the photo. 

• Zoom and Rotate Separately zooms and rotates the Sky Chart when aligning the Sky Chart 
to the photo. 
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Image Scale Helper 

These options can be helpful to determine the approximate image scale of your camera and 
optical system. 

Field of View Indicators Button 

Click this button to show the Field of View Indicators window (page 119), and, if you have not 
already done so, create a FOVI based on your equipment. 

FOVI Pop-Up 

This pop-up menu lists all of the available FOVIs.  Choose the description that best matches your 
setup. 

Get Image Scale From Field of View Indicator 

Click this button to retrieve the select FOVI’s image scale and update the Image Scale text box on 
the Search tab with this value. 

Source Extraction 

Source Extractor is a powerful photo analysis tool that finds, measures and catalogs the sources 
of light (stars, extended objects like nebulas, asteroids, etc.) in photos. 

Setup 

Click this button to show the Source Extraction Setup window with the configuration settings for 
this tool. 
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Figure 139: The Source Extraction Setup window. 

Generally, the only two settings that need to be adjusted are the values for the Detection 
Threshold and/or the Minimum Number of Pixels Above Threshold.  Each is described below. 
 

Detection Threshold 

The Detection Threshold can range from 1.0 up to 50.0.  Smaller values detect more light sources 
in the photo, larger values detect fewer light sources.  If the Detection Threshold too small, then 
potentially too many light sources, or light sources that are actually noise can be detected, and 
will cause the astrometric solution to fail. 
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Source Extraction settings are saved to different text files, based on the current task, in the 
Application Support Files folder (page 27).   
 

• default.sxt contains the default Source Extraction parameters.  Click the Restore Defaults 
button to restore the default settings. 

• DSS.sxt contains the Source Extraction parameters that work well for FITS photos from 
the Digitized Sky Survey. 

• AutomatedPointingRun.sxt contains the Source Extraction parameters that are used to 
find the inventory on photos acquired during an automated pointing calibration run. 

 
The current source extraction text file name appears in the window’s caption. 
 
Minimum Number of Pixels Above Threshold 
The Minimum Number of Pixels Above Threshold is the number of “pixel counts” above the 
background (or black point) that a light source must be to be detected.  Increase this value by 
increments of 5 or so until the astrometric solution is found. 
 
Advanced users can read Source Extractor for Dummies by Dr. Benne W. Holwerda of the Space 
Telescope Science Institute for a technical explanation of each source extraction parameter. 

Light Source Data Tab 

The Light Source Data tab on the right side of the Image Link window shows a preview of the 
currently open FITS photo. 

Show Light Sources 

Turn this checkbox on to show the inventory of stars and other light sources on the photo after 
the Find Astrometric Solution button is clicked.  Light sources are shown with green circles. 

Show Astrometric Stars 

Turn this checkbox on to show purple circles that represent the known cataloged stars used in 
the astrometric solution. 

Astrometric Solution Tab 

The table on the Astrometric Solution tab shows the details of the astrometric solution. 
 

http://astroa.physics.metu.edu.tr/MANUALS/sextractor/
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Figure 140: The Astrometric Solution tab. 

Center RA and Dec 

Shows the Equinox 2000 coordinates of the center of the photo. 

Scale 

Shows the image scale of the photo, in arcseconds per pixel. 

Position Angle 

Shows the photo’s position angle, measured counterclockwise from north. 

RMS 

Shows the total root mean square of the residual errors in the astrometric solution, and the RMS 
error in each axis immediately below. 

Number of Stars Used In Solution 

Shows the number of cataloged stars that we used in the astrometric solution. 
 
Each row in the table represents a known or cataloged star that was used in the astrometric 
solution.  The table below describes each column in the report. 
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Column Name Description 

Used? The word Yes in this column indicates this star was used in 
the solution.  No means the star was rejected because the 
residual error was greater than the Residual Filter value. 

Star The astronomical catalog of the known star. 

Position Error The error in the position of the cataloged star’s 
coordinates. 

Eq Coords The Equinox 2000 coordinates of the cataloged star. 

Photo X The x-axis position of the cataloged star on the photo. 

Photo Y  The y-axis position of the cataloged star on the photo. 

Residual The amount by which the position of the star in the photo 
differs from the cataloged position. 

Residual Filter 

Enter the value of the maximum residual error that is permissible to use a given star in the 
astrometric solution. 

Update Results 

Click this button to update the astrometric solution table based on the value of the Residual 
Filter. 

FOVI Options Tab 

A Field of View Indicator can be generated automatically from a successful Image Link photo. 

Current Image Link Photo 

Use these options to generate a FOVI from the Image Link photo. 

FOVI Description 

Enter the description of the FOVI that will appear beneath it on the Sky Chart. 

Create FOVI from Scale and Position Angle 

Click this button to generate a FOVI based on the Image Link photo, and add the FOVI to the list 
of My FOVIs (page 119). 

Synchronize Rotator Angle to Position Angle 

Click this button to synchronize the rotator’s current angle to the position angle of the Image Link 
photo. 

Rotate FOVIs to Computed Position Angle 

When this checkbox is turned on, the position angle of all field of view indicators is updated to 
match the Image Link’s position angle.  Forcing the FOVI’s position angle to always match the 
position angle of a photo can be useful when manually rotating the imaging camera to place an 
appropriate guide star on an on-axis guider. 
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Troubleshooting Image Link Failures 

While Image Link and All Sky Image Link are extremely powerful astrometric search engines that 
work on a wide range of photos, there are several different parameters that can affect the 
success or failure of the astrometric solution.  The common causes of, and solutions to Image 
Link and All Sky Image Link (page 332) failure are described below. 

Examine your Photo 

When a photo does not meet the minimum requirements (page 312), Image Link will most likely 
fail.  While this may seem obvious, a good first step is to look carefully at the photo that fails and 
manually count the number of distinct star stars that are visible.  If there are fewer than ten or 
so “clearly distinguishable” stars on the photo, Image Link is going to have a difficult time 
matching these few stars to actual stars in the field.   

Verify the Image Scale 

One of the most common reasons for Image Link failure is when the wrong image scale is used.  
While Image Link attempts to find the image scale based on a “best guess”, if the guess is off by 
a factor of two, for example, the link will most likely fail.  Likewise, setting a known scale to the 
incorrect value will always result in Image Link failure. 
 
Remember that binned photos change the image scale by the bin factor (page 528).  For example, 
if your optical system produces photos that have an image scale of 1 arcsecond per pixel when 
the camera is binned 1x1, then the image scale of a photo that is acquired at 2x2 binning would 
be 2 arcseconds per pixel, and 3 arcseconds per pixel at 3x3 binning.    
 
To avoid failures, be sure to change the Image Scale parameter based on the photo’s binning. 

Check the Source Extraction Parameters  

If you are confident the photo has sufficient stars, and the image scale is correct, another 
troubleshooting step is to review the Source Extraction Setup parameters.     
 
If your wide-field photo contains too many light sources (photos in the Milky Way, for example 
can have thousands, or tens of thousands of stars), or, alternatively, has a poor signal to noise 
ratio (from a short exposure), you’ll want to try altering two Source Extractor parameters 
accordingly to achieve a successful astrometric solution.  In other words, if there are too many 
light sources, increase the Detection Threshold so that fewer stars are used on the astrometric 
solution.  If there is an insufficient number light sources, decrease the Detection Threshold until 
a sufficient number is found. 
 
Typically, the Detection Threshold is the only setting that needs to be adjusted to allow a 
successful astrometric solution.   
 
If an astrometric solution fails for a photo, or for all the photos obtained your imaging system, 
then altering the Detection Threshold is usually the solution. 
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If changing the Detection Threshold over a range of values fails to find a solution, the next, not 
normally necessary, step is to change is the Minimum Number of Pixels Above Threshold. 
 
Here are a few examples of how modifying the Detection Threshold parameter can affect the 
astrometric solution. 

Check the Telescope Coordinates in the FITS Header 

When TheSkyX takes a photo, and is also connected to a telescope, the telescope’s right 
ascension and declination (equinox 2000.0) are saved in the FITS header using the SBIG FITS 
Extension OBJRA and OBJDEC keywords.   

 
When the FITS photo is opened from the Image Link window, the Sky Chart is automatically 
centered at this position.  From here, clicking the Find Astrometric Solution button begins a 
search for the cataloged stars that match the stars in the photo, starting from the equatorial 
coordinates of the Sky Chart’s center. 
 
If the equinox 2000.0 coordinates of the telescope are wrong, Image Link, which searches a small 
region around the Sky Chart’s current center position, will most likely fail.  
 
The File Information tab on the FITS Viewer window shows the FITS header.  If Image Link fails 
for a photo, make sure the right ascension and declination (equinox 2000.0) in the header are 
close to the coordinates of the object in the photo.   
 
For example, the equinox 2000.0 coordinates in the FITS header for a photo of M51 should be 
close to 13h 29m 53s, +47° 11' 44".  If not, the telescope was most likely not properly initialized 
when the photo was acquired.  So, attempting an Image Link using this photo will fail without 
manually centering the Sky Chart near M51 will fail.  Another workaround is to edit the FITS 
header with the correct object coordinates. 
 
If you suspect that incorrect telescope coordinates are causing Image Link to fail, use All Sky 
Image Link to determine the astrometric solution.  All Sky Image Link does not use the OBJRA 
and OBJDEC keywords to determine the photo’s position, and searches the entire celestial 
sphere for a match instead. 

Check the All Sky Image Link Crop Options 

For photos acquired with a camera that has more than 2500 pixels in one dimension, to speed 
searches, All Sky Image Link automatically crops the photo (see the All Sky Image Link Crop 
Settings under “Advanced Preferences” on page 225 to configure this option).   
 
If a photo acquired with a large format camera has few stars in it, or a very poor signal to noise 
ratio, the All Sky Image Link crop process can result in "not enough stars" being found.   
 
If your camera has more than 2500 pixels in either dimension, and All Sky Image Link fails, 
increase the default crop size to 80 percent or so and try All Sky Image Link again. 
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Example Image Link Photos  

The photos below were submitted to Software Bisque because Image Link failed. 

Example 1 

 

Figure 141: Photo with satellite trail. 

The above photo has a satellite passing through it.  Setting the Detection Threshold to 1, and 
then clicking the Light Sources button on the Image Link Setup tab shows the light sources in the 
photo. 
 

 

Figure 142: A “poor” inventory of light sources. 

What’s wrong here? When the Detection Threshold at set to 1, the streak is misidentified as a 
series of non-existent light sources.  These “stars” are then used in the astrometric solution, and, 
Image Link fails because these light sources do not actually exist. 
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Figure 143: "Correct" inventory. 

Changing the Detection Threshold parameter from 5 to 10, shows no stars detected in the 
“streak” and only true “stars” are identified. 
 
Note: Even though an astrometric solution can be found using this photo, it is a very poor photo 
for many reasons. It has very bad signal to noise ratio (the dynamic range is 65 counts out of a 
possible 65535), and it is also “deficient” in stars (about 6 are “inventoried”). A longer exposure 
is highly recommended for photos like this.  
 

Example 2 

This photo also reveals the importance of the Detection Threshold setting. 
 

 

Figure 144: Sample image. 

The above photo contains relatively good signal and has many “well-defined” stars. However, 
notice how the nebulosity in the upper left affects the inventory using different Detection 
Threshold values. 
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Figure 145: Note the incorrectly identified "stars" in the upper left corner. 

A Detection Threshold setting of 6 identifies stars in the nebula that do not exist, and causes the 
astrometric solution to fail. 
 

 

Figure 146: Changing the detection threshold correctly identifies stars in the nebula. 

 
A Detection Threshold setting of 30 correctly identifies the stars in the nebula.  Image Link is now 
successful. 
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Example 3 

 

Figure 147: Poor signal-to-noise ratio, poor focus and poor tracking make this a very poor candidate for an astrometric 
solution. 

At first glance, image in Figure 147 may appear to be a good candidate.  Upon closer inspection, 
the image “falls apart”. 
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Figure 148: Histogram shows poor signal in the photo. 

The histogram shows that there is very little actual signal.  The default background and range 
settings differ by hundreds of counts using camera that has a much larger dynamic range (16-bit, 
or a total of 65,355 counts).  Increasing the exposure time ensures better a signal-to-noise ratio. 
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Figure 149: Same image after adjusting the range or "white point" 

After increasing the range (that is, increasing the “white point” in the image), another very 
important deficiency is revealed, specifically that the image is way out of focus. Notice the donut-
looking stars.  
 

 

Figure 150: Two light sources (indicated by the two red circles) are detected for each “out of focus” stars. 

The Show Inventory command, using a detection threshold of 10, reveals that several of the out 
of focus stars are identified as two separate light sources (stars), instead of just one!  When 
multiple light sources are detected for a single star, the astrometric solution will almost certainly 
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fail.  The solution is to adjust focus until the light coming from a point source is recorded correctly.  
Consider using @Focus (page 572) to achieve optimal focus. 

All Sky Image Link 

 
 
NASA’s moniker for a technique satellites use to determine their orientation is “lost in space”.  
To determine its orientation, the satellite acquires a photo of a star field, any star field, then 
matches the stars in the photo with the known positions of stars in astronomical databases.  Once 
the photo’s location on the celestial sphere is known, the satellite’s orientation in space can also 
be determined. 
 
All Sky Image Link applies a similar “lost in space” process to help initializing, calibrating, polar 
aligning, and precisely pointing (using the “Closed Loop Slew” feature, page 382) earth-based 
telescopes.  Anyone who has ever tried to setup a telescope, especially one with a DLSR, video 
or CCD camera attached, knows that one of the most difficult tasks is finding or placing that very 
first star in the eyepiece, or on the detector so that the telescope’s control system can be aligned 
with this position.   
 
Once an uninitialized telescope acquires a FITS photo, anywhere on the celestial sphere, All Sky 
Image Link can find the photo’s astrometric solution (a.k.a. “plate solution”).  The astrometric 
solution is also saved to the FITS header using the World-Coordinate System (WCS) so that the 
equatorial coordinates of every pixel on the photo is known.  This information can be used for 
the initial control system synchronization, or to calibrate the mount. 
 
The optional TPoint Add On’s Automated Pointing Calibration feature automates the process of 
choosing a target to photograph, slewing the telescope to the target, acquiring a photo, 
determining the astrometric solution, and adding this information to the pointing calibration data 
set.  Choose the TPoint Add On User Guide command from the Help menu and search the PDF 
document for more information. 

All Sky Image Link Requirements 

• The Camera Add On and a supported camera to acquire FITS photos. 

• An optical system that produces a minimum field of view of 10 arcminutes for the smaller 
dimension.  See “Advanced Preferences” on page 225 to configure All Sky Image Link for large 
format photos, or photos with 3-degree fields of view and wider. 

• All Sky Image Link can be configured to search a range of image scales if it is not known.  Once 
the image scale is determined, subsequent All Image Sky Image Links are significantly faster. 

Using All Sky Image Link 

All Sky Image Link operates performs similar functionality as Image Link (see “Image Link and 
Automated Astrometry” on page 312).  Image Link requires an approximate or “best guess” image 
scale and the approximate equatorial coordinates of the photo so that is can search a small region 
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of the sky to locate a pattern match between the stars in the photo and the actual stars.  All Sky 
Image Link searches the entire celestial sphere to match the star patterns in your photo. 

All Sky Image Link Database 

To perform an All Sky Image Link, the 1.8 GB “All Sky Image Link Database” named 10-180.allsky 
must be present on the computer.  This database contains millions of known star patterns for 
fields of view between 10 and 180 arcminutes. 

Installing the All Sky Image Link Database 

Due to its large size, the All Sky Image Link Database is distributed as a separate download.  The 
procedure below describes how to download and save this file to your computer. 
 

1. Click the Image Link command from the Tools menu. 
2. On the All Sky tab, click the Download the All Sky Image Link Database link at the top of 

the window to download and save the All Sky Image Link Database archive, named 10-
180.zip.  Note that you must be signed in to the Software Bisque web page, and have a 
registered TheSkyX Professional Edition serial number with an active subscription to 
access this resource.  Download access will be denied otherwise. 

3. Unzip or extract the file named 10-180.allsky from 10-180.zip and save it to the 
Astrometry folder in the “Application Support Files” folder (see page 26 for details about 
the location of this folder on your operating system).  

 
Once the All Sky Image Link Database has been copied to your computer, you are ready to 
perform an All Sky Image Link. 
 

1. Choose the Image Link command from the Tools menu. 
2. Click the Open FITS button on the All Sky tab of the Image Link window. 
3. Navigate to the folder on your computer where the photo resides, highlight it, and then 

click the Open button.   
4. Configure the All Sky Image Link options described below, and click the Find All Sky Image 

Link. 
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Figure 151: Successful All Sky Image Link using a photo with a limited star field. 

Download the All Sky Image Link Database 

When visible, click this link to open a browser on the All Sky Image Link Database download page.   
 
The URL to this page is: http://www.bisque.com/allskydownload.  You must be signed in to the 
Software Bisque web page, and have a registered TheSkyX Professional Edition serial number with 
an active subscription to access this resource. 

Open FITS 

Click this button to open the FITS photo on which to perform an All Sky Image Link. 

All Sky Search 

Click this button to begin searching the entire celestial sphere (or, the visible declinations, when 
the Search Visible Declinations Only checkbox is turned on) for an Image Link.  Depending on the 
size of the photo, and the search parameters below, the search time can be from a few seconds, 
to a minute or more. The button text changes to Abort so that the process can be stopped if 
needed. 

Blind 

Turn this option on if you do not know the image scale, in arcseconds per pixel, for the photo.   

http://www.bisque.com/allskydownload
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Minimum/Maximum Scale 

When the Blind option is selected, enter the range of image scales to use during the all sky 
image link search.  All Sky Image Link starts with the lower image scale, performs an all sky 
search, and when no match is found, increments the image scale and continues this process, 
up to the maximum image scale, or until a match is found. 
 
The above process can be very time consuming, so please be patient.  Once the image scale 
has been found for optical configuration, use the Known Image Scale option to speed 
searches. 

Use Known Image Scale 

Use this option when you know the image scale of the photo to minimize the time it takes to find 
an All Sky Image Link. 

Image Scale 

Enter the image scale for the photo, in arcseconds per pixel. 

Image Scale Tolerance 

For best results, the image scale of the photo should be accurate to within a few hundredths 
of its actual value.  In practice, determining image scale this accurately without Image Link 
can be difficult.  Setting a larger Image Scale Tolerance, specified as a percentage of the 
photo’s image scale, can help find the astrometric solution when only the approximate image 
scale is known. 

Search a Range of Image Scales 

If you’re unsure of your imaging system’s image scale, use this option to specify a range of image 
scales to search to find the Image Link. 

Image Scale Search Range 

Enter the Minimum and Maximum image scales, in arcseconds per pixel, to search. 

Mirror Option 

Choose the appropriate option for your telescope.  The time required to find a matching star 
patterns in photos with the patterns of cataloged stars can be greatly reduced if you know 
whether the photos generated by your optical system are mirrored. 

Photo is Not Mirrored 

Choose this option if photos produced by your optical system (telescope, camera, focal 
reducer, etc.) are not mirrored. 

Photo is Mirrored 

Choose this option if photos produced by your optical system (telescope, camera, focal 
reducer, etc.) are mirrored. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 336 

Unknown or Not Sure 

Choose this option if you are unsure or do not know the details of the optical system that was 
used to produce the photo. 

Search Visible Declinations Only 

When this checkbox is turned on, All Sky Image Link determines the lowest visible declination 
based on TheSkyX’s current latitude settings (page 33), and then only searches at or above this 
declination to speed up all sky searches.   

Use All Sky Image Link for Automated Pointing Runs 

Turn this checkbox on to use All Sky Image Link instead of Image Link during automated pointing 
calibration runs.  This can be use helpful for portable setups, before the polar alignment is  

Status  

This text box provides status of the search and reports the astrometric solution results when 
successful (see Figure 151). 

Show Light Sources 

Turn this checkbox on to show the inventory of stars and other light sources on the photo after 
the Find All Sky Image Link button is clicked.  Light sources are shown as green circles. 

Show Astrometric Stars 

Turn this checkbox on to show purple circles that represent the known cataloged stars used in 
the astrometric solution. 

Differences between Image Link and All Sky Image Link  

Understanding the minor differences between how Image Link and All Sky Image Link work can 
be helpful to troubleshoot failures using either method.  

Image Link Specifics 

• Image Link uses the RA/Dec coordinates from the FITS header's OBJCTRA and the 
OBJCDEC keywords for the approximate locate of the photo on the celestial sphere, and 
then searches a relatively small region around these coordinates to find the astrometric 
solution.   

• When the RA/Dec of the photo is available, the Sky Chart is automatically centered on 
these coordinates once the Image Link search is started.  If the angular separation 
between the RA/Dec in the FITS header compared to the actual coordinates is "relatively 
large", then Image Link can fail. 

• The OBJCTRA and the OBJCDEC coordinates in FITS photos are obtained from the 
telescope's current position (where the telescope “thinks” it is pointing.  If the telescope's 
position is not correct (which can be the result of poor polar alignment, pointing errors, 
improper synchronization, etc.), then the OBJCTRA and the OBJCDEC coordinates in the 
FITS header do not match the actual coordinates of the photo.   
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• If the FITS header does not contain RA/Dec information, you must manually adjust the 
position of the Sky Chart for Image Link to be successful.   

All Sky Image Link Specifics  

• All Sky Image Link does not use the RA/Dec from the FITS keywords to obtain the photo's 
coordinates, it searches the entire celestial sphere for stars that match the inventory of 
stars in the photo instead.  

• After a successful All Sky Image Link, the RA/Dec center of the Sky Chart is changed to 
match the photo’s RA/Dec.  
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Imaging System Setup 

 
 
Use the Imaging System Setup window to configure the hardware-specific settings and 
preferences for the following devices: 
 

• Mount 

• Focuser 

• Camera  

• Dome 

• Filter Wheel 

• Rotator 

• Video Device 

• Autoguider Camera 

• Autoguider Filter Wheel 

• Autoguider Video Device 
 

 

Figure 152: The Imaging System Setup window. 

The left side of the Imaging System Setup window lists the devices that make up your imaging 
system.  Note that this list may be incomplete compared to the above list if you do not own all 
the Add Ons. 
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To configure TheSkyX Professional Edition to use a device, either double-click its name in the list, 
or highlight the name by clicking once, then click the Choose command from the <Device Name 
Here> Setup pop-up menu (where <Device Name Here> is the name of the device).  The list of 
supported devices appears on the Choose <Device Name Here> window.   
 
For example, to use the SBIG ST-2000M model camera, highlight it in the list, and then click OK. 
 

 

Figure 153: The Choose Camera window. 

This same procedure can be used to choose each device in your system.  Once a device is selected, 
the right side of the Imaging System Setup window reveals hardware and driver information, and 
other options that are particular to that device.   
 
These settings are saved automatically as they’re made, to the profile named 
imagingsystem.ini (page 27) and the caption of the Imaging System Setup window shows 
the name of the current profile in use. 

Imaging System Profiles 

An imaging system profile represents a snapshot of all the hardware and hardware-specific 
settings related to one imaging system.  Multiple imaging systems can be saved and opened using 
the buttons located at the lower left of the Imaging System Setup window. 
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New Profile 

Click this button to restore all the hardware to “none selected” with default settings so that you 
can “start from scratch” setting up a new imaging system. 
 

Open Profile 

Click this button to choose an existing profile. 
 

Save Profile As 

Click this button to save the existing profile’s settings using a name other than the default name 
(imagingsystem.ini). 
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Telescope Control 

 
TheSkyX can control many go to and computer-aided (or “push to”) telescope mounts. 
 

 

NEVER attempt to observe the Sun through your telescope!  
Without a specially designed solar filter, viewing the Sun – for 
even a fraction of a second – will cause instant, irreversible eye 
damage.  When observing during the day, do not point the 
telescope near the Sun.  Do not use TheSkyX Professional Edition’s 
automatic slew feature to find objects during the day.   
 
Children should never use a telescope during the daytime without 
strict adult supervision. 
 

Telescopes with Optical Encoders (Push To) 

If your telescope is equipped with optical encoders, TheSkyX can show and track its position with 
the aid of a “serial interface box”.  The encoders read the rotation of the telescope’s axes, and 
return numbers that represent how much they moved. The following serial interface boxes are 
compatible with TheSkyX. 
 

• AB Engineering 

• BBox (Software Bisque) 

• NGC-MAX (JMI)   

• NGC Sky Commander (Lumicon)  

• Sky Commander (SkyComm Engineering)  

• Sky Wizard 3 (Lumicon)  

• Sky Tour (Tele Vue)  

• SkyQuest IntelliScope Computerized Object Locator (Orion Telescopes & Binoculars) 
 
Jim’s Mobile, Inc. (www.jimsmobile.com) is a good source to purchase software-guided telescope 
(SGT) hardware.  

http://www.jimsmobile.com/
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Telescopes with Go To Control 

TheSkyX comes with native telescope drivers that can send positioning and other commands to 
the following “go to” telescope systems. 
 

• Astro-Physics GTO mounts (all models)  

• Celestron™ Advanced Series (all models)  

• Celestron™ NexStar (all models)  

• Celestron™ CG Series (all models)  

• Celestron™ CGE Series (all models)  

• Celestron™ CPS Series (all models)  

• Celestron™ GT Series  

• Celestron™ SLT Series (all models)  

• Celestron™ NexStar i Series (all models)  

• Celestron™ Ultima 2000™ telescopes* 

• Gemini Telescope Positioning System (Losmandy and MI-250)  

• iOptron™ SmartStar™ Series 

• Meade™ LX200™ (Classic) Telescopes 

• Meade™ LX200™ 16-inch (Classic) Telescopes 

• Meade™ Autostar (classic) telescopes 

• Meade™ Autostar II (LX200 GPS) Telescopes and Mounts 

• Meade™ Autostar III Telescopes and Mounts  

• Orion® Telescopes & Binoculars Atlas™ EQ-G Equatorial Mounts and Sirius™ EQ-G 
Equatorial Mounts  

• SkyWatcher mounts using the SynScan Controller 

• StellarCAT™ Computer Assisted Telescope Innovations 

• Takahashi™ Temma mounts (all go to models)  

• Vixen™ Sphinx™ and Sphinx Deluxe mounts 
 

* The Celestron Ultima 2000 telescope is considered a “legacy mount” since so few of them are 
still in use.  While TheSkyX includes a driver for the Ultima 2000, we no longer provide technical 
support for this mount.  Sorry for any inconvenience.  
 
In addition, TheSkyX can simulate a telescope link.  You can experiment without actually having 
a telescope connected.  
 
Whether your telescope has optical encoders, or computer control, the Sky Chart tracks the 
telescope’s position.  In addition, TheSkyX can command “go to” telescope systems.  Select an 
object from TheSkyX’s database and it will point the telescope at it. 
 
All systems using optical encoders are set up the same way and are explained below in a single 
section.  Computer-controlled telescopes are each set up slightly differently.  
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X2 and Third-Party Telescope Drivers 

TheSkyX Professional Edition and TheSkyX Serious Astronomer Edition can control telescopes 
using third-party telescope drivers with the X2 Driver Standard (see “Appendix G: TheSkyX Pro 
Device Driver Architecture” on page 659). 

Setting the Correct Time 

Computer-controlled drive systems typically have an internal clock that must be set with high 
accuracy.  (Encoder-based systems do not need as high degree of accuracy.)  The best method 
for keeping accurate time on your computer is to use an Internet time server.  Most modern 
operating systems include time synchronization as part of their Date & Time settings.   

Night Vision Mode 

 
Selecting the Night Vision Mode command from the Display menu (or clicking the Night Vision 
button) redraws the display in red to minimize loss of dark adaptation.   
 
On the Mac, turning on Night Vision Mode will show the entire desktop, and all other applications 
that are running, red.  Turning off Night Vision Mode, or exiting TheSkyX restores the screen 
colors. 
 
Under Windows, by default, turning on Night Vision Mode reddens only TheSkyX’s main window.  
To change the color of the desktop, you must configure TheSkyX to use a Windows Theme.  See 
the “Night Vision Setup (Display Menu)” below for details. 
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Night Vision Setup (Display Menu) 

 
TheSkyX for Windows allows you to change screen elements or both screen elements and the 
Windows theme to red.  (You can learn more about Windows Themes by searching Windows 
help.)  Each method has advantages and disadvantages.  Together they can provide an effective 
way to minimize screen brightness that should satisfy even the most discriminating astronomer. 
 
The Night Vision Setup window lets you configure how colors are changed when entering and 
exiting Night Vision Mode. 
 

 

Figure 154: Night Vision Setup window (Night Vision Setup command, Display menu, Windows OS only). 

When the Change Windows Desktop Theme checkbox is off, and the Night Vision Mode button 
clicked on, TheSkyX’s screen changes to red. 
 
Note that when the Change Windows Desktop Theme checkbox is turned off, the options to set 
theme names are disabled.  
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Figure 155: Sample Night Vision Mode Screen using the standard Windows Desktop Theme. 

When the Change Windows Desktop Theme checkbox is on and the Night Vision Mode button 
is clicked on, the selected Night Vision Mode Theme File Name is loaded.   
 
Themes are changed automatically under Windows 7, 8 and 10.  

Night Vision Mode Theme File Name 

Click the Choose button to select the theme file name to load when Night Vision Mode is turned 
on. 

Standard Windows Theme File Name 

Click the Choose button to select the theme file name to load when Night Vision Mode is turned 
off.   
 
Before you can choose a theme file name, you save one to your hard drive.   

Saving a Theme File (Windows 7 and 8) 

1. Click Start > Control Panel. 
2. Click the Change the Theme link under Appearance and Personalization. 
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3. Under the Change the Visuals and Sounds on your Computer window, select the desired 
theme.  The easiest way to save a theme file under Windows 7 is to modify an existing theme, 
then save it.  (There’s no other obvious way just save a “supplied” theme.)  For example, after 
selecting a theme to use, click the Window Color icon at the bottom of this window and then 
modify the color’s intensity before clicking the Save Changes button.  The now “modified” 
theme appears in My Themes. 

4. Right-click the modified theme, then click the Save Theme for Sharing command. 
5. Enter a name for the “theme pack file” (.themepack), such as My Theme, and then click OK.  

The Windows 7 default location to save themes is the Libraries > Documents folder.  
Remember this folder name. 

Windows 7 Starter Edition and Themes 

If you are using a Netbook computer, chances are it runs Window 7 Starter Edition.  Windows 
themes on this “streamlined” operating system are very limited and cannot be saved to a file, or 
restored from a file.  These limitations make TheSkyX’s Night Vision Mode less than ideal.  To best 
preserve dark adaptation when using Windows 7 Starter Edition, we recommend covering the 
computer screen with a sheet of red velum, which is available at most hobby stores. 
 
Once you’ve saved the theme file, to select it in Night Vision Setup window, click the Choose 
button next to the Standard Windows Theme File Name, then navigate to the folder where the 
file resides, and double-click the theme pack name.  TheSkyX will now load this theme when 
exiting Night Vision Mode. 

Setting Up and Using Push To Telescope Systems 

Other than the encoders and their interface box, the extra hardware required includes a standard 
serial (RS232) cable to connect the interface to your computer and a USB to serial adaptor. The 
serial cable is usually supplied with the encoder system; USB to serial adaptors can be purchased 
at almost any computer store.  Make the appropriate connections from the encoders to the 
interface box, and the box to your computer.  

Configuring the Hardware 

You are now ready to configure the hardware. 
 
Select the Telescope Setup command from the Telescope menu.  The Telescope Setup window is 
displayed.  
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Figure 156: The Imaging System Setup window. 

1. From the Mount pop-up, click the Select Mount button. On the Select Mount 
window, select SGT.  Or select the name of your serial interface box, if it’s listed then 
click OK. 

2. Click Settings.  The Telescope Settings window appears. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 349 

 

Figure 157: The SGT Settings window. 

Click the Serial Port button to select the serial port to which the interface is 
connected.  All telescope serial interface boxes use RS232 serial communication. Since 
most modern computers are not equipped with a serial port, you’ll most likely need 
to purchase a USB to serial adaptor to convert a USB port into a serial port.  Follow 
the manufacturer’s instructions for installing the software drivers for this hardware.  
On the Mac, choose the port that contains the manufacturer of your USB to serial 
adaptor’s name.  On Windows, use the Device Manager to determine the 
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communications port number (COM number) for the adaptor, and enter “COMN”, 
when “N” is the number of the port reported by the Device Manager. 

3. Select your telescope model from the Telescope pop-up menu.  If it isn’t listed, choose 
the CUSTOM option.  The number of encoder tics per revolution for the selected 
telescope is displayed in the Encoders text boxes to the right. If your telescope isn’t 
listed, don’t worry.  Just manually enter the correct values in the Encoders edit boxes.  
If you don’t know these values, contact the manufacturer. 

4. Enter the same values in the Tics/Rev text boxes.  The RA and Dec values are 
sometimes different. Don’t switch them. If you own version 1.7 through 1.99 of the 
BBox, or version 2.93 through 3.49 of NGC-MAX, enter 32768 for both axes. 

5. Set the Clockwise/Counterclockwise options for Azimuth and Altitude Direction.  If 
you aren’t sure which way the encoders are supposed to be mounted, contact the 
manufacturer.  Or continue with the setup, and see which way the cross hairs move 
when you link the telescope and computer.   If the cross hairs move in the wrong 
direction, you’ve selected the wrong direction. 

6. Click the Configure Device button.  This step applies only if you own a BBox, version 
1.7 (or later).  If not, skip to the next step. The BBox is automatically configured for 
the selected number of encoder tics. If you get the message “Cannot configure BBox,” 
try again. If you still cannot configure the box, please refer to the “Troubleshooting” 
section on page 398.  This step need be done only once, as the interface box stores 
the configuration in non-volatile memory.   

7. Click Close to save the configuration. 

Aligning the Encoders 

TheSkyX is now configured to communicate with the encoders.  The next step is to align the 
encoders by aiming the telescope at specific stars.  This gives TheSkyX the information it needs 
to calculate where the telescope is pointing. 
 
Any two stars that are visible from your location can be used during the alignment procedure.  
 

1. After your telescope is setup, select the Connect command from the Telescope menu to 
show the SGT Alignment window. 

2. Click the Start Alignment button.  If your telescope is mounted equatorially (that is, the 
RA axis is pointing to the celestial pole), point it at declination 90°, by default.  Choose a 
different declination (or azimuth) from the Point Scope At pop-up menu if your telescope 
cannot be pointed at 90°. 

3. If your telescope has an azimuth/altitude mounting, point it at 90° altitude.  Specifically, 
you’re looking for the telescope position where rotation in right ascension (or azimuth) 
causes no rotation in declination (or altitude). The default angle is 90°.   

4. Point the telescope at the first alignment star.  The default first-alignment star is Polaris. 
To use a different star, use the Find command to locate the star (or just click on it in the 
Sky Chart).  Then click Align On in the Telescope sheet of Object Information window. 

5. Point the telescope at the second alignment star.  The default second-alignment star is 
Capella. To use a different star, use the Find command to locate the star (or just click on 
it in the Sky Chart). Then click Align On in the Object Information window.  The difference 
between the actual angular separation of the alignment stars and the angle measured by 
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the encoders is displayed. A difference of zero indicates a “perfect” alignment.  
Experience shows that a difference of 1 degree or less is acceptable. If the difference is 
substantially greater, you should try pointing to two different stars. 

6. Click Accept Alignment.  The alignment is complete. You should see cross hairs in the Sky 
Chart, marking the approximate center of the field of view of the telescope. 

 
As you move the telescope, the cross hairs move to show where the telescope is pointing. As the 
cross hairs reach the edge of the screen, the Sky Chart automatically scrolls to keep the cross 
hairs visible.  
 
The Connect button on the toolbar is “down” to show the telescope link is active.  

Selecting Alignment Stars 

If you can choose different alignment stars, don’t pick closely spaced ones.  The greater the 
angular separation of the alignment stars (in both right ascension and declination), the more 
errors inherent to the system are “averaged out” across the sky. 

Realignment with Each Use 

TheSkyX has no provision for saving alignment settings because you must align the telescope each 
time you use it, even when observing from the same location.  

Mount and Status 

When Mount is highlighted in the Imaging System list, the name of the selected mount driver is 
displayed on the top, right side of the Imaging System window.  The Status of the connection is 
shown below it.  Common status messages include the following.  Green-colored text indicates 
normal operation; red indicates either no communication, or a communication failure. 
 

Status Text Description 

Not Connected The red text indicates there is no connection between TheSkyX and 
the mount.     
 
To connect to the mount: 
 
Choose your mount from Mount List window on the Mount Setup 
pop-up menu from the Telescope Setup window 
Choose the communication port by clicking the Settings command 
on the Mount Setup pop-up menu 
Click the Connect command from the Telescope menu, or the 
Connect Mount command from the Start Up pop-up menu on the 
Telescope window to connect to the mount. 
 
See the step-by-step setup instructions below for your specific 
mount. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 352 

Status Text Description 

Connecting  This message is displayed while TheSkyX attempts to establish 
communication with the mount.   
 
If connection fails, double check: 
 

• The mount is powered on. 

• The communication cable is plugged into the correct port on 
the mount and computer. 

• When using the device’s RS232 communications port (serial 
port), make sure the USB to Serial Adaptor driver for your 
operating system are installed.  Under Windows, check the 
Device Manager to ensure the driver is recognized and 
functioning properly. 

• Click the Settings button on the Telescope Setup window to 
make sure TheSkyX’s Telescope settings are correct. 

• Make sure the RS232 telescope cable is wired correctly for 
your model telescope. 

• Make sure the USB cable is working properly by using it on a 
different USB device.  As a troubleshooting test, remove any 
USB hubs, USB extenders and plug a 15-foot USB cable 
directly into computer’s USB port, and directly into the USB 
adaptor. 

 

Disconnecting This message appears while TheSkyX terminates communication 
with the mount. 
 

Not Homed The green Not Homed status message means TheSkyX is successfully 
communicating with the mount’s control system, but the mount has 
not been homed.    
 
Click the Find Home command from the Start Up pop-up menu on 
the Telescope window slew the mount begin the homing process.   
 

Finding Home This message appears while the mount is searching for the homing 
sensors. 
 

Not Synced Synchronization is the procedure where the optical tube assembly is 
pointed to a position on the celestial sphere (typically a bright star) 
and the mount is synchronized to this specific equatorial coordinate.  
See “Software Synchronization” on page 377 for more information. 
 
To perform a synchronization from TheSkyX, identify the bright star 
on the Sky Chart, center this star in the telescope’s field of view, then 
click the Sync button on the Telescope Star Synchronization 
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Status Text Description 

window.  (To display the Telescope Star Synchronization window, 
click the Star Synchronization command from the Start Up pop-up 
menu on the Telescope window.) 
 
Provided TheSkyX’s location, date, time, time zone and Daylight-
Saving Option is configured correctly, and the correct star is 
identified on the Sky Chart, and the telescope is actually pointing to 
the identified star, the mount is now oriented with the celestial 
sphere so that when you tell the mount to “slew to this RA/Dec” it 
will actually slew to the correct position. 
 

Tracking at 
Sidereal Rate 
 

The mount’s right ascension axis is rotating at the same rate as the 
stars, so that there will be no apparent motion in the eyepiece.   
 
This “steady state” message appears when the mount is tracking at 
the sidereal rate (and not a custom tracking rate). 
 

Tracking at 
Custom Rates 
 

The mount has been configured to track at a rate other than the 
sidereal rate.  See “Set Track Rates” on page 394 for details about 
configuring custom rates. 
 

Slewing to 
Target 

This message appears after clicking the Slew button (or right-clicking 
an object on the Sky Chart that is above the horizon and selecting 
the Slew command) and while the mount slews to the target object.   
See “Slewing to Objects” in TheSkyX Pro User Guide for details. 
 
Click the Abort button on the Telescope window to stop the slew. 
 

Joysticking This message appears when the Paramount’s joystick (Paramount 
ME) or hand paddle controller (Paramount MX) is being used to slew 
the mount. 
 

Parking The mount can be slewed and “parked” to a custom position at the 
end of each observing session.  Please carefully read the Defining the 
Park Position and Park Position Rules for more information. 
 
This message is displayed while the mount slews to the park 
position. 
 

Parked When the mount reaches the Park Position, tracking is turned off.  
Once the mount is parked, make sure to disconnect from the mount 
to terminate the observing session. 
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Status Text Description 

Tracking 
Satellite  

This message is displayed while the mount is tracking a satellite (the 
right ascension and declination tracking rates are configured for the 
satellite that is being tracked). 
 
Click the Abort button to terminate this process. 
 

Connection Lost 
or Poor 
Communications 

After multiple retries, when TheSkyX cannot reliably send/or receive 
commands to/from the telescope, the connection is terminated. 
 

Mount and Driver Information 

After selecting your mount, the Imaging System Setup window lists the mount’s driver-specific 
information.  (The telescope driver is the software that “talks” to the mount’s control system.) 

Device Name 

Displays the name of the mount or control system. 

Device Description 

Displays a short description of the selected mount. 

Driver Information 

Displays a short description about the telescope driver. 

Driver Version 

Displays the software version of the telescope driver. 

Firmware Information 

When available, the mount or control system firmware version is displayed.  Remember, 
firmware is the internal software that is used by the control system and is different than the 
telescope driver version.   

Model 

When available, the model of the mount is displayed. 

Telescope-Related Software Preferences 

The Imaging System window provides the following additional preferences for both encoder and 
“go to” interfaces. 

Always Confirm Slews 

When this option is turned on, after initiating a slew command (page 381), you must confirm 
whether you want to slew the telescope before the mount begins slewing.   
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Turn off the Always Confirm Slews option on the Confirm Slew window or on the Telescope Setup 
window so that confirmation is not required. 

Always Confirm Syncs 

When this option is turned on, after initiating a software synchronization (page 377), you must 
confirm whether you want to sync the telescope. 
 
Turn off the Always Confirm Slews option on the Confirm Slew window or on the Telescope Setup 
window so that confirmation is not required. 

Confirm Pointing Samples 

When this option is turned on, after adding a new pointing sample, you must confirm whether 
you want to do so. 
 
Turn off the Always Confirm Pointing Samples option on the Confirm Pointing Sample window 
or on the Telescope Setup window so that confirmation is not required. 

Impose Slew Limits (Destination Coordinates Only) 

Turn this option on to have TheSkyX try to stop slews to slew limit regions (page 362). 
 

*** 

Atmospheric Refraction Parameters 

Click the Atmospheric Refraction Parameters button to set the temperature, pressure and other 
weather-related parameters that can change telescope pointing (specifically, refraction 
calculations) from night to night.  Note that these parameters can usually be left unchanged for 
most observers.  For those using the TPoint Add On’s Super Model feature to achieve sub-10 
arcsecond pointing, setting these parameters each night will help maintain superb pointing. 
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Figure 158: Tonight's Atmospheric Refraction Parameters window. 

Temperature 

Enter tonight’s ambient temperature. 

Pressure  

Enter the barometric pressure, in mB.  Note that the pressure TPoint needs is the absolute 
pressure at the observatory site (QFE), not the equivalent sea-level pressure (QNH). Websites and 
weather stations almost always give the latter, always around 1000 hPa, whereas the pressure 
at Golden, Colorado (for example) is about 820 hPa. If you mistakenly use the sea-level pressure 
you are likely to find the term TX10 appearing in your pointing model to correct the overestimate, 
not that it always means that. 

Humidity 

Enter the relative humidity, as a percentage. 

Observing Wavelength 

Enter the wavelength of light that is being observed.  Yes, the atmosphere affects different 
wavelengths. 

Tropospheric Lapse Rate 

In degrees K/m, the default value is 0.01.  Note that the default value can be used in nearly all 
circumstances. 

Defaults 

Click this button to restore the default atmospheric refraction settings. 
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*** 

Cross Hair Update Interval 

Enter the length of time, in milliseconds, that the coordinates of the telescope cross hairs are 
updated.  The default setting is As Fast As Possible; if you cannot establish communication with 
your mount, or encounter communication failures, it may be that your mount cannot keep up 
with TheSkyX’s requests.  If this is the case, try increasing the interval to 500 milliseconds or 
higher. 

Always Keep Telescope Cross Hairs Visible on Sky Chart 

The telescope cross hairs can be forced to remain visible on the Sky Chart so that you can more 
easily track its position.  The other options in this list include: 
 

• No: This option allows the telescope cross hairs to move independently from the Sky 
Chart.  Use the Center Cross Hairs button to adjust position of the Sky Chart based on the 
telescope’s current position. 

• Yes: The telescope cross hairs remain visible on the Sky Chart.  If the telescope is slewed, 
or the Sky Chart’s position is changed, the Sky Chart is automatically updated to center 
the cross hairs.   

• Yes, Centered: The telescope cross hairs are pinned to the center of the Sky Chart. 

• No, Suspend Connection: The telescope link is suspended; the telescope cross hairs are 
no longer displayed, and Sky Chart’s field of view can be changed.  

Telescope Field of View (FOV) 

Click the Choose button to choose the Field of View Indicator (page 119) for your imaging system. 

Using the Software-Guided Link 

The cross hairs in the Sky Chart will now “follow” the telescope.  This is true whether you move 
the telescope by hand, or let its motor drive turn it. Be sure you’ve clicked the Computer Clock 
button. The Sky Chart will then update automatically. If you select a specific date and time, the 
Sky Chart does not update; however, the Sky Chart may not match what you see through the 
telescope. 

Terminating the Link 

On the Telescope menu, click the Connect command.   Or, select Disconnect Telescope in the 
Shut Down pop-up menu on the Telescope window.  

Finding an Object 

TheSkyX can help you position the telescope on an object.   
 
1. Use the Find command on the Edit menu to locate the object.  
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2. Click the Guide To Current Object button.  It is located on the Utilities tab of the SGT 
Alignment window.  This will show the Guide To controls on the Sky Chart.  When the 
telescope is pointing relatively near the target object, its position is represented by cross hairs 
on the RA/Azimuth and Dec/Altitude axis circles.  When an axis is far from the object, a red 
and green line are shown instead.  The red line rotates as the telescope is moved. The green 
line remains stationary.  Your goal is to move the telescope until the red line is drawn on top 
of the green line.  At this point, the lines fade away.  Slowing move the telescope axis until 
the cross hair is over the center green circle. 

 

 

Figure 159: The SGT Guide To controls.  

3. Starting with the RA/Az axis, move the telescope until the cross hairs are centered in the 
circle.  Lock the RA/Az axis.  

 
Repeat the last step for the Dec/Alt axis.  
 
The Sky Chart’s cross hairs are now over the desired object. When you look through the 
telescope, the object should be near the center of the field. If Impose Slew Limits are enabled, 
TheSkyX warns you if you try to move the telescope into a limit-line region. 

Setting Up and Using your Go To Telescope 

TheSkyX can drive many popular commercial telescopes.  Most telescopes that TheSkyX controls 
are serial devices (one exception is Vixen SX mounts; it uses an Ethernet connection).   In order 
for a telescope that uses serial communications to “communicate” with the computer (and 
TheSkyX), the computer must have a serial port. 
 
Unfortunately, serial ports have been replaced by USB ports on virtually every newer model 
computer.  This means the physical USB hardware, as well as the USB protocol, is not compatible 
with older serial devices.  Fortunately, there is a solution… 

USB to Serial Adaptors 

The most common method to connect a personal computer that has a USB port to a telescope 
that uses serial (RS232) communication, is to use purchase a USB to serial adaptor.  This hardware 
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device “converts” one of the computer’s USB ports into a virtual serial port that understands 
serial communication used by the telescope.   
 
The most common way to do this is to use a USB to Serial Adaptor so that one of the computer's 
USB ports can accept RS232 commands.  (Bluetooth or serial to Ethernet hardware devices are 
other, less common, and typically more expensive alternatives.) 
 
USB to serial adaptors are relatively inexpensive and can be purchased at almost any computer 
store.   

• Before purchasing the USB to serial adaptor, make sure the adaptor is compatible with 
your computer’s operating system.  For example, some USB to serial adaptors are not 
compatible with Mac OS X Snow Leopard. 

• Carefully follow the manufacturer’s setup instructions for your operating system.  
Remember, the USB to serial adaptor hardware requires that you install a separate 
software driver before it can be used to communicate with a telescope. 

Mac OS X Snow Leopard and USB to Serial Adaptors 

When you plug a USB to Serial Adaptor into a computer that is running Mac OS Snow Leopard, a 
message appears that a new network device has been connected, and prompts you to set it up 
(via the Network options in System Preferences).   
 
Configuring the USB to Serial Adaptor as a network device will not allow TheSkyX to control a 
telescope that uses RS232 serial communication.  
 
For TheSkyX to control a telescope that uses serial communications on Mac OS X, an OS X 
compatible USB to serial adaptor driver must be installed first.   
 
Contact the manufacturer of your USB to Serial Adaptor hardware device, or visit the 
manufacturer’s Downloads page to obtain this driver.  
 
After installing the Mac OS X-compatible USB to Serial Adaptor driver, you need to select it from 
TheSkyX’s Telescope > Telescope Setup > Settings window.  
 
You’ll also need a telescope cable that connects your computer to USB to serial adaptor.  Cables 
for Meade and Celestron products can be purchased from the Software Bisque Store.  
 
We strongly recommend that you read the telescope’s owner manual carefully, and become 
thoroughly familiar with the telescope’s operation, before using TheSkyX to control it.  

Configuring the Telescope Interface 

TheSkyX must be configured so your computer can communicate with the telescope.  The 
following general procedure applies to most “go to” telescopes.  
 

1. Turn off the telescope.  
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2. Using the appropriate telescope cable, connect the serial port on the telescope to an 
unused serial port.  If your computer does not have a serial port, you’ll need to use a USB 
to serial adaptor. 

3. Turn on the telescope.  
4. Select the Telescope Setup command from the Telescope menu to show the Imaging 

System Setup window.  
 

 

Figure 160: The default Imaging System Setup window. 

5. Highlight Mount from the Imaging System tree on the left. 
6. From the Mount Setup drop down menu, click the Choose command to select your 

telescope model and click OK. 
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Figure 161: Select your mount from the list of supported telescopes. 

7. From the Mount Setup drop down menu, click the Settings command.  On the Mac, the 
Serial Device Settings window allows you to specify the USB to serial adaptor that your 
telescope cable is connected to. 

Windows Serial Port Notes 

• Only standard serial ports or USB to serial adaptors that are not being used by any 
other device should be used. 

• Use Windows Device Manager to determine the COM port number for your serial 
ports, or USB to serial adaptor. 

Linking To and Synchronizing the Telescope 

Most “go to” drive systems must be properly configured before TheSkyX can control them.  You 
can do this “by hand,” using the telescope’s hand paddle.  Or, you can do it from within TheSkyX 
by performing a process called synchronization. 
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(Note that Celestron telescopes using firmware version 4.1 and earlier cannot be synchronized 
from TheSkyX and must be aligned using the hand paddle before TheSkyX can control it.) 

Important Notes: 

• The local date, time, time zone, Daylight Saving Time and terrestrial coordinates must 
be manually input to the telescope’s hand paddle.  If the telescope is connected to 
your computer, you might find it easier to use TheSkyX to initialize the telescope’s 
hand paddle with these values.  If your telescope can be initialized by TheSkyX, click 
the Location, Date, Time command from the Tools pop-up menu on the Telescope 
window to do so (page 370). 

• The telescope must be aligned with the celestial sphere.  Follow the manufacturer’s 
instructions for aligning the telescope with the night sky. 

 
See “Software Synchronization” on page 377 for details how to synchronize your mount with 
TheSkyX. 

Telescope Setup Options 

After choosing your telescope, the Imaging System Setup window displays mount and driver 
specific information, and allows you to specify your telescope preferences.  

Telescope Limits 

Controlling the slewing limits of your telescope is a snap with TheSkyX’s telescope limits 
command.  There, you can set lower altitude and upper altitude and declination limits.  To open 
the Telescope Limits window, select the Telescope Limits command from the Telescope menu. 

Telescope Operation Disclaimer 

Any motor-driven telescope can – through improper initialization, accident, carelessness, or 
component failure – be run into its mechanical limits.  Software Bisque provides the limit region 
feature as a convenience – not as a guaranteed cure for the problem. You are responsible for the 
safe use of your instrument. 

Upper Limits 

When you first open the Telescope Limits window, you will first be given an opportunity to set 
the Upper Limits of your telescope’s slewing control.  Use the data fields to enter maximum 
values for declination and altitude slewing and to choose whether the telescope limits are plotted 
on the Sky Chart. 

Lower Altitude Limit 

Choose the Lower Altitude Limit tab to set minimum altitude limits for your telescope setup.  In 
the top portion of the window, you will see a graph upon which you can click and drag the mouse 
pointer to draw a set of altitude limit data for given azimuth values. 
 
You can also choose to Open a pre-existing horizon file, and, once you have set altitude limits, 
you can save a horizon file for later use by clicking Save As. 
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Clicking Set To allows you to set altitude limits according to a number of values, such as a given 
set altitude, or to match the current horizon image.  For more on horizon images, see Horizon & 
Atmosphere Options. 
 
You can also import the telescope’s current Az/Alt position into the window by clicking Get 
Telescope Az/Alt. 
 
Here, too, you choose to have TheSkyX plot the set limits onto the Sky Chart by clicking Show 
limits on Sky Chart. 
 
Once you are satisfied with the input limit data, click OK to commit.  If you decide not to use 
these data, click Cancel. 

TPoint Add On 

The TPoint Add On is optional telescope pointing analysis software that allows you to analyze the 
errors inherent in your telescope system to drastically improve its pointing performance.  Both 
TheSkyX Serious Astronomer Edition and TheSkyX Professional Edition supply a 90-day trial 
version of TPoint.  The TPoint Add On can be accessed from the Tools menu. 
 
Like many aspects of your imaging system, there is a learning curve.  Fortunately, TheSkyX makes 
using TPoint Add On easier and you should be able to complete an automated calibration run on 
the first night to start analyzing and improving your telescope’s pointing right away.  The TPoint 
Add On User Guide is available by selecting the TPoint Add On User Guide from the Help menu. 

Telescope Controls 

The Telescope window holds the most commonly used telescope controls.  Select the Telescope 
command from the Display menu to show it.   
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Figure 162: The Telescope window (Telescope command, Display menu). 

Not all telescope mounts have the same feature set; the Telescope window shows the most 
commonly used mount controls.  Note that the commands in the Start Up, Tools and Shut Down 
pop-up menus may change for each mount. 
 
Manufacturer-specific telescope control features can be accessed from the appropriate 
<Telescope Name> command in the Display menu.  For example, the control system specific 
commands for the Gemini are located on the Gemini window. 
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Telescope Initialization 

The Start Up pop-up menu on the Telescope window shows mount-specific commands that are 
used to connect to, synchronize, unpark or find the mount’s home position, when applicable.   
 

Connect Telescope Command 

 
This command is identical to selecting the Connect command from the Telescope menu.  See 
“Linking To and Synchronizing the Telescope” for more information about this command. 
 

Find Home Command 

 
Where supported, this command tells the mount to slew to its home position.   
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Star Synchronization Command 

 
Use this command to tell TheSkyX where the telescope is currently pointing.  See “Software 
Synchronization” for more information about this command. 

Telescope Setup Command 

 
Shows the Telescope Setup window.  See “Configuring the Telescope Interface” for more 
information about setting up your mount. 
 
Once communication with the telescope is established, the Telescope window can be used to 
find objects, monitor the status of the communications between the mount and the computer, 
initialize the mount’s hand paddle or controller with TheSkyX’s location, date, time, and time 
zone values, methodically slew the telescope outward to search for a nearby star and more.  

Telescope Tools 

The Tools pop-up menu contains the less-commonly used telescope control features. 
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Turn Sidereal Tracking On/Off 

      
Use the Turn Sidereal Tracking On and Turn Sidereal Tracking Off commands to enable or disable 
sidereal tracking on mounts that support this feature. 

Slew To Coordinates 

Use this command to enter a specific right ascension and declination or altitude and azimuth 
coordinate.  See “Slewing to a Specific Coordinate” on page 381 for more information. 

Slew Prior 

Use this command to slew the telescope to its previous coordinates.  For example, if you slew to 
M42, then to the Pleiades, selecting the Slew Prior command will return the mount to M42.  
Slews must have been initiated by TheSkyX for this command to work.  In other words, using the 
telescope hand paddle to slew to an object, then attempting to slew to the previous object will 
not work. 

Star Search  

The Star Search feature slews the telescope in a spiral pattern of increasing size to help locate an 
object in the eyepiece.  Choose the Star Search command from the Tools pop-up on the 
Telescope window to show the Star Search window. 
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Figure 163: The Star Search window (Tools menu on the Telescope window). 

Begin Spiral Search (Star Search button) 

 
Clicking this button begins slewing the telescope in a “spiral” pattern, based on the size of the 
selected Field of View Indicator.   

Defining the Size of the Spiral (Telescope’s Field of View) 

The angular distance between slews when the telescope “spirals” outward can be configured to 
match the telescope’s field of view.  Click the Select From Field of View Indicators button to tell 
TheSkyX the specifics of your optical system. 

Communications Log 

The Communications Log command (Tools pop-up menu on the Telescope widow) shows the 
serial or network communications between TheSkyX and the telescope.   
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Figure 164: The Communications Log window. 

The report contains six columns.   
 

• Packet Count – The total number of packets or commands sent to the telescope, including 
retries and failures.  

• Date and Time – The date and time the packet was sent. 

• Transmit – The telescope-specific command that was sent to the telescope.  Please refer the 
telescope protocol specifications for your telescope to decipher what each command means. 

• Received – The response received from the telescope.   

• Number of Bytes Received – The number of individual characters received. 
 
This information can be useful when troubleshooting telescope connection problems.   

Packets, Retries, Failures 

The number of Packets represents the individual commands that have been transmitted to the 
telescope.  If the telescope does not respond to a command, TheSkyX resends or Retries to send 
the command three times.  Failures mean the telescope did not respond to a command.  Multiple 
failures usually indicate that there is a configuration, cabling or other hardware problem.  To 
begin troubleshooting, check that the telescope is turned on, the serial cable plus the USB to 
serial cable is properly plugged in to the computer and the telescope’s communication port.   

Clear  

Click the Clear button to clear the current report. 

Pause 

Click the Pause button to temporarily stop the communications log report from being updated.  
Note that communications with the telescope continue when this button is pressed down.  
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Location, Date, Time 

Astro-Physics, Gemini, Celestron and Meade mounts allow TheSkyX to configure the control 
system’s location, date, time and time zone information, rather than having to set them manually 
using the hand paddle.  Choose the Location, Date, Time command from the Tools pop-up on 
the Telescope window to show the Telescope Location, Date, Time window. 
 

 

Figure 165: The Telescope Location, Date, Time window (Tools menu on the Telescope window). 

For the telescope to be commanded to the correct coordinates, the telescope must use the same 
parameters as TheSkyX.   

Refresh Button 

Click the Refresh button to get the telescope’s current settings.  
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Arrow Button 

Click the green arrow button to configure the hand paddle’s settings to match TheSkyX’s current 
time, date, latitude, longitude and time zone settings.   
 
TheSkyX’s settings may not exactly match the telescope’s settings for the following reasons. 
 

Parameter Reason for Difference 
 

Time The time display is not updated continuously on this 
window, so the seconds may differ. 
 

Latitude and Longitude The telescope protocol may not allow arcsecond 
accuracy for latitude and longitude. 
The telescope’s coordinate convention may differ from 
TheSkyX’s convention.  For example, the Astro-Physics 

longitude is displayed from 0–360; TheSkyX measures 

longitude from 0–180 East or West of GMT. 
 

Time Zone TheSkyX uses a different time zone sign convention as 
compared to the telescope protocol, so the sign of 
TheSkyX’s time zone is opposite from the telescope. 
TheSkyX sets the telescope’s time zone to the nearest 
whole number. 
When Daylight Saving Time is in effect, the telescope 
protocol must be configured to use a one hour offset 
from the actual time zone.  This convention means 
TheSkyX’s time zone will differ from the telescope by 
one hour. 

 
These differences are normal and expected and ensure the telescope is properly configured for 
TheSkyX control. 
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Figure 166: The Jog pane on the Telescope window. 

 

Figure 167: The Move pane on the Telescope window. 

Bisque TCS 

 
Paramount Robotic Telescope Systems (page 423) use the Bisque Telescope Control System 
(Bisque TCS) for dual axis motion control.  The Bisque TCS command provides access to control 
system specific features.  See the Paramount User Guide for Bisque TCS documentation. 

Virtual Telescope 

The Virtual Mount window simulates the orientation and motion of your mount, and can be 
especially helpful for monitoring and troubleshooting remote mount operation.  As the actual 
mount is commanded to slew, the simulated, virtual mount follows.   
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The current simulated mounts include: 
 

• Astro-Physics Mach1 GTO 

• Software Bisque Paramount ME 

• Software Bisque Paramount MX 
 
The simulated telescope on the simulated mount is a Newtonian optical tube assembly shown in 
Figure 168.  We hope to add other simulated mounts and telescopes in future versions of 
TheSkyX. 
 
Choose the Virtual Mount command from the Tools pop-up on the Telescope window to show 
the Virtual Mount window. 
 

 

Figure 168: The simulated Paramount MX. 
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Right-click and drag on the Virtual Mount window to change the point of view.  Place the mouse 
cursor over this window and use the mouse scroll wheel to zoom in and out. 
 
The pop-up menu on the bottom of the Virtual Mount window allows you to select the simulated 
telescope mount. 

Move and Jog Controls 

Use the controls on the Move and Jog tabs to manually slew or move, by discrete increments, 
the telescope. 

Move Tab 

Click and hold the Move arrow buttons on the Telescope window to direct the telescope in a 
specific direction.   The Rate pop-up menu controls the speed of the slew.  The Rate options in 
this list change depending on the currently selected mount. 
 
The Move window offers eight different direction controls: north, east, south, west, and the 
“diagonal” directions in between.  Diagonal direction buttons are hidden for mounts that do not 
support dual-axis moves. 

Jog Tab 

Use these arrow buttons to slew the telescope by the angular distance shown in the Distance list, 
and using and equatorial (RA/Dec) or horizon (Azm/Alt) coordinates. 

Orientation Options 

The direction a button moves the mount is configurable.  This is useful, for example, when the 
optical tube on a German equatorial mount changes sides from East to West, the relative motion 
of the telescope in the right ascension axis is reversed.  Changing the orientation for the right 
ascension axis makes the buttons work “as expected” for the opposite side of the mount. 
 

• Normal sends the standard commands to the mount for moving in this direction. 

• Swap Axes changes the left/right direction buttons to up/down, and up/down to 
left/right. 

• Flip Left/Right swaps the left and right buttons.  Left moves right, and right moves 
left. 

• Flip Up/Down swaps the up and down buttons.  Up moves down and down moves up. 
 
Alice, welcome to Wonderland. 

Shut Down Procedure 

At the end of the night, you’ll want to make sure to park the telescope so it will be in the correct 
orientation to close the observatory roof.  Note that some telescope control systems cannot park 
the telescope.  For these telescopes, TheSkyX uses a “built-in” park feature that slews the mount 
to the park position (a fixed altitude/azimuth coordinate) that you define and turns off the 
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mount’s sidereal tracking.  When communication with the mount is established again, TheSkyX 
can unpark the mount and initialize the mount’s control system. 

Set Park Position 

 
 
Use this command to specify the altitude and azimuth coordinates to slew the mount before 
parking.  The current position of the telescope cross hairs is used as the park position. 

Clear Park Position 

 
Use this command to delete the previously defined park position.  After clearing the park 
position, a new one must be defined with the Set Park Position command before the telescope 
can be parked. 
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Park  

 
The Park command slews the telescope to the park position, and then turns the mount’s sidereal 
tracking off (where possible). 

Unpark 

 
Once a mount has been parked, it may have to be unparked to initialize the telescope control 
system to restore normal operation.  

Disconnect Telescope 

Terminates communication with the mount.  This command is the same as selecting the Connect 
command from the Telescope menu when there is a connection.  See “Linking To and 
Synchronizing the Telescope” for more information about this command. 

Focuser 

Controls the focus and focus speed of a pulse focuser that is connected to the telescope’s focuser 
port.  This feature is especially useful when viewing CCD images on a monitor while focusing.  
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Software Synchronization 

 
 
Star synchronization (or “sync” for short) a mount with TheSkyX initializes the mount’s control 
system to an equatorial position on the celestial sphere.  Mount synchronization may be 
performed using the mount’s hand paddle, if one is available, or through software 
synchronization.   

To synchronize a mount using TheSkyX 

1. For telescopes that employ an external hand paddle that can control the mount 
independently, make sure that TheSkyX’s location, date, time, time zone and Daylight-Saving 
Time settings (DSO) match the telescope’s hand paddle settings.  See “Entering Your 
Location” on page 33 for information about how to configure TheSkyX for your location on 
earth.  See “Location, Date, Time” on page 370 for details how to use TheSkyX to configure 
the mount’s site and time settings. 

 
If your mount does not have a hand paddle, or the Location, Date, Time command is not available 
for your telescope, consult the owner’s manual for your mount for details how to initialize the 
control system before using TheSkyX to control it. 
 
2. From TheSkyX, manually center a known star in the telescope’s eyepiece (or other detector) 

using the mount’s hand controller or TheSkyX’s telescope move control commands (see 
“Move and Jog Controls” on page 374). 

3. Find or identify this star in TheSkyX Professional Edition.  (See “Finding and Identifying 
Celestial Objects” on page 59). 

4. Choose the Star Synchronization command from the Start Up pop-up menu on the 
Telescope window. 

5. Click the Sync button. 
 
The following procedure applies if your telescope can be synchronized through software like 
TheSkyX.  Some control systems do not support software synchronization and must be configured 
to operate “standalone” first.  If your telescope mount does not support software 
synchronization, following the manufacturer’s initialization instructions now.  TheSkyX can 
control the mount only after it has been initialized using the hand paddle. 
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Figure 169: The Telescope Star Synchronization window (Synchronize command in the Start Up pop-up menu on the 
Telescope window). 

1. Select the Connect command from the Telescope menu.  Cross hairs appear on the Sky 
Chart, showing the position the telescope “thinks” it is pointing.    

2. If you haven’t set the telescope’s time and coordinates, do so now (page 370).   
3. Position the center of the telescope’s field on a known star.  In general, do not select a 

planet, nebula, galaxy or other “extended object” for synchronization; star coordinates 
are typically more accurate, and a star is a true “point source.”  

4. Click on the same star if it is visible on the Sky Chart or use the Find command to locate 
it.   

5. Click the Star Synchronization command in the Start Up pop-up menu on the Telescope 
window.  

6. On the Star Synchronization window, click the Sync button. 
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The Sky Chart’s cross hairs should jump to and overlay the star that was used for synchronization, 
or be centered on the star used during the hand paddle initialization.   
The telescope is now aligned on, or synchronized with, the target object and can be controlled 
by TheSkyX.  See “Slewing to a Specific Object or Target” on page 381 to get started slewing the 
telescope.   

A Faster Way to Synchronize 

Use the Sync command to perform a synchronization on the current target object.  This command 
bypasses the Star Synchronization window.   
 
The Sync action should not be performed unless you are sure of the consequences. 
 

• Once a permanently mounted Paramount-class mount is polar aligned and a working TPoint 
model established, further synchronization should not be necessary.  A “bad” synchronization 
can cause the mount to lose its orientation with the celestial sphere. 

• Telescopes that employ TPoint should only be synchronized before pointing calibration data 
is acquired.  Subsequent observing sessions should recalibrate the model rather than re-
synchronize the mount.  See the TPoint Add On User Guide for more information about 
recalibration.   

• If there is no TPoint model, then you may wish to “single-click” synchronize the mount 
multiple times during a single observing session to minimize pointing errors in a small area of 
the sky.  

 
To add the Sync command to a toolbar: 
 
1. On the Preferences window, click the Toolbars icon (page 202).   
2. Click the Customize button to show the Customize Toolbars window.   
3. Select the toolbar to add an action. 
4. Select the Sync command from the Actions list, under All Other Commands. 
5. Click the right arrow to add this action to the selected toolbar. 
6. Click OK. 
7. Click Close.   
 
The single-click Sync command is now accessible on the selected toolbar. 

Image Link and Sync 

If you are familiar with TheSky6 Professional Edition, you may have used the Image Link and Sync 
feature, where the coordinates of a photo determined by Image Link are used to synchronize the 
telescope.  TheSkyX Professional Edition can do the same. 

Synchronizing on an Image Link Photo 

Follow the steps below to use a photo from a previous session to reestablish the telescope’s 
position. 
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1. Use the Image Link command to overlay a photo on the Sky Chart and determine the 
astrometric coordinates for every position in the photo (page 312). 

2. Click on the Sky Chart anywhere “inside” the boundaries of the Image Link photo.  The first 
object in the Related Search Results list on the Details tab of the Find window is named < 
OBJECT FITS Keyword> Image Link Photo, where <OBJECT FITS Keyword> is the text from the 
OBJECT keyword in the photo’s FITS header.  The coordinates of the Image Link photo are the 
2000.0 astrometric RA/Dec of the center of the photo.  Synchronizing on the Image Link photo 
restores the telescope’s position to these coordinates. 

3. Synchronize the telescope on this target (page 377). 
 

 

Figure 170: Clicking the Image Link photo on the Sky Chart displays the photo’s OBJECT name in the FITS header, plus 
Image Link Photo in the Related Search Results of the Find window. 
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Slewing to a Specific Object or Target 

 
 

1. Click on the object in the Sky Chart.  If the desired object is not visible on the current chart, 
click the Find command from the Edit menu, enter the object’s name (Crab Nebula, for 
example) or its catalog number (M1) into the Search For text input and click the Find 
button.   

2. Click the Slew button.  One is located on the Telescope, Find and the Observing List 
windows and on the Telescope toolbar.   

 
The Search For text input and Find button are also available on the Telescope window.  
 
There’s another way slew the telescope… 
 

1. Right-click an object in the Sky Chart. 
2. Select the Slew command from the Sky Chart’s pop-up menu. 

Slewing to a Specific Coordinate  

Astronomers know better than to claim stars do not move.  Proper motion, precession, nutation, 
aberration and other phenomena cause astronomical bodies to move over time when observed 
from earth.   
 
While TheSkyX makes every effort to hide the complexities involved with coordinate 
transformations in cataloged data, and generally uses the object’s topocentric coordinates, you 
may still need to slew a telescope to coordinates that were recorded at a different time.  For 
example, older astronomical catalogs may have recorded in equinox 1950.  Slewing the telescope 
to equatorial coordinates that are from 1950, when TheSkyX is expecting positions from a 
different equinox, means the telescope will point to the wrong position. 
 
Use the Slew To Coordinates command from the Tools menu on the Telescope window to display 
the Enter Coordinates tab of the Navigate window.  From here, enter the right ascension, 
declination or azimuth, altitude coordinates, then click the Slew To RA/Dec or Slew To Az/Alt 
button, respectively.  
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When using coordinates from historical observations, make sure to specify the equinox of the 
coordinates by entering the year into the Equinox list box, or choosing one of the default options: 
Apparent, 2000.0, or B1950.0.  Or, manually enter a different value if the coordinated are from 
a different equinox. 

Slewing to the Prior Target 

 
Use the Slew Prior command to slew the telescope to the previous target.  This command is not 
accessible on the Telescope window, but can be added as a button to any tool bar. See 
“Customizing Toolbars” on page 202 for details about adding buttons to toolbars. 
 

Slewing to an Image Link or All Sky Image Link Target 

A telescope can be slewed to the coordinates that match the center of an Image Link photo so 
that its position can be restored from night to night. 

To Slew to an Image Link Photo 

1. Use Image Link or All Sky Image Link to find the astrometric solution for a photo.  After a 
successful Image Link, the photo will be overlaid on the Sky Chart, precisely matched 
against the background stars.  Make sure to turn on the Show Linked Photo checkbox on 
the Image Link window to make the photo visible. 

2. Click within the Image Link photo on the Sky Chart to identify it.  This target object appears 
in under Related Search Results on the Object Information window with the name < 
OBJECT FITS Keyword> Image Link Photo, where <OBJECT FITS Keyword> is the text from 
the OBJECT keyword in the photo’s FITS header (or DSS Image Link Photo when the photo 
was obtained from the Digitized Sky Survey data).   

3. Select the Image Link Photo text to make it the current target object, then click the Slew 
button to slew the telescope to J2000.0 RA/Dec of the photo’s center. 

Closed Loop Slew 
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Imagine, while observing objects visually with your go to telescope, slewing the telescope to a 
star cluster (the “target”) in a different part of the sky.  Chances are, the telescope’s inherent 
pointing inaccuracies mean the cluster will not fall “dead center” in the eyepiece.  At this point, 
you will most likely grab the telescope’s hand paddle to manually find and center the object in 
the eyepiece before enjoying the view. 
 
A Closed Loop Slew automates this target centering process using the astrometric position of a 
photo acquired with a camera, instead of the human eye.  Image Link (page 312) replaces the 
observer’s interaction with the telescope to automatically center the target object.  The result of 
a closed loop slew is that, using a single button click, a go to telescope with a camera attached 
can be slewed to any target, or equatorial coordinate, and the object will fall squarely in the 
center of the frame. 
 
This feature can be used, for example, to precisely slew the telescope to a specific star so that it 
falls on a spectrographic slit each night.  Or, to precisely slew the mount to the center of a 
previously acquired photograph. 

How does Closed Loop Slew work? 

The Closed Loop Slew command incorporates automated telescope control, automated Image 
Links and automated camera control to ensure the target object is centered. 
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Figure 171: The Closed Loop Slew button on the Find window. 
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Figure 172 shows what happens “behind the scenes” when the Closed Loop Slew button is clicked.   

 

Figure 172: Flow chart showing each step of a Closed Loop Slew. 

Acquiring multiple photos, and determining the astrometric solution necessarily requires more 
time than the typical “open loop slew”, however, the result of a Closed Loop Slew means the 
target object should be centered on the photo to within a few arcseconds of the target’s right 
ascension and declination coordinates. 
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Closed Loop Slew Setup 

To access the Closed Loop Slew settings,  
 

1. Click Tools > Image Link and open the Setup tab. 
2. Click the Automated Image Link Settings button to display the Automated Image Link 

Settings window. 
 

 

Figure 173: The Automated Image Link Settings window. 

Exposure Time 

Enter the length of the exposure, in seconds of time, to use when performing a Closed Loop Slew. 

Image Scale 

Enter image scale, in arcseconds per pixel, of the camera and optical system used to perform the 
Closed Loop Slew. 

Binning 

Select the camera’s bin mode during Closed Loop Slews. 

Filter 

Select the filter to use during Closed Loop Slews. 

Search Area 

Enter the size of the sky region to search for an Image Link match during the Closed Loop Slew. 
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Retries Near Each Target 

Specify the number of times to retry performing a Closed Loop Slew at a given position before 
displaying a failure error message. 

Use All Sky Image Link for Automated Pointing Runs 

When this check box is turned on, Closed Loop Slews use All Sky Image Link instead of the classic 
Image Link (See page 336 for a comparison of these technologies) to determine the astrometric 
solution. 

Source Extraction Setup  

Click is button to specify the Source Extraction settings (page 319) to use for Closed Loop Slews. 
 
All other camera-specific settings used when acquire photos from the imaging camera during a 
Closed Loop Slew (including bin mode, image calibration, etc.) can be configured from the 
Camera tab (page 436).  Closed Loop Slews do not use the autoguider settings. 
 

 

When the camera’s binning (page 452) is changed, the value of the Image Scale 
on the Automated Pointing Calibration Run window must be changed accordingly. 
 
For example, if the image scale produced by the optical system at 1x1 binning is 1 
arcsecond per pixel, and the binning is changed to 2x2, then the value in the Image 
Scale text box must be changed to 2 arcseconds per pixel.  Failure to do so will 
cause the Closed Loop Slew’s Image Link to fail. 

Performing a Closed Loop Slew 

 

The Automatically Save Photos checkbox must be turned on before performing a 
closed loop slew.  If this option is turned off, the initial photo is not saved 
automatically, and the Image Link portion of the closed loop slew process will fail 
with the error message: “Error 507.  Please save the photo.” 

 
Once TheSkyX Professional Edition has been configured for your mount (page 358) and imaging 
camera (page 445), click the Closed Loop Slew button to connect to the mount and the camera, 
then slew to the telescope to the target (using the Closed Loop Slew process described above). 
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Tracking Spacecraft 

 
TheSkyX Professional Edition can slew the telescope to, and track spacecraft.  The first step is to 
locate the satellite to track (by clicking its symbol on the Sky Chart or using the Find command), 
then click the Track Satellites button on the Telescope window (which is otherwise hidden).  If 
the satellite is currently above the horizon, mount is slewed to intercept the satellite’s path, then 
the mount’s tracking rates are set to match satellite’s rates. If the satellite is currently below the 
horizon, TheSkyX waits until it is visible (specifically, above the local horizon) then begins the slew 
to and track satellite process. 
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Figure 174: Tracking initiated, but not yet “stable”. 

When then satellite appears above the theoretical local horizon, the mount slews to the satellite 
and begins tracking it.  The satellite’s Position, relative Track Rate and Track Error in Right 
Ascension and Declination are displayed at the top of the window.   
 
The black region represents the background sky.  The white circle represents the satellite, the 
white arrow drawn through this circle shows the magnitude of the satellite’s tracking rate and its 
current trajectory.  The gray cross hairs show the center of the field.  The green X represents the 
current Tracking Offset that is applied to the mount’s position.  
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Optimal tracking is achieved when satellite is centered in the field.  Mechanical errors and 
uncertainty in the satellite two-line elements may cause the satellite to fall away from the center.  
To adjust the position of the satellite, click in the black region away from the satellite’s current 
position.  The green X shows this new offset, and, when the correct offset is applied, the satellite 
will slowly move to the center of the field. 
 
A larger number in the Track Box Size text box allows a larger maximum tracking offset.  Click the 
Clear Offsets button to set the offset to zero in each axis. 
 
If for any reason the mount cannot continuously track the satellite, the message “Target lost, 
unable to maintain tracking.  Error = 7501.” is displayed, and the mount’s tracking rates will be 
turned off.  

Satellite Tracking Controls 

Each control on TheSkyX Professional Edition’s standard Satellite Tracking window is described 
below. 
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Figure 175: The Satellite Tracking window’s graphical controls. 

Figure 175 shows numbers next to each graphical element, and each is described below:  

• The white arrow (1) shows the relative position of the satellite in the field of view and 
points in the direction of the satellite’s motion. 

• Click and drag the small circle at the end of the cross in the center of the graphic (2) to 
rotate the field (so that the satellite path can be oriented to match the video or detector). 

• Click anywhere inside the black region (which represents a “satellite tracking field of 
view” or track box) to apply an offset to the telescope’s current tracking position, which 
is represented by a large green “X” (3). 
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Advanced satellite tracking capabilities for Paramount-class mounts are available in the optional 
Advanced Satellite Tracking Add On; contact Software Bisque for details. 

Position (RA/Dec) 

Shows the right ascension and declination coordinates of the telescope. 

Track Rate (RA/Dec) 

Shows an internal tracking rate for the satellite. 

Track Error (RA/Dec) 

Shows the magnitude of the tracking error in each axis.  The minimum “acceptable” average 
tracking error that is allows to start tracking can be configured from the Satellite Tracking options 
in the Advanced pane on the Preferences window (page 225). 

Tracking Offsets (RA/Dec) 

Shows the offsets in right ascension and declination, in arcminutes that are applied to the 
satellite’s position during tracking.  The offset is represented by the green X graphic.  To change 
the offset, click the mouse within the black region.   

Clear Offsets 

Click this button to set the tracking offsets to zero. 

Track Box Size 

Enter the relative size of the satellite tracking box.  The size of the track box can be adjusted to 
match the field of view of the optical system.  The track box size can be up to two (2) arcminutes, 
so that relatively large “position offsets” to the telescope’s current track position can be 
introduced by clicking on the track box graphic. 

Status Message (Status Text Box) 

Shows the current state of satellite tracking. 
 

• Idle – No satellite tracking. 

• Begin – TheSkyX has initiated satellite tracking. 

• Start Slew – Telescope slewing is about to start. 

• Waiting for Target to Rise – TheSkyX is monitoring the satellites position, and will begin 
tracking when it rises. 

• Slewing to Target – Telescope is being slewed to the satellite. 

• Settling – The position of the telescope is being adjusted to match the satellite’s position. 

• Tracking – The mount is successfully tracking the satellite. 

Last Error Message (Last Error Text Box) 

Shows the most recent error message to occur. 
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Update Frequency (Cycles Per Second) 

Shows the frequency at which the satellite’s position is being updated. 

Track Satellite Button 

Click this button to start tracking the selected satellite. 

Abort Button 

Click this button to stop tracking the satellite. 

Satellite Tracking Notes:  

• TheSkyX Professional Edition does not use a “leap frog” or “successive slews” method to track 
satellites.  Instead, TheSkyX sets the mount’s tracking rate in both RA and Dec to match the 
current satellites current tracking rate.   

• Many commercial mounts do not allow tracking rates to be configured in both RA and Dec 
axis, so these mounts cannot be used to track satellites with TheSkyX.   

• For mounts that can set dual axis tracking rates, many still do not have the required dynamic 
range to track very slow or very fast-moving satellites.  Trying to use a mount that does not 
have configurable tracking rates from zero to several degrees per second may not result in 
satisfactory results. 

• TheSkyX Professional Edition’s satellite tracking has been optimized for, and extensively 
tested with both the Paramount ME and Paramount MX mounts and works quite well to 
accomplish this task. The Paramount control system allows tracking rates to be configured 
for both the RA and Dec axes and can track virtually any satellite (or any object that tracks at 
any rate from 0.0 arcseconds per second up to several degrees per second).   

Center Cross Hairs 

 
 
Click this button to center the telescope cross hairs on the Sky Chart. 
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Set Track Rates 

 
Solar system objects, including the Sun, Moon, planets, comets and asteroids each move at rates 
that can vary greatly compared to sidereal rate.   
 

• Important Note: To track objects at non-sidereal rates using TheSkyX, the mount’s control 
system must be able to set tracking rates for both the right ascension axis and declination 
axis based on the computed rates of the object. 

• See “Tracking ” on page 388 for details about tracking satellites with TheSkyX.  Many 
commercial mounts either cannot set the tracking rates in both axes, or do not have sufficient 
dynamic range to track relatively slow moving or relatively fast-moving objects. 

 
To configure the mount to track at the non-sidereal rate for one of these objects:  
 
1. Locate the object on the Sky Chart (using either the Find command or by clicking the object 

on the Sky Chart). 
2. Click the Slew button to slew the telescope to the object.  This step is optional, but, if the 

object is a “faster mover”, it’s better to position the telescope close to its current position 
first.  

3. Click the Set Track Rates button on the Telescope window.  The Confirm Set Track Rate 
window shows the current right ascension and declination rates for the selected target, in 
arcseconds/second. 
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Figure 176: The Confirm Set Track Rate for solar system objects. 

Clicking the Yes button sets the mount’s right ascension and declination tracking rates. 

Important Note 

Slewing to a star automatically resets the right ascension’s axis to the sidereal rate and sets the 
declination rate to 0.0.  
 

 

Figure 177: Set tracking rate to the sidereal rate. 

Clicking the Set Track Rate button when the target object is a star shows 0.0 for both the right 
ascension and declination tracking rates, which, although perhaps confusing, is TheSkyX’s 
convention.   The right ascension tracking rate is relative to the sidereal rate, so, setting a tracking 
rate of 0.0 in right ascension means “track at the sidereal rate”.  As expected, the declination 
axis’ tracking rate is set to 0.0. 

Add Pointing Sample 

 
Click this button to add a TPoint Add On pointing calibration sample to calibration data.  See 
“TPoint Add On” on page 363 for details about telescope modeling using the TPoint Add On 
software. 
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Search for Targets 

Enter the name of a target object into the Search For text box then click the Find button.  Or, click 
the mouse on the Sky Chart to select the target.  If there is more than one object near the mouse 
cursor, click the forward or backward buttons to scroll through them.  
 

 
  

Flip Mount Now 

 
Click the Flip Mount Now button to slew the telescope to the opposite side of the pier and still 
point to the same object.  This can be convenient when a German equatorial mount is pointing 
to an object near the meridian and the telescope is on the west side of the pier.  
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Terminating the Telescope Link 

 
Select the Connect command on the Telescope menu to stop communicating with the telescope, 
and close the communications port.   

Using the Telescope Simulator 

The telescope simulator allows you to simulate the process of connecting to, synchronizing and 
slewing a go to telescope without connecting to a physical telescope mount.  This can be useful 
to become familiar with how to operate a telescope from TheSkyX or practice an observing 
session during daylight. 
 

1. Select the Telescope Setup command from the Telescope menu.  
2. In the Telescope Setup window, click the Select Mount button.  
3. Choose the Telescope Mount Simulator option from the Simulator list.  
4. Click OK.   
5. Click the Connect button on the Telescope Setup window to establish a virtual connection 

to the simulated telescope mount. 

Digital Setting Circles 

 
TheSkyX’s Digital Settings Circles window displays a status report that contains, for example, the 
telescope’s RA/Dec coordinates.  The text size is also configurable so that it can be more easily 
read at a distance.  
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This feature is available with both encoder-based systems and telescopes having full computer 
control.  
 
To use it, select the Digital Setting Circles command from the Telescope menu.  
 

 

Figure 178: Digital Setting Circles window. 

Configuring the Digital Settings Circles Report (Report Setup button) 

By default, the report shows universal time (UT) and local sidereal time (LST).  Click the Report 
Setup button to show the Digital Setting Circles report in the Preference window. 
 
Select the attributes you wish to display in the report, and then click Close. 

Telescope Troubleshooting 

Physically connecting a hardware device to computer software is not always a simple task. Things 
can, and often do, go wrong.  Below is a checklist of items to consider before contacting the 
Software Bisque support desk. 
 

• Both the software and the hardware must be correctly configured.  Communication ports, 
cables, connectors and telescope control systems all must be plugged in, turned on, 
connected properly using the correct telescope interface cable and initialized before 
attempting to be “linked” to the computer. 

• Connection cables must be wired correctly.  TheSkyX uses “bi-directional” serial 
communication with most devices.  This means that the connecting cable must be wired 
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properly to send and receive commands.  You can verify that a serial cable is functioning by 
measuring resistance between pins 2, 3 and 5 on each end of the telescope cable. 

• The communication port must be operational.  If you are using a USB to serial adaptor, make 
sure that you have the latest software drivers installed for the device. 

• The proper telescope firmware (that is, the software that is run by the telescope’s control 
system) must be correct before TheSkyX can control the telescope.  Contact the manufacturer 
to obtain firmware updates. 
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Astro-Physics GTO German Equatorial Mounts 

 

Figure 179: Astro-Physics GEM ( Astro-Physics) 

AP GTO Minimum System Requirements 

TheSkyX can control any mount that employs the Astro-Physics GTO control system running 
firmware version G or later (including the GTOCP1, GTOCP2 and GTOCP3).  If you have an older 
version of the firmware, contact Astro-Physics for details about upgrading.  TheSkyX will 
successfully connect to and control earlier firmware versions (for example, Software Bisque has 
successfully tested TheSkyX using the GTO model controller with firmware version D from May 
2001 with the GTO model controller).  However, we strongly recommend using the latest 
firmware version. 

Hardware Requirements 

• Astro-Physics GTO German Equatorial control system with firmware G or later.  

• A standard RS232 serial cable.  Serial cables can be purchased from most any 
computer store. 

• A USB to serial adaptor.   

Step-by-Step AP GTO Setup Procedure 

1. Using a standard DB9 M/F RS232 serial cable, connect the male end of the cable to 
the port labeled COM1 on the GTO Control Panel and the female end to the USB to 
serial adaptor. 

2. Click the Telescope Setup command from the Telescope menu.  
3. Select Mount in the Imaging System list on the left side of the Imaging System Setup 

window.  
4. On the Choose Mount window, select your model telescope and click OK.   If the exact 

model of your telescope is not listed, don’t worry; just select a similar model 
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telescope.  The underlying serial communication protocol is the same for similar 
models. 

5. Click the Settings command on the Mount Setup pop-up menu and then select the 
correct COM port (Windows) or the correct Serial Device (Mac). 

6. On the Imaging System Setup window, turn on the desired preferences and then click 
Close. 

7. Select the Connect command from the Telescope menu.   
 
The telescope cross hair will now display the current coordinates of the telescope.  If the mount 
has not been parked, or has not been initialized with the location, date and time from another 
application, the coordinates of the telescope will be RA: 0h 0' 0" Dec: 90° 0' 0".   
 
AP mounts are automatically initialized using TheSkyX’s time, date, location and Daylight-Saving 
Time adjusted time zone, the mount's tracking is started, and the control system is configured to 
use the more accurate long format mode when sending and receiving equatorial coordinates to 
and from the mount. 

Synchronization vs. Recalibration 

 

 

Synchronizing a GEM when the telescope is pointing to a position in the sky that is 
on the same side of the pier as the telescope (for example, when the telescope is on 
the east side of the pier and is pointing to a star on the east side of the meridian) 
can result in unexpected behavior and possibly damage your equipment.   Please 
carefully read the most recent version of the Astro-Physics Keypad Manual for 
details how to use synchronization and recalibration. 

 
The Astro-Physics command protocol provides two different methods that planetarium software 
like TheSkyX can use to initialize the mount’s control system. 

 

• The Calibrate mount or Sync command (:CM# is sent to the control system) defines both 
the equatorial coordinates of the telescope and on which “side of the pier” the optical 
tube assembly resides.   

 
The normal or expected orientation of a GEM is when the optical tube assembly is on one 
side of the pier (for example, the east side of the pier) and points to a position on the 
opposite side of the pier (in the west).  Always make sure the mount is this normal 
orientation before using the synchronization command.   
 
If you are unsure about which side of the pier the control system “thinks” the telescope 
is on, click the Get Current Settings button under Hand Paddle Status on the 
Miscellaneous tab of the Astro-Physics window. 

 

• The Re-calibrate or Re-Cal command (:CMR# is sent to the control system) is used to 
update the control system with the telescope’s current position only, and does not define 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 402 

the telescope’s side of pier.  Astro-Physics highly recommends using the command 
instead of using the Synchronization command.   

 
When Astro-Physics mounts are controlled by TheSkyX, by default, TheSkyX uses the Astro-
Physics command protocol’s Recalibration command instead of the Calibration command.  See 
page 377 for details about TheSkyX’s telescope Synchronization command.   
 
If you need to use the Astro-Physics Calibrate command to initialize the telescope’s position and 
side of pier information, turn off the Convert Sync to Re-Cal (highly recommended) checkbox on 
the Astro-Physics window.  Don’t forget to turn this checkbox back on once the calibration has 
been performed. 

Astro-Physics GTO Control System Notes 

• TheSkyX always places the Astro-Physics control system into the “long format” mode 
upon establishing a link. 

• Click the Location, Date, Time command from the Tools pop-up menu on the 
Telescope Setup window (Display menu) to compare TheSkyX’s date, time, latitude, 
longitude and time zone settings to the mount.  Click the >> button to reset the AP 
GTO’s values to match TheSkyX’s. 

Astro-Physics Specific Commands 

Select the Astro-Physics Specific command from the Display menu to show commands that are 
specific to this control system.  This command is only available when an Astro-Physics model 
mount is selected Telescope > Telescope Setup window. 
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Figure 180: The Astro-Physics window’s Miscellaneous pane. 
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Figure 181: The Astro-Physics window’s PEC/Backlash/Reticle pane. 
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Figure 182: The Astro-Physics window’s Key Pad pane. 

Most of the AP-specific commands are self-explanatory.  Details about each command can be 
found in AP RS-232 Command Language document which is available from Astro-Physics web 
site. 

Convert Sync to Re-Cal (Highly Recommended) 

When this checkbox is turned on (and is by default), the Astro-Physics Re-Cal command is used 
in place of the Astro-Physics Calibrate command whenever the Star Synchronization command 
(page 377) is issued from TheSkyX.  Turn this checkbox off to use the Astro-Physics Calibrate 
command instead of the Re-Cal command.  
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The Communications Log (page 368) can be used to verify that TheSkyX is 

sending the appropriate commands to the mount. 
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Celestron and NexStar-Compatible Mounts 

 

Figure 183: The Celestron C11-SGT (XLT) Computerized Telescope (NexStar-compatible).   Celestron International. 

TheSkyX controls most NexStar-compatible telescopes manufactured by Celestron International, 
including:   

• Celestron™ Advanced Series (all models) 

• Celestron™ NexStar (all models) 

• Celestron™ CG Series (all models) 

• Celestron™ CGE Series (all models) 

• Celestron™ CPS Series (all models) 

• Celestron™ GT Series (all models) 

• Celestron™ SLT Series (all models) 

• Celestron™ NexStar i Series (all models) 
 
The NexStar control system is also used on telescopes from other manufacturers, including: 

• Orion Telescopes and Binoculars go to telescopes 
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• Sky-Watcher SkyScan go to telescopes 

• Tasco go to telescopes 

Celestron Minimum System Requirements 

TheSkyX can control telescopes that employ the NexStar control system using firmware version 
1.6 and later and motor controller version 4.2 or later.  If you have an older version of the 
firmware, contact the manufacturer for details about upgrading. 

NexStar-Compatible Telescope Hardware Requirements 

• A NexStar-compatible telescope. 

• A NexStar Telescope Interface Cable.  This cable can be purchased from Software 
Bisque, or the manufacturer. 

• A USB to serial adaptor.  
 
Important Notes 
 

• The NexStar firmware version 1.6 and later, and motor controller version 4.2 and later 
are required to support high precision (24-bit) slewing and variable tracking rates.    

 
To determine the NexStar firmware version for your mount, when the hand paddle LED reads 
NexStar GPS, press the Menu button, then press the button labeled UP or DOWN (6 key or 9 key) 
until the Utilities menu appears. Press the UP or DOWN arrows on the keypad until the Version 
option appears, then press the Enter button. The versions for different firmware components are 
listed in the following order: hand controller, motor controller version for each axis, GPS version 
and then the bus control version. 
  
Contact Celestron International for details about obtaining updated firmware for your NexStar. 
 

• NexStar GT Series telescopes using firmware version 1.6 and earlier and motor 
controller version 4.2 and earlier must use the Ultima 2000 model mount.   

• The NexStar command protocol version 4.1 or later supports software 
synchronization (that is, the telescope's position can be defined by external software 
like TheSkyX).  See page 377 for details about synchronizing your mount with TheSkyX. 

 

 

TheSkyX does not require third-party software, such as Celestron’s NexRemote 
application, or virtual serial port drivers, to control NexStar mounts. 

 

Step-by-Step NexStar Setup Procedure 

1. Turn off both the computer and the telescope (always a good idea when connecting devices). 
2. Connect the telescope interface cable to the serial port of the computer and the hand paddle 

of the NexStar (RJ22 end connector).  

http://www.celestron.com/
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3. After the telescope interface cable is plugged into the NexStar’s hand paddle and into the 
USB to serial adaptor, turn both the computer and the telescope on (the order does not 
matter). 

4. Click the Telescope Setup command from the Telescope menu.  
5. Select Mount in the Imaging System list on the left side of the Imaging System Setup 

window.  
6. On the Choose Mount window, select your model telescope and click OK.  If the exact model 

of your telescope is not listed, don’t worry; just select a similar model telescope.  The 
underlying serial communication protocol is the same for similar models. 

7. Click the Settings command on the Mount Setup pop-up menu and then select the correct 
COM port (Windows) or the correct Serial Device (Mac). 

8. On the Imaging System Setup window, turn on the desired preferences and then click Close. 
9. Select the Connect command from the Telescope menu. 
10. Click the Star Synchronization command on the Start Up pop-up menu (page 377), then 

follow the on-screen instructions to complete the initialization. 
 
The telescope cross hairs show the current position of the telescope should appear on the Sky 
Chart. 

For NexStar models 4, 5, 8 (non-GPS), 60, 80 and 114  

Before connecting TheSkyX to the NexStar models 4, 5, 8 (non-GPS), 60, 80 and 114, make sure 
that the hand paddle is in the RS 232 mode. That is, the NexStar hand paddle must display the 
text RS-232 on the top line, and Undo to Exit on the bottom line, at all times so that the 
hardware's serial port is operational; otherwise a connection cannot be established to the device 
through software. If the hand paddle does not remain in RS232 mode at all times, TheSkyX will 
not be able to communicate with the telescope.  

NexStar/TheSkyX Communication Notes 

• Make sure so set the correct Daylight-Saving Time setting on the NexStar hand paddle, 
otherwise TheSkyX’s positions for solar system object, and object rise/set times, will 
differ from the NexStar hand paddle’s values by one hour.    

• The NexStar models 4, 5, 8 (non-GPS), 60, 80 and 114 hand paddle must be in RS232 
mode in order to communicate with TheSkyX.   

• The NexStar models 4, 5, 8 (non-GPS), 60, 80 and 114 must be initialized and aligned 
in order to communicate with TheSkyX.   

• The NexStar models 8 GPS and 11 GPS hand paddle does not need to be in any specific 
mode or show a specific menu to communicate with TheSkyX.   

• The NexStar firmware version 1.6 and later supports Motion Control buttons.   

• The NexStar firmware version 1.6 and later has built-in slew limits. If a slew from 
TheSkyX fails, check the LED readout from the hand paddle to make sure these limits 
have not been exceeded.  
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Gemini Astronomical Positioning System 

 

Figure 184: The Losmandy Gemini astronomical positioning system.   Losmandy Instruments. 

Gemini Minimum System Requirements 

TheSkyX can control any mount that employs the Gemini Astronomical Positioning System 
firmware version 1.05 or later.  If you have an older version of the firmware, contact the 
manufacturer for details about upgrading. 

Hardware Requirements 

• Gemini Astronomical Positioning System with firmware version 1.05 or later.  

• A Gemini telescope cable.  (Contact Losmandy Instruments to purchase this cable.)  

• A USB to serial adaptor.  

Step-by-Step Gemini Setup Procedure 

1. Using the Gemini telescope serial cable, plug the male RJ22 end of the cable into the port 
labeled RS-232 on the Gemini controller and the female end to the USB to serial adaptor. 

2. Click the Telescope Setup command from the Telescope menu.  
3. Select Mount in the Imaging System list on the left side of the Imaging System Setup 

window. 
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4. On the Choose Mount window, select your model telescope and click OK.   If the exact model 
of your telescope is not listed, don’t worry; just select a similar model telescope.  The 
underlying serial communication protocol is the same for similar models. 

5. Click the Settings command on the Mount Setup pop-up menu and then select the correct 
COM port (Windows) or the correct Serial Device (Mac). 

6. On the Telescope Setup window, turn on the desired preferences and then click Close. 
7. Select the Connect command from the Telescope menu.  
8. If the telescope has not been initialized, click Tools > Locate, Date, Time command on the 

Telescope window (Display menu).  This window shows TheSkyX’s settings, and the Gemini’s.  
Click the >> button to set the Gemini’s values to TheSkyX’s. 

9. Click the Star Synchronization command on the Start Up pop-up menu (page 377), then 
follow the on-screen instructions to complete the initialization. 

 
The Gemini should now be initialized and ready to use. 

Gemini Specific Commands 

Select the Gemini Specific command from the Display menu to show commands that are specific 
to this control system.   
 
Note that this command is only available when the Gemini is selected in the Mount pop-up menu 
on the Telescope > Setup window. 
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Figure 185: The Gemini window’s Setup pane (Display menu). 

Details about Gemini window options can be found in Gemini User Manual; this document is 
available on the Losmandy web site (http://www.losmandy.com). 
 
 

http://www.losmandy.com/
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iOptron Mounts 

 

Figure 186: The iOptron EQ45 Pro German Equatorial Mount.  iOptron. 

iOptron Minimum System Requirements 

TheSkyX can control iOptron model altitude/azimuth and equatorial mounts that use the iOptron 
firmware dated after February 2014.  Please contact iOptron support to obtain the latest 
firmware for your model telescope. 

iOptron Hardware Requirements 

• iOptron mount.  

• A standard RS-232 cable (supplied with the mount). 

• A Mac or Windows computer running TheSkyX Professional Edition or TheSkyX Serious 
Astronomer Edition. 

iOptron Software Driver Requirements 

• No software driver is required for iOptron mounts that use a serial (RS232) interface. 

• iOptron mounts that use a USB interface require an operating system-specific Virtual Serial 
Port Driver that must be installed before TheSkyX can communicate with this mount.  The 
SmartStar uses the Silicon Labs CP210X USB to UART Bridge computer chip for serial 
communications, and the driver can be downloaded from the Silicon Laboratories’ web site: 
http://www.silabs.com. 

 
The USB to UART Bridge product page (and drivers) is:  
http://www.silabs.com/products/mcu/pages/usbtouartbridgevcpdrivers.aspx 

 
Download and run the above appropriate installer for your operating system to install the 
VCP driver. 

http://www.silabs.com/
http://www.silabs.com/products/mcu/pages/usbtouartbridgevcpdrivers.aspx
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Step-by-Step iOptron Setup Procedure 

1. If necessary, install the virtual serial port drivers for the iOptron for your operating system 
(see iOptron Software Driver Requirements on page 413).  

2. From TheSkyX, click the Telescope Setup command from the Telescope menu.  
3. Select Mount in the Imaging System list on the left side of the Imaging System Setup 

window. 
4. Click the Choose command in the Mount Setup pop-up menu. 
5. On the Choose Mount window, select your model telescope and click OK.  If the exact model 

of your telescope is not listed, don’t worry; just select a similar model telescope.  The 
underlying communication protocol is usually the same for similar models. 

6. Click the Settings command on the Mount Setup pop-up menu and then select the correct 
COM port (Windows) or the correct Serial Device (Mac). 

7. On the Telescope Setup window, turn on the desired preferences and then click Close. 
8. Select the Connect command from the Telescope menu.  
9. On the Telescope Setup window, select the Location, Date, Time command and verify 

TheSkyX’s location, date, time, and time zone settings match the mount’s settings.  Click the 
right pointing green arrow button to update the mount’s settings to match TheSkyX’s settings 
if they don’t match. 

10. Click the Star Synchronization command (page 377) on the Start Up pop-up menu, then 
follow the on-screen instructions to complete the initialization. 

 
The iOptron should now be initialized and ready to use. 
 

iOptron-specific Settings 

Settings specific to iOptron mounts can be accessed from the iOptron window.  By default, this 
window appears as a pane on the left side of the Sky Chart and is displayed automatically when 
a connection to the mount is established ().  Choose the iOptron command from the Display 
menu to show this window if it is hidden. 
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Figure 187: The iOptron settings window. 

Use this widow to access settings specific to your model mount. 

Tracking Rates 

iOptron mounts support four different tracking rates: 

• Sidereal 

• Solar 

• Lunar 

• King 
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And tracking at the selected rate can be turned on by clicking the Tracking On button, or off by 
clicking the Tracking Off button. 

Hand Controller Status 

These controls can be helpful to double-check that the mount is initialized properly for your site.   

OTA Side of Pier 

For a German equatorial mount, the optical tube assembly normally resides on the west side of 
the pier when observing objects on the east side of the meridian. Likewise, the optical tube 
assembly normally resides on the east side of the pier when observing objects on the west side 
of the meridian.   
 
However, German equatorial mounts can be oriented such that the counterweight shaft is 
“above horizontal”.  In this orientation, the OTA is on the east side of the pier, and observed 
objects are on the east side of the meridian.  In this orientation “atypical” orientation, 
synchronizing the mount to a star causes the telescope to think the OTA is on the opposite side 
of the pier, and subsequent mount slews will end up at the wrong equatorial position.  Before 
synchronizing, orient the mount such that that the counterweight shaft is in a “below horizontal” 
position, then choose a bright star on the appropriate side of the meridian. 

Local Sidereal Time 

Displays the local sidereal time that is computed by the hand paddle.  The hand paddle’s LST must 
closely match TheSkyX’s LST; if they do not, reset the mount’s location, date, and time to match 
TheSkyX, as described above.  If the LSTs differ by one hour, make sure the hand paddle’s 
Daylight-Saving Time setting is correct for your site and for the current date. 

Tracking Rate 

Shows the hand paddle’s current tracking rate. 

Tracking State 

Shows the hand paddle’s current tracking state, either on or off. 

Daylight Saving Time 

Shows if the hand paddle’s Daylight-Saving Time option is in effect or not. 

Enable DST/Disable DST 

Click the appropriate button to enable or disable Daylight Saving Time. 

Anti-Backlash 

To minimize the effects of backlash between the worm and gear, the hand paddle can be 
configured to rotate the right ascension or declination axis by a small amount, in the opposite 
direction of the slew, after a slew is completed.  The amount of rotation is defined by the step 
size in each axis.  Use the hand paddle to determine the angular size, in arcseconds, of each step.  
For example, the Anti-Backlash setup screen on the iEQ30 model states: “One step equals to [sic] 
0.11 arc seconds”. 
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RA/Dec Backlash Step Size 

Enter the number of backlash compensation steps for each axis, then click the Set Backlash 
button to save these values to the hand paddle’s permanent memory. 

Get Backlash 

Click this button to retrieve the current RA and Dec steps from the hand paddle’s permanent 
memory. 

Set Backlash 

Click this button to save the current RA and Dec steps to the hand paddle’s permanent memory. 

Duration of Motion during Autoguiding 

Enter the length of time, in milliseconds, the telescope is moved when guider corrections are 
applied. 
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Meade Instruments Mounts 

 

Figure 188: The Meade Autostar ETX-90PE telescope.   Meade Instruments. 

Meade Mount Minimum System Requirements 

TheSkyX can control LX200 Classic, Autostar, Autostar II, Autostar III and Autostar-compatible 
mounts, including the RCX400 series and telescopes that use the LX200 protocol (including the 
Vixen SkySensor 2000).   

LX200 Classic Hardware Requirements 

• LX200 “classic” model by Meade Instruments Corporation telescope (or a control 
system that uses the LX200 command protocol). 

• An LX200 telescope cable.  This cable can be purchased from the Software Bisque 
Store or the manufacturer. 

• A USB to serial adaptor. 

Autostar and Autostar II Hardware Requirements 

• Autostar, Autostar II-compatible telescope by Meade Instruments Corporation 
telescope (or a control system that uses the LX200/Autostar serial communications 
protocol). 

• An Autostar telescope cable.  This cable can be purchased from the Software Bisque 
Store or from the telescope’s manufacturer.  

• A USB to serial adaptor.    

Autostar III Hardware Requirements 

• A standard USB cable for the Autostar III controller.  The Autostar III controller (for 
example, the ETX-LS) has an integrated USB to serial adaptor so the square end of a 
USB cable can be plugged into the mount’s port labeled USB-B, and the other end 
connected directly to your personal computer’s USB port.   

 
The integrated USB to serial adaptor requires installation of a software driver before TheSkyX can 
communicate with the mount.  Consult the user guide for your mount for instructions on how to 
install the Meade mount’s USB to serial adaptor driver for the Windows operating system (32- 

http://www.bisque.com/sc/shops/store/autostar-nextstar-cable.aspx
http://www.bisque.com/sc/shops/store/autostar-nextstar-cable.aspx
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and 64-bit operating systems require a different driver).  You might also check the Meade USB to 
Serial Downloads page for the most recent drivers.   
 

 

Figure 189: Windows Device Manager showing the ETX LS USB serial port driver’s COM port number assignment. 

The authors have not found a Mac-compatible driver for Meade eFinder Serial Emulator. 
 

Installing Windows 64-bit Autostar III Drivers 

Use the following procedure to install the latest Autostar III Meade eFinder Serial Emulator 
drivers. 
 
1. Run the Autostar Update application (by choosing the Product Updates command on the 

Telescope menu of the Autostar Suite app), then click the Download My Autostar button.  
This will download the latest version of Autostar Update that includes the Windows 64-bit 
compatible LS drivers (this step does not actually install the LS drivers, it just updates the 
installer). 

2. Plug the Autostar III telescope into the computer’s USB port. 
3. From Windows Device Manger, under Unknown Devices, right-click on the Meade eFinder 

Serial Emulator and click the Update Software Driver command.  IMPORTANT NOTE: Meade 
eFinder Serial Emulator is the USB device's name (not the actual USB driver name) and the 
Autostar III device will be listed under Unknown Devices until the actual driver has been 
installed.   

4. From the Update Driver Software window, click the Browse My Computer for Software 
option. 

5. Choose the folder where the Autostar Suite is installed and turn on the Include Subfolder 
checkbox then click Next.   

http://www.meade.com/USB_Serial/USB_SER.html
http://www.meade.com/USB_Serial/USB_SER.html
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6. After the driver is installed, the name of the device is ETX_LS USB Serial Port (COMN) and the 
location of the driver is listed under Ports (COM & LPT). 

Meade RCX400 (Autostar II) Hardware Requirements 

• Meade RCX400 by Meade Instruments Corporation telescope. 

• An LX200-compatible telescope cable.  This cable can be purchased from the Software 
Bisque Store or the manufacturer. 

Step-by-Step Meade Mount Setup Procedure 

TheSkyX must be properly configured before it can communicate your mount. 
 
1. Turn off the telescope.  
2. If your mount has a USB port, insert the square end of the USB cable into the port labeled 

USB-B and the rectangular end into a USB port on your computer.  If the mount has a serial 
port, insert the phone-type connector of the telescope cable into the bottom of the hand 
paddle, and the DB9 connector to the USB to serial adaptor.  

3. Turn on the telescope.  
4. Click the Telescope Setup command from the Telescope menu.  
5. Select Mount in the Imaging System list on the left side of the Imaging System Setup 

window.  
6. On the Choose Mount window, select your model telescope and click OK.   If the exact model 

of your telescope is not listed, don’t worry; just select a similar model telescope.  The 
underlying serial communication protocol is essentially the same for similar models. 

7. Click the Settings command on the Mount Setup pop-up menu and then select the correct 
COM port (Windows) or the correct Serial Device (Mac).  If your mount has a built-in USB to 
serial adaptor, and you’ve installed the drivers for it, use the Windows Device Manager to see 
the COM port number that is assigned to the mount’s USB port. 

8. Click Close. 
9. Click Telescope > Connect. 
10. Click the Star Synchronization command (page 377) on the Start Up pop-up menu, then 

follow the on-screen instructions to complete the initialization. 

Meade Control Window 

Meade specific telescope controls can be accessed from the Meade window.  By default, this 
window is docked to the left side of the Sky Chart and is turned on when you select a Meade 
Instruments mount from the mount list.  Select the Meade command in the Display menu to 
show or hide this window. 

German Equatorial Mount 

Turn this option on if your mount is a German equatorial mount.  This setting is used by the TPoint 
Add On so that it can correctly determine and record which side of the pier the OTA end of the 
declination axis is on when collecting pointing calibration data. 
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Parking a Meade Telescope Mount (Park button) 

Press the Park button on the Meade window to send the mount to the park position.  The 
handbox LED display will show the Turn the Mount Off Now message once parking complete.  
The next time the mount is powered on, no initialization is required. 
 
Note that TheSkyX’s software-based parking is not compatible with Meade mounts due to the 
protocol limitations discussed below.  Therefore, do not use the Park and Unpark commands on 
the Telescope window to park your Meade mount. 
 
See the following section for details on how to set a Meade mount’s park position using the 
simulated handbox controls. 

Simulated Meade Handbox (Autostar Handbox) 

These controls can be used to simulate button presses to the Autostar handbox.  Any command 
that can be accessed by pressing buttons on the handbox can also be accessed through software. 
 
Simulated handbox control is particularly useful to perform certain features that are either not 
supported or inaccessible through the mount’s serial communication protocol.  For example, 
according to the published Meade protocol, the command to set the park position using the 
current position of the telescope (:hS#) is supported for LX200 GPS/RCX400 and LX16 models 
only.   
 
If your Meade handbox includes the Select Item: Setup > Select Item: Preferences > Select Item: 
Parking Place > Select Item: Park Scope Here > Yes/No option, then you can navigate to this 
command using the simulated handbox control buttons to manually set the mount’s park 
position.  (The Autostar I and Autostar III we tested allow the mount’s park position to be 
configured this way.) 
 
When the mount is subsequently parked using the Park button on the Meade window, the mount 
will dutifully slew to this park position before shutting down. 

Allow Handbox Control 

Turn this checkbox on to allow handbox simulation.  (The Autostar I and III mounts we tested 
allow simulated handbox control.  The LX200 Classic handbox has not been tested.) 

Hand Control Display Text 

When the Allow Handbox Control checkbox is turned on, and the telescope is connected, the 
text that is displayed on the handbox LED display is also shown in here.   

Enter/Back/Go To/Mode/Media/Up Arrow/Down Arrow Buttons 

These buttons perform the same operation as the equivalent button on the handbox.  The 
up/down arrow buttons represent the buttons on the bottom of the handbox, not the direction 
buttons.  The Media button is found on the Autostar III handbox only. 
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Troubleshooting the Meade Telescope 

TheSkyX will successfully establish communications with the Meade mounts, provided all of the 
following are true: 
 

• The device is turned on and functioning. 

• The hand paddle is plugged into the telescope’s base panel. 

• The hand paddle is in Polar or Alt/Az mode and not in Land Mode. See the documentation 
for setting this mode. 

• For mounts that require a serial telescope cable, the telescope cable is wired correctly for 
bi-directional communications.  

• For mounts that require a serial telescope cable, the telescope interface cable is plugged 
into the correct serial communications port or USB to serial adaptor. 

• The telescope cable is plugged into the RS232 port on the LX200 base panel.   

• The telescope cable is not plugged into a modem port (Windows). 

• The COM port or USB to serial adaptor is functional, the software drivers are installed, 
and the functioning USB serial port appears in Windows Device Manager.  

• For mounts that require a serial telescope cable, the telescope serial cable (the one sold 
by Software Bisque) is using the DB9 end connector labeled “LX200” not “BBox and 
Compatible”. 

• The correct model mount is selected on the Telescope Setup window.   

• The selected serial device (Mac) or COM port (Windows) is correct.  Click Telescope > 
Telescope Setup > Settings to check this setting.  

 
If all the above is correct, TheSkyX will successfully communicate and control the telescope. 
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Software Bisque Paramount Robotic Telescope Systems 

 

 

Figure 190: The Software Bisque Paramount Robotic Telescope Mounts.  © Software Bisque, Inc. 

The documentation for setting up and using Software Bisque Paramount Robotic Telescope 
Systems with TheSkyX Professional Edition is found in the Paramount User Guide for the following 
models: 
 

• Paramount ME GEM 

• Paramount ME II GEM 

• Paramount MX GEM 

• Paramount MX+ GEM 

• Paramount MYT GEM 

• Paramount Taurus 400 Equatorial Fork Mount 

• Paramount Taurus 500 Equatorial Fork Mount 

• Paramount Taurus 600 Equatorial Fork Mount 

• Bisque TCS/MKS 4000 Dual Axis Motion Control System-controlled mounts 

• Bisque TCS/MKS 5000 Dual Axis Motion Control System-controlled mounts 
 
A printed copy of Paramount User Guide is included with the mount.  A digital copy, in PDF format 
can be downloaded by clicking the Downloads link on the Software Bisque web site.  From there, 
click the Documentation link in the left column, then click on the desired user guide.  The URL of 
this page is: http://www.bisque.com/sc/media/p/75568.aspx. 

Paramount ME and Mac OS X 

The Paramount ME can be controlled by TheSkyX Professional Edition for Mac using the mount’s 
RS 232 port in conjunction with a USB to serial adaptor.  The USA 19-HS High-Speed USB Keyspan 
Adaptor by Tripp Lite is one USB to Serial Adaptor that works well on both Windows and Mac. 
 

http://www.bisque.com/sc/media/p/75568.aspx
http://www.tripplite.com/product/Keyspan-USB-Adapters/849
http://www.tripplite.com/product/Keyspan-USB-Adapters/849
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StellarCAT  

The StellarCAT hardware permits “go to” functionality for Dobsonian-class telescopes. 

Computer Assisted Telescope Innovations 

  

Figure 191: ServoCAT and ServoCAT Jr. Track/GOTO.   StellarCAT. 

StellarCAT Minimum System Requirements 

TheSkyX can show the position of your telescope that uses the StellarCAT and StellarCAT Jr. 
control system, as well as issue slew commands to point the telescope to any object.   

StellarCAT Hardware Requirements 

• StellarCAT or StellarCAT Jr. Track/GOTO system 

• Sky Commander or Argo Navis DSC.  (See the “ServoCAT Quick Start and 
Troubleshooting Guide” for details about setting up the Digital Setting Circle or DSC.) 

• A USB to serial adaptor. 

Step-by-Step StellarCAT Setup Procedure 

TheSkyX must be configured correctly before it can communicate with the StellarCAT.  Please 
consult the StellarCAT User’s Manual for details about setting up and configuring the system 
before attempting to connect it to TheSkyX. 
 

1. Turn off the control system.  
2. Using the appropriate cable, connect the serial port from the serial interface box to 

the computer’s USB to serial adaptor (or serial port).   
3. Turn on the control system.  
4. Select the Telescope Setup command from the Telescope menu.  
5. Select Mount in the Imaging System list on the left side of the Imaging System Setup 

window.  
6. Select the Choose command from the Mount Setup pop-up menu. 
7. On the Choose Mount window, select your model telescope and click OK.   If the exact 

model of your telescope is not listed, don’t worry; just select a similar model 
telescope.  The underlying serial communication protocol is the same for similar 
models. 
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8. Click the Settings command on the Mount Setup pop-up menu and then select the 
correct COM port (Windows) or the correct Serial Device (Mac). 

9. Click Close 
10. Click Telescope > Connect. 

Troubleshooting the StellarCAT Connection 

TheSkyX will successfully establish communications with the StellarCAT, provided all of the 
following are true: 
 

• The device is turned on and functioning. 

• The DSC serial cable is wired correctly for bi-directional communications.   See the 
ServoCAT User’s Manual for details about this cable.   

• The ServoCAT serial cable is plugged into the correct serial communications port or 
USB to serial adaptor (PC side). 

• The ServoCAT telescope cable is plugged into the RS232 port on back of the unit.   

• The telescope cable is not plugged into a modem port (Windows). 

• The COM port or USB to serial adaptor is functional and the software drivers are 
installed.  

• The telescope interface cable (the one sold by Software Bisque) is using the DB9 end 
connector labeled “LX200” and not “BBox and Compatible”. 

• Autostar/LX200 is selected as the Mount.   

• The selected serial device (Mac) or COM port (Windows) is correct.  Click Telescope > 
Telescope Setup > Mount Setup > Settings to check it.  

 
If the all the above is correct, and TheSkyX will successfully communicate and control the 
telescope. 
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Takahashi Temma Mounts 

 

Figure 192: Takahashi Temma mounts.   Takahashi. 

Temma Minimum System Requirements 

TheSkyX can control Takahashi Temma model altitude/azimuth and equatorial mounts, including: 
 

• EM-10 Temma PC Jr. (USD2)  

• EM-200 Temma PC Jr. (USD2)  

• EM-200 Temma PC   

• NJP Temma PC   

• EM-500 Temma PC 

• EM-10 Temma2 Jr. (USD3) 

• EM-200 Temma2 Jr. (USD3) 

• EM-11 Temma2 Jr. (USD3) 

• EM-200 Temma2   

• EM-400 Temma2 

• EM-500 Temma2 

Hardware Requirements 

• Any Takahashi Temma or Temma2 mount.  

• A Takahashi telescope cable (supplied with the mount). 

• A USB to serial adaptor.  

Step-by-Step Temma Setup Procedure 

TheSkyX must be configured correctly before it can communicate with the Temma mount. Make 
sure to set TheSkyX’s location, date, time, time zone and Daylight-Saving Time correctly before 
proceeding. 
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Figure 193: Temma PC Jr. Control Panel 

 
1. Turn off the Temma telescope mount.   
2. Using the gray Temma telescope cable (supplied with your mount), connect the round 

end to the port labeled RS-232C on the Temma mount, and the DB9 end to the USB to 
serial adaptor. 

3. Turn the MOTOR and COMPUTER STAND BY switches to the ON position.  When the 
Temma control system is powered on, it is initialized with the following default 
parameters. 

 

• The control system “thinks” the optical tube assembly end of the declination axis is 
on the West side of the mount.   

• The control system “thinks” telescope is pointing at right ascension 0.0 and 
declination 0.0. 

• The right ascension and declination correction speeds are set to 90.   

• The control system’s tracking direction is for the Northern Hemisphere. 
 
These default parameters will not match the actual position of the optical tube assembly. 
TheSkyX allows you to correctly initialize the Temma’s control system to match the position of 
the OTA. See the steps below to do so. 
 

1. Select the Telescope Setup command from the Telescope menu. 
2. Select Mount in the Imaging System list on the left side of the Imaging System Setup window. 
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3. Select the Choose command from the Mount Setup pop-up menu.   
4. On the Choose Mount window, select your model telescope and click OK.   If the exact 

model of your telescope is not listed, don’t worry; just select a similar model telescope.  
The underlying serial communication protocol is the same for similar models. 

5. Click the Settings command from the Mount Setup pop-up menu and then select the 
correct COM port (Windows) or the correct Serial Device (Mac). 

6. Click Close. 
7. Click the Connect command from the Telescope menu.  The Temma’s local sidereal time 

and latitude are set based on TheSkyX's values.  The telescope cross hairs appear on the 
Sky Chart at 0,0 right ascension/declination.  The Temma’s tracking direction is 
automatically set based on TheSkyX’s North or South latitude setting.   

8. Click the Star Synchronization command (page 377) on the Start Up pop-up menu, then 
follow the on-screen instructions to complete the initialization.  See “Temma 
Synchronization” below for more information. 

Temma Synchronization 

When the Temma mount is powered off, then on, the Temma control system’s right 
ascension/declination coordinates are always 0.0, 0.0.  
 
At this point, you must point the telescope to a known position, and then synchronize TheSkyX 
at that position. 
  

Synchronization Method Procedure 

To synchronize when the optical 
tube assembly end of the 
declination axis is on the West 
side of the mount. 

1. Loosen the clutches on the mount and orient the 
telescope so that the optical end of the declination 
axis is on the West side of the mount. 

2. Keeping the OTA end of the declination axis on the 
West side of the mount, center a known star that is 
on the opposite side of the meridian. 

3. Identify this star in TheSkyX (either by clicking on it 
or using TheSkyX’s Find command from the Edit 
menu.) 

4. On the Telescope window, select the Synchronize 
command in the Start Up pop-up menu and follow 
the on-screen instructions. 

 

To synchronize when the optical 
tube assembly end of the 
declination axis is on the East 
side of the mount. 
 

1. Loosen the clutches on the mount and orient the 
telescope so that the optical end of the declination 
axis is on the East side of the mount. 

2. Keeping the OTA end of the declination axis on the 
East side of the mount, center a known star that is on 
the opposite side of the meridian. 

3. Identify this star in TheSkyX (either by clicking on it 
or using TheSkyX’s Find command from the Edit 
menu.) 
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Synchronization Method Procedure 

4. On the Telescope window, select the Synchronize 
command in the Start Up pop-up menu and follow 
the on-screen instructions. 

 

To synchronize by pointing the 
telescope at the zenith. 

1. Loosen the clutches on the mount and orient the 
telescope so that the optical tube assembly is 
pointing straight up (that is, the OTA is vertical). 

2. Select the Temma command from the Display menu 
to show the Temma window if necessary. 

3. Click the Settings tab on the Temma window. 
4. Click the Sync At Zenith button on the Temma 

window. 
 

No synchronization. If the Temma has been initialized using other software, 
or is still initialized from a previous observing session 
(that is, you did not turn off the Computer Stand By 
switch on the mount). 
 
Click the Connect command from the Telescope menu. 
 

Built-in Backlash Compensation 

The Temma control system has a built-in “backlash compensation” feature that attempts to 
minimize the effects of gear slop.  When the mount is commanded to slew from TheSkyX, it slews 
past the object a small amount, then slews back to it in the direction of sidereal tracking.   

Temma Mount Specific Commands (Temma Window) 

Select the Temma command from the Display menu to show commands that are specific to this 
control system.   
 
Note that this command is only available when the Temma is selected in the Mount pop-up menu 
on the Telescope > Setup window. 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 430 

 

Figure 194: The Temma window’s Settings pane (Display menu). 

Settings Tab 

The Settings tab provides Temma-control system specific mount settings for adjusting tracking 
rates, guide rates, and provides control system status. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 431 

Set Solar Rate 

Click this button to set the mount’s tracking rate to approximate the Sun’s rate of motion across 
the sky. 

RA Adjustment (sidereal seconds/day) 

Enter the adjusted tracking rate for the right ascension axis in sidereal seconds per day. There 
are 86,164 seconds in one sidereal day (1 "earth day" = 1.002738 “sidereal day”).  See the tracking 
rate example below. 

Dec Adjustment (min/day) 

Enter the adjusted tracking rate for the declination axis in minutes per day. See the tracking rate 
example below. 

Tracking Rate Example 

The following example shows how to set the Temma’s tracking rates to match (approximately) 
the Moon’s reported rate.  This same procedure can be used for any solar system object. 
 

1. From TheSkyX, click the Find command from the Edit menu. 
2. Type Moon in the Find text box, and then click the Find button.   
3. On the Object Information window report, note the RA Rate (arcseconds/sec) and the 

Dec Rate (arcseconds/sec). For this example, suppose RA = 0.4334 and Dec = 0.2567.   
4. Compute the RA adjustment using the following equation: (TheSkyX’s RA Rate × –5760). 

The value is –2496.  
5. Compute the Dec adjustment using the following equation: (TheSkyX’s Dec Rate × –1440). 

The value is –370.  
6. Enter both values and click the Set Tracking Rates button. 

Stop RA Motor (Standby Mode) 

Click this button to turn tracking off.  Note that this command is not supported by all Temma 
models.  You may wish to verify that the mount’s motor stops tracking before relying on this 
command to enter standby mode.  

Guide Rates 

RA  

Enter the right ascension correction speed (as a percentage of the sidereal rate).  This setting is 
used for the slow speed when using the Motion Controls. 

Dec 

Enter the declination correction speed (as a percentage of the sidereal rate).  

Set RA/Dec Guide Rates 

Click this button to set the current tracking rate using the number entered in the New text box. 
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Sync At Zenith 

Click this button to synchronize the Temma mount when the OTA is pointing at the zenith. 

Use 12V Power Source Button 

Click this button to configure the Temma control system to use 12-volt power supply. 

Use 24V Power Source Button 

Click this button to configure the Temma control system to use 24-volt power supply.   

• Issuing these commands when the Temma is slewing will cause the mount’s motors to 
stop.  

• Even when a 12-volt power supply is used, clicking the 24V Power Source Button results 
in higher slew rates. 

Status Tab 

Temma’s Local Sidereal Time 

Displays the local sidereal time reported by the Temma control system, in hours, minutes and 
seconds.  

OTA is on this Side of Mount (East/West) 

For German equatorial mounts, the optical tube assembly (OTA) end of the declination axis can 
be located on the East or West side of the mount.  The Temma reports which side of the mount 
it “thinks” the optical tube assembly is on.  Select the appropriate side from the pop-up menu. 

Voltage From Power Supply 

The Temma mount can use either 12V or 24V power.  The actual voltage that is being supplied 
to the control system is shown here. 

Hemisphere Tracking Direction 

TheSkyX’s North/South latitude setting in the Input > Location window is used to configure the 
Temma’s direction of tracking. 

Standby Mode 

Reports whether the Temma mount is in “standby mode,” which means the mount’s MOTOR 
switch (Figure 193 on page 427) is turned off.  When this switch is in the off position, the mount’s 
right ascension axis will not track at the current tracking rate. 

Parking the Temma PC Jr.  

Temma PC Jr. mounts do not allow the mount’s tracking rate to be turned off through software 
(the Motor Power switch must be turned off to stop the motors from tracking at the current 
rate).  Therefore, when the Park command is issued for this mount, TheSkyX still slews the mount 
to the park position, but it must then periodically slew back to the park position every few 
minutes (to undo the rotation or the right ascension axis that is the result of the mount tracking 
at the sidereal rate).   
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Note that “software-based parking and continuous rewinding” is a poor workaround to a 
fundamental shortcoming in the mount’s control system.  Loss of communication between the 
mount and TheSkyX will prevent TheSkyX from correcting the mount’s park position, and will 
most likely result in the mount tracking into itself.  This unfortunate event will most likely cause 
damage to the mount, equipment, cabling or all three.  The Temma control system has no built-
in software or hardware tracking limits and it will try to rotate the right ascension axis even after 
the mount has tracked into a fixed object like, such as the pier. 
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Vixen HTTP Equatorial Mounts 

 

Figure 195: The Vixen™ Sphinx HTTP mount.   Vixen Optics. 

Vixen Minimum System Requirements 

TheSkyX can control Vixen Sphinx HTTP mounts using firmware version 1.2 build 35 and later.  If 
you have an older version of the firmware, contact the manufacturer for details about upgrading. 

Hardware Requirements 

• Any Vixen Sphinx model German equatorial mount that uses the STAR BOOK™ Star-
Chart Go To System.  

• An Ethernet crossover cable for direct connection from the computer to the STAR 
BOOK or an Ethernet straight cable for network connection to the telescope through 
a router. 

Cabling Notes 

The Vixen HTTP mount uses standard network protocol rather than serial communications.  In 
the Settings window, enter the URL of the mount on your network.  The default URL is 
http://169.254.1.1.  Use this address if the Vixen is connected directly to the computer’s network 
port using with an Ethernet crossover cable.    
 
If your mount is plugged into a network router, use a standard network cable instead.   
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Step-by-Step Vixen HTTP Setup Procedure 

1. Plug the network cable into the base of the Star Book and into the computer’s network port; a 
network crossover cable is required for this configuration.  Or, plug the cable into a network 
router or hub using a standard Ethernet cable. 

2. Turn on the mount. 
 

 

When connecting to an existing network, be sure to plug in the network cable 

into the base of the Star Book controller and into a network port before turning 

on the mount.  Otherwise, the default URL of the IP address will be wrong, and 

TheSkyX will not connect. 

 
3. Select the Telescope Setup command from the Telescope menu. 
4. Select Mount from the Imaging System list on the left side of the Imaging System Setup window. 
5. Select the Choose command from the Mount Setup pop-up menu.   
6. On the Choose Mount window, select your model telescope and click OK.   If the exact model of 

your telescope is not listed, don’t worry; just select a similar model telescope.  The underlying 
serial communication protocol is the same for similar models. 

7. On the Imaging System Setup window, click the Settings button from the Mount Setup pop-up 
menu and enter the URL of the Vixen Star Book.  When the mount is turned on and the network 
cable is plugged into both the Star Book hand paddle and the network router, the Star Book’s 
About box shows the URL of this device on the network.  Enter this address into the URL text 
input on the HTTP Port Settings window. 

8. On the Imaging System Setup window, turn on the desired preferences and then click Close. 
9. Select the Connect command from the Telescope menu.  The telescope cross hair displays the 

current coordinates of the telescope. 
10. Click the Star Synchronization command (page 377) on the Start Up pop-up menu, then follow 

the on-screen instructions to complete the initialization. 
 
The Vixen mount should now be initialized and ready to use. 
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Camera Control 

 

 
TheSkyX Professional Edition with the optional Camera Add On can be used to acquire photos 
from CCD, DSLR or video cameras.  The Camera Add On can be purchased from the Software 
Bisque Store and activated using the serial number that is registered to your Software Bisque 
account when the product is purchased.  (You do not need to download and install additional 
software to use the Camera Add On.)  See “Activating the Camera Add On” below for more 
information. 

Activating the Camera Add On 

When you purchase the Camera Add On to TheSkyX Professional Edition from the Software 
Bisque Store, the Camera Add On serial number is automatically registered to your Software 
Bisque account, and can be viewed by visiting your account’s Subscriptions page. 
 
The Camera Add On serial number is used to activate the camera control features directly from 
TheSkyX Professional Edition.  No additional installers, software or software downloads are 
required to use the Camera Add On. 
 
To access your serial number and activate the Camera Add On: 
 
1. Sign in to the Software Bisque web site by clicking the Sign In link in the upper right corner of 

the site.  After you are signed in, your Sign In Name appears in the upper right corner of the 
site. 

2. Navigate to your subscriptions page by clicking your Sign In Name, then click the 
Subscriptions link.   

3. From TheSkyX Professional Edition, click the Telescope Setup command on the Telescope 
menu. 

4. Highlight Camera on the Imaging System list. 
5. Click the Camera Setup pop-up menu and select the Enter Serial Number command. 
6. Manually enter your Name and your Camera Add On Serial Number. 
7. Click OK. 

http://www.bisque.com/sc/shops/store/Camera-Add-On.aspx
http://www.bisque.com/sc/shops/store/default.aspx
http://www.bisque.com/sc/shops/store/default.aspx
https://www.bisque.com/sc/shops/mysubscriptions.aspx
https://www.bisque.com/
https://www.bisque.com/sc/shops/mysubscriptions.aspx
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The Camera Add On to TheSkyX Professional Edition is now activated and ready to use.  You’ll 
need to repeat the above procedure on each computer that is running a licensed copy of TheSkyX 
Professional Edition and the Camera Add On. 
 
Before you attempt to link to the camera, run through this checklist to make sure you are ready 
to begin imaging: 
 

• The camera should be securely attached to the telescope.  If practical, attach a safety wire, 
cable, or strap to catch the camera if it works loose.  The camera’s power and other cables 
may tug on the camera as you move your mount, and if the camera isn't completely secure it 
can work loose, fall off the telescope and damage or destroy the camera. 

• All electrical connections should be secure, and power to the camera should be turned on. 

• The cable from the camera or control box to your computer should be securely attached, 
especially if you have a laptop that may get moved about during use. 

• Double check the routing of all cables to make sure they will not catch on the mount, 
telescope, or other accessories.  We suggest that you route your cables next to the mount, 
then along the telescope to the camera.  This reduces the free-swinging weight of the cables 
and will provide a steadier imaging platform. If your mount provides internal routing for 
cables, make sure all cables attached to the mount are secure. 

Supported Cameras 

The Camera Add On can natively control the cameras listed in the table below. 
 

Camera Manufacturer/Model 
     

Apogee Instruments Alta and later model 
cameras (Andor owns and distributes Apogee 
cameras) 
 

- 
 

- - 

ATIK cameras 
   

- - 

Canon/EOS models1 

   
- - 

DirectShow-compatible video cameras2 
 

- 
 

  

Finger Lakes Instruments/All models 
     

Moravian Instruments cameras3 
  

- - 

Orion Starshoot Autoguider (SSAG) 
  

- - - 

QHYCCD/All models 
 

- 
 

- - 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 438 

Camera Manufacturer/Model 
     

Quantum Scientific Imaging (QSI)/All models 
     
Santa Barbara Instruments Group/All 
models4 
 

   
- 

Software Bisque/Camera simulator5 

     

Starlight Xpress/Lodestar/CoStar/Superstar/ 
Ultrastar/SXVR/Trius models 

 
    

ZWO/All models 
     

 
1The Camera Add On supports Digic III, IV and V model Canon EOS cameras, including: 

• 5D Mark II 

• 5D Mark III 

• 50D 

• 6D 

• 60D(a) 

• 7D 

• 70D (via USB only; Wi-Fi interface not 
supported) 

• 80D 

• 100D Rebel SL1 

• 450D Rebel XSi 

• 500D Rebel T1i 

• 550D Rebel T2i 600D Rebel T3i 

• 650D Rebel T4i 

• 650D Rebel T4i 

• 700D Rebel T5i 

• 1000D Rebel XS 

• 1100D Rebel T3 
 

2 TheSkyX Pro Camera Add On for Windows can take photos from any video device that 
supports the Windows DirectShow media streaming architecture. 
 

3 A Windows X2 Plug In for Moravian Instruments cameras is distributed by Moravian 
Instruments, not Software Bisque, and must be downloaded and installed separately. 
 

4  SBIG DEVICE SUPPORT ON MACOS DISCLAIMER: At the time of this writing, the SBIG 

camera drivers are not digitally signed, so System Integrity Protection (SIP) prevents 

successful installation of the drivers on macOS El Capitan (macOS version 10.11) and 

later.  Please read this support post for instructions how to disable SIP on macOS so that 

the SBIG driver can be installed to allow SBIG device control. 

 

SIP web site: https://support.apple.com/en-us/HT204899  

Software Bisque Community Post: https://tinyurl.com/y95drrt9  

 

5 Camera simulator can acquire photos from the Digitized Sky Survey (web-based, or from the 
10x DSS on the TheSkyX Pro Database Add On). 
 
The Camera Add On can also control any camera with an X2 Camera Plug In that adheres to the 
X2 Standard (page 440) on Mac or Windows, or any ASCOM-compliant cameras, Windows only. 

http://www.gxccd.com/art?id=431&cat=1&lang=409
https://support.apple.com/en-us/HT204899
http://www.bisque.com/sc/forums/p/29925/151692.aspx#151692
https://support.apple.com/en-us/HT204899
https://tinyurl.com/y95drrt9
http://www.bisque.com/help/theskyx%20pro%20info/Database_Add_On.htm
http://www.bisque.com/x2standard/
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Note that third-party vendors can develop, distribute and install third-party camera drivers 
independent of Software Bisque and TheSkyX Professional Edition’s installers, so the above list 
may not be comprehensive.   
 
To view the list of supported cameras by the Camera Add On: 
 

1. Click the Telescope Setup command on the Telescope menu 
2. Highlight Camera in the Hardware List on the left side of the Imaging System Setup 

window. 
3. Click the Choose command from the Camera Setup pop-up menu. 

 
If your model camera is not listed, check with the camera’s manufacturer to find out if a TheSkyX 
Professional Edition Camera Add On or X2 Camera Plug In is available. 
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X2 Camera Plug In and Camera Drivers 

 

Figure 196: Minimum requirements for camera control. 

Figure 196 shows the minimum software and hardware components that are necessary for the 
Camera Add On to “take a picture” with an astronomical camera.  The top and bottommost 
components are obvious; the purpose of the less obvious middle two software components is 
described below. 
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Original Equipment Manufacturer (OEM) Camera Driver 

Camera hardware and firmware require a camera software driver (or camera driver) to send 
commands to, and receive commands from, a personal computer.  This two way communication 
is usually performed using a USB, Ethernet, Wi-Fi, parallel port, or other standard 
communications interface.   
 
The camera driver is normally developed, distributed and updated by the original equipment 
manufacturer (OEM), not Software Bisque. 
 
For cameras that require a separate OEM driver, you must download and install the camera driver 
from the manufacturer’s web site before the Camera Add On can control it.  See the table under 
“X2 Plug In and Driver Distribution” on page 442 for a list of each camera manufacturer and the 
Mac/Windows OEM camera driver availability.   
 
Like all software, camera drivers are periodically updated to fix bugs, or add new features.  
Software Bisque recommends that you keep your camera driver up to date by installing the latest 
drivers from the OEM’s web site.  Installing the latest camera driver is also an excellent first step 
when troubleshooting camera-related problems. 

X2 Camera Plug In 

The Camera Add On communicates with a camera device driver through a software component 
called the X2 Camera Plug In.  X2 Camera Plug Ins are based on Software Bisque’s X2 Plug In 
Standard Interface (www.bisque.com/x2). 

http://www.bisque.com/x2
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X2 Plug In and Driver Distribution 

 

Figure 197: X2 Camera Plug In and OEM Camera Driver distribution options. 

Figure 197 shows the three camera driver distribution options for the TheSkyX Professional 
Edition and the Camera Add On.  The shaded regions indicate which component is distributed by 
TheSkyX Professional Edition.  
 
The camera driver and X2 Plug In distribution options include: 
 

• TheSkyX Pro distributes both the X2 Camera Plug In and the OEM Camera Driver.  

• TheSkyX Pro distributes only the X2 Camera Plug In.  The OEM Camera Driver must be 
downloaded and installed from the camera manufacturer’s web site. 

• TheSkyX Pro does not distribute either the X2 Camera Plug In or the OEM Camera Driver.  
Both must be must be downloaded and installed separately from the camera 
manufacturer’s web site. 

 
Cameras that can be controlled by the Camera Add On using an X2 Camera Plug In and the OEM 
Camera Driver are considered “natively supported.”  

To configure the Camera Add On to control a natively supported camera:  

1. If necessary, install the OEM camera driver from the manufacturer’s web site listed in the 
table above. 
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2. If necessary, install the X2 Camera Plug In from the manufacturer’s web site listed in the 
table above. 

3. From TheSkyX Professional Edition, click the Telescope Setup command from the 
Telescope menu. 

4. Double-click Camera in the Imaging System list to display the Choose Camera window. 
5. Expand and highlight your model camera, then click OK.  If the exact model of your camera 

is not listed, choose a similar model camera. 
6. Click the Settings command from the Camera Setup pop-up menu to display the ASCOM 

Chooser window then choose your camera.   
7. Click the Properties button on the Chooser window to configure the camera and click OK. 
8. Click OK to close the Chooser window. 
9. Click the Connect command from the Camera Setup pop-up menu on the Imaging System 

Setup window to connect to the camera. 

Third-Party Camera Drivers 

TheSky Pro Camera Add On for Windows can control cameras that have an ASCOM driver. 
 
To configure the Camera Add On to control a camera that has an ASCOM camera driver:  
 

1. Download and install the ASCOM platform.  Details how can be found on the ASCOM web 
site. 

2. Download and install the ASCOM-driver for your camera (visit the ASCOM web site, or the 
camera manufacturer’s web site to download it). 

3. From TheSkyX Professional Edition, click the Telescope Setup command from the 
Telescope menu. 

4. Double-click Camera in the Imaging System list to display the Choose Camera window. 
5. Expand ASCOM and highlight ASCOM Camera, then click OK. 
6. Click the Settings command from the Camera Setup pop-up menu to display the ASCOM 

Chooser window then choose your camera.   
7. Click the Properties button on the Chooser window to configure the camera and click OK. 
8. Click OK to close the Chooser window. 
9. Click the Connect command from the Camera Setup pop-up menu on the Imaging System 

Setup window to connect to the camera. 
 
The ASCOM camera is now ready to be controlled from the Camera Add On. 

MaxIm DL Controlled Cameras 

In addition to native camera support and ASCOM camera support, the Camera Add On can 
acquire photos from any camera controlled through Cyanogen’s MaxIm DL.  Note that MaxIm DL 
is required for the Camera Add On to be able to communicate with cameras under the control of 
MaxIm DL. 
 
To configure the Camera Add On to control MaxIm DL’s camera:  
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1. Install the MaxIm DL Pro or MaxIm DL DSLR software and configure your camera based 
on the software’s instructions. 

2. From TheSkyX Professional Edition, click the Telescope Setup command from the 
Telescope menu. 

3. Double-click Camera in the Imaging System list to display the Choose Camera window. 
4. Expand Diffraction Limited and highlight MaxIm DL’s Camera, then click OK. 
5. Click the Connect command from the Camera Setup pop-up menu on the Imaging System 

Setup window to connect to the camera. 
 
The Camera Add On will now use the MaxIm DL-controlled camera to acquire photos. 

Controlling a Camera  

Once the camera and the computer are powered up, start TheSkyX Professional Edition and then 
choose the Telescope Setup command from the Telescope menu.  This displays the Imaging 
System Setup window.  In the Hardware List on the left side of this window, click on the Camera 
text to display the camera setup options shown in Figure 198. 
 
Click the Choose command from the Camera Setup pop-up to select your camera from list (see 
Figure 200) and click OK.   
 
If you have a filter wheel, focuser or rotator installed/attached to the camera, select the model 
from the hardware list. 
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Figure 198: The Camera Setup options on the Imaging System Setup window. 

Selecting Camera in the Hardware list displays camera driver details and other camera-specific 
preferences. 

Currently Selected Camera (Camera text) 

The Camera text at the top of the Imaging System Setup window shows the manufacturer and 
model of the currently selected camera. 

Camera Setup Pop-Up Menu 

The Camera Setup pop-up menu provides commands for choosing, setting up, connecting, 
disconnecting and entering the Camera Add On serial number. 

Choose 

Click this command to display the Choose Camera window.  The Camera list shows all supported 
models. 

Settings 

Click this command to display camera-specific port setup and driver options. 
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Connect 

Choose this command to establish a connection to the camera. 

Disconnect 

Choose this command to stop communicating with the camera.  

Enter Serial Number 

Choose this command to enter your Camera Add On serial number.  See “Activating the Camera 
Add On” on page 436. 
 
After selecting your model camera, click the Settings command in the Camera Setup pop-up 
menu to configure the communication interface and other camera-specific options. 

Camera Status (Status text) 

This text box displays the current camera status. 

Hardware and Driver Information 

When Camera is highlighted in the Hardware list on the Imaging System Setup window, the 
following camera hardware and camera driver-specific information is displayed. 

Device Name 

This text box shows the name of the selected device.  

Device Description 

This text box shows an abbreviated description of the device. 

Driver Information  

This text box shows additional information about the driver for this device. 

Driver Version  

This text box shows the version of the software driver used to control this device. 

Firmware Version 

This text box shows the version of the device’s firmware, when available. 

Model 

This text box shows the hardware’s model as reported by the device’s firmware, when available. 

Camera Preferences 

You can specify the default values that the Camera Add On will use when saving photos under 
the Preferences section of the Imaging System Setup window. 
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New Photo Defaults 

These values will be stored to the appropriate FITS keyword in the FITS header when new photos 
are acquired. 

Observer 

Enter the name of the observer.  The value is saved to the OBSNAME FITS keyword in the FITS 
header. 

Origin 

Enter the place of origin of the photograph, typically the observatory name of observing site.  This 
value is saved to the ORIGIN FITS keyword in the FITS header. 

Telescope  

Enter the physical characteristics of the telescope or optical tube assembly below.   

Description 

Enter a description of the telescope. 

Focal Length 

Enter the focal length of the telescope, in millimeters.   This value is: 

• Used to compute the AO Wander metric for the autoguider camera.  When entering the 
telescope’s focal length for AO Wander, be sure to set the autoguider’s preferences by 
highlighting the camera listed under Autoguider, not the camera listed under Imaging 
System. 

• Used to compute the image scale of a photo (in arcseconds per pixel) taken with the 
selected camera or autoguider.  This image scale is displayed on the right side of the y-
axis of autoguider graphs (see Figure 216). 

• Saved as the value of the FOCALLEN keyword in the FITS header.   

Aperture Area 

Enter the area of the telescope’s mirror, in square millimeters.  The Aperture Area value is used 
to specify the area of the aperture, minus any central obstruction, and is saved as value of the 
APTAREA keyword in the FITS header.  

Aperture Diameter 

Enter the diameter of the telescope’s mirror, in millimeters.  This value is saved as the value of 
the APTDIA keyword in the FITS header. 

AutoDark Subtract Uses All Processors 

For computers that have more than one processor, turn this checkbox on to allow the Camera 
Add On to use all available processors when performing auto dark calibrations. 

AutoSave Setup 

Click this button to show the preferences to use when photos are automatically saved (page 462). 
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Display Camera Temperature Status 

When this checkbox is turned on, the camera’s temperature-related settings, including 
temperature, set point, and the cooler’s power usage are displayed below the Camera Status text 
on the Camera window.   Turn the checkbox off to hide these settings.   

Auto Reverse X for GEMs 

Turn this checkbox on to so that the direction of the x-axis guider corrections are automatically 
reversed when the telescope on a German equatorial mount changes sides of the pier. 
 

Accurate Shutter Timing 

Turn this checkbox on to record accurate time stamps in the FITS header. 
 

 

• This option is hidden by default, and is shown only when the appropriate 
time-source software is running when TheSkyX is launched. 

• This option is compatible with TheSkyX for Windows, only. 

SBIG Camera Settings  

 

Figure 199: The SBIG Camera Settings window. 

Use the SBIG ST… Settings window to set the communications interface, binning options and the 
roles of the camera’s imaging and autoguiding sensors. 

Camera Communications (Interface text box) 

SBIG cameras can be connected to a computer using one of the following communication 
interfaces. 
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Interface Name Description 

Ethernet  SBIG offers an optional Ethernet communications box that 
uses TCP/IP network protocol to communicate with the 
camera. 
 
After selecting the Ethernet option, enter the IP Address 
assigned to the camera and click OK. 
 

USB The USB option applies to all “modern” SBIG cameras.   
 
Selecting the USB interface allows the SBIG camera driver to 
automatically locate the camera plugged into the USB port. 
 
If you own two SBIG cameras and want to assign a specific 
USB port to a specific camera, choose the USB1, USB2, USB3 
or USB4 option and click OK. 

 
The Camera Add On does not support legacy SBIG parallel port cameras. 

Use Off-Chip Binning 

Turn this checkbox on to have the SBIG camera driver perform binning rather than the SBIG 
camera hardware.  

Vertical N Binning (Spectroscopy Use Only) 

Enter the bin value (1-255) used when performing spectroscopy with the SBIG camera. 

Swap Detector Roles 

Turn this checkbox on to use the camera’s main sensor as the guiding sensor and the guiding 
sensor for the imaging sensor. 

Setting Up an SBIG Camera 

Follow the steps below to configure TheSkyX Professional to control an SBIG model camera. 
 
1. Install the SBIG camera drivers for your operating system.  If necessary, use SBIG’s free CCOPS 

software for your OS to make sure the driver is properly installed and you can take photos 
with the camera. 

2. Make sure your camera is plugged in, turned on and connected to a USB port on your 
computer.  Before attempting to connect to the camera, allow about 30 seconds or so for the 
SBIG camera to initialize. 

3. From TheSkyX, select the Telescope Setup command from the Telescope menu. 
4. Select the Camera text in the Imaging System list. 
5. Click the Choose command on the Camera Setup pop-up menu to display the Choose Camera 

window.  If you have not purchased the Camera Add On, click the Run Trial button to use 
begin the 90-day trial period. 

 

http://www.sbig.com/sbwhtmls/softpage.htm
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Figure 200: Figure 158: The Choose Camera window. 

5. Expand SBIG, then select your camera model and click OK.  The name of the selected camera 
will appear at the top of the Camera window (Figure 201). 

6. Select the Connect command from the Camera Setup pop-up menu or click the Connect 
button on the Camera window.  If the SBIG drivers are installed properly, after about fifteen 
seconds, the green Ready status text appears on the Imaging System Setup window and on 
the Camera window.   

Configuring the Remote Guide Head 

SBIG offers a separate Remote Guide Head (RGH) for the STT, STXL and STX Series cameras.  The 
RGH allows autoguiding using a separate guide scope, off-axis guider or camera lens.  When 
plugged into the camera’s Remote Head port, the RGH effectively replaces the functionality of 
the camera’s built-in autoguider.   
 

1. Click the Telescope Setup command from the Telescope menu.  
2. Double-click Camera under Imaging System on the left side of the window.  
3. Expand SBIG, then choose SBIG <Your Model Imager Name> and click OK.  
4. Double-click Camera under Autoguider and choose Imager's Built-in Autoguider.   
 

 

The SBIG RGH is considered a "built-in" autoguider and the SBIG driver will recognize 
this device only after connection to the Imager is established. 
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Canon DSLR Cameras 

Canon DSLRs are popular for astrophotography and the Camera Add On allows these cameras to 
be an integral part of your digital imaging workflow. 

Canon Camera Plug In Minimum Requirements 

TheSkyX Professional Edition’s Canon DSLR Plug In is intended to work with all Canon Digic 4 or 
later DSLRs on the following operating systems. 

Mac OS X Minimum Requirements 

• An Intel-based Mac running Mac OS X 10.6 (Snow Leopard) or later.  Attempting to connect 
to a Canon DSLR using Mac OS X 10.5 or earlier with this plug in will always result in the error 
message: “A necessary driver was not found.” 

Windows Minimum Requirements 

• Windows 10, 8 or Windows 7, 32- or 64-bit operating system. 
 

 

The Canon camera’s mirror must be unlocked before the camera can be controlled from the 
Camera Add On.  See the camera’s documentation for details how to unlock it. 

Canon Camera Minimum Requirements 

The Camera Add On supports Digic 3, 4, and 5 model Canon EOS cameras, including: 
 

• 1D X 

• 5D Mark II 

• 5D Mark III 

• 50D 

• 6D 

• 60D(a) 

• 7D 

• 80D 

• 100D Rebel SL1 

• 450D Rebel XSi 

• 500D Rebel T1i 

• 550D Rebel T2i 

• 600D Rebel T3i 

• 650D Rebel T4i 

• 650D Rebel T4i 

• 700D Rebel T5i 

• 1000D Rebel XS 

• 1100D Rebel T3 

• 1200D Rebel T5 
 

 
Choose Universal/Generic for unlisted Digic 3, 4, or 5 models from the Canon camera list if your 
model is not listed. 
 
The Digic 4 processor was also used in some of the latest Canon PowerShot series cameras.  
However, the mechanics of connecting these model cameras to a telescope can be difficult and 
are beyond the scope of this document.   
 
The Canon X2 Plug In may be compatible with older model cameras, but may not be able to take 
exposures over 30 seconds (which is a severe limitation for anything beyond automated TPoint 
calibration runs).  
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Canon Camera Acquisition Modes 

Canon cameras have the following methods for taking a photo (also known as “acquisition 
modes”). 
 
1. Luminance:  This mode works best for automated pointing calibration runs and Image Links.  

(This mode is a bit of a cheat for a one-shot color camera.  It uses a standard RGB to 
Luminance formula to derive the luminance values from the RGB components.  Not perfect, 
but works very well for these tasks.)  THIS IS THE ONLY CURRENTLY FUNCTIONING MODE 
FOR THE CANON PLUG IN. 

2. Canon Debayer: For color images, this will use the built-in Canon debayer algorithms.  (Under 
development.) 

3. RAW Color:  Better debayer routines.  This mode may replace the Canon Debayer mode after 
further testing takes place. 

4. SuperPixel: Converts a 2x2 RAW OSC pixel block (before debayering) into a single RGB pixel.  
This mode will provide good color results, at a lower reduced resolution.   

5. LiveView: This mode has many potential applications, but is still under development. 

Binning 

Canon DSLR’s do not support hardware binning.  This software binning mode simply sums 
neighboring pixels.  

Known Canon Driver Limitations 

• Luminance acquisition only. 

• Mirror lock cannot be enabled.  No error messages reported, the driver will just hang when 
attempting to take an exposure. 

• Camera mode dial must be set to Manual. 

Setting Up a Canon Camera 

Follow the steps below to configure TheSkyX Professional to directly control a Canon camera. 
 
1. Download and install TheSkyX Professional Edition version 10.3.0 or later from the Software 

Bisque web site: http://www.bisque.com/sc/media/p/47013.aspx. 
2. Make sure your camera is plugged in and turned on.   
3. From TheSkyX, select the Telescope Setup command from the Telescope menu. 
4. Select the Camera text in the Imaging System list. 
5. Click the Choose command on the Camera Setup pop-up menu to display the Choose Camera 

window.  If you have not purchased the Camera Add On, click the Run Trial button to use 
begin the 90-day trial period. 

6. Expand Canon, click Canon DSLR and click OK (or double-click on the camera model to select 
it and close the window.) 

7. Select the Connect command from the Camera Setup pop-up menu or click the Connect 
button on the Camera window.  After about thirty seconds, the green Ready status text 
appears on the Imaging System Setup window and on the Camera window.   

 

http://www.bisque.com/sc/media/p/47013.aspx
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TheSkyX Professional Edition can now acquire photos from the Canon camera. 
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Orion Starshoot Autoguider 

The Camera Add On can autoguide telescopes via Relays (page 483) using the Orion Starshoot 
Autoguider (SSAG) on both Mac and Windows.   
 

1. The SSAG’s hardware relays do not adhere to the SBIG ST-4 standard, so you must use the 
autoguiding cable that comes with the guider, otherwise the telescope will not respond 
to guider corrections issued from the camera. 

2. On the cameras the driver author tested, the first row of pixels in all full and subframes 
acquired with this camera are consistently “garbage” (that is, they contain random data).   
As a workaround to this behavior, the first two rows in the photo are ignored and appear 
all black.   

3. Dark frames are automatically acquired to mitigate hot pixels while autoguiding with this 
model camera.   
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Taking Photos 

 

Figure 201: The Camera Add On window. 

Once the camera is selected and communication established, take a photo using the default 
settings by clicking the Take Photo button on the Camera window.   
 
When the exposure is complete, the photo is downloaded from the camera and displayed in the 
“FITS Viewer Window” (page 107). 
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Establish Communication with the Camera (Connect button) 

Click the Connect button to establish a communication link between the camera and TheSkyX.  
The Ready status text indicates the camera is ready to acquire photos.  

Camera Cooling (Temp. Setup button) 

Click this button to specify the cooling point for the camera. 

Terminate Communication with the Camera (Disconnect button) 

Click the Disconnect button to end communication with camera.  This step is usually performed 
at the end of the imaging session.  The status text will show Not Connected. 

Take a Photograph (Take Photo button) 

Click this button to take a photo with the selected camera using the current camera settings. 

Abort Exposure Process (Abort button) 

Click this button to immediately end the process of acquiring a photograph from the camera.    

Select Exposure Length (Exposure Time) 

The maximum exposure length is determined by how good your polar alignment is, and by how 
accurately your mount tracks. If you see stars trailing into lines, shorten your exposure until this 
goes away (or take some time to improve your polar alignment or the accuracy of your mount’s 
tracking). If you see wiggly lines on long exposures, then your mount's tracking error is too large 
for the current focal length.  Use a focal reducer, or switch to a scope with a shorter focal length 
that better fits the capabilities of your mount. 
 
The following table includes some recommended exposure times for various objects. The table 
assumes a focal ratio in the range of about f/7.  Use longer exposures for longer focal ratios, and 
shorter exposures for shorter focal ratios.  If you get blooming on a particular object, then go to 
a shorter exposure. If you don't get much detail in the image, or it seems washed out, go to a 
longer exposure.  Generally speaking, unless you run into blooming, saturation, or other 
problems, longer exposures are generally better. Experiment to find the best exposures for your 
setup. You might want to keep a written record of successful exposures, which you can use as a 
guide for future imaging sessions. 
 

Object Suggested Exposure Range 

Sun Use a visual solar filter, plus any additional filters needed to cut the light. 
Polarizing filters, moon filters, or other specialized filters such as h-alpha 
filters can reduce the light so that your camera's shortest exposure will be 
sufficient for solar images. Do not use so-called photographic solar filters. 
These are intended for film, which is much less sensitive than your CCD 
detector.  

 
Never attempt to photograph or view the sun without a proper solar filter! 
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Object Suggested Exposure Range 

Bright planets Planets such as Venus, Jupiter, Saturn and Mars require surprisingly short 
exposures with most setups, as little as 5 to 10 thousandths of a second.  
However, if you use a Barlow or eyepiece projection to increase the focal 
ratio to f/20 or even f/30, longer exposures (up to a full second) may be 
required. 

 

Moon The moon is also very bright, especially around full moon, and may require 
some effort on your part to attenuate the light sufficiently for imaging.  
Polarizing filters and moon filters, or both, will get the job done.  As with 
solar images, the shortest possible exposure of your camera should be tried 
first.  Then add additional filtering if that isn't short enough, or increase the 
exposure if it's not long enough. 

 

Open clusters, 
bright globular 
clusters 

These objects require relatively short exposures, and exposure length is 
usually limited by blooming if you don’t have an anti-blooming camera.  If 
you do have an anti-blooming camera, you can even image open clusters 
long enough to image background galaxies.  For clusters with very bright 
members, or globular clusters with very bright cores such as M13, 
exposures under a minute should be enough.  Dimmer clusters may require 
exposures longer than a minute.  Very bright clusters, such as the Pleiades, 
may only work well with anti-blooming cameras.  For color imaging, be 
careful not to saturate bright stars so you can get truer star colors. 

 

Galaxies Galaxies come in a enormous range of brightness levels.  M31 will show up 
in an exposure of a few seconds; M101 may require 5 to 10 minutes or 
more.  Generally speaking, edge-on spirals and elliptical galaxies are 
brighter and require shorter exposures.  Face-on spirals are usually the 
dimmest galaxies and require longer exposures.  When using a scope with 
a very long focal length, large pixels or binning may be required to get 
reasonable exposure times. 

 

Nebulas Nebulas come in an even wider range of brightness than galaxies do. Some, 
like M42, will yield excellent results in less than 20 seconds.  Others, like the 
Rosette Nebula, may require 20-minute exposures to get good detail.  A few 
trial exposures will help you determine the best exposure for any given 
nebula. 

 

 
Generally speaking, longer exposures are better in most cases because they provide better-
quality data.  However, blooming, the risk of passing satellites or airplanes, and other factors 
usually limit the longest exposure time you can use.  You can take multiple exposures and 
combine them in various ways to increase the quality of your photos. 
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Delay before Taking Photo (Exposure Delay) 

Enter the number of seconds to wait before taking the next photo.  This delay useful to allow the 
telescope to settle, or to make sure everything is in order before taking a long exposure. 

Select Bin Mode (Binning pop-up) 

Binning is an on-camera process that effectively combines the signal from a group of adjacent 
pixels into a single pixel on the photo to increase the sensitivity but decreases the photo’s image 
scale.  Binning pixels allows you to match pixel size to telescope focal length. Pixels that are small 
require longer exposures and provide higher resolution.  Large pixels allow shorter exposures but 
provide lower resolution.  For any given combination of camera and telescope, one bin mode or 
another will provide the optimal compromise between exposure duration and resolution.  
 
Figure 202 shows how binning works.  Binning 2x2 groups four pixels together, giving you virtual 
pixels that are made up of 4 actual pixels.  Binning 3x3 yields virtual pixels made up of nine actual 
pixels. 
 

 

Figure 202: Bin modes group pixels together for greater sensitivity, at a cost of lower resolution. 

Figure 203 shows the relative sizes of image taken with 1x1 binning (larger image) and 2x2 binning 
(smaller image).  Both images cover exactly the same area of sky, about 1 by 1.5 degrees in this 
example.  The 2x2-binned image shows that the binned detector is more sensitive because there 
is more detail visible in the dim areas of M42.  It also shows that the binned pixels bloom less 
quickly – four pixels can hold more energy than one before they spill over into adjoining pixels. 
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Figure 203: Relative sizes of a 1x1- and 2x2-binned image. 

Generally speaking, you will most often use a bin mode that will delivers between 2 and 4 
arcseconds per pixel.  This is the most common range for general-purpose CCD imaging. When 
working in this range, each pixel in the image “sees” or covers 2 to 4 arcseconds of the sky. The 
seeing conditions on most nights allow approximately 2 to 4 arcseconds of detail, and that is the 
reason for this range of values.  If you have better or worse seeing conditions, select a bin mode 
based on your local conditions. 
 
High-resolution imaging provides fewer than 2 arc-seconds per pixel, and can only be done on 
nights when the seeing is exceptionally good.  This type of imaging is used most often for planets, 
but can also yield very fine detail on galaxies.  The key is to wait for exceptional seeing conditions 
that will support higher resolution. 
 
Low-resolution imaging (more than 4 arc-seconds per pixel) allows you to image wide fields of 
view, and can be done with camera lenses or telescopes with very short focal lengths. Seeing is 
unlikely to affect low-resolution wide-field images, so you can do this kind of imaging on almost 
any clear night. 
 
You can use various tools and web pages to determine arcseconds per pixel for your camera and 
telescope combination, or use the following formula: 
 

( )
th_in_mmfocal_lengtelescope_

s_in_micronpixel_size*205
 

 
If you are binning 2x2, be sure to double the pixel size to get the correct value. For example, if 
you have an ST-7E camera (9-micron pixels) and are using it unbinned on a Meade LX200 8-inch 
at f/10, this is: 
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( )
2000

9*205  

 
Or 0.93 arcseconds per pixel. That's very high resolution. Since a typical night offers 2-4 arcsecond 
seeing conditions, you would rarely be able to use all that resolution. Binning 2x2 yields 18-
micron pixels, which gives you 1.86 arc-seconds per pixel. This is just under two arcseconds per 
pixel, and offers a good compromise on nights of typical seeing. 
 
You can also approach this from another direction: using a 50% focal reducer will bring the focal 
length of this scope down to 1000mm, which provides 1.86 arcseconds per pixel unbinned. 
 

 

• Binning also increases the sensitivity of your camera, as shown in Figure 
203.  Smaller pixel size means higher resolution, while larger pixel size 
means greater sensitivity.   
 
When you bin 2x2, you are making the pixel size four times larger in 
area, so the virtual pixel is four times more sensitive to light. You are 
making a tradeoff between resolution and sensitivity whenever you 
select a bin mode for your image.  
 
Try an experiment for yourself.  Take a one-minute exposure of a galaxy 
using 1x1, 2x2, and (if available) 3x3.  Note the differences in resolution 
and sensitivity. 

 
 • The range of available bin modes depends on the camera hardware.  

While the Camera Add On attempts to use information from the camera 
driver to list only the bin modes that are available for your camera, 
please consult the camera’s documentation to determine the bin modes 
that your camera supports. 
 

 

Set Frame Type to Light 

If you are just getting started, make sure that the Frame is set to Light.  The Frame pop-up also 
includes settings for taking photo reduction frames.  A CCD detector generates a certain amount 
of noise, and photo reduction removes a great deal of that noise. When you are taking a photo, 
always set the frame type to Light. 
 

Frame Types Description 
Light A normal photo, taken with the shutter open. 

 
Bias A frame of the shortest possible exposure, taken with the shutter closed.  

It represents the minimum noise in the CCD detector and camera circuitry.  
This frame is subtracted from Dark frames so that the dark frames can be 
scaled for time and temperature differences. 
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Frame Types Description 
Dark A photo taken with the shutter closed.  It is in effect a picture of the 

electronic noise in the camera.  This noise can be subtracted from a Light 
image to create a cleaner image. 
 

Flat Field A flat-field is an image taken of an evenly illuminated field, with the shutter 
open. Think of the flat-field as a photograph of the optical noise in the 
system, such as dust motes on glass surfaces or reflections off of the inside 
of the telescope.  The Flat Field is applied to the Light frame to eliminate 
this source of noise. 
 

Set an Appropriate Reduction Setting (Reduction pop-up) 

When you select Light as the frame type, you can also choose the type of reduction to apply to 
the photo.  Reduction is the process of applying bias, dark, and flat-field frames to your image to 
reduce system noise. 
 
For your first images, choose the AutoDark reduction setting. After your exposure is finished, the 
software will automatically take a dark frame with the same exposure settings, and subtract it 
from the photo. This will give you a cleaner image with less thermal noise. When you gain more 
experience, you can explore the other reduction options: 
 

Dark Frame Description 
None The software performs no photo reduction.  Use this setting when you wish 

to manually apply your own bias, dark, and flat-field images; or when you 
simply want a quick image without any reduction. 
 

AutoDark This will follow the first exposure with a single dark frame.  The dark frame 
is saved in memory and will be applied to all subsequent exposures with 
the same duration and temperature.  If you change the exposure duration, 
or the camera’s cooled temperature changes several degrees, a new dark 
frame will be taken.  For computers with more than one processor, see 
“AutoDark Subtract Uses All Processors” on page 447 to speed this process. 
 

Full Calibration Photos are calibrated using a master frame from the selected calibration 
Group. 
 

Group The Group pop-up appears when Full Calibration is selected from the 
Reduction pop-up and is hidden otherwise.  Choose the name of the image 
calibration group to apply to each photo. 
 

Image 
Calibration 
Library 

Click this button to open the Image Calibration Library window.  The 
controls on this window can be used to define calibration groups and create 
master frames (page 550). 
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Acquire a Partial Frame (Subframe On checkbox) 

Turn on this checkbox to acquire a photo using only a portion of the detector, rather than the full 
frame.  This can be useful, for example, to speed the photo download process when focusing on 
a star. 

Define the Partial Frame Size (Size button) 

Click this button to shows the Subframe window and define the position and of the subframe 
rectangle on the photo. 

Subframe Window 

 

 

Figure 204: The Subframe window. 

Left/Top Position 

Enter values to define the top and left position of the subframe rectangle on the photo. 

Width/Height 

Enter values to define the width and height of the subframe rectangle on the photo. 

Full 

Click this button to reset the dimensions of the subframe to match the size of the entire photo. 

Half 

Click this button to define a subframe that covers the top half of the photo. 

Quarter 

Click this button to define a subframe that covers the top, left quarter of the photo. 
 

Automatically Save Photos 

Turn on the Automatically Save Photos checkbox to automatically save each acquired photo to 
the computer’s hard drive. 
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On the Imaging System Setup window, highlight Camera in the Hardware list, then click the 
AutoSave Setup button to configure how photos are saved.  The most common choice is to 
automatically save all photos. You can even save focusing photos if you so want.  Photos from 
both the imager and autoguider can be saved automatically. 
 

 

Figure 205: The AutoSave Setup window with the advanced settings hidden. 
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Figure 206: The AutoSave Setup window showing the advanced settings. 

AutoSave Folder 

This text box shows the current folder where photos are saved.  The default location is the 
AutoSave folder in the Application Support Files folder (page 26).  Click the Choose button to 
select a different folder.  

Automatically Save Photos 

Turn the checkbox on to save all photos. 
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Sequence Number 

Each time a photo is saved using AutoSave, this Sequence Number is incremented by 1.  If you 
want to have a unique number for every photo, leave this value unchanged.  Or, you can reset 
the sequence number back to 1 every observing session or every series of photos.   

File Name Prefix 

Use this text box to define the text that will appear at the beginning of each file name. 

Sample AutoSave File Name 

This text box shows what an automatically saved file name will look like based on the current 
settings. 

Show/Hide Advanced  

File names for light, bias, dark and flat frames can be customized individually by turning on the 
Show Advanced radio button and defining the frame-specific file name “keys”.  Each key defines 
specific information that is used to construct a unique file name. 

Date-based Subfolder Format 

Autosave automatically creates a new folder for each observing session and uses the current date 
for the folder name.  The text that appears in this text box defines the format and position of the 
month, day and year for the folder name.   
 
For example, for photos created and auto-saved on January 1, 2030, the default text MMM dd 
yyyy will save files to the folder named Jan 01 2030.  See “Date & Time Format Configuration” 
on page 224 for date formatting options, or hold the mouse cursor over this control to show a 
tool tip with this information. 

Customize AutoSave File Names (Light, Bias, Dark, Flat Frames) 

For each frame type, enter a set of “abbreviations” to define the file name. 
 

Abbreviation Explanation  
:a Enter the colon character followed by a lower case letter “a” to insert the date 

when the photo is acquired.  For example, the text 01 31 2012 is inserted in 
the file name for photos acquired on January 31, 2012.    
 
See “Date & Time Format Configuration” on page 224 for details how to 
format the date and time. 
 

:b Enter the colon character followed by a lower case letter “b” to insert text 
that defines the bin mode (1x1, 2x2, 3x3) used to acquire the photo. 
 

:B Enter the colon character followed by an upper case letter “B” to insert text 
that defines the orientation of a German equatorial mount when the photo is 
acquired.   
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Abbreviation Explanation  
The “beyond the pole” (Btp) convention is used to define the position of the 
optical tube assembly end of the declination axis with respect to the celestial 
pole. 
 
NoBtp: The mount’s current orientation is not beyond the pole. 
Btp: The mount’s orientation is beyond the pole. 
 

:c Enter the colon character followed by a lower case letter “c” to insert the 
current temperature sensor. For example, –5.02C.   
 

:e Enter the colon character followed by a lower case letter “e” to insert the 
exposure time, in seconds. For example, 61.05secs.  
 

:f Enter the colon character followed by a lower case letter “f” to insert the filter 
name used to acquire the photo. For example, Green. 
 

:i Enter the colon character followed by a lower case letter “i” to insert frame 
type. For example, Light. 
 
Options: 
Light 
Bias 
Dark  
Flat 
 

:m Enter the colon character followed by a lower case letter “m” to insert the 
exposure time, in minutes. For example, 1.02mins.  
 
 

:q Enter the colon character followed by a lower case letter “q” to insert the 
current sequence number in the file name.  
 
Note that a sequence number is always included in AutoSave file name.  If no 
:q appears in the custom name, the sequence number appears at the end of 
file name, before the file name suffix.  Otherwise, add a :q at the desired 
position of the sequence number. 
 

:t Enter the colon character followed by a lower case letter “t” to insert the 
name of the target object. For example, Andromeda Galaxy. 
 

Extension (suffix) 

Enter an extension for the AutoSave file name that appears after the period character in the file 
name.  By default, the three-letter extension fit is used when automatically saving Flexible Image 
Transport files. 
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Small Mount Adjustments via Camera Relays, DirectGuide, or PulseGuide 

Click the +X/+Y/–X/–Y buttons to make small adjustments to the mount’s position using the 
current autoguide method.   
 

• Camera Relays: the camera’s guider relays are activated which pulls to ground the 
appropriate lead(s) through a guider cable to the mount’s guider port to move the 
telescope.  

• Direct Guide: the mount’s position is adjusted directly through the mount’s control 
system (Paramount and Bisque TCS-controlled mounts, only). 

• PulseGuide: the telescope is move by sending “small” telescope move commands directly 
to the telescope’s control system (non-Paramount mounts). 

Digitized Sky Survey Photos (Simulate Photo Using DSS) 

Turn on the Simulate Photo Using DSS checkbox to take photos of Digitized Sky Survey objects, 
instead of collecting “actual” photons with the camera’s detector and a telescope.  See “Creating 
a FITS File of a Digitized Sky Survey Photo” on page 106 for more information about configuring 
TheSkyX Pro to retrieve photos from the Digitized Sky Survey. 
 
You can control where in the sky the simulated camera is pointing by selecting a new target in 
the Find window (page 70), or connecting to a simulated (or actual) telescope, and then slewing 
the telescope to the target (page 381) 

Taking a Photo 

To take a photo, click the Camera tab, enter the Exposure Length, Binning and click Take Photo 
button.  
 
When the photo is ready, it is displayed in the FITS Image Viewer window (page 107). 
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Autoguiding 

The Camera Add On incorporates many powerful features for autoguiding using CCD, DLSR or 
video camera.   
 
This chapter describes how to use the Camera Add On to autoguide using a camera with dual 
CCDs from SBIG (essentially two cameras in one, where autoguiding is called Self-Guiding) or 
autoguide using two independent cameras, one for imaging and one for autoguiding.  We 
typically refer to the imaging camera or "main camera", the one that is capturing the resultant 
autoguided photo, as the "Imager" and the autoguiding camera as the Autoguider.  
 
Here you will learn how to: 
 

• Determine how well your mount can autoguide. 

• How to fine-tune your mount for autoguiding. 

• How to use the autoguiding features in the Camera Add On effectively. 

• How to customize the autoguiding settings to meet your needs. 

Quick Start for Experienced Users 

For this chapter, an experienced user is someone who is familiar with autoguiding a mount 
through software. 
 

One important feature in the Camera Add On is the ability to continue autoguiding even after 
downloading an image.  This allows you to take multiple, autoguided photos without restarting 
autoguiding.  The autoguiding process runs independently of the imaging process.  In fact, if you 
have a physically separate, independent autoguider, autoguiding is continuous (with an SBIG dual 
CCD the imager and autoguider share the same shutter so autoguiding is briefly paused while the 
imager is downloaded). 
 
Another key feature: since the TheSkyX Professional Edition with the Camera Add On includes a 
complete framework for star charting and telescope control, the Camera Add On offers 
unsurpassed camera, guider, focuser, filter wheel, rotator, and mount integration. 
 
Before you can autoguide, you must first calibrate the autoguider.  Open the Autoguider tab 
(click Display > Autoguider if the window is not visible), and follow these steps: 

Autoguider Calibration  

1. From the Autoguide tab on the Autoguider window, click Connect.   
2. Click Take Photo and use the mount’s motion controls, or the camera's relay buttons, to 

position a bright calibration star on the autoguider photo, and not near an edge of the 
photo.  For best results, the star should not be saturated and there should not be any 
stars of similar brightness on the photo so that the bright calibration star can be easily 
recognized.  



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 470 

3. Click Calibrate.  While the calibration is in progress, the autoguider photo shows arrows 
on the photo to indicate the direction the calibration star moves as each relay is activated 
(that is, when the mount is moved).  If calibration fails due to insufficient guide star 
movement, click Settings and increase the X and Y calibration times and or check the relay 
cable from the camera to the mount to make sure it is functioning properly. 

4. When calibration is complete, the results are displayed (you can view the results any time 
by clicking Setup and going to the Relay Calibration Results tab). 

Autoguiding 

From the Autoguide tab for the Autoguider: 
 

1. With no sub-frame and 1x1 binning, click Take Photo.  Adjust exposure time so that one 
or more guide stars are visible.  See “Choosing a Good Autoguider Calibration Star” on 
page 476 for details. 

2. Double click on the guide star.  A track box is centered on the guide star and momentarily 
flashes to identify the guide star selection.  You can also choose the guide star by clicking 
the Auto Find Guide Star button to scan the entire image for the brightest light source 
and place the track box on it. 

3. Click Take Photo to confirm the brightness, location and presence of the guide star.   
4. Click Autoguide to start the autoguiding process.  Watch the X and Y errors; when they 

“settle down” and are at acceptable levels, from the Camera tab, click Take Photo to 
begin acquiring your “guided” photo. 

Principles of Autoguiding 

The fundamental idea behind autoguiding is simple: For successive photos, the Camera Add On 
measures the exact position (the star’s centroid) of the guide star.  If the star’s position deviates 
from one exposure to the next, the Camera Add On adjusts the telescope to keep the guide star 
at its original position.  This process minimizes mount tracking errors that cause elongated stars. 
 
The Camera Add On can control two independent cameras (one for autoguiding and the other for 
imaging), or an SBIG dual CCD that contains both an imaging CCD and an autoguiding CCD.   
 
You can also configure the Camera Add On to use either detector as the imager or the autoguider.  
This means that every feature available to the imaging camera is also available to the autoguiding 
camera, and vice versa.  To use this advanced capability, turn on the Advanced Camera User 
Interface (Restart Required) checkbox from the Advanced pane of the Preferences window (The 
Preferences command is accessed from TheSkyX menu on the Mac, the Tools menu on 
Windows).   
 
When this checkbox is turned on and, after TheSkyX Professional Edition is restarted, the Camera 
window has both a Take Photo tab and an Autoguide tab.  Similarly, the Autoguider window has 
both a Take Image tab and an Autoguide tab.  To minimize confusion, this option is off by default.  
Just remember, the Camera and the Autoguider can both image and autoguide and you are free 
to choose which configuration option best suits your needs. 
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The basic steps to autoguide are: 
 

1. Calibrate your autoguider (The Camera Add On determines how the mount reacts to 
guider corrections). 

2. Choose a guide star. 
3. Autoguide; that is, continually adjust the position of the mount so the guide star remains 

at a fixed position. 
 
Unwanted motion of the guide star typically results from three sources: 
 

• Poor polar alignment, which causes a slow drift of the field. 

• Periodic error in the mount's mechanics, which causes star images to elongate as the mount 
speeds up and slows down by very small amounts during rotation of the worm gear. 

• Systematic errors due to flexure, variations in gears, etc. (Paramount owners should turn on 
ProTrack so the autoguider has less to do). 

 
Various complexities creep into the seemingly simple autoguiding operation (that is, slewing the 
telescope to a star and guiding on a star over a long period): 
 

• The required pointing accuracy is very high, usually on the order of several arcseconds.  Since 
one arcsecond equates to one part in 1,296,000, the magnitude of pointing accuracy isn't just 
high; it’s extraordinarily high. 

• The longer the focal length of your telescope, the greater the accuracy required for accurate, 
successful guiding. 

• Mounts have some degree of repeating error, called periodic error.  Some mounts have built 
in periodic error correction (PEC); some do not.  Autoguiding can correct most tracking errors 
related to periodic error. 

• If the mount is even slightly misaligned from the celestial pole, telescope drift over time is 
introduced and will cause tracking errors.  The greater the misalignment, the greater the drift.  
Good polar alignment makes autoguiding easier. 

• Any mechanical “looseness” in the mount can contribute to pointing error (hysteresis).  There 
are many potential sources of hysteresis, including backlash (slop) in the gears, mirror flop, 
and endplay of a worm gear.  Some hysteresis can create counterintuitive movements, such 
as a movement in declination causing a movement in right ascension.  You can diagnose these 
types of problems by using a high-power reticle eyepiece to observe what happens during 
tracking and guiding. 

• The tripod, mount, and the optical tube assembly are subject to different amounts of flexure 
as the weight of the telescope moves over time.  This can contributes to guiding errors and 
to pointing errors as well. 

• If all of the parts of the mount aren't exactly aligned with each other, pointing error is the 
result.  For best results, you want your telescope orthogonal to the mount, especially when 
polar aligning.  (The optional TPoint Add On to TheSkyX can be used to automatically correct 
these errors.)  

• Turbulence in the atmosphere (seeing) can change the apparent position of the star used for 
reference in a random manner over time.  This makes it look as if a guiding correction is 
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needed even when it is not, or depending on timing, it could also mask the need for guiding 
corrections.  The worse the seeing, the harder it is to guide accurately.  Longer guide 
exposures can compensate for poor seeing, to some degree. 

 
In short, keeping a telescope pointing at an object over the length of time involved in an extended 
exposure is not a trivial task.  Any given mount will have a certain level of accuracy that it can 
reach.  Pushing a mount past this point will result in guiding and tracking errors that will at the 
very least reduce the quality and sharpness of your images, and at worst turn stars from round 
circles into ellipses or worst case lines.  If you find that your mount simply cannot track or guide 
accurately enough for your equipment, try shortening your focal length with a focal reducer, or 
switch to a telescope with a shorter focal length. 

Assessing Mount Accuracy 

A mount has two axes, and most mounts can guide by adjusting both axes.  However, the right 
ascension and declination axes behave in fundamentally different ways. 
 
The right ascension axis is always moving to keep up with the apparent motion of the stars.  This 
rate of motion is called the sidereal rate, and is very nearly one revolution per day.  You will often 
see reference to some fraction of the sidereal rate, such as 1x (exact sidereal rate), 0.5x (one-half 
sidereal rate), etc. 
 
Because the right ascension axis is always moving, you have an opportunity to eliminate many 
(but not all) sources of error by simply making guiding corrections at speeds slower than the 
sidereal rate.  For example, it is common to make right ascension adjustments using either 0.5x 
sidereal (slow the mount down to half speed to move it further east), or 1.5x sidereal rate (speed 
the mount up to 150% of sidereal rate to move it further west).  Depending on the focal length 
of your telescope, you may get better results at 0.75x/1.25x (shorter focal lengths), or at 
0.25x/1.75x (longer focal lengths). 
 
The declination axis, on the other hand, is stationary until a correction needs to be made.  If there 
is substantial looseness in the declination axis at any point (motor bearings, reduction gears, 
worm endplay, or worm mesh with the worm gear), the mount may literally be unable to guide 
adequately in declination. 
 
The result of these differences is that special attention must be paid to the state of the 
declination axis components to obtain high-quality guiding results.  See “Assessing Autoguiding 
Possibilities,” for detailed information about getting the best autoguiding results out of your 
mount. 

Autoguider Calibration 

Once your mount is tuned to minimize backlash and/or correct any other problems, you can use 
it for autoguiding.  See the section “Adjusting and Tuning Your Mount” for details on getting the 
most out of your mount. 
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Autoguiding makes small corrections to keep a guide star at a given location on a CCD.  This 
corrects for small errors in polar alignment; for periodic error that results from slight eccentricity 
in the worm or worm gear; and other errors that result from a mount and system that is simply 
not perfect.  The pixel size of your CCD, the focal length of your telescope, and the length of your 
guide exposures all affect the rate and amount of movement during an autoguiding correction. 
 
The autoguide correction speed also changes with declination.  At the celestial equator, 
correction speed is highest because the lines of equal right ascension are furthest apart.  Near 
the poles, the effective correction speed is slower because the lines of equal right ascension are 
closer together.  The autoguider calibration takes care of this.  
 
Before you can autoguide, you need to perform an autoguider calibration.  Calibration allows 
Camera Add On to determine your system's behavior during autoguiding corrections.  The 
Camera Add On uses the calibration data to determine how long to move the mount (at whatever 
guide speed you are using) to make an appropriate autoguider correction.  You can perform a 
single calibration, and Camera Add On will adjust the corrections for other declinations.  If you 
choose this method, you should perform the initial calibration near the celestial equator so that 
the scaling will be most accurate.  You can also perform a new calibration whenever you move 
the telescope to a new declination to achieve the highest level of autoguiding accuracy.  The 
longer your focal length, the more you must gain from performing new calibrations when you 
change declination. 
 
The basic steps in calibrating the autoguider: 
 
1. Connect the hardware to autoguide.  This is typically accomplished by connecting a guider 

cable from the camera to the mount.  Paramount users can configure the Camera Add On to 
autoguide using DirectGuide, which eliminates the need for a guider cable. 

2. Move the telescope so that a suitably bright star falls on the autoguider detector. 
3. Take a reference image to verify the presence, location, and brightness of the calibration star. 
4. Perform the calibration. 
 
How often should you perform a calibration?  Calibration frequency depends on your imaging 
session and your equipment.   
 
If you have a GEM, and “flip” the mount to point on the other side of the meridian, the direction 
of correction for the x relay changes direction.  When TheSkyX Professional Edition is controlling 
the telescope, the Camera Add On automatically detects the meridian flip and reverses relay 
direction. 
 
If you are using the Camera Add On to autoguide, and the telescope is not controlled by TheSkyX 
Professional Edition, the Reverse X checkbox on the Autoguide tab reverses X corrections, and 
you can manually turn this checkbox on when the mount is on the opposite side of the meridian.  
But remember, (especially with longer focal lengths), you can always recalibrate the autoguider.  
The longer your focal length, the greater the sensitivity to changes, and the more likely you are 
to need to recalibrate whenever you autoguide at a new location. 
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To calibrate the autoguider, from the Autoguider tab, click the Autoguide tab.  For an overview 
of all of the controls on the Autoguide tab, see “Autoguide Tab” on page 491. 
 

 

Figure 207: The Autoguider window. 

Make sure the hardware is connected 

To autoguide, you need either a camera that will be dedicated to autoguiding, such as a video 
camera, SBIG ST-i, or an SBIG dual CCD camera that has its own built-in autoguiding detector.  
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Consult the camera documentation for instructions on how to connect the autoguider cable to 
the camera.  The other end of the autoguide cable attaches to your mount; consult your mount 
documentation for the location of the autoguider connection. 
 
Not all mounts support input from an autoguider.  Contact the mount manufacturer for 
information on how to build an interface box or cable to fit such a mount.  Most cameras come 
with a standard autoguider cable.  If the standard cable doesn't fit your mount (such as for a 
Takahashi mount, or a Vixen Sky Sensor-equipped mount), consult the mount documentation for 
information about building or buying a suitable cable.  Some mounts require the use of third-
party relay hardware to provide appropriate guide signals; read your camera and/or mount 
documentation for details. 

Choosing a Good Autoguider Calibration Star 

When calibrating the autoguider, selecting an appropriate calibration star is important.  As you 
will see shortly in the list of possible errors, the brightness and location of the star used for 
autoguider calibration plays a major role in the success or failure of the calibration.  Here are 
some tips in picking a good autoguider calibration star. 
 

• Don't use a dim, hardly recognizable, calibration star. 
o The calibration star should be bright enough to show clearly against the background.  

Typically this is achieved if you can visually and easily identify the star on the 
autoguider photo using the Camera Add On’s standard auto-contrast routines.  In 
other words, do not try to calibrate the autoguider using a dim, hardly recognizable 
star.  You can run the cursor over the star and the background to see how bright they 
are; the brightness values appear at the left of the status bar at the bottom left of the 
photo window.  The longer the exposure, the brighter the stars and background, but 
star brightness will increase faster than background brightness.  If you can't find a 
suitable calibration star for a given exposure, increase the exposure time to see if any 
good candidates emerge.  

• Don't use a saturated calibration star. 
o The calibration stars brightness should not be close to the camera’s saturation level.  

The calibration star brightness will indeed vary and you want make sure it does 
saturate because saturation can lead to an incorrect star position and thus leading to 
an incorrect autoguider calibration. 

• Don't use a calibration star close to the edge of the CCD. 
o The calibration star should not be near any edge of the autoguider CCD.  This is critical 

when calibrating, since the Camera Add On will move the mount during autoguider 
calibration and you don't want the calibration star to move off the detector.  If the 
calibration star moves within 10 pixels of an edge, calibration will fail with an error 
stating so.  You can use the camera relay buttons, the telescope's motion controls, or 
the mount's hand controller to move the calibration star more toward the center of 
the photo.   

• During autoguide calibration, the Camera Add On finds the autoguide calibration star after 
each calibration relay adjustment (that moves the mount) by scanning the photo for the 
brightest light source.  Because the Camera Add On can autoguide with the camera at any 
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orientation, the Camera Add On does not make any assumptions about which way the 
calibration star will move with respect to relay activations and instead relies on the 
convention that the brightest light source on the autoguider photo during autoguide 
calibration is the calibration star.  It is critical that during autoguide calibration the calibration 
star is significantly brighter than all other stars on the image otherwise the Camera Add On 
might incorrectly choose a different calibration star of similar brightness on a subsequent 
photo.   

• Sometimes an unintended bright star will enter the photo after relay activation and usually 
results in the calibration error "invalid motion".  In this case, pick a different autoguide 
calibration star in a different area.  No other star in the tracking detector’s image should be 
close to the brightness level of the calibration star when calibrating.  Otherwise, the Camera 
Add On can get confused about which star is the calibration star.  You can use the Camera 
Add On to visually inspect the area around your selected guide star.  Check for a distance 
equal to the 1.5 times the width of the area covered by the autoguiding CCD detector at a 
minimum.  See the section “Select a Guide Star,” in this chapter, which can help you select a 
guide star. 

• Accurate focus is required to accurate autoguider calibration.  See “Using @Focus2” on page 
572 for a reliable, automated focus method. 

• Make sure the camera is cooled to the desired temperature setpoint to minimize noise/hot 
pixels. 

• Turn on AutoDarks so that calibration images do not have as much noise or hot pixels. 

• Do not use a long calibration time.  The shortest calibration time that results in a successful 
calibration without a “Motion too small” error is optimal.  There is not a lot to gain by having 
an unnecessarily long calibration time and there are in fact disadvantages; the whole 
calibration takes longer and the chances of the calibration star moving off the photo increase. 

 

 

If you find that calibration repeatedly to fails because the Camera Add On finds a 
different calibration star from photo to photo, use the a subframe to capture less of 
the photo and aid the Camera Add On in finding the same bright, calibration star in 
photo to photo.   
 
In other words, the subframe applies during autoguide calibration and you can use 
that to your advantage (and perhaps avoid a say pesky hot pixel in a certain region 
of the CCD).  Avoid making the subframe too small or the calibration might move 
the guide star off the photo. 

Choosing a Good Guide Star 

• The Camera Add On is able to autoguide with either a dim guide star that is only a few counts 
above the background, which can be challenging, or a guide star that is bright and easily 
recognizable to the eye, which is less challenging.  Generally speaking, autoguiding will do 
fine if the guide star is, say, 1,000 or more counts brighter than the background (more if you 
are doing tricolor imaging, since color filters will reduce the star's brightness, and the 
brightness of the star will often vary with the filter used). 

• If your image composition makes it impossible to put the guide star near the center for 
autoguiding, you can still get good results as long as the star is at least 10 pixels from an edge.  
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However, you increase the risk of losing the guide star during downloads from the Imager.  
The Camera Add On will automatically reacquire the guide star after Imager download, but 
cannot do this if the guide star has moved off the detector.  The greater the periodic and 
random errors of your mount, or the poorer the polar alignment, the greater the chances of 
losing the guide star during Imager download. 

• When autoguiding, a star of similar brightness should not be within the autoguider track box, 
or the Camera Add On may jump between the two stars during autoguiding. 

Take a Photo as a Reference 

Typical autoguide exposures range from 1 to 10 seconds.  Shorter and longer exposures can be 
used, but are not often necessary.  Guide exposures shorter than 1-2 seconds can be affected by 
seeing.  When the guide exposure is very short, the autoguiding often winds up measuring and 
correcting for fluctuations in the atmosphere rather than actual guide star movement that needs 
to be corrected.  If the autoguide exposure time is too long, the guide star could move so much 
that corrections are not being made when they should be, resulting in an undesirable final image 
with elongated stars. 
  
The Camera Add On automatically accounts for autoguiding at a declination different from where 
the autoguider was calibrated, provided TheSkyX Professional Edition is controlling the mount 
during autoguider calibration and during autoguiding.  If no mount is connected, you must 
manually enter the declination that the telescope is pointing to in the box labeled Declination.  
An accuracy of one-tenth degree is sufficient if you enter this value manually. 
 
The image you take as a reference image should be long enough to clearly acquire a star suitable 
for guiding.  If you are unsure, start with an exposure of 1 to 10 seconds.  You can always adjust 
the exposure length as needed. 
 
Click Take Photo on the Autoguide tab to acquire an autoguider photo.  Figure 208 shows the 
result for the guide detector on an SBIG ST-2000 camera.  The guide detector is much smaller 
than the imaging detector, so download times are short.  By default, a dark frame is automatically 
taken and subtracted from the light frame (reduction is set to AutoDark). 
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Figure 208: An autoguide image taken for reference.  Note the isolated, bright star makes a good choice for a guide star. 

Evaluate the image to determine if the exposure time provides a suitable brightness level for the 
guide star.  As mentioned earlier, a good guide is at least 1,000 units over background level, and 
not near saturation. 

Select a Guide Star 

You can either click Auto Find Guide Star on the Autoguide tab to have the Camera Add On pick 
the brightest star for the guide star, or you can double click any desired guide star on the photo.  
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A white track box flashes briefly around the star to indicate that it has been selected as the guide 
star.  Also, the coordinates of the selected guider star appear in the X and Y boxes of the Use 
Guide Star At control.  
 
The Camera Add On can display the precise coverage of your CCD detector on the sky display (ST-
237 and similar cameras) or both the imaging and tracking CCD detectors (ST-7/8/9/10) on the 
map of the sky.  Figure 209 shows the projection for an ST-8E camera.  The inner rectangle is the 
imaging detector; the small rectangle above it is the tracking detector.  The circles show the 
position of the tracking detector if you rotate the camera.  These circles can help you find an 
alternate guide star just by rotating the camera, instead of moving the mount.  The Camera Add 
On does not require that the camera be orthogonal (square) to the mount in order to autoguide.  
It will calibrate and guide successfully at any camera angle. 
 

 

Figure 209: The imager and autoguider detectors of an ST-8E with an ST-237 guider camera.  

To set up your camera's field of view indictor, follow these steps in TheSkyX Professional Edition: 
 

1. Click Display > Field of View Indicators. 
2. Choose your telescope and detector and click Create My FOVIs. 
3. Click the My FOVIs tab, turn on the checkbox next to your FOVI and click Center. 

 
The field of view indicator will only appear when magnifications on the start chart are large 
enough to see it.  Zoom in if necessary to see the field of view indicator (page 119).   
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In Figure 210, the pair of interacting galaxies known as Messier 51 (M51) is centered on the 
imaging detector, and celestial north is straight up on the Sky Chart.  The box at the top shows 
that there are a few dim stars on the tracking detector, but none is very bright, and none are near 
the center.  The two galaxies form a nearly vertical line with each other, and several dimmer 
galaxies are also in the frame.  You could try to guide using the star at the eight o'clock position 
on the tracking detector, but for calibration you should move the mount to bring a brighter star 
onto the tracking detector. 
 
A brighter guide star allows you to use a shorter guide exposure time.  If your mount is very stable 
and accurate, you can use longer guide exposure times and therefore dimmer guide stars are 
suitable.  If your mount has poor polar alignment, larger periodic error, or suffers from random 
movements during tracking, brighter guide stars are more important to a nicely autoguided 
Imager photo. 
 
Figure 211 shows one approach to finding a nice, bright guide star: move the mount so that a 
bright star falls on the guide detector, while M51 remains in the same orientation.  M51 has been 
moved away from the center of the imaging detector.  If you want M51 near the center, you can 
also rotate the camera to bring a guide star onto the guide detector.  If your mount has goto 
features, you can control it from TheSkyX Professional Edition.  Changing the camera’s rotation 
requires a trip out to the telescope, unless the Camera Add On is connected to the rotator. 
 

 

Figure 210: Placing a guide star on the autoguider. 
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If you were performing a calibration, the bright star in Figure 211 is clearly brighter than others 
in this field.  It is an ideal star for calibration.  For this star, use short exposure time; this also will 
speed up the calibration process.  In general, you should expect to move your mount away from 
the object you intend to image to do a calibration, because putting a bright calibration star near 
the center of the detector is important to successful autoguider calibration.  With the Camera 
Add On available to position the mount, you can move, calibrate, and return to your object very 
quickly. 
 
If you want to keep M51 at or near the center for taking the actual image, rotating the camera to 
bring a guide star onto the tracking detector works well.  Figure 211 shows that a rotation that 
puts north at about eight o'clock puts a reasonably bright star on the tracking CCD detector.  You 
can experiment with TheSkyX Professional Edition to find the right rotation angle, and then 
physically adjust the camera to the new orientation.  Since the Camera Add On can guide 
accurately at any orientation, even 45 degrees away from orthogonal, you have complete 
flexibility in framing your images.  If the Camera Add On is connected to a camera rotator, your 
FOVI can be linked to the rotator (page 609) so that when you rotate the FOVI on screen, the 
rotator hardware follows. 
 

 

Figure 211: Rotating the view to look for a suitable guide star. 

Adjust Calibration Settings 

During calibration, the Camera Add On will move the mount for a period of time, then take 
another image and determine the motion of the calibration star (that is, how far the mount has 
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moved).  Each photo is displayed along with graphical arrows indicating how the calibration star 
moved so that you can follow along.  These images and arrows (resultant calibration vectors) are 
a useful for diagnosing common problems that occurs during calibration.  
 
The software measures the amount of movement of the calibration star from one photo to the 
next.  The exact sequence is as follows: 
 

1. Take an initial reference photo. 
2. Active the +X relay, take a photo, measure calibration star movement. 
3. Active the –X relay, take a photo, measure calibration star movement. 
4. Active the +Y relay, take a photo, measure calibration star movement. 
5. Active the –Y relay, take a photo, measure calibration star movement. 

 
An ideal mount and imaging system concludes this sequence with the guide star in the exact 
same position as at the start of the calibration procedure.  In most cases, there will be at least a 
small difference in starting and ending position due to whatever errors accumulated while the 
mount moved in all four possible directions.  
 
It is intuitive to relate relay activation to calibration star motion when the camera is aligned 
square to the mount’s right ascension and declination axis.  For example, when the camera is 
aligned square to the mount’s right ascension and declination axes, X relay activation 
corresponds to calibration star motion changing in X pixels on the resultant photo and Y relay 
activation corresponds to calibration star motion changing in Y pixels on the resultant photo.  In 
contrast, if the camera is rotated so that it is not “square” with the right ascension and declination 
axis, activating, say, the X relay, will produce calibration star motion in both X and Y pixels on the 
resultant photo.  The Camera Add On can cope with a completely non-square camera position.  
This gives a great deal of flexibility in selecting a guide star. 
 
To set the time interval for calibration, as well as other related settings, click Setup on the 
Autoguide tab.  See Figure 212 for the default appearance of the Autoguide Settings window.  
The calibration time is the length of time in seconds that each relay is activated during the 
autoguide calibration process. 
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Relay Settings Tab 

 

Figure 212: The Relay Settings tab on the Autoguide Setup window. 

The calibration time you enter depends on, primarily, the focal length of your telescope, the pixel 
size of your camera and the bin mode.  If the camera is reasonably well matched to the telescope 
(a camera with anywhere from 1 to 4 arcseconds per pixel), the values shown in the following 
table are useful starting values for calibration time. 
 

Focal length (mm) Suggested calibration time (seconds) 

100-300 (typically a camera lens) 15 

300-500 10 
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Focal length (mm) Suggested calibration time (seconds) 

500-1000 5 

1000-2000 5 

2000-3000 3 

 
Here are the remaining autoguide setup parameters on the Relay Settings tab: 

Relay Enabled 

Determines whether autoguiding corrections are applied to the indicated axis.  For example, if 
the mount’s polar alignment is exceptional and exposure duration is under about one hour, you 
can turn off corrections to the declination axis to avoid spurious corrections that result from 
atmospheric turbulence.  In addition, if you are creating a tracking log to determine your mount’s 
periodic error, you will want to disable both axes. 

Backlash compensation  

Backlash exists when the motors on the mount must turn for some period after a change of 
direction before the gears fully engage and move the mount.  Backlash compensation is the time 
that the Camera Add On should turn the motors to take up backlash when the direction reverses.  
Since guide speeds in right ascension are typically less than sidereal rate (0.5x is commonly used), 
no reversal occurs, and you should not set a backlash compensation time for right ascension 
backlash compensation unless you are using a mount autoguide speed of 1x sidereal or faster.  
You should always slightly under compensate for backlash; over compensation leads to over 
correction and can make autoguiding impossible. 

Minimum move 

This specifies the minimum autoguiding correction that the Camera Add On will make.  If the 
autoguide correction is less than this amount, no autoguiding correction occurs.  When an 
autoguiding correction is equal to or greater than this amount, the autoguide correction will be 
made. 

Maximum move 

 The longest time to move the mount during an autoguide correction.  If you find that the mount 
is too active, no matter how you change other settings, this can force the Camera Add On to use 
shorter corrections.  However, if at all possible, you should find the source of the problem and 
fix it instead. 

Aggressiveness  

A number from 1 to 10, indicating the relative aggressiveness of the corrections.  With a setting 
of 10, the Camera Add On makes the full, computed correction.  With a setting of 5, the Camera 
Add On makes fifty percent of the computed correction.  With a setting of 1, ten percent of the 
indicated correction occurs.   
 
If autoguider corrects cause the mount to overshoot, you can reduce the amount of the 
correction with this setting to minimize guiding errors.  For example, when pointed near the 
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zenith, your mount may be more responsive to corrections due to changes in balance.  You can 
use a lower aggressiveness setting to compensate if your mount behaves in this manner. 

Autoguide Using 

 This setting determines how the Camera Add On makes autoguiding corrections.   
 

• Camera Relays: If a camera relay cable is connected directly to the mount (or connected 
through the SBIG relay box), then use the Camera Relays setting.  

• RelayAPI (serial): If you are using a special, custom arrangement via the serial port of the 
computer running the Camera Add On, then choose RelayAPI (serial).  

• Direct Guide™: Paramount Robotic Telescope Mounts, and mounts that employ the 
Bisque TCS (Software Bisque Telescope Control System) support Direct Guide, a technique 
that allows autoguider corrections to be applied directly to the mount’s control system 
so that a separate autoguider relay cable is not required.      

• PulseGuide: Autoguiding corrections can be also be made directly to the mount using 
PulseGuide. 

Delay After Correction 

If your mount tends to vibrate or bounce slightly after a correction is applied (needs a settling 
time), a delay can help ignore this oscillation.  This is usually true only of lighter mounts, but it 
can also occur with larger mounts that over loaded. 

Log Autoguiding 

When this checkbox is turned on, tracking data is saved to a log file.   

• The name of the log file is automatically generated so that earlier tracking log data is 
never overwritten.   

• The name of the log file has the form Auguider.001.log where .001 is incremented each 
time the Autoguide button is clicked.   

• The location of the log file is defined by the AutoSave path.  This option is immediately 
applied while autoguiding is in progress so that you can control when logging starts and 
stops.  The Clear Log button on the Autoguide tab applies immediately as well.  See the 
section “Graphically Examining Autoguider Data” on page 504 for information about the 
tracking log file. 

Simultaneous X- and Y-Axis Relay Activation 

Turn this option off if your mount is not capable of making an x and y correction at the same time 
(some older mounts).  By default, this checkbox is on so that autoguider corrections that involve 
both an x-and y-relay activation are applied the mount at the same time.  Some much older model 
Losmandy mounts (Gemini controlled mounts excluded) cannot perform simultaneous 
corrections.  
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Autoguider Calibration Results Tab 

Calibration Procedure 

Click OK to save changes.  Click Calibrate to start the calibration process.  You will see information 
reporting the progress of the calibration in the Autoguide tab, such as Moving Mount (Plus X).  
The calibration procedure starts with a new reference image and dark frame.  It then moves plus 
and minus in the X and Y directions, measuring how the calibration start moves for each relay 
activation. 
 
If there are any problems during the calibration, an error is reported in the calibration results 
windows.  The following table lists common problems and explains what you can do to try to fix 
the problem. 
 

Calibration Problem Solution 

Error message:  
 
“Star too dim.  Lost 
during +X, -X, +Y, or –
Y” 

The guide star is too dim, and could not be found on one or more 
of the photos acquired during calibration.  Use a longer exposure, 
or choose a brighter star.  A star is too dim not just when it is too 
dim to be pulled from the background, but also when the brightest 
star in a calibration image is less than 25% as bright as in the 
preceding image. 
 

Error message: 
 
“Motion too small 
during +X, -X, +Y, or -Y 
move.  Increase 
calibration time.” 
 

The calibration time was too short to move the star far enough to 
get a valid result.  The solution is to use a longer calibration time.  
For a valid calibration, the star must move at least 5 pixels. 

Error message: 
 
“Star too close to edge 
after +X, -X, +Y, or -Y 
move.” 

The calibration star is too close to the edge of the image after a 
move.  You can reduce the calibration time to cause less movement, 
and you can also begin calibration with the guide star at the center 
of the frame.  This error will occur when the guide star moves to 
within 10 pixels of the edge. 
 

Error message:  
 
“Invalid motion in X- 
or Y-axis.” 

This error typically occurs when: 
 
The brightest star in a calibration image is a star other than the 
original guide star due to random variations in brightness.  The 
guide star should be significantly brighter than any other star in the 
image. 
A brighter star moves into the guide frame during calibration.  The 
guide star should be isolated from similarly bright stars by at least 
1.5 times the width or height of the guide frame in arcseconds. 
The mount is very inaccurate, with motion in X resulting in motion 
in Y, or vice versa.  Check the Calibration Results graph to see if it 
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Calibration Problem Solution 

provides any clues about what kind of invalid motion is contributed 
by the mount. 
 

Error message:  
 
“Unable to calibrate, 
both axes are 
disabled.  At least one 
axis must be enabled 
to calibrate.” 
 

With both axes disabled, no calibration is possible.   
 
To enable one or both axes, from Autoguide tab, click Settings, 
then turn on the Enabled checkbox for one or both axes. 

Problem:  
 
No calibration in one 
axis. 

If an axis is disabled, no calibration will occur for that axis.   
 
To enable one or both axes, from Autoguide tab, click Settings, 
then turn on the Enabled checkbox for one or both axes. 
 

Problem:  
 
Calibration star moves 
out of frame. 

This problem can cause several different error messages to appear, 
depending on what happens when the calibration star moves off of 
the photo.  You might see “Star too dim” if another star winds up 
being interpreted as the calibration star, or you might see “Star too 
close to edge” or another message depending on where the 
brightest star winds up.  
 
The Camera Add On displays the photos taken at each step in the 
calibration process; watch these images to see if the guide star is 
moving out of the frame.  Use a shorter calibration time to keep the 
guide star in the frame, and start with the guide star as close as 
possible to the center of the frame.  Severe mount errors can also 
move the star out of the frame at longer focal lengths. 
 

 
Once you have successfully calibrated the autoguider, you are ready to begin autoguiding.  If you 
moved the mount to find a good calibration star, move it back to the object you want to capture. 

Autoguiding in Action 

Once your system is calibrated, you can start autoguiding.  The Camera Add On supports 
autoguiding independent of imaging.  This means that you can start an autoguiding session and 
then take a series of Imager images while the autoguiding continues uninterrupted.  If the 
autoguider is integrated into the camera, as with an SBIG dual CCD’s, autoguiding is temporarily 
paused during the Imager photo download since the shutter must be closed during the Imager 
download and the autoguider shares the same shutter (and since the shutter is close the 
autoguider cannot capture photos). 
 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 488 

If you have a good polar alignment – which is always a good idea when imaging anyway – the 
guide star will be more likely to remain within the autoguider track box when autoguiding 
resumes.  If the guide star moves, the Camera Add On will perform corrections to move it back 
to the center of the autoguide window.  If this move tends to be large, you can add a delay to 
your Imager exposures.  This will give the Camera Add On time to make corrections before the 
next Imager exposure begins.  
 
The larger the corrections, the longer the delay should be to give the autoguider time to settle 
down.  For most applications, use a delay that is a few seconds longer than two times the 
autoguide exposure.  For example, if your guide exposure is 4 seconds, then use a delay of about 
10 seconds.  The extra time allows for downloading the autoguider images and processing time.  
If you find that your particular mount requires shorter or longer delays, adjust accordingly. 
 
Once you have calibrated the autoguider, you can begin autoguiding.  A typical autoguiding 
session includes the following steps: 
 

1. Adjust the position of the mount if necessary to put a suitable guide star on the 
autoguider detector. 

2. Click Take Image on the Autoguide tab, and verify the location of the guide star using an 
appropriate exposure length.  If you are not sure, try 10 seconds. 

3. If the brightness of the guide star is to too high or too low, adjust the exposure time.  Aim 
for a brightness level of about 1000 counts and less than saturation. 

4. Enter the current declination of the telescope.  If you are using TheSkyX Professional 
Edition to point your telescope, this will be filled in automatically when you click 
Autoguide. 

5. Click Autoguide to begin guiding. 
 
If you have TheSkyX Professional Edition controlling your mount, it will automatically get the 
current declination of the telescope and use it to scale your calibration.  If you move a large 
distance across the sky, or if you cross the meridian, then you may want to do another calibration.  
If you are imaging at longer focal lengths (2500 mm and larger), you can calibrate before every 
image if necessary to get the best possible autoguiding out of your system. 
 
During autoguiding, the Camera Add On continuously updates the autoguider photo to show the 
guide star.  The current autoguide error appears near the top of the Autoguide tab, showing the 
number of pixels that the guide star has moved from the original position (X Error and Y Error).  
These numbers may be positive or negative, and are reported for both X and Y directions to the 
nearest hundredth of a pixel.  Each photo captured for autoguiding shows a progress bar in the 
line for the autoguider at the Autoguider tab. 
 
Autoguiding will continue until the Abort button is clicked.  If there is an error during autoguiding, 
autoguiding will continue when possible, for instance if the guide star’s brightness falls drastically 
due to clouds, autoguiding corrections are not made and autoguiding continues until the guide 
star brightness returns.  If the guide star is lost and will not return (such as when the telescope is 
bumped), abort autoguiding and start over. 
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When using an SBIG dual CCD, the shutter will be closed when the Imager photo is being 
downloaded from the camera.  Autoguiding is suspended while the shutter is closed, and will 
resume after the Imager download is complete.  If the mount’s polar alignment is good, the guide 
star will still be visible, and autoguiding will resume.  You can enter an exposure delay in your 
Imager exposure(s) to allow for guiding corrections to settle right after the guide star is 
reacquired. 

Recalibration 

When should you recalibrate?  The simplest way to tell is to start an autoguiding session and 
observe what happens.  Start autoguiding after the telescope moves to a new position.  Observe 
what happens to the X error and Y error numbers.  If the both stay within +/- 1.0 pixel, you will 
likely have good results.  If both stay within +/- 0.5 pixel, then the seeing is very good, and you 
should get excellent results.  If one or both shows values greater than +/- 1.0, either the seeing 
is poor, or you may need to recalibrate for the new position.  The need to recalibrate varies 
greatly from mount to mount, your image scale, and only experience will show you what works 
best for your particular mount. 
 
Sometimes, autoguiding will not work as expected.  Common problems, and possible solutions, 
include:  
 

Autoguiding 
Problem 

Suggested Solution 

No corrections 
occur, and the X 
and/or Y Error 
numbers continue 
to increase 

Most likely, autoguiding corrections are not getting to the mount, check 
the cable between the camera and the mount.  Make sure that 
corrections are enabled for the appropriate axes.  Verify that the guide 
speed is set to an appropriate value (usually 0.5x sidereal) for the mount.  
You can test connections by pressing the relay buttons on the Autoguider 
tab and verifying if the stars in the photo move accordingly or worst case 
see if the mounts coordinates change (warning you will have to press a 
relay button a long time before seeing a change in mount the position 
reported by the mount. 
 

Corrections tend 
to oscillate 
between positive 
and negative 
values (for 
example, +1.3 and 
–0.9) 

If the load on your mount is too carefully balanced, the mount will be 
unusually sensitive to guide corrections, and may overshoot.  You want a 
slight but definite excess of weight on the east side.  This keeps the gears 
meshed, and reduces the tendency of the mount to over-react to 
corrections.  Oscillations can also occur when working near the zenith.  
You can also simply reduce the aggressiveness setting to see if that will 
eliminate the oscillation.  Sometimes the mount will simply have a 
resonant period similar to the exposure duration and certain correction 
speeds; try a shorter or longer guide exposure length to see if it will 
eliminate the oscillation. 
 

The mount 
suddenly makes 

A “large movement” is any sudden movement of two pixels or more.  This 
usually results from irregularities in the mount's bearings or gears, and 
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Autoguiding 
Problem 

Suggested Solution 

large movements, 
and then comes 
back to zero. 

may limit the success you will be able to achieve with autoguiding.  
Shorter exposures can help by allowing you to complete an image before 
you hit one of the large movements.  Contact your manufacturer to see if 
you might need to replace a worn or damaged part.  Dirt or grit in the 
gears can also cause this problem.  Another possibility: wind gusts.  If it's 
very windy, you may not be able to guide or track successfully, as the 
mount will bounce around.  The larger and/or longer your telescope, the 
more likely it is to catch wind and cause deflections that will show up as 
guiding errors.  In some cases, if the movements are not extreme, you 
may be able to guide successfully by shortening the guide exposure so 
that the Camera Add On can detect these movements sooner and correct 
for them more often.  Guide exposures of 1-3 seconds can give you better 
results on less-expensive mounts, but not all objects will have a 
sufficiently bright guide star for you to try this option. 
 

The guide star 
suddenly 
disappears 

The most common cause for this is simply clouds.  Guide exposures are 
short enough that many stars will simply disappear if even a thin cloud 
moves through that part of the sky.  If your mount is well aligned to the 
pole, and tracks accurately, you can sometimes simply wait out the cloud 
and guiding will resume when it passes.  Any exposure you were taking 
during the time the cloud was in the way may or may not be salvageable.  
The guide star can also disappear if the mount is disturbed, in which case 
you probably have also lost your polar alignment.  You might have 
touched your mount accidentally, but even a stray cat rubbing against a 
tripod leg has been known to cause trouble! 
 

Corrections occur, 
but the X and Y 
errors are large 
and random 

This could be a sign of over correction.  Try recalibrating and see if that 
happens smoothly.  Another option is to lower aggressiveness setting.  Try 
lowering the aggressiveness one unit at a time and see if you get any 
improvement.  Stop lowering the aggressiveness when you get into the 
range of +/- 1.0 pixels (average seeing) to +/- 0.5 pixel (good seeing).  
Problems with your mount's bearings or gears are another potential 
source of trouble; consider tuning your mount if you get wild changes in 
the X and Y errors.  For any given mount, there is a limit to how accurately 
it will track and autoguide; if tuning and/or service won't improve your 
results, you may need to upgrade your mount to work at a given focal 
length. 
 

The guide star 
keeps trying to 
move in a specific 
direction. 

If the move is always in declination, this is most likely the result of a polar 
misalignment that is fairly large (more than 0.5 degree).  If the autoguider 
is able to handle the movement in declination and keep it within a 
trouble-free range, the only concern is field rotation for long (one hour or 
more) photos or series of photos.  If the autoguider fails to make the 
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Autoguiding 
Problem 

Suggested Solution 

corrections and keep the error in a reasonable range, you can usually 
solve this problem by refining your polar alignment.  See “Camera-
Assisted Drift Alignment,” later in this chapter. 
 

The guide star 
wanders slowly 
back and forth. 

Typically, this happens in right ascension, and you are seeing the periodic 
error of your mount.  If your camera is oriented with north up, this will be 
a side-to-side (x pixels) motion in the autoguider photo.  If the camera is 
turned 90 degrees (east or west up), then the motion will be up and down 
(y pixels).  Periodic error usually results in slow, steady changes that go 
back and forth, so it is relatively easy for the autoguider to compensate.  
If your mount has the ability to record periodic error and then 
compensate for it (usually called PEC, for periodic error correction), you 
can use it or not, as you wish.  It will not harm the performance of the 
autoguider if PEC and the autoguider are operating at the same time.  
However, the autoguiding is usually able to compensate for periodic error 
on its own, and you do not need to engage your PEC feature to get 
accurate guiding.  You can also use the autoguider to log guide star 
motion which is sufficient to create PEC for capable mounts. 
 

Autoguide Tab 

The table below lists the controls in the Autoguide tab. 
 

Control Description 

Take Photo  Click this button to take a photo using the current Exposure Time, Exposure 
Delay and other settings. 
 

Autoguide  Click this button to initiate autoguiding. 
 

Graphs Click this button to display the Autoguiding Graphs window. 
 

Abort Click this button to abort the camera operation in progress. 
 

Setup Displays the Autoguide Setup window. 
 

Calibrate  
 

Start the autoguider calibration process. 

Exposure Time Enter the exposure time, in seconds, for the autoguider photo. 
 

Exposure Delay Enter a pre-exposure delay in seconds. 
 

Binning Enter the camera binning. 
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Control Description 

Frame The type of photo to be acquired: 
Light 
Dark 
Bias 
Flat 
 

Reduction Choose the type of reduction that is applied to each image acquired. 
None 
AutoDark 
Full Calibration 
 
 

Clear AutoDark Clears the AutoDark frame causing the Camera Add On to acquire a new 
dark frame on the next photo (when Reduction is set to AutoDark). 
 

Sub-frame On When checked, only a portion of the CCD is acquired when a photo is taken.   
 
The sub-frame size is set by either dragging a sub-frame on the photo or by 
typing in the size after clicking the Size button. 
 

Size... Type in the size of the desired sub-frame. 
 

Automatically 
Save Photos 

 

When checked, every photo is automatically saved to the hard drive. 

AutoSave... Click to display the AutoSave setup window. 
 

Use Guide Star At 
X, Y 

 

The x and y pixel coordinate of the guide star. 

Auto-Find Guide 
Star 

 

Scans the photo for the brightest guide star and sets Guide Star XY 
accordingly. 

Clear Guide Star Removes any selected guide and sets guide star’s X,Y position to 0,0. 
 

Declination   The telescope's declination. 
 

Reverse X   Allows reusing of autoguide calibration results after flipping a GEM even 
though initial calibration happened on the other side.  
 
Note that the Camera Add On, when used with a TheSkyX Professional 
Edition-controlled mounts, automatically reverses the X direction. 
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Control Description 

Display 
Autoguider 

This checkbox is on by default, and forces every autoguider photo acquired 
to be displayed.  On slower computers, turn this checkbox off so that 
autoguider photos are not displayed and increase the photo throughput. 
 

Log Autoguiding Generate a tracking log for periodic error correction. 
 

Clear Log... Delete the existing autoguider log file. 
 

Track Box Size  Choose the size of the track box, in pixels. 
 

Camera Relays 
 

Click or click and hold one of the +X, +Y, –X, -Y buttons to activate the 
camera relays in that direction. 
 

Auto Contrast 
Setup… 

 

Click this button to show the Auto Contrast window and choose the desired 
method to adjust the contrast method to apply to subsequent photos. 
 
Auto Contrast options: 
 
SBIG: Use Santa Barbara Instrument Group’s autocontrast algorithm to 
compute the photo’s black and white points. 
Bjorn: Use the proprietary algorithm, along with the selected Background 
and Highlight options to compute the photo’s white and black points. 
 

Simulate Photo 
Using DSS 

Turn on the Simulate Photo Using DSS checkbox to take photos of Digitized 
Sky Survey objects, instead of collecting “actual” photons with the camera’s 
detector and a telescope. 
 

Screen Shutter Turn this checkbox on to show a completely black computer during 
exposures.  This can minimize “light leak” from your monitor. 
 

Assessing Autoguiding Possibilities 

Once you have mastered enough CCD imaging skills to take focused photos, the next step is to 
lengthen your exposures so you can take deeper, more detailed, and cleaner photos of your 
favorite celestial objects.  The accuracy of your mount determines how deep you can go.  The 
more accurate your mount, the easier it will be to take long exposures. 
 
Some mount manufacturers specify the accuracy of their mounts.  This accuracy is expressed in 
arcseconds.  An exceptional mount can guide with accuracy of 2-3 arcseconds or less.  A very 
good mount can guide to about 5-6 arcseconds.  The average low-cost mount guides to within 
15-20 arcseconds.  Mounts with even less accuracy are less suitable for CCD imaging unless the 
focal length of the telescope or lens is exceptionally short. 
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Whatever the accuracy of your mount, the key to success is matching the focal length of your 
telescope or camera lens to the abilities of the mount.  For example, consider a CCD detector 
with pixels that are 9 microns square, such as the ST-7E.  The angle on the sky covered by each 
pixel varies with the focal length of your telescope: 
 

ST-7E (9-micron pixels) 

Focal Length of the Telescope (mm) Angle of Sky (arcseconds) 

300 6.2 

500 3.7 

700 2.6 

900 2.1 

1100 1.7 

 
For example, imaging with a 300mm camera lens, at least 6 arcseconds of error are tolerable 
because a single pixel covers just over 6 arcseconds.  Imaging with a refractor that has 1100mm 
focal length, a single pixel covers only 1.7 arcseconds, and the need for tracking accuracy is almost 
four times higher. 
 
In practice, star images cover more than one pixel due to atmospheric scattering, the same 
process that causes stars to twinkle, so you would have more leeway than shown here.  The 
important concept is that the shorter your focal length, the less the need for tracking accuracy in 
your mount. 
 
A short focal length alone won't necessarily solve the problem, however.  Smaller or larger pixels 
on your CCD detector alter the numbers.  As shown in the following table, large pixels cover more 
sky for a given focal length, and smaller pixels cover less sky: 
 

ST-9E (20-micron pixels) ST-237 (6.8-micron pixels) 

Focal Length of 
Telescope (mm) 

Angle of Sky, 
(arcseconds) 

Focal Length of 
Telescope (mm) 

Angle of Sky, 
(arcseconds) 

800 5.1 300 4.7 

1000 4.1 500 2.8 

1200 3.4 700 2.0 

1500 2.7 900 1.5 

2000 2.0 1100 1.3 

 
For best results, match the focal length of your telescope to both your CCD camera and your 
mount.  Most CCD imagers aim for a camera/telescope combination that yields from 1.5 to 4 
arcseconds per pixel.  Your choice of mount should match the capabilities of whatever 
combination you select.  You can calculate the arcseconds per pixel of your camera/telescope 
combination using the following formula: 
 
(<pixel size in microns> / <focal length in mm>) * 206 
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Experience shows that, to get good results, your mount error should be no more than +/- 2 pixels.  
For high-quality images, one and a half times the arcseconds per pixel value is a safer limit.  Very 
high precision results demand a value of a single pixel.  For very long focal lengths (2500mm and 
up), local seeing and other conditions becomes more important and the calculations are not so 
straightforward; experience of local conditions is needed to assess the requirements for the 
mount. 
 
In general, then, for high-quality images, a mount should be able to guide to within 2.25 and 6 
arcseconds, depending on the pixel size of the CCD camera in relation to the focal length of the 
telescope. 
 

 

If your mount isn't providing the pointing accuracy needed by your telescope, you 
can either use a focal reducer to shorten the focal length of your telescope, or take 
steps to increase the pointing accuracy of your mount, or both. 

 
If you already own a mount, and want to assess its approximate pointing accuracy, you can follow 
this procedure. 

Adjusting and Tuning Your Mount 

Mounts come in a variety of designs.  Most mounts intended for use CCD cameras involve a worm 
and worm gear, as shown in Figure 213.  There is normally one pair for right ascension, and 
another pair for declination, but some mounts are only driven in right ascension.  
 
A motor drives the worm gear, and there will usually be gears between the motor and the worm 
to reduce the speed of rotation at the worm.  The worm in turn drives the worm gear, which is 
attached to the shaft.  The right ascension shaft turns at sidereal rate, which is the rate stars 
appear to move across the sky (approximately one revolution per day).  The motor speed and 
gear ratios are set to track accurately at the sidereal rate.  Some mounts provide a way to adjust 
the tracking rate for the highest possible accuracy, but most do not. 
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Figure 213: A Byers precision worm and worm gear. 

To track and autoguide accurately, a worm-driven mount must often be adjusted or tuned in 
several ways.  Before using a mount for autoguiding, we suggest the following; please consult 
your mount's documentation or the manufacturer for specific procedures on making these 
adjustments: 
 

• Verify that the worm and worm gear are properly seated.  If the end bearings of the worm 
are too tight, the worm will bind and could be damaged.  If the worm is too loose between 
its end bearings (end play), reversals of direction will be erratic.  Endplay in the worm gear is 
the usual cause if you observe that the mount initially and briefly moves in the wrong 
direction when reversing directions. 

• Verify that the mesh between worm and worm gear is appropriate.  Some mounts are made 
from harder materials and to closer tolerances, and these will typically require a very tight 
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mesh between the worm and worm gear.  Other mounts are made of softer metals, or to 
looser tolerances, and will require a looser mesh.  If the mesh is too tight for the design, the 
gears will bind and could overheat or be damaged.  If the mesh is too loose, there will be 
excessive backlash.  Some mounts have built-in backlash compensation that allows you to 
keep the gears appropriately loose; the Camera Add On provides software backlash 
compensation that serves the same purpose.  During backlash compensation, the motor is 
run at a higher speed to take up slack in the gears.  Too much compensation will result in a 
jerky movement; too little compensation will result in a delay before a guiding correction is 
effective.  It is always better to have too little rather than too much backlash compensation.  
If in doubt about how tight to mesh the gears, err on the side of being too loose.  See the 
section “Assessing Mount Accuracy” on how to measure backlash. 

• A slow-turning motor usually has less torque (that is, less force available to move the mount).  
This means that a slowly turning motor is more likely to stall than one that is turning quickly.  
If the worm and worm gear are too tightly meshed, the slowdown to 0.5x sidereal that occurs 
during autoguiding could cause the mount to stall, or move at the wrong speed. 

• Cold conditions can cause some lubricants to become stiff, and this can alter the behavior of 
your mount.  If you need to operate your mount in very cold conditions, or if you observe 
increased stiffness in cold weather, check with the manufacturer to find out whether you will 
need to use different lubrication for cold conditions. 

• Some mounts, after tuning and adjustment, will have a large enough residual error that it will 
limit the focal length telescope you can use successfully.  The larger the error (from periodic 
and non-periodic sources), the shorter the focal length of the telescope you can use for 
imaging.  The actual limit depends on the weight of your telescope and its overall physical 
length as well as its focal length.  Long, heavy telescopes require more careful balancing and 
tuning for successful guiding.  Focal reducers are available to help with this situation.  
Otherwise, you will need to use a telescope with a shorter focal length. 

• Test the balance of your mount in various positions.  Off-center equipment, such as a finder 
offset from the centerline of your telescope, or a camera attached piggyback fashion onto 
your telescope, can dynamically alter the balance of your mount as you point at different 
areas of the sky.  A mount should always be loaded so that there is slightly more weight on 
the east side of the mount.  This keeps the right ascension axis loaded at all times, eliminating 
backlash as a factor in right ascension autoguiding (as long as the correction speed is less than 
sidereal rate).  If off-center equipment does cause the balance to change at different pointing 
angles, you can either rearrange equipment and/or counterweights after pointing to a new 
area of the sky, or you can incorporate sliding weights or some other weight-shifting system 
into the design of your setup.  An out of balance mount can oscillate or wander unpredictably, 
or require a new calibration when pointing to different parts of the sky even if the declination 
remains similar. 

• You can calibrate your setup at a higher correction speed than you use when autoguiding.  
This tends to mask some errors, but it isn't a cure-all.  It slows down the correction process, 
and if your mount tends to be over-responsive, it can eliminate unnecessary corrections and 
provide smoother autoguiding. 

 
More than any other single factor, the ability of your mount to track accurately and to respond 
quickly and smoothly to guiding corrections determines the success of your imaging.  It is well 
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worth measuring the accuracy of your mount, and tuning and adjusting it to improve that 
accuracy to the greatest degree possible. 

Polar Alignment 

In order to track accurately, your mount needs to be aligned close to the celestial pole.  Many 
mounts include a polar telescope (also called a bore telescope or bore sight) to help you polar 
align.  There are many different kinds of polar telescopes, but most contain some kind of reticle 
that allows you to point the mount at specific stars to achieve alignment.  Most mounts also 
contain provisions for aligning in either the northern or southern hemispheres. 
 
Although you do not need perfect polar alignment for autoguiding, there are some issues to be 
aware of with respect to polar alignment.  If you are taking single images of less than five minutes, 
even a rough polar alignment will be satisfactory if you are autoguiding.  The lack of a perfect 
alignment will cause the field of view to drift during the exposure, but the autoguider will detect 
the drift and correct for it.  The field will rotate a small amount during the exposure, but if the 
exposure is short enough, the amount of rotation is generally negligible.   If you are concerned 
about the effects of field rotation in your photos and use TPoint, type FROT in the Command text 
box on the Command Line tab of the TPoint Add On window to show the amount for field 
rotation, in radians per hour, over a range of declinations. 
 
Autoguiding can correct for small misalignments to the celestial pole.  If the misalignment is too 
large, however, the autoguider will have to make large, frequent corrections making the 
autoguider work very hard and only high quality mounts will respond accordingly.  The larger the 
misalignment, the shorter your guide exposures must be in order to make corrections before 
they become too significant and pollute the Imager photo (stars not round). 
 
If your exposures are longer than fifteen minutes or so, rotation of the field over time may 
become an issue.  If you are combining short-duration images for better signal-to-noise ratio or 
for color, the routine must also rotate the photos before combining. 
 
Very short focal lengths are more sensitive to field rotation because the image covers a larger 
area of the sky.  You can minimize field rotation by taking the time to polar align your mount very 
carefully.  Use the polar telescope for rough alignment, and then use drift alignment to refine 
alignment.  You can do drift alignment manually, or you can use the CCD camera to assist.  You 
can also use the TPoint Add On, a Software Bisque software tool that increases telescope-
pointing accuracy, to achieve extremely accurate polar alignment. 

Manual Drift Alignment 

1. Level the base of the mount if possible.  A level mount is not required, but it makes adjust 
easier by reducing interplay between altitude and azimuth adjustments. 

2. Locate a bright star near the celestial equator and near the meridian (the midpoint 
between east and west).  Center the star in the crosshairs of an illuminated reticle 
eyepiece. 

3. Observe the star until it drifts north or south; ignore drift to the east or west.  If the star 
drifts north, adjust azimuth so the mount points more to the east.  If the star drifts south, 
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adjust azimuth so the mount points more to the west.  Repeat until north/south drift 
becomes negligible over a 5-minute observing period. 

4. Locate a bright star near the celestial equator and near either the east or west horizon.  
Center it in the crosshairs of an illuminated reticle eyepiece. 

5. Observe the star until it drifts north or south; ignore drift to the east or west.  
 
If you are looking east: 

• If and the star drifts north, adjust altitude downward.  

• If the star drifts south, adjust altitude upward.  
 
If you are looking west: 

• If and the star drifts north, adjust altitude upward.  

• If the star drifts south, adjust altitude downward.  
 
Repeat until north/south drift becomes negligible over a 5-minute observing period. 
 

 

To determine which way is north in the eyepiece, move the telescope toward 
the south and note the direction the stars move; they are moving toward the 
north in the field of view. 
 
In general,  
 

• If you move the telescope to a slightly more positive declination the stars 
will move south in the field of view.  

• If you move the telescope to a slightly bigger right ascension the stars will 
move west in the field of view.  

Camera-Assisted Drift Alignment 

Calibrate your autoguider as described earlier in this chapter. 
 
1. See if the camera is currently orthogonal (square) to the mount.  If you have performed a 

calibration, you can use the Camera Add On to tell you how close the camera is to orthogonal.  
On the Autoguide tab for the Autoguider, click Setup.  This opens the Autoguide Setup 
window.  Click the Relay Calibration Results tab.  This displays a graph showing how the 
camera is oriented with respect to the right ascension and declination axes of the mount.  
Ideally, the X- and Y- relay vectors will line up closely with the X- and Y-axis of the photo/CCD 
(Figure 214).  Ideally, but not necessarily, the angle of the +X vector should be close to zero, 
and the +Y axis vector should be nearly perpendicular to the +X vector.  If your camera is 
rotated with respect to the mount axes (Figure 215), you will not get accurate readings for 
camera-assisted drift alignment. 

 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 500 

 

Figure 214: Relay calibration results that show the camera is ready to assist with drift alignment. 
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Figure 215: The camera axes are not square to the mount axes.  The camera rotation is not well situated for assisting 
with drift alignment. 

2. If the camera isn't square with the mount, adjust the camera so that the top of the CCD 
detector points toward north.  For the greatest accuracy, repeat calibration to verify 
alignment of the camera.  Repeat until you've got everything lined up to your satisfaction. 

3. Using the Autoguide tab, set an appropriate exposure time (for example, 5-10 seconds), and 
then click Take Photo.  Check your results, and adjust the exposure time as needed.  Double 
click on a suitable guide star. 
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4. Click Log Autoguiding.  This allows you to examine your data later if you have any questions 
about the progress you are making toward polar alignment.  The log file is named 
autoguider.XXX.log, and can be found under the camera's autosave folder.  See the 
next section, “Autoguider and Tracking Log,” for a list of the fields contained in the log file. 

5. To measure drift, you need to turn off corrections.  From the Relay Settings tab, uncheck the 
Relay Enabled checkboxes for X-and Y-relay.  Note: Remember to re-enable corrections when 
you are done. 

6. Click OK to close the Autoguide setup window. 
7. Click the Autoguide button on the Autoguide tab.  You can now observe the Y (declination) 

error to measure drift very accurately and very quickly.  You can examine the log file at any 
time to determine the total amount of drift versus elapsed time.  Positive Y error values are 
northward drift; negative Y error values indicate a drift to the south. 

8. Once you have a measurement of the current amount of drift north (+Y) or south (-Y), adjust 
the mount as for manual drift alignment and repeat the autoguiding process.  

9. For optimal results, continue drift aligning until you can autoguide for several minutes with a 
Y error no larger than +/- 1.0.  For critical applications, continue until you can autoguide for 
five minutes with a Y error no larger than +/- 0.5. 

Autoguider and Tracking Logs 

You can turn on logging of autoguider operation using the either the Log Autoguiding Data 
checkbox on the Autoguide tab or the same checkbox under the Setup button on the Autoguider 
tab. Turn the checkbox on to collect autoguiding data.  New autoguiding data is always 
automatically saved to a new file per autoguiding session.  To clear the log file, click the Clear Log 
button. 
 
A sample autoguider.log file is shown below.  The lines are wrapped because the data 
content is too long to fit on a single line here.  In the file itself, each line of data is a single line. 
 

TheSkyX Camera Add On Autoguiding Log 

Camera = Imager's built-in autoguider 

X Axis = Enabled 

Y Axis = Enabled 

ExposureTime = 0.10         

Aggressiveness Factor = 10 

Calibration Time X = 4.00         

Calibration Time Y = 4.00         

Calibration declination = 0.00         

Declination now = 0.00         

Minimum Move = 0.01         

Maximum Move = 1.00         

Backlash X = 0.00         

Backlash Y = 0.00         

Delay After Move = 0.00         

Autoguide using Relays 

 

Calibration Determined Velocity Vectors (pixels/sec) 

 XPlus  Speed=     5.00106 (XPlus  X=     5.00076, XPlus  Y=     0.05490) Angle=     0.00000 

 XMinus Speed=     5.00016 (XMinus X=    -4.99985, XMinus Y=    -0.05594) Angle=     0.00000 

 YPlus  Speed=     4.99963 (YPlus  X=    -0.00182, YPlus  Y=    -4.99963) Angle=     0.00000 

 YMinus Speed=     4.81357 (YMinus X=     0.05687, YMinus Y=     4.81323) Angle=     0.00000 

 

|Elapsed Secs|RefCentroidX|RefCentroidY|CurCentroidX|CurCentroidY|GuideErrX   |GuideErrY   |TotGuideErr 

|XPlusRelay  |XMinusRelay |YPlusRelay  |YMinusRelay |PECIndex RA |PECIndex Dec| 

|      0.0000|     49.8300|     49.0000|     49.7707|     48.9768|     -0.0593|     -0.0232|      0.0637|           

1|           0|           0|           0|           0|           0| 
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|      2.4020|     49.8300|     49.0000|     49.8054|     48.9818|     -0.0246|     -0.0182|      0.0306|           

0|           0|           0|           0|           0|           0| 

|      3.3230|     49.8300|     49.0000|     49.8077|     48.9778|     -0.0223|     -0.0222|      0.0314|           

0|           0|           0|           0|           0|           0| 

|      4.2590|     49.8300|     49.0000|     49.8038|     48.9827|     -0.0262|     -0.0173|      0.0314|           

1|           0|           0|           0|           0|           0| 

|      5.1950|     49.8300|     49.0000|     49.9322|     48.3956|      0.1022|     -0.6044|      0.6130|           

0|           2|           0|          13|           0|           0| 

|      6.1310|     49.8300|     49.0000|     49.8545|     48.8989|      0.0245|     -0.1011|      0.1040|           

0|           0|           0|           2|           0|           0| 

|      7.0670|     49.8300|     49.0000|     49.8569|     48.9807|      0.0269|     -0.0193|      0.0331|           

0|           1|           0|           0|           0|           0| 

|      7.9870|     49.8300|     49.0000|     49.8139|     48.9820|     -0.0161|     -0.0180|      0.0241|           

0|           0|           0|           0|           0|           0| 

|      8.9080|     49.8300|     49.0000|     49.8128|     48.9798|     -0.0172|     -0.0202|      0.0265|           

0|           0|           0|           0|           0|           0| 

0.0000|           0|           0|           0|           0| 

 
The top portion of the file record the camera used, as well as which axes are enabled.  The 
exposure time and the aggressiveness setting are also recorded. 
 
The next section lists the calibration details.  This is a text version of the information you see in 
the Relay Calibration Results window (Figure 214). 
 
The bottom section contains a record of all guiding corrections.  The example above shows only 
a few lines.  You could have hundreds of correction entries for a long exposure.  The following 
data is included for each correction; for X/Y coordinates, the origin is the upper left corner of the 
detector: 
 

Heading Description 

Elapsed Secs Total number of seconds that have elapsed since the start of the 
current autoguiding session. 

RefCentroidX The X coordinate of the starting position of the guide star centroid. 

RefCentroidY The Y coordinate of the starting position of the guide star centroid.   

CurCentroidX The current X coordinate of the guide star, in pixels. 

CurCentroidY The current Y coordinate of the guide star, in pixels. 

GuideErrX The number of pixels the guide star has moved from the starting 
position along the X-axis.  Equal to ( )dXRefCentroidXCurCentroi −  

GuideErrY The number of pixels the guide star has moved from the starting 
position along the Y-axis.  Equal to ( )dYRefCentroidYCurCentroi −  

TotGuideErr The total current guide error in pixels, measured in a straight line from 

the origin.  Equal to ( )22 GuideErrYGuideErrX +  

XplusRelay Time in one-hundredths seconds that the X-plus relay was on to make 
the correction. 

XminusRelay Time in one-hundredths seconds that the X-minus relay was on to 
make the correction. 

YplusRelay Time in one-hundredths seconds that the Y-plus relay was on to make 
the correction. 

YminusRelay Time in one-hundredths seconds that the Y-minus relay was on to 
make the correction. 
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Heads up, the deciphering the autoguiding log is not intuitive when the camera is rotated with 
respect to right ascension and declination since an x pixel error may manifest itself to both an X 
and Y relay adjustment.  Another potential point of confusion: resultant autoguiding corrections 
account for autoguiding at a declination different from the declination at calibration time so they 
may be bigger or smaller than what you might expect at first glance. 

Graphically Examining Autoguider Data 

If you logged autoguiding information, you can open the log file from the Autoguiding Graphs 
window to see the data graphically.  Press the Graphs button on the Autoguiding sub tab and 
from the Autoguiding Graphs window, right click the "X Pix Error" graph (or the "Y Pix Error" or 
"XY Err Pix" graph) and choose Open Autoguiding Log. 
  

 

If you turn off corrections during autoguiding, in addition to errors caused by 
atmospheric seeing, the log file will contain a record of the periodic error of your 
mount.   Let autoguiding proceed for one full revolution of the right ascension 
worm.  This is usually in the range of four to seven minutes.  Consult your mount 
documentation if you aren't sure, or contact the mount manufacturer.  To turn off 
corrections, click Setup on the Autoguide tab. Turn off the Relay Enabled 
checkboxes to disable the X- and Y relays. 
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Autoguider Graphs Window 

 

Figure 216: Sample autoguider graphs. 

While autoguiding, press the Graphs button to display the Autoguiding Graphs window.  These 
graphs give great visual feedback and provide insight into autoguiding performance at a glance. 
 
The graphs show the X error in pixels and arcseconds (see note below), the Y error in pixels and 
arcseconds (see note below), the XY error as a scatter graph, the guide star’s relative signal as 
well as a three-dimensional graph of the guide star. 
 

 
 

The autoguider’s image scale is computed from the Telescope Parameters on 
Imaging System Setup window (page 447).  Make sure to highlight Autoguider’s 
Camera (not the Imager’s Camera) to view them.   
 
If these values are not set, the autoguider graphs show errors in pixels, not 
arcseconds. 
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The XY error graphs show the error for the last 100 autoguiding cycles.  You can zoom in/out on 
the XY error graphs by holding your mouse over the graph and using the mouse wheel.  Click and 
drag the graphs to scroll left or right.  The graphs window is also sizable allowing it to be viewed 
“full screen” on a second monitor, for example. 
 
Each point on the autoguiding graphs is color coded, as described in the table below. 
 

Color of Point on Graph Description 

 
 

Blue points show the Guide Error, that is, distance the 
centroid of guide star moved in the photo.  Guide errors can 
be caused by a host of factors, including poor mount 
tracking, polar drift, seeing errors and more. 
 

 
 

Green points show the Mount Correction which is the 
angular distance the mount’s position was changed or 
corrected.  The correction distance is computed based on 
on the star’s centroid (Guide Error), as well as the 
Aggressiveness, Minimum and Maximum Move 
parameters. 
 

 
 
 

Orange points indicates Signal Lost which means the guide 
star’s signal (ADU) fell below a minimum threshold during a 
particular guiding sequence.    Passing clouds are common 
cause. 
 

 

Red points show that the guide star contains Saturated 
Pixels, meaning that the signal from the star for the given 
exposure time exceeds the maximum signal the camera can 
record.   
 
Saturated pixels in a guide star make centroid 
determination, and therefore guiding, less accurate.  Try 
using a fainter guide star, or a shorter exposure to mitigate 
pixel saturation. 
 

 
 
Guide errors (the relative motion of the star computed from its centroid in each exposure) 
 
You can change the viewing angle of the three-dimensional guide star by clicking and dragging 
within this window.  Right click and choose properties to change the appearance of the three-
dimensional star (these settings are not saved and the three-dimensional star will return to its 
default settings on exit and restart). 
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Autoguide Using Adaptive Optics 

 
 
There are three types of autoguiding available in the Camera Add On: 

 

• Self-guiding with an autoguiding CCD built into an SBIG dual camera. 

• Autoguiding with a separate autoguiding camera (in a guide scope or using an off-axis 
splitter). 

• Autoguiding with adaptive optics (using the SBIG AO). 
 
The first two methods work similarly: the guide corrections are calculated and TheSkyX Camera 
Add On makes corrections by activating a camera relay which in turn moves the mount.  This 
section assumes you are familiar with conventional, relay-based, autoguiding, and that you 
understand the concepts covered in the section “Autoguiding” above. 
 
With the SBIG AO, an internal mirror tilts rapidly to make the autoguide corrections.  When using 
the SBIG AO, you must calibrate using relays so the TheSkyX Camera Add On knows how to move 
the guide star by moving the mount and calibrate using AO tip/tilt so that the Camera Add On 
knows how to move the guide star by tip/tilting the AO mirror. 
 

 

Guide corrections to the mount (via camera relays or Direct Guide) may still occur 
when using the SBIG AO.  The mirror tilt of the AO has a limited range of motion.  
By default, if the mirror reaches 50% of maximum tilt in any direction, the mount’s 
position is moved slightly, or “bumped”, to bring mirror tilt back within range.  Polar 
misalignment and refraction are two primary reasons why the guide star drifts over 
time.   
 
To optimize non-guided tracking, Paramount mount users are strongly encouraged 
to employ TPoint’s telescope model-assisted tracking technology called ProTrack.  
It continuously updates the mount’s position to correct tracking errors from polar 
misalignment, refraction, tube flexure, and other non-sidereal tracking errors.   

 

  

Since guiding with the AO still involves use of the camera relays or Direct Guide to 
bump the mount when necessary, you should always confirm that you can 
successfully autoguide using the camera relays stand alone.  Verify that the mount 
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moves via the camera relays, and that guiding is accurate and satisfactory. 
Otherwise, when the SBIG AO “bumps” the mount, you may lose your guide star 
and not get the result you want. 

 

Quick Start 

If you are familiar with the Camera Add On and the SBIG AO, follow these steps to start 
autoguiding with the SBIG AO.  This section assumes that you are familiar with conventional 
autoguiding (see “Autoguiding”) For details, please read “Autoguiding with the SBIG AO” below. 
 

 

The AO quick start instructions above perform both calibrations using the 
autoguider, you could also perform both calibrations using the Imager.  The Camera 
Add On will automatically calibrate the Imager upon successful autoguider 
calibration and vice versa.  Since the Imager CCD is always bigger than the built-in 
autoguider, it is easier to place stars on the Camera.  You must turn on the 
Advanced Camera User Interface checkbox (page 225) to enable the Autoguide tab 
on the Camera window. 

 

 
The SBIG AO must be connected to the camera and all cabling in place between the computer, 
camera, and SBIG AO before you start. 
 

1. Choose SBIG with AO... for the camera and Imager’s Built-In Autoguider as the autoguider. 
a. Go to Telescope, Telescope Setup and from the Imaging System window, Open Imaging 

System and highlight Camera.  Click Camera Setup, Select SBIG with AO… from the 
Camera list.  

b. Click Imaging System, Autoguider and highlight Camera.   
c. On the Camera Setup pop-up menu, click Choose and select Imager’s Built-In Autoguider. 

2. Place an appropriate calibration star on the autoguider photo. 
a. Click Take Photo to take an autoguider photo.  Adjust telescope pointing and exposure 

time until you have a suitable star for calibration.  A good calibration star must be the 
brightest star in the field of view, and there must not be similar bright stars nearby that 
will move into the field of view during calibration.  Use the Camera Add On to help locate 
suitable calibration stars. 

3. Calibrate the autoguider using relays. 
a. From the Autoguider tab, Autoguide sub tab, perform an autoguider calibration using 

relays as you normally would when autoguiding without the AO.  You do not have to 
uncheck AO Enabled.  To use relay calibration, click Calibrate on, then click the Calibrate 
Using Relays option.  

4. Set the AO settings to their default values. 
a. Click the AO Settings tab. Click the AO Default Settings button to set the default values 

for the parameters.  For fine-tuning the device, see the section “SBIG AO Settings” on 
page 512.  Click OK. 

5. Calibrate the autoguider using the AO. 
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a. Click Calibrate… and then click Calibrate using AO. Verify that the AO deflection… setting 
is 100%. Click Calibrate.  The SBIG AO will move its mirror, take exposures of the 
calibration star, and measure the movement in each direction.  

6. Start autoguiding. 
a. Click Take Photo to download an image using the guide chip. Adjust telescope pointing 

and exposure time until you have a suitable guide star.  See “Autoguiding” on page 469 
for information about what makes a star suitable for guiding. 

b. Double click the desired guide star in the photo to select it as the guide star, or click the 
Auto Find Guide Star button to have the Camera Add On select the guide star for you. 

c. Click Autoguide to start autoguiding.  You can monitor progress using the information on 
the Autoguide tab, including X/Y tilt, wander, etc.  See following sections for details. 

Autoguiding with the SBIG AO 

Once the SBIG AO is installed and connected according to the instructions from SBIG, you must 
do the following before you can start using the AO device: 
 

• Make the correct camera choices for the Camera and Autoguider. 

• Verify that the SBIG AO is enabled on the Autoguide window. 

• Calibrate using the SBIG AO and calibrate using relays.  
 
You must choose the SBIG with AO... as the camera and the Imager's Built-In Autoguider as the 
autoguider before autoguiding with the AO is possible.  Figure 1 shows the correct camera 
choices for using the SBIG AO: If you choose any of the other individual cameras instead, the SBIG 
AO will not be active or available. 
 
If you have been using another autoguider, take a moment to verify that the Autoguider selection 
is correct.  From the Imaging System Setup window, open Autoguider and highlight Camera. 
Choose Camera Setup, Choose and select Imager’s built-in autoguider as the selected 
Autoguider camera (see Figure 218).  
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Figure 217: Make sure the Camera is SBIG with AO (all models…) and the Autoguider camera is SBIG Camera with 
Integrated AO… 

  

If you are having trouble seeing the guide star, try to adjust the photo’s contrast 
settings (click the Show Histogram button on the FITS Viewer window).  When using 
the SBIG AO, dim guide stars and/or short exposures are common and can be difficult 
for auto contrast algorithms to get right.  By trying different contrast algorithms, you 
should be able to “see” the guide star.  The underlining autoguide algorithm doesn’t 
care about the contrast setting—it will pick out the guide star if it is bright enough, only 
a few counts above the background, even if you can’t see it.  A good measure of how 
well the SBIG AO is autoguiding is to monitor the Wander (see section “SBIG AO 
Settings” for details). 
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Figure 218: You may need to adjust the contrast to see fainter guide stars while autoguiding. 
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SBIG AO Settings 

To access the Camera Add On’s SBIG AO controls, see the Autoguide tab on the Autoguider 
window (Figure 219). 
 

 

Figure 219: The Autoguide window showing AO-related controls. 

 
The most frequently used AO settings are found at the bottom of the scrolling controls on the 
Autoguide tab. Check AO Enabled to turn on the SBIG AO for autoguiding.  Unlike most other 
controls of the Camera Add On, AO Enabled (and Fan On, Aggressiveness and Slew Rate) are 
real-time controls in that they apply immediately when you change them.  This allows you to turn 
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on AO guiding, camera fan, aggressiveness and slew rate while autoguiding is in progress.  The 
following list explains all of the AO features found in this window. 
 

 

If you have the AO Enabled checkbox turned on and checked the AO will “do its thing” 
and tip/tilt the AO mirror to guide and  if necessary the relays will bump the mount to 
bring the AO mirror near center. If you do not have AO enabled checked, the AO will 
not perform any corrections and no relay bumps will occur.  In other words, when AO 
enabled is not checked, no guiding of any kind occurs.  If you want to do normal guiding, 
disconnect and switch to your regular camera setting (for example, a specific SBIG 
camera by name). 

 

Control Description 

AO enabled When this checkbox is turned on, the SBIG AO will operate during autoguiding.  
This checkbox can be toggled during autoguiding.  Unlike most other Camera 
Add On controls, this control remains active in real time during autoguiding.  
When turned off, no guiding occurs (no SBIG AO mirror tilt and no “bumping” 
of the mount with the camera relays occurs). 
 

Fan on This checkbox turns the camera fan on and off and can be toggled during 
autoguiding.  Note that the fan may introduce a small vibration that can affect 
the quality of the photo; turning it off may improve your image sharpness at 
long focal lengths and high magnifications.  Unlike most other Camera Add On 
controls, this control remains active in real time during autoguiding. 
 

 

Your camera cooler may have to work harder to maintain its 
temperature if you shut off the fan.  Keep an eye on the Power text 
at the top of the Autoguide tab and monitor the percentage of 
cooling capacity in use.  It should stay below 90% for effective 
cooling. 
 

 

Center button Click this button to center the SBIG AO’s mirror.  The center position is at the 
middle of the range of motion for both X- and Y- axes.  A warning message is 
displayed when this button is clicked since centering will change the field of 
view, so you should re-take any reference image before proceeding after 
centering the mirror.  Otherwise, a guide star currently in the field of view could 
move out of the field of view, or be at a slightly different position. 
 

Aggressiveness This functions like the aggressiveness setting when guiding with camera relays.  
A value of 10 means that 100% of a correction (mirror tilt) will be made.  A value 
of 5 means that 50% of the indicated correction will be made, and so on. 
 

Slew rate Controls how the AO reacts to large error corrections.  The units are 
arcseconds/second.  If a correction would exceed this value, it is limited to this 
value.  In order for this option to work correctly, you must enter your telescope 
focal length by clicking Telescope > Telescope Setup, then highlight Camera and 
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Control Description 

click New Photo Defaults.  For example, a slew rate of 250 arcseconds per 
second at 5 Hz would result in a maximum 50 arcsecond correction. 
 

X tilt The current tilt of the mirror in the X-axis (left to right with respect to the 
camera, if the SBIG AO is mounted to the camera according to the instructions 
from SBIG).  The mirror tilts in the X-axis from 0% to 100%, with 50% being the 
middle position.  
 

Y tilt The current tilt of the mirror in the Y-axis (top to bottom with respect to the 
camera, if the SBIG AO is mounted to the camera according to the instructions 
from SBIG). The mirror tilts in the Y-axis from 0% to 100%, with 50% being the 
middle position.  
 

Wander The amount of guide star position error left after the AO makes a correction.  
In other words, this is the amount of error that the AO cannot correct.  It will 
be higher if the seeing is bad, the guide rate is too low, or when the AO is 
oscillating from over-correction.  It may be helpful to compare the Wander 
value with and without the SBIG AO enabled: the Wander value without the 
SBIG AO is controlled by the seeing; the Wander value with the SBIG AO shows 
the improvement obtained using the SBIG AO.  You can tune the Slew Rate and 
Aggressiveness settings to minimize Wander with the AO enabled. 
 

First count The flux (total brightness above the background) of the guide star.  All the pixel 
values in the star above the background are summed to find the star’s flux. 
 

Count The current flux (total brightness) of the guide star.  Compare this to the First 
Count value during guiding.  If this value changes by a large amount following a 
download, the current guide star might not be the same as the original.  If the 
value drops slowly over time, focus may be shifting.  If this value jumps 
erratically, seeing may be poor, or clouds may be passing through. 
 

Guide rate The rate at which the SBIG AO is guiding. This will sometimes be slower than 
the actual exposure time suggests.  For example, if you are using an exposure 
time of 0.25 seconds, you might expect a guide rate of 4 Hz (4 times per 
second).  However, the download time, display time, and computer processing 
time slow this down.  A very fast computer could hit a maximum guide rate as 
high as 60Hz with a sufficiently bright guide star and a small track box.  Dimmer 
stars and slower computers will achieve lower rates.  As a point of comparison, 
a 300 MHz laptop can achieve a guide rate of 8 Hz. 
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Autoguide Calibration Using Relays 

When autoguiding with the SBIG AO, there are two types of autoguiding taking place.  The SBIG 
AO tips and tilts its mirror to make rapid, precise guide corrections.  Over time, the guide star 
may drift, and the AO accommodates this drift as it continues to guide.  If the star’s drift is large 
enough, the mirror has a larger base tilt.  When the base tilt reaches a certain value, the mount 
is moved in the opposite direction (“bumped”) using the camera relays or Direct Guide.  This puts 
the AO mirror back closer to the center of its range of motion. 
 
These two types of guiding (mirror tip/tilt and camera relays/Direct Guide) are the reason that 
you must have both the autoguider calibrated using camera relays/Direct Guide and the 
autoguider calibrated using the SBIG AO before you can successfully autoguide using the SBIG 
AO. 
 

  

• If you have a Paramount mount and ProTrack™ is enabled, the Camera Add On 
usually does not need to bump the relays to keep the AO within its range of motion 
as ProTrack adjusts for nearly all the stellar drift. 

 

• The aggressiveness setting for the mount applies when using the SBIG AO.  A lower 
aggressiveness setting on the Relay Settings tab results in smaller (but more 
frequent) mount movements.   A higher aggressiveness setting results in larger (and 
less frequent) mount movements.  Too frequent mount movements can reduce the 
effectiveness of the SBIG AO.  Too large mount movements can result in elongated 
stars.  You will need to determine a happy medium for the aggressiveness setting 
that balances these two extremes. 

 

 
For details on relay calibration for autoguiding, please see “Autoguider Calibration” on page 469. 

Additional AO Settings 

Figure 219 shows the basic AO settings available on the Autoguide tab.  In most cases, you will 
not need to adjust any other settings to get good results with the SBIG AO.  However, additional 
AO parameters are available on the Autoguide Settings window’s AO Settings tab (Figure 220).  
You can use these settings to refine the accuracy and performance of the SBIG AO.  To access this 
window, click Setup on the Autoguide tab of the Autoguider window (refer to Figure 219). 
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Figure 220: The AO Settings tab on the Autoguide Setup window. 

The Tracking Options section of the AO Settings tab contains the following settings: 
 

Control  Description 

Aggressiveness This is the same as the aggressiveness setting for the SBIG AO on the 
Autoguide tab. 
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Control  Description 

 

Slew Rate This is the same as the slew rate setting for the SBIG AO on the Autoguide 
tab. 
 

Relay 
Threshold 

The amount of mirror tilt that must occur before the mount is “bumped” 
with the camera relays.  The default value is 50%, and this will work for 
most situations.  If the seeing is very steady, and you would like to see less 
frequent mount movement, set this to a higher number.  Never set the 
number so high as to cause the mirror to reach the end of its travel; the 
mirror cannot make corrections beyond 100% movement.  Always leave a 
margin of safety.  If seeing is poor, you can increase the safety margin by 
lowering this value. 
 

Relay “bump” 
size 

The relay bump size defines how much the telescope is moved when the 
SBIG AO mirror runs out of tilt.  The bump size unit of measurement 
depends on the type of guiding: 
 

• For camera relays, the unit is seconds of time that the relay is closed. 

• For Direct Guide, the unit is more closely related to, but not exactly, 
arcseconds of movement.  

 

Track Box The size of the subframe used for autoguiding with the AO.  Available 
values are small (4x4 pixels), medium (8x8) and large (16x16).  A smaller 
track box allows for faster downloads and thus faster guiding.  However, if 
the track box is too small, seeing-induced movement may cause the star 
to be lost, resulting in poor guiding.  On any given night, the seeing will 
limit the size of the track box you can use. 
 

Always Use 
2x2 

Binning the guide chip 2x2 increases its sensitivity.  For a given star, the 
guide rate will be slower with 1x1 binning than with 2x2 binning.  Since AO 
corrections are limited by exposure length, the shorter exposures possible 
with 2x2 binning allow you to use faster guide rates. A faster guide rate 
means the AO can work more effectively.  
 
 

 

The increased sensitivity for 2x2 binning comes from an 
increase in signal to noise ratio.  Signal increases 4 times (22), 
and noise only increases ~1.4 times (square root of 2). 
Therefore, the best possible signal to noise increase is from x 
to (4x/1.4) or 2.85x. 
 

 

Use AO 
Defaults 

Click this button to restore the default settings. 
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The Exercise AO group of controls allows you to test the movement of the AO mirror.  You should 
remove the AO from the telescope when testing and observe whether the motion occurs.  The 
AO device will make a light vibrating sound while it is being exercised. 
 
The Exercise AO section contains the following settings: 
 

Setting Description 

Step period Defines how long to move the SBIG AO for each step.  The default value is 10 
milliseconds. 
 

Driven axes You can test the X- or Y-axis alone or both axes together. 
 

Exercise Click this button to begin exercising the SBIG AO.  A window appears during 
exercising to show the current X and Y position of the mirror.  Click Cancel to 
stop the exercise process. 
 

 
When you are finished making changes to the AO Settings tab, click OK save them, or Cancel. 

AO Calibration 

 

Even if you are using the SBIG AO for guiding, you must still calibrate the 
autoguider using relays as well.  See the section, “Autoguide Calibration,” for 
information. The relay calibration must be done prior to guiding with the 
SBIG AO.  If mount calibration fails, the SBIG AO may be unable to guide 
accurately, because movement of the mount via camera relays during 
guiding will be incorrect and the guide star will be lost. 

 
During drive calibration, the Camera Add On takes a photo, moves the mount 
in a given direction, and then takes another photo.  The difference in the 
calibration star’s position between the two photos tells the Camera Add On 
how fast the mount moves in each of the four directions.  Once calibrated, 
the Camera Add On can issue guide corrections that are as accurate as the 
mount will allow.  Various factors, such as backlash and rough gear surfaces, 
can reduce the accuracy of mount-based guiding. 

 

 
With the SBIG AO, corrections are made by tipping and tilting a small, lightweight mirror.  There 
are no gears to worry about, and the mass of the mirror is tiny compared to the mass of a mount.  
In addition to its adaptive optics capabilities, the SBIG AO provides very accurate guiding and can 
compensate, up to a point, for an inaccurate mount.  The mount must be accurate enough to 
move reliably with the camera relays.  You can use a larger track box (see preceding section) to 
compensate for some of the mount’s inaccuracies—a larger track box makes it less likely that a 
mount error will push the star out of the track box. 
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As with any calibration, the key to success is finding a suitable star for calibration.  A good 
calibration star must be the brightest star in the field of view, and there must not be similar bright 
stars nearby that will move into the field of view during calibration.  You can use stars the 
simulated stars on the Sky Chart to help locate suitable calibration stars.  For more information 
about selecting stars for calibration, please see the section “Choosing a Good Autoguider 
Calibration Star” on page 475. 
 
Adjust the telescope position to put the calibration star roughly in the center of the photo.  This 
will prevent it from moving out of the field of view during calibration.  Next, click Calibrate on 
the Autoguider tab of the Autoguider window to show the Calibration Autoguider window 
(Figure 219). 
 

 

Figure 221: Calibrating the SBIG AO. 

Click the Calibrate Using AO Tip/Tilt radio button to use this calibration method.  For most 
applications, use 100% as the AO Deflection While Calibrating.  You can reduce this number to 
see if it improves the perpendicularity of calibration.  Use the AO Calibration Results tab of the 
Autoguide Settings window to evaluate AO calibration (Figure 222). 
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Figure 222: AO calibration results. 

Note that the X/Y axes of the calibration results (green arrows) are not necessarily perpendicular 
to the reference X/Y axes.  This is normal.  Even if the camera and SBIG AO are installed exactly 
orthogonal to the mount’s axes, the vector showing AO movement may be slightly non-
orthogonal because of how the mirror moves.  The Camera Add On takes this into account and 
will guide accurately with the SBIG AO. 
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AO-Assisted Autoguiding 

Once you have calibrated the autoguider using both relays and the SBIG AO, you can use the SBIG 
AO for guiding.  Start by clicking Take Photo from the Autoguide tab of the Autoguide window. 
 
As with calibration, the key to successful autoguiding is finding a suitable guide star.  The guide 
star should be away from the edges of the chip, and if you are using color filters it should be 
bright enough to remain visible through all filters.  The brighter the guide star, the faster the 
guide rate you can use.  Since the SBIG AO works best with the brightest available guide star, it’s 
usually worthwhile to find the brightest one you can. 
 
You can use TheSkyX to help locate suitable guide stars, adjust the framing of your photo, or 
rotate the camera to find the best available guide star.  For more information about selecting 
stars for guiding, please see the section “Select a Guide Star” on page 478.  
 
Adjust the telescope position to put the guide star at least 10 pixels away from the edges of the 
guide window.  This will make it less likely that the guide star will move off of the guide chip 
during guiding.  You can adjust the guide star’s position using the mount’s hand paddle; TheSkyX 
mount controls; or using the NSEW buttons on the Autoguide tab.  The NSEW buttons move the 
telescope at the current guide rate using the camera relays, and you can use them to make very 
small adjustments to position. 
 
Before you start autoguiding, you can make final adjustments to guide parameters.  Settings for 
Aggressiveness and Slew Rate can be made right on the Autoguide tab.  You may also need to 
adjust the Track Box Size to adjust for seeing conditions.  The better the seeing conditions, the 
smaller the track box you can use.  Figure 223 shows the appearance of the three track box sizes.  
Note that different zoom levels are used for the track boxes, so the track box stays the same size, 
but the relative size of the star changes.  From left to right, they are Small, Medium, and Large.  
The Small track box requires very good seeing (steady skies), or the star will move out of the track 
box.  The Medium setting is good for more typical seeing conditions, and the Large track box 
allows you to use the SBIG AO on nights when the seeing is below average. 

 

Figure 223: Different sizes of the AO track box.  From left: Small, Medium, and Large. 

Once the guide star is properly positioned, click Autoguide to begin guiding.  The Camera Add On 
takes multiple dark frames and averages them to reduce noise in the dark frame.  This master 
dark is subtracted from all light frames to provide as clean an image as possible during guiding.  
If your exposure time is relatively long (for example, 5 seconds), it will take longer to capture the 
multiple dark frames before the start of guiding.  A 5-second exposure will not give you any 
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benefits of the adaptive optics, but could be used instead of conventional guiding if your mount 
does not handle guide corrections effectively. 
 
During guiding, you can monitor the effectiveness of guiding by watching the values in the AO 
Enabled section of the Autoguide tab.  The X and Y Tilt values show the current tilt of the SBIG 
AO mirror.  These values should change over time as the mirror tilts to accommodate drift.  When 
tilt reaches the maximum value allowed (default is less than 25% or greater than 50%), The 
Camera Add On will bump the mount and the tilt should return closer to 50% for both axis.  The 
amount it will go down depends on the aggressiveness setting of the mount.  With low 
aggressiveness settings on the mount, smaller bumps will occur, and the bumps will therefore be 
more frequent.  
 
The Wander metric indicates how accurately the SBIG AO is guiding.  If the SBIG AO 
aggressiveness is too low, wander will be high because the SBIG AO will under correct.  If the SBIG 
AO aggressiveness is too high, over-correction may occur and this will also increase the Wander 
value.  Adjust Aggressiveness and the Slew Rate to obtain the optimal Wander value. 

 

 

• The Wander metric is computed based on the physical characteristics of the 
telescope.  Enter these parameters on the Imaging System Setup window 
(Telescope > Telescope Setup, highlight Camera, and enter the telescope’s 
Telescope Focal Length.). 

• Local seeing conditions also affect Wander.  Compare the Wander value with 
and without SBIG AO guiding so that you know the contribution to Wander from 
seeing. 

 
 
A good measure of the optimal tuning of the aggressiveness, guide rate, etc. is the RMS wander.  
This wants to be a small as possible and ideally will not degrade when the AO is turned off 
momentarily. 
 
Ideally an AO guided image will have 30% lower stellar half-width and 50% to 100% better peak 
brightness. 
 
You can also use First Count and Count to monitor guiding.  If the Count value drops, you may 
have clouds moving in or a focus shift.  Focus can shift from changes in temperature, or from a 
physical slippage of the focuser. 
 
The Guide Rate may be lower than you expect, depending on the processing speed of your 
computer’s processor.  For example, if you are using an exposure of 0.02 seconds, you might 
expect a guide rate of 50 Hz (exposures per second).  However, it takes time to download and 
display images, and it takes additional time to perform calculations on your computer.  This time 
is added to each exposure, resulting in the actual guide rate.  In this example, the guide rate 
might be anywhere from 6 to 40 Hz depending on your equipment. 
 
Autoguiding will automatically suspend during downloads from the main imaging chip.  
Autoguiding will resume when the download is complete.  If you are using a Small or Medium 
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track box, the guide star may have drifted out of the field of view during the download.  Cameras 
with USB download are much faster, and it is more likely that you will retain your guide star using 
a USB-equipped camera.  An extremely accurate polar alignment will also help you retain your 
guide star following a download. 
 
If the guide star is lost, or if a different guide star is found, you can Abort the guiding and restart 
it with the desired star.  Re-center the mirror if tilt is large.  Click Take Photo to get a new image 
using the guide star, click to select the guide star, and then click Autoguide to begin again.  If you 
are taking a sequence of images, you may need to monitor the downloaded images and the guide 
star window to determine if the guide star is still available. 
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Taking Series of Photos 

The Camera Add On gives you the ability to acquire multiple photos, in sequence, using the Take 
Series tab on the Camera window. 
 

 

Figure 224: The Take Series tab on the Camera window. 
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Take Series Button 

Click this button to begin the process of taking photos based on the settings in the Series table. 

Repeat Executes Options 

These two options permit a flexible means to control how individual series are executed. 

Per Series 

When this option is selected, Series 1 is repeated based on the Series 1 Repeat value, followed 
by Series 2, which is repeated based on the Series 2 Repeat value, and so on until the series is 
completed. 
 
For the series defined in Figure 224, Series 1 is repeated 10 times, followed by Series 2, which is 
repeated five times, followed by Series 3, eight times, followed by Series 4, three times. 

Across Series 

When this option is selected, Series 1 is executed first, and once, regardless of the Repeat value, 
then Series 2 is executed once, regardless of the Repeat value, and so on until the end of the 
series.  The series execution continues for each series that has a Repeat value greater than one.   
 
For the series defined in Figure 224, Series 1-4 are each executed three times, then series 1-3 are 
executed two more times (since the Repeat count of Series 2 is 5, and that makes five repeats), 
then Series 1 and 3 are each executed three more times, and Series 1 repeats to more times for 
a total of ten repeats. 

Abort  

Click this button to stop taking a series of photos. 

Series Table 

The top row of the Series Table lists each series, starting with Series 1.  
 
The left-most column of the Series Table lists the camera settings (and filter settings, if a filter 
wheel has been selected) that will be applied to each series.  To edit any one of the series 
parameters, double-click the appropriate table entry.  For example, double-clicking on the 
number 10 next to Exposure Time shows the spin box that lets you enter a different value. 
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Figure 225: To change a camera or filter setting for a series, double-click the appropriate table to reveal the text input 
control or pop-up menu.  

Exposure Time 

Enter the length of the exposure, in seconds, for this series.  See “Select Exposure Length 
(Exposure Time)” on page 456 for details about this camera setting. 
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Binning  

Choose the binning for this series.  See “Select Bin Mode (Binning pop-up)” on page 458 for details 
about this setting. 

Frame 

Choose the type of frame (Light, Bias, Dark, Flat Field) to capture for this series.  See “Set Frame 
Type to Light” on page 460 for details about this camera setting. 

Filter 

Select the desired filter for this series.  Note that the Filter option is displayed only if an 
appropriate filter wheel is selected on the Imaging System Setup window. 

Repeat 

Enter the number of times to repeat this series. 

Calibration 

Each series can have its own image calibration setting.   
 

• Default: Apply the selected Reduction option (None, AutoDark, or Full Calibration) 
described under Reduction (Default Calibration) below. 

• None: Do not calibrate the images acquired in this series. 

• AutoDark: Apply a dark frame to photos. 

• Full: Imager:  Apply a calibrated photo to the photos acquired with the imaging camera. 

• Full: Autoguider: Apply a calibrated photo to the photos acquired with the guiding 
camera. 

 
These options allow, among other possibilities, creating master flat images for multiple filters 
and to have the reduction process proceed automatically during image acquisition without user 
intervention.   

Add Series  

Click this button to add a new series to the Series Table. 

Remove Series 

Click this button to remove the selected series from the Series Table. 
 
The options that appear on the lower portion of the Take Series tab are applied to each series.  
For example, an Exposure Delay of 10 seconds, is applied to every series automatically. 

Exposure Delay 

Enter the delay between each exposure in each series to allow for telescope settling. 

Dithering 

Enter the number of pixels to move the guide star (specifically, the telescope) between successive 
photos in the series. 
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Settle Threshold 

Enter the maximum deviation, in pixels, of the guide star after the telescope’s position has been 
adjusted during dithering process.   
 
The threshold value only applies when dithering is taking place.  While dithering, the guide star 
is “moved” and the next photo from the autoguider is interpreted as a large guider error.  Over 
subsequent guider photos, the error is corrected until the guider settles into its new position. 
This value represents the largest acceptable guider error that should be detected before 
resumes. 

Reduction (Default Calibration) 

This reduction setting is used when the Default option is selected from the Calibration pop-up 
menu in the series.   
 

• None: Do not apply any reduction to the photo. 

• AutoDark: Apply a dark frame to the photo. 

• Full Calibration: Apply a calibrated photo to the photo. 
 
The following options are only displayed when the Full Calibration Reduction option is selected. 

Group Pop-up Menu 

Choose either Imager to apply a calibrated photo from Image Calibration Library for the imager, 
or Autoguider to apply a photo for the autoguider. 

Image Calibration Library Button 

Click this button to show the Image Calibration Library window.  See “Taking Calibration Frames” 
on page 534 for more information about image reduction and calibration. 

Subframe On 

Turn this option on to show and use a portion or subframe of the photo instead of the full frame. 

Size Button 

Click this button to define the size of the subframe. 

Automatically Save Photos 

Turn this checkbox on to automatically save photo acquired during the series. 

AutoSave Button 

Click this button to show the AutoSave Setup window to configure the AutoSave settings (page 
462). 
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Image Reduction 

Image reduction allows you to clean up images to better reveal the data in them.  You can in 
effect take pictures of some of the noise in your imaging equipment, and then use those pictures 
to remove much of the noise. 
 
Noise is the error in the brightness levels in an image.  Noise can occur from a variety of sources.  
Some noise is random and unpredictable.  Such noise can be limited, but never removed.  This 
type of noise is defined as the level of uncertainty in brightness levels.  For example, if you took 
four images of an object, you might see brightness levels of 98, 97, 103, and 102.  That variation 
in brightness reflects the error level. 
 
Other types of noise are inherent to the imaging equipment, and this type of noise is called 
system noise.  System noise can be subtracted from your images to clean them up.  It builds up 
while you are taking your image, and while reading the image off of the CCD detector.  By taking 
steps to limit noise in the camera (mainly by cooling the detector), and by removing the 
repeatable noise that is left, you can achieve very high-quality images.  Image reduction, 
however, can only clean up an image so far.  The quality of the image itself determines that limit.  
Longer exposures, or combined exposures, when reduced properly, will give you the highest level 
of quality possible. 
 
All noise by nature creates uncertainty in the brightness levels of the pixels in your image.  If a 
picture has a lot of noise in it, you can see this visually.  There will be variations in brightness in 
areas that you expect to have a more uniform brightness.  Words commonly used to describe 
this effect are “grainy” and “gritty.” 
 
Some common sources of system noise in CCD imaging include: 
 

• Readout noise results from collecting, amplifying, and converting pixel data to electrons 
inside the camera. 

• Dark current results from electrons accumulating in pixels even in the absence of light. 

• Optical dust is debris and bits of dust in the optical path that cast shadows on the CCD 
detector. 

• Background noise results from sky glow.  

• Reflections are the effects of light that reflects off various surfaces in the telescope, focuser, 
or CCD camera, and falls on the CCD detector. 

• Image processing noise results from processing the image using various techniques. 
 

Removing the system noise from your images is a form of data reduction.  The term “calibration” 
is sometimes used to refer to this process, but data reduction is a more accurate description of 
the procedures involved.  Calibration involves comparing values to a known accurate reference, 
such as calibrating the brightness of a star in an image using its known magnitude, or determining 
how far your mount moves in 10 seconds (autoguider calibration). 
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Even when you take steps to remove noise, you also add some noise back into the image at the 
same time.  For example, when you subtract a dark frame (page 538), you add the dark frame’s 
noise to the image.  You are usually removing much more noise than you add, providing a net 
gain from this and most other noise reduction processes.  Thus, there is no way to remove all the 
noise from an image.  You can remove a lot of noise with careful technique, however.  Figure 1 
shows two halves of an image.  The top half shows the original image; the bottom half shows the 
same image after data reduction. 
 

 

Figure 226: The benefits of data reduction on an image of Stephan’s Quintet. 

This chapter describes how to use TheSkyX Camera Add On to remove noise from your images, 
leaving them cleaner and ready for further processing.  In this chapter, you will learn how to: 
 

• Acquire bias frames. 

• Acquire and apply dark frames. 

• Acquire and apply flat-field frames. 

• Create and manage groups of bias, dark, and flat-field frames. 

• Manually and automatically apply data reduction to images. 

Quick Start for Experienced Users 

For this section, an experienced user is someone who has experience creating and applying bias 
frames, dark frames, and flat field frames to CCD images. 
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The most powerful way to apply reduction is to create reduction groups, consisting of any 
number of bias, dark, and flat-field frames.  You can apply reduction groups to individual images, 
to a folder of images, or automatically to each image as you acquire it. 
 

1. Create a reduction group, and add images to it.  To begin, you must have appropriate bias, dark, 
and flat-field images to add to the group.  Follow accepted guidelines for optimal creation of 
these files: 

• Bias and dark frames should be taken at the same temperature as the light frames. 

• Bias frames should be taken using the shortest possible exposure time. 

• Dark frames should be taken with same exposure as the light frames. 

• If matching exposure temperature and duration is not practical, the Camera Add On can 
be set to compensate for these differences. 

• Flat fields can be taken at different times and temperatures than light and dark frames.  
If appropriate, you can use separate dark frames for flat fields. 

2. Click Input > Photo Calibration Library to open the Photo Calibration Library window.  Click Add 
Group to create a new group.  Try using a name that includes the date, detector temperature, 
and/or other items that can help you with later re-use of the group. 

3. The new group will have placeholders for bias frames, dark frames, dark frames for flats only, 
and flat frames.  Click on the placeholder, and then click Add Frames.  Navigate to the folder with 
the files you want to add.  Highlight the frames you want to add (use Ctrl and Shift keys to select 
more than one), and then click Open. 

4. Continue until you have added all the images you desire to any or all of the four placeholders. 
 
You now have several options for using the newly created reduction group: 
 

• If you have one or more images open that you want to reduce, click Calibrate, select the photos 
to calibrate, and click OK.  

• If you have a folder of photos to reduce, click Calibrate Folder and navigate to that folder.  Then 
select the output folder and click the Calibrate button.  This is a powerful feature that can save 
you hours of effort.  For example, in just a few minutes you could apply bias, dark, and flat frames 
to hundreds of photos.  Note: every file in the folder must be an appropriate photo in FITS format 
for the calibration group.  For best results, copy images with the same calibration characteristics 
into a folder. 

• If you are taking new photos, and want to apply the calibration group to each photo as it is 
acquired, start by making sure to save your photos by turning on the Automatically Save Photos 
checkbox on the Camera window.  Next, select Full Calibration as the Reduction option.  Then 
select the desired group from the Group option just below the Reduction option.  Note: The 
Group pop-up menu is hidden unless you choose the appropriate Reduction option.  The group 
you select will automatically be applied to each photo.  The original photo and the reduced photo 
are both saved to the AutoSave folder.  The reduced photo will have the keyword “REDUCED” 
added to the filename. 
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Principles of Image Reduction 

There are many sources of noise in the data collection process.  There are three things you can 
do that will remove most of the noise from most images, and they all involve taking a picture that 
captures the noise you want to remove.  These are bias, flat-field, and dark frames.  Figure 2 
shows an example of each type of frame. 
 

 

Figure 227: Samples of bias, flat-field, and dark frames. 

Bias Frames: Bias represents pixel values that occur on your CCD detector even if the exposure 
time is zero (or as close to zero as possible).  In other words, even a zero-length exposure still 
delivers non-zero brightness values.  This means that pixels do not necessarily start with a zero 
value at the beginning of an exposure.  Note: SBIG cameras include a 100-unit pedestal (that is, 
100 units are added to the value of every pixel).  This is true not just of bias frames, but of all 
frames (bias, dark, flat-field, and light).  TheSkyX Camera Add On appropriately subtracts the 
pedestal during data reduction.  You will find instructions for taking bias (and other types of data 
reduction frames) in later sections of this chapter. 
 
Dark Frames: Even if no light strikes the CCD detector, the individual pixels change value over 
time, building up an electrical charge consisting of electrons that accumulate in the pixels.  Most 
of this energy comes from heat, and it is called thermal noise or dark current.  Most CCD detectors 
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are cooled to reduce this type of noise, but there will always be some level of dark current.  The 
greater the cooling, the lower the dark current will be.  Each pixel responds to dark current 
differently.  Some are more sensitive, and will be brighter as a result of dark current.  Others are 
less sensitive, and may change very little.  The top half of figure 1 shows many hot pixels from 
dark current.  Dark current varies slightly from image to image, but it is highly consistent.  Thus, 
as with a bias frame, you can take an image with the shutter closed (or your hat over the front of 
the telescope if your camera has no shutter) to create a dark frame.  TheSkyX Camera Add On 
subtracts dark frames from light frames to remove most of the effects of dark current. 
 
Flat Field Frames: As light comes through the telescope and CCD camera, several things can 
happen.  Under the best of circumstances, the light will come through unobstructed and perfectly 
distributed.  This ideal situation is seldom the case, however.  For example, the center of the focal 
plane is often brighter than the edges.  Also, dust can get on the optical surfaces, casting shadows 
that affect the amount of light reaching each pixel.  In addition, internal reflections can cause 
unwanted light to fall on the CCD detector.  A flat-field frame records these variations in 
brightness.  To create a flat-field frame, take an image of an evenly illuminated surface.  Various 
parts of the optical path add or subtract light from the evenly illuminated surface, and the flat 
field records the variations. 

Taking Calibration Frames 

Bias frames are easy to take, and require no special technique.  You simply take the shortest 
possible exposure that your camera provides.  Dark frames are also relatively simple, though you 
should match the temperature and exposure length of the light frame(s) reasonably well.  Flat-
field frames are the trickiest to master.  It’s not as easy as it sounds to create an evenly 
illuminated surface.  You’ll learn some useful techniques for creating good flat fields later in this 
chapter.  The  
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Bias Frames 

Figure 3 shows the Take Series tab set up to take a series of three, one-minute light exposures.  
Binning is 1x1, and no image reduction will occur because the Reduction option is set to None.  
See the section “Automatic Reduction” later in this chapter for information about automatic 
image reduction. 
 

 

Figure 228: The light frame to which the sample bias, dark, and flat-field frames will be later applied.  Note that the Filter 
row is only shown when connected to a filter wheel. 
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To take a bias frame for this photo, simply double click Light and instead choose Bias.  Since the 
bias frame is the shortest possible exposure, the Exposure Time settings is ignored.  TheSkyX 
Camera Add On will automatically use the shortest possible exposure for your camera when it 
exposes a bias frame. 
 
Note that the Repeat setting is set to 3.  We recommend taking at least three bias frames.  These 
can be averaged to reduce noise.  The images you take for image reduction have their own levels 
of random noise.  Combining images is one of the most effective ways of reducing the random 
noise in your reduction frames and your images.  This occurs automatically when you use 
reduction groups with multiple frames.  See the section “Using Groups for Reduction” later in this 
chapter for details. 
 
When you are ready to take your bias frames, click Take Series.  If you have set AutoSave on, the 
filename will contain the word BIAS in it so you can readily distinguish your bias frames.  For most 
situations, we recommend leaving AutoSave on to make sure that no images or reduction frames 
are accidentally lost.  As with any image, you can cancel the bias frame or its download by clicking 
Abort.  
 
Bias frames can only be applied as part of a group; there is no command for applying only a bias 
frame to an image. 
 
The Take Series tab allows for taking multiple series of a single target.  For the example at hand, 
we could have taken three lights, three bias and three darks like this by simply clicking Add Series. 
When you press Take Series photos would have been acquired in just that order, three lights, 
three darks, and three bias frames. 
 
If instead you wanted to take one light, one bias, one dark, three times, simply set Repeat to one, 
then copy all three columns and paste to the end twice.  There is really no limit to the number of 
series and the ability to copy and paste a series makes it fairly easy to get most any combination 
of frames. 
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Figure 229: Take Series tab on the Camera window. 

Dark Frames 

Dark frames are an important tool for image reduction.  Dark current varies with the temperature 
of the CCD detector.  Most CCD cameras cool the detector, some by as much as 35 degrees Celsius 
or more.  The warmer the CCD detector, the greater the dark current and the greater the need 
for dark frames.  For optimal noise reduction, take at least three dark frames and use them in a 
reduction group. 
 
Each CCD detector has a pattern of hot and cold pixels that varies minimally from image to image.  
The intensity of the hot pixels varies with exposure length and temperature, however.  For this 
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reason, you should, whenever possible, take dark frames that have the same temperature and 
exposure length as your light frames.  If you are unable to do so, TheSkyX Camera Add On will 
scale dark frames to fit the exposure of a light frame.  The results will not be quite as good as 
when you match temperature and exposure length precisely.  The greater the difference in 
exposure time, the less likely this compensation will be effective.  For example, if you have a light 
frame with a two-minute exposure, a dark frame of 90 seconds or three minutes will be 
reasonably effective.  A ten-minute dark frame, however, will probably add substantial noise to 
the image.  The colder the CCD, the less of a problem this will be, since the total noise in the 
image will be less. 
 
To take a series of three dark frames matching the light frame from figure 3, simply change Frame 
to Dark.  Note that the exposure time matches that of the light frame, and that the temperature 
is the same.  There will often be small fluctuations in CCD detector temperature (less than a 
quarter degree, typically), and these can be safely ignored.  The Frame has been set to Dark.  
Note that the Reduction drop-down list is disabled, since there can be no reduction of a dark 
frame. 
 
When you are ready to take your dark frame(s), click Take Series.  If you have turned AutoSave 
on, the filename will contain the word DARK so you can readily distinguish your dark frames.  For 
most situations, we recommend leaving AutoSave on to make sure that no images or reduction 
frames are lost accidentally.  As with any image, you can cancel the image or the download by 
clicking Abort, which is only active when imaging or downloading.  
 
You may notice on some cameras that one side of the dark frame is a little brighter than the 
other.  This is normal.  It may take as much as a minute or more to download the data from 
cameras with very large pixel arrays, and during this time dark current continues to build up on 
the CCD detector.  Since this gradient occurs in both the light frame and the dark frame, it is 
automatically removed during image reduction.  Cameras that transfer the image instantly via 
frame buffers will not show this effect. 
 
You can apply a single dark frame to an image, or you can apply multiple dark frames as part of a 
group.  Since the thermal noise (dark current) in dark frames is also present in the light frame, 
the idea is to simply subtract the dark frame from the light frame, leaving a clean record of the 
light that struck the CCD detector.  TheSkyX Camera Add On automatically handles the 100-count 
pedestal that is added to images acquired with SBIG cameras (see bias frame section above for 
details). 

Flat-Field Frames 

Like dark frames, flat fields can make a big difference in the appearance of your images.  Flat, in 
this case, means “evenly illuminated.”  Unlike dark frames, which simply require you to take an 
image to record the dark current, taking a good flat field requires much more operator 
involvement.  You should expect to spend some time perfecting your technique in making high-
quality flat-field frames.  It’s not as easy as it might seem to evenly illuminate a surface.  Stray 
light and reflections outside the optical tube are a challenge to control. 
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The flat-field frame is a record of the optical path’s characteristics (see figure 14 for an example 
of a flat field).  Anything that casts a shadow or causes a reflection leaves its imprint on the flat-
field image.  This includes dust on any of the optical surfaces; lint hanging from the inside of the 
tube into the optical path; light reflecting off of any surfaces within the tube, focuser, filter wheel, 
and/or camera, etc. 
 
If you rotate your camera, change filters, use a different dew shield, or make any other changes 
to your system, you’ll probably need a new flat field.  You’ll also want to take new flat fields 
periodically to account for any new dust that settles on the optical surfaces, or that moves or falls 
out of the system. 

Quality Issues for Flat Fields 

The best way to judge the quality of a flat field is to apply it to a test image.  The ideal test image 
is of a sparse star field unaffected by light pollution, without any large galaxies or nebulas in the 
field of view.  This allows you to examine the effects of the flat field on the entire background of 
the image.  If applying the flat field removes shadows from dust particles, and provides a flat, 
even background in your images, then it is an effective flat field.  If you do not have an area of 
sky unaffected by light pollution, you may have to use your best judgment on the quality of your 
flat field. 
 
Several things can get in the way of this simple test of a flat field, however: 
 

• If there is a moon or other bright light source, the sky background may not be flat.  It will 
be brighter on the side toward the light source, and darker away from the light source.  
This gradient may be very small, but after you apply a flat field the gradient will be much 
more visible.  A bright full moon, a nearby streetlight, or lights from an urban area near 
the horizon can all create severe problems that are a major challenge to solve.  It’s difficult 
to test a flat field when such a gradient is present, and the flat field won’t solve this type 
of gradient problem because the source is outside the optical system.  In some cases, such 
as when the light is very bright or the dynamic range of your CCD detector is small, the 
gradient will overwhelm the image completely. 

• Off-axis light sources can pollute a flat field.  For example, suppose you are using a dew 
shield and that there is a neighbor’s security light to the left of the telescope’s optical axis.  
If that light reflects off of the dew shield, it could make it down the optical tube and hit 
the CCD detector.  As a result, one side of the flat field image will be brighter than the 
other.  The off-axis light source prevents you from getting even illumination.  Similarly, if 
you are using a translucent panel to create the even illumination, an off-axis light source 
could reflect preferentially at some angles and create bright spots in the flat field. 

 
All of these obstacles can be overcome.  You need to invest some time to discover the ways in 
which undesired light is interfering with even illumination.  Once you eliminate the extraneous 
light sources, you wind up with a very high quality flat field that will give you much better looking 
images. 
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Flat fields have value for scientific research.  A properly executed flat field will remove distortions 
in brightness levels from an image, and allow you to make accurate measurements of the relative 
brightness of objects in the image.  Without a good flat field, your calculations will contain a 
larger amount of error. 
 
But flat fields are also important for taking “pretty pictures,” too.  It is difficult – sometimes 
impossible – to process an image that has variable levels in the background.  Dim areas of an 
image get lost in the brighter portions of the background.  A properly executed flat field can 
completely solve such problems.  Getting to a flat, even background is very important no matter 
what kind of images you take. 
 
A good flat field will correct for any shadows and reflections in your optical system.  Any gradient 
in the background that remains after a good flat field is either caused by brightness in the sky 
itself, as from the moon or a bright planet; light pollution; or by off-axis light sources that cause 
additional internal reflections.  Creating a counter gradient and subtracting it can remove 
gradients, but you will almost always loose some image quality in the process. 

Flat Fields 

Figure 230 shows the settings to use for taking a flat field.  The exposure time need not (and 
mostly will not) match the exposure time of the original image.  Likewise, the temperature need 
not be the same.  You will need to take a separate dark frame (or set of dark frames) that match 
the temperature and exposure time of your flat field frames.  If you apply a flat field individually 
to an image, apply the flat’s dark frame first.  If you use reduction groups, the dark frames for the 
flat field frames are part of the group, and will be applied to the flat frame automatically.  In 
Figure 230, the Frame type has been set to Flat Field, and the Reduction is set to None. 
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Figure 230: Settings for taking a series of flat-fields. 

The obvious question about a flat field is how to long to expose.  The goal is to have a flat-field 
image with an average value that is about 33-50% of the CCD detector’s saturation level.  The 
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table below summarizes the ideal range for flat-field images for various SBIG cameras binned 
1x1.  For other camera brands, or for binned images, you will need to calculate the saturation 
level yourself, using the following formula: 
 

ADU per electrons

capacity  wellfull
 

 
The full-well capacity is the largest number of electrons that a pixel can hold, and is normally 
available in the technical specifications for the CCD detector.  “Electrons per ADU” is called the 
gain of the camera.  “ADU” stands for Analog to Digital Unit, and is a single brightness level. 
 
Each camera also has a certain number of bits that are used to perform the analog to digital 
conversion.  The ST-7E, for example, uses 16 bits, which provide a maximum value of about 
65,500 units.  The ST-237 uses 12 bits, with a maximum value of 4096.  If the saturation level is 
greater than the maximum value based on the number of bits, use the number based on the 
number of bits. 
 
Table: Saturation values for flat-field frames 
Average value of the brightest area should fall between 33% and 50% of saturation. 
 

Camera/ 
Guider 

Full Well 
Capacity Gain * 

Calculated 
Saturation 

Effective 
Saturation 

33% *** 
Saturation 

50% *** 
Saturation 

ST-4 
8 bits 

80,000 150 533 533 175 250 

STV 
10 bits ** 

20,000 4.0 5,000 1024 350 500 

ST-5C 
16 bits 

50,000 2.0 25,000 25,000 8,500 12,500 

ST-237 
12 bits 

20,000 4.0 5,000 4.096 1350 2000 

ST-6B 
16 bits 

400,000 6.7 59,700 59,700 20,000 30,000 

ST-7E ABG 
16 bits 

50,000 2.3 21,740 21,740 7,250 11,000 

ST-7E NABG 
16 bits 

100,000 2.3 43,500 43,500 14,500 21,750 

ST-8E ABG 
16 bits 

50,000 2.3 21,740 21,740 7,250 11,000 

ST-8E NABG 
16 bits 

100,000 2.3 43,500 43,500 14,500 21,750 

ST-9E 
16 bits 

200,000 2.8 71,400 65,000 21,600 32,500 

ST-10E 
16 bits 

77,000 1.5 51,000 51,000 17,000 25,500 

* Electrons per ADU 

** Varies with binning mode; see SBIG documentation. 

*** Rounded values for easy memorization 
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Note: CCD detectors and CCD cameras have natural variations in their full-well capacity and gain 
settings.  The numbers shown in the table for saturation are only approximate. 
 
Note: When measuring brightness of a flat-field image, be sure to average a small group of pixels 
so that a single bright pixel won’t throw off the reading.  To find the value of a pixel in TheSkyX 
Camera Add On, pass the mouse cursor over the image.  The coordinates and brightness value 
appear on the status bar at the bottom of the TheSkyX Camera Add On window. 
 
The best way to take a flat field depends on your telescope and overall optical configuration.  
Here are some suggestions for different ways to take a flat field; you can try them to see which 
provides the best results for you. 

Taking a Flat Field Image 

The idea behind a flat field is simple: Using the same focus position you use for taking light 
images, take an image of an evenly illuminated surface so that you achieve approximately one-
third to one-half the saturation level of the CCD chip.  Here are some things to keep in mind when 
taking a flat field: 
 
Same Focus Position:  The flat field is a snapshot of your optical system in a specific arrangement.  
If you change the focus position, the relative positions of the optical elements change, and any 
dirt or dust will cast different shadows, and reflections will change as well.  To get a useful flat 
field, the optical system must be in the same position as when used for astronomical imaging. 
 
Take An Image: The flat field is an image of something.  That means that it must be treated like 
any other image: it will need a dark frame, for example. 
 
Evenly Illuminated Surface: Whatever it is that you are taking a picture of when you take a flat-
field image, the surface needs to be evenly illuminated.  Otherwise, the flat field isn't flat.  The 
flat field represents the variations from flat illumination caused by your optical system.  If the 
surface you are imaging is not evenly illuminated, then the flat field is only an approximation, not 
a true flat field.  You can get away with some unevenness at times, but the more even your 
illumination, the better your flat field will work. 
 
If you normally use a dew shield when imaging, make sure you also use it when you take the flat.  
Otherwise, off-axis illumination can cause internal reflections that vary from those that occur 
when you image. 
 
Here are some things you can try for making flat field images.   
 

• The Two-Surface Flat (Figure 231) involves shining a light on a flat object so that it reflects 
off of another flat object and into the front of the telescope.  The main disadvantage to this 
method is that it frequently takes two people to get enough distance between the two 
diffusing surfaces. 
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Figure 231: Taking a flat using two surfaces to diffuse light to create even illumination. 

• The Dome Flat involves imaging the inside of an observatory or the wall of a nearby house, 
shed, or fence.  You can use any evenly lit surface to take this kind of flat, but getting even 
illumination can be tricky.  Try moving the scope slightly between images, and average 
multiple images to improve evenness. 

• The Sky Flat involves taking many images of the sky at twilight, and averaging them to create 
a flat field.  You may get some dim stars, but taking 8 or 12 or even 16 images, and moving 
the mount between images, will allow you to combine the images by averaging to remove 
the stars.  Figure 232 shows a typical twilight flat; Figure 233 shows how averaging a dozen 
such images can remove any trace of stars. 
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Figure 232: A single sky flat taken at twilight. 

 

 

Figure 233: An average of twenty twilight flats. 
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• The Light Box Flat involves a box with a light source and a diffuser, which is placed on the end 
of the telescope.  These are available commercially, or you can build your own.  Numerous 
plans for light boxes can be found on the web. 

• The T-Shirt Flat uses a T-shirt or other white cloth over the front of the telescope.  Figure 234 
shows this in operation.  It may not be pretty, but if you are very careful about off-axis light 
sources, this method can generate very high-quality flat field frames.  Make sure the cloth is 
stretched as flat as possible across the aperture.  Point the telescope away from bright lights 
(toward the ground in daylight) to get the most even illumination possible.  The goal is to get 
a perfectly even, indirect light falling on the cloth.  If you use a dew shield, attach the cloth, 
and then put the dew shield on before you take your flat field. 

 

 

Figure 234: Using a T-shirt to take a flat in daylight.  Be sure to point the scope away from bright sources of light. 

Figure 235 shows a comparison between a good flat and a great flat.  The important point is that 
the difference is actually very small.  The sky flat in Figure 235 has a brighter right edge.  The T-
shirt flat has a distinctly darker right edge.  How do you determine which is the “better” flat field 
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image?  You apply each to a test image as described earlier in this chapter.  The sky flat created 
a gradient in the test image, while the T-shirt flat left an even background.  It is important to 
make sure that your flat-field setup doesn’t allow any off-axis light into the telescope.  Off-axis 
light can reflect off of the flat surface and/or interior surfaces of the optical system and make a 
mess of a flat field.  A dew shield can help prevent off-axis light from being a problem.  If you use 
a dew shield for imaging, be sure to also use it for creating your flat fields. 
 

 

Figure 235: Comparing the results from two types of flat fields. 

Figure 236 shows some examples of evaluating the quality of flat fields.  Take an image that is 
near the zenith on a night with good transparency and minimal sky glow.  Now apply your dark 
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frame(s) to the light image.  Measure the variations in the background levels.  If the levels vary 
by only a small amount, then you have a good test image for your flat field.  If you are having 
trouble evaluating the quality of the background numerically, you can also adjust the background 
and range to give you useful visual feedback.  Set a low background and a very small range.  This 
will reveal variations in the background clearly.  Adjust the black and white point settings (click 
the Histogram button on the FITS Viewer window, page 109) to provide a fairly bright 
background, and then reduce the range until it is grainy and any brightness variations present 
show up clearly. 
 
Figure 236 shows the differences between the results obtained with the two flat fields.  The upper 
left image is the raw image.  The upper right image had the sky flat applied to it.  Note that the 
right side of the upper right image is darker, which indicates that the bright right edge of the sky 
flat was probably the result of some off-axis illumination.  To get a good sky flat, the off-axis 
source would have to be identified and removed.  If it was a streetlight, for example, putting a 
stepladder with a tarp over it between the telescope and the streetlight should solve the 
problem.  
 
The lower left image shows the results of using the T-shirt flat.  The background is almost 
completely even, so the T-shirt flat does a better job, and was the more accurate flat field of the 
two.  The “optimized” version of the T-shirt flat at lower right has had the background and range 
adjusted for best results.  The T-shirt flat in this case is the better flat because it does a better 
job.  But with appropriate adjustments during exposure, a sky flat or any other type of flat could 
do just as well. 
 

 

Figure 236: A comparison of results from applying two different flat fields. 
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Ultimately, it’s a good idea to take lots and lots of flats using different methods and different 
equipment attached to your telescope.  There is no substitute for having a deep knowledge of 
how light passes through your telescope.  For example, the telescope used for this example does 
not have one edge brighter than the other; any such variation is due to off-axis light.  Typically, 
off-axis sources are well off-axis, and it’s easy to miss them, yet they can have a noticeable effect 
on your results.  The more flat fields you take under different conditions using different 
techniques, the sooner you will develop the skills you need to take and apply flat-fields to your 
images effectively. 
 
You can apply a single flat-field frame to an image, or you can apply multiple flat-field frames as 
part of a group.  Unlike a dark frame, which is simply subtracted from a light frame, the flat-field 
frame is applied to the light frame in a more complex manner.  A dark frame represents simple 
offsets from the accurate value, and is therefore simply subtracted from the light frame.  For 
example, if a light frame pixel has a value of 800, and that same pixel in the dark frame has a 
value of 500, then the corrected value of the pixel after dark frame subtraction is 300. 
 
For a flat field, the pixel values in the light image are adjusted using a more complex formula 
based on the average brightness level and the corresponding pixel in the flat-field frame.  There 
isn’t a simple relationship between the pixels in the light frame and the pixels in the flat-field 
frame; the entire image is used to effectively apply the flat field. 

Using Calibration Groups 

A single bias, dark, or flat-field frame helps considerably in improving your images.  But the 
improvements come at a cost.  Everything you do to the original image adds noise even as it 
removes various system effects.  The ideal situation would be to take bias, dark, and flat-field 
frames that have as little noise as possible. 
 
You can accomplish this by taking multiple bias, dark, and flat-field images. TheSkyX Camera Add 
On can combine these images in ways that reduce overall noise. It can even apply the combined 
images automatically when you are taking images with the camera (see the next section). 

Creating Calibration Groups 

 
Before you can create a group, you must take the bias, dark, and flat-field frames you plan to 
include in the group.  To build the group, click choose the Image Calibration Library command 
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from the Input menu (note that this command visible only when the Camera Add On’s trial period 
is in effect, or when it has been activated).  Figure 239 shows the Image Calibration Library 
window.  By default, there are two groups: Imager and Autoguider.  You can add bias, dark, flat-
field, and darks for flat-field frames to these groups, or create your own groups. 
 

 

Figure 237: The Image Calibration Library window. 

To create a new group, click Add Group.  This displays the Add Group window (see figure 25).  
Type in the new group name, and click OK to add the group to the list. The new group will 
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automatically contain sub folders for bias frames, dark frames, dark frames for flats only, and flat 
frames. 
 

 

Figure 238: Adding a new group. 

To add individual images to your group, click on the sub-group name (Bias Frames, Dark Frames, 
Flat Frames) to highlight it, and click Add Frames.  This opens the appropriate Select Frames 
window.  Navigate to the folder that contains the desired files, and click to highlight them.  You 
can add more than one frame at a time; use Shift+Click and/or Control+Click 
(Command+Click on the Mac) to select multiple photos.  Click Open to add the files.  Figure 

239 shows multiple files added to all four sub-groups.  You can resize the Image Reduction 
window to see long filenames, or you can hold the mouse cursor over a specific file to view the 
entire name. 
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Figure 239: Files added to the bias, dark, sub-groups. 

When you apply a reduction group to an image or a folder of images, the Camera Add On will 
create master frames by combining the images.  A master frame is the result of combining all of 
the frames of a given type.  There is a master frame for the bias frames, a master frame for the 
dark frames, etc.  The master frames are created automatically the first time you use a reduction 
group.  The master frames are also updated automatically the first time you use a reduction group 
after adding, deleting, or otherwise changing the frames in a reduction group. 
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You can create a copy of the master frame for any one sub-group at any time by clicking Preview 
Combined Frames (Master Frame) near the bottom of the Image Reduction window.  A copy of 
the master frame appears in a window, and you can examine it to make sure it meets your 
requirements. 
 
The Remove button acts differently depending on what you highlight in the Image Reduction 
window: 
 

• If a single frame is highlighted, the frame is removed from the group. 

• If a sub-group is highlighted, the frames in the sub-group are removed.  The sub-group itself 
remains. 

• If a group name is highlighted, the frames in all sub-groups of the group are removed. If the 
group is a default group (Imager and Autoguider are the default groups), the empty group 
remains. If the group is one you created, the group is also removed. 

 
If you double-click on a file in a sub-group, the file opens in a new window. 

Setting Calibration Group Properties 

You can specify how TheSkyX Camera Add On should combine frames in a sub-group. For 
example, if your sub-group contains 4 dark frames, you can choose how to combine them: 
average or median. 
 
Average – The brightness of each pixel in the combined image is the average of the values in the 
same pixel in all of the images in the group.  Summing the pixel values, and dividing by the number 
of images in the sub-group calculate the average. 
 
Median – The brightness of each pixel in the combined image is the median of the values in the 
same pixel in all of the images in the group. The median is the value in the middle of the 
distribution of brightness levels.  There are equally many values larger than the medium as there 
are smaller. 
 
In addition, the Photo Calibration Library window contains options for how dark frames are 
applied to your light images and flat frames: 
 

Option Values/Description 

Dark 
Exposure 
Correction 

None – No exposure correction occurs.  The dark frame is simply subtracted from 
the light frame.  It’s up to you to make sure that the exposure times for light and 
dark frames are the same. 
Automatic – TheSkyX Camera Add On reads the file header to obtain exposure 
and temperature information, and uses this information to scale the dark frame 
before applying it to the light frame.  Only file types that contain header 
information, such as FITS and SBIG files, work with this option. 
Manual – The dark frame is scaled using numeric values that you supply, using 
either duration or a multiplier. 
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To set the options for Bias, Dark, and Flat Frames, click to highlight the group or any file in the 
group; the options appear in the area below the list of files in the group (Figure 239).  Note that, 
when an individual filename is highlighted, the attributes for the file appear in the Frame 
Attributes area at lower right.  The attributes can help you identify which file is which, and can 
help you determine whether you have the correct files included in the group.  The Frame 
Attributes are especially helpful long after you take images or create reduction groups. 
 
Note: the dark frames you add to a group should all have approximately the same exposure 
duration. If you try to combine dark frames with very different exposure durations, you will add 
a lot of noise to your images. For the cleanest, lowest-noise reduction, use dark frames with 
identical exposures. 

Calibrating a Single Photo 

To calibrate a single photo, open the image in the Camera Add On and then open the Image 
Reduction window (Input > Photo Calibration Library).  Click the Calibrate button to open the 
Calibrate Photos Now window (Figure 240).  If this is the first time you have used the group for 
reduction, there will be a delay while the Camera Add On builds the master bias, dark, dark for 
flat, and flat-field frames. 
 

 

Figure 240: Calibrating photos using the Calibrate Photos Now window. 

As with a single flat field, you can evaluate the correction of an image reduction group by 
examining the background brightness values.  Pass the mouse cursor over the image, and look 
for consistent brightness levels in the background.  Gradients due to sky glow, moonlight, or light 
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pollution make it harder to evaluate the quality of a reduction.  Use an image that has a known 
flat background to evaluate the quality of your reduction, such as an image from a dark site taken 
near the zenith. 

Calibrating a Folder of Images 

You can also use the Image Reduction window to reduce all of the images in a folder.  This is 
convenient for many imaging situations – color images with many images taken at the same time 
and temperature, for example, or an evening’s worth of images when hunting for supernovas, 
comets, or minor planets.  Click the Calibrate Folder button to open the window shown in Figure 
241. 
 

• Click the Choose Folder button under Folder of Photos to Calibrate to locate the folder 
with the photos you want to calibrate. 

• Click the Choose Folder button under Folder to Save Calibrated Photos to specify the 
folder where the calibrated photos are to be saved. 

• Choose the Calibration Group from the pop-up menu at the bottom of the window. 

• Click Calibrate to start the reduction process. 
  

 

Figure 241: Reducing all of the images in a folder. 

Calibration Group Strategies 

A calibration group is simply a collection of bias, dark, flat-field, and dark-for-flat-field frames. 
You can use dark frames taken at any exposure or temperature, so it is up to you to make sure 
that the right files go into each group you create. It is typical to create a number of groups for a 
given night’s images, with each group being used for one or more of your light photos. 
 
For example, suppose you took the following photos in one night: 
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• Ten one-minute photos of M51. 

• Ten two-minute photos of the Owl Nebula. 

• Four 10-minute photos of M101. 
 
You could create two or three calibration groups. If you created two groups, you would use 90-
second darks in one group, and 10-minute darks in the second group.  You could calibrate both 
your M51 and Owl Nebula photos with the first group, and your M101 photos with the second 
group.  The Camera Add On would scale the dark frames in the first group for the differences in 
exposure times.  The 90-second exposure for dark frames is halfway between the exposure times 
of the M51 and Owl Nebula images. 
 
Note: Bias frames are optional.  However, if you scale dark frames, you should include bias frames 
in your calibration groups.  The bias frames allow the Camera Add On to scale the dark frame 
more accurately. 
 
Flat fields typically require exposures that are different from light frame exposures.  As a result, 
you will often use a separate dark frame for your flat fields.  There is a special heading in the 
Calibration window where you can add dark frames that are for flat fields only. If you do not add 
any dark frames for the flat-field frames, no dark is subtracted from the flat fields. 
 
Color imaging often involves taking images that have different exposure times. You should 
normally use several reduction groups for a single set of color images. The ST-7E camera with a 
CFW-8 color filter wheel, for example, generally works best with exposures having a ratio of 
1:1:1.6.  If you intended to image the galaxy M101 in color, you might plan to take the following 
images: 
 

• 5 luminance images with an exposure of 5 minutes each, binned 1x1. 

• 3 red and 3 green images with exposures of 10 minutes each, binned 1x1. 

• 3 blue images with exposures of 16 minutes each, also binned 1x1. 

• 4 flat-field images at 40% of saturation, with exposures of 10 seconds each. 
 
You could create one, two, or three reduction groups for these images.  The difference between 
the groups would be the exposure time for the dark frames: 

Method #1 

Create one group, with an average dark frame exposure time suitable for all light images. Use dark 
frames with an exposure time between the shortest and longest exposures: 10 minutes, for 
example.  Your darks would not perfectly match all of the light images, and there would be some 
additional noise in the final image as a result. A good reduction group using this approach could 
include: 

 

• 3 dark frames at 10 minutes each. 

• 3 bias frames. 

• 3 dark frames at 10 seconds each for the flat-field frames. 

• 4 flat-field frames at 10 seconds each. 
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Method #2 

Create two groups, with each having an average dark frame exposure time suitable for some of the 
light images. Use darks of 5 minutes in one group (for the luminance images), and 13 minutes in 
a second group (for the red, green, and blue images). The two groups could look like this: 

 
Group one: 

• 3 dark frames at 5 minutes each. 

• 3 bias frames. 

• 3 dark frames at 10 seconds each for the flat-field frames. 

• 4 flat-field frames at 10 seconds each. 
 
Group two: 

• 3 dark frames at 13 minutes each. 

• 3 bias frames. 

• 3 dark frames at 10 seconds each for the flat-field frames. 

• 4 flat-field frames at 10 seconds each. 

Method #3  

Create three groups, with each having a dark frame exposure matched to specific light images. 
 
Which method should you choose?  It depends on your needs.  If you want to get the greatest 
possible benefit from your dark frames, then use method #3 with three groups.  If you are 
working at very cold temperatures (for example, -33ºC), you might feel that the noise levels are 
low enough to use Method #1 with a single group of darks.  The Camera Add On scales the darks 
to match the actual exposures, but this scaling introduces some inaccuracies into the process. If 
you are imaging at a warmer temperature (for example, -22ºC), then you might choose Method 
#2. 

Automatic Reduction 

There is a third way to do image reduction: automatically when you acquire an image.  The Take 
Photo tab in the Camera tab (see figure 31) provides a Reduction pop-up menu in the options 
for: 
 

• No automatic reduction (choose None). 

• Take a single dark frame (choose AutoDark) and apply it to each image. 

• Apply a reduction group to images as they are downloaded (choose Bias, Dark, Flat). 
 
If you select Full Calibration, the Group option appears.  Pick a reduction group from the list of 
available groups. 
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Figure 242: Setting up automatic image reduction. 

We recommend turning the Automatically Save Photos checkbox on if you are automatically 
applying a reduction group to your images as they are downloaded.  If Automatically Save Photos 
is turned on, two versions of the file are saved: the raw image, and the reduced image.  If an error 
occurs during reduction, the raw data is still saved to disk.  
 
For example, if you were imaging the Antennae galaxies, then the two filenames could be: 
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00000045.Antennae.FIT 
00000045.Antennae.REDUCED.FIT 
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Focuser Control 

 

 
 
The Camera Add On can be used to manually adjust the camera’s focus using pulse focusers or 
other motorized focusers.  The @Focus (pronounced “at focus”) algorithm provides a means to 
automatically move an optimal focus using star brightness or half-flux diameter.   
 
Automated focus adjustments can further be made based on the current optical filter, or by 
monitoring the ambient temperature using external temperature sensor. 
 
The Camera Add On can natively control the focusers listed in the table below. 
 

Focuser Manufacturer/Model 
     

Astro-Physics/CP3 and CP4 built-in 
pulse focuser controller interface (a 
pulse focuser, sold separately, is 
also required) 
 

    

Finger Lakes Instruments/All models 
     
Gemini Astronomical Positioning 
System/Built-in pulse focuser 
controller interface (a pulse focuser, 
sold separately, is also required)  
 

    

Meade Instruments/Autostar or 
LX200 built-in pulse focuser 
controller interface (a pulse focuser, 
sold separately, is also required) 
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Focuser Manufacturer/Model 
     

Moonlite Telescope 
Accessories/Moonlite NiteCrawler 
Focus Controller 
 

    

Officina Stellare ATC-02 (OTA-based 
secondary mirror control to adjust 
the position of back focus, not 
specifically designed to adjust the 
optical focus position) 
 

  
- - 

Officina Stellare RotoFocus Focuser 
    

Optec/FocusLynx Focuser 
     
Optec/TCF-S3 and TCF-S 
Temperature Compensated 
Focusers 
 

  
- - 

Rigel Systems/nSTEP 
     
Starizona/MicroTouch AutoFocuser 
   

- - 

QSI/All models 
  

- - 

Software Bisque/Paramount, MKS 
3000, MKS 4000 and MKS 5000 
built-in pulse focuser controller 
interface (a pulse focuser, sold 
separately, is also required) 
 

    

Software Bisque/Focuser Simulator 
     
Starlight Instruments FeatherTouch 
Focuser     

Starlight Xpress/All models 
   

- - 

 
The Camera Add On can also control any ASCOM-compliant focuser on Windows. 
 
Serial port-based focusers, just like serial port-based telescopes, require a USB to serial adaptor 
to connect the focuser’s serial port to the computer’s USB port.  See “USB to Serial Adaptors” on 
page 358 for details about this additional hardware device. 
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Focuser Setup 

Use the Imaging System Setup window to choose, setup, and connect to the focuser.  The Focuser 
Setup pop-up menu provides commands to do so. 

Focuser Setup Pop-up Menu 

The Focuser Setup pop-up menu on the Imaging System Setup window includes the following 
commands. 
 

• Choose: Shows the Choose Focuser window to select your model focuser. 

• Settings: Displays a focuser-specific settings window for the selected focuser.   

• Connect: Use this command to establish communications with, or connect to the 
selected.  Make sure to configure the focuser port settings by choosing the Settings 
command first. 

• Disconnect: Terminate communication with the focuser. 
 
To configure TheSkyX to control a focuser: 
 
1. Choose the Telescope Setup command from the Telescope window to display the Imaging 

System Setup window. 
2. Highlight Focuser in the Hardware list. 
3. From the Focuser Setup pop-up menu, select the Choose command. 
4. On the Choose Focuser window, select the desired focuser from the Focuser list and click OK. 
5. For serial port-based focusers, choose the Settings command from the Focuser Setup pop-up 

menu to configure the focuser’s settings. 
 

 

Figure 243: The Focuser Settings window (Mac) 
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Figure 244: Focuser Settings window (Windows) 

Serial Device/Serial Port 

Select the serial device name (Mac) or COM port (Windows) for the focuser. 

TCF-S More Settings 

Click the More Settings button on the Serial Port Settings window to configure focuser step size, 
backlash compensation and temperature compensation, when applicable 
 

 

Figure 245: The Optec TCF-S Settings window. 

Step Size (Large and Small) 

The Large and Small focuser steps are applied when focusing a camera with @Focus and 
@Focus2 automated focusing algorithm (page 572).  The step size number represents the relative 
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motion of the focuser; the larger the number the more focuser motion.  The large step is used to 
get close to focus, the small step size is used to get “optimal” focus. 

Backlash 

Enter a number for the relative amount of backlash compensation (gear slop) in the focuser.  
Consult the focuser hardware documentation for more information on this setting. 

Automatic Temperature Compensation 

Choose the Automatic Temperature Compensation setting for the Optec focuser.  Consult the 
focuser hardware documentation for more information on this setting. 

Starizona MicroTouch Focuser Installation 

The MicroTouch™ Autofocuser unit can be used to adjust the focus on FeatherTouch™ focusers 
from Starlight Instruments.  The Camera Add On can control this device through its USB interface. 

Minimum Requirements  

• TheSkyX Professional Edition for Mac or Windows, version 10.5.0 and later and the 
Camera Add On.  

• MicroTouch firmware version 4.4 or later. 

• MicroTouch Windows USB driver (Windows only). 

• SiliconLabs VCP driver (Mac only). 

MicroTouch Driver Installation 

1. Verify that the firmware version 4.4 or later is installed on the MicroTouch focuser hand 
controller box.  See Upgrading Firmware in the MicroTouch AutoFocuser Operating 
Instructions for details.  This document can be downloaded from the MicroTouch product 
web page. 

2. Install the MicroTouch USB driver.   
 

 The Mac driver can be downloaded from the Silicon Labs web site under 
Download for Mac OS X:  
https://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx 
 

 The Windows driver can be installed from the MicroTouch web page:  
http://starizona.com/acb/MicroTouch-Autofocuser-Wired-Version-
P2715C745.aspx 

 
There are several downloads available on this page.  The download link you’re 
after is labeled: “Download same drivers (updated for Windows 10) and install 
files above, without ASCOM and FocusMax (for users who already have those 
programs installed). 18MB ZIP file.” 

 
Follow the installer’s instructions to complete the installation of this driver. 
 

http://starizona.com/acb/MicroTouch-Autofocuser-Wired-Version-P2715C745.aspx
http://starizona.com/acb/MicroTouch-Autofocuser-Wired-Version-P2715C745.aspx
https://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx
http://starizona.com/acb/MicroTouch-Autofocuser-Wired-Version-P2715C745.aspx
http://starizona.com/acb/MicroTouch-Autofocuser-Wired-Version-P2715C745.aspx
http://starizona.com/acb/downloads/MicroTouch_Install_Win10_NoASCOM.zip
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3. From TheSkyX Professional Edition, verify that version 10.3.0 (Build 8649), or later, is 
installed.  If not, choose the Check for Updates command from TheSkyX’s Help menu to 
download the latest version from Software Bisque web site.  Once downloaded, run the 
installer, and launch TheSkyX Professional Edition.  Next, choose the About TheSkyX 
command from TheSkyX menu on the Mac or the Help menu on Windows to verify the 
correct version has been installed. 

4. Connect the MicroTouch to the computer and turn it on. 
5. From TheSkyX Professional Edition, choose the Telescope Setup command from the 

Telescope menu. 
6. Double-click Focuser under Imaging System on the left side of the Imaging System Setup 

window and choose Starizona MicroTouch Focuser and click Close. 
7. Choose the Settings command from the Focuser Setup pop-up menu, and choose the 

name of the port the focuser is connected to. 
 
See “Controlling the Focuser” on page 567 for details how to adjust focus. 

Moonlite Focuser and Mac OS X 

On Mac OS X, if you encounter Moonlite focuser connection errors, or slow/sluggish 
communication between TheSkyX Pro and the Moonlite focuser, install the latest Future 
Technology Devices International (FTDI) USB driver: http://www.ftdichip.com/FTDrivers.htm. 

Focuser Options 

Once the focuser is selected, the right side of the Imaging System Setup window displays focuser 
options. 

Timeout 

Enter the number of seconds to wait for a response from the focuser before displaying a 
communication failure error.  Consider increasing the number of seconds to wait if repeated 
“error due to poor communications” errors occur when connected to a focuser. 

Temperature Source 

To perform temperature-compensated focus adjustments, the focuser hardware can get the 
ambient temperature from a variety of sources.   
 

• Focuser (Default) Use the focuser’s built-in temperature sensor. 

• Partnered Focuser Choose this option if an imaging system with two focusers uses the 
temperature reading from the second focuser. 

• Paramount Mount Read the ambient temperature from the Paramount’s built-in 
temperature sensor. 

• OTA Read the temperature from the optical tube assembly’s weather/temperature 
sensors. 

• Weather Station Get temperature from a weather station (optional Weather Add On 
required; this Add On is not available to the general public at this time). 

http://www.ftdichip.com/FTDrivers.htm
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Controlling the Focuser 

Figure 246 shows the Focuser controls on the Telescope window that can be used to adjust the 
focuser’s position. 
 

 

Figure 246: Focuser controls on the Telescope window. 

Move In/Move Out Buttons 

Click these buttons to adjust the position of the focuser. 

Amount  

Select the relative amount of focuser travel that will be applied to each Move In/Move Out 
button click.   

Pulse Focuser Adjustments 

• Slow: Adjusts the position of the focuser using a slow motor speed for adjusting final 
focus. 

• Fast: Adjusts the position of the focuser using a fast motor speed for making significant 
changes to focus. 

Optec Focuser Adjustments 

• 100: Adjusts the position of the focuser using the Small step size (page 564). 

• 1000: Adjusts the position of the focuser using the Large step size (page 564). 

Status 

Shows the status of the focuser connection. 

• Not Connected: The focuser is currently not connected to TheSkyX. 

• Connected: The focuser is connected to TheSkyX. 
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Focusing Principles 

The human eye is a marvelous instrument.  Not only can it follow rapidly moving objects, but it 
can also adjust focus in real time, compensating for minor focus drift or out of focus conditions.  
The eye is a very forgiving focuser, in other words. 
 
The CCD camera, on the other hand, is a very unforgiving measurer of focus.  Cameras require 
very precise focus to get sharp, detailed images.  Precise focus is also important for research 
(astrometry and photometry). 
 
The Camera Add On has features that will allow you to achieve the best possible focus.  But there 
are also mechanical considerations about focus that play a role in how effectively you can achieve 
that “sweet spot” called critical focus. 
 
“Critical focus” is a range of focal positions, not just a single point along the focuser's range of 
travel.  Even at critical focus position, stars are not usually imaged as single points of light; 
atmospheric turbulence and other factors spread out the star's image on the CCD detector.  
Critical focus is the range of focus positions that provides the best possible focus and is 
dependent upon the focal ratio of your telescope. 
 
The focal ratio alone determines the size of your critical focus zone.  The zone of critical focus 
becomes shorter with lower, “faster” focal ratios.  For the purposes of focusing, a fast focal ratio 
is f/6 or lower; a slow focal ratio is greater than f/6.  The focal ratio is the ratio of the telescope 
focal length to the aperture.  For example, a telescope with an aperture of 100mm and a focal 
length of 500mm has a focal ratio of f/5.  Lower-numbered focal ratios are said to be “fast” 
because they require shorter exposure times. 
 
Figure 248 shows light cones for fast (f/5) and slow (f/10) telescopes.  The front of a hypothetical 
telescope is at left.  Light enters from the left, and is brought to a focus where the converging 
lines cross. 
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Figure 247: The focal ratio of your telescope determines the length of the critical focus zone. 

The f/5 light cone is very steep; as you move away from the front of the telescope, the light 
converges to focus very quickly.  The f/10 light cone is shallow, and does not converge as rapidly 
as you move away from the front of the telescope.  For all telescopes, the light diverges again 
past the focal point.  The telescope’s focuser, manual or motorized, moves the CCD camera back 
and forth.  The CCD detector inside the camera must sit within the critical focus zone to get a 
sharp image.  To bring the CCD camera to focus, the focuser moves the camera so that the CCD 
detector is within the critical focus zone, as shown in Figure 248. 
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Figure 248: Moving the camera into the critical focus zone. 

 
This means that telescopes with fast focal ratios have a shorter critical focus zone, and thus they 
are more challenging to focus manually.  You can improve your ability to focus a fast telescope 
by adding a motorized focuser.  The Camera Add On includes a focusing utility, @Focus2 
(pronounced “at focus two”, which can make extremely small focuser movements limited only 
by the minimum step size of a motorized focuser.  Fast telescopes are also more susceptible to 
anything that will cause focus drift, such as falling or rising temperatures.  A motorized focuser 
can also help you adjust focus throughout a long imaging session.  
 
The slower your focal ratio, the longer the critical focus zone and the easier it will be to find focus. 
 
When the seeing is very good (that is, the atmosphere is stable), star images hold steady and are 
very small and sharp.  As the seeing deteriorates, star images begin to bloat and lose their hard 
edge.  This makes measuring focus more difficult, and @Focus2, may not converge on the best 
focus position under poor seeing conditions.  Manual focusing is also harder to achieve under 
poor seeing conditions (turbulent atmosphere). 
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If the zone of critical focus is very short, you may find it difficult to achieve critical 
focus reliably or easily using a manual focuser.  You can purchase various types of 
motorized focusers that can help with this problem, including some that have digital 
readout of focus position.   
 
A motorized focuser can provide smaller adjustments in many cases than you can 
do by hand, and is thus better at making the small adjustments that position the 
CCD detector inside the critical focus zone.  To get useful results from a motorized 
focuser, it should enable you to make movements that are at least one-half the size 
of your zone of critical focus on nights of optimal seeing conditions.  For optimal 
focusing, look for a focuser that will move in increments that are one-quarter or less 
the size of your critical focus zone. 

 
The equation below computes the size of the critical focus zone (CFZ) in microns for a “perfect” 
optical system that is perfectly collimated: 

2.2*_ 2ratiofocalCFZ =  

So, for a C-14 that is f/11: 

2662.2*112 ==CFZ  

266 microns is 0.266 millimeters or 0.01 inches.  Here’s an example with an f/5 focal reducer on 
the C-14, making it effectively an f/5.5 system: 

5.662.2*5.5 2 ==CFZ  

66.5 microns is 0.0665 millimeters or 0.0026 inches.  Note that the critical focus zone is now one 
quarter that of the longer f-ratio system.  This means that if you reduce the focal ratio by half, 
you reduce the close focus zone to one quarter.  Note: real world values are approximately 10%-
30% greater than the theoretical values above. 
 
TheSkyX includes two methods of focusing: automatic using @Focus2, and manual focusing.  To 
use @Focus2, you must have a computer-controlled focuser (for example, RoboFocus, Optec 
TCF-S, RCOS Focuser or JMI Smart Focus), or a motorized focuser controlled by your mount (for 
example, JMI NGF-S, Meade Zero Image Shift Focuser or MotoFocus connected to a Paramount, 
LX200, or Astro-Physics GTO, etc.).  
 
To access @Focus2, click the Focus Tools tab on the Camera tab. Figure 249 shows the layout of 
the Focus Tools tab.   
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Figure 249: The Focus Tools pane of the Camera window. 

Using @Focus2 

@Focus2 is the version 2.0 of Software Bisque’s automated focusing algorithm.  First use manual 
focusing methods to get close to focus and then @Focus2 does the hard part by optimizing the 
position of CCD detector in the critical focus zone.  @Focus2 requires an automated focuser that 
can be controlled by the Camera Add On.  The list of supported focusers is available by clicking 
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Telescope > Telescope Setup, highlight Focuser in the Hardware list, then click the Choose 
command from the Focuser Setup pop-up menu. 
 
@Focus2 is designed to be an end-to-end, fully automatic focus routine.  It will: 
 

1. Slew to an appropriate focus star. 
2. Automatically place a sub-frame around the focus star. 
3. Compute an appropriate exposure time 
4. Find critical focus.   

 
@Focus2 is flexible enough to use even if you have manually sub-framed a candidate focus star, 
you can simply configure @focus to skip steps 1, 2, and 3 and “jump” to finding critical focus. 
 
@Focus2 is a single star focus algorithm that requires focus data on either side of critical focus in 
order to work.  It requires being “close to” focus initially.  @Focus2 starts by moving the focuser 
in one half of the Focus Range setting and proceeds to move the focuser out by Focus 
Range/(Samples-1) while measuring focus.  Provided the Range is an appropriate value, 
@Focus2 will have crossed critical focus and will have the necessary data to compute and move 
to an accurate, critical focus. 
 
The basic steps involved in using @Focus2 are: 
 
Step 1: Manually get near focus. 
Step 2: Click @Focus2 on the Focus Tools tab of the Camera tab.  Set the @Focus2 

parameters to match your equipment’s capabilities. 
Step 3: Run @Focus2, and verify that it finds the best focus position. 

 
@Focus2 automates the focusing process and needs an accurate focuser and appropriate 
settings to be successful.  At a minimum, @Focus2 requires a starting point near focus and a 
Range value that is appropriate for your system.  
 

Condition Description 

Mechanical 
quality of the 
focuser 

Best case: The focuser should have virtually no backlash, and can be 
positioned with an accuracy of one half or less the size of the critical focus 
zone.  (Backlash is free play in the focuser mechanism.) 
 
Potential issues: Poor mechanical quality in the focuser results in an 
inability to position the point of focus accurately.  Typical mechanical 
quality issues include: 

• Backlash (looseness) in the focuser, which results in varying 
movement when reversing direction. 

• Varying voltage levels in the mount or the focuser; this results in 
variable movement of the focuser. 
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Condition Description 

• Non-orthogonality (focuser does not hold camera square to the 
optical path), which results in image distortions that make it harder 
to define the best focus position. 

 

Position 
feedback from 
the focuser 

Best case: If the focuser reports its actual physical position to TheSkyX, this 
allows TheSkyX to position the focuser with a very high degree of accuracy.  
The TCF-S focuser, for example, matches numeric values to specific focuser 
positions.  Zero always means that the focuser is fully in; 3,500 is exactly 
halfway; and 7,000 always means the focuser is fully out. 
 
Potential issues: Focusers that do not report their position do not allow 
TheSkyX to reliably position the focuser.  These include the NGF-S, 
RoboFocus, etc.  Some focusers, such as the NGF-S with DRO and 
RoboFocus, report a number but the number does not necessarily 
correspond to a physical focus position.  For example, if the focuser reaches 
its end of travel, and the motor continues to turn, the numbers continue 
to change but focus position does not.  See the section on “Focuser Types” 
below for additional information. 
 
There can also be delays within the device that communicates with the 
focuser.  Some mounts, such as the LX200, introduce variable delays while 
processing focus commands.  Because the length of the delay cannot be 
predicted, the effects on @Focus2 are variable and do not allow @Focus2 
to reliably position the focuser. 
 

No movement in 
the optical 
system 

Best case: Nothing in the telescope/camera system moves, other than the 
motorized focuser controlled by TheSkyX. 
 
Potential issues: If you have a moving primary mirror, a movement of the 
mirror (even a very small one) will not only change focus, but will change 
the field of view as well.  A mount that tracks poorly, or that is not well 
aligned to the celestial pole, can also change the field of view.  Both effects 
confound the data collected by @Focus2, and that may make it impossible 
for @Focus2 to get into the critical focus zone.  Locking down the mirror in 
an SCT, and adding something like an NGF-S Crayford-style focuser, usually 
helps.  Focusers that focus by moving the primary may or may not have 
sufficient accuracy to work well with @Focus2.  If any part of the focuser 
has backlash, it becomes very difficult for @Focus2 to move the focuser 
reliably.  Experiment with different backlash settings in the Setup window 
for your focuser to see which works best. 
 

@Focus2 
parameter 
settings 

Best case: @Focus2 must be tuned to the focal length of your telescope, 
the focal ratio, the speed of your focuser, and other factors to perform 
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Condition Description 

effectively.  These factors are described in detail in the section “Set 
@Focus2 Parameters” later in this chapter. 
 
Potential issues: If the Focus Range is too small, @Focus2 will not see much 
difference from one focus position to the next, and may not judge focus.  If 
the Range is too large, @Focus2 may miss focus entirely by passing over it 
without generating enough data to know where best focus is.  See the “Set 
@Focus2 Parameters” section for additional information. 
 

Very good to 
excellent seeing 

Best case: Steady seeing with minimal changes in apparent focus quality 
allows @Focus2 to converge upon focus quickly and easily. 
 
Potential issues: If the seeing is poor, the noise level in the focusing data 
makes it difficult to measure focus.  A high noise level tends to make it 
more difficult for @Focus2 to determine focus.  The averaging parameter 
allows @Focus2 to accommodate nights with poor seeing by averaging 
images and effectively averaging the noise.  @Focus2 will take longer to 
find focus when averaging is high.  @Focus2 will often work under 
surprisingly poor seeing, but we recommend that you monitor focus quality 
when the seeing is average or worse. 
 

Dark skies Best case: Dark skies without serious light pollution, moon glow, or sky 
glow. 
 
Potential issues: Any kind of sky illumination can decrease the signal to 
noise ratio in your images.  The ultimate impact of a bright sky depends on 
whether you are using a light pollution filter, how bright the objects in the 
image are, and other factors.  A bright sky by itself is usually not enough to 
confound focusing, but it can team up with other issues and make those 
problems harder to deal with. 

Focuser Types 

@Focus2 must be able to communicate with a motorized focuser.  There are two types of 
motorized focusers available: 
 

• Focusers that have positional feedback.  The Optec TCF-S is an example of this type of 
focuser.  These focusers can be positioned with repeatable accuracy.  They are the best 
type of focuser for critical focusing because when @Focus2 says, “go to a specific position 
for best focus,” the focuser goes to exactly that position. 

• Focusers that do not have positional feedback.  Typically, the focuser is pulsed for a brief 
period by the mount.  These focusers can be positioned with variable success, depending 
on how accurate the mount’s pulse length is; how long it takes the mount to send the 
pulse (latency); how much backlash the focuser has, and other electrical and mechanical 
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factors.  When @Focus2 says, “go to a specific position for best focus,” the focuser may 
or may not be able to go to that position. 

 
@Focus2 is extremely reliable with focusers that provide positional feedback.  Other types of 
focusers, and various combinations of focusers and mounts, provide varying degrees of success 
with @Focus2.  The current list of compatible focusers, in roughly the order of quality of focus 
provided, includes (your results may vary): 
 

• Best: Optec TCF-S model focusers that have a serial-port. 

• Very Good: JMI SmartFocus, RCOS Focuser, or RoboFocus attached to a Paramount 
mount. 

• Good: JMI NGF-S attached to an Astro-Physics GTO series mount.  Small delays may occur 
in making position changes; verify quality of final focus. 

• Fair: JMI NGF-S or Meade Zero Image Shift Focuser attached to a Meade LX200.  Key 
problems include delays in carrying out focus position changes, and variable voltage 
applied to the focuser motor.  Both problems result in random errors in positioning.  You 
should use the methods described later in this chapter to evaluate the quality of focus 
before imaging.  If you cannot achieve focus with a non-positional focuser, bypass the 
LX200 and use a focuser than can be controlled by your computer’s serial port. 

• Variable: RoboFocus attached to your computer’s serial port.  Since the RoboFocus 
controls the existing focuser on your telescope, the results you get with a RoboFocus 
depend heavily on the quality of your telescope’s focuser. 

 
In addition to those listed above, other focusers from third parties will become available over 
time.  Software Bisque has a standardized, cross platform device driver architecture to allow the 
Camera Add On and TheSkyX Professional Edition to control most any USB- or serial port- 
controllable focuser  
(www.bisque.com/x2).   

Keys to @Focus2 Success 

There are some things you can do to get the best possible results with @Focus2.  Keep in mind 
that not all motorized focusers are accurate enough to work with @Focus2.  @Focus2 may use 
extremely small movements to achieve critical focus, and not all focusers can make such small 
adjustments accurately. 
 
Here are some suggestions for getting the most out of @Focus2: 
 

1. Use a focuser with an absolute minimum of backlash.  The greater the backlash (free play 
or looseness), the less likely the focuser is to achieve accurate, repeatable focus.  
@Focus2 attempts to correct for backlash problems, but the less backlash, the better the 
results.  If your focuser has too much backlash or other problems, @Focus2 should get 
you close, and you can manually refine focus following the @Focus2 run. 

2. Use a focuser that provides accurate, absolute position feedback to @Focus2 (for 
example, Optec’s TCF-S).  

http://www.bisque.com/x2
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3. If your telescope uses a moving primary mirror for focus, lock down the primary mirror 
and use a motorized focuser such as the JMI NGF-S.  Motorized focusers that move the 
primary mirror are among the least likely to be successful with @Focus2. 

4. Make sure that focus can be reached within the travel of the motorized focuser controlled 
by @Focus2. 

5. Set the correct Focus Range for focuser movement (see “Step 2: Set @Focus2 
Parameters” for details on step sizes).  The range must be large enough for @Focus2 can 
detect changes in focus, and yet small enough so that @Focus2 does not completely move 
through focus in less than the number of Samples.  See the information on Range in the 
section “Set @Focus2 Parameters” below. 

6. Your mount must be well aligned to the celestial pole.  Software Bisque’s TPoint software, 
sold separately, can quantify polar alignment and is ideal for imaging.  If objects drift in 
and out of the field of view during @Focus2ing, this will affect the measure of focus and 
could lead to spurious results.  

7. There must be a single focus star in the photo.  A single star usually leads to successful 
focus,  

Step 1: Get Close to Focus 

@Focus2 is designed to handle the hardest part of focusing: getting into the critical focus zone.  
Before you use @Focus2, you need to get the focus position close to the critical focus zone.   
 
Here are some techniques you can use to get close: 
 

• Move the focuser to a known good focus position.  This technique works best with 
telescopes that allow you to physically see the position of the focuser tube, such as a 
refractor with rack and pinion focusing.  Telescopes with internal focusers, such as many 
stock Schmidt-Cassegrains (SCTs), cannot use this method. 

• Use an eyepiece that is parfocal with your CCD camera.  (A parfocal eyepiece comes to 
focus at the same position as your CCD camera.)  

• Manually adjust focus while using the Camera tab’s Focus Tools tab in continuous mode 
and maximize peak value and or minimize HFD values. 

 

 

How close should you be to perfect focus before running @Focus2?  If the focus star 
looks like a large “doughnut” focus is not yet good enough. 

 
Figure 250 shows an example of an OK starting point for an @Focus2 run.  The medium-bright 
stars are clearly small doughnuts with central holes.  Brighter stars often don’t display doughnut 
holes because the default image histogram settings. 
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Figure 250: An example of an acceptable starting point for @Focus2. 

 

Seeing conditions may have a significant impact on your ability to use faint stars for 
evaluating focus quality.  This is especially true at longer focal lengths (greater than 
about 1500mm).  The seeing may reach a point where fluctuations from turbulence 
scatter the light so much that it appears that you aren’t at good focus.  However, 
@Focus2 will still be able to find the best possible focus for the seeing conditions.  Even 
on nights with very poor seeing there is a position of optimal focus.  If the seeing is 
poor, and the best focus you can reach isn’t good enough, switch to a shorter focal 
length if possible or image when the seeing is better. 

Step 2: Set @Focus2 Parameters 

If you have followed the guidelines in the “Keys to @Focus2 Success” section, you are ready to 
configure @Focus2 for optimal focusing with your system.  
 
Parameter settings that change more frequently are included on the @Focus2 Automated Focus 
window, which opens each time you click on the @Focus2 button on the Focus Tools tab of the 
Camera window (Figure 251).  When you click OK, @Focus2 starts a focusing run.  We suggest 
you review the detailed information about the various parameters below before you try your first 
focusing run, as you may need to adjust some of these parameters to suit your system. 
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Figure 251: Setting @Focus2 parameters. 

@Focus2 settings are described in this section.  The following list includes the parameters you 
may encounter using @Focus2.  Depending on the focuser you are controlling, however, some 
parameters may not be available. 

Samples 

This is the number of photos @Focus2 uses to achieve best focus position.  The available range 
is 4 to 50.  For most applications, the default value of 4 gives good results (two samples on each 
side of focus).  @Focus2 requires at least 2 samples on each side of the critical focus zone.  For 
critical applications, you can increase the Samples number. 

Averaging 

This is the number of photos to take per focus sample.  Averaging can help when seeing is poor.  
For good to excellent seeing conditions with a high-quality focuser, a value of 1 is usually 
satisfactory.  For poor to average seeing, a value of 2 or 3 is a good compromise between speed 
and quality.  When the seeing is creating serious problems, averaging 5 or higher will smooth out 
the focus curve significantly, although it will take longer for @Focus2 to converge upon focus.  
You can also use averaging when the seeing is good to reduce the overall noise level in the 
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focusing data.  Experiment to determine the optimal setting for your system.  Generally, the 
smallest setting that regularly achieves excellent focus is the right value to use.  We recommend 
starting with the default values, then change settings one at a time to see what affect that has 
on focus quality. 

Focus Range  

This is the focus range that will be sampled when performing a focusing run, half below and half 
above whatever focus position is at the start of the run.  Setting the Focus Range requires some 
analysis of the behavior of your telescope/mount/focuser system, and is covered in detail below.  
 
The key parameter for success with @Focus2 is getting the Focus Range value correct.  
 
A rough starting point for your Range is approximately 40 times the size of your critical focus 
zone.  For example, an initial Range for an f/5 scope with the TCF-S would be (40 * 55) = 2200 
microns.  At 2.18 microns per step, that would give an initial Range of about 1000. 
 
Experience with your camera and using the Focus Graphs also helps determine the Focus Range.  
The focus V-Curve graph should end up being a V shape where the vertex of the V points to the 
critical focus position. 

Automatically Slew Telescope to the Nearest Appropriate Star 

When TheSkyX Pro is being controlled through the user-interface, or via script, and this checkbox 
is turned on, clicking the @Focus2 button, and then clicking OK on the @Focus2 Automated 
Focus window, slews the telescope to the nearest available star (that is, the star located the 
shortest angular distance from the telescope’s current position, not the star closest in terms of 
light years!) to use for focusing the telescope. 

Minimum Altitude 

Enter the lowest permissible altitude of the focus star to slew the telescope, in degrees.  Stars 
below this altitude are considered “inappropriate” and are not used. 

Automatically Place Subframe Around Focus Star 

When TheSkyX Pro is being controlled through the user-interface, or via a script, and this 
checkbox is turned on, clicking the @Focus2 button, and then clicking OK on the @Focus2 
Automated Focus window, a subframe is placed around the focus star.  When the subframe is 
present, only the region within the subframe box is download from the camera to make the focus 
process more efficient. 

Subframe Box Size 

Enter the size of the subframe, in pixels, that is placed around the focus star.   

Automatically Set the Exposure Time 

When TheSkyX Pro is being controlled through the user-interface, or via a script, and this 
checkbox is turned on, clicking the @Focus2 button, and then clicking OK on the @Focus2 
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Automated Focus window, the following two parameters are used to set the exposure time of 
the focus star photo. 

Star Signal Calibration 

@Focus2 can use any star to find focus, but stars vary in brightness.  If the calibration star is 
saturated because the exposure time is too long, the HFD of the star will not be accurate, and 
@Focus2 will fail.   
 
In general, you want to take an exposure that is long enough to get a good star signal for 
measuring the HFD, but not so long that the star’s signal saturates the camera.  Use the following 
two parameters to define the magnitude of the calibration star, and the exposure time for your 
optical system that produces a signal of approximately 20,000 counts or ADUs. 

Calibration Star’s Magnitude (Between 3.5-6.5 Inclusive) 

Enter the magnitude of the calibration star that is used to achieve focus.  The star’s magnitude 
must be from 3.6 to 6.5. 

Exposure Time that Produces Approximately 20,000 Count Signal 

Enter an exposure duration, in seconds, that produces approximately 20,000 ADUs for your 
camera and optical system. 

Focuser Training 

The Focuser window shows focuser status, with options for adjusting the focuser’s position, and 
training the focuser offsets to apply for a given light filter when acquiring photos.  
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Figure 252: Focuser Training controls. 

The currently selected focuser is displayed at the top of the Focuser window.  Click the gear icon 
to display the Choose Focuser window and select your focuser, if necessary. 

Connect 

Click this button to establish connection to the selected focuser. 

Disconnect 

Click this button to terminate connection to the selected focuser. 

Status  

The connection status for the selected focuser is displayed next to the Status text. 
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Position 

Shows the current position of the focuser.  Depending on the model focuser, this value may be 
relative to an absolute focuser position, or relative to the starting focuser position.   

Temperature 

For focusers that report ambient temperature, the focuser’s current temperature is displayed 
next to the Temperature text. 

Amount 

This pop-up menu can be used to select the relative amount of travel in the focuser’s position 
when moving it in or out, Small, Medium or Large.   

In/Out 

Click these buttons to move the focuser in or out. 

Move To  

Click this button to move to the focuser position that is entered in the text box to the right of this 
control. 

Abort 

Click this button to stop an in-progress focuser position adjustment. 

Current Filter 

The Focuser Training section of the Focuser window shows the currently selected filter wheel 
filter when one is present.  If no filter is shown, click the Move Now button on the Camera or 
Video window to rotate the filter wheel to a known position. 

Focuser Training Graph 

Shows the data points that will be used to make adjustments to the position of the focuser for 
each filter. 

Filter and Offsets Table 

This table lists each filter wheel in the Name column, and the focuser offset in the Offset column.  
Double-click on each filter name to select the background color. 

Protect Current Data Model 

Turn this checkbox on to prevent changes to the filter offsets that are currently assigned to each 
filter. 

Add Data Point 

Click this button to add a focuser offset for the current filter. 
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Use Current Values 

Click this button to create a temperature compensation curve based on the current filter offset 
values. 

Clear 

Click this button to clear the data points from the existing model, and reset the graph. 

Open 

Click this button to open a Focuser Data file that contains  

Focuser Training Details 

Motorized focusers can be “trained” so that focus adjustments can be made while imaging.  In 
the context of focuser training, there are two different types of focus: 
 

• Closed Loop Focus: Focus is adjusted, and the results are verified (either automatically by 
software, or visually).  

• Open Loop Focus: Focus is adjusted based on previously measured characteristics of the 
system.  

 
In both cases, closed loop focus generally yields better results than open loop, but open loop can 
keep maintain critical focus for a good deal longer than would normally be possible. 
 
@Focus2 provides automated closed loop focusing.  The Focuser Training Tool attempts to 
characterize your system so that open loop focusing can be used effectively. 
 
The Camera Add On attempts to compensate for two separate sources of defocus: 
 

1. Defocus due to filters that are not, or are not quite, parfocal. 
2. Defocus caused by temperature variations.  

 
To successfully characterize the open loop movements that must be performed to compensate 
for these sources of focus “error”, the Camera Add On must acquire a number of “known valid 
points” (KVPs).  These data points record: 
 

• Focuser position  

• Current temperature  

• Current filter  
 
When enough KVPs have been acquired, the Camera Add On is able to perform open loop 
focusing to compensate for different filters and varying temperatures. 
 
There are two ways to acquire KVPs: 
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• Automatically:  Successfully completing an @Focus2 run records a KVP (unless the 
Protect Current Data Model checkbox turned on in the training tool).   An unsuccessful 
@Focus2 run will not record a KVP. 

• Manually:  Clicking the Add Data Point button in the training tool adds a KVP using the 
current system parameters.  

 
The total number of KVPs needed to maintain focus is subjective.  While more KVPs produce a 
more accurate model, in practice, a small number of KVPs for each filter will generate good 
results if the KVPs are collected over a wide temperature range. 
 
Once a data model contains a good number of KVPs, click the Use Current Values button to make 
use of the collected data.  If you have already characterized your system using another software 
package, you can also manually edit the focus compensation values. 
 
The Filter and focus offsets may be entered in the Filter Names Setup window.  The temperature 
compensation slope for your system may be entered in the Temp Compensation, Adjust C text 
box.  These fields will automatically be filled out when you click the Use Current Values button 
on the focuser training tool. 
 
Once these values have been filled out, they will remain in your imaging system profile.  The 
focuser will automatically adjust itself each time a new filter is selected. 
 
Turn on the Activate checkbox under Temp. Compensation to command the Camera Add On to 
automatically adjust the focuser’s position as temperature changes.  Note that at least one valid 
KVP must be recorded before temperature compensation can be performed. 
 
The KVP data model can be refined over the course of several imaging sessions.  Data models 
may be saved and loaded at any time, although their parameters will not become active until the 
Use Current Values button is clicked. 
 
Some focusers do not return to the same physical position each time they are activated 
(examples would be a relative focuser that always comes up at position 0, or an inline focuser on 
the end of a drawtube).  Special care must be taken when loading models generated by these 
sorts of focusers.  Rather than simply loading a model generated by this sort of system, generate 
a new model with a few data points instead, then select Merge when loading the previously 
saved data set.  This will ensure that the old data set makes use of the system's current focuser 
offsets. 

Focusing Manually 

The Camera Add On can assist you in achieving manual focus.  You can get close to focus in several 
ways: 
 

• If you found the correct focus position previously, mark the focuser position so you can move 
the focuser into position at the start of your imaging sessions.  This will not work with scopes 
that have internal focusers, such as most Schmidt-Cassegrain telescopes. 
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• If you can get a very bright star in the field of view of the CCD camera, it will show a very large 
out of focus image of a star.  The star should be magnitude 2 or brighter, or the out of focus 
image will be so dim that you might not recognize it.  Center the star, and adjust focus until 
the star is close to focus. 

 
Figure 253 shows four examples of images that are out of focus.  Image A is just slightly out of 
focus.  If you have a parfocal eyepiece or can position the focuser in the same place on 
subsequent nights, this is the type of focus quality you might see.  Image B shows a star image 
very far out of focus, as it appears in a refractor.  You can adjust focus to reduce the size of the 
star image, but you will likely have to make a large change in focus position to get close to focus.  
Image C shows a similar very far out of focus star image, but taken with an SCT.  Note the shadow 
of the central obstruction.  Image D shows an out of focus star image that is underexposed.  The 
image is very grainy, and the default image settings had to be changed to show the star clearly.  
 
The histogram or the background and range settings are used to make these changes.  You will 
generally need longer exposures to show out of focus stars, even very bright ones.  You can 
reduce exposure time during focusing as the star’s image becomes smaller and brighter.  If you 
are sure you have a star in the field of view, but think it might be very far out of focus, try a much 
longer exposure to see if the star’s out of focus image comes into view. 
 

 

Figure 253: Various stages of focus.  A: slightly out of focus with a wide-field refractor; B: far out of focus with a refractor; 
C: far out of focus with an SCT; D: moderately out of focus with a refractor and underexposed.   

You may find it useful to center the out of focus star so that it will still be on the CCD detector 
when you get close to focus. 
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The idea behind manual focus is to take photos continuously while changing the focus position 
to maximize, maxim pixel value or minimize HFD. 

Step 1: Get your focusing tools ready 

You can use the Focus Tools tab to focus manually (Figure 254).  To use the Move Focus buttons, 
you must have selected a focuser from Telescope, Setup.  There are two types of focus 
adjustment outside of TheSkyX: manually changing the focus of your telescope, or controlling a 
motorized focuser with a hand paddle, such as a JMI MotoFocus. 
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Figure 254: Most of the tools you'll need for focusing are on the Focuser window (Focuser command, Display menu). 

Step 2: Verify Initial Settings 

The initial focus exposure is often taken using the largest possible binning mode on your camera.  
Binning provides a faster download time, and lets you check your focus quality quickly.  For 
example, with an ST-8E, the maximum binning is 3x3. 
 
Typical initial settings should be: Image Frame set to Light, and Image Reduction set to 
AutoDark.  The Camera Add On will automatically take dark frames with the same exposure 
length as the light frames.  This removes hot pixels from the focus images, and makes it easier to 
tell when dim stars are properly focused.  If you have a filter wheel installed, set it to the Clear 
filter for focusing. 
 
Make sure Subframe On is not checked, and also make sure.  For a quick test of your current 
focus position, start with a Bin setting of 3x3.  Set the Delay to 0.00.  Click Graphs to provide the 
most accurate assessment of focus quality. 

Step 3: Enter an Exposure Time 

Enter an exposure time in the Exposure Seconds box.  This will typically be about 5 to 30 seconds, 
depending on how bright you expect the stars to be in your field of view, the aperture and focal 
ratio of your telescope, the quantum efficiency of your camera, the current state of focus, etc.  
Experience will show you what exposure lengths will work well for focusing with your setup.  We 
suggest that you use 10 seconds as a starting point for your first attempt at focusing.  You can 
increase or decrease this value based on the results you get from your system.  If you have a non-
antiblooming CCD detector, make sure your exposure is short enough that there are no blooming 
stars.  Figure 253b shows an example of a blooming star.  A bloom occurs when pixels have filled 
up with electrical charge and spill over (bloom) into their neighbors.  Blooming only occurs in one 
axis, so a bloom is always a line extending from a star in two directions. 
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Figure 255: An example of a star that is bright enough to bloom. 

 

Step 4: Take a Photo 

Click Take Photo.  You will see various messages in the Status area at the top of the Camera 
window: 
 

• Selecting Filter (appears only if you have a color filter wheel). 

• Exposing Light (appears during exposure, with a timer showing time remaining). 

• Downloading Light (appears while the frame is being downloaded from the camera to your 
computer). 

• Exposing AutoDark (appears during the dark frame exposure, taken with the shutter closed). 

• Downloading AutoDark (appears while the dark frame is being downloaded from the camera 
to your computer. 

 
The light frame will appear first.  Do not be concerned if it has many bright pixels; these will go 
away when the dark frame is downloaded and subtracted from the light frame.  
 

  

The use of an AutoDark frame is optional for focusing.  If you are using a very bright 
star for focusing, or if you are taking very long focus exposures, you can choose not to 
use AutoDarks.  However, accurate focusing is critical to getting sharp images and 
useful photometry, and we recommend that you use AutoDark when focusing.  A new 
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AutoDark is taken only when the exposure length or image size changes, so you only 
have to wait for the first one. 

If the stars are not small, round, and numerous in the image, adjust focus in until stars appear as 
small round dots.  Aim for somewhere close to focus.  Don't try to achieve optimal focus in 3x3-
binned mode.  You need to switch to 1x1 using sub-frames, covered below in step 5. 
 

  

Make a mental note of the direction you are moving the focuser knob during step 4.  
Your goal is to approach focus from one side until it is optimum.  In the next step, 
you'll be making very small changes, and it helps to know the direction you should be 
moving in to improve focus.  Seeing conditions may interfere with clear evaluation of 
focus quality, and knowing the direction to move will help you keep track. 

Step 5: Select a Star and Put It in a Sub-Frame 

Another tool for speeding up your focusing is the sub-frame.  This is a small portion of the image 
immediately around the star you will be using for focusing.  To select a sub-frame, click and drag 
around a bright star in your 3x3 binned photos, as shown. 
 
Which star should you select?  The ideal star meets these criteria: 
 

• It is one of the brighter stars in the frame, but it is not saturated.  Move the cursor over 
the star and observe the brightness value in the status bar; make sure it's not saturated.  
That is, make sure it does not have a brightness level anywhere near the maximum value 
for your camera. 

• There are other, dimmer stars close to the focus star.  You can use these dim stars to 
assist you in accurately evaluating focus quality.  When you are imaging in the Milky Way, 
this is easy to do.  At other times, dim stars may not be available. 

 

  

In general, the better your polar alignment, the smaller your focusing sub-frame can 
be.  With a good polar alignment, the stars will move very little between exposures, 
and you can use a small sub-frame without worrying about losing the star after a few 
exposures.  The smaller your sub-frame, the faster it will download and the more 
efficiently you can focus.  If the star gets close to the edge of the sub-frame, you can 
use the N/S/W/E buttons in the Move telescope section to make adjustments if you 
are having an autoguider connected to your telescope. 
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Figure 256: Select a focusing sub-frame by clicking the Sub-frame button and dragging a sub-frame in the FITS Viewer 
window. 

Note that the Subframe checkbox in the Camera Control Panel gets turned on automatically 
when you select a sub-frame using click and drag.  You can also click Size, and enter the position 
and size of the subframe numerically, but for most focusing needs a click and drag will be your 
best bet.  For best results, you want a small sub-frame so that you don't spend a lot of time 
waiting for focus images to download.  Allow room around the star for any dim background stars 
to show up.  These dim stars can be an effective asset when focusing. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 592 

Step 6: Adjust Focus Using Continuous Focus Mode 

Click on the Take photos continuously checkbox on the Focus Tools tab.  This activates 
continuous focus mode.  The Camera Add On will take focus exposures one after another while 
you adjust focus.  If the star you are using for focusing becomes too bright as you improve focus 
(that is, it becomes saturated and/or blooms), you can abort, adjust exposure time, Abort, and 
resume in continuous focus mode. 
 
Use the 1x1 (unbinned) bin mode to get best focus.  Use the Bin pop-up menu at top center of 
the Focus Tools tab to select the 1x1 option. 
 
If you need some time between exposures to make manual (or motorized) adjustments to focus 
position, enter an appropriate delay in the Delay box at upper left.  We suggest 7-10 seconds 
when you are getting started.  As you gain experience, you can use shorter delays to speed up 
your focusing process.  No delays can work once you are familiar with the manual focus process. 
 

  

If you have an electric focuser that is controllable from TheSkyX Professional Edition 
software, but not accurate enough to work with @Focus2, you can use the Move In 
and Move Out focuser control buttons on the Telescope window. 

 
You can visually observe the sub-frame window to help you decide when you have reached 
optimal focus.  The Focus Tools tab also provides several types of feedback that will help you 
identify when you are in the critical focus zone.  These include a graph showing a history of HFD 
or brightest-pixel values, and a numeric readout below the graph.  If TheSkyX is connected to a 
focuser the Focus Graphs will also display Focus V-Curve graph of HFD vs. Focus Position (the HFD 
is at a minimum when in focus). 
 
If connected to a focuser that doesn't have digital readout, TheSkyX maps focuser Move In, Move 
Out to relative numeric focus values so that the Focus V-Curve Graph may be valid provided the 
numeric focus values somewhat relate to reality and the focuser physically moves consistently. 
 
To start fine focusing, continue focusing in the direction you established during your initial, very 
rough focusing procedure.  The star image will get smaller, and the value of the brightest pixel in 
the image will increase.  
 
The brightest pixel gets brighter because, as you get closer to optimal focus, you are 
concentrating more light energy from the star on the central pixels of the star image.  This value 
rises steadily as you improve focus, but turbulence frequently causes it to become somewhat 
erratic as you get very close to focus.  
 
The HFD value is a great tool for judging the quality of focus.  HFD tracks the quality of focus more 
accurately than brightest-pixel values.  You can always check the current brightest pixel value in 
the information lines at the top the Camera tab, under the heading Max. 
 
The trick when focusing is to know what to expect at the point of best focus.  The simplest way 
to find this out is to go past best focus and observe what happens with the appearance of the 
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image and the Focus Graphs.  As you move toward focus, the star’s image gets smaller and 
brighter, and the HFD trends downward.  Past best focus, the star image will begin to get fuzzy 
again, and the HFD will start to trend upward.  Strong atmospheric turbulence makes the graph 
values especially erratic near optimal focus, but HFD is less susceptible to this compared to 
brightest pixel value.  
 
Dim stars in your sub-frame are one of the best methods you can use to assist you in determining 
focus.  The reason for this is simple: when you are out of focus, even by a little bit, dim stars will 
be invisible or extremely fuzzy.  When you reach optimal focus, dim stars suddenly jump into 
view. 
 
Several things indicate optimal focus.  The minimum HFD and the brightest pixel value is now 
much higher than in the previous photos. 
 
Some additional methods of focus include: 
 

• Observing sharpness of diffraction spikes, such as from a Newtonian's spider or masking 
tape across the front of the telescope.  These will appear double when you are out of 
focus, and will get closer together as you approach the critical focus zone.  When they 
merge and become a single, bright diffraction spike, you know you are at the optimal 
focus position. 

• Various kinds of masks, such as a Hartmann mask, can be used to assist in determining 
best focus.  Such masks cover the aperture of your telescope, and have two or more holes 
cut in them.  The holes cause multiple star images, which merge when you reach the 
critical focus zone. 

• You can also create diffraction spikes using artificial spiders.  For example, you can make 
a cross of wooden dowels to put across the front of your telescope, or you can make a 
cross of masking tape quickly and easily across the front of your scope. 

 
Figure 257 shows two examples of spikes from a Newtonian spider: slightly out of focus on the 
left, and in focus on the right.  Masking tape will produce the same kind of diffraction pattern.  
Note the two dim stars in both images, and how they also come into sharp focus at the same 
time as the diffraction spikes. 
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Figure 257: Diffraction spikes can be used to determine the point of best focus. 

Figure 258 shows three examples of diffraction spikes created by three types of mask.  From left 
to right, they are a three-hole mask, a two-hole mask, and a two-triangular hole mask.  The 
advantage of the triangular-hole mask is that each triangle throws off diffraction spikes.  When 
all the spikes have a common center, you are focused. 
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Figure 258: Focusing masks show bright spots with the same shapes as the holes in the mask.  The holes converge as 
focus improves.  The two-triangle mask (right) is easy to use because it has diffraction spikes; round holes do not have 

diffraction spikes.   

When you have reached focus, you can proceed to capture images.  The Camera Add On offers 
several opportunities for productive imaging and guiding using the Camera tab and Autoguider 
tab. 
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Filter Wheel Control 

 

 
 
The Camera Add On can natively control the filter wheels listed in the table below. 
 

Filter Wheel Manufacturer/Model 
     

Apogee Instruments/All models - 
 

- - 

ATIK/All models 
  

- - 

FLI/All models 
    

Orion/All models - 
 

- - 

QSI (Embedded) 
    

SBIG/All models 
   

- 

Software Bisque/Filter Wheel 
Simulator     
Starlight Xpress/All models 

    
Xagyl Filter Wheels1 

    
 
1This open-source X2 Plug In must be downloaded and installed separately from RTI-Zone.org. 
 
The Camera Add On can also control any ASCOM-compliant filter wheel on Windows. 

Filter Wheel Setup 

Choose the Telescope Setup command from the Telescope menu to display the Imaging System 
Setup window.  On the Imaging System Setup window, highlight Filter Wheel in the Hardware 
list to display filter wheel specific options. 

https://rti-zone.org/macosx_x2filterwheel_plugins.php
https://rti-zone.org/macosx.php
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Figure 259: The Filter Wheel options on the Imaging System Setup window. 

Currently Selected Filter Wheel (Filter Wheel text) 

The Filter Wheel text at the top of the Imaging System Setup window shows the manufacturer 
and model of the currently selected filter wheel.   

Hardware and Driver Information 

When Filter Wheel is highlighted in the Hardware list on the Imaging System Setup window, the 
following hardware and driver-specific information is displayed. 

Filter Wheel Names Setup Pop-Up Menu 

The Filter Wheel Setup pop-up menu provides commands for choosing, setting up, connecting to 
and disconnecting from a filter wheel. 

Choose 

Click this command to display the Choose Filter Wheel window.  The Filter Wheel list shows all 
supported models. 
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Figure 260: The Choose Filter Wheel window. 

Settings 

Click this command to display filter wheel-specific port setup and driver options, when available.   
 

 

Figure 261: The Filter Wheel Settings window. 
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Connect 

Choose this command to establish a connection to the filter wheel. 

Disconnect 

Choose this command to stop communicating with the filter wheel.  

Filter Wheel Status (Status text) 

This text box displays the filter wheel status. 

Device Name 

Shows the name of the selected device.  

Device Description 

Shows a short driver-specific description of the device. 

Driver Information  

Shows additional information about the driver for this device. 

Driver Version  

Shows the version of the software driver used to control this device. 

Firmware Version 

Lists the version of the device’s firmware, when available. 

Defining Filter Names (Filter Names Setup Button) 

Click the Filter Names Setup button to show the Filter Names Setup window so that each filter 
can be assigned a custom name. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 600 

 

Figure 262: The Filter Names Setup window. 

Filter 1-<Number of Filter Wheel Positions Reported by Filter Wheel Driver> 

Enter the name of the filter in each filter position.  The number of filter wheel positions that 
appear on Filter Names Setup window changes based on the number of filter wheel positions 
that are reported by the filter wheel driver.  The Filter Wheel Simulator shown in Figure 262 has 
a simulated “125-position filter wheel.” 
 
Use the Filter Wheel window to connect to and select different filters. 
 
If your camera does not have a shutter, but you want to use a blocking (or dark) filter for taking 
auto-dark exposures, enter the name, “!Shutter!” (that is, the word Shutter immediately 
preceded and followed by an exclamation mark, with no quotes) for the filter position that 
contains the blocking filter.   
 
When a dark frame is required, and a filter wheel is connected, the filter is automatically changed 
to this position. 
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Figure 263: The Filter Wheel window (click the Filter Wheel command from the Display menu to show it). 

The top of the Filter Wheel window lists the name of the currently selected filter wheel.  Click 
the Filter Wheel Setup button to show the Image System Setup window to configure the filter 
wheel. 

Connect 

Click this button to establish a connection to the filter wheel. 

Disconnect 

Click this button to stop communicating with the filter wheel.  

Filter Wheel Status (Status text) 

This text box displays the filter wheel status. 

Filter Wheel Presently at Filter 

This status text shows the name of the current filter. 

Changing Filters 

To change the current filter, choose the desired filter name from the Filter pop-up on the Camera 
Setup window. 
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Figure 264: Change the position of the filter wheel on the Filter Wheel window. 
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Rotator Control 

 
 

 
 
The Camera Add On can natively control the rotators listed in the table below. 
  

Rotator Manufacturer/Model 
     

Moonlite NiteCrawler 
    

Officina Stellare RotoFocus/Rotator 
    

Optec/Pyxis LE 
  

- - 

Optec/Gemini 
    

Software Bisque/Rotator simulator 
    

 
The Camera Add On can also control any ASCOM-compliant rotator on Windows. 

Rotator Setup 

Choose the Telescope Setup command from the Telescope menu to display the Imaging System 
Setup window.  On the Imaging System Setup window, highlight Rotator in the Hardware list to 
display rotator-specific options. 
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Figure 265: The Rotator options on the Imaging System Setup window. 

Currently Selected Rotator (Rotator text) 

The Rotator text at the top of the Imaging System Setup window shows the manufacturer and 
model of the currently selected rotator.   

Rotator Setup Pop-Up Menu 

The Rotator Setup pop-up menu provides commands for choosing, setting up, connecting to and 
disconnecting from a rotator. 

Choose 

Click this command to display the Choose Rotator window.  The Rotator list shows all supported 
models. 
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Figure 266: The Choose Rotator window. 

Settings 

Click this command to display rotator-specific port setup and driver options, when available.   
 

 

Figure 267: The Rotator Serial Port Settings window (Windows). 
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Figure 268: The Rotator Serial Port Settings window (Mac). 

Connect 

Choose this command to establish a connection to the rotator. 

Disconnect 

Choose this command to stop communicating with the rotator.  

Rotator Status (Status text) 

This text box displays the rotator status. 

Hardware and Driver Information 

When Rotator is highlighted in the Hardware list on the Imaging System Setup window, the 
following hardware and driver-specific information is displayed. 

Device Name 

Shows the name of the selected device.  

Device Description 

Shows a short driver-specific description of the device. 

Driver Information  

Shows additional information about the driver for this device. 

Driver Version  

Shows the version of the software driver used to control this device. 

Firmware Version 

Lists the version of the device’s firmware, when available. 

Rotator Polarity  

Some rotators move clockwise as their angular position increases, some move 
counterclockwise.  Select the orientation that corresponds to your rotator's movement polarity. 
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This setting will correctly convert your rotator's reported angular position into an absolute 
position angle against the sky. 

Positive Angles Rotate Clockwise 

Choose this option if the rotator hardware reports positive angles for clockwise rotation. 

Positive Angles Rotate Counterclockwise 

Choose this option if the rotator hardware reports positive angles for counterclockwise rotation. 

Move Rotator 180° on Mount Pier Flip 

When this field is checked, your rotator will automatically move 180 degrees when your 
equatorial mount reports that its slew has caused it to execute a meridian flip.  This feature is 
only available for mounts capable of reporting their current side-of-pier status.  Automatic 
rotator movement is disabled during any form of TPoint calibration. 

Controlling the Rotator 

Use the controls on the Rotator window (Display menu) to control the rotator. 
 

 

Figure 269: The Rotator window. 

The name of the rotator is displayed at the top of the Rotator window.  Click the Rotator Setup 
button to select a different model, or to configure the rotator hardware. 
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Connect 

Click this button to establish communication with the rotator hardware.  Make sure to choose 
the correct serial or other interface port for your rotator hardware and that the hardware is 
plugged in turned on and connected to the computer before proceeding. 

Disconnect 

Click this button to terminate communication with the rotator hardware. 

Status 

Shows the current status of the rotator. 
 

Status Text Description 
Not 
Connected 

The red text indicates there is no connection between TheSkyX and 
the rotator.     
 
To connect to the rotator: 
 
Choose your rotators from Rotator List window on the Rotator 
Setup pop-up menu from the Telescope Setup window. 
Choose the communication port by clicking the Settings command 
on the Rotator Setup pop-up menu. 
Click the Connect command from the Rotator Control window to 
connect to the rotator. 
 

Connecting  This message is displayed while TheSkyX attempts to establish 
communication with the rotator.   
 
If connection fails, double check: 
 

• The rotator is powered on. 

• The communication cable is plugged into the correct port on 
the rotator and computer. 

• When using the device’s RS232 communications port (serial 
port), make sure the USB to Serial Adaptor driver for your 
operating system are installed.  Under Windows, check the 
Device Manager to ensure the driver is recognized and 
functioning properly. 

• Click the Settings button on the Telescope Setup window to 
make sure TheSkyX Professional Edition’s Rotator settings 
are correct. 

• Make sure the cable (RS232 or USB cable) is not frayed, 
damaged or otherwise compromised.   

 
Ready This message appears after TheSkyX has successfully established 

communication with the rotator and the device is ready to use. 
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Status Text Description 
 

Rotating This message is displayed while the rotator is changing position. 
 

Disconnecting This message appears while TheSkyX terminates communication 
with the rotator. 

Rotator Angles vs. Position Angles 

You have the option of displaying and commanding the rotator either in terms of a rotator angle 
or a position angle.   
 

• Rotator angles are the raw angular values reported by the rotator hardware and 
firmware.   

• Position angles are an angular measurement from the north, through east.  
 
Choosing either option not only changes what value is shown in the rotator Position field, but 
also changes how the rotator’s "destination position" is interpreted.   

Rotator Offset  

No matter how carefully a rotator is installed in an imaging system, the zero position generally 
does not exactly correspond to a zero-degree position angle.  The Rotator Offset value accounts 
for the difference between these two values.  Combined with the Rotator Polarity (page 606), 
the imaging system's true position angle can be predicted, based on your rotator's current 
position.   
 
TheSkyX Pro will automatically populate this field if you click the Synchronize Rotator Angle to 
Position Angle button following a successful Image Link (page 323).  For any linked FOVIs, this 
value is additive with the FOVI’s own position angle. 

Position 

The current position of the rotator, in degrees. 

Destination Position 

Enter the destination position for the rotator, in degrees. 

Go To 

Click this button to rotate the rotator to the destination position. 

Abort 

Click this button to stop rotation. 

Linking Rotator to Field of View Indicator 

The position of the rotator can be tied or “linked to” the position angle of a field of view indicator.  
See “Link to Rotator” on page 122 for details how to perform this step. 
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When a field of view indicator is linked to the rotator and the field of view indicator is rotated, 
the following window appears. 
 

 

Figure 270: Rotating hardware based on the FOVI position angle. 

Choose the Send Rotate Command To Rotator option to change the position of the rotator 
hardware to match the FOVI.  Choose the Adjust FOVI Position Angle option and click OK to 
change the FOVI’s position angle. 
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Dome Control 

 

 
 
The Dome Add On can control the astronomical domes listed in the table below. 
 

Dome Manufacturer/Model 
     

ACL-compatible dome controllers 
- 

 
- - 

Software Bisque/Rotator simulator 
    

NexDome Rotation Kit1 
    

m1OASYS Roll-off Roof Automation 
System1 
 

    

MaxDome II1  
    

Rigel Rotation Drive Unit for Pulsar Dome1 
    

SkyRoof Roll-off Roof Automation 
    

 
1This open-source X2 Plug In must be downloaded and installed separately from RTI-Zone.org. 
 
On Windows, the Dome Add On can also control all ASCOM-compatible domes, including the 
popular Digital Dome Works (DDW) from Technical Innovations and MaxDome II from Diffraction 
Limited. 
 
As you slew the telescope using TheSkyX, the Dome Add On automatically rotates the dome’s 
aperture to the correct azimuth considering the telescope-dome geometry. 
 

https://rti-zone.org/macosx_x2dome_plugins.php
https://rti-zone.org/macosx.php
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The position of the dome’s opening is displayed on the Sky Chart for reference. 
 

 

Figure 271: Sky Chart showing dome slit and telescope cross hair. 

Minimum Requirements 

• One of the supported dome or roof controllers listed above. 

• Any ASCOM-compatible dome hardware (Windows only). 
 
TheSkyX Professional Edition for Mac and Windows, stand alone, can control astronomical domes 
with the Dome Control Add On.   

Activating the Dome Add On 

When you purchase TheSkyX Professional Edition Dome Add On, a Dome Add On serial number 
is automatically registered and can be viewed on your Software Bisque account’s Subscriptions 
page. 
 
The Dome Add On serial number is used to activate the dome software directly from TheSkyX 
Pro.  No additional installers, software or software downloads are required for Dome Add On 
activation. 
 
To access your serial number and activate the Dome Add On: 
 

https://www.bisque.com/sc/shops/mysubscriptions.aspx
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1. Sign in to the Software Bisque web site by clicking the Sign In link in the upper right corner of 
the site.  After you are signed in, your Sign In Name appears in the upper right corner of the 
site. 

2. Navigate to your subscriptions page by clicking your Sign In Name, then click the 
Subscriptions link.  

3. From TheSkyX Pro, click the Telescope Setup command on the Telescope menu. 
4. Highlight Dome on the Imaging System list. 
5. Click the Enter Serial Number command on the Dome Setup pop-up menu. 
6. Enter your Name and Serial Number. 
7. Click OK. 
 
The Dome Add On is now activated and ready to use.  You’ll need to repeat the above procedure 
on each computer that is running a licensed copy of TheSkyX Professional Edition. 

Configuring the Dome Control Add On  

Follow the steps below to configure TheSkyX Professional Edition to directly control a dome. 
 
1. Make sure your dome controller is ready.   
2. From TheSkyX, select the Telescope Setup command from the Telescope menu. 
3. Select Dome from the Imaging System list. 
4. Click the Choose command on the Dome Setup pop-up menu.  If you have not purchased the 

Dome Control Add On, you can click the Run Trial button to use begin the 90-day trial period. 
5. Select your dome controller and click OK. 
6. Select the Connect command from the Dome Setup pop-up menu.  If the dome drivers are 

installed properly, after about 15 seconds, the green Connected status text appears on the 
Imaging System Setup window and on the Dome window.   

Using AutomaDome for Windows (Legacy) 

 

The Dome Add On supersedes AutomaDome for Windows.  The section 
immediately below remains for legacy reference only. 

 
In addition to the TheSkyX’s standalone support for domes, any dome that can be controlled by 
AutomaDome for Windows can also be used.  Please double-check that you have installed the 
latest release of AutomaDome for Windows before continuing. 

Configuring TheSkyX to Use AutomaDome  

• Make sure AutomaDome, standalone, can connect to control the dome.  If AutomaDome does 
not work to control the dome, TheSkyX can’t use it to control the dome either. 

• From TheSkyX, select the Telescope Setup command from the Telescope menu. 

• Select Dome from the Imaging System list. 

• Click the Choose command on the Dome Setup pop-up menu.  If you have not purchased the 
Dome Control Add On, click the Run Trial button to use begin the 90-day trial period. 

https://www.bisque.com/
https://www.bisque.com/sc/shops/mysubscriptions.aspx
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• Expand Software Bisque, then select AutomaDome Dome and click OK. 

• Select the Connect command from the Dome Setup pop-up menu.  The green Connected status 
text appears on the Imaging System Setup window and on the Dome window. 

Dome Preferences 

Dome preferences are configured on the Imaging System Setup window.  Click the Telescope 
Setup command from the Telescope menu to show this window.   Next, highlight Dome in the 
Imaging System list on the left side of the window to reveal the dome-specific settings. 
 

 

Figure 272: The dome Preferences on the Imaging System Setup window. 
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Dome 

Shows the name of the selected dome hardware driver.  Choose the Setup command from the 
Dome Setup pop-up menu to change the current selection. 

Dome Setup Pop-up Menu 

Click this pop-up menu to access dome-specific commands. 
 
Choose 
Click this command to show the Choose Dome window and select the dome driver for your 
dome controller. 
 

 

Figure 273: The Windows Choose Dome window. 

ASCOM Dome 

On Windows, choose ASCOM Dome under Ascom in the Dome list if to use an ASCOM driver to 
control your dome hardware.  You must install the ASCOM platform and the ASCOM-specific 
dome driver first.  See the ASCOM site for details about how.  Next, click the Settings command 
from the Dome Setup pop-up menu to display the ASCOM Chooser window.  If you have installed 
the ASCOM platform and the ASCOM-compatible dome driver for your dome hardware, the 
driver name will appear in the list of supported domes.  Choose it, then click the Properties 
button to configure the ASCOM dome settings.  TheSkyX Professional Edition should now be able 
to connect to and control the dome. 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 616 

ACL Dome 

Choose ACL Dome if your dome hardware is compatible with the Astronomy Command Language 
(ACL). 

DomeAPI 

If your dome hardware has a custom-written dome driver based on Software Bisque’s legacy 
DomeAPI framework.  Dome driver developers are strongly encouraged to update these drivers 
to conform to the X2 Standard (page 657) instead. 

Dome Simulator 

The Dome Simulator can setup, connect to, and use a “simulated” dome without connecting to 
any physical dome hardware.  This can be useful to get familiar with how TheSkyX Professional 
Edition and the telescope interact with a dome. 

Dome Information 

The Dome Information controls let you configure dome-specific options. 

Couple Dome to Telescope Slews 

When this checkbox is on, and slew commands are issued from a telescope that is controlled by 
TheSkyX Professional Edition, the dome will be rotated to keep the two aligned.  Note that the 
geometry of where the telescope is mounted inside the dome must be configured using the dome 
geometry controls below. 

Couple Dome to Telescope Tracking 

When this checkbox is on, as the telescope tracks, the dome will be rotated to keep the two 
aligned.  Note that the geometry of where the telescope is mounted inside the dome must be 
configured using the dome geometry controls below. 

Dome Update Interval 

Enter the number of milliseconds that must elapse before the dome’s position is updated. 

Maximum Angle from Slit Edge to Telescope Position 

Enter the maximum number of degrees that the edge of the dome slit can be separated from the 
telescope before the dome’s position is updated. 

Center Telescope Position 

Turn this option on so that the telescope will be kept near the center of the dome slit. 

Dome Geometry 

The next step is to determine your dome’s geometry so that the dome opening can be coupled 
to, and follow the telescope.  Figure 274 shows a mount and telescope inside an astronomical 
dome.    
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The center of the dome represents the origin of the coordinate system from which the dome 
geometry measurements should be taken.  The intersection of the mount’s right ascension and 
declination axis is labeled in Figure 274.  The dome radius is the distance from the center of the 
dome ‘sphere’ to the inside edge of the dome. 

 

Figure 274: The positions of the dome geometry parameters in a hemispherical dome.   
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Figure 275: An overhead view of the dome.  Note that in the example shown, Xt, Xm and Ym all happen to be negative 
quantities 
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Figure 276: Zm is the vertical distance from the dome center to a horizontal line through intersection of the RA and Dec 
axes. 

The red text and red lines in Figure 275 and Figure 276 show the five dome geometry 
measurements that are required for most amateur mounts.   All measurements should be the 
same units. 

Dome Radius  

Enter the radius of the dome (Figure 275).   

Offset of Mount from Dome  

The values of Xm, Ym and Zm define the offset of the intersection of the RA and Dec axes from 
the center of the dome ‘sphere’.  
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Xm  

Enter the distance from the N-S centerline of the center of the dome ‘sphere’ to the intersection 
of the RA and Dec axes (Figure 275).  This value is usually negative. 

Ym  

Enter the distance from the E-W centerline of center of the dome ‘sphere’ to the intersection of 
the RA and Dec axes (Figure 275).  This value is usually negative. 

Zm 

Enter the vertical distance from the center of the dome ‘sphere’ to the intersection of the RA and 
Dec axes.   
 
The Paramount User Guide (page 423) describes how to compute the latitude-dependent height 
of Paramount mounts.   

Offset of Telescope from Mount  

The arguments Xt, Yt specify the offset of the telescope from the mount.  

Xt  

Enter the distance from the N-S centerline of the intersection of the RA and Dec axes to the 
optical center.  This value is typically negative. 
 
Based on customer feedback, the Xt parameter seems to be the most difficult to determine out 
of the box, especially for German equatorial mounts.   
 
One way to determine whether Xt is correct is to slew the telescope low on the horizon, close to 
due south and note the position of the telescope relative to the dome’s slit.  Next, reverse the 
sign of Xt, then repeat this test.   

Advanced Dome Geometry Settings 

Turn on the Advanced checkbox to enter the geometry for non-standard telescopes. 

Yt  

Enter the distance from the E-W centerline of the intersection of the RA and Dec axes to the 
optical center. This parameter is not defined in the above diagram, and is normally zero. See the 
section “Technical Description of Dome Geometry Parameters” on page 621 for more 
information. 

Offset of Optical Axis from Telescope (Yo)  

Enter the offset of the optical axis within the telescope. This value is typically zero for most 
amateur telescopes.  
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Dome Slit Dimensions 

These options define the dome width, and the lower and upper limits of the dome shutter. 

Width 

Enter the width of the dome slit.  Be sure to use the same units of measure for all dome geometry 
parameters. 

Upper Altitude 

Enter the highest allowable altitude, in degrees, for the dome shutter. 

Lower Altitude  

Enter the lowest possible altitude, in degrees, for the dome shutter. 

Technical Description of Dome Geometry Parameters  

Parameter Description) 

Rdome   Radius of dome  

Xm, Ym, Zm Offset of mount  

Xt, Yt  Offset of telescope 

Yo   Offset of optical center  

Notes:   

 

• The dome is presumed to be hemispherical (or some other portion of a sphere).  The 
radius of the sphere is specified through the Rdome parameter.  Any desired units can be 
used as long as all the other parameters (namely Xm, Ym, Zm, Xt, Yt, Yo) are in the same   
units. 

• The parameters Xm, Ym, Zm specify the offset of the mount from the center of the dome.  
The "mount" in this context is that point along the polar axis (and hence fixed in space) 
that lies nearest to the declination axis.  The x,y,z coordinate system is oriented east, 
north, up.  

• The parameters Xt, Yt and Yo form a sequence of offsets linking the polar axis, the 
declination axis and the telescope's optical axis:  
 Xt is the distance along the declination axis to where the telescope assembly turns, 

starting from the point on the declination axis closest to the polar axis.  For fork 
mounts Xt is zero, but for GEMs Xt is a substantial distance. 

 Yt is the separation between the polar and declination axes at their closest approach.  
For most GEMs, the two axes intersect and hence Yt is zero.  Occasionally (some 
horseshoe mounts for example) the two axes do not intersect and Yt is non-zero.  

 Yo is the separation between the declination and optical axes.  It is usually zero.  Very 
occasionally, for example where a second telescope is mounted on the “side” of the 
main telescope, the declination axis and optical axis do not intersect and so Yo is non-
zero. 
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The offsets Xt and Yt are at right angles, and the offsets Xt and Yo are at right angles, but the 
angle between the offsets Yt and Yo varies with declination. 
 

The sign conventions for Xt, Yt and Yo are such that with the telescope pointing at HA,Dec (0,0), 
Xt is positive towards (-6h,0d), Yt is positive towards (12h,0d), and Yo is positive towards Dec 
+90d. 

Dome Commands 

Select the Dome command from the Display menu to show the Dome window.  This window is 
normally “docked” to the left side of the Sky Chart, but can be positioned elsewhere by dragging 
the caption. 
 

 

Figure 277: The Dome commands window (Dome window, Display menu). 

Dome Driver Name 

The name of the currently selected dome driver is listed at the top of the Dome window.   

Dome Commands Pop-up Menu 

Click this button to display the Dome-specific settings on the Imaging System Setup window. 
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Status 

Shows the status of the dome connection. 

Azimuth  

Shows the azimuth of the dome opening. 

Connect 

Click this button to establish communication with the dome controller. 

Disconnect 

Click this button to terminate communication with the dome controller. 

Go To  

Click this button to enter the azimuth to position the dome opening. 

Find Home 

Click this button to locate the dome’s home position. 

Open Dome  

Click this button to open the dome shutter. 

Close Dome  

Click this button to close the dome shutter. 

Park Dome  

Click this button to send the dome to its park position. 

Unpark Dome  

Click this button to perform any necessary initialization when starting up the dome for the night.  

Sync Dome 

Click this button to synchronize the dome opening to a specific azimuth. 

Abort 

Click this button to terminate in any dome command that is currently in progress. 

Result  

Shows the results of the dome command reported by the dome controller hardware. 
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Appendix A: Databases and Cross References 

TheSkyX Professional Edition and Serious Astronomer Edition include databases of celestial 
objects from the standard astronomical catalogs listed in the tables below.  
 
If you want to use a specific set of databases, select the Database Manager command from the 
Input menu to turn any catalog on or off. 

Star Catalogs 

The Hipparcos-Tycho Catalogs are the primary stellar databases used to display information by 
TheSkyX for stars to about 12th magnitude and brighter. 

  

TheSkyX also cross-references stars from the following catalogs.  

• Bayer/Flamsteed Designations 

• Smithsonian Astrophysical Observatory Catalog (SAO)  

• Positions and Proper Motion Catalog (PPM)  

• Henry Draper Catalog (HD)  
 

Star Catalog Name Details/Object Count 

Hipparcos/Tycho Stellar Catalog 
 

1.2 million stars, complete to 12th magnitude 
 

Hubble Guide Star Catalog (GSC) Version 
1.2  
 

19 million stars, complete to about 14th magnitude 

General Catalog of Variable Stars (GCVS) 
 

40,214 variable stars 
 

New Suspected Variable Star Catalog 
(NSV) 
 

13,490 suspected variable stars 
 

Struve Double Star Catalog 
 

4,307 double stars 
 

Washington Catalog of Double Stars 
(WDS) 
 

102,139 double stars 

Non-Stellar Catalogs 

Non-stellar Catalog Name Details/Object Count 

Historically Corrected New General 
Catalogue (HCNGC) from the NGC/IC 
Project* 
 

7,840 non-stellar objects 
 

Index Catalog (IC) from the NGC/IC 
Project* 
 

5,382 non-stellar objects 

Catalog of Principal Galaxies (PGC 2003) 
  

900,000 galaxies 
 

http://www.rssd.esa.int/index.php?project=HIPPARCOS&page=Overview
http://tdc-www.harvard.edu/software/catalogs/hstgsc.html
http://ad.usno.navy.mil/wds/
http://www.ngcic.org/
http://www.ngcic.org/
http://www.ngcic.org/
http://www.ngcic.org/


TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 625 

Non-stellar Catalog Name Details/Object Count 

Catalog of Principal Galaxies (PGC 2011)  
 

1,670,818 galaxies 

PK Planetary Nebula Catalog (PLN) 
 
 

1,455 planetary nebulae 

Tomm Lorenzin 2000+ Catalog 
 
 

2,088 non-stellar objects 

Herschel Catalog 
 

400 

Caldwell Catalog 
 

109 

Messier Catalog (M)  
 

110 

Saguaro Astronomy Club (SAC) Database 
 

10,580 

 
*The HCNGC and IC catalog is used with permission of The NGC/IC Project LLC - http://www.ngcic.org – 
please contact Bob Erdmann at hcngc at ngcic dot org for questions or clarifications regarding 
this astronomical catalog. 

Additional Sky Databases (SDBs) 

TheSkyX includes the following additional astronomical catalogs that can be displayed on the Sky 
Chart.  From the Input > Database Manager window, navigate to the Sky Databases (SDBs) > 
Optional Databases node in the Databases list to turn them on or off.  
 

Catalog Name Search Prefix Object Count Object Type 

1.4 GHz Northern Sky 
 

1-4ghz 31524 Reference Point 

6C Survey of Radio Sources  
 

6CSRSI 1761 Radio Source 

6C Survey of Radio Sources II 
 
 

6CSRSII 8278 Radio Source 

6C Survey of Radio Sources III 
 
 

6CSRSIII 8749 Radio Source 

6C Survey of Radio Sources IV 
 
 

6CSRS-IV 5421 Radio Source 

6C Survey of Radio Sources V – A 
 
 

6CSRS-VA 2229 Radio Source 

6C Survey of Radio Sources V – B 
 
 

6CSRS-VB 1229 Radio Source 

6C Survey of Radio Sources VI 
 
  

6CSRS-VI 6752 Radio Source 

Abell–Zwicky Clusters of Galaxies AGC 2712 Cluster of Galaxies 

http://www.ngcic.org/
http://www.ngcic.org/
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Catalog Name Search Prefix Object Count Object Type 

 

Abell Planetary Nebulae 
 

APN 86 Nebula 

Ackerman Red Stars 
 

ARS 267 Reference Point 

APM Bright Galaxy Catalogue 
 

APM 14681 Galaxy 

Arp Globular Clusters 
  

Arp-GC 43 Globular Cluster 

Arp Peculiar Galaxies 
  

ARP-PG 38 Galaxy 

Barnard's Dark Nebulae  
 

Barnard 349 Dark Nebula 

Bright Nebulae Drawings (TMB)** 
   

TMB-BN 25743 Bright Nebula 

Catalog of Bright Galaxies 
  

CBG 4364 Galaxy 

Celestron NexStar Doubles 
  

CND 55 Double Star 

Cepheids in the Large Magellanic 
Cloud 
  

LMC-CV 97 Variable Star 

Cluster System of the Large 
Magellanic Cloud 
 

LMC-CL 1762 Mixed Deep Sky 

Cool Galactic Carbon Stars 
 

CCS 5987 Reference Point 

Cousins Photometric Standards 
 

CPS 670 Reference Point 

Culled Henden CI Labels 
  

HC-L 0 Reference Point 

Dark Nebulae Isophotes TMB** 
 

DND 650 Dark Nebula 

Declination Zero  
  

 51 Reference Line 

Declination Zero Label 
  

 13 Reference Point 

DeepMap 600  
  

 470 Reference Point 

Don Macholtz Messier Marathon  
 

Macholtz 110 Target Object 

Double Stars with common names 
   

 169 Double Star 

Einstein Observatory Ex M-S Survey 
  

EMSS 835 X-Ray Source 

Feitzinger Dark Nebula 
 

FZ-DN 489 Dark Nebula 

Feitzinger Globules 
 

FG 331 Reference Point 

Florsch - Small Magellanic Cloud 
Stars 
 

SMC-Florsch 584 Reference Point 

G2 V Stars from SIMBAD Query G2V 688 Reference Point 
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Catalog Name Search Prefix Object Count Object Type 

  

Galactic Globular Clusters – 
Monella 
 

GC-Monella 160 Globular Cluster 

Galactiglob Galaxies 
  

TJ-GG 2495 Galaxy 

Galaxy Isophote M51 Example 
 

BSR-GI 902 Galaxy 

Hickson Compact Groups of 
Galaxies 
 

Hickson 463 Galaxy 

Hickson Compact Groups of 
Galaxies – Group Identifier 
 

HGG 100 Cluster of Galaxies 

Hickson Compact Groups of 
Galaxies – Labels 
 

<none> 463 Galaxy type 

Heinz Nebula Small Magellanic 
Cloud 
 

HN 117 Nebula 

Henden 3C 
 

H3C 504 Reference Point 

Herbig-Haro Objects 
   

HH 454 Reference Point 

HW Clusters Large Magellanic Cloud 
  

HW-SMC 87 Globular Cluster 

IRAS 1.2 Jy Redshift 
 

IRAS-1.2 9899 Galaxy 

IRAS Small Scale Structure 
 

IRASS 16740 Reference Point 

Kron Clusters Small Magellanic 
Cloud 
 
 

SMC-KRON 69 Globular Cluster 

Landolt Faint Photometric 
Standards 
 

LFPS 526 Reference Point 

Landolt Photometric Standards 
 

LPS 1154 Reference Point 

Landolt Photometric Standards 
South 
 
 

LPS-S 109 Reference Point 

Lindsay Clusters Small Magellanic 
Cloud 
 

SMC-L 118 Globular Cluster 

Lynds' Bright Nebulae 
  

LBN 1053 Bright Nebula 

Lynds' Dark Nebulae 
  

LDN 1791 Dark Nebula 

Meade Alignment Star Labels 
  

MAS 78 Reference Point 
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Catalog Name Search Prefix Object Count Object Type 

Michael Covington Deep Sky 
Objects 
 

COV 200 Mixed Deep Sky 

Milky Way Globular Clusters  
 

MW-GC 150 Globular Cluster 

Molonglo Reference - Radio 
Sources 
 

Molongo Radio 12141 Radio Source 

Navigational Stars 
 

NavStar 58 Reference Point 

NB Carbon Stars – Skiff 
  

NBC 211 Reference Point 

Nebulae in the Magellanic Clouds – 
HII 
 

LMC-HII 358 Nebula 

NGC and IC objects UNKNOWN 
magnitudes  
 

 982 Mixed Deep Sky 

NGC Max Alignment Stars – JMI 
  

JMI 30 Star 

Objects in the Direction of the SMC 
 

SMC-B 965 Reference Point 

Open Cluster Data Fifth Edition 
(Lynga 1987)  

OC-L 1151 Open Cluster 

Palomar Globular Clusters 
 

PAL 15 Globular Cluster 

Palomar Sky Survey - 102 CD labels 
 

DSS-102 0 Reference Point 

Palomar Sky Survey Plates 
Additional Data 
 
 

POSS 1037 Reference Point 

Parkes Radio Sources 
  

PKS90 8264 Radio Source 

Planetary Nebulae in LMC 
 

LMC-PLN 169 Planetary Nebula 

Pulsars  (Taylor+ 1993) 
  

PULSARS 558 Radio Source 

Query Common Non-Stellar 
 

 329 Mixed Deep Sky 

RealSky CD's North Labels 
 

RealSky-N 765 Reference Point 

RealSky CD's South Labels 
 

RealSky-S 800 Reference Point 

RealSky North & South Labels 
 

RealSky-NS 658 Reference Point 

Redshift Galaxies 
 

RG 12844 Galaxy 

Rich Clusters of Galaxies (North) 
 

RC-GN  2712 Cluster of Galaxies 

Rich Clusters of Galaxies (South) 
 

RC-GS 1364 Cluster of Galaxies 

Roslund Red Stars in Scorpious RR 69 Reference Point 
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Catalog Name Search Prefix Object Count Object Type 

 

Seyfert Galaxies 
 

Seyfert 121 Galaxy 

Shapley-Ames Bright Galaxies 
 

SA-BG 1246 Galaxy 

Sharpless H II Regions 
  

SH2- 313 Nebula 

Skiff North Bright Standards 
 

BK-NBS 119 Reference Point 

Southern hemisphere H-alpha 
emission regions (Rogers+ 1960) 
 

RCW 14 Nebula 

Southern hemisphere H-alpha 
emission regions (Rogers+ 1960) 
Labels 
 

<none> 14 Label 

Star Clusters and Associations 
 
 

SCA 1039 Open Cluster 

Stars in the Double-Double 
  

DDS 2 Star 

Supernova Remnants – Green 
 

SNR-G 231 Supernova 

Terzan Globular Clusters 
 

Ter 11 Globular Cluster 

Third Catalogue of Nearby Stars 
 

CNS3 3802 Reference Point 

Trapezium Circumstellar disks 
 

TCD 149 Reference Point 

Trapezium ROSAT PSPC 
 

Trap-XRay 171 X-Ray Source 

Trapezium Stars – TMB** 
 

 14 Star 

Trapezium Stars VizieR 
 

Trap-Vzr 292 Reference Point 

Trumpler Clusters 
 

Tr 34 Open Cluster 

Trumpler Stars 
 

Tr-S 39 Reference Point 

UV-Excess Galaxies 
 

UVG 8162 Galaxy 

Van Den Berg Reflection Nebulae 
  

Vdb 158 Nebula 

Video Calibration Stars 
  

VCS 958 Target Object 

W-G Clusters Small Magellanic 
Cloud 
  

WG 18 Globular Cluster 

X-ray source 
 

1RXSJ 108 Galaxy 

Yale Bright Star Catalog First Half 
  

YBSC-1 4991 Star 

Yale Bright Star Catalog Second Half YBSC-2 4105 Star 
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*TMB indicates this optional SDB was created or compiled by Thomas M. Bisque. 
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Solar System Objects 

Group Objects in Group Number of Objects 

Sun, Planets, Moons 
 

Sun 
Mercury 
Venus 
Earth 
Earth’s Moon 
Mars 
Jupiter 
Io 
Ganymede 
Europa 
Callisto 
Saturn 
Enceladus 
Mimas 
Tethys 
Dione 
Rhea 
Titan 
Hyperion 
Iapetus 
Uranus 
Neptune 
 

22 
 

Small Solar System Bodies 
 

Pluto 
 

1 
 

Comets 
 

Up to 1000 at once. 
 

Asteroids (Minor Planets) 
 

Every known asteroid (Orbital 
elements are updated from the 
web.) 
 

Artificial Satellites 
 

Updated from the web via the 
Input > Satellites command. 

Up to 10,000 two-line elements 
(TLEs) can be imported and 
updated from the web when 
TheSkyX is launched. 
 

Photographs 

Photos Database Details 

Anglo-Australian Observatory Photos 172 color photos from the David Malin collection of AAO images. 

Deep-sky Overlays 127 photos that appear on the Sky Chart. 

Hubble Photos 314 color photographs from the Hubble Space Telescope. 

Messier Overlays 104 color photographs. 
 

Non-stellar objects 
 

53 color photographs of non-stellar objects. 
 

Solar System Photos 255 color photographs of the solar system objects. 
 

Digitized Sky Survey thumbnails 100,000 grayscale photos from the Digitized Sky Survey. 
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Catalog Cross References 

TheSkyX includes cross references the following catalogs.  Use the Find command on the Edit 
menu to locate any object in these catalogs. 
 

  

Cross-Referenced Catalogs Prefix Object Count 

2MASS Galaxies 
 

2MASXJ – 

2MFGC Catalog 
 

2MFGC – 

6dFJ 
 

6dFJ – 

Abell  
 

ABELL – 

Abell 1644 
 

ABELL_1644 145 

AGC 
 

AGC – 

AM 
 

AM – 

Antila Group 
 

Antila Group – 

Arakelian Catalog of Galaxies 
 

ARK 591 

Arp 
 

ARP – 

Bayer/Flamsteed Designations 
 

n/a – 

Bonner Durchmusterung Number 
 

B+nn nnnnn – 

BTS 
 

BTS – 

Caldwell Catalog 
 

Caldwell + Cn 109 

Cape Durchmusterung Number 
 

P-nn nnnn – 

Catalog of Galaxies and Clusters of Galaxies 
 

CGCG 29,809 

Catalog of Galaxy Groups 
 

KDG 253 

Catalog of Isolated Pairs of Galaxies 
 

KCPG – 

CGMW 
 

CGMW – 

Common Non-Stellar Object Names 
 

name of object  – 

Common Star Names 
 

name of object  – 

Compact Groups of Galaxies 
 

2DFGRSN – 

Constellations 
 

name of constellation 88 
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Cross-Referenced Catalogs Prefix Object Count 

Cordoba Durchmusterung 
 

C-nn nnnnn – 

David Dunlap Observatory Catalog of Galaxies 
 

DDO 242 

DDO 
 

DDO – 

Dorado Group 
 

DORADO_GROUP – 

DRCG 
 

DRCG – 

DUKST 
 

DUKST – 

EDCC 
 

EDCC – 

European Southern Observatory (Southern objects) 
 

ESO 16,239 

Fairall Catalog of Galaxies 
 

FAIR 1,185 

FCC 
 

FCC – 

FCCB 
 

FCCB – 

FGC 
 

FGC – 

FGCE 
 

FGCE – 

FM 
 

FM – 

Galaxy Identification Number 
  

GIN 795 

GIN 
 

GIN – 

GMP 
 

GMP – 

Groups of Galaxies 
 

2DFGRSS –  

HCG 
 

HCG – 

Henry Draper Number 
 

HD 359,083 

Hickson Compact Galaxy Groups 
 

HCG 450 

HIPASSJ 
 

HIPASSJ – 

HRG 
 

HRG – 

HSTGC 
 

HSTGC – 

IC (PGC 2011 Cross Reference) 
 

IC – 

IISZ 
 

IISZ – 

Infrared Astronomical Survey IRAS 9,347 
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Cross-Referenced Catalogs Prefix Object Count 

 

ISZ 
 

ISZ – 

Karachentseva Catalog of Galaxies 
 

KARA 183 

Kazaryan UV Galaxies 
 

KAZ 581 

KDG 
 

KDG – 

KIG 
 

KIG – 

Kiso UV Galaxies 
 

KUG 5,455 

KKH 
 

KKH – 

KPG 
 

KPG – 

KUG 
 

KUG – 

LCRSB 
 

LCRSB – 

Leo Group 
 

LEO_GROUP – 

LGG 
 

LGG – 

MCG 
 

MCG – 

Messier Catalog 
 

M 110 

MRK 
 

MRK – 

NFPJ 
 

NFPJ – 

NGC (PGC 2011 Cross Reference) 
 

NGC – 

NPM 
 

NPM – 

NRGb 
 

NRGb – 

NRGs 
 

NRGs – 

PDFJ 
 

PDFJ – 

PGC (PGC 2011 Cross Reference) 
 

PGC – 

PKS 
 

PKS – 

Positions and Proper Motions Number 
 

PPM - 

POX 
 

POX – 

RKK 
 

RKK – 



TheSkyX Professional and Serious Astronomer Edition User Guide 

Page 635 

Cross-Referenced Catalogs Prefix Object Count 

SBS 
 

SBS – 

SDSSJ 
 

SDSSJ – 

Second Byurakay Survey 
 

SBS 259 

Smithsonian Astrophysical Observatory Catalog (SAO) 
  

SAO 258,997 

SRGb 
 

SRGb – 

SS 
 

SS – 

Struve Catalog 
 

STRUVE 3,100 

Tololo Galaxies 
 

TOL 111 

UCG 
 

UCG – 

UCGA 
 

UCGA – 

University of Michigan Catalog of Galaxies 
 

UM 652 

LGS 
 

LGS 5 

Uppsala General Catalog of Galaxies 
 

UGC 13,073 

VCC 
 

VCC – 

Virgo Cluster Catalog of Galaxies 
 

VCC 2097 

VV 
 

VV – 

Weinberger Catalog of Galaxies 
 

WEIN 207 

WINGSJ 
 

WINGSJ – 

WKK 
 

WKK – 

WMMA 
 

WMMA – 

ZOAG 
 

ZOAG – 

Zwicky1 
 

1ZW 238 

Zwicky2 
 

2ZW 199 

Zwicky3 
 

3ZW 159 

Zwicky4 
 

4ZW 203 

Zwicky5 
 

5ZW 531 

Zwicky6 6ZW 238 
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Cross-Referenced Catalogs Prefix Object Count 

 

Zwicky7 
 

7ZW 1,145 

Zwicky8 8ZW 645 

Ephemeral Data 

TheSkyX can display the positions of comets and minor planets and man-made satellites.  The 
orbital element data required to accurately display these objects changes frequently and can be 
updated from TheSkyX using different sources on the worldwide web.  
 
The table below lists the sites the TheSkyX uses to update this information. 
 

Object Type Object Count Web Site Address to Obtain Updated Orbital Element Data 

Comets Up to 1000 http://www.minorplanetcenter.net/iau/MPEph/MPEph.html 
 

Satellites Up to 10,000 
 

http://celestrak.com  
 

Asteroids (Large 
Database) 
 

All known asteroids http://asteroid.lowell.edu  
 
 

 
  

http://www.minorplanetcenter.net/iau/MPEph/MPEph.html
http://celestrak.com/
http://asteroid.lowell.edu/
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TheSkyX Professional Edition-Specific Databases 

 
TheSkyX Professional Edition includes a subset of the UCAC4 star catalog that 
contains approximately 30 million stars, more or less evenly distributed across the 
celestial sphere.  This catalog is ideal for determining the astrometric solution 
of photos with moderate to wide fields of view using Image Link (page 312). 
 
The limiting magnitude of the UCAC4 Subset catalog is approximately 14. 

TheSkyX Professional Edition Database Add On 

 

Figure 278: TheSkyX Pro Database Add On hard drive (the physical SSD drive may vary). 

Software Bisque offers an optional TheSkyX Professional Edition Database Add On, a set of 
astronomical catalogs distributed on a 350 GB hard drive.  The table below lists each catalog or 
resource included on the drive. 
 

Catalog or Resource Name Number of Stars or Description Approximate Size (GB) 

Native NOMAD Catalog and related files 
 

1.1 billion  100 

TheSkyX Pro-specific NOMAD plot files 
 

800 million  40 

Native UCAC4 Catalog and related files and 
folders 
 

113 million 8 

Small TheSkyX Pro-specific UCAC4 plot file 30 million 1 

http://www.bisque.com/sc/shops/store/All+Products/Hot+Products/TheSkyX-Pro-Database-Add-On-.aspx
http://www.nofs.navy.mil/nomad/
http://www.usno.navy.mil/USNO/astrometry/optical-IR-prod/ucac
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Catalog or Resource Name Number of Stars or Description Approximate Size (GB) 

All Sky Image Link Database installers for 
macOS and Windows 

This database is required to perform 
All Sky Image Links. 

2 

AAVSO Photometric All Sky Survey (APASS) Funding for APASS was provided by 
the Robert Martin Ayers Sciences 
Fund. 

2 

Large TheSkyX Pro-specific UCAC4 plot file 113 million 3 

Digitized Sky Survey “First generation” Digitized Sky 
Survey from the Space Telescope 
Science Institute contains photos of 
the entire celestial sphere at 10x 
compression.  Distributed with 
permission. 

60 

Total   200 
 
 

These databases can be accessed from TheSkyX Professional Edition for Mac or Windows. 

Packing List 

TheSkyX Professional Edition Database Add On includes the following items: 
 

Quantity Description 

1 250 GB USB SSD drive  

1 USB cable 

 

 

Figure 279: TheSkyX Pro Database Add On USB SSD drive cable. 

https://www.aavso.org/apass
https://en.wikipedia.org/wiki/Digitized_Sky_Survey#Production
https://en.wikipedia.org/wiki/Digitized_Sky_Survey#Production
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Getting Started 

After unpacking the drive and cable from the shipping box, the next step is to plug the USB drive 
into your computer.  The following procedure applies to all operating systems. 
 

1. Plug the non-USB end of the cable into the hard drive port (Figure 280). 
 

 

Figure 280: Plug this end of the USB cable on the left into the SSD drive’s input port. 

2. Plug the USB connector on the USB cable into a free USB port on your computer (Figure 
281).   

 

 

Figure 281: Plug the USB connector into the computer’s USB port. 
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Troubleshooting 

You may have to wait 30 seconds or so for the operating system to recognize the SSD drive after 
it is plugged in.  

Windows AutoPlay 

If your computer is configured to run AutoPlay when a USB drive is plugged in, the following 
AutoPlay window appears: 
 

 

Figure 282: The Windows AutoPlay window. 

Click Cancel to prevent Windows from scanning the 1.2 million files on the drive. 

Accessing TheSkyX Pro Database Add On Catalogs 

Configuring TheSkyX Professional Edition to use the Database Add On star catalogs and photos 
from Digitized Sky Survey is straightforward.   
 
1. Launch TheSkyX Professional Edition. 
2. From TheSkyX Pro, select the Database Manager command from the Input menu. 
3. In the list of databases, expand the Database Add On, then highlight Database Add On. 
4. Click the Choose Folder button. 
5. Select the volume name (Mac) or drive letter (Windows) for the drive and click the Choose 

button.  The Property table now shows the location of the files on the Database Add On hard 
drive. 

6. Click Close. 
 
The Sky Chart can now show all the stars from the UCAC3, UCAC4 and NOMAD star catalogs at 
small fields of view.   
 
When the Disc Or Other Drive option is turned on from the Create Photo tab on the Digitized 
Sky Survey window (Tools menu), photos from the Digitized Sky Survey will be retrieved from the 
hard drive when the Show Digitized Sky Survey Photo command is selected from the Tools menu.  

NOMAD Catalog Notes 

 

• Stars from the NOMAD catalog only appear at one-degree fields of view and smaller. 
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• Unlike most astronomical catalogs, the NOMAD catalog does not have a unique numerical 
identifier for each star, so there's no way to search, for example, NOMAD 1000000000.  
Use the NOMAD star’s right ascension and declination coordinates to locate it. 

• In order to show stars from the NOMAD catalog, the NOMAD folder with the native 
NOMAD catalog data must also contain the Software Bisque proprietary 35 GB 
nomad.plot file.  If this file is not present, TheSkyX Professional Edition will not display 
NOMAD stars.  (Bandwidth limitations prevent Software Bisque from offering this file for 
download and creating the NOMAD plot file, even on a 12-core machine, requires several 
days of uninterrupted computer time.) 

Copying Database Add On to another Drive 

The files and folders on TheSkyX Professional Edition Database Add On hard drive are not copy 
protected, and can by moved to, or copied to a different hard drive (subject to the Copyright 
Notices below).   
 
If you want to copy the databases to a different drive, make sure to copy the entire contents of 
TheSkyX Professional Edition Database Add On drive to the second drive, then configure TheSkyX 
Pro accordingly (see “Accessing TheSkyX ” on page 640). 

Copyright Notices 

TheSkyX Professional Edition Database Add On is a compilation of copyrighted astronomical 
catalogs from various sources.  Please carefully read the copyright information below. 

TheSkyX Professional Edition Optimized UCAC and NOMAD Catalogs 

TheSkyX Professional Edition-specific plot files that are included on TheSkyX Pro Database Add On 
hard drive are copyright 2016, Software Bisque, Inc.  They are licensed to you for private, non-
commercial use with TheSkyX Professional Edition and cannot be redistributed. 

Palomar Sky Survey 

The data supplied in the Palomar folder is licensed under agreements between the Association 
of Universities for research in Astronomy, Inc (AURA), the UK Astronomy Technology Centre, ROE 
and Software Bisque, Inc. 
 
This dataset is distributed for scientific and educational use, primarily to amateur astronomers 
and educational institutions. Redistribution of this dataset is prohibited without explicit 
permission from STScI and ROE. 

UCAC and NOMAD Catalog Copyrights 

This catalog contains data from a diverse collection of photographs, reductions, and catalogs.  
Many different organizations claim copyright and/or intellectual property rights on the various 
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components.  Although the details differ, all permissions for usage of data are contingent on 
unrestricted access. Distribution and/or other direct costs can be recovered, but re-packaging, 
re-formatting, or similar activities, especially for commercial purposes, are not permitted except 
as authorized by the U. S. Naval Observatory in consultation with the other institutions listed 
below and as appropriate. 
 

• Palomar Observatory, National Geographic Society, and California Institute of Technology 
own Palomar Observatory Sky Surveys I and II. 

• European Southern Observatory. 

• The UK Particle Physics and Astronomy Research Council (formerly Science and 
Engineering Research Council and before that Science Research Council). 

• The Anglo-Australian Telescope Board. 

• The Hipparcos and Tycho Teams on behalf of the European Space Agency. 

• Space Telescope Science Institute on behalf of AURA, Inc. and NASA. 

• U.S. Naval Observatory on behalf of the U.S. Government. USNO claims domestic and 
international copyright protection for the digitized images, the data reduction, catalog 
compilation, and all other aspects of the derived products.  

• Funding for the APASS was provided by the Robert Martin Ayers Sciences Fund. 
 
When using data from this catalog, please acknowledge the source of the data, and if 
appropriate, please include a specific citation. 

Database Add On Hard Drive Warranty Information 

Software Bisque warrantees all product media for 30 days from the date of purchase and will 
replace it free of charge (please return defective media to Software Bisque).  Proof of purchase 
is required for warranty replacements.   

Backing Up the Databases 

As with all removable media, Software Bisque strongly recommends that you make a backup copy 
of the contents of the Database Add On hard drive. 
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Appendix B: Migrating from TheSky6 to TheSkyX 

If you are familiar with TheSky6, please review the table of changes below to ease the transition 
to TheSkyX. 

Terminology Changes 

This phrase or command in TheSky6… Is now this in TheSkyX… 

Chart Mode Map Like option, Display menu, page 251. 
 

Comets/Minor Planets/Extended Minor 
Planets 

Small Solar System Bodies command, page 
244. 
 

Data Menu Input Menu. 
 

Data Wizard Advanced Query, page 289. 
 

Data Wizard Results Observing List, page 288. 
 

Daytime Sky Mode Show Daylight, page 57. 
 

Display Explorer Chart Elements, page 236. 
 

Display Properties Chart Attributes, page 236. 
 

Eclipse Finder Solar and Lunar Eclipse Viewer, page 184. 
 

Extended Labels Detailed Labels, page 80. 
 

Extended Minor Planets Asteroids (Large Database), page 245. 
 

Image Groups Place Photos, page 99. 
 

Image Link and Sync Synchronize on an Image Link photo, page 
379 
 

Image Manager (Data Menu) Place Photo, page 99. 
 

Images Photos, page 95. 
 

Import command Create Sky Database command, page 274. 
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This phrase or command in TheSky6… Is now this in TheSkyX… 

Mapping/Map Points Pointing Calibration/Pointing Samples.  See 
the TPoint Add On User Guide for details 
about pointing calibration. 
 

Minor Planets Asteroids, page 245. 
 

Mirror Image Show Mirror Image, page 49. 
 

Moon Phase Calendar Calendar, page 135. 
 

Moon Viewer Moon Photo Viewer, page 170. 
 

N/E Indicator Celestial North Arrow (Chart Elements 
window, page 236). 
 

Night Vision Mode Show Night Vision Mode. 
 

Options command Preferences (Tools Menu, Windows) page 
201. 
 

Pole Up Celestial Sphere, Orientation menu, page 44. 
 

Print Preview  Export Chart, page 164. 
 

Real Mode Options Horizon & Atmosphere Options, page 259, 
and Milky Way Options, page 267. 
 

Sky Database Manager Database Manager, page 269. 
 

Sky Display Sky Chart, page 32. 
 

Sky Document Sky Chart Settings, page 57. 
 

Sky View Preferences Chart Element Attributes, page 236. 
 

Stellar & Solar System Update Frequency  Target Frame Rate, page 225 .   
 
Solar system object updates now occur 30 
times per second by default, rather than once 
every 5 minutes as did TheSky6. 
 

Sun & Moon Report Reports, page 149. 
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This phrase or command in TheSky6… Is now this in TheSkyX… 

Sync command  Startup pop-up menu on the Telescope 
window (Display menu), page 377. 
 

Use Computer’s Clock Computer Clock, page 223. 
 

User-Defined Data My Chart Elements, page 283. 
 

User-Defined Object Types My Object Types, page 49. 
 

View Menu Display Menu. 
 

Virtual Sky Mode Photo Like, page 251. 
 

Zenith Up Terrestrial Sphere Orientation, page 150. 
 

 

TheSky6 Feature Equivalent TheSkyX Feature 

Changing Font Colors 
 

Edit the Attributes of Chart Elements (page 
236). 

Defining Telescope Limit Lines Click the Telescope Limits command from the 
Telescope menu. 

Edit or Draw the Local Horizon  Click the Horizon & Atmosphere command 
on the Display menu. 
Click the Horizon tab. 
Select the Custom Drawn option in the 
Horizon Type list. 

Object Tips (Tool Tips) 
 

Click the Preferences command from the 
Tools menu (Windows) or TheSkyX menu 
(Mac). 
Click the Report Setup icon. 
Select Tool Tips from the Report list.  
Turn on the desired Object Properties to 
appear in the tool tip. 
 

Right-click to drag the screen 
 

Left-click the mouse to drag the Sky Chart. 

Setting the Upper and Lower Magnitude Limits Setting the magnitude limit, page 158. 

Showing Labels (common labels and extended 
labels) on Sky Chart 

Labels (for common names and detailed 
labels) are located on the Labels window.  
Click Labels command on the Display menu 
to show this window. 
 

Showing Reference Lines and Reference Photos, 
including: 

Reference lines can be turned on or off from 
the Chart Elements window (page 254).  
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TheSky6 Feature Equivalent TheSkyX Feature 

Constellation Figures 
Constellation Drawings 
Constellation Boundaries 
Galactic Equator 
Milky Way 
Equatorial lines (equatorial grid and North/East 
Indicator) 
Horizon 
Ecliptic 
Telescope Limit Lines 
Horizon-based lines, including the local horizon, 
refracted horizon, meridian and horizon grid 
Local Horizon Fill Color 
 

Zoom Box Press and hold the SHIFT key while dragging 
the mouse on the Sky Chart to create a zoom 
box. 
 

TheSky6 and TPoint for Windows Settings 

TheSky6 can open and save a variety file formats.  The follow section describes each format and 
how to transition your existing data to TheSkyX.  

Sky Documents 

• By default, TheSkyX uses your computer’s IP address to determine your location.  TheSkyX 
also has a To Google Map option that can be used verify and refine your location.  If you have 
the GPS coordinates of your observing site, then you can enter them manually, as well as your 
time zone,  from the Input > Location > Custom tab (page 36). 

• TheSkyX uses the computer’s local time by default.  See “Entering the Date and Time (Date & 
Time Control)” on page 140 for details how to set a specific date and time. 

Field of View Indicators 

• TheSky6 stores your custom field of view indicators in a text file named Field of View 
Indicators.txt in the folder named <My Documents>\Software Bisque\TheSky6\Field of View 
Indicators.  

 
TheSkyX also stores FOVIs in a text file of the same name, but in the folder named <My 
Documents>\Software Bisque\TheSkyX Professional Edition\Field of View Indicators.  The format 
of TheSky6's Field of View Indicators.txt text file the same as TheSkyX.  So, you can copy TheSky6's 
Field of View Indicators.txt to TheSkyX’s folder to preserve your FOVIs.  
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Telescope Configuration 

• Telescope-configuration is a manual process.  You'll need to manually set the telescope and 
the telescope settings (telescope type, COM port, limit settings, etc.) from TheSkyX.  

• Use TheSky6 to park the telescope.  Then connect to the telescope from TheSkyX and, without 
slewing the telescope, on the Telescope window, from the Shut Down pop-up menu, 
configure TheSkyX’s park position by clicking the Set Park Position command (page 375). 

TPoint for Windows Settings and Models 

Important Note: TPoint for Windows is not compatible with TheSkyX Professional Edition.  
TheSkyX Professional Edition instead now offers the integrated TPoint Add On. 
 

• In TheSky6, the TPoint for Windows model is saved as part of the Sky Document (.SKY) 
document.  TPoint for Windows is a separate application.  In TheSkyX, the can be purchased 
as an "Add On" but is an integrated component and is accessed by clicking the Telescope > 
TPoint Add On command at any time (there's a 90-day free trial period to use the TPoint Add 
On).  

To transfer an existing TPoint for Windows model to TheSkyX Pro and the TPoint Add On 

1. From TheSky6, open the TPoint document by right-clicking on the TPoint icon, and then click 
Open.  This launches TPoint for Windows and opens the .tpt document with the model.  

2. From TPoint for Windows, click the Export command from the File menu, then enter a name 
for the text file that will hold your exported mapping data.  This “pointing data” can be 
imported into the TPoint Add On.  

3. From TheSkyX, click the TPoint Add On command from the Telescope menu.  
4. From the TPoint Add On Setup tab, select the Import command from the TPoint Add On 

Settings pop-up menu.  
5. Select the text file name that holds the TPoint for Windows pointing data and then click Open.  
 
The TPoint Add On now has your pointing data, and you can turn on the desired terms for your 
model.  A recalibration will be required to restore the CH, IH and ID terms (the telescope’s 
“synchronization” information).  See the TPoint Add On User Guide for more information about 
recalibration 

Comets/Asteroids/Satellites 

• The latest orbital elements and two-line elements TLEs for these objects will need to be 
downloaded from TheSkyX.  See page 183 for details. 

Sky Databases 

A folder of TheSky6 SDBs can be converted to TheSkyX-compatible Sky Database format (.SDBX) 
from the Advanced tab of TheSkyX’s Database Manager (page 272). 
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Importing Photographic Horizons 

If you have created a photographic horizon for TheSky6 for Windows and want to show it in 
TheSkyX do the following: 
 
1. Open the tagged image format (.tif) photograph from TheSky6 for Windows in your favorite 

image processing software. 
2. Save the photo as a PNG (see “Tips for Creating Panorama Photos” on page 263). 
3. Copy the PNG photo to the appropriate folder and select it as the current panoramic horizon 

(see “Selecting the Panorama Photo” on page 263). 
 
In TheSky6, the orientation of the photographic horizon relative to the local horizon is stored in 
a file with the extension <Horizon Name>.horizon.  If you wish to maintain this position for the 
same photograph in TheSkyX, do the following: 
 
1. Manually copy TheSky6’s <Horizon Name>.horizon file for the particular photo into the 

Horizons folder (see “Selecting the Panorama Photo” on page 263).   
 
When the panoramic horizon is selected in TheSkyX, the appropriate horizon photo options are 
set based on the contents of the <Horizon Name>.horizon file, so that the photo is oriented 
correctly. 

Importing Custom Drawn Horizons 

TheSkyX can display custom-drawn horizons that were created in TheSky6.  TheSky6’s custom 
drawn horizon data must be saved in a TheSkyX-compatible format first. 
 
Here’s how: 
 
1. Launch TheSky6. 
2. Choose the Reference Lines command from the View menu. 
3. Click the Edit Local Horizon button to show the Horizon Editor window. 
4. On the Horizon Editor window, click the Copy button to copy the horizon’s azimuth and 

altitude positions to the Clipboard. 
5. Launch Windows Notepad. 
6. From Notepad, type the number 360 and press the Enter key.   
7. From Notepad, choose the Paste command from the Edit menu. 
8. From Notepad, choose the Save As command from the File menu. 
9. On the Save As window, navigate to TheSkyX’s Application Support Files Folder (see page 26). 
10. In the File Name text box of the Save As window, type the name custom horizon.hrz 

and click the Save button. 
 
When TheSkyX is launched, and Custom Horizon is selected in the Horizon Type pop-up menu on 
the Horizon tab of the Horizon and Atmosphere Options window (Display menu), this custom 
horizon exported from TheSky6 will appear. 
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Appendix C: Daylight Saving Time  

The following table lists the international Daylight Saving Time (DST) starting and ending dates 
that TheSkyX uses to determine when DST begins and ends. 

 

The Time Zone options are found in the Daylight Saving Option (DSO) pop-up. 
 

Time Zone DST Starts DST Ends Adopting Countries 

Australia-
NSW  

Last Sunday 
of October 

Last Sunday of March Australia (Australian Capital 
Territory, Lord Howe Island, 
New South Wales)  
  

Australia-
South  

Last Sunday 
of October 
  

Last Sunday of March Australia (Broken Hill NSW, 
South Australia, Victoria)  
  

Brazil  Third 
Sunday of 
October   

Third Sunday of 
February 

Brazil  
  

Chile  Second 
Sunday of 
October  

Second Sunday of 
March 

Chile  
  

China  Third 
Sunday of 
April 
  

Second Sunday of 
September 

China  
  

Cuba  First 
Sunday of 
April  

Second Sunday of 
October  

Cuba  
  

Egypt  First Day of 
May  

First Day of October  Egypt  
  

Europe  Last Sunday 
of March 

Last Sunday of October  Albania, Andorra, Austria, 
Belarus, Belgium, Bosnia 
Herzegovina, Bulgaria, Croatia, 
Cyprus, Czech Republic, 
Denmark, Estonia, Faroe 
Islands, Finland, France, 
Georgia, Germany, Gibraltar, 
Greece, Greenland 
(Scoresbysund), Hungary, Italy, 
Kazakhstan, Latvia, Lebanon, 
Lithuania, Luxembourg, 
Macedonia, Malta, Monaco, 
Mongolia (Ulan Bator), 
Netherlands, Norway, Poland, 
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Time Zone DST Starts DST Ends Adopting Countries 

Portugal, Romania, Russian 
Federation, San Marino, 
Slovakia, Slovenia, Spain, 
Sweden, Switzerland, Turkey, 
Ukraine, Yugoslavia  
  

Falkland 
Islands 

Second 
Sunday of 
September  

Third Sunday of April  Falkland Islands  

Greenland  Last Sunday 
of March 

Fourth Sunday of 
September 

Greenland (except 
Scoresbysund and Thule)  
  

Iran  21st Day of 
March 

21st Day September  Iran  
  

Israel  Last Friday 
of March 

Last Sunday of August Israel  
  

Jordan  First Friday 
of April  

Third Friday of 
September 

Jordan  
  

Kyrgyzstan  Second 
Sunday of 
April 

Last Sunday of 
September 

Kyrgyzstan  
  

Moldova  First 
Sunday of 
March 

Last Sunday of 
September 

Moldova  
  

Namibia  First 
Sunday of 
September 

First Sunday of April  Namibia  
  

New 
Zealand  

First 
Sunday of 
October 

Third Sunday of March  New Zealand  
  

U.S. and 
Canada 

Second 
Sunday of 
March 

First Sunday of 
November  

Begins March 2007 
  
Bahamas, Bermuda, Canada, 
Greenland (Thule), Mexico, St. 
Pierre and Miquelon, Turks and 
Caicos Islands, United States of 
America  
  

Paraguay  First 
Sunday of 
October 

Last Sunday of February Paraguay  
  

Syrian  First Day of 
April 

First Day of October Iraq, Syria 
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Time Zone DST Starts DST Ends Adopting Countries 

Tasmania  First 
Sunday of 
October 
  

Last Sunday of March  Tasmania  

United 
Kingdom  

Last Sunday 
of March 

Last Sunday of October England, Ireland, Isle of Man, 
Scotland, Wales  
  
  

Mexico First 
Sunday of 
April 
  

Last Sunday of October Mexico 
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Appendix D: Macro Commands 

The table below lists the macro commands that can run at waypoints in tours. 
 

Command Name 
Number of 
Arguments Argument 1 Argument 2 Argument 3 Argument  4 Argument 5 

SetVisible 2 Object type Visible    

SetMagFaintest 2 Object type Magnitude    

SetMagBrightest 2 Object type Magnitude    

SetSizeMin 2 Object type Size (arcmins)    

SetSizeMax 2 Object type Size (arcmins)    

SetPenStyleWidth 3 Object type 
Pen style 
(0=none) Pen width   

SetPenColor 5 Object type Red Green Blue Alpha 

SetFillRgb 5 Object type Red Green Blue Alpha 

SetFontRgb 5 Object type Red Green Blue Alpha 

SetFontFamilySize 3 Object type Family name Point size   

SetSymbolSVG 3 Object type SVG filename Size(mm)   

ToggleVisible 1 Object type     

SetExtendLabel 4 Dataset/Type Database Field Value  

AddObject 4 RA Dec Type Magnitude  

AddLabel 3 RA Dec Label   

AddArrow 4 RA Dec Width Height  

AddAreaOfInterest 3 RA Dec Size   

AddChartScale 2 RA Dec    

AddTelrad 2 RA Dec    

AddMoveTo 2 RA Dec    

AddLineTo 2 RA Dec    

AddPolyPoint 2 RA Dec    

AddEllipse 5 RA Dec Major axis Minor axis 
Position 
Angle 

AddSVG 4 RA Dec File name Size  

ClearUserData 0      

SetRefFrame 1 Frame     

SetDefaultType 1 Object type     

SetConstlLine 2 Constellation On/Off    

SetConstlBoundary 2 Constellation On/Off    

SetConstlDrawing 2 Constellation On/Off    

SetConstlLabel 2 Constellation On/Off    

ConstlLinesUpdate 0      

LaserPointer 3 RA Dec Duration   

Fade 1 Seconds     

Zoom 1 Degrees     

Center 1 Object name     

Frame 1 Object name     

TourIncrement 1 Days     

TourText 3 Text Height Position   

 





Page 655 

Appendix E: Constellation Abbreviations 

(And) Andromeda (Cru) Crux Australis (Ori) Orion 

(Ant) Antlia (Cyg) Cygnus (Pav) Pavo 

(Aps) Apus (Del) Delphinus (Peg) Pegasus 

(Aqr) Aquarius (Dor) Dorado (Per) Perseus 

(Aql)Aquila (Dra) Draco (Phe) Phoenix 

(Ara) Ara (Equ) Equuleus (Pic) Pictor 

(Ari) Aries (Eri) Eridanus (Psc) Pisces 

(Aur) Auriga (For) Fornax (PsA) Pisces Australis 

(Boo) Bootes (Gem) Gemini (Pup) Puppis 

(Cae) Caelum (Gru) Grus (Pyx) Pyxis 

(Cam) Camelopardus (Her) Hercules (Ret) Reticulum 

(Cnc) Cancer (Hor) Horologium (Sge) Sagitta 

(CVn) Canes Venatici (Hya) Hydra (Sgr) Sagittarius 

(CMa) Canis Major (Hyi) Hydrus (Sco) Scorpius 

(CMi) Canis Minor (Ind) Indus (Scl) Sculptor 

(Cap) Capricornus (Lac) Lacerta (Sct) Scutum 

(Car) Carina (Leo) Leo (Ser) Serpens 

(Cas) Cassiopeia (LMi) Leo Minor (Sex) Sextans 

(Cen) Centaurus (Lep) Lepus (Tau) Taurus 

(Cep) Cepheus (Lib) Libra (Tel) Telescopium 

(Cet) Cetus (Lup) Lupus (Tri) Triangulum 

(Cha) Chamaeleon (Lyn) Lynx (TrA) Triangulum Australis 

(Cir) Circinus (Lyr) Lyra (Tuc) Tucana 

(Col) Columba (Men) Mensa Berenices (UMa) Major Ursa 

(Com) Coma Berenices (Mic) Microscopium (UMi) Ursa Minor 

(CrA) Corona Australis (Mon) (Vel) Vela 

(CrB) Corona Borealis (Mus) Musca (Vir) Virgo 

(Crv) Corvus (Nor) Norma (Vol) Volans 

(Crt) Crater (Oct) Octans (Vul) Vulpecula 

 (Oph) Ophiuchus  
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Appendix F: TheSkyX Pro Automation Model 

 
 
TheSkyX Professional Edition can be scripted using TheSkyX Scriptable Objects.  Documentation 
is available on the web at http://www.bisque.com/scripttheskyx. 
 
For third-party developers using TheSky6’s object model, note that TheSkyX Professional Edition’s 
automation model interface, for the most part, mirrors TheSky6 Professional Edition.  Click on the 
Modules tab on the above web page for details about TheSkyX objects and TheSky6 Classic 
Objects.  See ScriptTheSkyX Documentation and Source Code Examples at ScriptTheSkyX 
Documentation and Source Code Examples on the Software Bisque Downloads page for scripting 
documentation and source code examples.  The URL to this page is:  
http://www.bisque.com/sc/media/p/44090.aspx.  
 
TheSkyX Pro can replace or be exchanged for TheSky6 Pro as far as automation is concerned, the 
only caveat is that controlling programs (clients) need to use TheSkyX Pro’s program identifiers 
(or program ids) in place of TheSky6 Pro’s program identifiers.  
 
For example, if your existing script or application source code references TheSky6 Pro’s StarChart 
object: 
 
TheSky6.StarChart  
 
To use TheSkyX Pro’s StarChart object, replace the above syntax with: 
 
TheSkyXAdaptor.StarChart   
 
Your application will now use TheSkyX Professional Edition’s StarChart object instead of TheSky6 
Pro’s StarChart object. 
 
The table below includes a complete list of TheSky6 Pro and TheSkyX Pro program ids. 
 

TheSky6 Pro Program ID Equivalent TheSkyX Pro Program ID 

TheSky6.DataWizard  TheSkyXAdaptor.DataWizard 

TheSky6.MyFOVs TheSkyXAdaptor.MyFOVs  

TheSky6.ObjectInformation TheSkyXAdaptor.ObjectInformation 

TheSky6.RASCOMTele TheSkyXAdaptor.RASCOMTele 

TheSky6.RASCOMTheSky TheSkyXAdaptor.RASCOMTheSky 

TheSky6.RASServerApp TheSkyXAdaptor.RASServerApp 

TheSky6.Raven TheSkyXAdaptor.Raven 

TheSky6.StarChart TheSkyXAdaptor.StarChart 

TheSky6.Utils  TheSkyXAdaptor.Utils  

 

http://www.bisque.com/scripttheskyx
http://www.bisque.com/sc/media/p/44090.aspx
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The Windows-specific Visual Basic (VB) code below shows an example how to use the StarChart 
object in either TheSky6 Pro or TheSkyX Pro.  Note that both applications can be installed and run 
on the same computer, and both object models can be accessed on a single computer, without 
issue. 
 
Dim StarChart    
‘Remove the tic mark below to use TheSky6 
‘Set StarChart = CreateObject("TheSky6.StarChart")    
 
‘The following line will use TheSkyX Pro’s StarChart object 
Set StarChart = CreateObject("TheSkyXAdaptor.StarChart")  

Automation and User Account Control 

In an effort to minimize the spread of malware, Windows operating systems employ User 
Account Control (UAC) which attempts to prevent unwanted or unauthorized changes to the 
operating system. 
 
UAC, unfortunately, may also prevent wanted or necessary changes to your computer.  For 
example, when TheSkyX Professional Edition is launched, it attempts to “register” COM 
automation interfaces in the Window Registry. 
 
By default, UAC blocks the registration, so that attempts to access TheSkyX Professional Edition’s 
automation interfaces in an external script (or by a third-party observatory automation 
application) are not possible. 
 
The workaround is to run TheSkyX Professional Edition as an Administrator to elevate the 
account’s privileges and allow changes to the Windows Registry. 
 
To run TheSkyX Professional Edition as an Administrator: 
 
1. Right-click on TheSkyX Professional Edition icon. 
2. Click the Run As Administrator command. 
 

http://windows.microsoft.com/en-US/windows-vista/What-is-User-Account-Control
http://windows.microsoft.com/en-US/windows-vista/What-is-User-Account-Control
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Appendix G: TheSkyX Pro Device Driver Architecture 

 
 
TheSkyX Professional Edition’s X2 Standard provides a cross-platform, plug in device driver 
architecture that allows third-party software developers and hardware manufacturers to develop 
and distribute TheSkyX Professional Edition-compatible software drivers for astronomical devices 
(mounts, cameras, rotators, focusers, and domes). 
 
Documentation and source code examples are available at: 
 
http://www.bisque.com/x2. 
 

http://www.bisque.com/x2
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Appendix H: TheSkyX Change Log 

The list of improvements, changes and bug fixes to TheSkyX Professional Edition and TheSkyX 
Serious Astronomer Edition is available at the following URL: 
 
http://www.bisque.com/sc/pages/TheSkyXChangeLog.aspx  
 

http://www.bisque.com/sc/pages/TheSkyXChangeLog.aspx
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Appendix I: Keyboard Shortcuts 

The table below lists TheSkyX’s main menu commands and the appropriate Mac and Windows 
keyboard shortcuts.  Menu commands without a keyboard shortcuts are left blank. 
 

Menu Command or Pop-Up 
Menu 

Keyboard Accelerator 

Mac Windows 

TheSkyX (Mac only) 

 About TheSkyX   

 Preferences COMMAND+, (,)  
 Hide TheSkyX COMMAND+H, (H)  

 Hide Others SHIFT+COMMAND+H (H)  

 Show All    

File 

 New COMMAND+N (N) CONTROL+N (CTRL+N) 
 Open COMMAND+O (O) CONTROL+O (CTRL+O) 

 Save COMMAND+S (S) CONTROL+S (CTRL+S) 

 Save As SHIFT+COMMAND +S (S) CONTROL+SHIFT+S (CTRL+SHIFT+S) 

 Print COMMAND+P (P) CONTROL+P (CTRL+P) 

 Print Setup SHIFT+COMMAND +P (P) CONTROL+SHIFT+P (CTRL+SHIFT+P) 
 Export Chart   

 Exit n/a CONTROL+Q (CTRL+Q) 

Edit 

 Find COMMAND+F (F) CONTROL+F (CTRL+F) 

 Paste Photo COMMAND+V (V) CONTROL+V (CTRL+V) 

 Copy COMMAND+C (C) CONTROL+C (CTRL+C) 
Display 

 Photo Like OPTION+COMMAND+P (⌥P) CONTROL+ALT+P 

 Map Like OPTION+COMMAND+K (⌥K) CONTROL+ALT+K (CTRL+ALT+K) 

 Celestial Objects 
Pop-Up 

  

 Show Stars   

 Show Variable Stars   

 Show Double Stars   

 Show Clusters   
 Show Galaxies    

 Show Nebulas   

 Field of View 
Indicators 

COMMAND+6 (6) CONTROL+6 (CTRL+6) 

 Show Mirror Image   
 Full Screen COMMAND+F8 (F8) CONTROL+F8 (CTRL+F8) 

 Show Daylight OPTION+COMMAND+A (⌥A) CONTROL+ALT+A (CTRL+ALT+A) 

 Show Night Vision 
Mode 

OPTION+COMMAND+J (⌥J) CONTROL+ALT+J 

 Constellation & 
Asterism Options 

  

 Horizon & 
Atmosphere Options 

  

 Star Options   

 Milky Way Options   
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Menu Command or Pop-Up 
Menu 

Keyboard Accelerator 

Mac Windows 
 Find   

 Date And Time   

 Labels   

 Photos   

 Chart Elements   

 Tours   
 Observing List   

 Chart Status   

 Telescope-Specific 
Commands 

  

 Nexstar   

 Meade   

 Astro-Physics   

 iOptron   

 Gemini   

Orientation    
 Look Pop-Up 

 Look North OPTION+COMMAND+N CONTROL+ALT+N 

 Look South OPTION+COMMAND+S CONTROL+ALT+S 

 Look East OPTION+COMMAND+E CONTROL+ALT+E 

 Look West OPTION+COMMAND+W CONTROL+ALT+W 
 Look Up OPTION+COMMAND+Z CONTROL+ALT+Z 

 Zoom To Pop-Up   

 Minimum 30' OPTION+COMMAND+END (⌥) CONTROL+ALT+END 

 Telescope 1° OPTION+COMMAND+T (⌥T) CONTROL+ALT+T (CTRL+ALT+T) 

 Finder 10° OPTION+COMMAND+F (⌥F) CONTROL+ALT+F (CTRL+ALT+T) 

 Binocular 50° OPTION+COMMAND+B (⌥B) CONTROL+ALT+B (CTRL+ALT+B 

 Naked Eye 100° OPTION+COMMAND+Y (⌥Y) CONTROL+ALT+Y (CTRL+ALT+Y) 

 Wide Field 180° OPTION+COMMAND+I (⌥I) CONTROL+ALT+I (CTRL+ALT+I) 

 Maximum  OPTION+COMMAND+HOME (⌥) CONTROL+ALT+HOME (CTRL+ALT+HOME) 

 Move Pop-Up 

 Move Up SHIFT+ () SHIFT+UP ARROW (SHIFT+UP) 
 Move Down SHIFT+ () SHIFT+DOWN ARROW (SHIFT+DOWN) 

 Move Left SHIFT + () SHIFT+LEFT ARROW (SHIFT +LEFT ARROW) 

 Move Right SHIFT + () SHIFT+RIGHT ARROW (SHIFT+RIGHT 
ARROW) 

 Navigate Pop-Up 
 Zoom In SHIFT+PAGE DOWN (⌥) SHIFT+PAGE DOWN (SHIFT +PGDOWN) 

 Zoom Out SHIFT+PAGE UP (⌥) SHIFT+PAGE UP (SHIFT +PGUP) 

 Terrestrial Sphere OPTION+1 (⌥ 1) ALT+1  

 Celestial Sphere OPTION+2 (⌥ 2) ALT+2  

 Free Rotation   
 Rotate Clockwise OPTION++ (⌥ +) ALT++  

 Rotate 
Counterclockwise 

OPTION+– (⌥ –) ALT+–  

Input  

 Location COMMAND+L (L) CONTROL+L (CTRL+L) 
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Menu Command or Pop-Up 
Menu 

Keyboard Accelerator 

Mac Windows 
 Date and Time COMMAND+T (T) CONTROL+T (CTRL+T) 

 Small Solar System 
Bodies 

COMMAND+1 (1) CONTROL+1 (CTRL+1) 

 Satellites COMMAND+2 (2) CONTROL+2 (CTRL+2) 

 Database Manager COMMAND+3 (3) CONTROL+3 (CTRL+3) 
 Create Sky Database COMMAND+4 (4) CONTROL+4 (CTRL+4) 

 My Chart Elements COMMAND+5 (5) CONTROL+5 (CTRL+5) 

Tools 

 Manage Observing 
List 

COMMAND+M (M) CONTROL+M (CTRL+M) 

 Rotate Tool COMMAND+R (R) CONTROL+R (CTRL+R) 

 Angular Separation & 
Position Angle 

SHIFT+COMMAND+R (R) CONTROL+SHIFT+R (CTRL+SHIFT+R) 

 Tours   

 Create Tour   
 Conjunction Finder   

 Solar and Lunar 
Eclipse Viewer 

  

 Calendar   

 Moon Photo Viewer   
 Reports    

 Iridium Flares   

 Object Paths   

 Solar System   

 3D Stars   
 Satellites from Above 

Earth 
  

 Image Link SHIFT+COMMAND+I (I) CONTROL+SHIFT+I (CTRL+SHIFT+I) 

 Mosaic Grid   

 Place Photo   
 Time Skip Pop-Up 

 Computer Clock OPTION+N (⌥N) ALT+N 

 Go Forward OPTION+> (⌥>) ALT+> 

 Step Forward OPTION+] (⌥]) ALT+] 

 Stop   

 Step Backward OPTION+[ (⌥[) ALT+[ 

 Go Backward OPTION+< (⌥<) ALT+< 

 Object Paths   

 Verify TheSkyX Time   

 Open FITS SHIFT+COMMAND+O (O) CONTROL+SHIFT+O (CTRL+SHIFT+O) 

 Digitized Sky Survey   

 Preferences 
(Windows Only) 

 CONTROL+, (CTRL+,) 

Telescope 

 Telescope Setup   

 Connect   
 TPoint Add On   

 Telescope Limits   

 Digital Setting Circles   

Help 
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Menu Command or Pop-Up 
Menu 

Keyboard Accelerator 

Mac Windows 
 Search (Mac only)   

 TheSkyX Help   

 TheSkyX User Guide   

 About TheSkyX 
(Windows only) 

  

FITS Viewer Window 

 Photo Pop-Up   

 Open   

 Save   

 Save As   
 Print   

 File Information   

 Zoom In COMMAND+= (=) CONTROL+= (CTRL+=) 

 Zoom Out COMMAND+– (–) CONTROL+- (CTRL+–) 

 Zoom Normal   

 Actual Pixels OPTION+COMMAND+0 (⌥0) CONTROL+ALT+0 (CTRL+ALT+0) 

 Clear   

 To Image Link   
 Close   

 
Mac Keyboard Key Accelerator Symbols 

 

Symbol Equivalent Keyboard Key 
 Command key 

⌥ Option/Alt key 
 Shift key 
 Page down 
 Page up 
 Home 
 End 
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Appendix J: Object Properties 

TheSkyX includes a myriad of standard astronomical catalogs with a wide-range of information 
on each object.  It provides the ability to create observing lists using open-ended database 
queries, as well as customize the information displayed for each object. 
 
The table below lists the breakdown of database parameters that can appear in observing list 
reports, on tool tips and on the Object Information Report. 
 

Object Property  Description 

Active Specifies whether the object type (satellites and 
asteroids only) is visible on the Sky Chart. 
 
0 = Not active 
1 = Active 
 

Air Mass Estimate of air mass at the current position. 
 

Alt Rate (arcsecs/sec) Rate at which the object is moving, in altitude. 
 

Altitude The angular distance from horizontal. 
 

Altitude w/Refraction The angular distance from horizontal, including 
refraction. 
 

Angular Separation (Prior Object) The angular separation from the previous target object. 
 

Apparent Angular Diameter The apparent angular diameter of the object. 
 

Apparent Magnitude The object’s apparent magnitude. 
 

Astronomical Twilight End The time of day when the sun is 18 below the horizon 
after sunset (evening). 
 

Astronomical Twilight Start The time of day when the sun is 18 below the horizon 
before sunrise (morning). 
 

Axis Position Angle The position angle, in degrees, of the extended object, 
measured counterclockwise from north. 
 

Az Rate (arcsecs/sec) The rate, in arcseconds per second, at which the current 
target is moving. 
 

Az Rise The azimuth of the target object when it rises. 
 

Az Set The azimuth of the target object when it sets. 
 

Azimuth The azimuth of the target object. 
 

Catalog The name of the astronomical catalog that is used to 
display information about the target object. 
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Object Property  Description 

 

Catalog Identifier The astronomical catalog’s name or abbreviation that 
can be used by the Find command to locate objects.  For 
example, M is the designation for objects from the 
Messier catalog.  Enter M1 in the Find text box locates 
Messier object number 1. 
 

Catalog Number A number or set of characters that uniquely identifies 
the target object in an astronomical database.  For 
example, M42 is the forty second object in the Messier 
catalog. 
 

Celestial Type Displays the celestial object’s type, for example, planet, 
satellite, galaxy, spiral cluster, double star, etc. 
 

Civil Twilight End The time of day when the sun is 6 below the horizon 
after sunset. 
 
 

Civil Twilight Start The time of day when the sun is 6 below the horizon 
before sunrise. 
 

Click Distance The number of screen pixels between successive mouse 
clicks. 
 

Comet Eccentricity The measure of an ellipse's distortion from a circle. This 
defines the shape of the comet's orbit. 
 

Comet Ecliptic The standard year (1950 or 2000) to which the orbital 
elements refer. 
 
 

Comet Inclination The tilt of the comet's orbital plane relative to the plane 
of the ecliptic. 
 

Comet Long. of the Asc. Node The angle, as viewed from the Sun, between the comet 
and the first point of Aries, when the comet passes 
through the plane of the ecliptic from below. 
 

Comet Longitude of Perihelion The comet’s longitude at the perihelion point. 
 

Comet Magnitude 1 The brightness of the comet as seen by a viewer at a 
standard distance. 
 
 

Comet Magnitude 2 A value which represents the change in the comet's 
brightness during its orbit. 
 

Comet Perihelion Day The day at which the object is closest to the Sun. This 
date should be in Universal Time (UT). 
 

Comet Perihelion Distance The distance, in astronomical units, of the comet's 
closest approach to the Sun. 
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Object Property  Description 

 

Comet Perihelion Month The month at which the object is closest to the Sun. This 
date should be in Universal Time (UT). 

Comet Perihelion Year The year at which the object is closest to the Sun. This 
date should be in Universal Time (UT). 
 

Constellation The name of the constellation in which the target object 
resides. 
 

Constellation (Abbrev.) The abbreviation of the constellation in which the target 
object resides. 
 

Constellation Number The constellation number (11-88) in which the target 
object resides. 
 

Date The current date. 
 

DB Field 1 The contents of the custom Sky Database field number 
1. 
 

DB Field 10 The contents of the custom Sky Database field number 
10. 
 

DB Field 11 The contents of the custom Sky Database field number 
11. 
 

DB Field 12 The contents of the custom Sky Database field number 
12. 
 

DB Field 13 The contents of the custom Sky Database field number 
13. 
 

DB Field 14 The contents of the custom Sky Database field number 
14. 
 

DB Field 15 The contents of the custom Sky Database field number 
15. 
 

DB Field 16 The contents of the custom Sky Database field number 
16. 
 

DB Field 2 The contents of the custom Sky Database field number 
2. 
 

DB Field 3 The contents of the custom Sky Database field number 
3. 
 

DB Field 4 The contents of the custom Sky Database field number 
4. 
 

DB Field 5 The contents of the custom Sky Database field number 
5. 
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Object Property  Description 

DB Field 6 The contents of the custom Sky Database field number 
6. 
 

DB Field 7 The contents of the custom Sky Database field number 
7. 
 

DB Field 8 The contents of the custom Sky Database field number 
8. 
 

DB Field 9 The contents of the custom Sky Database field number 
9. 
 

Dec (2000.0) The target object’s declination at equinox 2000.0. 
 

Dec (Topocentric) The target object’s topocentric declination. 
 

Dec Rate (arcsecs/sec) The arcseconds per seconds rate of motion in 
declination for the target object. 
 

Declination of Earth The current declination of Earth. 
 

Declination of Sun The current declination of the Sun. 
 

Defect of Illumination A measure of the widest non-illuminated portion of a 
celestial object, in arcseconds. 
 

Depth of Eclipse  
 

Earth Altitude  

Earth Distance (au) Target object’s distance from Earth, in astronomical 
units. 
 

Eccentricity A measure of an orbit's distortion from circular. 
 

Ecliptic Asteroid’s ecliptic epoch. 
 

Epoch Day Day of the epoch (asteroid). 
 

Epoch Month Month of the epoch (asteroid). 
 

Epoch Year Year of the epoch (asteroid). 
 

Flamsteed-Bayer Target object’s Flamsteed and Bayer designation (when 
available). 
 

Frame Size (arcmins) Minimum angular size, in arcminutes, of the field of view 
that can frame the object. 
 

Geocentric Latitude Target object’s Earth-centered latitude. 
 

Geocentric Longitude Target object’s Earth-centered longitude. 
 

Geocentric Mean Latitude Target object’s Earth-centered mean latitude. 
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Object Property  Description 

 

Geocentric Mean Longitude Target object’s Earth-centered mean longitude. 
 

Geocentric Mean Radius Target object’s Earth-centered mean radius. 
 

Geocentric Radius Target object’s Earth-centered radius. 
 

GSC Block Stars in the GSC are separated into 9537 blocks that 
represent a small region of the sky.  
 
This value is the target object’s Guide Star Catalog block 
offset number.   
 
 

GSC Num Target object’s Guide Star Catalog identifier, for 
example, GSC 9520:526 
 

Height The height, in pixels, of the target object (photos only). 
 

Heliocentric Latitude The target object’s heliocentric latitude. 
 

Heliocentric Radius The target object’s radius when observed from the 
center of the Sun. 
 

Hour Angle The target object’s hour angle. 
 

Inclination The target object’s inclination. 
 

Index The target object’s catalog index number. 
 

Julian Date The current Julian date. 
 

Latitude The target satellite’s longitude. 
 

Light Years The distance, in light years, of the target object from 
Earth. 
 

Long. of the Ascending Node The target asteroid’s longitude of the ascending node 
parameter. 
 

Longitude The target satellite’s longitude. 
 

Longitude of the Central Meridian The longitude of the target object’s central meridian. 
 

Longitude of the Central Meridian (II) The longitude of the target object’s central meridian 
(system II). 
 

Longitude Perihelion The target asteroid’s longitude of perihelion. 
 
 

Mag. 1st Component   The magnitude of the first component of a binary 
system. 
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Object Property  Description 

Mag. 2nd Component The magnitude of the second component of a binary 
system. 
 

Magnitude The target object’s apparent magnitude. 
 

Magnitude 1 The target asteroid’s absolute magnitude (g). 
 

Magnitude 2 The target asteroid’s magnitude constant (k). 
 

Magnitude B The target object’s apparent blue magnitude. 
 

Magnitude R The target object’s apparent red magnitude. 
 

Magnitude V The target object’s apparent violet magnitude. 
 

Major Axis The target object’s major axis, in arcseconds. 
 

Maximum Mag. The target variable star’s maximum magnitude. 
 

Mean Anomaly The target asteroid’s mean anomaly parameter. 
 

Minimum Mag. The target variable star’s minimum magnitude. 
 
 

Minor Axis The target object’s minor axis, in arcseconds. 
 

Moon Alt w/Refraction The Moon’s altitude including refraction. 
 

Moon Angular Diameter The Moon’s angular diameter. 
 

Moon Distance (km) The Moon’s distance from Earth, in km. 
 

Moon Ecliptic Latitude The Moon’s ecliptic latitude. 
 

Moon Ecliptic Longitude The Moon’s ecliptic longitude. 
 

Moon Ecliptic Radius The Moon’s ecliptic radius. 
 

Moon Optical Libration b The Moon’s optical libration (b). 
 

Moon Optical Libration l The Moon’s optical libration (l). 
 

Moon Parallax The Moon’s parallax. 
 

Moon Phase Angle The Moon’s phase angle. 
 

Moon Physical Libration b The Moon’s physical libration (b). 
 

Moon Physical Libration l The Moon’s physical libration (l). 
 

Moon Pos. Angle of Bright Limb The position angle of the Moon’s bright limb. 

Moon Position Angle The Moon’s position angle. 
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Object Property  Description 

Moon Topocentric Ang. Diameter The Moon’s topocentric angular diameter, in 
arcseconds. 
 

Moon Total Libration b The Moon’s total libration (b). 
 

Moon Total Libration l The Moon’s total libration (l). 
 

Moon True Dec The Moon’s true right declination. 
 

Moon True RA The Moon’s true right ascension. 
 

Moon’s Age (Days Past New) The age of the Moon’s phase, in days past the new 
Moon. 
 

Name 10 One of up to ten different aliases for the target object. 
 

Name 2    One of up to ten different aliases for the target object. 
 

Name 3 One of up to ten different aliases for the target object. 
 

Name 4 One of up to ten different aliases for the target object. 
 

Name 5 One of up to ten different aliases for the target object. 
 

Name 6 One of up to ten different aliases for the target object. 
 

Name 7 One of up to ten different aliases for the target object. 
 

Name 8 One of up to ten different aliases for the target object. 
 

Name 9 One of up to ten different aliases for the target object. 
 

Nautical Twilight End The time of day when the sun is 12 below the horizon 
after sunset. 
 

Nautical Twilight Start The time of day when the sun is 12 below the horizon 
before sunrise. 
 

NGC/IC This parameter is reserved for future use. 
 

Non-stellar Fields This parameter is reserved for future use. 
 

Object Name The target object’s common name. 
 

Object Type The target o 
 

Observing Notes This parameter holds observing notes for the target 
object. 

Parallax  
 

Parsecs The distance to the target object, in parsecs. 
 

Penumbra Diameter The diameter of the Earth’s penumbra. 
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Object Property  Description 

 

Period The target object’s orbital period. 
 

Phase (%) The current phase of the target object. 
 

Phase Correction The target object’s phase correction. 
 

Point 3D X The target object’s x-axis position.  
 

Point 3D Y The target object’s y-axis position. 
 

Point 3D Z The target object’s z-axis position. 
 

Polar Diameter The target object’s polar diameter. 
 

Position Angle (Prior Object)  The position angle measured between successive mouse 
clicks on the Sky Chart. 
 

Position Error Dec The target object’s position error in declination. 
 

Position Error Parallax The target object’s parallax error. 
 

Position Error RA The target object’s position error in right ascension. 
 

Proper Motion Dec The target object’s proper motion in declination. 
 

Proper Motion Error Dec The target object’s proper motion error in declination. 
 

Proper Motion Error RA The target object’s proper motion error in right 
ascension. 
 

Proper Motion RA The target object’s proper motion in right ascension. 
 

RA (2000.0) The target object’s equinox 2000.0 right ascension. 
 

RA (Topocentric) The target object’s topocentric right ascension. 
 

RA Rate (arcsecs/sec) The target object’s rate, in arcseconds per second, in 
right ascension. 
 

Radius The target object’s radius. 
 

Range The target satellite’s range, in meters. 
 

Range Rate The target satellite’s range rate. 
 

Ring Axis (a) Saturn’s A ring axis. 
 

Ring Axis (b) Saturn’s B ring axis. 
 

Rise Time The target object’s rise time.   
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Object Property  Description 

Rise/Set Notes Notes indicating whether or not Daylight Saving Time is 
in effect. 
 

Satellite Eclipse This value is set to true when the satellite is eclipsed by 
the Earth. 
 

Satellite Extended This value is set to true when the satellite is extended. 
 

Satellite Julian Date The Julian Date used to compute the satellite’s position. 
 

Satellite Name The name of the satellite. 
 

Satellite TLE1 The satellite’s two line element parameter (line 1). 
 

Satellite TLE2 The satellite’s two line element parameter (line 2). 
 

Satellite Visible This value is true when the satellite is visible from the 
current location. 
 

Scale Photo’s image scale, in arcseconds per pixel. 
 

Screen X The x position of the mouse click, in screen coordinates. 
 

Screen Y The y position of the mouse click, in screen coordinates. 
 

Semi-Major Axis The target object’s semi-major axis. 
 

Set Time The time at which the target object sets (below the 
horizon). 
 

Sidereal Time The current sidereal time. 
 

Skip Index The zero-based index for the object in the object path. 
 

Source Catalog The source catalog used to display information about 
the target object. 
 

Spectral The target object’s spectral class. 
 

Spectral Type The target object’s spectral type. 
 

Star Identifier The target star’s catalog identifier. 

Sun Distance (au) The target object’s distance from the Sun, in 
astronomical units. 
 

Sun Position Angle The Sun’s position angle. 
 

Text Record Text-based information about the target object. 
 

Text Record Start The starting position of the text record. 
 

Time The current time. 
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Object Property  Description 

Transit Time The time at which the target object transits. 
 

True Dec The target object’s true declination. 
 

True RA The target object’s true right ascension. 
 

Type of Variable The variable star’s classification. 
 

Umbra Diameter The diameter of the Earth’s umbra. 
 

Width The width, in pixels, of the target object (photos only). 
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Appendix K: User Guide Revision History 

Revision Number Publish Date Changes 

6.0 May, 2018 • Updated dome screen capture and documented the 
dome slit preferences. 

• Updated the Database Add On documentation. 

• Added SBIG macOS disclaimer information. 

• Added missing description for the the SBIG AO relay 
bump size setting. 
 

5.9 November, 2017 • Clarify the Default Calibration option on the Take 
Series tab of the Camera window. 

• Corrected miscellaneous typographical errors. 
 

5.8 October, 2017 • Corrected misspelled word. 
 

5.7 September, 2017 • Clarified the uses of the Subframe tool. 

• Updated the description of the Cursor Information 
tool. 

• Added documentation about how to take AutoDarks 
using a camera without a mechanical shutter. 
 

5.6 May, 2017 • Added @Focus parameter documentation. 
 

5.5 April, 2017 • Added references to newly developed X2 Plug Ins. 

• Corrected links to download Dome Add On X2 Plugs. 
 

5.4 March, 2017 • Revised the description of the stars’ motion in the 
eyepiece using the drift method to polar alignment a 
telescope mount. 

• Clarified how the Camera Parameters are used. 

• Corrected the location of the Closed Loop Slew 
Setup. 

 

5.3 December, 2016 • Added missing checkmarks in table of supported 
focusers. 
 

5.2 December 2016 • Added missing camera-specific preference settings. 
 

5.1 November 2016 • Updated list of supported cameras and domes.  

• Corrected rotator reference text. 
 

5.0 August 2016 • Text and graphics updated for version 10.5. 
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Revision Number Publish Date Changes 

 

4.2 January 2016 • Removed Windows XP installation instructions. 

• Added Windows 10 to installation instructions. 

• Miscellaneous OS-specific changes. 

• Clarified TPoint’s pressure requirement. 
 

4.1 November 2015 • Corrected a misplaced arrow on the dome geometry 
diagram. 

• Refined dome geometry diagrams. 

• Updated dome geometry notes. 

• Corrected three missing bookmark references. 
 

4.0 August 2015 • Added notes about the NOMAD catalog. 

• Removed dated Canon plug in documentation. 
 

3.9 April 2015 • Clarified the explanation of the time zone setting on 
the Locations window. 

• Added Moonlite/FTDI USB Driver troubleshooting on 
Mac OS X. 

• Removed incorrect TOC entry. 

• Added additional Image Link troubleshooting tips 
and examples. 
 

3.8 April 2015 • The Camera Add On controls SBIG AO with STT 
model cameras.  Removed documentation stating 
otherwise. 
 

3.7 March 2015 • Corrected cross references. 

• Formatted photos for HTML and App-based help. 

• Update FOVI Options documentation.  
 

3.6 March 2015 • Added instructions for using the MicroTouch focuser 
(Windows). 

• Updated dome geometry graphics and 
documentation. 
 

3.5 December 2014 • Documentation changes related to TheSkyX version 
10.3.0. 
 

2.9 February 2013 • Updated Dome Add On documentation. 

• Updated Take Series documentation. 
 

2.7  November 2013 • Clarified Closed Loop Slew documentation. 
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Revision Number Publish Date Changes 

 

2.6 
 

 • Added Closed Loop Slew documentation. 
 

2.4  • Description of the X2 Plug In driver model. 

• SSAG release notes. 

• Corrected object reference in Figure 24. 

• Miscellaneous changes and corrections 

2.0  • Documentation changes related to version 
10.2.0.  (Note that the file name of this document 
has been abbreviated from TheSkyX Professional and 
Serious Astronomer Edition User Guide.pdf to 
TheSkyX Pro User Guide.pdf in order to 
accommodate the 27-character maximum length of 
file names on hybrid media; it still contains 
documentation for both Editions). 
 

1.7  • Camera Add On documentation including 
Autoguiding, AO Autoguiding, Image Reduction and 
Histogram. 

• Changes and updates related to TheSkyX version 
10.2.0. 

 

1.4.8  • Updated Application Support Files documentation. 
 

1.4.6 
 

 • PDF document includes table of bookmarks for 
Adobe Reader. 

• Updated location input documentation. 

• Update NexStar telescope minimum requirements. 
 

1.4.5  • Clarified telescope synchronization. 
 

1.4.4 
 

 • Clarify photo size limitations to All Sky Image Link. 
 

1.4.3  • Added documentation for the Camera Add On's 
Canon Plug In (Mac). 

• Added documentation for the FOVI window's 
Update Equipment Databases From Web button. 

 

1.4.1  • Describe all Application Support files and folders. 

• Added step by step procedure for importing TheSky6 
horizon lines into TheSkyX. 
 

1.4.0  • Updated documentation for iOptron telescopes. 
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Revision Number Publish Date Changes 

 

1.3.7 
 

 • Dome Add On completely replaces AutomaDome for 
Windows, making AutomaDome for Windows setup 
instructions unnecessary. 
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